
 

 

 

 

 

 

ArcGIS Solutions: Archived help 
ArcGIS Enterprise 10.9 

Updated November 2023 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 2 

Table of contents 
3D Basemaps ............................................................................................................................ 5 

Address Data Management.......................................................................................................21 

Address Field Operations ..........................................................................................................31 

Adopt-A-Catch Basin.................................................................................................................36 

Adopt-A-Stop ............................................................................................................................48 

Agricultural Best Management Practices ...................................................................................60 

Business Resilience ..................................................................................................................65 

Capital Project Planning ............................................................................................................81 

Capital Project Tracking ............................................................................................................89 

Citizen Problem Reporter ........................................................................................................ 100 

Code Enforcement Operations ................................................................................................ 130 

Communications Data Management for ArcGIS Enterprise ..................................................... 134 

Community Data Aggregation ................................................................................................. 140 

Community Health Assessment .............................................................................................. 147 

Community Health Outreach ................................................................................................... 157 

Community Science ................................................................................................................ 170 

Conservation Easement Monitoring ........................................................................................ 178 

Conservation Outreach ........................................................................................................... 183 

Coronavirus Business Continuity............................................................................................. 188 

Coronavirus Force Readiness ................................................................................................. 204 

Coronavirus Health Screening ................................................................................................ 212 

Coronavirus Recovery Dashboard .......................................................................................... 221 

Coronavirus Site Safety .......................................................................................................... 227 

Coronavirus Testing Sites ....................................................................................................... 243 

Coronavirus Vaccine Distribution Dashboard .......................................................................... 249 

Crime Analysis ........................................................................................................................ 260 

Daily Activity Dashboard ......................................................................................................... 282 

Dam Safety ............................................................................................................................. 288 

Damage Assessment .............................................................................................................. 292 

Fusion Center ......................................................................................................................... 388 

Gas and Pipeline Data Management for ArcGIS Enterprise .................................................... 401 

Homeless Point-in-Time Counts .............................................................................................. 407 

Homeless Risk Reduction ....................................................................................................... 415 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 3 

Invasive Pest Inspections ........................................................................................................ 422 

Know Your Zone ..................................................................................................................... 430 

Land Use Outreach ................................................................................................................. 436 

Market Development ............................................................................................................... 441 

Mosquito Service Requests..................................................................................................... 449 

Mosquito Surveillance ............................................................................................................. 468 

Mosquito Treatments .............................................................................................................. 472 

Multi Source Data Feeds ......................................................................................................... 478 

My Neighborhood Services ..................................................................................................... 483 

My Trash Services .................................................................................................................. 488 

Neighborhood Early Warning .................................................................................................. 493 

Neighborhood Stabilization ..................................................................................................... 496 

Network Path Planner ............................................................................................................. 507 

Operations Management ......................................................................................................... 510 

Parcel Drafter .......................................................................................................................... 518 

Parcel Value Analysis ............................................................................................................. 522 

Participatory Budgeting ........................................................................................................... 528 

Performance Management ...................................................................................................... 534 

Plans and Drawings ................................................................................................................ 548 

Police Transparency ............................................................................................................... 553 

Protection Operations ............................................................................................................. 580 

Public Notification ................................................................................................................... 586 

Public Parking ......................................................................................................................... 591 

Readiness Management ......................................................................................................... 602 

Recreation Outreach ............................................................................................................... 611 

Resource Management ........................................................................................................... 621 

Road Closures ........................................................................................................................ 626 

Road Network Data Management ........................................................................................... 633 

ROW Permitting ...................................................................................................................... 637 

School Locator ........................................................................................................................ 643 

Sewer Data Management for ArcGIS Enterprise ..................................................................... 648 

Special Event Operations ........................................................................................................ 654 

Special Event Permitting and Operations ................................................................................ 674 

Stormwater Data Management for ArcGIS Enterprise ............................................................. 701 

Target Hazard Analysis ........................................................................................................... 707 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 4 

Tax Reverted Property ............................................................................................................ 712 

Traffic Crash Analysis ............................................................................................................. 716 

Transit Outreach ..................................................................................................................... 725 

Transit Safety .......................................................................................................................... 732 

Transportation 511 .................................................................................................................. 740 

Vaccine Coverage Analysis..................................................................................................... 749 

Vision Zero .............................................................................................................................. 753 

Water Distribution Data Management for ArcGIS Enterprise ................................................... 768 

Wildlife Management............................................................................................................... 774 

 

 

 

 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 5 

3D Basemaps 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. The capabilities have been replaced with 3D Buildings. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to 3D Basemaps 
3D Basemaps can be used to author and maintain a 3D basemap for your organization. 

It provides a series of workflows that streamline the creation and maintenance of a 3D basemap 
that supports diverse information needs. This optimized approach allows organizations to use 
existing data (for example, lidar, building footprints, and utilities) and generate 3D visualizations 
that increase understanding and community engagement. 3D Basemaps is typically 
implemented by planning departments, emergency management agencies, GIS departments, 
and utilities that want to use 3D basemaps to visualize the built environment. 

The 3D Basemaps solution delivers a set of capabilities that help you use existing data, develop 
a standard set of 3D layers, and visualize your community in an immersive way. 

 

Requirements 
The 3D Basemaps solution requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 - ArcGIS Pro 2.9 (Advanced) 

– ArcGIS 3D Analyst extension 

– ArcGIS Spatial Analyst extension 

 

Information products 
3D Basemaps includes the following information products: 

Item Description 
Minimum user 
type 

3D 
Basemaps 

An ArcGIS Pro project used by GIS analysts and mapping 
technicians to create and maintain a 3D basemap for their 
organization 

GIS Professional 
Advanced 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 
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Release notes 
The following are the release notes: 

Version Description 

1.3 • Resolved an issue when a meter-based coordinate system is used with the 
Windows language set to other than English. 

• Resolved an issue with roof form extraction when running multiple times on large 
datasets. 

1.2 • Added an integrated mesh editing and maintenance workflow. 
• Added the ability to color trees in lidar point clouds. 
• Lidar class codes can now be preserved when classifying trees using deep 

learning. 
• Improved stability of footprint segmentation. 
• Resolved an issue with extracting tree points using cluster analysis. 

1.1 • Added deep learning for tree classification in lidar. 
• Added tree extraction using cluster analysis. 
• Significantly improved the performance and quality of building footprint 

extraction. 
• Added links to 3D analysis solutions that can use 3D basemaps layers. 
• Resolved an issue with building footprint extraction in ArcGIS Pro 2.6. 

1.0 • First release of 3D Basemaps. 
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Use 3D Basemaps 
The 3D Basemaps solution delivers a set of capabilities that help you leverage existing data (for 

example, lidar, building footprints, utilities), develop a standard set of 3D layers, and visualize 

your community in an immersive way. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Get to know 3D Basemaps 
You will assume the role of a mapping technician responsible for creating a 3D basemap for 

your community. The 3D Basemaps ArcGIS Pro project includes a series of tasks to help guide 

you through these workflows. The first set of tasks will help you get to know 3D Basemaps. 

1. Start the ArcGIS Pro application and open the 3D Basemaps project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Getting to know 3D 

Basemaps task and go through the various subtasks. 

 

Understand the 3D Basemaps solution 
The 3D Basemaps solution uses existing data within the organization such as lidar, building 

footprints, power lines, and underground pipe features. Your 3D basemap can be created at 

different levels of detail (LOD) depending on the quality of the input lidar data. This first task will 

guide you through the data requirements and help you learn how you can utilize your 3D 

basemap in other workflows and applications. 

 

Download sample data 
Sample data is provided to help you learn how to use the 3D Basemaps solution. Click to 

expand the Getting to know 3D Basemaps task group and double-click on Download sample 

data task. Click the sample data hyperlink to download sample data for Naperville and 

Philadelphia. Using the sample data the first time will help you learn how to use the tasks and 

how to organize your data. 

Start using 3D Basemaps 
The 3D Basemaps project includes a task workflow that provides a structured sequence using 

tasks and steps. Follow the steps in this task to learn how to use the 3D Basemaps solution. 

 

Publish data for your 3D Basemaps 
After you have reviewed the Get to know 3D Basemaps section, you can begin using the 

solution with your data. The following set of tasks will help you learn how to use 3D Basemaps. 

1. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 
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2. In the Catalog pane, expand the Tasks folder, and double-click the How to use 3D 
Basemaps task and go through the various subtasks. 

 

Publish ground elevation surface 
Detailed elevation layers can be automatically generated from the input lidar data. These layers 

are used to create buildings and vegetation layers. The ground elevation layer can be used to 

enhance the existing elevation in your 3D scene. 

To publish your ground elevation surface, click the Publish ground elevation surface task and 
follow the steps provided. 

 

Extract elevation surfaces from LAS dataset 
This task extracts three elevation surfaces from the LAS dataset: a ground elevation (dtm), a 

surface elevation (dsm), and a normalized surface elevation (ndsm). These surfaces are used to 

create buildings and vegetation layers. The ground elevation layer can also be used to improve 

the ground in your scene. 

 

Publish ground elevation 
This task publishes the ground elevation layer to your organization. Reprojection to Web 

Mercator with height in meters is only required if you want to use the published layers in a global 

web scene. 

 

Publish buildings 
Buildings with simple roof structures can be generated automatically from the lidar. Attributes 

such as building height, eave height, and the roof form are extracted from the lidar and added to 

the building footprints. Procedural rules are then used to create the 3D roof structures. High-

density lidar (point spacing less than 3 feet) and building footprint segmentation are needed to 

model complex roof structures. 

Note: 

The quality of the roof structures is dependent on the quality of the input lidar and building 
footprint data. A lidar point spacing of 3 feet or less is required, 1 foot or less is 
recommended. Building footprints with one roof type within their boundary (for example, 
suburban areas) will produce higher-quality roof structures than footprints with multiple roof 
types (for example, city centers). These footprints require splitting, segmentation, and 
updating of the roof form attributes. 

To publish your buildings, expand the Publish buildings group task and follow the steps 
provided. 
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Extract building footprints (optional) 
Run the Extract building footprints task to optionally extract building footprints from lidar. It is 

not required if you have an accurate footprint feature class. 

 

Preprocess building footprints (optional) 
Run the Preprocess building footprints task to prepare the building footprints for a realistic 

3D visualization. Some building footprints may contain several roof types and roof parts. To 

accurately represent these buildings, they need be split into their separate parts. Building 

footprints can be split with another feature class or by differences in elevation. 

 

This image shows the result of building extraction before preprocessing of building footprints. 

 

This image shows the result of building extraction after preprocessing of building footprints. 
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Tip: 

Separate features of similar size into separate feature classes before running segmentation 
to improve segmentation quality. Use different spectral and spatial detail for each of these 
feature classes to tweak the roof segmentation for your data. Merge the feature classes 
when finished. 

 

Create buildings 
Run the Create buildings task to create a 3D building layer. This task uses the elevation 

surfaces and building footprints to find both flat and sloped planar areas within a roof area of a 

building. It estimates a standard architectural form for the roof based on the attributes collected 

from these planar surfaces. These attributes are then used to inform a procedural rule that 

generates these features in 3D. 

 

This image shows the roof types that will be automatically classified. 

 

Review buildings 
Run the Review buildings task to inspect your building roof forms. The Confidence 

Measurement tool reports the following measurement (attribute added to the building 

footprints): 

Note: 

The RMSE field shows the root mean square error of the generated building multipatch to 
the underlying surface model. The higher this number, the more likely that the building 
creation encountered an error in classification. In general, a value of 1 meter (3 feet) or less 
is desirable, though this depends on the required application of the output features, and the 
resolution of the input data. 
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Modify buildings 
Use the Modify buildings task to further improve the quality of the building roof forms. The 

building roof form is driven by the attributes that are generated by the Create buildings task and 

by the underlying the building footprint. To refine the building roof form, modify the attributes or 

the building footprint. 

Tip: 

The attributes that control the roof form are building height, eave height, roof direction, and 
the type of roof are BLDGHEIGHT,EAVEHEIGHT, ROOFFORM, RoofDirAdjust. By 
editing these attributes, you can adjust your building models to better match the lidar data. 

 

Building footprint attributes that control the roof form. 

 

Building height 

If the ridge of the building is not at the correct height, identify the elevation of a LAS point on the 

true ridge by clicking the LAS point while having the Explore tool active. You will need to 

subtract the BASEELEV value from the LAS elevation to get the correct BLDGHEIGHT value. 

 

Results of manual updating of the BLDGHEIGHT attribute are shown. 

 

Eave height 

Similar to building height, reference the lidar to obtain the correct eave height. You will need to 

subtract the BASEELEV from the lidar elevation to get the correct the EAVEHEIGHT value. 

 

Results of manual updating of the EAVEHEIGHT attribute are shown. 
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Roof form 

If your roof type does not match the lidar data, change the roof type by choosing the correct roof 

form from the drop-down list. 

 

Results of manual updating of the ROOFORM attribute are shown. 

 

Roof direction 

Adjust the direction of the roof by modifying the RoofDirAdjust field. The default value is 0. A 

value of 1 will rotate the roof counterclockwise 90 degrees, or a value of 2 will rotate it 180 

degrees. 

 

Results of manual updating of the RoofDirAdjust attribute are shown. 

 

Split roof segments 

Some building footprints may contain several roof types and roof parts. To accurately represent 

these buildings, you can split the footprints into separate features manually and update the 

attributes for each feature accordingly. 

To edit the building footprints, complete the following steps: 

1. Select the feature you want to segment. 

2. Use the Split tool in the Roof Segmentation task, or in the Modify Features pane to 
segment the selected feature. 

3. Edit the attributes as needed with the new sections of the building footprint. 

https://www.esri.com/en-us/privacy/overview
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Results of manual splitting of buildings are shown. 

 

Modify building vertices 

Sometimes building footprints may have been created incorrectly and do not represent the 

building adequately, resulting in lower-quality roof forms. 

To edit the building footprints, complete the following steps: 

1. Select the feature you want to modify. 

2. Use the Vertices tool in the Modify Building Vertices task, or on the Edit tab to modify the 
selected feature. 

3. Edit the attributes as needed with the modified building footprint. 

 
Results of manual updating of building vertices are shown. 

 

Create cross gable roof forms 

You can also use vertex editing to make cross gable roof forms. To do so, complete the 

following steps: 

1. Select the feature you want to modify. 

2. Use the Split tool in the Roof Segmentation task, or on the Edit tab to segment the 
building footprint according to the roof forms present within the footprint. 

https://www.esri.com/en-us/privacy/overview
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3. Use the Vertices tool in the Modify Building Vertices task, or in the Modify Features pane 
to extend one gable roof into the other one. 

4. Edit the attributes as needed with the modified building footprint. 

 

Results of manual updating of cross gable roof forms are shown. 

 

Fuse buildings 
If you have segmented some building footprints into separate features, you can use the Fuse 

buildings task to fuse the building features that represent building parts back together in the 

resulting 3D building features. 

Note: 

Review and modification of buildings is done on the building footprint layer with procedural 
symbology. Fusing saves the modification to multipatch format for texture adding and 
publishing. 

 

Add textures to buildings (optional) 
Use this task to add realistic textures to the previously extracted buildings. 

Note: 

Textures depict generic usage of buildings and are applied based on footprint size. Using 
high-resolution textures will result in large output, potentially leading to decreased 
visualization performance. 

 

Publish buildings layer 
This task publishes the building layer to your organization. Reprojection to Web Mercator with 

height in meters is only required if you want to use the published layers in a global web scene. 

 

Update buildings (optional) 
Use this task if new lidar is available. It compares an existing 3D multipatch building layer with a 

new lidar dataset to verify whether there are any updates required due to new construction or 

https://www.esri.com/en-us/privacy/overview
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demolition. If changes have been detected, these can then be merged back into the original 3D 

building layer. 

To update your existing buildings, you will need the following data: 

• Multipatch buildings 

• Lidar with ground and buildings classified 

The Update Buildings process accomplishes the following purposes: 

• Detects changes between input 3D multipatch buildings and new lidar. The output is 
building update polygons where changes have been detected depending on the input 
parameters. 

• Creates LOD2 update buildings using the building update polygons and the lidar. 

• Merges the LOD2 update buildings with the existing 3D buildings. 

 

Publish floors 
Building Floors can be created using the Publish floors task. The input is multipatch buildings, 

which can come from the Publish buildings task or from other sources such as CityEngine or 

third-party providers. The output is building floor plates and floor volumes. Floors can be created 

using a Building Space Use table where the building will be split into tiers or groups of floors, 

each with their own number of floors, floor height, space use, and color. Alternatively, building 

attributes such as number of floors, ground floor height, upper floor height, and roof height can 

be used to create the floors. 

Note: 

Splitting buildings into floors can take a long time to run, especially when the initial split 
failed, and a more time-intensive splitting algorithm must be used. Ensure you only split the 
buildings that are required. Also, factors such as building size and complexity will affect the 
processing time. 

In the Task Pane, click the Publish floors task and follow the steps provided. 

 

Create building floors 
This tool splits existing 3D buildings into floors based on building attributes. You can use the 

buildings created in the Publish buildings task or bring in your own buildings. 

One option to create building floors is to use the building space use table to split the building 
into tiers or groups of individual floors with defined space use. The building space use table has 
several attributes that describe the different tiers within the building. Each tier has an attribute 
defining space use, number of floors, floor color, and floor height. The BuildingTypeName 
attribute is the identifier that links the Building Space Use table to the building features. An 
example building space use table can be found in the tables folder of the 3D basemaps ArcGIS 
Pro project. 
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Create floor volumes 
If you require floor volumes, use the Create floor volumes task to create floor volumes out of the 

3D floor plates. The Extrude By Attribute geoprocessing tool requires a building feature class 

with space usage information that includes floor height. 

 

Publish trees 
Tree location, size, and width can be extracted from ground classified lidar as point features. 

Tree point features are then symbolized using procedural rules and can be schematic or 

realistic. If trees are classified in the lidar, the quality of the tree extraction will improve. 

In the Task pane, expand the Publish trees group task and follow the steps provided. 

 

Classify trees in lidar using deep learning 
Run this tool to optionally classify trees in the lidar using a deep learning model. Classified trees 

will improve the vegetation extraction but keep in mind that deep learning is computationally 

very intensive, and a powerful GPU is needed to process large datasets faster. Depending on 

data size and available hardware, it can take hours to finish. Start with one LAS file to see 

processing time on your system. 

To work with the deep learning tools in ArcGIS Pro, you need to install supported deep learning 
frameworks packages. See deep learning frameworks for ArcGIS. 

A tree classification model trained by Esri can be downloaded from ArcGIS Living Atlas of the 
World or you can create your own model using the Training a Deep Learning model for Point 
Cloud Classification notebook that can be found in the notebooks folder of the 3D basemaps 
ArcGIS Pro project. 

 

Extract tree points using surface analysis 
Use this tool to extract tree points from the lidar using surface analysis. This type of extraction is 

faster for large lidar datasets, but the results are less accurate than using cluster analysis for 

dense lidar (point spacing less than 1.5 feet/0.5 meters). 

 

Extract tree points using cluster analysis 
Use this tool to extract tree points from the lidar using cluster analysis. This type of extraction is 

slower for large lidar datasets, but the results are more accurate than using surface analysis. 

Note: 

When creating the 3D trees, make sure to verify the Vegetation class code. The correct 
class codes for vegetation is typically 5. The tool will verify whether your lidar has this code, 
but trees might be represented by other codes as well. Visually review your lidar and verify 
what class code tree points have by clicking a tree lidar point. If the vegetation has not been 
classified, enter the class code that represents the vegetation, for example, 0 or 1. 
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Tip: 

Use the Extract tree points using surface analysis tool to create an initial vegetation layer. 
Run the Extract tree points using cluster analysis tool for lidar files for which you need 
detailed trees and replace the trees from the initial layer with the more detailed trees where 
needed. 

 

Create colorized lidar trees 
Classified lidar can also be used directly to visualize trees. This step extracts just the tree points 

from the input lidar and uses aerial imagery to colorize them. 

 

Publish bridges 
If bridge surfaces are classified in the lidar and the lidar is dense enough, it is possible to extract 

the bridge surfaces as 3D polygons. 3D bridges can then be created by applying procedural 

rules. 

In the Task pane, expand the Publish bridges group task and follow the steps provided. 

 

Create bridges 
In the Extract bridge surfaces from lidar step, enter the following: 

• Class Code—The class code that represents the bridge surfaces. 

• Sampling Value—Experiment with this value to improve processing speed and output 
quality. 

• Bridge Area—This is the minimum area that defines a bridge surface. 

Note: 

The bridge surface should be a separate class code. If bridge surfaces are not classified in 
the lidar, you can interactively classify the bridge surfaces in ArcGIS Pro. 

Note: 

Only rectangular bridge surfaces and models are supported. 

 

Publish power lines 
Use your existing GIS data to visualize distribution and transmission lines in 3D. Procedural 

rules are used to create the 3D support structures and conductors. A wide variety of conductor 

and tower configurations are supported. 

In the Task pane, expand the Publish power lines group task and follow the steps provided. 
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Create transmission lines 
Run the Create transmission lines task to create 3D transmission lines. Enter the following: 

• Voltage—Select the voltage for the transmission line. The values for the voltage list are 
read from the TowerLUTable table located in the project tables directory. Change these 
values to modify conductor and tower features. 

• Tower configuration—Experiment with these parameters to create the desired towers. 

 

Create distribution lines 
Run the Create distribution lines task to create 3D distribution lines. Enter the following: 

• Pole configuration—Experiment with these parameters to create the desired poles. 

Note: 

Both tools support line and point feature input. You can use existing features, features that 
have been extracted from lidar, or manually create features. In the case of line features, the 
vertex locations are used to create towers. In the case of point features, a line and tower 
attribute must be present. The line attribute should describe which line the points belong to 
and the tower attribute should describe the tower order per line. Connected lines are not 
supported. 

Note: 

This tool requires that the Microsoft Access Database Engine driver is installed. 

 

Publish underground pipes 
You can turn your existing 2D underground utility features into 3D features using elevation 

attributes. 

In the Task pane, expand the Publish underground pipes group task and follow the steps 
provided. 

 

Create gravity mains 
Run the Create gravity mains task to create 3D gravity-driven mains. The first time you run this 

step, you evaluate the current state of the gravity mains and highlight errors. After reviewing the 

errors and updating fields that are incorrect, run Interpolate gravity mains to calculate any 

remaining missing values. 

 

Create manholes 
Run the Create manholes task to create 3D manhole features. 
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Create laterals 
Run the Create laterals task to create 3D lateral features. 

 

Create a surface trench 
Run the Create a surface trench task to better visualize underground pipe features. 

 

Publish integrated mesh 
An integrated mesh is a textured continuous meshed surface capturing a current state of an 

area or city. They are often derived from drone, aerial, or satellite imagery via photogrammetric 

processing. 

In the Tasks pane, expand the Publish integrated mesh group task and follow the steps 
provided. 

 

Add integrated mesh 
This step adds an integrated mesh to your scene. A mesh (.slpk) is typically created from 

photogrammetric sources, like imagery captured by drones and processed with Drone2Map or 

SiteScan. There are also several Esri partners that specialize in producing city-scale integrated 

mesh for purchase. 

 

Modify integrated mesh 
Use this step to make a modification to an integrated mesh layer. You can create a new 

modification or import from an existing polygon feature layer. Mesh modifications are useful to 

be able to show other 3D layers such as buildings, trees or bridges together with the integrated 

mesh. 

 

Publish integrated mesh layer 
This step publishes the integrated mesh layer to your organization. Reprojection to Web 

Mercator with height in meters is only required if you wish to use the published layer in a global 

web scene. 

Run Share as new web scene to publish the entire scene as web scene to your organization. 
Remove all the layers that you don't want to publish from the scene before publishing. 

Run Share as scene layer if you need to add an integrated mesh to an existing web scene. 
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Modify integrated mesh in web scene 
This tool modifies an integrated mesh in a published web scene without having to republish the 

entire mesh as a new web scene. 

 

Publish 3D Basemaps 
The 3D basemap is a web scene that can be used across the ArcGIS platform. 

In the Task pane, expand the Publish 3D basemap web scene group task and follow the 
steps provided. 

Tip: 

For more information on creating a web scene, see Get started with scenes. 
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Address Data Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Address Data Management 
Address Data Management can be used to maintain an authoritative inventory of road 

centerlines with address ranges, valid road names, site addresses, and related mailing 

addresses. 

It provides a series of workflows and standard address layers that streamline the maintenance 
of a central address repository that supports diverse information needs (for example, public 
safety, permitting, utility billing, assessment and taxation, and so on). This optimized approach 
allows organizations to capture the physical location of an address early in the development 
process and continuously improve the accuracy of address information over time. Address Data 
Management is typically implemented by planning departments, public safety agencies, GIS 
departments, and other local government organizations that want to develop and maintain an 
address repository that supports a variety of government functions. 

The Address Data Management solution delivers a set of capabilities that help you maintain a 
standard set of address layers that incorporate national guidelines, streamline address data 
management workflows, and continuously improve the quality of address information. 

 

Requirements 
Address Data Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.5 or later (Standard or Advanced) 

– ArcGIS Data Reviewer (optional) 

 

Information products 
Address Data Management includes the following information products: 
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Item Description 
Minimum user 
type 

Address Data 
Management 

An ArcGIS Pro project used to maintain an inventory of 
road centerlines, valid road names, site addresses, and 
related mailing addresses 

GIS Professional 
Standard 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Address Data Management 
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Configure Address Data Management 
Learn how to configure the Address Data Management solution to meet specific needs in your 

organization. 

 

Configure address data management project 
The Address Data Management solution includes an ArcGIS Pro project and sample data you 

can use to explore data management workflows. When you are ready to configure the project, a 

series of tasks are included to help you review the schema, make modifications to the maps and 

layers, load your data, and optionally migrate into ArcGIS Enterprise. 

1. Sign in to your ArcGIS organization and browse to the Address Data Management Desktop 
Application Template. 

2. Open the item page and click Download. 

3.  Unzip and open the Address Data Management ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Address Data 
Management task. 

6. In the Tasks pane, expand the Configure Address Data Management task group. 

 

Review schema 
Included in the solution is a data dictionary that describes the feature classes, relationship 

classes, and domains included in the Address Data Management geodatabase. 

To review the data dictionary, browse to the Data Dictionary.htm file included with the 

Address Data Management project and open in your default web browser. 

 

Define spatial reference 
The Address Data Management project comes with two file geodatabases. Address Data 

Management Sample.gdb contains data designed to help test workflows supported in the 

solution. 

Address Data Management.gdb is an empty geodatabase with the same schema and a spatial 
reference set to Web Mercator. You can use this geodatabase to define your spatial reference 
and load your data. 

To define the spatial reference, follow the steps in the Define spatial reference task. 

 

Configure maps, layers, and rules 
The Address Data Management solution leverages preconfigured attribute rules to automate 

many of the editing workflows. For example, when you create an address point, a unique ID is 

automatically generated for the point. 
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In some cases, you may need to modify the default schema included with the solution to meet 
your organization’s needs. If you need to remove or rename fields that are used in any of the 
attribute rules, you must first update the rule to remove the reference to the field. Adding new 
fields does not impact the rules. You may also want to add additional rules or configure the 
feature templates to set the default attributes applied when a feature is created. 

To modify the schema, attribute rules, and feature templates of the layers, follow the steps in 
the Configure maps, layers, and rules task. 

 

Load your data 
When you have completed any schema modifications, you can load your existing data into the 

Address Data Management layers by following the steps in the Load your data task. 

 

Load into ArcGIS Enterprise 
While everything included with the Address Data Management solution is supported in a file 

geodatabase, some organizations may choose to manage this data in ArcGIS Enterprise. 

To copy the Address Data Management schema into ArcGIS Enterprise, follow the steps in the 
Load into ArcGIS Enterprise task. 

 

Configure data validation 
You can use Data Reviewer to validate, maintain, and improve the integrity of your address 

data. The Address Data Management map includes a collection of preconfigured checks that 

help you identify and resolve common errors in your address data. You can add, remove, or 

modify these checks to meet your organization’s needs. 

To modify the Data Reviewer checks, follow the steps in the Configure data validation task. 

 

Use logical block addressing 
Logical block addressing uses the starting address, an interval or distance between unique 

addresses, and the length of the road segment to calculate the address range for the block. If 

your organization uses logical block addressing, you can configure attribute rules to 

automatically calculate the left and right to address from the left and right from address. 

To enable the logical block addressing attribute rules, complete the following steps: 

1. Start the ArcGIS Pro application and open the Address Data Management project. 

2. In the Contents pane, right-click the Local Streets layer. 

3. From the Design menu, choose Attribute Rules. 

4. In the Attribute Rules table, click the Logical Block Addressing (Left) rule. 

5. In the Expression Builder update the value for the addressIntervalDistance and unit to the 
distance your community uses between unique addresses along a road. 

  // Specify the interval or distance between unique addresses 
var addressIntervalDistance = 10; 
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// Specify the unity of measure. Valid options are feet, meters, yards, 
miles, kilometers 
var unit = "feet"; 

6. Click the Save button  on the Attribute Rules tab. 

7. Click Enable Rule in the Attribute Rules group on the ribbon. 

8. Repeat steps 5 through 7 for the Logical Block Addressing (Right) rule. 

9. Click Save button on the Attribute Rules tab. 

 

Pull information from an intersecting feature 
You can configure additional attribute rules for the site address layer to automatically pull 

information from an intersecting feature when the address point is created or updated. For 

example, you can write the name of the municipality, ZIP Code, or the property identification 

number (PIN) the address falls within and write it to a field within the site address point. 

To add an intersecting feature attribute rule to your site addresses layer, complete the following 
steps: 

Note: 

This rule requires both the site addresses feature class and the intersecting feature class 
be in the same database. 

1. In ArcGIS Pro, from the Contents pane, right-click the Site Addresses layer. 

2. From the Design menu, choose Attribute Rules. 

3. From the Attribute Rules table, click the Add Rule drop-down arrow and choose Add 
Immediate Calculation Rule. 

4. Provide a Rule Name and Description for your rule. 

5. Click the Field drop-down arrow and choose a field in your Site Addresses layer where you 
want to write the attribute from the intersecting feature. 

6. Click Expression Builder  to open the Expression Builder dialog box. 

7. Copy the code below and paste it into the Expression Builder. 

  // replace 'FeatureClassName' with the name of the feature class to pull 
intersecting features from (ex. Cities, ZipCodes, Parcels) 
var intersectingFeatures = Intersects(FeatureSetByName($datastore, 
"FeatureClassName"), $feature); 
for (var feature in intersectingFeatures) { 
     // replace 'fieldname' with the name of the field from the 
intersecting feature to pull the value from 
     var value = feature.fieldname; 
      if (IsEmpty(value)) continue; 
     return value; 
} 
return null; 
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8. In the code, find and replace the text FeatureClassName with the name of the feature 

class to pull intersecting features from (for example, Cities, ZipCodes, or Parcels). 

9. In the code, find and replace the text fieldname with the name of the field from the 

intersecting feature to pull the value from. 

10. Click the Verify button and click OK to close the Expression Builder dialog box. 

11. In the details pane, under Triggers, check Insert. If you want the rule to run when the 
address is moved as well, check Update. 

12. Click the Save button  on the Attribute Rules tab. 

  This button is unavailable if you have any pending feature edits. Save or discard your edits 
to enable the Save button. 

  Note: 

  The rule is now active. When you create a site address point, the rule runs and pulls the 
attribute of the intersecting feature into the field specified by the rule. Repeat the steps 
above to add additional rules for different feature classes and field values. 

  Tip: 

  The code above is configured to return null if no intersecting features are found, and if 
multiple intersecting features are found (overlapping polygons), it returns the first nonnull 
feature attribute found. Below are some additional code samples for other common 
scenarios. 

 

Return multiple intersecting feature values as a comma-delimited list 
Copy this code and paste it into the Expression Builder dialog box to return a list. 

// replace 'FeatureClassName' with the name of the feature class to pull 
intersecting features from (ex. Cities, ZipCodes, Parcels) 
var intersectingFeatures = Intersects(FeatureSetByName($datastore, 
"FeatureClassName"), $feature); 
var values = []; 
for (var feature in intersectingFeatures) { 
     // replace 'fieldname' with the name of the field from the intersecting 
feature to pull the value from 
     var value = feature.fieldname; 
     if (IsEmpty(value)) continue; 
     values [Count(values )] = value; 
} 
return Concatenate(values, ", "); 

 

Return multiple intersecting feature values as a statistic (Mean, Min, 

Max, Sum) 
Copy this code and paste it into the Expression Builder dialog box to return statistic values. 
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// replace 'FeatureClassName' with the name of the feature class to pull 
intersecting features from (ex. Cities, ZipCodes, Parcels) 
var intersectingFeatures = Intersects(FeatureSetByName($datastore, 
"FeatureClassName"), $feature); 
var values = []; 
for (var feature in intersectingFeatures) { 
     // replace 'fieldname' with the name of the field from the intersecting 
feature to pull the value from 
     var value = feature.fieldname; 
     if (IsEmpty(value)) continue; 
     values[Count(values)] = value; 
} 
return Mean(values); 

 

Publish address locators 
You can author the address locators described below in ArcGIS Pro from the layers managed in 

the Address Data Management solution: 

• Composite 

• Dual Range 

• Site address 

• Road name 

Once you have authored the locators, you can use them in ArcGIS Pro to locate places using 

addresses along the left or right side of a road, rooftop address locations, and road names. You 

can also share the locators with your organization and use them in many ArcGIS Solutions. 

Learn how to create an address locator and more about the components of an address locator 
in the ArcGIS Pro help. 
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Use Address Data Management 
The Address Data Management solution delivers a set of capabilities that help you maintain a 

standard set of address layers that incorporate national guidelines, streamline address data 

management workflows, and continuously improve the quality of address information. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Manage address data 
You will assume the role of a mapping technician responsible for maintaining an inventory of 

road centerlines, valid road names, site addresses, and related mailing addresses. The Address 

Data Management ArcGIS Pro project includes a series of tasks to help guide you through 

these workflows. 

1. Sign in to your ArcGIS organization and browse to the Address Data Management Desktop 
Application Template. 

2. Open the item page and click Download. 

3.  Unzip and open the Address Data Management ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Address Data 
Management task. 

6. In the Tasks pane, click the How to Use Address Data Management task group to 
expand the collection of tasks. 

 

Add new roads 
Roads are line segments representing centerlines of all roadways or carriageways that support 

address geocoding and mapping. They are also a resource for the agencies responsible for the 

active management of the road network. Typically, this information is compiled from 

orthorectified aerial imagery and record drawings. 

The road features leverage a valid list of road names that can be assigned to a road and 
subsequent site address. The Master Road Names table includes the unique elements of a road 
name (for example, direction, name, and type) and uses an attribute rule to create a full road 
name. To ensure data integrity, a road name index is derived from the Master Road Names 
table and used to populate official road names when creating new road centerlines and site 
addresses. 

The feature classification and type schema for the roads is based on a functional classification 
of roads provided by the Federal Highway Administration (FHWA). Specific attributes and 
default values vary for each feature type. 

To update the road name index and add new roads, follow the steps in the Add new roads 
task. 
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Add site addresses 
Site addresses represent the location of a site or service delivery address assigned by a local 

government. Typically, site addresses are placed on top of the associated structure. 

Alternatively, they may be placed at the center of a parcel or in close proximity to the curb cut. 

Site addresses are related to two other address layers: 

• Address points that represent the location along the road network where the 
specific site or service delivery address has been assigned. 

• Entrance points that represent the location where the public, or a service provider, 
gains access to the specific site address. In urban settings, an entrance point can 
represent a driveway for a home that is on a corner lot and the address is assigned 
off an adjacent road. In rural areas, an entrance point can represent a shared 
driveway that provides access to many homes. Entrance points are optional and 
can be added on a case-by-case basis. 

Each site address may have one or more postal addresses associated with it. Postal addresses 

provide contact information for the owner or occupant of the building or buildings associated 

with a site address. The Owner / Occupant field indicates whether the postal address is for the 

owner, occupant, or both. 

The feature classification and type schema for the site addresses is based on a status field. This 
status field allows local governments to identify pending, temporary, and current addresses. 

To add a new site address and one, or more, related postal addresses and building entrances, 
follow the steps in the Add site addresses task. 

 

Update road names 
Road names may change during the plan review process and as a result, pending road names 

must be updated. When updates are made to the Master Road Names table and road name 

index, the changes are pushed to the road and site address features to ensure data integrity is 

maintained. 

To modify a pending road name and update related features, follow the steps in the Update 
road names task. 

 

Modify road and address parity 
In some cases, roads were not drawn in the direction of ascending address ranges and the 

direction of the line must be flipped to improve address geocoding. This may also mean the 

address range parity is incorrect and must be flipped as well. 

To modify the road direction or address parity, follow the steps in the Flip roads and swap 
parity task. 
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Create road intersections 
When creating new roads, existing roads are split at intersections along the new road. An 

inventory of road intersections with the names of relevant crossroads is often required by 911 

systems and to manage right-of-way assets. 

To create road intersections, follow the steps in the Create road intersections task. 

 

Validate address integrity 
You can use ArcGIS Data Reviewer to validate, maintain, and improve the integrity of your 

address data. The Address Data Management map includes a collection of preconfigured 

checks that help you identify and resolve common errors in your address data. 

To validate address integrity, follow the steps in the Validate address data task. 
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Address Field Operations 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Address Field Operations 
Address Field Operations can be used to crowdsource missing address information from 

stakeholders, manage address fieldwork, and collect and verify address information while in the 

field. 

Current and accurate address data is an essential requirement for a variety of functions, 
including emergency management, as well as administration, research, publications, mapping, 
routing, navigation, and many other purposes. Successful address authorities assign addresses 
early in the development life cycle and improve the integrity of their address repository with 
quality control procedures that incorporate feedback from stakeholders. Address Field 
Operations is typically implemented by planning departments, public safety agencies, GIS 
departments, and other local government organizations that want to continuously improve an 
address repository that supports a variety of government functions. 

The Address Field Operations solution delivers a set of capabilities that help you solicit missing 
or inaccurate address information from internal and external stakeholders, verify these 
submissions in the office, or create work assignments and dispatch staff to verify and collect 
new address information from a mobile device in the field. 

 

Requirements 
Address Field Operations requires the following: 

• ArcGIS Enterprise 

• ArcGIS Workforce 

• ArcGIS Collector 

 

Information products 
Address Field Operations includes the following information products: 

Item Description 
Minimum 
user type 

Address 
Crowdsourcing 

An ArcGIS Survey123 form used by addressing staff to 
crowdsource missing address information from stakeholders. 

Editor 
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Address 
Assignments 

An ArcGIS Workforce Classic project used by addressing staff 
to manage address field operations. Field users access the 
Address Assignments project using the Workforce for ArcGIS 
mobile app. 

Field 
Worker 

Address Field 
Inventory 

An ArcGIS Collector map used by addressing staff to collect 
address information while in the field. 

Field 
Worker 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Address Field Operations 

 

Use Address Field Operations 
The Address Field Operations solution delivers a set of capabilities that help you solicit missing 

or inaccurate address information from internal and external stakeholders, verify these 

submissions in the office, or create work assignments and dispatch staff to verify and collect 

new address information from a mobile device in the field. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Submit a missing address 
You will first assume the role of an employee in the public works department. When attempting 

to issue a permit, you search for an address, but no result is returned. You will use the Address 

Crowdsourcing form to report the missing address. 

1. In a browser, go to the Address Crowdsourcing form. 

2. In the Address Crowdsourcing form, fill in the following details: 

  Questions 

  Answers 
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  Address 
Number 

  Type 201. 

  Full Road Name   Type E Oak Ave. 

  Municipality   Type Naperville. 

  Select Location   Zoom and pan in the map to the approximate location of the 
missing address. 

  Full Name   Type your name. 

  Email   Type your email address. 

  Phone   Type your phone number. 

3. Click Submit. 

 

Assign a missing address for verification 
You will now assume the role of a supervisor at an addressing authority. As a supervisor, you 

are responsible for assigning field crews to verify missing or incorrect address reports from 

stakeholders. Using the Address Assignments ArcGIS Workforce Classic project, you will create 

a new assignment using the missing address report and assign it to one of your fieldworkers. 

1. In a browser, sign in to your ArcGIS organization and click the Apps button  in the 
header of the site. 

2. From the app launcher, click ArcGIS Workforce to open the app. 

3.  Under Classic projects, click Address Assignments to open the project. 

  Tip: 

  When implementing the Address Field Operations solution in your organization, you 
must add anyone responsible for verifying addresses in the field to the Address 
Assignments ArcGIS Workforce Classic project with a Mobile Worker role. You can add 
users and assign roles in the configuration settings of the project. To access 
configuration settings, hover over Address Assignments project and click Configure. 
Click the Users tab. For the purposes of this exercise, ensure your named user account 
is assigned as a dispatcher and as a mobile worker. Click My Projects tab to return to 
your projects. 

4. On the map, select the address you created in the previous section and click the + Create 
Assignment at the bottom of the pop-up window. 

5. From the Create Assignment panel, fill in the following details: 

– For Assignment Type, choose Verify Address. 

– For Assigned to, choose a worker. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 34 

– For Priority, choose Medium. 

– For Due Date, choose tomorrow. 

6. Click Create Assignment. 

 

Verify missing addresses 
You will now assume the role of a fieldworker at an addressing authority. As a fieldworker, you 

are responsible for verifying missing or incorrect address reports. Using the Address 

Assignments ArcGIS Workforce Classic project, you will review and update the status of your 

assignments and open the Address Field Inventory map in ArcGIS Collector to verify missing 

addresses. 

1. Download Workforce for ArcGIS and Collector for ArcGIS (Classic) apps onto your mobile 
device. 

2. Open the Workforce for ArcGIS app and sign in to your ArcGIS organization. 

3. Tap the Address Assignments project. 

4. Tap Verify Address from the To Do list. 

5. Tap Start. 

6. From the overflow menu, tap Collect at Assignment. 

  This opens the Address Field Inventory map in Collector for ArcGIS (Classic) and defaults to the 
location of the assignment and drops a pin. 

7. Tap Close to cancel the dropped pin. 

8. Tap the missing address point at the same location. 

9. Tap Edit to modify the details of the address. 

  At this point, verify the details of the address and make any necessary changes to the attributes and 
location of the address. 

10. Tap Verified and tap Yes. 

11. Tap Submit (iOS) or the check mark (Android). 

  The address point changes from red to green and now reflects any edits you made during 
verification. 

12. Return to the Workforce for ArcGIS app and tap Finish to complete the assignment. 

 

Collect new addresses 
You will continue your role as a fieldworker at an addressing authority. You are responsible for 

collecting addresses for a new subdivision in the community. You will use the Address Field 

Inventory map in ArcGIS Collector to collect new addresses in the field. 

1. From your mobile device, open the Collector for ArcGIS (Classic) app. 

  Tap the back arrow, if necessary, to go back to the Maps list. 

2. Tap the Address Field Inventory map. 

3. Tap Add. 

4. By default, the point is set at your current location. Adjust the location on the map as 
necessary and tap Add Point. 

5. Swipe up and enter the details of the address. 
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  When adding multiple addresses, they may have common attributes such as the road 
name and municipality. You can create a copy of an existing address point by selecting it 
and tapping Copy. 

6. Tap Submit (iOS) or the check mark (Android). 
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Adopt-A-Catch Basin 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Adopt-A-Catch Basin 
Adopt-A-Catch Basin can be used to operate catch basin adoption programs that allow 

volunteers to adopt storm drains and clean them for the community. 

Adopt-A-Catch Basin programs seek to improve water quality, decrease localized flooding, and 
reduce maintenance costs by leveraging individual volunteers and organizations to clean drains 
and keep water flowing. Program volunteers are typically asked to inspect their drains; remove 
leaves, trash, and other debris; and report damage or clogs at regular intervals. In some cases, 
they may even be asked to check on an adopted drain before a forecasted storm. This simple 
action has a big impact on the cleanliness of local waterways and reduces the chance of 
localized flooding during a storm. Adopt-A-Catch Basin is typically implemented by public works 
agencies or utilities that want to engage the community and maximize the capacity of operations 
staff. 

The Adopt-A-Catch Basin solution delivers a set of capabilities that help you engage volunteers 
to keep catch basins clear of debris and functioning properly, manage participants, and monitor 
the adoption program. 

 

Requirements 
Adopt-A-Catch Basin requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.5 or later (Basic, Standard, or Advanced) 

• ArcGIS Web AppBuilder (Developer Edition) 2.11 or later 

• SMTP Server 

 

Information products 
Adopt-A-Catch Basin includes the following information products: 

Item Description Minimum user type 

Adopt-A-Catch 
Basin 

An ArcGIS Hub site used by the general public to 
learn how they get involved in the Adopt-A-Catch 
Basin program 

Not required 
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Adopt-A-Catch 
Basin 

An ArcGIS Pro project package used by 
stormwater personnel to configure the Adopt-A-
Catch Basin app and publish supporting web tools 
to ArcGIS Enterprise 

GIS Professional 
Standard with Web tool 
publisher permission 

Adopt-A-Catch 
Basin Manager 

A Crowdsource Manager app used by stormwater 
personnel to manage Adopt-A-Catch Basin 
participants 

Editor 

Adopt-A-Catch 
Basin 
Dashboard 

An ArcGIS Dashboards app used by stormwater 
personnel to monitor the Adopt-A-Catch Basin 
program 

Viewer 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Adopt-A-Catch Basin 
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Configure Adopt-A-Catch Basin 
Learn how to configure the Adopt-A-Catch Basin solution to meet specific needs in your 

organization. 

 

Publish the Adopt-A-Catch Basin app 
The Adopt-A-Catch Basin solution includes an ArcGIS Pro project used to publish the Adopt-A-

Catch Basin app. When you are ready to publish the app, a series of tasks is included to help 

you get started. 

 

Get started 
Use the ArcGIS Pro project to familiarize yourself with Adopt-A-Catch Basin. 

1. Sign in to your ArcGIS organization and browse to the Adopt-A-Catch Basin Project 
Package. 

2. Open the item page and click Download. 

3. Browse to and open the Adopt-A-Catch Basin project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Adopt-A-
Catch Basin task. 

6. In the Tasks pane, expand the Getting to Know Adopt-A-Catch Basin task 
group. 

7. Double-click Understanding Adopt-A-Catch Basin task to review it. 

 

Configure Adopt-A-Catch Basin 
Use the ArcGIS Pro project to set up Adopt-A-Catch Basin. 

1. In the Tasks pane, expand the Configure Adopt-A-Catch Basin task group. 

2. Use the Configure Adopt-A-Catch Basin task group to access several tasks that 
guide you through: 

– Load your catch basins into the CatchBasin feature layer deployed with the 
solution. 

– Set up a user table in ArcGIS Enterprise to store program participants. 

– Publish the authentication geoprocessing webtool. 

– Configure the Adopt-A-Catch Basin app. 

 

Contact participants 
Use the ArcGIS Pro project to configure tools necessary for contacting participants in the Adopt-

A-Catch Basin program. 

1. In the Tasks pane, expand the Contact participants task group. 
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  The Contact participants task group contains tasks help you contact program participants 
by sending bulk emails or contacting a selection of participants by local or attribute. 

2.  Follow the task instructions to configure the bulk email model with your SMTP 
server and contact participants. 

 

Configure the Adopt-A-Catch Basin site 
The Adopt-A-Catch Basin solution includes the Adopt-A-Catch Basin ArcGIS Hub site that your 

organization can configure with your branding and can use to share information about 

participating in the Adopt-A-Catch Basin program with the public. 

 

Update with organizational information 
After deploying the Adopt-A-Catch Basin solution, the Adopt-A-Catch Basin site layout only 

requires a few updates to fit your local context. Consider what information you already have and 

what you can most easily find. This information can include the following: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-
A-Catch Basin site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Statistics section listed under the title of the website.  

  The Catch Basins Adopted, Cleaned This Month, and Clogged Catch Basins statistics 
cards are already linked to the Adopt-A-Catch Basin solution’s CatchBasins_public feature 
layer. These stats automatically update as participants adopt catch basins and report 
cleanings and issues using the Adopt-A-Catch Basin app. 

5. Scroll to the Adopt a Catch Basin section, hover over the card and click settings 

button .  

6. Click the Adopt Catch Basin button and click Edit.  

7. Enter the Adopt-A-Catch Basin app published using the Adopt-A-Basin ArcGIS Pro 
project URL into the Link Destination text box and click Add Link button. 

  Tip: 

  Browse to the Adopt-A-Catch Basin app. Open the item page, click View Application, 
and copy the app URL. 

8. Scroll to the Frequently Asked Questions section, hover over the card and click 
the settings button, and update the questions and answers. 

9. Scroll to the Stormwater Data section, hover over the card and click the settings 
button, and in the site editor under Data update the category links using tags, 
categories, or groups that reference your open data. 
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10. To modify your site’s footer, click Customize Toggle  on the side panel. 

11. Click Footer.  

  A custom footer is already provided, and in most cases, it needs to be updated with your 
organization's branding, contact information, and social media references. 

12. Click the HTML text box. 

  The HTML window appears. 

13. Make the necessary changes and click Apply. 

14. Click Save. 

 

Share items with the public 
Several layer views, maps and apps included in the Adopt-A-Catch Basin solution must be 

shared with everyone so they can be accessed by the public on the Adopt-A-Catch Basin site. 

To share your adopt-a-catch basin items with everyone, use the guide below and complete the 

following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-
A-Catch Basin folder. 

2. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   CatchBasins_public 

  Web Map   Adopt-A-Catch Basin 

  Web Mapping Application   Adopt-A-Catch Basin 

  Site Application   Adopt-A-Catch Basin 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 

 

Deploy related solutions 
This site references content from the Citizen Problem Reporter solution. To deploy the Citizen 

Problem Reporter solution, follow the steps in the Deploy an ArcGIS Solutions section. 
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Update solution references 
This site references a solution deployed in the previous section. To update your site, complete 

the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-
A-Catch Basin site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Report a Problem section. 

5. Hover over the Submit Report card and click settings button . 

6. Click on the Submit Report button and click Edit. 

7. Enter the Citizen Problem Reporter app URL in the Link Destination text box and 
click Add Link button. 

  Tip: 

  Browse to the Citizen Problem Reporter app. Open the item page, click View 
Application, and copy the app URL. 

8. Hover over the Contact Call Center card, click the settings button and edit the 
phone numbers in the card or remove if not applicable. 

9. Click Save. 

 

Share items with the public 
Several layer views, maps and apps included in the Citizen Problem Reporter solution must be 

shared with everyone so they can be accessed by the public on the Adopt-A-Catch Basin site. 

To share your citizen problem reporter items with everyone, use the guide below and complete 

the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Citizen 
Problem Reporter folder. 

2. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   CitizenProblems_health 

  Feature Layer (hosted, view)   CitizenProblems_utility 

  Feature Layer (hosted, view)   CitizenProblems_blight 
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  Feature Layer (hosted, view)   CitizenProblems_road 

  Feature Layer (hosted, view)   CitizenProblems_animal 

  Feature Layer (hosted, view)   CitizenProblems_parktree 

  Feature Layer (hosted, view)   CitizenProblems_trash 

  Feature Layer (hosted, view)   CitizenProblems_landuse 

  Feature Layer (hosted, view)   CitizenProblems_snowice 

  Web Map   Health Problems 

  Web Map   Water / Sewer Problems 

  Web Map   Blight Problems 

  Web Map   Road Problems 

  Web Map   Animal Problems 

  Web Map   Park / Tree Problems 

  Web Map   Trash Problems 

  Web Map   Land Use Problems 

  Web Map   Snow / Ice Problems 

  Web Mapping Application   Citizen Problem Reporter 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 
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Adopta widget settings 
The Adopt-A-Catch Basin app uses the Adopta widget with preconfigured settings and actions. 

Optionally, you can modify and expand the Adopta widget’s settings to meet your organization's 

needs. Use the tables below to understand the Adopta widget's configuration settings and 

capabilities. 

 

Layer and Authentication settings 
The Layer and Authentication settings allow you to configure behaviors as well as the look and 

feel of the user interface. 

Setting Description 

Asset nickname 
field 

Field that stores the catch basin's nickname. 

Login screen 
message 

Message that appears when signing into the application. 

Additional 
signup field 

Fields in the UserTable to be displayed in the sign up form in addition to 
email—for example, add first and last name, address, and phone number. 

Show asset 
address 

Display the reverse geocoded address of a catch basin in the details view. 

Asset highlight 
color 

Color of selection symbol displayed around the catch basin symbol when it is 
selected on the map. 

Tolerance 
setting 

New catch basins are created if no asset is found within the tolerance. 

My asset 
symbol 

Choose a symbol and set the size of user-adopted catch basins. 

 

Actions 
The primary actions used for the Adopt-A-Catch Basin app are assign (Adopt) and unassign 

(Opt out). You can configure additional actions as needed. 

Setting Description 

Assign status 
settings 

Allows you to label the button (Adopt) in the asset detail view and specify 
additional actions that occur after clicking the assign status button. 

Unassigned 
status settings 

Allows you to configure the unassigned label (Abandoned) in the asset 
detail view and specify additional actions that occur after clicking the 
unassigned label. 

Additional status 
settings 

Allows you add additional actions you want adopters to report on—for 
example, a damaged catch basins. 

Primary Status Displays text and status buttons in the Adopta application—for example, Is 
the catch basin cleaned? 
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Before action 
image 

Image that is displayed before performing an action. 

After action image Image that is displayed after performing an action. 

 

Messages 
The Adopt-A-Catch Basin app displays messages based on user interaction—for example, 

Thank you for adopting catch basin name. You can modify messages or create additional 

messages according to your organization’s needs. 

Setting Description 

Assign Message displayed when an asset is successfully assigned. Use 
'${assetTitle}', for example, to display the title of asset in message. 

Unassign Message displayed when an asset is successfully unassigned. 

Action Message displayed when action is successfully completed. Use 
'${actionName}', for example, to display the name of action in message. 

Asset not found Message displayed when asset is not found. 

Asset already 
assigned 

Message displayed when asset is already assigned. Use '${assetTitle}', 
for example, to display the title of asset in message. 

Unable to perform 
action 

Message displayed when action is not successful. Use ${actionName}, 
for example, to display the name of the action message. 

Asset creation Message displayed when creating a new asset. Use ${layerName}, for 
example, to display the name of the layer in message. 

Create asset failed Message displayed when asset creating fails. 

User token expired Message displayed when user token is expired and generated. 

Signup/Login 
success 

Message displayed after successful sign up or log in. 

Home screen (when 
logged in) 

Message displayed in widgets home screen after user logs in to the 
application. 

Cursor tooltip before 
login 

Message displayed when the user hovers over the map with their 
pointer before signing in to the application. 

Cursor tooltip after 
login 

Message displayed when the user hovers over the map with their 
pointer after signing in to the application. 

Nickname hint The text displayed in the nickname hint text box. 
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Use Adopt-A-Catch Basin 
The Adopt-A-Catch Basin solution delivers a set of capabilities that help you engage volunteers 

to keep catch basins clear of debris and functioning properly, manage participants, and monitor 

the adoption program. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Adopt a catch basin 
You’ll assume the role of a resident in the community who wants to participate in your city’s 

adopt-a-catch basin program. You’ll use the Adopt-A-Catch Basin app to adopt a catch basin 

near your home and report its condition. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Adopt-A-
Catch Basin solution. 

2. View the Adopt-A-Catch Basin site. 

3. Scroll to the Adopt a Catch Basin section, and click the Adopt Catch Basin 
button to open the Adopt-A-Catch Basin app. 

4. Enter your email in the Enter email address text box and click Login/Sign Up to 
sign up and begin the adoption process. Enter your contact details in the 
subsequent form and click Sign Up. 

  The Adopt-A-Catch Basin app sends an email with program details and a link you will use 
to log in to the app. 

5. In the email, click Login. 

  Returning users also receive an email with a link used to sign in to the app. 

  The Adopt-A-Catch Basin app opens in a browser with your newly created user 
authenticated. Notice the instructions to select a catch basin on map to adopt. 

6. Select an available catch basin to adopt (the green symbols on the map). 
Optionally, add a nickname to your catch basin in the text box. Click Adopt Catch 
Basin. 

  Adopt-A-Catch Basin displays a thank you message. The Adopt-A-Catch Basin pane 
displays your adopted catch basin and allows you to report the condition of the catch basin 
(for example, cleaned, clogged, or damaged), or abandon the catch basin. You can use the 
Adopt-A-Catch Basin app to regularly report cleanings and condition. 
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Manage adoptions and participants 
You are now a public works agency employee managing the catch basing adoption program. 

You will use Adopt-A-Catch Basin Manager to resolve reported issues and contact program 

participants. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Adopt-A-
Catch Basin solution. 

2. View the Adopt-A-Catch Basin Manager app. 

3. In the app, click the Last Known Condition column filter.  

4. Click Last Known Condition drop-down arrow and choose Damaged to view all 
reported damaged catch basins. 

5. Click one of the catch basins to view its details. 

  Public Works has repaired the catch basin. You'll use the Adopt-A-Catch Basin Manager 
app to contact the adopter to let them know the catch basin has been repaired. 

6. Click the Email Adopter button in the lower left corner of the app. 

  Adopt-A-Catch Basin Manager opens your email client and presents a preformatted 
subject. 

7. In the app, click the Edit button . 

8.  Click the Last Known Condition drop-down arrow to No Issues. 

9. Click Save. 

10. Optionally, click the Manage User’s Catch Basin button to open the Adopt-A-
Catch Basin app and manage the catch basins adopted by the selected user. 

  You can use this workflow to remove an adopter from a catch basin, making it available for 
adoption. 

   

Monitor the program 
You will continue your role as a public works employee, this time looking to monitor the Adopt-

A-Catch Basin program. You will use the Adopt-A-Catch Basin Dashboard to review key metrics 

and trends. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Adopt-A-
Catch Basin solution. 

2. View the Adopt-A-Catch Basin Dashboard app. 

  The Adopt-A-Catch Basin Dashboard displays new adoptions and cleaning charts by 
month and provides management a quick view of program activity over time. 

3. On the Overview tab, review the high-level metrics. 

4. Click the Catch Basin tab at the bottom of the dashboard. 

5. Click the arrow on the left of the app to display additional filters. 

6. Use the filters in the left panel to explore catch basin status, condition, visibility and 
last cleaned.  
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  Tip: 

  Dashboard charts are linked. If you click on a month in either New Adoptions by Month 
or Cleanings by Month charts, related details are filtered and updated in other elements 
in the dashboard. 

7. Select a catch basin from the Catch Basins list or the map to view key details. 
Optionally, click the Manage Asset button in the pop-up to launch the Adopt-A-
Catch Basin Manager app. 

 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 48 

Adopt-A-Stop 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Adopt-A-Stop 
Adopt-A-Stop can be used to operate stop adoption programs that allow volunteers to adopt 

transit stops and clean them for the community. 

A transit ride begins and ends at a stop, and a rider’s overall experience includes not only the 
ride, but their time spent at transit stops. Adopt-A-Stop programs seek to improve this 
experience and reduce maintenance costs by leveraging individual volunteers and organizations 
to clean transit stops. Program volunteers are typically asked to inspect their stops, remove 
trash, and report graffiti or serious damage at regular intervals. This simple action has a big 
impact on rider satisfaction, safety around the stop and the quality of life in a neighborhood. 
Adopt-A-Stop is typically implemented by transit agencies that want to engage the community 
and maximize the capacity of operations staff. 

The Adopt-A-Stop solution delivers a set of capabilities that help you engage volunteers to keep 
transit stops clean, manage participants, and monitor the performance of the adoption program. 

 

Requirements 
Adopt-A-Stop requires the following: 

• ArcGIS Enterprise 

• ArcGIS Web AppBuilder (Developer Edition) 2.11 or later 

• ArcGIS Pro 2.5 or later (Basic, Standard, or Advanced) 

• SMTP Server 

 

Information products 
Adopt-A-Stop includes the following information products: 

Item Description Minimum user type 

Adopt-A-Stop An ArcGIS Hub site used by the general public to 
learn how to get involved in the Adopt-A-Stop 
program 

Not required 
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Adopt-A-Stop An ArcGIS Pro project package used by transit 
personnel to configure the Adopt-A-Stop app and 
publish supporting web tools to ArcGIS Enterprise 

GIS Professional 
Standard with Web tool 
publisher permission 

Adopt-A-Stop 
Manager 

A Crowdsource Manager app used by transit 
personnel to manage Adopt-A-Stop participants 

Editor 

Adopt-A-Stop 
Dashboard 

An ArcGIS Dashboards app used by transit 
personnel to monitor the Adopt-A-Stop program 

Viewer 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Adopt-A-Stop 

 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 50 

Configure Adopt-A-Stop 
Learn how to configure the Adopt-A-Stop solution to meet specific needs in your organization. 

 

Publish the Adopt-A-Stop app 
The Adopt-A-Stop solution includes an ArcGIS Pro project used to publish the Adopt-A-Stop 

app. When you are ready to publish the app, a series of tasks are included to help you get 

started. 

 

Get started 
Use the ArcGIS Pro project to familiarize yourself with Adopt-A-Stop. 

1. Sign in to your ArcGIS organization and browse to the Adopt-A-Stop Project 
Package. 

2. Open the item page and click Download. 

3. Browse to and open the Adopt-A-Stop project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Adopt-A-Stop 
task. 

6. In the Tasks pane, expand the Getting to Know Adopt-A-Stop task group. 

7. Double-click Understanding Adopt-A-Stop task to review it. 

 

Configure Adopt-A-Stop 
Use the ArcGIS Pro project to set up Adopt-A-Stop. 

1. In the Tasks pane, expand the Configure Adopt-A-Stop task group. 

2. Use the Configure Adopt-A-Stop task group to access several tasks that guide 
you through: 

– Load your transit stops into the AdoptAStops feature layer deployed with the 
solution. 

– Set up a user table in ArcGIS Enterprise to store program participants. 

– Publish the authentication geoprocessing webtool. 

– Configure the Adopt-A-Stop app. 

 

Contact participants 
Use the ArcGIS Pro project to configure tools necessary for contacting participants in the Adopt-

A-Stop program. 

1. In the Tasks pane, expand the Contact participants task group. 

  The Contact participants task group contains tasks to help you contact program 
participants by sending bulk emails or contacting a selection of participants by local or 
attribute. 
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2.  Follow the task instructions to configure the bulk email model with your SMTP 
server and contact participants. 

 

Configure the Adopt-A-Stop site 
The Adopt-A-Stop solution includes the Adopt-A-Stop ArcGIS Hub site that your organization 

can configure with your branding and can use to share information about participating in the 

adopt-a-stop program with the public. 

 

Update with organizational information 
After deploying the Adopt-A-Stop solution, the Adopt-A-Stop site layout only requires a few 

updates to fit your local context. Consider what information you already have and what you can 

most easily find. This information can include the following: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-
A-Stop site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Statistics section listed under the title of the website.  

  The Stops Adopted and Cleaned This Month statistics cards are already linked to the 
Adopt-A-Stop solution’s AdoptAStops_public feature layer. These stats automatically 
update as participants adopt stops and report cleanings using the Adopt-A-Stop app. 

  The Volunteers stat is provided in a text card but styled to resemble the Summary 
Statistics card; this allows you the option to manually enter a statistic of your choice, 
independent of the solution data. Update the Volunteers stat card with the number of 
program participants, a metric of your choice, or replace the text card with a Summary 
Statistics card and connect it to the AdoptAStops_public feature layer in a similar fashion 
to the other dynamic stat cards. 

5. Update the Volunteers card, hover over the card, click the settings button , 
and then update the text. To add a Summary Statistics card onto the existing row, 
see Display key metrics section in the Insert charts, tables, and metrics topic. Once 
the card has been added to the row, hover over the existing Volunteers card and 

click the delete button . 

6. Scroll to the Adopt a Stop section, hover over the card and click the settings 
button. 

7. Click the Adopt Stop button and click Edit. 

8. Enter the Adopt-A-Stop app URL published using the Adopt-A-Stop ArcGIS Pro 
project into the Link Destination text box and click Add Link. 
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  Tip: 

  Browse to the Adopt-A-Stop app. Open the item page, click View Application, and copy 
the app URL. 

9. Scroll to the Frequently Asked Questions section, hover over the card and click 
the settings button, and update the questions and answers. 

10.  On the side panel, click Footer. 

  A custom footer is already provided, and in most cases, it needs to be updated with your 
organization's branding, contact information, and social media references. 

11. Click the HTML text box. 

  The HTML window appears. 

12. Make the necessary changes and click Apply. 

13. Click Save. 

 

Share items with the public 
Several layer views, maps and apps included in the Adopt-A-Stop solution must be shared with 

everyone so they can be accessed by the public on the Adopt-A-Stop site. To share your adopt-

a-stop items with everyone, use the guide below and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-
A-Stop folder. 

2. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   AdoptAStops_public 

  Web Map   Adopt-A-Stop 

  Web Mapping Application   Adopt-A-Stop 

  Site Application   Adopt-A-Stop 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 
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Deploy related solutions 
This site references content from the Transit Outreach solution. To deploy the Transit Outreach 

solution, follow the steps in the Deploy an ArcGIS Solutions section. 

 

Update solution references 
This site references a solution deployed in the previous section. To update your site, complete 

the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-
A-Stop site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Report a Problem section, hover over the card, and click the settings 

button . 

5. Click the Submit Report button and click Edit. 

6.  Enter the Transit Rider Reporter app URL deployed in the Transit Outreach 
solution in the Link Destination text box and click Add Link. 

  Tip: 

  Browse to the Transit Rider Reporter app. Open the item page, click View Application, 
and copy the app URL. 

7. Edit the phone numbers in the Contact Call Center section or remove if not 
applicable. 

8. Click Save. 

 

Share items with the public 
Several layer views, maps and apps included in the Transit Outreach solution must be shared 

with everyone so they can be accessed by the public on the Adopt-A-Stop site. To share your 

transit outreach items with everyone, use the guide below and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Transit 
Outreach folder. 

2. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   TransitRiderReports_public 

  Form   Transit Rider Reporter 
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3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 

 

Adopta widget settings 
The Adopt-A-Stop app uses the Adopta widget with preconfigured settings and actions. 

Optionally, you can modify and expand the Adopta widget’s settings to meet your organization's 

needs. Use the tables below to understand the Adopta widget's configuration settings and 

capabilities. 

 

Layer and Authentication settings 
The Layer and Authentication settings allow you to configure behaviors as well as the look and 

feel of the user interface. 

Setting Description 

Asset nickname 
field 

Field that stores the stop's nickname. 

Login screen 
message 

Message that appears when signing in to the application. 

Additional 
signup field 

Fields in the UserTable to be displayed in the sign up form in addition to 
email—for example, add first and last name, address, and phone number. 

Show asset 
address 

Display the reverse geocoded address of a stop in the details view. 

Asset highlight 
color 

Color of selection symbol displayed around the stop symbol when it is 
selected on the map. 

Tolerance 
setting 

New stops are created if no asset is found within the tolerance. 

My asset 
symbol 

Choose a symbol and set the size of user-adopted stops. 

 

Actions 
The primary actions used for the Adopt-A-Stop app are assign (Adopt) and unassign (Opt out). 

You can configure additional actions as needed. 

Setting Description 

Assign status 
settings 

Allows you to label the button (Adopt) in the asset detail view and specify 
additional actions that occur after clicking the assign status button. 
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Unassigned 
status settings 

Allows you to configure the unassigned label (Abandoned) in the asset 
detail view and specify additional actions that occur after clicking the 
unassigned label. 

Additional status 
settings 

Allows you add additional actions you want adopters to report on—for 
example, damaged stops. 

Primary Status Displays text and status buttons in the Adopta application—for example, Is 
the stop cleaned? 

Before action 
image 

Image that is displayed before performing an action. 

After action image Image that is displayed after performing an action. 

 

Messages 
The Adopt-A-Stop app displays messages based on user interaction—for example, Thank you 

for adopting stop name. You can modify the messages or create additional messages 

according to your organization’s needs. 

Setting Description 

Assign Message displayed when an asset is successfully assigned. Use 
'${assetTitle}', for example, to display the title of asset in message. 

Unassign Message displayed when an asset is successfully unassigned. 

Action Message displayed when action is successfully completed. Use 
'${actionName}', for example, to display the name of action in message. 

Asset not found Message displayed when asset is not found. 

Asset already 
assigned 

Message displayed when asset is already assigned. Use '${assetTitle}', 
for example, to display the title of asset in message. 

Unable to perform 
action 

Message displayed when action is not successful. Use ${actionName}, 
for example, to display the name of the action message. 

Asset creation Message displayed when creating an asset. Use ${layerName}, for 
example, to display the name of the layer in message. 

Create asset failed Message displayed when asset creating fails. 

User token expired Message displayed when user token is expired and generated. 

Signup/Login 
success 

Message displayed after successful sign up or log in. 

Home screen (when 
logged in) 

Message displayed in widgets home screen after user logs into the 
application. 

Cursor tooltip before 
login 

Message displayed when the user hovers over the map with their 
pointer before logging in to the application. 

Cursor tooltip after 
login 

Message displayed when the user hovers over the map with their 
pointer after logging in to the application. 

Nickname hint The text displayed in the nickname hint text box. 
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Use Adopt-A-Stop 
The Adopt-A-Stop solution delivers a set of capabilities that help you engage volunteers to keep 

transit stops clean, manage participants, and monitor the performance of the adoption program. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Adopt a stop 
First, you’ll assume the role of a transit rider who wants to participate in your local transit 

agency’s adopt-a-stop program. You’ll use the Adopt-A-Stop app to submit an adoption request 

and report the stop is clean. 

1. In a browser, from the Adopt-A-Stop solution, view the Adopt-A-Stop site. 

2. Scroll to the Adopt-A-Stop section, and then click Adopt Stop to open the Adopt-
A-Stop app. 

3. In the panel on the right, type your email address, and then click Login/Sign Up to 
sign up and begin the adoption process. 

4. In the form, type your contact details, and then click Sign Up. 

  The Adopt-A-Stop app sends an email with program details and a link that you will use to 
log in to the app. 

5.  In the email, click Login. 

  Returning users also receive an email with a link used to sign in to the app. 

  The Adopt-A-Stop app opens in a browser with your newly created user authenticated. 
Notice the instructions to select a stop on map to adopt. 

6. Select an available stop to adopt (the gray symbols on the map). Optionally, add a 
nickname to your stop in the text box. Click Adopt. 

  Adopt-A-Stop displays a thank you message. The Adopt-A-Stop pane displays your stop as 
Adoption Pending and allows you to report if the stop is clean or to opt out of adopting the 
stop. You can use the Adopt-A-Stop app to regularly report cleanings. 

   

Manage adoptions and participants 
You are now a transit agency employee managing the stop adoption program. You will use the 

Adopt-A-Stop Manager app to approve adoption requests and contact program participants. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Adopt-A-
Stop solution. 

2. View the Adopt-A-Stop Manager app. 
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  Pending and adopted stop requests are listed in the table at the top. The table can be 
sorted and filtered in various ways. 

3. In the table, click the Adoption Status column filter, and then for Status is, choose 
Pending. 

4. Click the Date Adopted column header and choose Sort in descending order. 

  The pending adoption requests are now listed with the most recent request at the top. 

5. Select a pending adoption request from the table. 

  The map selects the stop and zooms to the appropriate location, and the request details 
open at the bottom left. 

6. Review the details. 

7. In the details, click the participant’s email address to share information about your 
Adopt-A-Stop program with the participant. 

  Adopt-A-Stop Manager opens your email client and presents a preformatted subject. 

  After contacting the participant, you are ready to approve the adoption request. 

8. In the Adopt-A-Stop Manager app, in the request details, click the Edit record 

button . 

9. For Adoption Status, choose Adopted.  

10. Optionally, modify the nickname to ensure it is appropriate to be displayed in 
Adopt-A-Stop app. 

11. Click Save. 

12. Optionally, click a record in the table, and then in its details, click Manage 
Adopter’s Stops to launch the Adopt-A-Stop app and manage the stops adopted 
by the selected user.  

  You can use this workflow to remove an adopter from a stop, making it available for 
adoption. 

   

Monitor the program 
You will continue your role as a transit agency employee, this time looking to monitor the Adopt-

A-Stop program. You will use the Adopt-A-Stop Dashboard to review key metrics and trends. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Adopt-A-
Stop solution. 

2. View the Adopt-A-Stop Dashboard app. 

  The Adopt-A-Stop Dashboard displays new adoptions and cleaning charts by month and 
provides management a quick view of program activity over time. 

3. On the left, adjust filters to explore transit stop status, type, date adopted and last 
cleaned.  
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  Note: 

  Dashboard charts are linked. If you click a month in either New Adoptions by Month or 
Cleanings by Month charts, related details are filtered and updated in other elements in 
the dashboard. 

4. On the right, select a stop from the list to view key details. Alternatively, click a stop 
on the map.  

5. Optionally, in a pop-up, click Manage Stop in the pop-up to launch the Adopt-A-
Stop Manager app.  
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Agricultural Best Management Practices 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Agricultural Best Management 

Practices 
Agricultural Best Management Practices can be used to enroll agricultural producers in best 

management practice programs and monitor the success of those programs. 

It simplifies the enrollment and verification process in best management practice programs and 
helps agriculture agencies promote efficient water resource practices. Monitoring enrollment 
and verification data in near real time allows program managers to target outreach efforts where 
they are needed to ensure water quality for everyone. Agricultural Best Management Practices 
is typically implemented by agriculture agencies and other government agencies that want to 
increase participation in best management practice programs. 

The Agricultural Best Management Practices solution delivers a set of capabilities that help you 
enroll participants in best management practices (BMP) programs, verify those participants, and 
analyze trends in BMP programs. 

 

Requirements 
Agricultural Best Management Practices requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 

• Survey123 Connect 

 

Information products 
Agricultural Best Management Practices includes the following information products: 

Item Description 
Minimum 
user type 

Best Management 
Practice Dashboard 

An ArcGIS Dashboards app used by program 
managers to evaluate BMP program status with policy 
makers, stakeholders, and the public 

Viewer 

BMP Enrollment 
Status 

An ArcGIS Dashboards app used by agriculture staff to 
monitor BMP enrollment and verification status 

Viewer 
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BMP Enrollment 
Survey 

An ArcGIS Survey123 form used by mobile workers to 
enroll agriculture producers in BMP programs 

Field Worker 

BMP Verification 
Survey 

An ArcGIS Survey123 form used by mobile workers to 
validate BMP programs in the field 

Field Worker 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Agricultural Best Management Practices 

 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 62 

Configure Agricultural Best Management 

Practices 
In this topic, you will learn how to configure the Agricultural Best Management Practices solution 

to meet specific needs in your organization. 

 

Load data 
Agricultural Best Management Practices can be used to enroll and verify agricultural producers 

in best management practice programs and monitor the success of those programs. In some 

cases, you may already have this information in ArcGIS or another business system. 

Review the layers provided with the solution and determine what source data you want to load. 
Then, load your existing data into the layers provided with the ArcGIS Solution before sharing 
the maps or applications. 

Once you have determined what source data must be loaded, complete the data loading 
workflow below. 

 

Load data from a shapefile 
Load data for the BMPEnrollments and BPMProgramSummary feature layers from a shapefile 

by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you wish to populate. 

3. On the feature layer item details page, Click Update Data and select Append Data 
to Layer. 

4. Under Filename, click Choose File. 

5. Navigate to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you wish to load data into and the layer that contains the 
updated data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Use Agricultural Best Management Practices 
The Agricultural Best Management Practices solution delivers a set of capabilities that help you 

enroll participants in best management practices (BMP) programs, verify those participants, and 

analyze trends in BMP programs. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Manage BMP programs 
The BMP Enrollment Survey can be used by program managers to enroll agricultural producers 

in BMP programs. The BMP Verification Survey verifies that best management practices are 

being followed, while the BMP Enrollment Status dashboard can be used to track participation 

and understand participation trends. 

 

Enroll participants 
You will assume the role of a mobile worker enrolling agricultural producers in BMP programs. 

1. Download ArcGIS Survey123 to a mobile device, if necessary. 

2. On the mobile device, open the app, and then open the BMP Enrollment Survey 
form. 

3. Tap Collect. 

4. Complete the survey with as much information as possible. 

5. Tap the check mark, and then tap Send Now to submit the form. 

 

Verify participants 
You will assume the role of a mobile worker verifying agricultural producers enrolled in BMP 

programs are adhering to best management practices. 

1. On a mobile device, in ArcGIS Survey123, open the BMP Verification Survey. 

2. Tap Inbox and, if no surveys appear, tap Refresh. 

3. Find your site in the list or tap Map to find sites near you.  

4. After you find your site, tap it to open the survey. 

5. Scroll to the Verification of Implementation section and update the information. 

6. Tap the check mark, and then tap Send Now. 
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Monitor participation 
You will assume the role of a BMP manager monitoring enrollment and verification trends in 

your BMP program. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Agricultural Best Management Practices solution. 

2. View the BMP Enrollment Status app. 

3. Use the dashboard to visualize your data. 

 

Use best management practices metrics 
The Best Management Practice Dashboard can be used by policy makers and constituents to 

understand overall program metrics for watersheds, counties, or legislative boundaries. It is 

typically used to understand how BMP programs are improving water quality, the total number 

of producers, and acres enrolled in BMP programs. 

 

Monitor best management practices metrics 
You will assume the role of a BMP manager monitoring the impact programs are having. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Agricultural Best Management Practices solution. 

2. View the Best Management Practice Dashboard. 

3. Use the dashboard to visualize your data. 
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Business Resilience 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Business Resilience 
Business Resilience can be used to better understand the current status of asset locations. 

Organizations focus on allowing key leaders to have constant awareness of threats to the 
organization. Security and risk teams must be able to have one location that visually 
communicates information to allow decision makers to take action when a threat occurs or a 
status changes at a location. Analysts must create assessment reports based on threats or 
changes to the facility and be able to share these assessments with key leadership at the facility 
level and up to the C-suite level for actionable decision making. Business Resilience is typically 
implemented by organizations that want to take a proactive, data-driven approach to plan, 
manage, and enhance current business operations. 

The Business Resilience solution delivers key leadership the ability to share the status of retail 
stores, manufacturing plants, and other facilities. The solution provides the ability to understand 
and update the current status and review and share operational assessments to key leaders. 

 

Requirements 
Business Resilience requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 Connect 

 

Information products 
Business Resilience includes the following information products: 

Item Description 
Minimum 
user type 

Business Resilience 
Web App 

An ArcGIS Web AppBuilder app used by analysts to 
understand, manage, and maintain the operational 
status of an organization 

Editor 

Operational 
Assessment Survey 

An ArcGIS Survey123 form app used by facility 
managers to report the facility status 

Editor 
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Facility Manager An ArcGIS Web AppBuilder app used by analysts to 
maintain an organization's facility information 

Editor 

FacilitySource An Excel document used to load and validate an 
authoritative list of facilities into ArcGIS 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • An update to the Operational Assessment Survey to support multiple 
images and automates contact data entry. 

• An update to the facility layer symbology. 
• An update to the facility and operational assessment layer schemas. 

1.0 • First release of Business Resilience 
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Configure Business Resilience 
In this topic, you will learn how to configure the Business Resilience solution to meet specific 

needs in your organization. 

 

Prevent duplicate records 
To support the updating of data using the Append Data to Layer and to ensure accurate 

statistics within the information products of the solution. You'll need to add an attribute index 

which applies a unique constraint to facility_id field in the facilities layer. 

To add an unique constraint, complete the steps below: 

1. Sign in to your ArcGIS Enterprise portal. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Facilities in the search box. 

4. On the left under Folders, click the folder Business Resilience was deployed to. 

5. On the right side of the page, click Facilities to view it details. 

6. Under the Layers section, click Facilities. 

7. In the URL section , click View. 

  A new tab opens into the ArcGIS REST Service Directory for this item. 

8. In the URL bar of the browser, edit the URL with the following changes: 

a. Add the word admin between /rest/ and /services/. (For example: 
ArcGIS/rest/admin/services/facilities.) 

b. Scroll to the bottom of the page and click on Add to Definition. 

c. A window appears where you will be entering JSON to add an index to the 
layer. 

d. In the text box , copy the following: 

  { 
"indexes" : [{ 
"name" : "facility_id_Index", 
"fields" : "facility_id", 
"isAscending" : false, 
"isUnique" : true, 
"description" : "" 
}] 
} 

e. Click Add To Layer Definition to commit update. 

  The following message will appear if add was successful. {"success": true} 

9. In the browser, return to the Facilities layer tab and click on the Data tab. 

10. Click the Fields and click on Facility ID. 

  This page reveals the properties for the facility_id field. Under Settings, the Unique field is 
set to Yes. 
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Load data 
Organizations can use Business Resilience as a source of information to understand risk to their 

company’s critical infrastructure. 

Facility information must be loaded before using the app. Use the FacilitySource file to organize 
facility information before loading it into ArcGIS. Ensure that you populate the Facility ID column 
with unique values in the FacilitySource file. 

Note: 

Each row in the FacilitySource Excel document must have a unique facility ID; otherwise, 
your data will not load correctly. 

In some cases, you may already have an inventory of facilities in ArcGIS. If you do, review the 
layers provided with the solution and determine what, if any, source data you would like to load. 
Then, load your existing data into the layers provided with the ArcGIS Solution before sharing 
the maps or applications. 

Note: 

If you need to load data into the solution, you may want to develop a source-target matrix to 
track how your source data will be loaded into the target layer or layers used in the solution. 

To load your facilities from a spreadsheet, complete the steps below: 

1. If necessary, sign in to your ArcGIS organization and browse to the FacilitySource 
item. 

2.  Open the item details page. 

3. Click Download. 

4. Edit the Excel file and populate your facility information in the document. 

  Note: 

  At a minimum, you need to provide a unique facility ID and the latitude and longitude for 
each facility in the FacilitySource file. If you don't have a unique ID, you can edit the 
Excel file and copy this formula into the first row of the facilityid column: 
=CONCATENATE("Facility-", TEXT(ROW(A1),"00000")). You can then drag the right 
corner of the cell downward to fill the formula for all facilities, giving each a unique ID. 

5.  In your ArcGIS organization, at the top of the site, click Content. 

6. On the My Content tab, type facilities in the search box. 

7. On the left under Folders, click the folder Business Resilience was deployed to. 

8. Click the item title for Facilities to view its details. 

9. Click Update Data and click Append Data to Layer. 

10. Under Filename, choose your spreadsheet. 

11. Click Upload and Continue. 

12. Under Choose the layer from FacilitySource.xlsx that contains the updated 
data, choose the spreadsheet Input Data.  
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13. Uncheck Update existing features 

  Note: 

  If features exist in the layer that you would like to update, do not uncheck. 

14. Click Show field matching to map the fields. 

  Note: 

  While field matching is auto mapped ensure that the fields are properly mapped. 

15. Click Apply Updates. 

 

Configure the survey form 
To show your facility information in the survey form, you will use ArcGIS Survey123 Connect to 

make necessary updates. Adding your facility information to the form enables an extra level of 

data validation to ensure that facility information is correct and the respondent’s questions are 

associated with the correct facility. 

 

Open the form using ArcGIS Survey123 Connect 
If Survey123 Connect is not already downloaded, you can find the download link on the ArcGIS 

Survey123 Resources page. 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Operational Assessment Survey in the search 

box. 

4. On the left under Folders, click the folder Business Resilience was deployed to. 

5. Click the item title for Operational Assessment Survey to view its details. 

6. Click Open in Survey123 and click Edit in Survey123 Connect. 

  ArcGIS Survey123 Connect opens. 

  Note: 

  If this is your first time opening ArcGIS Survey123 Connect, you may need to add your 
organization’s portal and sign in. To add the URL, click Settings. Then, in the Settings 
window, click Add Connection and paste the URL. Click OK. After adding the 
connection, click Sign in to sign in to your organization. Verify that the active connection 
is set to the correct URL. 

7. Click the Operational Assessment Survey form to download the survey. 

8. Click the Operational Assessment Survey form again to open the survey. 
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Update survey form with Facilities service URL 
The survey form is configured to pass values from the Facilities layer and populate questions 

based on a custom URL scheme using the facility ID. To get the URL for the facility layer, open 

your browser and complete the following steps. 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Facilities in the search box. 

4. On the left under Folders, click the folder Business Resilience was deployed to. 

5. Click the item title for Facilities to view its details. 

6. Under the Layers section, click Facilities. 

7. In the lower right section name URL, click the Copy button to copy to your 
clipboard. 

  Note: 

  The service URL should include the layer reference index /0. For example: 

  https://services9.arcgis.com/9S3xKDKM8mHbxXx/arcgis/rest/services/Facil
ities/FeatureServer/0 

8.  Paste the URL into a plain text document to keep it available and go back to 
ArcGIS Survey123 Connect. 

9. In the left pane, click Open XLSForm Spreadsheet. 

  An Excel window appears where you are presented with survey property settings. 

10. In the Survey tab, scroll to the right until you see the default column. 

11. In the row labeled facility_url, copy the URL of the survey from your text document 
and paste it into the cell for the default column. 

12. Save the Microsoft Excel spreadsheet and close it. 

13. In ArcGIS Survey123 Connect, click Publish in the left pane to publish the 
changes. 

 

Update the survey URL fields 
The Facilities feature layer is used in the Business Resilience Web App to map your facilities, 

display their data contained in the attribute table, and connect to the Operational Assessment 

Survey. Complete the steps below to add the survey URLs as attributes in the Facilities layer. 

 

Acquire the URL of the survey 
To get the URL of the survey, complete the following steps: 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 
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3. On the My Content tab, type Operational Assessment Survey in the search 

box. 

4. On the left under Folders, click the folder Business Resilience was deployed to. 

5. Click the item title for Operational Assessment Survey to view its details. 

6. Click Open in Survey123 > Open in Survey123 app. 

  Note: 

  A new tab opens, prompting you to open into Survey123 app. Click Cancel and remove 
"&open=native" from the URL to open survey directly into the browser. 

7. In the address bar of the browser, copy the survey URL, including the question 
mark and portalURL= statement. 

  Note: 

  For example, if the URL is as follows: 

  https://survey123.arcgis.com/share/aee97bcef4d24c9187da9590ec86b67c?por
talUrl=https://LearnGIS.maps.arcgis.com 

  This URL will be used to populate the survey URL attributes for the Facilities layer. 

8. Paste the URL into a plain text document to keep it available. 

 

Populate the Base Survey URL field 
To populate the Base Survey URL field, complete the following steps: 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Facilities in the search box. 

4. On the left under Folders, click the folder Business Resilience was deployed to. 

5. Click the item title for Facilities to view its details. 

6. Click the Data tab. 

  A table view of the layer appears. 

7. Scroll to the right until you see the Base Survey URL field. Click Base Survey 
URL and click Calculate. 

8. In the Calculate Field pane, click Arcade. 

9. In the Arcade calculator, type the following: 

   var BaseURL = ”” 

10. Copy the URL of the survey from your text document and paste it between the 
quotation marks. 

11. Add a new line and type the following: 

   return BaseURL 

12. Click OK. 
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  The string is added to each record in the Facilities layer’s Base Survey URL field. 

  Note: 

  This calculation must be manually run when new features added to the Facilities layer. 

 

Populate the Assessment Survey URL field 
To populate the Assessment Survey URL field, complete the following steps: 

1. Scroll to the right until you see Assessment Survey URL. Click Assessment 
Survey URL and click Calculate. 

2. In the Calculate Field pane, click Arcade. 

3. Copy and paste the Arcade expression into the expression box: 

  var BaseURL = $feature["base_survey_url"] 
var JoinedURL = BaseURL + "&field:survey_facility_id=" + 
UrlEncode($feature["facility_id"]) 
return JoinedURL 

4. Click OK. 

  The Assessment Survey URL field is populated with URLs that also have the field 
parameter set to the corresponding facility’s ID value. 

  Note: 

  This calculation must be manually run when new features added to the Facilities layer. 

 

Enable live data fields 
The Business Resilience Web App utilizes live data feeds that provide information about major 

hazards, such as severe weather, earthquakes, or hurricanes, that would likely impact assets, 

and it provides real-time content about these natural disasters. To use these feeds in the app, 

you first need to enable them in the app. 

Note: 

Real-time data is hosted in ArcGIS Living Atlas, an authoritative data catalog maintained by 
Esri. You can read more about live feeds in ArcGIS Living Atlas in the Putting the “Live” in 
Living Atlas of the World blog post. 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Business Resilience Web App in the search box. 

4. On the left under Folders, click the folder Business Resilience was deployed to. 

5. Click the item title for Business Resilience Web App to view its details. 

6. Click Edit Application. 
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  ArcGIS Web AppBuilder opens in edit mode. 

7. In the left pane, click the Attributes tab. 

8. In the Attribute pane, click Subscriber Content Access. 

  The map layers listed are all premium subscriber content that your organization has access 
to. Enabling this content consumes credits. Learn more about ArcGIS Online information 
on credits. 

9. Check each layer to enable the content. 

10. Click Save. 

  Now that the app is configured, you can view the live feeds. 

11. Click Launch to view the app. 
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Use Business Resilience 
In this topic, you will learn how to use the Business Resilience solution and the set of 

capabilities and features that it provides. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Visualize hazards 
There are a variety of hazards, such as severe weather, fires, earthquakes, and hurricanes, that 

have the potential to affect your facilities. Many organizations have large geographic footprints 

and may be impacted by a diverse array of natural hazards and threats. The Business 

Resilience solution allows an analyst in an operation center to monitor hazards that may 

threaten your facilities. 

To use the Business Resilience solution to visualize hazards, complete the following steps: 

1. In a browser, open the Business Resilience Web App. 

  On the right side of the app, the layers pane is divided into the following sections: 

– Organizational Assets 

– Weather Layers 

– Drought and Wildfires 

– Natural Disasters  

  In the Organizational Assets section of the Layers pane, the Operational Assessment 
Survey and Facilities layers are turned on by default. 

  Facilities are represented by point features that appear on the map and are symbolized to 
indicate their status. 

  The Operational Assessment Survey layer shows results of surveys that have been 
submitted by facility managers. 

2. In the upper right of the Weather Layers section, click the options menu and click 
Turn all layers on. 

  These layers contain real-time weather feeds, many of which are published by the National 
Weather Service. Use these layers to track potential severe weather threats to your 
facilities. 

  To see the symbology for these layers, you can expand them individually by clicking the 
arrows to the left of the layer visibility check boxes. 

3. To optionally view more details on each layer, click the options button and click 
Show item details. Otherwise, in the upper right of the Weather Layers section, 
click the options menu and click Turn all layers off. 
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  Tip: 

  You can also use keyboard shortcuts to turn groups of layers on or off and expand or 
collapse them. Press the Ctrl key and check the layer check box to turn layers on or off 
in the same level. Press the Ctrl key and click the arrow to expand or collapse a layer in 
the same level. 

4. In the upper right of the Wildfires and Active Fires section, click the options menu 
and click Turn all layers on. 

  These layers contain the latest up-to-date information on current and ongoing fire-related 
incidents. Areas suffering drought conditions may be at greater risk of wildfire, so these 
areas may pose an elevated risk to your facilities. Use these layers to track potential fire-
related threats to your facilities. 

  To see the symbology for these layers, you can expand them individually by clicking the 
arrows to the left of the layer visibility check boxes. 

5. To optionally view more details on each layer, click the options button and click 
Show item details. Otherwise, in the upper right of the Droughts and Wildfires 
section, click the options menu and click Turn all layers off. 

6. In the upper right of the Natural Disasters section, click the context menu to 
expand and click Turn all layers on. 

  These layers contain real-time feeds of the latest natural hazards, such as hurricanes and 
earthquakes. 

  To see the symbology for these layers, you can expand them individually by clicking the 
arrows to the left of the layer visibility check boxes. 

7. To optionally view more details on each layer, click the options button and click 
Show item details. Otherwise, in the upper right of the Natural Disasters section, 
click the options menu and click Turn all layers off. 

  Tip: 

  When you configure the Business Resilience Web App, you can include your own 
sections, groups, and layers. For example, if you are tracking threats to coastal facilities, 
you can create another section named Coastal Threats and include layers from the 
National Weather Service, such as High Surf Advisory, Areal Flood Warning, and 
Coastal Flood Watch. 

 

Send an assessment survey 
The role of an analyst in the operations center is to watch over the multitude of threats that may 

impact one or more assets within your organization. When a threat has been detected to 

potentially impact one or more facilities, it is imperative to alert the facility administrators of the 

possible impact and understand the potential effects of the even on the facility to minimize 

disruption. The Business Resilience Web App is configured to allow you to quickly send out an 

assessment to the facility manager. 
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Send an assessment to a single facility 
In this workflow, you will take on the role of an analyst who has be alerted to an event that is 

threatening a facility. You will be sending an assessment form to gather relevant information 

from the facility manager at the threatened facility. 

1. In a browser, open the Business Resilience Web App app if you do not have it open 
already. 

2. Select a facility of interest from the list on the left side of the application or zoom to 
the location of the facility and click the facility. 

  In the pop-up window, general details about the facility are provided. 

3. On the pop-up, in the Notes section, click the Click here to send Operational 
Assessment to Facility Administrator link. 

  An email opens in your email client. It is populated with the email address of the facility 
manager, the name of the manager, text requesting information about the event, and a 
hyperlink to a survey that the manager can use to reply with status information. 

4. Select the [INSERT EVENT DESCRIPTION AND DETAILS HERE] text in the 
email and add any other information that may be useful to the facility manager in 
evaluating the threat. 

5. Send the email to the manager. 

 

Send an assessment to multiple facilities 
In this workflow, you will take on the role of an analyst who has identified a hurricane event that 

is threatening multiple facilities. You will be sending assessments form to gather relevant 

information from the facility manager at the threatened facilities. 

1. In a browser, open the Business Resilience Web App if you do not have it open 
already. 

2. Select the Create Assessment Report widget in the upper right of the application, 
above the layers pane. 

3. With the Create Assessment Report widget open, define an area of interest by 
searching for a location in the Place Name tool or using the Draw tool. Click the 
Draw tool and click the Select by Rectangle button. 

4. Click Choose selectable layers to expand the layer list and select Hurricane Irma 
Example – Forecast Cone. Uncheck all other layers. 

  You can use the Choose selectable layer list to define the layers that are selectable on 
the map. 

5. On the map, drag a small box on the Hurricane Irma forecast cone feature. This 
selects the feature from the service, just as it would select a feature in a live 
Hurricane Forecast feed. 

6. Optionally, set a Buffer distance value to select facilities that are also within a 
distance from the selected feature, and click Report. 

  The report of facilities within the buffer around the forecast cone is generated. 

7. In the Create Assessment Report pane, click the Expand button next to 
Facilities to expand the list. 
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  The report contains information about each facility, including the facility ID, a survey link, 
the number of employees at the location, and the manager's name and email address. 

8. If you would like a CSV file of selected facilities, click the Download button. 

9. If you want a PDF report, click the Print button, choose a report layout size, and 
click the Print button to generate the report. 

10. In the header section of the report web page, click Print to save. 

  Tip: 

  You can get a list of all the email addresses from the downloaded CSV file of selected 
facilities. Find the email column and copy the facility manager email address to your 
clipboard, and paste it into your email client to send a report. 

 

Submit an assessment survey 
For an organization to assess impacts, facility managers can share relevant information about 

the operational status of their facility and the impact of a likely event. The Operational 

Assessment Survey allows facility managers to submit this information back to the operations 

center. The survey contains assessment questions about the exterior, interior, and employee 

vulnerability. This information allows decision makers to understand the threat, prioritize aid, 

and allocate supporting resources throughout the organization. 

In this workflow, you will take on the role of a facility manager at a threatened facility and use 
the survey link to send status information to the operations center. 

1. In a browser, open the Operational Assessment Survey. 

  This is a link to the survey for Facility #104. 

  Note: 

  The URL for the survey includes the facility ID. This ties the survey to a specific facility 
location and allows the survey to be populated with information about the facility, saving 
the manager time. 

  The survey opens in a browser tab. The Potential Impact Assessment section is open 
with a number of questions that you can answer to communicate your facility's status back 
to the operations center. 

2. Click the header for the top section, Facility Location Details. 

  The details for your facility are prepopulated in the survey. 

3. Complete the Potential Impact Assessment section. 

  Parameter 
  Value 

  External Vulnerablity   Select Low. 
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  Interior Vulnerablity   Select Negligible. 

  Employee Vulnerablity   Select Moderate. 

  Employee Vulnerablity Extent   Select 25% to 
50%. 

   Do you foresee the need to possibly temporarily 
close this location due to this event? 

  Select Maybe/Not 
Sure. 

   Is there a potential need for local evacuation?   Select No. 

   Describe any relevant information, thoughts, 
strategies, or issues 

  Type relevant 
information. 

4. Optionally, upload pictures of the facility and of any vulnerability concerns in the 
Media group to provide further context. 

5. Once the survey is completed, click the Submit button. 

 

Review assessments 
Upon submission of assessment reports, they appear as points on the map. The feedback in the 

survey is key to assessing the potential impact to the health and safety of customers, 

employees, and assets while also understanding how to facilitate resources and minimize 

interruptions. 

In this workflow, you will take on the role of the analyst in the command center reviewing an 
open submission by a facility manager. 

1. In a browser, open the Business Resilience Web App app. 

2. In the Facilities pane on the left side of the Business Resilience web app, expand 
the Assessment Status section if it is not already expanded. 

  This group contains a list of assessments by status with the latest submission at the 
bottom. 

3. Click the latest submission in the list. 

  The assessment is selected, and the pop-up appears on the map. 

4. On the pop-up, in the lower right corner, click the Options button and click Smart 
Editor. 

  The Review Assessments pane appears. You can see the responses the facility manager 
sent, describing the probable impact of the event on the facility. 

5. Review the information provided by the facility manager. 

6. Optionally, change the status from Open to Under Review. 

7. Click Save and close the Review Assessments pane. 
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  The assessment status changes to Under Review on the map and in the Assessment 
Status group. Once the review status is set to Closed, the assessment is removed from 
the list and the map. 

   

Modify operational status 
Upon review of an assessment, an analyst can modify the status of one or more facilities in the 

organization to reflect its current state for visual awareness. This is important when working with 

a team that needs to keep track of the overall operational impact to an organization and share 

the latest information with an executive audience. 

In this workflow, you will take on the role of the analyst in the command center updating the 
operational status of facilities to reflect their current state. 

1. In a browser, open the Business Resilience Web App if you do not have it open 
already. 

2. Zoom in on the map to the facility you want to update. 

3. Select the Modify Facility Status widget from the upper right of the application, 
above the layers pane. 

4. In the Modify Facility Status pane, click the Select by Rectangle button. 

5. Drag a box around the facility you want to modify. 

  The Modify Facility Status window appears with multiple drop-down buttons. 

  Note: 

  You can also select and update multiple facilities at the same time. 

6. Enter the following values for the parameters: 

  Parameter 
  Value 

  Notes   Manager reports local flooding with the power and gas 
service out. 

  Operating Status   Select Impacted. 

   Electric Service 
Status 

  Select Impacted. 

   Fire System Status   Select Operating. 

   HVAC Status   Select Operating. 

   Gas Service Status   Select Impacted. 
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   Water Service 
Status 

  Select Operating. 

7. Click Save. 

  The change in status updates the symbology of update facilities on the map as well as the 
Facilities list on the left side to reflect the current count of facilities by status. 
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Capital Project Planning 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Capital Project Planning 
Capital Project Planning can be used to define a project portfolio, organize the portfolio into an 

official capital improvement plan, and share the plan with internal and external stakeholders. 

High-quality infrastructure is essential to a community's economic vitality and quality of life. A 
good capital project planning process helps communities make smart infrastructure 
improvements and investments in their future. Governments may have hundreds of projects in 
their capital improvement plan (CIP) that range in cost from thousands to billions of dollars. 
Managing this CIP comes with inherent challenges that can impact the schedule, quality, and 
cost of infrastructure improvements. Capital Project Planning is typically implemented by 
government agencies and utilities that want an efficient way to manage and share a capital 
improvement plan. 

The Capital Project Planning solution delivers a set of capabilities that help you define capital 
project plans, coordinate project schedules with internal and external agencies, manage 
pavement moratoriums, organize a project portfolio into an official capital improvement plan, 
and share capital improvement plans with the public and other key stakeholders. 

 

Requirements 
Capital Project Planning requires the following: 

• ArcGIS Enterprise 

 

Information products 
Capital Project Planning includes the following information products: 

Item Description Minimum user type 

Capital Project 
Plans 

A Category Gallery app that includes a collection of 
ArcGIS Web AppBuilder apps used by project leads 
to organize new capital project plans and revise 
project information during the planning process 

Editor 

Capital Project 
Review 

A Crowdsource Manager app used by plan review 
staff to organize a project portfolio into an official 
capital improvement plan 

Editor 
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Capital Project 
Review 
Dashboard 

An ArcGIS Dashboards app used by plan review 
staff to examine proposed projects before inclusion 
in an official capital improvement plan 

Viewer 

External Agency 
Projects 

An ArcGIS Web AppBuilder app used by private 
utilities and external agencies to share capital 
projects planned for their respective infrastructure 

Editor 

Pavement 
Moratoriums 

An ArcGIS Web AppBuilder app used by 
engineering and operations staff to inventory 
moratoriums that preclude, or restrict, right-of-way 
activity on newly paved streets 

Editor 

Capital 
Improvement 
Plan 

An ArcGIS Experience Builder app used by the 
public and other interested parties to review 
projects included in the capital improvement plan 

Viewer (required if 
application is used for 
internal purposes 
only) 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • A new Capital Project Plans app. 

1.0 • First release of Capital Project Planning 

 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 83 

Use Capital Project Planning 
The Capital Project Planning solution delivers a set of capabilities that help you define capital 

project plans, coordinate project schedules with internal and external agencies, manage 

pavement moratoriums, organize a project portfolio into an official capital improvement plan, 

and share capital improvement plans with the public and other key stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Manage pavement moratoriums 
Engineering and operations staff of a local municipality are typically responsible for inventorying 

moratoriums that preclude or restrict right-of-way activity on newly paved streets. Moratoriums 

identified by staff are shared with municipal departments, private utilities, and other external 

agencies so that they can understand the impact of any work planned in the same right-of-way. 

You will assume the role of a municipality staff member and will use the Pavement Moratoriums 
app to create new and update existing pavement moratoriums. 

 

Add a pavement moratorium 
In this workflow, you will use the Pavement Moratoriums app to create a pavement moratorium. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Capital 
Project Planning solution. 

2. View the Pavement Moratoriums app. 

  The app opens with the Create Moratorium widget opened by default. 

3. On the map, use the search field to zoom to your area. 

4.  In the Create Moratorium widget, click the Pavement Moratoriums template, and 
then uncheck the Save new features automatically check box. 

  Note: 

  When Save new features automatically is checked, edits are automatically saved 
without opening the Pavement Moratoriums form. This option is useful when you want 
to digitize new features quickly. 

5. On the map, draw a new pavement moratorium. 

  A Pavement Moratoriums form opens on the right. 

6.  Complete the form with your moratorium information. 

7. Click Save to complete the pavement moratorium creation workflow. 
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Edit a pavement moratorium 
In this workflow, you will edit the details for an existing moratorium. 

1. In the Create Moratorium widget, unselect the Pavement Moratoriums template, 
if necessary. 

2. On the map, select the moratorium that you just created. 

  The Pavement Moratoriums form opens on the right. 

3. Revise the form information, and then click Save. 

 

Delete a pavement moratorium 
In this workflow, you will delete an existing moratorium from the app. 

1. In the Create Moratorium widget, unselect the Pavement Moratoriums template, 
if necessary. 

2. On the map, select the moratorium that you just created. 

  The Pavement Moratoriums form opens on the right. 

3. Click Delete, and then confirm the deletion. 

  Note: 

  If you plan to complete subsequent workflows, ensure that you leave at least one 
moratorium in the app. 

 

Create and share project plans 
Capital projects, typically defined for water, sewer, stormwater, parks, facility, and transportation 

assets in a community, can be visualized together with external agencies' projects when the 

agencies plan and schedule work for their respective infrastructure. Sharing this information 

helps identify potential project conflicts and can become the foundation for public-private 

partnership opportunities. 

Infrastructure project planning and coordination between municipalities and external agencies 
can be achieved by using the Capital Project Planning and External Agency Projects apps. 

 

Create and share external agency projects 
In this workflow, you will assume the role of a project lead from a private utility who is 

responsible for coordinating infrastructure development and improvement activities with the 

local municipality. You will use the External Agency Projects app to gain insight into existing 

external projects and pavement moratoriums and to enter new project information. 

The updates that you provide in the External Agency Projects app will be immediately available 
to the municipality plan review team and will aid in their coordination of schedules of planned 
projects. 
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1. In a browser, sign in to your ArcGIS organization, and then browse to the Capital 
Project Planning solution. 

2. View the External Agency Projects app. 

  The app opens with the Sort Projects widget opened by default. This widget allows you to 
search for and filter existing external agency projects by company name. 

3. To create a new external agency project, at the top right, click the Create Project 
button. 

  The Create Project widget opens. 

4. On the map, use the search field to zoom to your area. 

5. In the Create Project widget, click the External Agency Projects template, and 
then uncheck the Save new features automatically check box. 

  Note: 

  When Save new features automatically is checked, edits are automatically saved 
without opening the Pavement Moratoriums form. This option is useful when you want 
to digitize new features quickly. 

6. On the map, draw a new external project boundary. 

  An External Agency Projects form opens on the right. 

7. Complete the form with your project information. 

8. Click Save to complete the external agency project creation workflow. 

 

Define capital project plans 
In this workflow, you will assume the role of a public works organization project lead who is 

responsible for organizing new capital project plans and revising project information during the 

planning process. You will use the Capital Project Plans app to gain insight into existing project 

plans, external agency projects, and pavement moratoriums and to create a project plan. 

After all relevant information has been added to the project plan and is ready for internal review, 
you will be able to share your plan with members of the coordinating body. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Capital 
Project Planning solution. 

2. View the Capital Project Plans app. 

  The Capital Project Plans app is a gallery that contains individual Capital Project Planning 
apps for water, sewer, stormwater, facilities, and transportation projects. 

3. Click the Sewer Project Plans app. 

  The app opens with the Create Plan widget opened by default. This widget allows you to 
create, edit, and delete sewer plans. 

4. On the map, use the search field to zoom to your area. 

5. To create a sewer project plan, in the Create Plan widget, click the Sewer 
Collection template. 

6. On the map, draw a new sewer project. 
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  A Sewer Project Plans form opens on the right. 

7.  Complete the form with your project information. 

  The Project Status parameter allows you to share your project in the Capital Project 
Review app with members of the coordinating body. 

8. To share your plan with members of review board, for Project Status, choose 
Analysis and Review. 

9. Click Save to complete the capital project plan creation workflow. 

  Tip: 

  Existing sewer project plans can also be edited or deleted. To edit or complete a plan, 
click the Sewer Collection template to unselect it, and then on the map, select an 
existing sewer project plan to enable the Sewer Project Plans form. In the form, you can 
edit plan information, update the feature's geometry, or delete the plan. 

 

Organize and review the project portfolio 
Many agencies have a coordinating body that is responsible for examining project proposals 

and preparing a consolidated list of projects that align with community goals and strategic 

priorities. 

Project-planning organization and review can be achieved using the Capital Project Review 
Dashboard and the Capital Project Review app. 

 

Review the portfolio of capital project plans 
In this workflow, you will assume the role of a member of the coordinating body that is 

responsible for reviewing proposed projects. You will use the Capital Project Review Dashboard 

to examine proposed projects, visualize project schedules, and summarize estimated costs. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Capital 
Project Planning solution. 

2. View the Capital Project Review Dashboard app. 

  On the right, any capital projects submitted for analysis and review are listed. 

  Tip: 

  If you do not have any projects listed, return to and complete the Define capital project 
plans workflow. 

3. On the left, adjust the filters to refine the capital project list by type, fiscal year, 
funding source, status, and planned start date. 

  Note: 

  Filter options will vary based on the types of projects submitted. 
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4. On the right, in the Capital Projects list, click the name of a capital project to zoom 
to it on the map. 

5. On the map, click a project to see a pop-up with more information about the project. 

6. If a proposed plan is ready for further review, click the Review Now button to 
launch the selected capital project plan within the Capital Project Review app. 

 

Organize the project portfolio into an official capital improvement plan 
In this workflow, you will assume the role of a member of the coordinating body that is 

responsible for reviewing proposed projects. You will use the Capital Project Review app to sort 

various key characteristics of a project and update project information, such as status, fiscal 

year, and funding sources, where appropriate. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Capital 
Project Planning solution. 

2. View the Capital Project Review app. 

  The same portfolio of projects from the Capital Project Review Dashboard are visible in this 
app. 

3. At the top, in the table, click a column head to sort and filter the project list by that 
key field. 

4. In the table, click a project to view its details.  

  The project details appear in the bottom left pane. If any items were attached when the 
project was created, you will see Details and Attachments tabs. 

5. Click the Details tab, and then click the Edit record button , if necessary. 

  As a decision maker, you can refine plan information such as funding source, fiscal year, 
project status and phase, and whether a project is funded. 

6. In the project details, click the Project Status drop-down arrow and choose Board 
Authorized, and then click the Funded Project drop-down arrow and choose Yes.  

  These settings ensure that the project will be included in the capital improvement plan 
(CIP). 

7. Click Save. 

  Because you have authorized the project and marked it as funded, it is no longer listed in 
the Capital Project Review app. 

 

Explore the capital improvement plan 
In this workflow, you will assume the role of a community member who is interested in learning 

more about projects being planned in your community and where they are located. You will use 

the Capital Improvement Plan app to review projects included in the capital improvement plan 

(CIP). 

1. In a browser, from the Capital Project Tracking solution, view the Capital 
Improvement Plan web experience app. 
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  Any projects that you authorized and marked as funded in the previous step appear in the 
Projects pane. 

2. In the left panel, under Type, check an option or options, and then set Planned 
Start Date filters to further explore and refine capital improvement plan results. 

  Note: 

  Filter options will vary based on the types of projects listed. 

3. In the Projects pane, click a project to zoom to it on the map and view project 
details. 

4. On the map, click the Home button to zoom to the full extent of the project map. 

  You can also use the map extent to filter results. 

5. Pan and zoom the map to refine the list of projects and project details. 
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Capital Project Tracking 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Capital Project Tracking 
Capital Project Tracking can be used to manage an active project portfolio, communicate project 

status, and share project updates with internal and external stakeholders. 

Managing a large project portfolio and quickly communicating progress is a challenge for 
government agencies and utilities. Many times, the lack of information leads to expensive 
project changes, budget overruns, frustrated executives and a disenfranchised public. 
Maintaining effective communication with internal and external stakeholders throughout the life 
cycle of a capital project increases transparency and strengthens public trust. It also assures 
stakeholders that public dollars are being spent effectively and improvements are being made in 
a timely manner. Capital Project Tracking is typically implemented by government agencies and 
utilities that want to proactively share the status of active capital projects with the communities 
they serve. 

The Capital Project Tracking solution delivers a set of capabilities that help you manage the 
status of active capital projects, track project performance, share project progress with internal 
stakeholders, and communicate investments being made with the public. 

 

Requirements 
Capital Project Tracking requires the following: 

• ArcGIS Enterprise 

 

Information products 
Capital Project Tracking includes the following information products: 

Item Description 
Minimum user 
type 

Maximizing 
Capital 
Expenditures 

An ArcGIS Hub site used by the public to learn more 
about public investments being made and how they 
can participate in the capital project planning process 

Not required 

Capital Project 
Dashboard 

An ArcGIS Experience Builder app used by internal 
and external stakeholders to monitor active capital 
projects 

Viewer (required for 
internal 
stakeholders) 
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Capital Project 
Reports 

A Crowdsource Manager app used by project leads 
to manage the status of active capital projects and 
communicate the schedule, quality, and cost to 
internal and external stakeholders 

Editor 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Capital Project Tracking 
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Configure Capital Project Tracking 
In this topic, you will learn how to configure the Capital Project Tracking solution to meet specific 

needs in your organization. 

 

Load capital projects 
The Capital Project Tracking solution is built on the same foundational feature layer, 

InfrastructureProjects, used in the Capital Project Planning solution. If you have also deployed 

the Capital Project Planning solution, you can use that solution to define project plans and 

organize your project portfolio into a capital improvement plan. Once projects have been 

approved and funded, they will display in the Capital Project Tracking solution. 

If you are using another system for project planning and want to use the Capital Project 
Tracking solution to report and share active projects with key stakeholders and the public, you 
will need to load these projects into the InfrastructureProjects feature layer. You will also need 
to update the Project Status, Funded Project, and Project Phase fields to make the projects 
visible in the Capital Project Reports and Capital Project Dashboard apps. 

Load data from a shapefile 
Capital projects can be loaded from a shapefile by completing the following steps: 

1. Create a .zip file of a shapefile of your capital projects. 

2. Sign in to your ArcGIS organization and browse to the InfrastructureProjects 
feature layer. 

3. Open the item page and click Update Data > Append Data to Layer. 

4. Click Choose File and browse to a .zip file containing the shapefile with your 

capital projects, and click Open. 

5. Click Upload and Continue. 

6. Click the Choose the layer that you wish to append data into drop-down arrow 
and choose the Infrastructure Projects. 

7. Uncheck Update existing features. 

8. Click Show field matching to map the fields. 

  Note: 

  The only required field is the projtype (Project Type) field. This is a text field that defines 
the type of project and supports the following values: Facilities, Parks, Sewer Collection, 
Stormwater Drainage, Transportation, Water Distribution, and Other. 

9. Click Apply Updates. 

  Tip: 

  To make additional updates to a hosted feature layer, see Append data to layers. 
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Update project attributes 
The Capital Project Reports and Capital Project Dashboard apps both use feature layer views to 

ensure only approved and funded projects are visible. Projects will only display in these apps if 

the Project Status is set to Board Authorized, Funded Project is set to Yes. And Project 

Phase is set to PreDesign, Design, Construction, or Closeout. 

To update the project attributes, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
InfrastructureProjects feature layer. 

2. Open the item page and click the Data tab. 

3. Click within a cell in the table and edit the attributes of the project. 

4. Click the column containing the values you want to update. 

5. Click Calculate. 

6. Click SQL. 

7. Enter the value you want to apply. For text fields, you need to surround the value 
with single quotes, for example, 'Board Authorized'. 

  Tip: 

  For more information, see Calculate field values. 

 

Configure the Maximizing Capital Expenditures site 
The Capital Project Tracking solution includes the Maximizing Capital Expenditures site that 

your organization can configure with your own branding and share important capital investment 

and planning information with the public. 

 

Update with organizational information 
After deploying the Capital Project Tracking solution, the Maximizing Capital Expenditures site 

layout only requires a few updates to fit your local context. Follow the steps below to update the 

site with your organization's needs: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Maximizing Capital Expenditures site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll down to the statistics section listed under the title of the website. The Capital 
Projects and Public Investment (dollars) statistics cards are already linked to the 
Capital Project Tracking solution’s InfrastructureProjects_allfundedprojects feature 
layer. These stats will automatically update as you load data into the feature layer. 

  The Public Workshops stat is provided in a text card but styled to resemble the Summary 
Statistics card; this allows you the option to manually enter a statistic of your choice, 
independent of feature layer data. Update the Public Workshops stat card using a metric 
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of your choice or replace the text card with a Summary Statistics card and connect it to the 
InfrastructureProjects_allfundedprojects feature layer in a similar fashion to the other 
dynamic stat cards. 

5. Scroll to the Meet the Capital Investment Planning (CIP) Committee section, 

hover over the row card and click the settings button  on the horizontal toolbar. 

6. Click Code View, replace the image URL with a URL of your image, and click 
Code View. 

7. Enter a new name and information Text card. 

8. Scroll to the Frequently Asked Questions section, hover over the card and click 
the settings button, and update the questions and answers. 

9. Scroll down to the Infrastructure Data section, hover over the card and click the 
settings button, and update the various category links using tags, categories, or 
groups that reference your ArcGIS Open Data. 

10. To modify your site’s footer, click Customize Toggle  on the side panel. 

11. Click Footer.  

  A custom footer is already provided, and in most cases, it needs to be updated with your 
organization's branding, contact information, and social media references. 

12. Click the HTML text box. 

  The HTML window appears. 

13. Make the necessary changes and click Apply. 

14. Click Save. 

 

Share items with the public 
Several layer views, maps and apps included in the Capital Project Tracking solution must be 

shared with everyone so they can be accessed by the public on the Maximizing Capital 

Expenditures site. To share your capital project tracking items with everyone, use the guide 

below and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Capital 
Project Tracking folder. 

2. Check the check box next to each of the items below: 

  Item 

  Name 

  Feature Layer (hosted, view)   InfrastructureProjects_allfundedprojects 

  Web Map   Capital Project Dashboard 

  Web Mapping Application   Capital Project Dashboard 
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  Site Application   Maximizing Capital Expenditures 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 

 

Deploy related solutions 
This site references content from the Participatory Budgeting, Capital Project Planning, and 

Citizen Problem Reporter solutions. To deploy these solutions, follow the steps in the Deploy an 

ArcGIS Solutions section. 

 

Update solution references 
This site has references to solutions deployed in the previous section. To update your site, 

complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Maximizing Capital Expenditures site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll down to the Report a Problem section, hover over the Submit a Report 

card and click the settings button . 

5. In the card, click the Submit Report button and click Edit. 

6. Enter the Citizen Problem Reporter app URL in the Link Destination text box and 
click Add Link button. 

  Tip: 

  Browse to the Citizen Problem Reporter app. Open the item page, click View 
Application, and copy the app URL. 

7. Hover over the Other Reporting Methods card and click the settings button. 

8. Enter a new phone number or remove if not applicable. 

9. Scroll down to the Planning Major Infrastructure Improvements section, hover 
over the card, and click the settings button. 

10. Click the Review Capital Improvement Plan button and click Edit. 

11. Enter the Capital Improvement Plan app URL deployed in the previous section (one 
of the apps deployed in the Capital Project Planning solution), and click Add Link. 
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  Tip: 

  Browse to the Capital Improvement Plan app. Open the item page, click View 
Application, and copy the app URL. 

12. Scroll down to the Do You Have a Project Idea section, hover over the card, and 
click the settings button. 

13. Click the Share my idea button and click Edit. 

14. Enter the Participatory Budgeting app URL deployed in the previous section (one of 
the apps deployed in the Participatory Budgeting solution) in the Link Destination 
text box and click Add Link. 

  Tip: 

  Browse to the Participatory Budgeting app. Open the item page, click View Application, 
and copy the app URL. 

15. Click Save. 

 

Share items with the public 
Several layer views, maps and apps included in the Citizen Problem Reporter, Capital 

Improvement Plan and Participatory Budgeting solutions must be shared with everyone so they 

can be accessed by the public on the Maximizing Capital Expenditures site. To share your items 

with everyone, use the guide below and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Citizen 
Problem Reporter folder. 

2. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   CitizenProblems_health 

  Feature Layer (hosted, view)   CitizenProblems_utility 

  Feature Layer (hosted, view)   CitizenProblems_blight 

  Feature Layer (hosted, view)   CitizenProblems_road 

  Feature Layer (hosted, view)   CitizenProblems_animal 

  Feature Layer (hosted, view)   CitizenProblems_parktree 
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  Feature Layer (hosted, view)   CitizenProblems_trash 

  Feature Layer (hosted, view)   CitizenProblems_landuse 

  Feature Layer (hosted, view)   CitizenProblems_snowice 

  Web Map   Health Problems 

  Web Map   Water / Sewer Problems 

  Web Map   Blight Problems 

  Web Map   Road Problems 

  Web Map   Animal Problems 

  Web Map   Park / Tree Problems 

  Web Map   Trash Problems 

  Web Map   Land Use Problems 

  Web Map   Snow / Ice Problems 

  Web Mapping Application   Citizen Problem Reporter 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 

6. Browse to the Capital Project Planning folder. 

7. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   InfrastructureProjects_capitalimprovementplan 

  Web Map   Capital Improvement Plan 
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  Web Mapping Application   Capital Improvement Plan 

8. Click Share. 

9.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

10. Click Update. 

11. Browse to the Participatory Budgeting folder. 

12. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   PublicProjectIdeas_public 

  Web Map   Participatory Budgeting 

  Web Mapping Application   Participatory Budgeting 

  Site Application   Participatory Budgeting 

13. Click Share. 

14.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

15. Click Update. 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 98 

Use Capital Project Tracking 
The Capital Project Tracking solution delivers a set of capabilities that help you manage the 

status of active capital projects, track project performance, share project progress with internal 

stakeholders, and communicate investments being made with the public. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Update capital project status 
You will first assume the role of a public works project lead responsible for communicating 

schedule, quality, and cost updates on active capital projects. 

The updates you provide in the Capital Project Reports app will be immediately viewable to the 
public and key stakeholders through the Maximizing Capital Expenditures site and the Capital 
Projects Dashboard. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Capital 
Project Tracking solution. 

2. View the Capital Project Reports app. 

  The Capital Project Reports app shows all categories of capital projects by default. 

3. On the left, click a report type to view active capital projects. 

4. At the top of the page, in the table, click a project report to view project details. 

  At the bottom left, you see the project's current information, including any attachments and 
comments associated with the project. 

5. To edit the project's information, on the Details tab, click Edit . 

6. Update the parameters with new values. 

7. Click Save. 

 

Monitor active capital projects 
As a member of the community, you are interested in learning more about the active capital 

projects in the community and whether they are on schedule and budget. You will use the 

Maximizing Capital Expenditures site to learn about the active public investments being made in 

the community and how you can participate in the capital project planning process. 

1. In a browser, from the Capital Project Tracking solution, view the Maximizing 
Capital Expenditures site. 

2. Scroll to the Active Capital Projects section and click the Review Active Projects 
button. 
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  On the left, under Active Projects, any active projects are listed. 

3. On the left, adjust the filters to refine the list by type, phase, or fiscal year. 

  The map's current extent can also further refine the results shown in the Active Projects 
list. 

4. Pan and zoom around the map to dynamically update the refined results in the 
dashboard. 

  Note: 

  Using the map extent to refine dashboard results will also honor dashboard filters for 
Type, Phase, or Fiscal Year, if enabled. 

5. To view the location and project details for a project, click a project in the Active 
Project list.  

  Selecting a project from the Active Projects list automatically pans and zooms the map to 
the selected project and updates and filters the project summary and detail information. 
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Citizen Problem Reporter 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Citizen Problem Reporter 
Citizen Problem Reporter can be used to solicit non-emergency problem reports (for example, 

blight, graffiti, trash, potholes, clogged drains, and flooding) from the general public. 

It provides 24/7 access to an organization and the location-enabled problem reports helps 
efficiently triage reports to the correct person or department responsible for its resolution. This 
accelerated approach improves the quality of life in a community and reduces long-term asset 
maintenance costs. Citizen Problem Reporter is typically implemented by planning departments, 
public works agencies, utilities, and other local government organizations that want to take a 
data-driven approach to asset maintenance or code enforcement. 

The Citizen Problem Reporter solution delivers a set of capabilities that help you solicit reports 
from the public, manage the response to each report, solicit feedback from the public after 
addressing a report, and monitor the resolution of nonemergency reports in a community. 

 

Requirements 
Citizen Problem Reporter requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 Connect 

 

Information products 
Citizen Problem Reporter includes the following information products: 

Item Description Minimum user type 

Citizen Problem 
Center 

An ArcGIS Hub site used by the general public to 
learn how they can report a nonemergency 
problem to help improve the community 

Not required 

Citizen Problem 
Reporter 

A Crowdsource Reporter app used by the general 
public, or local government personnel, to submit 
nonemergency problems in their community 

Editor (required for 
government 
personnel only) 
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Citizen Problem 
Satisfaction Survey 

An ArcGIS Survey123 form used by the general 
public to report their satisfaction regarding the 
service requested 

Not required 

Volunteer in Your 
Neighborhood 

An ArcGIS Survey123 form used by the general 
public to volunteer to help their community 

Not required 

Citizen Problem 
Manager 

A Crowdsource Manager app used by local 
government personnel to triage submitted problem 
reports and update the status of each report as 
needed 

Editor 

Citizen Problem 
Dashboard 

An ArcGIS Dashboards app used by local 
government personnel to monitor nonemergency 
problems submitted by the general public 

Viewer 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Citizen Problem Reporter 
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Configure Citizen Problem Reporter 
Learn how to configure the Citizen Problem Reporter solution to meet specific needs in your 

organization. The first three sections will guide you through adding a new problem category, 

modifying existing problem types and agencies, and revise existing survey questions. The last 

section guides you through extending the app to generate report IDs, moderate reports, send 

email notifications and enrich reports. 

Add a new problem category 
The Citizen Problem Reporter app allows the public to submit nonemergency problem reports. 

Problem reports are grouped into categories that make it easier to submit a report. The problem 

categories appear when a user signs in to the app and are stored in the CitizenProblems feature 

layer and visualized in feature layer views. 

Citizen Problem Reporter includes nine problem categories: Animal, Blight, Health, Land Use, 
Park/Tree, Road, Snow/Ice, Trash, and Utility. In some cases, you may want to add a problem 
category to Citizen Problem Reporter to meet your organization’s needs. 

Add problem category 
Review the CitizenProblems feature layer categories and identify what categories your 

organization may want to add or remove from the Citizen Problem Reporter app. 

1. Sign in to your ArcGIS organization and browse to your CitizenProblems feature 
layer. 

2. Open the item page and click the Data tab. 

3. Click Fields. 

4. Click the Category display name. 

  In the List of Values (Domain) section, review existing categories and identify ones that 
are not applicable and ones that are missing. 

5. Click Edit next to List of Values (Domain). 

6. Optionally, click the Delete button to remove a category from the list. 

7. Optionally, click Add. 

8. Type the new category name into the Displayed Value and Stored Value text 
boxes. 

9. Repeat steps 7 and 8 to add the remaining missing categories. 

10. Optionally, drag the category to a new location in the list to reorder them. 

11. Click Save. 

If you did not add new categories on the CitizenProblem layer but rather deleted them, go to the 

Add or remove project category indicator section. 

 

Create feature layer view 
Create a feature layer view of each new category added to the CitizenProblems feature layer. 

1. In your browser, click the Overview tab. 

2. On the CitizenProblems feature layer item page, click Create View Layer. 
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3. Type the name of the category in the Title text box—for example, 
CitizenProblems_animal. 

4. Type tag terms separated by commas. 

5. Type a summary in the Summary text box—for example, A public view of 
<insert category name> problems reported by the public through 
focused citizen engagement apps. 

6. Save the feature layer view in the Citizen Problem Reporter folder. 

7. Click OK. 

  Update the editing setting, so the public can submit nonproblem reports with the Citizen 
Problem Reporter app. 

8. On the item page, click the Settings tab. 

9. Scroll to the Feature Layer (hosted, view) section and check the Enable editing 
check box. 

10. Uncheck the Delete check box under the What kind of editing is allowed setting. 

11. Click Save. 

  Set the view definition so the public sees the new problem report category. 

12. Click the Overview tab. 

13. Click Open in Map Viewer. 

14. On the new category layer, click More Options, and click Set View Definition > 
Define Features. 

15. Create the following expression: Category is new category. 

16. Click Add another expression and create the following expression: Visible to the 
public is Yes. 

  By default, all problem reports submitted using the Citizen Problem Reporter automatically 
set the Public View field to Yes, making it visible to the public. You can manually set the 
visibility to No using the Citizen Problem Manager when triaging the issue. 

17. Click Apply Definition. 

18. On the new category layer, click More Options, and click Show Item Details. 

19. Close the new category map tab. 

20. On the item page, click the Data tab. 

21. Click Fields. 

22. Click the Type of Problem display name. 

Install add-in 

To add a problem category using the Modify Domain tool, install the ArcGIS Solutions 

Deployment Tool Add-In. If you already installed the add-in, you do not need to install it again. 

Note: 

The current version of the 

ArcGIS Solutions 

Deployment Add-In is 2020.7.28. Ensure you have the most recent version of the add-in 
installed before proceeding. 
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1. Download the ArcGIS Solutions Deployment Tool .zip file. 

2. Close ArcGIS Pro before installing the add-in. 

3. Browse to the folder to which you downloaded the .zip file and extract its contents. 

4. Double-click SolutionDeployment.esriAddInX to run the installer. 

5. Click Install Add-In.  

6. After installation is complete, click OK. 

  Note: 

The current version of the ArcGIS Solutions Deployment Add-In is 2020.7.28. Ensure you 
have the most recent version of the add-in installed before proceeding. 

 

Add problem type domain 

Add a problem type domain for the new problem report category. 

1. Open ArcGIS Pro and create a new project. 

2. Sign in to the ArcGIS organization to which you deployed the Citizen Problem 
Reporter solution. 

3. On the Share tab, in the Deploy group, click ArcGIS Solutions. 

4. Double-click Configure an ArcGIS Solution task. 

5. On the Configure an ArcGIS Solution step, click Next Step. 

6. On the Add Fields step, click Skip. 

7. On the Modify Domains step, click the browse button next to the Input Layer or 
Table parameter. 

  The Input Layer or Table dialog box appears. 

8. Under Portal, click My Content. 

9. Double-click the Citizen Problem Reporter folder. 

10. Double-click the new category feature layer view. 

11. Click Citizen Problems, and click OK. 

12. In the Field parameter, click the drop-down arrow and choose Type of Problem. 

13. In the Type parameter, click the drop-down arrow and choose Coded Value. 

14. Type the category name in the Name text box—for example, Animal. 

15. In the Domain section, type a new category in the Code text box and in the 
Description text box. Repeat this step until all the domains that apply to your 
organization have been added. 

16. Once you have finished adding domains, click Run. 

17. Click Finish. 

18. Close ArcGIS Pro and save your changes. 

19. In your browser, refresh the Type of Problem page. 

20. Click Fields. 

21. Click the Type of Problem display name. 
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Under the List of Values (Domain), you see the newly added domains. The domains added 

appear in the Type of Problem drop-down list in the Report a problem form. 

Repeat the steps in this section for each new category you want to add to your Citizen Problem 
Reporter app. Once you have finished adding new categories, you will create a map for each 
category. 

 

Create a map 
Each problem category displayed in the Citizen Problem Reporter app is a single map. Create a 

map for each category you want to add to your Citizen Problem Reporter app. 

1. At the top of the site, click Map. 

2. Click the Add button and choose Search for Layers. 

3. Type the name of a category feature layer view in the search box. 

4. Click the Add button  on the layer result. 

5. Click the Back button. 

6. Click the Content button. 

7. On the new category layer, click More Options, and click Rename. 

8. Type the category name in the Layer Name text box—for example, Animal 
Problems. 

9. Click OK. 

  Create feature templates for each new problem report category. 

10. On the layer, click Change Style. 

11. Click the Choose an attribute to show drop-down arrow and choose Show 
location only. 

  A warning window appears, informing you the changes made to the symbology will affect 
the symbols displayed. Add and update the symbology once you have created a feature 
template for your new category. 

12. Click Yes. 

13. Click Done. 

14. Click the Edit button. 

15. Click Manage. 

16. Click the New Feature drop-down arrow and choose Properties. 

17. Type the category name and – Submitted in the Name text box—for example, 

Animal Problems - Submitted. 

18. Click the Category drop-down arrow and choose the new category. 

19. Click Done. 

20. Click Save Changes. 

21. Click the Close button. 

Change style 

Update the symbology to reflect your new problem report category. 

1. Click the Details button. 
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2. On the layer, click Change Style. 

3. Click the Choose an attribute to show drop-down arrow and choose Status. 

  A warning window appears, informing you the changes made will affect the symbols 
displayed. 

4. Click Yes. 

5. Click Options. 

6. Click the Submitted symbol. 

7. Click Shape. 

8. Click the drop-down arrow and choose a symbol set or Custom Images. 

9. If you chose to add a symbol from a symbol set, click a symbol and set the symbol 
size, click OK. 

  Tip: 

  If you chose a symbol from the Government symbol set, set the symbol size to 21 px. 

10. If you chose to add a custom image, click Use an Image, paste a URL in the text 
box, set a symbol size, and click OK. 

11. Repeat steps 6 through 8 and assign symbols for the remaining category statuses. 

12. Optionally, click the symbol options button to drag and reorder the symbols. 

13. Click OK. 

14. Click Done. 

 

Update the pop-up 

Update the pop-up on the new problem report layer. 

1. On the layer, click More Options, and click Configure Pop-up. 

2. Enter a title for your pop-up by clicking the [+] button and choosing the Type of 
Problem field. 

3. Click Configure. 

4. Click the View HTML Source button in the editor. 

5. Delete the existing HTML code. 

6. Copy and paste the following HTML code: 

  {category} problem reported on {CreationDate}.<br /><br /> 
<b>Details:</b> {details}<br /><br /> 
<b>Status:</b><br /> 
<table style="border-collapse: separate; border-spacing: 2px 4px; width: 
100%; table-layout: fixed; margin: 0px -2px; max-width: 350px;"> 
  <tbody><tr height="16"> 
    <td style="{expression/expr0}; text-align: center; width: 25%"></td> 
    <td style="{expression/expr1}; text-align: center; width: 25%"></td> 
    <td style="{expression/expr2}; text-align: center; width: 25%"></td> 
    <td style="{expression/expr3}; text-align: center; width: 25%"></td> 
  </tr> 
  <tr height="24" style="text-align: center;"> 
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    <td style="text-align: center; width: 25%; font-weight: normal; 
padding-left: 0px; word- wrap: break-word;">Submitted</td> 
    <td style="text-align: center; width: 25%; font-weight: normal; 
padding-left: 0px; word- wrap: break-word;">Received</td> 
    <td style="text-align: center; width: 25%; font-weight: normal; 
padding-left: 0px; word- wrap: break-word;">In Progress</td> 
    <td style="text-align: center; width: 25%; font-weight: normal; 
padding-left: 0px; word- wrap: break-word;">Completed</td> 
  </tr> 
</tbody></table> 
<table style=" border-collapse: separate; border-spacing: 0px 0px; width: 
100%; table-layout: fixed; margin: 0px -1px;"> 
  <tbody><tr> 
    <td style="display:{expression/expr4}; text-align: left; width: 
100%"> 
      <b><br />Resolved On:</b> {resolutiondt}<br /><br /> 
      <b>Resolution:</b> {resolution} 
    </td> 
  </tr></tbody> 
</table> 

7. Click the View HTML Source button in the editor. 

8. Click OK. 

9. Click the Configure Attributes link. 

10. Click the Edit check box, and uncheck the check box. 

11. Click the Display check box and uncheck the check box. 

12. Click the Display check box next to the following fields: {probtype}, {status}, 
{details}, {expression/expr0}, {expression/expr1}, {expression/expr2}, 
{expression/expr3}, and {expression/expr4}. 

  Display fields are displayed in the Report a problem form. 

13. Check the Edit check box next to the following fields: {probtype}, {details}, 
{pocfullname},{pocmail}, and {pocphone}. Ensure {pocfullname}, {pocmail}, and 
{pocphone} display check box is unchecked, so this information isn’t publicly 
visible. 

  Edit fields are editable in the form, so when the public submits a problem report, the 
information is written to the editable fields. 

  Optionally, you can choose to use the {pocfirstname} and {poclastname} fields in your 
Report a problem form instead of the {pocfullname} field. If you choose to, the First Name 
and Last Name parameters appear in the form instead of Full Name. 

14. Click the {details} field row. 

15. Click the Textbox Type drop-down arrow and choose Multiple Line. 

16. Rename the {details} field alias to Problem Details. 

  The details field (in the Report a problem form) is renamed to Problem Details and the 
text box has doubled in size, so users can add more information about the problem they 
are submitting. 
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17. Reorder the fields in the following order: {probtype}, {details}, {pocfullname}, 
{pocphone}, {pocmail}, {status}. To reorder the fields, click the field name and use 
the Move up and Move down arrows. 

  The order of the fields in the Configure Attributes window reflects the order of the 
questions in the Report a problem form. 

18. Add a colon after the following Field Alias values: Type of Problem, Problem 
Details, Full Name, Phone Number, Email, and Status. 

19. Click OK. 

20. Check the Show feature attachments as links check box. 

21. Uncheck the Show when last edited check box. 

22. Under Attribute Expression, press the Shift key and click the Resolution Time 
and Full Name expressions. 

23. Click the Remove expression button. 

  The Resolution Time and Full Name Arcade expressions persisted when you created the 
category feature layer view from the CitizenProblems feature layer. These Arcade 
expressions are not used in the Citizen Problem Reporter app. 

  The first four expressions define the color used in the status bar in the layer pop-up as well 
as in the problem details in the Citizen Problem Reporter app. The status bar updates as 
the problem reported status is updated to Submitted, Received, In Progress, and 
Completed. 

  The last Arcade expression is configured to only display the Resolved On date and 
Resolved fields and information in the pop-up and problem details if the status is set to 
Completed. 

24. Click OK. 

 

Configure the pop-up 

Configure the Comments table pop-up. 

1. On the Comments table, click More Options, and click Rename. 

2. Rename the table to Comments. 

3. Click OK. 

4. On the Comments table, click More Options, and click Configure Pop-up. 

5. Delete the pop-up title. 

6. Click Configure Attributes link. 

7. Click the Edit check box, and uncheck the check box. 

8. Click the Display check box, and uncheck the check box. 

9. Click the Display check box next to the {comments} field. 

  Display fields are displayed in the Citizen Problem Reporter comment form. 

10. Check the Edit check box next to the following fields: {comments}, {pocfullname}, 
{pocphone}, and {pocemail}. Ensure that {pocfullname}, {pocmail}, and {pocphone} 
display check box is unchecked, so your citizen information isn’t publicly 
accessible. 
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  Edit fields are editable in the comment form, so when citizens make comments about a 
problem report, the information is written to the editable fields. 

  Optionally, you can choose to use the {pocfirstname} and {poclastname} fields in your 
Report a problem form instead of {pocfullname} field. If you choose to, the First Name and 
Last Name parameters appear in the form instead of Full Name. 

11. Click the {comments} field row. 

12. Click the Textbox Type drop-down arrow and choose Multiple Line. 

13. Rename the {details} field alias to Leave a comment. 

  The comment field (in the form) is renamed to Leave a comment and the text box has 
doubled in size, so users can add more information about their comment. 

14. Change Phone Field Alias to Phone Number. 

15. Add a colon after the following Field Alias values: Leave a comment, Full Name, 
Phone Number, and Email. 

16. Click OK. 

17. Uncheck the Show when last edited check box. 

18. Click OK. 

19. On the Surveys table, click More Options, and click Remove. 

20. Click Yes, Remove Table. 

 

Save the map 

Save the new problem category map. 

1. Click Save > Save As. 

2. Type a title—for example, Animal Problems. 

3. Type tags that describe your map. 

4. Provide a summary that describes the map—for example, A map used to report 
animal concerns in our community. 

5. Save the map in the Citizen Problem Reporter folder. 

6. Click Save Map. 

7. Click Share. 

8. Check the Citizen Problem Reporter check box. 

9. Click Cancel to update sharing. Do not share the feature layer view to the Citizen 
Problem Reporter group. 

10. Click Done. 

11. Click the About button. 

12. Click the More Details link. 

13. Close the new category map tab. 

14. On the item page, click Edit Thumbnail, and upload an image for the new category 
map. 

  Repeat the steps in this section for each new category you want to add to your Citizen 
Problem Reporter app. In addition, you can view your new problem report category, or 
categories, in the Citizen Problem Reporter app. 
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15. At the top of the site, click Content. 

16. On the My Content tab, under Folders, type Citizen Problem Reporter in the 

search box. 

17. Click the Citizen Problem Reporter folder. 

18. Under Item Type, click Apps. 

19. On the right side of the page, click the Citizen Problem Reporter app. 

20. On the item page, click View Application. 

21. If you haven’t shared the Citizen Problem Reporter app and all the maps 
referenced in the app publicly, choose Sign in with ArcGIS. 

  You see the new category or categories in the app. 

22. Click a new category and click Submit Problem. 

23. Click the Type of Problem drop-down arrow to see the type of problem domains 
you added in ArcGIS Pro. 

Once you finished reviewing the Citizen Problem Reporter app, close the tab. 

 

Add problem category symbology 
Add new problem category symbology. 

1. At the top of the site, click Content. 

2. On the My Content tab, under Folders, type Citizen Problem Reporter in the 

search box. 

3. Click the Citizen Problem Reporter folder. 

4. Under Item Type, click Layers. 

5. On the right side of the page, click the CitizenProblems layer. 

6. On the item page, click the Open in Map Viewer drop-down arrow and choose 
Add to new map. 

7. On the layer, click Change Style. 

8. Click the Choose an attribute to show drop-down arrow and choose Category. 

  A warning window appears, informing you the changes made to the symbology will affect 
the symbols displayed. 

9. Click Yes. 

10. Click Options. 

11. Click the Animal symbol. 

12. Click Shape. 

13. Click the drop-down arrow and choose the Government symbol set. 

  All category symbols except for the new category you created are available in the 
Government symbol set. 

14. Browse to the Animal symbol  and type 21 in the Symbol Size text box. 

15. Click OK. 

16. Repeat steps 11 through 15 to symbolize the remaining categories. 

17. Optionally, click the symbol options button to drag and reorder the symbols. 
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18. Click OK. 

19. Click Done. 

20. On the layer, click More Options, and click Save Layer. 

  Repeat the steps in this section to update the CitizenProblems_dashboard feature layer 
view symbology. 

21. Click the Add button and choose Search for Layers. 

22. Type CitizenProblems_dashboard feature layer view in the search. 

23. Click the Add button on the layer result. 

24. Click the Back button. 

25. Repeat steps 7 through 20 to apply symbols to the CitizenProblems_dashboard 
feature layer view. 

  Tip: 

  You can restore the original CitizenProblems symbols, as well as adding new category 
symbols, by adding a point to the map with every category and status combination. 

 

Add category features 

Add new problem features to the map and save them to the problem category and 

CitizenProblem_dashboard layer view. 

1. Click the Edit button. 

2. In the Add Features pane, click the Animal feature and add a point to the map. 

3. In the pop-up, click the Status drop-down arrow and choose Submitted, and then 
click Close. 

4. Repeat this step to add a point symbol for Animal Received, Animal In Progress, 
and Animal Completed because it already exists. 

5. Repeat step 2 and 3 to add the remaining category status to the map. 

6. Once all the category and status point combination have been added to the map, 
click the Close button. 

7. On the CitizenProblems layer, click Change Style. 

8. Click the Choose an attribute to show drop-down arrow and choose New 
Expression. 

9. Copy the following expression and paste it in the text box: 

  return $feature.category + " " + $feature.status 

10. Click OK. 

11. Click Options. 

12. Click Ungroup to ungroup the remaining categories. 

13. Click the Animal Completed symbol. 

14. Click Shape. 

15. Click the drop-down arrow and choose the Government symbol set. 
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16. Choose the Animal Problems - Completed symbol and type 21 in the Symbol Size 

text box. Click OK. 

17. Repeat step 13 through 16 for the remaining symbols. 

  All category symbols except for the new category you created are available in the 
Government symbol set. 

18. Optionally, click the symbol options button to drag and reorder the symbols. 

19. Click OK. 

20. Click Done. 

21. On the CitizenProblems layer, click More Options, and click Save Layer. 

22. Repeat steps 7 through 21 to apply the original and new category symbology to the 
CitizenProblems_dashboard feature layer view. 

23. Click the Edit button. 

24. In the map, click one of the points and scroll to the bottom of the pop-up and click 
Delete. Repeat this step to delete the remaining points. 

25. Click the Close button. 

 

View new category 

View new categories in the Citizen Problem Manager and Citizen Problem Dashboard map. 

1. At the top of the site, click the Home drop-down arrow and choose Content. 

2. On the My Content tab, under Folders, type Citizen Problem Reporter in the 

search box. 

3. Click the Citizen Problem Reporter folder. 

4. Under Item Type, click Maps. 

5. On the right side of the page, click the Citizen Problem Manager map. 

6. On the item page, click Open in Map Viewer. 

7. Click Yes, open the map. 

8. Click the Legend button and review the symbology. 

Repeat steps 1 through 7 to review the symbology in the Citizen Problem Dashboard map. 

 

Add or remove problem category indicator 
Add or remove a category indicator in the Citizen Problem Dashboard app. 

1. At the top of the site, click the Home drop-down arrow and choose Content. 

2. On the My Content tab, under Folders, type Citizen Problem Reporter in the 

search box. 

3. Click the Citizen Problem Reporter folder. 

4. Under Item Type, click Apps. 

5. On the right side of the page, click the Citizen Problem Dashboard app. 

6. On the item page, click Edit Dashboard. 

  On the Overview tab, not all the problem categories may apply to your community; you 
can add new category indicator or indicators to your dashboard. 
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7. To add a new indicator, hover over the upper corner of the Animal Control indicator 
and choose Duplicate Element . 

8. Hover over the new indicator upper corner and choose Configure . 

9. In the Value area, under Filter, click the Value drop-down arrow and choose a new 
category. 

10. Scroll down to the Reference area, under Filter, click the Value drop-down arrow 
and choose a new category. 

11. Click the Indicator tab, in the Style for value at or above reference area, type a 
new category in the Top Text text box. 

12. In the Style for value below reference area, type a new category in the Top Text 
text box. 

13. Click the General tab and type a new indicator name in the Name text box. 

14. Click Done. 

15. Hover over the new indicator in the upper corner and choose Drag item . 

16. Press the Shift key on your keyboard while dragging the item to group as a column. 
Dock the indicator next to an existing indicator. 

17. Optionally, to delete an indicator, hover over the upper corner of the indicator you 

want to delete and choose Delete . 

18. Click Save to save changes made to the dashboard and close the dashboard. 

 

Modify problem types and responsible agencies 
Citizen Problem Reporter includes problem types and responsible agencies for each problem 

category. In some cases, you may want to add a problem type to an existing category or add a 

new problem type for any new problem category you created. In addition, you may want to 

modify the responsible agencies provided to more accurately reflect the name of the agency, 

department, or team that is responsible for responding to problem reports. 

1. At the top of the site, click Content. 

2. On the My Content tab, under Folders, type Citizen Problem Reporter in the 

search box. 

3. Click the Citizen Problem Reporter folder. 

4. Under Item Type, click Layers. 

5. On the right side of the page, click the feature layer view you want to modify—for 
example, CitizenProblems_Animal. 

6. On the item page, click the Data tab. 

7. Click Fields. 

8. Click the Type of Problem display name. Review List of Values (Domain). 
Identify domains that are missing or need to be removed from the list. 
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  Tip: 

  To modify problem types and responsible agencies using the Modify Domain tool, you 
must install the Solution Deployment Tool Add-In. If you already installed the add-in, you 
do not need to install it again. 

9. Open ArcGIS Pro. 

10. Sign in to the ArcGIS organization to which you deployed the Citizen Problem 
Reporter solution template. 

11. On the Share tab, in the Deploy group, click ArcGIS Solutions. 

12. Double-click the Configure an ArcGIS Solution task. 

13. On the Configure an ArcGIS Solution step, click Next Step. 

14. On the Add Fields step, click Skip. 

15. On the Modify Domains step, click browse next to Input Layer or Table 
parameter. 

  The Input Layer or Table dialog box appears. 

16. Under Portal, click My Content. 

17. Double-click the Citizen Problem Reporter folder. 

18. Double-click the new feature layer view. 

19. Click Citizen Problems, and click OK. 

20. In the Field parameter, click the drop-down arrow and choose Type of Problem. 

21. In the Domain section, optionally, to delete a domain, hover to the left of the 
domain you want to delete and click remove. Repeat this step until all the domains 
that do not apply to your organization have been removed. 

22. Optionally, to add a new domain, type a new category in the Code text box, and 
then type it in the Description text box. Repeat this step until all the domains that 
apply to your organization have been added. 

23. Optionally, to modify an existing domain or domains, click in the Code text box and 
type a new problem type, and click in the Description text box and type a new 
problem type. 

24. Once you have finished modifying domains, click Run. 

25. Click Finish. 

26. Close ArcGIS Pro and save your changes. 

 

View new problem type 
View new problem type in the Citizen Problem Reporter app. 

1. In your browser, refresh the Type of Problem page. 

2. Click Fields. 

3. Click the Type of Problem display name. 

  Under List of Values (Domain), you see the newly added or removed domain or domains. 

  Repeat the steps in this section for each problem type you want to add or modify in your 
Citizen Problem Reporter app. 
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4. At the top of the site, click Content. 

5. On the My Content tab, under Folders, type Citizen Problem Reporter in the 

search box. 

6. Click the Citizen Problem Reporter folder. 

7. Under Item Type, click Apps. 

8. On the right side of the page, click the Citizen Problem Reporter app. 

9. On the item page, click View Application. 

10. Sign in to the app using Sign in with ArcGIS. 

11. Click the category for which you modified the problem types, and then click Submit 
Problem. 

12. In the Report a problem form, click the Type of Problem drop-down arrow and 
you see the updated type of problem domains. 

  Once you finished reviewing the Citizen Problem Reporter app, close the tab. 

  Now, review the list of responsible agencies and modify them to meet the needs of your 
organization. 

13. At the top of the site, click Content. 

14. On the My Content tab, under Folders, type Citizen Problem Reporter in the 

search box. 

15. Click the Citizen Problem Reporter folder. 

16. Under Item Type, click Layers. 

17. On the right side of the page, click the CitizenProblems feature layer. 

18. On the item page, click the Data tab. 

19. Click Fields. 

20. Click the Assigned To display name. 

  Review existing agencies and identify missing ones in the List of Values (Domain) 
section. 

21. Click Edit next to List of Values (Domain). 

22. Optionally, click Add. 

23. Type the new agency name in the Displayed Value and Stored Value text boxes. 

24. Repeat steps 22 and 23 to add the remaining missing agencies. 

25. Optionally, click Delete to remove an agency. 

26. Optionally, click in the Label text box with an existing agency labeled and change 
the agency name. Repeat this step to change the Code as well. 

27. Optionally, drag the category to a new location in the list to reorder them. 

28. Click Save. 

 

Share Citizen Problem Reporter maps and app 
For the Citizen Problem Reporter app to be publicly accessible through guest and social media 

access, the maps and layers must be shared with everyone. Follow the steps below to share 

your maps and layers with everyone. 

1. Click Groups at the top of the site. 
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2. Open the Citizen Problem Reporter group page and click View all group content. 

  Note: 

  Review the maps shared to the group. The maps shared to this group will be displayed in 
the Citizen Problem Reporter app. 

3. Optionally, add a map or maps to the group by clicking the Add items to group 
and browse to the map or maps. Check the check box next to the map or maps you 
want to add to the group and click Add items. 

4. Optionally, remove a map or maps from the group by checking the check box next 
to the map and click Remove from group. 

5. Click the Settings tab. 

6.  Under Who can view this group, click Everyone (public), and click Save. 

7. Click Content at the top of the site. 

8. On the My Content tab, under Folders, type Citizen Problem Reporter in the 

search box. 

9. Click the Citizen Problem Reporter folder. 

10. Under Item Type, click Maps. 

11. On the right side of the page, check the check box next to the maps you want to 
appear in the Citizen Problem Reporter app, and click Share. 

  Tip: 

  Share maps with the word problems in the map name. 

12. In the Share window, click Everyone (public) and click Save. 

13. In the Update sharing window, click OK. 

  Note: 

  The layers associated with the maps should also be shared publicly. 

14. Next to Item Type, click Clear. 

15. Under Item Type, click Apps. 

16.  On the right side of the page, click the Citizen Problem Reporter app. 

17.  On the item page and click Share. 

18. In the Share window, click Everyone (public) and click Save. 

19. Click View Application. 

20. Sign in to the app using one of the sign in options and review the app. 

 

Sharing solution items 
Several layer views, maps and apps included in the Citizen Problem Reporter solution must be 

shared with everyone so they can be accessed by the public on the Citizen Problem Center site. 
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To share your citizen problem reporter items with everyone, use the guide below and complete 

the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Citizen 
Problem Reporter folder. 

2. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   CitizenProblems_public 

  Feature Layer (hosted, view)   Volunteers_public 

  Web Map   Citizen Problem Center Reports 

  Form   Volunteer in Your Neighborhood 

  Site Application   Citizen Problem Center 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 

 

Revise satisfaction survey questions 
The Citizen Problem Satisfaction Survey allows you to solicit feedback from the public that helps 

you improve your community’s customer service. The survey includes six questions. In some 

cases, you may want to add, or remove, questions from the survey. 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Citizen Problem Satisfaction Survey to download the survey. 

4. In the Download window, click Download and click OK. 

5. Click Citizen Problem Satisfaction Survey again to open the survey. 

6. On the side toolbar, click the Open XLSForm Spreadsheet button. 

7. In the Microsoft Excel spreadsheet, click the choices tab. 

  This tab comprises all the selectable options for survey questions. 

8. Click the survey tab. 

  This tab comprises all the questions in the survey. 

9. Revise the survey to reflect your needs. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://www.esri.com/en-us/arcgis/products/arcgis-survey123/resources


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 118 

10. Save and close the Microsoft Excel spreadsheet and preview your changes in 
ArcGIS Survey123 Connect. 

11. In ArcGIS Survey123 Connect, click Publish on the side toolbar to publish your 
changes. 

12.  Click Publish survey to publish your changes and click OK. 

 

Extend Citizen Problem Reporter 
You can extend the Citizen Problem Reporter solution with a set of Python tools that can be 

used to generate report IDs, moderate reports, send email notifications, and enrich reports. 

These tools can be executed automatically via Task Scheduler and as new problem reports are 

submitted or updated the corresponding action occurs. 

 

Add the ServiceFunctions toolbox 
The ServiceFunctions toolbox contains tools for generating report IDs, moderating reports, 

sending email notifications, and enriching reports. Download and add the ServiceFunctions 

toolbox to your ArcGIS Pro project before configuring the appropriate tools. 

1. Download the ServiceFunctions toolbox. 

2. Browse to the ServiceSupport.zip file and unzip the file to the location from 

which you want to the tools to execute. 

3. Open ArcGIS Pro and create a new project. 

4. Sign in to the ArcGIS organization to which you deployed the Citizen Problem 
Reporter solution, if necessary. 

5. On the View tab, in the Windows group, click the Catalog pane, if necessary. 

6. In the Catalog pane, right-click Toolboxes and choose Add Toolbox. 

  The Add Toolbox dialog box appears. 

7. Browse to the ServiceSupport folder. 

8. Click the ServiceSupport.pyt Python toolbox, and click OK. 

9. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

  If you've never used the ServiceSupport toolbox before, run the Define Connection 
Settings tool to establish a connection between the toolbox and the CitizenProblem feature 
layer. 

10. In the Catalog pane, in the ServiceSupport.pyt Python toolbox, double-click the 
Define Connection Settings tool. 

11. In the ArcGIS Online organization or ArcGIS Enterprise portal URL parameter, 
click the drop-down arrow and choose a URL. 

12. In the Username parameter, type your user name for the organization you chose in 
step 11. 

13. In the Password parameter, type your password for the user name provided in the 
Username. 

14. Click Run. 
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Generate report IDs 
Many workflows require you to generate a unique identifier when a feature or record is created 

so it can be referenced and tracked in other workflows. You can use the Generate IDs tool to 

configure custom unique identifiers that will be applied to features at a regularly scheduled 

interval of your choosing. The tool only generates the configuration; you must run an additional 

script (provided) to update the features with incrementing identifier values. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt, if necessary. 

2. Double-click the Generate IDs tool. 

3. In the Layer parameter, click Browse. 

  The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Citizen Problem Reporter folder. 

6. Double-click the CitizenProblems feature layer. 

7. Click Citizen Problems, and click OK. 

  Expand General Identifier Settings. If the tool has not been run previously, start by 
specifying at least one identifier sequence. 

8. In the Sequence Name parameter, type a name for the sequence. 

  This value appears in the drop-down menu for selecting the sequence to assign to each 
layer. 

9. In the Pattern parameter, type a pattern to use for the sequence. 

  This can be a combination of letters, numbers, and symbols. Mark the location for the 
incrementing value with a pair of curly braces {}. Python formatting is applied to the pattern 
text, so string formatting syntax such as {0:03d} pads the incrementing number section with 
zeros to a length of 3. For example, the expression seq-{0:05d} creates the following 
pattern of values: seq-00001, seq-00002, seq-00003, and so on. 

10. In the Next Value parameter, type a value. 

  When initially creating the sequence, this must be the first value in the identifiers. After this 
point, this value shows the value to be used for the next identifier generated. 

11. In the Interval parameter, type a value. 

  The interval by which the identifier values increase between features. For example, an 
initial Next Value of 1 and an Interval of 10 creates identifiers with the incrementing values 
of 1, 11, 21, and so on. 

  Deleting or changing these sequences impacts all the layers that are configured to use the 
edited sequences. 

12. Optionally, edit the identifier configuration and run the tool to overwrite the existing 
identifier configuration for the selected layer. 

  Note: 

  If an identifier configuration already exists, a check box appears that, when checked, 
deletes the existing identifier configuration for the selected layer. 

13. Choose the moderation list to use to process the features in the selected layer. 
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14. Choose the sequence to use to generate the identifiers for each feature in the 
layer. 

15. Choose a text field to store the generated identifier. 

16. Click Run to write out the identifier configuration for the layer and any changes to 
the identifier sequences. 

17. To configure identifiers for another layer, rerun the tool with the settings for the next 
layer. 

General Identifier Settings are not specific to any one layer—they apply to all layers configured 

using this tool. 

 

Moderate reports 
Public comment apps can occasionally generate feedback that should not be made publicly 

visible. Data entered into specific fields, such as personal information, can be hidden and 

protected using the pop-up configuration and layer security, but sometimes entire comments 

need to be hidden to avoid displaying sensitive or explicit content to other users. 

You can hide features by updating the value of a field so that it no longer meets the 
requirements of a filter applied to that layer in the map. You can use the Moderate Reports tool 
to configure which layers and fields to scan for explicit or sensitive words and phrases and how 
to update the feature so that it can be filtered from the map. You can choose how often to scan 
features and records. The tool only generates the configuration; an additional script (provided) 
must be run to scan the features. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

2. Double-click the Moderate Reports tool. 

3. In the Layer parameter, click Browse. 

  The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Citizen Problem Reporter folder. 

6. Double-click the CitizenProblems feature layer. 

7. Click Citizen Problems, and click OK. 

  Expand General Moderation Settings. If the tool has not been run previously, start by 
specifying at least one moderation list. 

8. In the List Name parameter, type a name. 

  This value appears in the drop-down menu for selecting the moderation list use when 
scanning each layer. 

9. In the Filter Type parameter, click the drop-down arrow and choose to scan feature 
for words and phrases that exactly match the provided list of words and phrases. 

  For example, when the filter type is EXACT, if the list contains the word duck, the script 
updates the specified field when the feature contains the word duck, but not when it 
contains the word duckling. When the filter type is FUZZY, the script updates the feature 
when either duck or duckling are found. 

10. In the Words and Phrases parameter, type a word or phrase. Provide a comma-
separated list of words or phrases to scan for. 
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  Keep in mind that deleting or changing these lists will impacts all the layers that are 
configured to use the edited sequences. 

11. If a moderation configuration already exists for the selected layer, choose to edit an 
existing configuration by selecting the name of the moderation list used in the 
configuration, or choose the option to add a new moderation configuration. 

  If you choose to edit an existing configuration, a check box appears that, when checked, 
deletes the existing moderation configuration for the selected layer. Alternatively, edit the 
moderation configuration and run the tool to overwrite the existing moderation configuration 
for the selected layer and moderation list. 

  To add a new moderation configuration, click the Add New button and continue with the 
following steps. 

12. Choose the moderation list to use to process the features in the selected layer. 

13. Choose the fields that will be scanned for content that matches the words and 
phrases in the selected moderation list. 

14. Optionally, provide an SQL query to only apply moderation to some features. 

  If no query is provided, all features are processed. 

15. Use the Field to Update parameter when a match is found between the value of a 
field and the content of a moderation list. Use the Found Value parameter to 
specify the value that should be written to this field indicating a match. 

16. Click Run. 

 

Send email notifications 
Many workflows require that an email be sent when a feature or record is created and updated. 

You can use the Send Emails tool to configure emails that can be sent based on attribute 

values and a schedule of your choosing. The tool only generates the configuration; you must 

run an additional script (provided) to actually generate and send the emails. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

2. Double-click the Send Emails tool. 

3. In the Layer parameter, click Browse. 

  The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Citizen Problem Reporter folder. 

6. Double-click the CitizenProblems feature layer. 

7. Click Citizen Problems, and click OK. 

  All existing email settings for the layer load and can be edited by updating the parameter 
values for each configuration. To delete a single email configuration, click the Remove 

button  next to the configuration. To delete all the email configurations for the layer, 
check the Delete all existing email configurations for this layer check box. Run the tool 
to save your changes. 

8. In the Email Template parameter, click Browse to access the ServiceSupport 
folder. 
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9. Click one of the HTML templates for the body of the email, and click OK. 

  To add attributes from the triggering feature to the email, use unique string keys in the 
places where the values should appear in the HTML and reference these strings in the 
Find parameter of the Email Substitutions section of the General Email Settings along 
with the name of the field that contains the value to be substituted for the string key in the 
Replace parameter. 

10. Optionally, in the SQL Query parameter, provide an SQL query to only trigger an 
email from specific features. 

  If no query is provided, all features trigger emails every time the script is run, so you most 
likely want to use this query along with the Field to Update and Sent Value parameters to 
ensure that the same email isn't sent repeatedly for the same feature. 

11. In the Recipient Email Address parameter, type an email address of the recipient 
or the name of a field in the layer that contains the address of the recipient. 

12. In the Email Subject parameter, type the subject for the email. 

  Similar to the email body provided in the HTML document, this text can contain string keys 
that will be swapped out for attribute values based on the Find and Replace values 
defined in the Email Substitutions list in the General Email Settings section. 

13. In the Field to Update parameter, type Email. When the email has been sent for 

each feature, use the Sent Value parameter to specify the value that should be 
written to this field indicating that the email has been sent. 

  This field and value can be used in the previously described SQL query to prevent 
duplicate emails from being sent. 

14. Configure additional emails to be sent for the currently selected layer by clicking the 
Add New button. 

  Emails will be sent in the order they are configured. Expand General Email Settings. If the 
tool has not been run previously, start by specifying the connection information for your 
SMTP server in the tool. 

15. In the SMTP Server parameter, type the URL of the SMTP server used for sending 
emails. 

16. In the SMTP Username parameter, type the user name required to authenticate to 
the SMTP server. This is not required if authenticating through a port. 

17. In the SMTP Password parameter, type the password required to authenticate to 
the SMTP server. This is not required if authenticating through a port. 

18. In the From Address parameter, type the address from which the emails should be 
sent. 

19. In the Reply Address parameter, type the address that should be used for any 
replies to the email message. 

20. Check or uncheck the Use TLS check box to turn on or off TLS. 

21. In the Email Substitutions section, type Find and Replace values. Swap out one 
piece of text for another in the outgoing email subject or body.  

  Anywhere a value in the Find parameter is found in the email subject or body, it will be 
replaced with the corresponding value from the Replace parameter. If the value in the 
Replace parameter is a field in the layer, the Find value will be replaced with the value in 
that field in the triggering feature. For example, to add the ID of a feature from the 
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REQUESTID field to the email subject, include a piece of text such as {ID} in the 
configured Email Subject, and add {ID} to the Find parameter and REQUESTID to the 
Replace parameter. All specified substitutions are applied to all emails configured for all 
layers so, while the Find values can be any piece of text, it's suggested that you use 
something that is clearly variable-like and unlikely to appear elsewhere in the messages in 
a literal form. 

  Deleting or changing these settings impacts all the emails for all the layers configured with 
this tool. 

22. Click Run. 

 

Enrich reports 
Reports made in public comment apps can be enriched with information about the report 

location. You can then use this information to efficiently direct the report to the correct person or 

agency responsible for its resolution. 

You can then use the Enrich Reports tool to configure which attribute values to calculate from a 
coincident or intersecting set of features at a regularly scheduled interval of your choosing. Note 
that the tool only generates the configuration; you must run an additional script (provided) to 
update the features based on intersecting features. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

2. Double-click the Enrich Reports tool. 

3. In the Layer parameter, click the browse button. 

  The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Citizen Problem Reporter folder. 

6. Double-click the CitizenProblems feature layer. 

7. Click Citizen Problems, and click OK. 

8. In the Enrichment parameter, if an enrichment configuration already exists for the 
selected layer, choose to either edit an existing configuration by selecting the 
configuration from the drop-down list, or choose the option to add a new 
enrichment configuration. 

  If you choose to edit an existing configuration, a check box appears that, when checked, 
deletes the existing enrichment configuration for the selected layer. Alternatively, edit the 
configuration and run the tool to save the changes. To add a new enrichment configuration, 
click the Add New button and continue with the following steps. 

9. Choose the polygon feature layer that will provide the enriching attribute values by 
either choosing a layer from the active map or by browsing to your hosted content 
and choosing a polygon feature layer. 

10. In the Source Field parameter, click the drop-down arrow and choose a field from 
the enrichment layer. 

11. In the Target Field parameter, click the drop-down arrow and choose a field from 
the CitizenProblem feature layer. 

  The script does not process features that already have a value in the target field. 
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12. In the Priority parameter, type a value. Specify the priority for this enrichment 
configuration relative to the other configurations for the CitizenProblem feature 
layer. 

  Enrichment configurations for a layer that have a lower priority value will override 
enrichment configurations with a higher value. For example, a layer has two enrichment 
configurations that use the same target field, but one has a priority value of 1 and the other 
has a priority of 2. If the configuration with priority 1 does not produce a valid value for the 
field, the field is populated with the value produced from the configuration with priority 2. 

13. Click Run. 

 

Set up Task Scheduler 
Use Windows Task Scheduler to schedule the script to generate report IDs when a feature or 

record is created, moderate reports when feedback contains inappropriate language, send email 

notifications when a feature or record is created or updated, or enrich reports. All the tools in 

this toolbox share a common configuration file and execution script, so only one scheduled task 

is required to automate running all the associated processes. 

1. Open the Task Scheduler on the computer that is hosting the scripts. 

2. Click Action > Create Task and name your task. 

3. Click the Action tab and click New. 

4. Set Action to Start a Program. 

5. Browse to the location of your Python 3 installation (for example, <default 
directory>\C:\Program Files\ArcGIS\Pro\bin\Python\envs\arcgispro-
py3\python.exe). 

6. In the Add arguments text box, type the name of the script 
(servicefunctions.py). 

7. In the Start in text box, type the path to the folder where your script is and click 
OK. 

8. Click the Trigger tab, click New, and set a schedule for your task. 

9. Click OK. 

When the trigger occurs, the scripts begin scanning the configured layers and, for each one, 

processing (in order) configurations for generating identifiers, enriching reports, moderating 

reports, and sending emails. 
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Use Citizen Problem Reporter 
The Citizen Problem Reporter solution delivers a set of capabilities that help you solicit reports 

from the public, manage the response to each report, solicit feedback from the public after 

addressing a report, and monitor the resolution of non-emergency reports in a community. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Submit nonemergency problem reports 
You will first assume the role of a concerned resident in the community and would like to notify 

the city of a burned-out light in the park. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Citizen 
Problem Reporter solution. 

2. View the Citizen Problem Center site. 

3. Scroll to the Report a Problem section and click the Submit a Report button to 
open the Citizen Problem Reporter app. 

4. On the Citizen Problem Reporter page, click  Proceed as Guest. 

  Tip: 

  Share the maps, app, and group with everyone (public) to sign in as a guest. For more 
information, see Share Citizen Problem Reporter maps and app. 

5. Click Park / Tree Problems. 

6. Click Submit Problem. 

7. For Type of Problem, choose Light Out. 

8. In the Report a problem form, provide the issue details and your name, phone 
number, and email address. 

9. Click the Where is the problem located text box and click the location of your 
broken park light on the map. 

10. To submit your problem, click Report It. 

11. At the top of the Park or Tree Problems form, click the Back button. 

12. At the top of the list of problems, click your Light Out problem to select it. 

  The park light problem you reported appears. As the report moves through its life cycle 
(Submitted, Received, In Progress, and Completed), the status bar updates. 

13. Optionally, click Leave a reply to display the comment form and add a new 
comment. 

You and others can add comments to update or highlight information related to the initial 

problem reported to authorities. 
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Respond to problem reports 
You are now an employee for the city who is responsible for responding to submitted problem 

reports, assigning them to the appropriate department for resolution. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Citizen 
Problem Reporter solution. 

2. View the  Citizen Problem Manager  app. 

3. In the app, click the Category column filter. 

4. Click Category is drop-down arrow and choose Park/Tree. 

5. Click the Type of Problem column filter. 

6. Type Light Out in the Type of Problem is text box. 

7. In the Problems table, identify and click the problem you reported. 

  Review the details of the problem in the lower left corner of the app. 

8.  On the Details tab, click the Edit button . 

9. Click the Status drop-down arrow and choose Received. 

10. Click Save. 

  Utility workers are ready to address the problem. 

11. On the Details tab, click the Edit button. 

12. Click the Status drop-down arrow and choose In Progress. 

13. Click the Assigned To drop-down arrow and choose Utility. 

14. Click Save. 

  Utility workers inform you that the park light bulb has been replaced. 

15. On the Details tab, click the Edit button. 

16. Click the Status drop-down arrow and choose Completed. 

17. For Resolved On, choose the current date. 

18. In the Resolution text box, type Park light bulb has been replaced. 

19. Click Save. 

  Once the issue is complete, the status indicator changes and the details now provide 
information about when and how the issue was resolved. 

20. In the Details tab, click the Send Satisfaction Survey button. 

21. Review the formatted email and send it to yourself. 

 

Provide feedback on work performed 
In the previous section, you sent yourself an email containing a link to a satisfaction survey. You 

will now respond to the survey as the resident who originally submitted the problem report with 

your feedback on how the issue was handled. 

1. Open the email you sent to yourself in the previous section. 

2. Click the URL in the email to open the Citizen Satisfaction Survey. 
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3. In the app, complete the first four survey questions. 

4. Optionally, for Do you have any other comments or concerns, add any other 
comments. 

5. For Would you like to be contacted for more information, click Yes. 

6. Provide information for the Full Name, Phone, and Email parameters. 

7. Click Submit. 

 

Monitor reports and measure performance 
As a program manager for the city, you want to know how well the citizen problem program is 

functioning, monitor the reports coming in, and see how satisfied the residents are with the 

program. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Citizen 
Problem Reporter solution. 

2. View the Citizen Problem Dashboard app. 

3. On the Overview tab, review the high-level metrics. 

  The Overview tab displays infographics of categories of reported problems. This 
information gives management a quick overview of the number of reported problems 
submitted by the public. 

4. Click the Problem Reports tab at the bottom of the dashboard. 

  The Problem Reports tab allows a department manager to monitor how their department 
is doing when it comes to resolving problems. The page displays the top problem types 
and categories and summarizes reports by month with details. 

5. Use the graphs to filter and explore active and resolved problem reports. 

  Dashboard charts are linked. As you click and select a category in one chart, related 
details are filtered and updated in other charts on the report to allow a manager to identify 
issues and areas that need attention. 

6. Click the Survey Results tab at the bottom of the dashboard and explore the 
survey responses. 

  The Survey Results tab displays the results from the Citizen Satisfaction Survey. The 
indicators on the tab include Resolution Quality, Resolution Time, and Customer 
Service indicators that identify whether a community is below or above its target. 

  The Recommended Problem Reporter to Friend or Colleague chart is used to display 
whether the person who submitted the survey would recommend using the Citizen Problem 
Reporter to a friend or colleague. The right side of the dashboard displays the number of 
surveys submitted and their details. 

7. Locate your response in the Surveys list and click it to see the details. 

8. Click the arrow on the left of the app to display additional filters. 

9. Use the filters in the left panel to explore survey results by date, category, problem 
type, resolution time and quality, and customer service experience feedback. 

  You can filter by Submission Date, Category, and Type of Problem. In addition, you can 
filter out information related to the Resolution Quality, Resolution Time, and Customer 
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Service Experience. These are indicators of overall success, user satisfaction, 
effectiveness, and public support. 

   

Volunteer in the community 
As an engaged resident of the community, you would like volunteer to help keep the community 

clean, healthy, and safe. You will fill out a survey to provide your interests, skills, and availability 

so the city can help connect you with volunteer opportunities. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Citizen 
Problem Reporter solution. 

2. View the Citizen Problem Center site. 

3. Scroll to the Volunteer in Your Neighborhood section and click the Volunteer 
button to open the Volunteer in Your Neighborhood survey. 

4. Complete the Volunteer in Your Neighborhood survey and click Submit. 
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Code Enforcement Operations 

Introduction to Code Enforcement Operations 
Code Enforcement Operations can be used to collect and monitor code violations and related 

inspection information. 

It provides access to code violation and inspection information in the field, which helps 
streamline field operations and improve communication between field and office staff. This 
improved process can decrease the overall time it takes to cite and resolve potential code 
violations. Code Enforcement Operations is typically implemented by code enforcement, zoning 
administrators, and other local government agencies that want to improve their response time 
resolving code violations. 

The Code Enforcement Operations solution delivers a set of capabilities that help you review 
potential code violations, inspect code violations in the field, and monitor the resolution of code 
violations in a community. 

 

Requirements 
Code Enforcement Operations requires the following: 

• ArcGIS Enterprise 

• ArcGIS Field Maps 

 

Information products 
Code Enforcement Operations includes the following information products: 

Item Description 
Minimum 
user type 

Code Violation A map used by code enforcement officers, building officials, 
and zoning administrators to collect code violation and related 
inspection information 

Field Worker 

Code Violation 
Dashboard 

An ArcGIS Dashboards app used by planning and zoning 
administrators to monitor code violations 

Viewer 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Code Enforcement Operations 
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Use Code Enforcement Operations 
The Code Enforcement Operations solution delivers a set of capabilities that help you review 

potential code violations, inspect code violations in the field, and monitor the resolution of code 

violations in a community. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Collect code violations 
You will start by assuming the role of a code enforcement officer responsible for verifying a 

potential code violation. You are asked to use Code Violation to visit a potential code violation in 

the field and verify the details. 

1. Download ArcGIS Field Maps to a mobile device, if necessary. 

2. On the mobile device, open the app, and then sign in to your ArcGIS organization. 

3. Tap the Code Violation map to open it. 

4. Tap the plus sign to open the ArcGIS Field Maps form. 

5. Complete the form, using the following table as a guide: 

  Parameter 
  Value 

  Violation ID   Type a unique ID. 

  Full Address   Type the property address, if applicable. 

  Location   Type a description of the location (for example, front yard), if 

applicable. 

  Violation Type   Choose a category. 

  Description   Type a description. 

  Municipal 
Code 

  Type the violation code number. 

  Visible   Choose Yes or No. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 133 

  Date 
Submitted 

  Choose the appropriate date. 

  Name   Type the contact's name. 

  Phone   Type the contact's phone number. 

  Email   Type the contact's email. 

  Violation 
Status 

  Choose Open or Closed. 

6. Tap Submit or the check mark to submit the form. 

 

Monitor code violation status 
Now, you will assume the role of a planning or zoning administrator responsible for reviewing 

current open and closed violations. You are asked to use Code Violation Dashboard to monitor 

code violations. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Code 
Enforcement Operations solution. 

2. View the Code Violation Dashboard app. 

  The Code Violation Dashboard opens, showing all submitted code violations. 

3. Review the high-level metrics about code violations, such as blight, illegal signs, 
and overgrown yards. 

4. On the left, use filters to refine the results by violation type, status, or date. 

5. On the right, click a specific code violation to review the violation ID, location on the 
premises, and property address. 

  Note: 

  Alternatively, click a point on the map. 
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Communications Data Management for ArcGIS 

Enterprise 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Communications Data 

Management for ArcGIS Enterprise 
Communications Data Management for ArcGIS Enterprise can be used to map and manage 

coax, copper, fiber, and wireless communication asset information with the ArcGIS Utility 

Network. 

The solution configures ArcGIS Enterprise and the ArcGIS Utility Network to be an authoritative 
repository of communications network information and provides workflows that facilitate 
capturing information correctly and keeping it up to date. 

Communications Data Management for ArcGIS Enterprise delivers a data model that makes a 
utility network behave like a communication network, editing apps configured for ArcGIS Pro 
and preconfigured maps for data sharing. It also provides a sample utility network dataset so 
users can experience a utility network in a single-user environment. 

 

Requirements 
Communications Data Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.8 (Standard or Advanced) 

 

Information products 
Communications Data Management includes the following information products: 

Item Description Minimum user type 

Communications Data 
Management for ArcGIS 
Enterprise 

A zipped file with an ArcGIS Pro project 
package with tasks, a configured utility 
network in a file geodatabase, editor and 
auditor maps, and an asset package 
geodatabase 

Creator user type 
with ArcGIS Utility 
Network user type 
extension 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
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(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • New diagram templates, sample data, edit templates, tasks and attribute 
rules have been added to improve usability and take advantage of new 
capabilities. 

• In-depth modeling of ports, patch panels, splitters, splices, multiplexers 
and other equipment. 

• Added a new Communication Circuit Tier for tracing communication 
circuits and a Cable tier has been added to replace the removed Copper, 
Coax and Fiber tiers. 

• Removed the Medium Converter equipment, the network type transition 
will be reflected by the connector types contained within the device. 

• The data model in the solution has been updated to version 1.1. For a full 
list of updates, refer to the change log. 

1.0 • The first release of Communications Data Management for ArcGIS 
Enterprise 
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Use Communications Data Management for 

ArcGIS Enterprise 
The Communications Data Management for ArcGIS Enterprise solution provides a 

preconfigured utility network, maps, styles, step-by-step instructions, common data 

management workflows, and more. The tasks in the Communications Data Management project 

guide you through creating your own utility network using the provided schema and data loading 

options and setting up an enterprise environment. The solution also includes a data dictionary 

with descriptions of the features in the data model. 

In this topic, you will learn how to use the solution to create and manage your communications 
utility network. 

Use the instructions in the Communications Data Management task to get started with the 
solution. 

1. Sign in to your ArcGIS organization and browse to the Communications Data 
Management For ArcGIS Enterprise V1.1 item. 

2. Open the item page and click Download. 

3. Unzip and open the downloaded Communications Data Management ArcGIS Pro 
project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand Tasks and double-click the task item. 

6. In the Tasks pane, click the Explore the Data Management Solution task group 
to expand the collection of tasks. 

  Tip: 

Click each group task heading and task to view a description at the bottom of the Tasks pane. 

Each task group includes instructional steps for using the solution. Begin by exploring the 
contents of the project, tracing and editing workflows with sample data, or configuring the 
solution for your organization. 

 

Explore the solution 
The data management solution is designed for organizations that want to experience a fully 

functional communications utility network. Explore common workflows with the sample data in 

the provided single user file utility network. Task-based workflows are also provided to create 

and model your own utility network to behave like a communications system in an enterprise 

environment. The solution also provides preconfigured maps for sharing data and editing data. 

This task group includes the following tasks 

• Overview 

• What's Included 

• Review the Data Model 

• Explore the Symbology and Data 
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These tasks introduce the solution and walk through exploring the capabilities of the utility 

network. 

 

Editing Workflows 
Users are guided through editing workflows with the provided sample data. These workflows are 

designed to showcase common tasks while highlighting the capabilities of the utility network. 

Note: 

In the Contents pane, click the List by Snapping tab. Expand all feature classes to ensure 
snapping is checked for each asset group. 

This task group includes the following editing tasks: 

• Creating Communications Hub 

• Create Cable Pathway and Structures 

• Creating a Cable with Strands 

• Create a Patch Panel Chassis with Access Hub Terminal 

• Create Duct Bank 

 

Explore Diagrams 
Users are guided through create diagrams as symbolic representation of geographic information 

drawn with an applied visualization technique. It allows users to efficiently create multilevel 

representations, readily check network connectivity, and obtain logical views of any utility 

network. 

This task group includes the following diagram tasks: 

• Explore Diagrams in Utility Network 

• Cable Diagram 

• Structure Diagram 

• Splice Diagram 

• Duct Diagram 

 

Tracing and Analysis 
Tracing is a key capability of the utility network. There are several core trace configurations that 

allow you to analyze your network. 

This solution includes workflows for critical traces for communications such as customer to 
upstream switch. The Customer to Upstream Switch task walks through how to find the switch 
and ports that are passed through from a customer location. 

This task group includes the following diagram tasks: 

• Customer to Upstream Switch 
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• Find Available Strands 

• Open Ducts 

 

Install Implementation Prerequisite 
Now that the sample utility network has been explored, move on to building out a utility network 

for your own organization. Before getting started, set up the environment with the necessary 

tools. 

This task group includes the following tasks: 

• Create a Python project environment 

• Install Utility Network Package Tools 

• Install Data Loading Tools 

 

Configure Data Model for Implementation 
The data model has been developed and curated over several years to reflect the latest 

capabilities of the utility network. This solution delivers the latest model which has been 

developed specifically to support communications organizations to best manage their assets in 

a digital environment. 

After exploring the solution, complete the following steps to remove the sample data and 
prepare the data model to manage your communications network. 

This task group includes the following tasks: 

• Project and Remove Sample Data 

• Create Modifications Tables (Optional) 

• Loading Data (Optional) 

 

Prototype in a Single User Environment 
Creating a utility network that fits your organization's needs requires a solid understanding of 

your data, as well as the provided data model. We recommend starting out with a prototype to 

explore with your own data and adjust where necessary. When ready, move on to setting up 

and implementing your solution in ArcGIS Enterprise. 

To learn more about the Attribute Rules included in the Communications Data Management 
project, review the Communications Data Management Attribute Rules document. 

This task group includes the following tasks: 

• Create File Geodatabase with Schema 

• Adjust Attribute Rules 

• Update Maps' Data Sources 

• Reset Trace Location Feature Classes 

• Adjust Maps 

• Export Asset Package 
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Prototype in a Single User Environment 
These tasks are a guide to set up a utility network from start to finish. This includes creating an 

enterprise database, utility network, and sharing the final maps and services with your 

organization 

This task group includes the following tasks: 

• Setup Enterprise Database 

• Create Utility Network 

• Apply Schema 

• Adjust Attribute Rules 

• Post Process 

• Publish Services 

• Update Subnetworks 

• Update Maps Data Source to Feature Service 

• Publish Web Map 

• Reset Trace Location Feature Classes 

• Adjust Maps 

• Share with Organization 
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Community Data Aggregation 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Community Data Aggregation 
Community Data Aggregation can be used to aggregate authoritative data (for example, 

addresses and parcels) and deliver focused maps and locators to key stakeholders. 

It provides a series of tools and standard layers that streamline the maintenance of regional 
address and parcel information. Traditionally, address and parcel data is managed by local 
governments. Aggregating this data into larger geographies (county, region, watershed, or 
state) helps organizations address common needs or issues that affect residents in many local 
governments. Community Data Aggregation is typically implemented by state and regional 
organizations that want to access authoritative data and address emergency response, 
permitting, as well as address land use and regulatory issues at a more regional level. 

The Community Data Aggregation solution delivers a set of capabilities that help you transform 
and load data source data (for example, addresses and parcels) in to target dataset with a 
standard information model. 

 

Requirements 
Community Data Aggregation requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 - 2.9 (Basic, Standard or Advanced) 

 

Information products 
Community Data Aggregation includes the following information products: 

Item Description 
Minimum 
user type 

CommunityAddresses A feature layer to help organizations aggregate 
address information from authoritative sources 

Not Required 

CommunityParcels A feature layer to help organizations aggregate parcel 
information from authoritative sources 

Not Required 
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DataAssistant An ArcGIS Pro Add-in that includes the Data Assistant 
ribbon and a series of tools that have been optimized 
for migrating data from a source dataset to a target 
dataset 

GIS 
Professional 
Basic 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Community Data Aggregation 
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Configure Community Data Aggregation 
Learn how to configure the Community Data Aggregation solution to meet specific needs in your 

organization.  

 

Set up data aggregation project 
Before you begin aggregating data, create an ArcGIS Pro project, install the Data Assistant add-

in, and add the Data Assistant ribbon to the project so you can access the tools and features of 

the add-in. 

 

Data Assistant add-in 
The Data Assistant add-in includes a series of tools that have been optimized for migrating data 

from a source dataset to a target dataset that may have a different data structure. It includes a 

series of predefined methods to automatically populate attributes when migrating data to the 

target dataset. For example, one method concatenates multiple source fields into a single target 

field. Other methods help you extract the left or right characters from a field or split a single 

source field into multiple target fields. 

To use the Data Assistant add-in, you must install the Data Assistant add-in on each ArcGIS 
Pro machine that will be used to migrate data from a source dataset to one or more target 
datasets. 

To install the Data Assistant add-in, complete the following steps: 

1. Deploy the Community Data Aggregation solution. 

2. Browse to the Content section of your ArcGIS organization. 

3. Click the DataAssistant item to open the item details page and click the Download 
button to download the add-in. 

4. Extract the DataAssistant .zip file. 

5. Close any open or running ArcGIS applications. 

6. Using Windows Explorer, browse to the DataAssistant folder. 

7. Double-click DataAssistant.esriAddInX to run the installer. 

8. Click the Install add-In button. 

 

Data aggregation project 
You can use an ArcGIS Pro project and the Data Assistant add-in to migrate community 

datasets from one or more source datasets to a target dataset. 

To create a data aggregation project, complete the following steps: 

1. In ArcGIS Pro, click Add Data and browse to the My Content folder in the active 
portal. Select the CommunityAddresses or CommunityParcels layer that deployed 
with the solution. 

2. Click Add Data and browse to your source data. Add your source data to the map. 
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3. Click the Data Assistant ribbon. Ensure that the Data Assistant add-in loaded and 
is accessible in ArcGIS Pro. 

4. Save the data aggregation project. 

 

Data mapping 
The Configure Data Mapping dialog box allows you to configure settings in a selected source-

target configuration file. 

 

File panel 
The Data Assistant file properties define the active source-target configuration file and allow you 

to further configure the source dataset, target dataset, and replace settings. 

Property Description 

Source-Target 
Configuration File 

The active source-target configuration file for Data Mapping. 

Source Layer The path to the source layer for the active configuration file. 

Replace By Field Value When enabled, defines the selection query for the target layer that will 
be used when the Replace Data tool is executed. 

Target Layer The path to the target layer for the active configuration file. 

 

Fields panel 
The Data Assistant field methods define the actions to occur when migrating data from a source 

dataset to a target dataset. You can use them to populate new values in the target dataset or 

perform more advanced field mapping that may be necessary when the target dataset has a 

different data structure. 

You can configure the following Data Assistant methods in your data migration project: 

Method Description 

Copy Copy source field values to target fields. 

Default Value Sets a default value for a field. 

Value Map Set target values based on source value. 

Change Case Change the case of the source text string. 

Concatenate Concatenate source values into a string. 

Left Extract a number of characters from the left. 

Right Extract a number of characters from the right. 

Substring Extract a set of characters from a string. 

Split Split a string into parts and use one part. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 144 

Conditional Value Construct an if/else statement. 

Domain Map Load and map domains values. 

 

Data Assistant settings 
You configure the following settings for Data Assistant. 

 

Match library 
When updated, the Data Assistant Match Library will assist with automatically creating field 

mappings based on configuration files you create. 

Setting Description 

Update Match 
Library 

The Match Library will be updated to include the settings in the currently 
selected source-target configuration file. 

Clear Match 
Library 

All saved settings in the Match Library will be erased. 
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Use Community Data Aggregation 
The Community Data Aggregation solution delivers a set of capabilities that help you transform 

and load data source data (for example, addresses and parcels) in to target dataset with a 

standard information model. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

This solution supports two parcel data aggregation models, both of which are supported by the 
same set of tools: 

• The Contributor Model allows authoritative data producers to update the community 
layers directly on a regular schedule. 

• The Aggregator Model allows authoritative data producers to send their data to a 
community aggregator so the community layer can be updated. 

Choose a parcel data aggregation model (Contributor or Aggregator) and configure the Data 

Assistant to load your source data. 

 

A quick tour of Data Assistant 
The Data Assistant add-In includes a set of focused tools that are organized on a Data Assistant 

toolbar. These tools enable you to create data mapping files and load or replace data in your 

target datasets. 

Tool Tool name Description 

 

New File Creates a new source-target configuration file for the selected source and 
target datasets. 

 

Data 
Mapper 

Enables users to define the field mapping and settings for the selected 
source-target configure file. 

 

Preview Creates a preview of the output from the source-target configuration file in 
a local database with a sub-set of records. 

 

Stage Stage Results in a local database using a subset of the records, skip final 
processing. 

 

Append 
Data 

Appends data into the target dataset from the source dataset according to 
the settings in the source-target configuration file. 

 

Replace 
Data 

When the Replace By Field Value option has been enabled and 
configured, replaces data in the target dataset from the source dataset 
according to the settings in the source-target configuration file. 

 

Settings Optional settings for the data mapping tool. 

Load data using Data Assistant add-in 
The Data Assistant add-in can be used by organization staff in order to migrate data from a 

source to target dataset, as well as schedule automated updates of the community layers. 
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Update community layer 
The Data Assistant Add-In includes a series of tools that have been optimized for migrating data 

to the CommunityParcels and CommunityAddresses hosted feature layers, as well as updating 

this data on a regular interval. 

To migrate your source data to one of the hosted feature layers provided and configure updates, 
complete the following steps: 

1. Open your data aggregation project in ArcGIS Pro. 

2. Sign in to your ArcGIS organization and make it the active portal. 

3. Click the Data Assistant ribbon. 

4. In the Source Dataset parameter, browse to the source dataset, and then click 
OK. 

5. In the Target Dataset parameter, browse to the CommunityParcels or 
CommunityAddresses dataset, and then click OK. 

6. In the Source-Target Configuration File parameter, browse to an output location 
and provide a name, and then click OK. 

7. Click Run. 

8. Click Data Mapper and select the Configuration File you created previously. Click 
Fields. 

9. Select the source fields and review the initial field mapping. Configure any 
additional fields and required data assistant methods. Once complete, click Apply. 

  Tip: 

  For hosted feature layers in ArcGIS Online, navigate to the Data tab and click Fields to 
find more information about each field in the data model. 

10. Optionally, click Preview and select a configuration file. Specify the Number of 
Features you'd like to generate in the preview. Click Run. 

11. Click Append Data or Replace Data and select the Configuration File you created 
previously. 

– If you are contributing or aggregating data for the first time, choose Append 
Data. This tool will add all features in the source dataset to the target 
dataset. 

– If you are updating data that already exists in the target dataset, choose 
Replace Data. This tool will use a defined query to replace specific features 
in the target dataset. 

12. Click Run. 

Note: 

In the Settings tool, the Update Match Library option can be used to use the updated field 
mapping to use fuzzy logic in order to speed up data loading in the future. 
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Schedule updates 
The Data Assistant tools can be used with Windows Task Scheduler to update layers on a 

regular interval. Scheduled updates will ensure users have access to current information to 

support more dynamic decision-making. 

To update community data on a schedule, complete the following steps: 

1. Using ArcGIS Pro, open the Python window 

2. Import ArcPy by typing the following command: 

  import arcpy 

3. Import a python toolbox from the Data Assistant tools by typing the following 
command: 

  arcpy.ImportToolbox(r"C:\Users\user\AppData\Local\Esri\ArcGISPro\Assembly
Cache\{28142961-b645-420f-ba2a-
72bcf8212558}\GPTools\DataLoadingAssistant.tbx") 

4. Specify your XML configuration file by typing the following command: 

  arcpy.dla.ReplaceData(r"C:\Users\youruserprofile\Documents\ArcGIS\Project
s\MyProject\ReplaceData.xml") 

  Note: 

  Using the Append Data and the Replace data tools, you can specify multiple XML files, 
separate each XML file with “;” 

5. Right-click in python window and choose to Save Transcript, this will save a new 
python file. 

6. Open Windows Task Scheduler. 

  Note: 

  Use Windows Start menu search box to find Windows Task Scheduler. 

7. Select Action > Create Task and name your task. 

8. Select the Actions tab and click New. 

9. Set Action to Start a Program. 

10. Browse to the location of your ArcGIS Pro python installation. 

  C:\Program Files\ArcGIS\Pro\bin\Python\Scripts\propy.bat 

11. In the Add Arguments text box, enter the full path of the script saved in step 5. 

 

Community Health Assessment 
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This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Community Health Assessment 
Community Health Assessment can be used to collect community health information, at the 

household-level, required for disaster response or health action plans. 

Health and Human Services professionals need information to make informed decisions as they 
allocate health resources. Timely access to community health information helps leaders 
maintain situational awareness, confirm assumptions and understand community need. The 
Community Assessment for Public Health Emergency Response (CASPER) framework 
(developed by the World Health Organization and adopted by the U.S. Centers for Disease 
Control and Prevention) framework to plan randomized clusters, conduct health assessments, 
and monitor progress accordingly was used. This framework has become a common 
methodology used to understand community need. Community Health Assessment is typically 
implemented by health and human services agencies or health care organizations that want to 
leverage CASPER principles as they conduct health assessments to understand community 
need. 

The Community Health Assessment solution delivers a set of capabilities that help you plan 
community health survey areas, collect survey responses from random households and monitor 
key indicators as the assessment occurs. 

 

Requirements 
Community Health Assessment requires the following: 

• ArcGIS Online 

• ArcGIS Pro 2.6 or later 

 

Information products 
The Community Health Assessment solution includes the following information products: 

Item Description 
Required 
User Type 

Community Health 
Assessment Planner 

An ArcGIS Pro project used to plan community 
health survey clusters used to conduct assessment 
surveys. 

GIS 
Professional 
Basic 

Community Health 
Assessment Manager 

A configuration of the Crowdsource Manager app 
used by assessment managers to assign survey 
teams. 

Editor 
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Community Health 
Assessment Survey 

An ArcGIS Survey123 form used to conduct health 
assessments. 

Field Worker 

Community Health 
Assessment Progress 
Dashboard 

An ArcGIS Dashboards app used by health and 
human services managers to monitor survey 
teams and the progress of a health assessment. 

Viewer 

Community Health 
Assessment 
Dashboard 

An ArcGIS Dashboards app used by 
epidemiologists and executives to monitor key 
indicators as the assessment occurs. 

Viewer 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Community Health Assessment 
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Configure Community Health Assessment 
Configure the Community Health Assessment solution to meet specific needs in your 

organization. 

 

Modify the survey 
The Community Health Assessment Survey is a survey with a comprehensive collection of 

questions, all based on the Community Assessment for Public Health Emergency Response 

(CASPER) Toolkit. In addition to the questions provided in the toolkit, questions for coronavirus 

disease 2019 (COVID-19) assessments are included. You have the option to add your own 

specific questions or hide some of the questions you do not need. 

All of the steps below use ArcGIS Survey123 Connect to modify the survey. See Install ArcGIS 
Survey123 for more information. 

Note: 

The following changes may impact the Community Health Assessment Progress 
Dashboard or the Community Health Assessment Dashboard. See dashboards 
documentation to learn more about configuring dashboards. 

 

Hide questions 
There are over 200 questions in the survey, and many may not be relevant to the issues that 

you want to assess. The survey has logical groupings of questions. Individual questions can be 

hidden, or entire groups of questions can be hidden if necessary. 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Community Health Assessment Survey  to download the survey. 

3. Click Community Health Assessment Survey  again to open the survey. 

4. In the left pane, click Open XLSForm Spreadsheet. 

5. In the Microsoft Excel spreadsheet, verify the survey tab if highlighted. 

6. Find a green highlighted row of the type: begin group. For example, find the group 
named damage repair. 

7. Scroll over to the relevant column. 

8. Change the value of the relevant column to false. 

  This process will hide all questions within that group. You can also do this for specific 
questions within a group. 

9. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect to verify the group no longer appears. 

10. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your 
changes. 
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Change a survey event 
Health assessments are often designed in the context of an emergency or event. Therefore, 

several questions may pertain to the status of that event. By default, the Community Health 

Assessment Survey specifies the event to be COVID-19. You can change one variable name in 

the survey to a different event, such as the name of a flood or hurricane. Then all questions will 

update to that name. 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Community Health Assessment Survey  to download the survey. 

3. Click Community Health Assessment Survey  again to open the survey. 

4. In the left pane, click Open XLSForm Spreadsheet. 

5. In the Microsoft Excel spreadsheet, verify the survey tab if highlighted. 

6. Select the first row for the surveyevent variable. 

7. Scroll over to the default column. The value should read COVID-19 Pandemic. 

8. Change the value from COVID-19 Pandemic to the name of another event or 
disaster. 

9. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

10. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your 
changes. 

 

Change the team names list 
By default, the survey has a drop-down list of team names as simple number values for Team 1 

through Team 15. Follow the steps below to change the list to a smaller number of teams or to 

change the names of your teams. 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Community Health Assessment Survey  to download the survey. 

3. Click Community Health Assessment Survey  again to open the survey. 

4. In the left pane, click Open XLSForm Spreadsheet. 

5. In the Microsoft Excel spreadsheet, click the choices tab. This tab comprises all 
the selectable options for survey questions. 

6. Near the top of the spreadsheet, revise the survey to reflect your team names. 

7. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

8. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your 
changes. 

 

Add questions 
Your community may have special circumstances you want to assess. Follow the steps below to 

add questions to the survey. 

1. Sign in to your ArcGIS organization and browse to the Community Health 
Assessment Survey hosted feature layer. 
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2. Add a new field to a layer in the Community Health Assessment Survey hosted 
feature layer. 

3. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

4. Click Community Health Assessment Survey to download the survey. 

5. Click Community Health Assessment Survey again to open the survey. 

6. In the left pane, click Open XLSForm Spreadsheet. 

7. In the Microsoft Excel spreadsheet, verify the survey tab if highlighted. 

8. Insert new records that represent your new fields. Refer to the Survey123 Connect 
documentation for more details on modifying surveys. 

9. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

10. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your 
changes. 

11. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

12. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your 
changes. 
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Use Community Health Assessment 
The Community Health Assessment solution delivers a set of capabilities that help you plan 

community health survey areas, collect survey responses from random households and monitor 

key indicators as the assessment occurs. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Plan survey areas 
The Community Health Assessment is based on guidelines from the Centers for Disease 

Control and Prevention (CDC) Community Assessment for Public Health Emergency Response 

(CASPER) framework. The CASPER framework uses a randomized sampling methodology to 

determine in which areas community surveys should be conducted to produce a result that is 

representative of the entire study area. 

Typically, in this specific CASPER methodology, a Community Health Assessment is conducted 
using 30 survey areas or clusters within the survey area. These clusters are commonly defined 
by census blocks as the geographic unit. The clusters are randomly selected, with the number 
of households given a higher weight, which increases the chance of a census block being 
selected. Once the clusters are defined, interview teams will select seven households in each 
survey area to conduct survey assessments. This workflow will guide you through the process 
of defining the survey areas (clusters). 

 

Plan and create survey areas 
You will start by assuming the role of an epidemiologist or GIS analyst who will create the 

survey areas within the area of interest to define where the assessments will be conducted. 

1. Download and open the Community Health Assessment Planner ArcGIS Pro 
project and sign in using your ArcGIS organizational account. 

2. On the View tab, in the Windows group, click Catalog and click Catalog Pane. 

3. In the Catalog pane, expand Tasks and double-click the Getting Started Task. 

4. Complete all steps in the Add Survey Area step. 

  This task provides an overview of the process to add a Survey Areas layer that is deployed 
with the solution. The layer will have a broken reference, which you will point to the 
deployed hosted feature layer. 

5. In the Catalog pane, expand Tasks and double-click Plan Survey Areas. 

6. Complete all steps in the Plan Survey Areas task. 
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Assign teams 
Once the survey areas are defined, you can assign teams to conduct the surveys within the 

selected survey areas. The Community Health Assessment Manager allows you to assign 

teams to the survey areas from the previous task. 

 

Assign teams and notify team members 
You will now assume the role of a community assessment manager or team lead who needs to 

assign teams and notify team members in their survey areas. 

1.  Sign in to your ArcGIS organization and browse to the Community Health 
Assessment Manager app. 

2. Select a record in the table that you want to assign a team. 

3. Review the details of the survey area and click the Edit button in the upper right 
corner of the pane. 

4. Change the Team value to a team in the drop-down list. Optionally, add more 
comments on this survey area. 

5. Click Save. 

  Once a team is assigned, you can notify individual teams of their duties and monitor 
progress. 

6. Click the Send Survey Info button. 

 

Conduct health assessment surveys 
Team members conduct assessments in the field at defined intervals (using the CASPER 

methodology) based on the number of housing units in each survey area. 

 

Conduct surveys in your survey area 
You will now assume the role of an interview team member who will conduct surveys in the field 

using your mobile device. The team manager has previously assigned you to a team. 

Note: 

The default survey has many questions that may not be related to your assessment. See 
the Configure Community Health Assessment topic to learn how to modify the survey. 

1. Open the email sent by the team manager, as described in the previous step. 

  The instructions indicate the number of surveys and how surveys must be conducted. 

2. Click the first hyperlink to open a map of the assigned survey area. 

  This hyperlink is used to help you ensure you are conducting assessments in the assigned 
survey area. You can use the GPS on the map to verify your location and determine 
whether you are currently within the assigned survey area. 

3. Click the second hyperlink to access the survey. 
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4. If this is the first time conducting the survey, click the Download button to 
download the Survey123 field app. 

5. Sign in to ArcGIS Survey123. 

6. Expand the Identification and physical location information. 

7. Fill in all information in this group. 

8. Expand the Demographic and functional needs section. 

9. Fill in all information in this group. 

10. Scroll down to the end of the survey. 

11. Make sure to choose a value for Survey Status End. 

12. Click the green check mark in the lower right to submit the survey. 

Tip: 

The Survey123 app allows you to complete the surveys offline. The email from the team 
manager automatically fills in the team, housing units, and survey area ID when using the 
app with the steps described above . However, a browser version of the Community Health 
Assessment Survey can also be used if the app is not installed. 

 

Complete an incomplete survey 
In some cases, the person you are interviewing may be unwilling or unable to complete the 

survey in one visit and may agree to finish the survey at a later time or date. In this case, you 

can complete a survey you submitted that is incomplete. 

1. Open the Survey123 app. 

2. Select the incomplete Community Health Assessment Survey. 

3. At the bottom of the screen, click Sent. 

  Note: 

  This option will only appear if you have submitted surveys with the value of Incomplete. 

4. Fill in the remaining information in the survey and submit. 

 

Monitor assessment progress 
Now, you will assume the role of the assessment manager or team leader who wants to monitor 

progress of the assessments being captured in the field. The CASPER toolkit has specific 

criteria defined for cooperation rates, contact rates, and completion goals. The traditional goal is 

to complete 80 percent of the surveys expected. This dashboard will help you determine 

whether you are reaching those metrics and whether the teams are completing their work. 

1.  Sign in to your ArcGIS organization and browse to the Community Health 
Assessment Progress Dashboard. 

2. Open the Community Health Assessment Progress Dashboard app. 

  The app opens with an overview of the current status. 
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3. Review the list of teams and click a team in the chart to see the dashboard update. 

4. Select the other charts to monitor the progress of the health assessment. 

 

Visualize key metrics from the assessment 
The demographic and functional needs section of the survey is particularly useful to executives 

who want a quick glance of their community. Visualizing the demographic information will help 

determine whether the demographic you have surveyed aligns with the overall makeup of the 

community. In addition, key metrics such as monitoring rent and mortgage payments or access 

to healthy foods are vital health indicators. 

1. Sign in to your ArcGIS organization and browse to the Community Health 
Assessment Dashboard app. 

2. Open Community Health Assessment Dashboard. 

  The app opens with an overview of the key indicators captured in the field. 

3. Review the Age Distribution chart and click a specific age category to see the 
dashboard update. 

4. Select the other charts to monitor the progress of the health assessment. 

 

View detailed survey results 
The demographic dashboard shows only a portion of what could be captured during 

assessments. Epidemiologists may prefer to highlight different information from the survey. You 

can create a dashboard or modify the demographic dashboard to see these results. In addition, 

you can export these results to share in other software applications. 

1. In a browser, go to My Surveys and sign in. 

2. Click Community Health Assessment Survey. 

3. Click the Analyze tab. 

4. Scroll down to examine the various questions that were asked during the survey. 

5. In the upper left, search for a key term of another question collection such as 
COVID. 

6. Click the Data tab. 

7. Click the Export drop-down menu and export to an Excel file. 
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Community Health Outreach 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Community Health Outreach 
Community Health Outreach can be used to communicate health initiatives, increase 

participation in key initiatives, and ensure the public knows where they can locate health 

services. 

Health and Human Services agencies have learned that a community's health goes beyond just 
access to healthcare services. Understanding the interplay of behavior, physical and social 
environments, biological and genetic factors, and access to health systems helps health and 
human services agencies devise initiatives that ultimately increase the well-being of all 
residents. Increasing public health requires a robust and transparent public education campaign 
that provides accurate healthcare information, progress on key healthy community initiatives, 
and guidance needed to access assistance. A key aspect of any healthy community program is 
a web destination that helps the public locate healthcare providers, review key initiatives, 
request assistance and volunteer to help. Community Health Outreach is typically implemented 
by public or private health and human services agencies that want to increase the quality of life 
for all residents and ensure the public understands where health services can be found in the 
community. 

The Community Health Outreach solution delivers a set of capabilities that help you launch a 
healthy communities web destination, provide an authoritative inventory of healthcare services, 
and engage the public in key health initiatives that increase the quality of life for all. 

 

Requirements 
Community Health Outreach requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 Connect 

 

Information products 
Community Health Outreach includes the following information products: 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 158 

Item Description 
Required 
User Type 

Health Resource 
Inventory 

An ArcGIS Web AppBuilder app used by health and 
human service agencies to inventory all health resources 
in their community 

Editor 

Healthy 
Communities 

An ArcGIS Hub site used by health and human service 
agencies to communicate key health initiatives, upcoming 
events, and ensure the public knows resources available 
for their health needs 

Not required 

Health Resource 
Locator 

An ArcGIS Web AppBuilder app used by the public to 
locate health resources 

Not required 

Health Resource 
Feedback 

An ArcGIS Survey123 form used by providers or the 
general public add their location or provide updated 
information to the Health Resource Inventory 

Not required 

Healthy Community 
Outreach 
Volunteers 

An ArcGIS Survey123 form used by the public to 
volunteer to help with various public health outreach 
activities 

Not required 

Healthy 
Communities 
Pledge 

An ArcGIS Survey123 form used by the public to pledge 
to lead healthy lives 

Not required 

Community Health 
Volunteer Manager 

A Crowdsource Manager app used by health and human 
services staff to manage volunteers 

Editor 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Community Health Outreach 
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Configure Community Health Outreach 
In this topic, you will learn how to configure the Community Health Outreach solution to meet 

specific needs in your organization. 

 

Load data 
In some cases, you may already have this information in ArcGIS or another mapping system. 

Review the layers provided with the solution and determine what source data you want to load. 

Then, load your existing data into the layers provided with the solution before sharing the maps 

or apps. 

Once you have determined what source data must be loaded, complete one or more of the data 
loading workflows below. 

 

Load data from a shapefile or file geodatabase 
Load data into a health resource layer from a shapefile or file geodatabase by completing the 

following steps: 

1. Create a .zip file of your shapefile or file geodatabase. 

2. Sign in to your ArcGIS organization and browse to the feature layer you want to 
populate. 

3. Open the item page and click Update Data > Append Data to Layer . 

4.  Click Choose File and browse to your .zip file, and click Open. 

5. Click the Contents drop-down arrow and choose Shapefile or File Geodatabase. 

6. Click Upload and Continue. 

7. Click Choose the layer that you want to load data into drop-down arrow and 
choose the layer that contains the updated data. 

8. Uncheck Update existing features. 

9. Click Show field matching and map the fields between the two layers. 

10. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

 

Populate operational hours 
This solution leverages the Opening Hours Specification to display operating hours for a place 

or service. When you populate the data fully, Arcade expressions interpret the data and display 

the operating hours in a human-readable format in the map pop-up. Understanding the data 

specification and options in the Arcade expressions will help you populate your data and display 

it in the maps and apps provided with the ArcGIS Solution. 
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Operating Hours Specification 
The Operating Hours Specification allows you to store a combination of operating hours in a 

single field but relies on a series of data standards to render the information correctly. To ensure 

operating hours are displayed correctly, follow the standards below: 

• Enter all times using a 24-hour clock without a leading 0—for example, Tu (7:00-
19:00). 

• Use a two-letter abbreviation for each day, with the first letter capitalized—for 
example, Mo, Tu, We, Th, Fr, Sa, Su. 

• When a location is open 24 hours a day, use 24 Hours—for example, Mo (24 
Hours). 

• When a location is closed on a specific day, use Closed—for example, Sa-Sun 
(Closed). 

• Enclose all times and closed statuses in parentheses—for example, Tu (7:00-
19:00); We-Mo (Closed). 

• Separate days and ranges with a semicolon to denote the two (or more) groups—
for example, Th-Fr (7:00-19:00); Sa (24 Hours). 

Using the standards above, a diverse set of operating hours can be populated for your places 

and services. Some common examples include the following: 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. seven days a week, 
populate the operating hours field with the following: Mo-Su (9:00-17:00). 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. during the week and 
closed on weekends, populate the operating hours field with the following: Mo-Fr 
(9:00-17:00); Sa-Su (Closed). 

• To specify the place is open one day (Tuesday) a week, populate the operating 
hours field with the following: Tu (7:00-19:00); We-Mo (Closed). 

• To specify the place has operating hours that vary by day, populate the operating 
hours field with the following: Mo-Tu (9:00-17:00); We (Closed); Th-Fr (7:00-19:00); 
Sa (24 Hours); Su (Closed). 

Operating hours data can be populated all at once for many places and services using Calculate 

field values or uniquely entered for each place or service using an application provided with the 

solution. 

 

Arcade expressions 
The Arcade expressions include several settings that allow you configure the look and feel of 

the operating hours when they are displayed in the web map pop-up. The expressions work with 

the operating hours data and web map pop-up configurations to display current operating hours 

in your map and app. 

This solution uses three Arcade expressions: Hours, Days, and Open/Closed. To modify one of 
these expressions, complete the following steps: 
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1.  Verify that you are signed in to your ArcGIS organization and browse to the Health 
Resource Locator map. 

2. Open the item page and click Open in Map Viewer. 

3. Click More Options and click Configure Pop-up on a health resource layer. 

4. Under Attribute Expressions, double-click the Arcade expression you want to 
modify. 

  Each Arcade expression has a set of variables that can be configured according to your 
organization’s needs. Review the expression notes and modify the variables as needed. 
Do not change anything else in the expressions. 

5. Click OK. 

6. Repeat the above steps for each health resource layer in the map. 

 

Configure Health Resource Locator 
The Health Resource Locator can be used by the public to locate health resources. It has some 

common configuration options you may want to explore and directions from your current 

location to a health resource can be enabled. 

 

Configure directions 
Health Resource Locator can be configured to provide directions to the nearest health 

resources. Follow the steps below to enable directions: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Health 
Resource Locator app. 

2. Click Edit Application. 

3. Browse to the Locate Health services widget and click the Edit button. 

4. Click the Direction Settings tab, check Enable Directions and click OK. 

5. Save the app and share it with everyone. 

6. Open the app. 

 

Modify surveys 
The Healthy Community Outreach Volunteers form can be used by the public to volunteer to 

help with various public health outreach activities. After reviewing the survey, you may decide 

you want to collect additional information from volunteers when they apply. 

To modify the volunteer survey, complete the following steps: 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click a survey and if prompted, download the Healthy Community Outreach 
Volunteers survey. 
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  Note: 

  If you have not downloaded the chosen survey, you will be prompted to click Download 
in the Download window, then click OK. You will also need to click the survey again to 
open it. 

3. On the side toolbar, click the Open XLSForm spreadsheet button. 

4. Edit the survey to reflect your needs. 

5. Click the Settings tab, and in the submission_url column, enter a hosted feature 
layer item URL. 

  Tip: 

  To create this URL, concatenate the Item ID with the portal Content Root. The Item ID 
can be found at the end of the URL immediately following ?id=. For an ArcGIS Online 
item, the URL looks like the following: 
https://www.arcgis.com/sharing/rest/content/items/21a6c530b31a4523bdff7gg94c9c5d9a
. 

6. Save and close the Microsoft Excel spreadsheet. 

7. In ArcGIS Survey123 Connect, click Publish on the side toolbar to publish your 
changes. 

 

Configure Healthy Communities site 
The Community Health Outreach solution includes the Healthy Communities ArcGIS Hub site 

that your organization can configure with your branding and use to share community health 

information with the public. 

 

Update with organizational information 
After deploying the Community Health Outreach solution, the Healthy Communities site layout 

only requires a few updates to fit your local context. Consider what information you already have 

and what you can most easily find. To update your site, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Healthy 
Communities site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Our Focus section, hover over each text card and click edit pencil .  

5. Update the focus area into the text box and repeat for each focus area. 

6. Scroll to the Frequently Asked Questions section, hover over the card and click 
the edit pencil, and update the questions and answers. 

7. Scroll to the Partners section, hover over the card and click the edit pencil, and 
update the image. 
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8. To modify your site’s footer, click Customize Toggle  on the side panel. 

9. Click Footer.  

  A custom footer is already provided, and in most cases, it needs to be updated with your 
organization's branding, contact information, and social media references. 

10. Click the HTML text box. 

  The HTML window appears. 

11. Make the necessary changes and click Apply. 

12. Click Save. 

 

Add health initiatives 
The Healthy Communities hub site includes a section that can be used to share information on 

key health initiatives. You can share links to other hub sites, web destinations, or even health 

related apps. There are several other ArcGIS Solutions you could deploy to assist with the key 

health initiatives (for example, homelessness, COVID-19, and addiction). Any one of those 

solutions could be cataloged in the key initiatives section. 

To add key health initiatives, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Healthy 
Communities site. 

2. Click Configure App. 

3. Click the Edit tool on the left of the screen. 

4. Scroll to the Programs and Initiatives section. 

5. Hover over the gallery and click Edit. 

6. For Select Groups, choose the group used to catalog the hub sites, web 
destinations, or health related apps are shared. 

7. Click Save. 

8. Click the drop-down arrow next to Save, and chose Publish Draft. 

 

Share health metrics 
The Healthy Communities hub site includes a section that can be used to share health metrics. 

You can share a link to an existing dashboard you might have. If you do not have an existing 

dashboard, you can deploy the Performance Management solution and use this solution to 

communicate health metrics and progress made. 

To share health metrics, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Healthy 
Communities site. 

2. Open the item page and click View Application. 

3. Click the Edit button to open the site editor. 

4. Scroll to the How Are We Doing? section, hover over the card and click the 
settings button. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 164 

5. Click the Select Application button. 

6. Browse to your dashboard or deployment of the Performance Management 
solution and click Select. 

7. Click Save and click Publish Draft. 

 

Share items with public 
Several maps and apps included in the Community Health Outreach solution must be shared 

with everyone to display on the public-facing hub site. The solution includes several feature 

layer views to avoid sensitive or incorrect data from being shared accidentally. Use the 

information below to help determine which items need to be shared with everyone. 

To share the Community Health Outreach maps and apps, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Health 
Resource Locator app. 

2. Open the item page and click Share. 

3. In the Share window, click Everyone (public). 

4. Click Save. 

5. Repeat steps 2 through 5 to share the following items with everyone: 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 165 

Use Community Health Outreach 
The Community Health Outreach solution delivers a set of capabilities that help you launch a 

healthy communities web destination, provide an authoritative inventory of healthcare services, 

and engage the public in key health initiatives that increase the quality of life for all. 

In this topic, you’ll learn how to use the applications in the solution by assuming various roles of 
individuals performing these duties. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Inventory health resources 
Health resources in a community can often change. New providers become available, operating 

hours and contact information at certain facilities change over time. This can make it challenging 

for citizens in your community to know where to find accurate information. A variety of health 

resources can be added to your inventory and shared with the public. The Health Resource 

Inventory app can be used by health and human service agencies to inventory health resources 

that will be shared with the public. 

In this workflow, you will assume the role of a staff member in a health and human services 
agency. You have been asked to inventory known health resources in your community. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Community Health Outreach solution. 

2. View the Health Resource Inventory app. 

3. On the right, click the Resource Editor to ope the widget, if necessary. Scroll 
through the list of available health resource types and place the location of a 
resource of your choice on the map. 

  The widget includes templates for various health resource types. 

4. In the widget, click the drop-down arrow or use the search field to locate the 
resource type. 

5.  Click the resource symbol, and then click the resource's location on the map to 
place the point. 

  Tip: 

  If you already have a list of health resources in a spreadsheet, you can use the Load 
Health Resources tool to load the entire list of testing sites. 

  Note: 

  The Load Health Resources widget will consume credits if you use an address in your 
spreadsheet to create the new health resource location. 
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6. In the Resource Editor, complete the form with details about the health resource 
location that you placed on the map; be as complete as possible. 

  Tip: 

  This solution leverages the Operating Hours Specification and relies on a series of data 
standards—for example, Mo-Fr (7:00-19:00)—to render the operating hours correctly. 
For more information, see Populate operating hours. 

7. Click Save to place the point on the map. 

8. Repeat these steps for each health resource that you want to add to your inventory.  

 

Review healthy community destination 
Improving public health outcomes requires a robust and transparent public education campaign 

that provides accurate healthcare information, progress on key healthy community initiatives, 

and guidance needed to access assistance. A key aspect of any healthy community program is 

a web destination that helps the public locate healthcare providers, review key initiatives, 

request assistance and volunteer to help. 

In this workflow, you will assume the role of a resident or member of the public. You are 
interested in the healthy community program, key initiatives, health resources available in the 
community. 

1. In a browser, from the Community Health Outreach solution, view the Healthy 
Communities hub site. 

2. Review the information on the site, including the Healthy Communities program 
focus, frequently asked questions, upcoming events, and other information 
provided. 

3. Scroll to the Programs and Initiatives section and review the healthy community 
initiatives in your community. 

  Note: 

  Each initiative may link to a separate ArcGIS Hub site, depending on how you configured 
your site. 

 

Take healthy community pledge 
A healthy community is built on active participation and recognition of important factors that 

influence a persons health. Raising awareness and encouraging members of the public to live 

healthy lifestyles is an important aspect of a public education campaign. The Healthy 

Communities Pledge survey can be used to create awareness of key health issues and collect 

public pledges to lead healthy lives. To take the pledge, complete the following steps: 

1. Return to the Healthy Communities hub site, if necessary, and then scroll to the 
Healthy Communities Pledge section. 
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2. Click the Take the Pledge button. 

3. Complete the survey, and then press Submit. 

 

Locate health resources 
Access to comprehensive health care services is important for promoting and maintaining 

health, preventing and managing disease, reducing unnecessary disability and premature 

death, and achieving health equity for all. The Health Resource Locator app can be used by the 

public to locate health resources. To locate health resources in the community, complete the 

following steps: 

1. Return to the Healthy Communities hub site, if necessary, and then scroll to the 
Find Health Services section. 

2. Click the Find Health Services button. 

  The Health Resource Locator app opens and shows all health resources from your 
inventory. 

3. Use the Locate Health Services widget to search for an address or place, or click 
the location on the map. 

4. Optionally, drag the slider to increase or decrease your search radius. 

  The results shown in the Locate Health Services widget highlight the various health 
resources near the location that you entered and within your search radius. 

5. In the widget, click one of the results. 

  Tip: 

  If you do not see any results, search for a new location or drag the slider to increase the 
search radius. 

 

Contribute missing health resources 
Developing a comprehensive inventory of health care providers is challenging. New providers 

will open, existing providers may close, and information you have about existing providers will 

continuously evolve. Engaging health care providers and the public is one way you can curate a 

health resource inventory and respond to changes in the community. The Health Resource 

Feedback survey can be used by providers to add a missing health resource location. It can 

also be used by the public to correct inaccurate information presented in the Health Resource 

Locator. 

In this workflow, you will assume the role of a staff member at a local health care provider. You 
have noticed that your health care facility is not visible in the Health Resource Locator and have 
been asked to add the facility and services provided. 

1. Return to the Healthy Communities hub site, if necessary, and then scroll to the 
Find Health Services section. 

2. Click the let us know hyperlink. 

3. Complete the Health Resource Feedback survey, and then click Submit. 
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  Tip: 

  The feedback will not appear in the Health Resource Locator until is has been reviewed 
and approved by the health and human services agency in the Health Resource 
Inventory app. To be notified automatically when these submissions are entered, you 
can set up Survey123 webhooks. 

 

Volunteer to help 
Health and Human Services agencies are always looking for volunteers that can help with 

activities that advance the overall health of the community. The Healthy Community Outreach 

Volunteers survey can be used by the public to volunteer to help with various public health 

outreach activities. 

In this workflow, you will assume the role of an engaged resident in the community. You have 
noticed several healthy community issues that are of interest to you and you want to volunteer 
your time, experiences, and skills. 

1. Return to the Healthy Communities hub site, if necessary, and then scroll to the 
Volunteer to Help section. 

2. Click the Volunteer Now button. 

3. Complete the Healthy Community Outreach Volunteers form, and then click 
Submit. 

 

Manage volunteers 
As volunteers offer to help with a variety of health outreach activities, health and human 

services staff must contact the volunteers to ensure that each volunteer has the required skills 

and experiences and then align their skills and experiences with appropriate volunteer 

opportunities. The Community Health Volunteer Manager can be used by health and human 

services staff to manage volunteers. 

In this workflow, you will assume the role of a staff member in a health and human services 
agency. You have been asked to review volunteer applications and contact each volunteer after 
you have completed your review. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Community Health Outreach solution. 

2. View the Community Health Volunteer Manager app. 

3. Expand the left panel, if necessary and click the Healthy Community Outreach 
Volunteers map. 

4. From either the table or the map, select a volunteer. 

  The volunteer's application opens at the bottom left. 

5. Review the volunteer's application form. 

6. Click Edit button to begin editing. 

7. Click the Status drop-down arrow and choose a status. 
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8. Optionally, in the comments text box, add comments to the volunteer application 
form. 

9. Click Save. 

10. Click Send Volunteer Email. 

  Your email client opens, which allows you to format the email message and attach any 
additional information that you want to share with the volunteer. 

 

Review health resource contributions 
Engaging health care providers and the public is one way you can curate a health resource 

inventory and respond to changes in the community but it is critical to review contributions made 

through the Health Resource Feedback form before making them visible in the Health Resource 

Locator app. 

In this workflow, you’ll assume the role of a staff member in a health and human services 
agency. You have been asked to review health resource contributions and make the necessary 
updates to your inventory. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Community Health Outreach solution. 

2. View the Health Resource Inventory app. 

  On the map, red diamonds indicate the locations marked in feedback contributions. 

3. On the right, click the Resource Editor button to open the widget, if necessary. 

4. On the map, click a red diamond. 

  Tip: 

  Current health care resources will be symbolized with a circle. 

5. Review the health resource contribution. 

6. If applicable, use the information in the contribution to create a health resource or 
update an existing one. 

7. After you finish updating your inventory, click the red diamond again to open the 
feedback form, and then and change the status to Reviewed.  
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Community Science 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Community Science 
Community Science can be used to solicit plant and animal observations from community 

scientists, manage each observation, and monitor community science programs. 

It encourages engagement with community scientists, and the location-enabled observations 
help community science program managers evaluate the effectiveness of community science 
initiatives. Contributing plant and animal observations to a larger initiative gives community 
scientists a sense of ownership and investment in the protection of these areas, and exploring 
observations submitted by others encourages further engagement. Community Science is 
typically implemented by conservation organizations, natural resource departments, and other 
government agencies that want to take a data-driven approach to conserving plant and animal 
populations. 

The Community Science solution delivers a set of capabilities that help you engage community 
scientists, manage incoming observations, and monitor community science programs. 

 

Requirements 
Community Science requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 

• Survey123 Connect 

 

Information products 
Community Science includes the following information products: 

Item Description 
Minimum 
user type 

Community Science 
Dashboard 

An ArcGIS Dashboards app used by conservation staff to 
explore reports 

Viewer 

Community Science 
Manager 

A Crowdsource Manager app used by conservation staff 
to monitor and verify reports 

Editor 
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Community Science 
Survey 

An ArcGIS Survey123 form used by community scientists 
to report plant and animal observations in wildlife areas 

Field Worker 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Community Science 
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Configure Community Science 
In this topic, you will learn how to configure the Community Science solution to meet specific 

needs in your organization. 

 

Edit survey categories 
Community Science Survey presents community scientists with a set of categories for their 

report. Each category is stored as a separate path in an SVG file. You can add and remove 

categories to reflect the types of reports that may be collected in your area by editing the SVG 

file in a vector graphics editor. 

Tip: 

Learn more about using SVG files in ArcGIS Survey123. 

 

Remove a category 
Removing a category from the Community Science Survey does not affect any observations 

that were previously collected. To remove a category in Community Science Survey, complete 

the following steps: 

1. Download and install Survey123 Connect. 

2. Sign in to Survey123 Connect using the account that owns your Community 
Science Survey application. 

3. Use Survey123 Connect to download and open your Community Science Survey. 

4. From the menu on the left side of the app, click Files. 

  Windows Explorer opens to the directory containing the downloaded files for the 
Community Science Survey. 

5. Open the media directory. 

  This folder contains the SVG files with the options for each of the categories. 

6. Open the file that contains the option you want to remove. You can use a text 
editor, but an editor such as Inkscape allows you to visualize the changes as you 
make them. 

7. Select and delete the option you want to remove. Each option consists of three 
paths: a colored square, one or several text elements, and a line drawing of an 
organism that belongs to the category. Delete all three belonging to the option you 
are removing. 

8. If necessary, rearrange the other categories to fill in the hole. 

9. Save the changes to the SVG file. 

10. In Survey123 Connect, click the Update button to preview your changes. If you are 
satisfied, click the Publish button to push your changes to your published survey. 
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  Note: 

  No changes are necessary in the XLSX form to remove a category from the Community 
Science Survey. 

11. Open the Item Details page for the survey hosted feature layer and click Data and 
then click the Fields button. 

12. If you want to remove a top-level category, click the I saw a field name. Remove 
the category from the list of values. 

13. Click the observation field. Remove the relevant category of categories from the 
list of values. 

14. Confirm that the category has been removed from the Dashboard view by repeating 
step 11 on the Dashboard layer. 

15. Open the Survey123 field app and refresh the survey by clicking the Refresh 
button on the Download Surveys screen. Open the survey to view the changes. 

 

Add a category 
Adding a category from the Community Science Survey app does not affect any observations 

that were previously collected. To add a top-level category from Community Science Survey, 

complete the following steps: 

1. Open the Item Details page for the survey hosted feature layer and click Data and 
then click the Fields button. 

2. Click the I saw a field name. Add the new category to the list of values. 

3. Confirm that the category has been added to the Dashboard view by repeating step 
1 on the Dashboard layer. 

4. Download and install Survey123 Connect. 

5. Sign in to Survey123 Connect using the account that owns the Community Science 
Survey. 

6. Use Survey123 Connect to download and open the Community Science Survey. 

7. Click the XLSForm button to open the survey spreadsheet. 

8. On the Choices tab, add the new option to the category list. Save the XLS form. 

9. From the menu on the left side of the app, click Files. 

  Windows Explorer opens to the directory containing the downloaded files for the 
Community Science Survey. 

10. Open the media directory. 

  This folder contains the SVG files with the options for each of the categories. 

11. Open the category.svg file. You can use a text editor, but an editor such as 
Inkscape allows you to visualize the changes as you make them. 

12. Copy and paste an existing option. Each option consists of three paths: a colored 
square, one or several text elements, and a line drawing of an organism that 
belongs to the category. Make sure you copy and paste all components. 

13. Update the id property of the colored square to match the name (not the label) of 
the new option. 
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14. Update the contents of the text to reflect your new category. 

15. If necessary, rearrange the categories, update the color, and provide a new 
graphic. 

16. Save the changes to the SVG file. 

17. In Survey123 Connect, click the Update button to preview your changes. If you are 
satisfied, click the Publish button to push your changes to your published survey. 

18. Open the Survey123 field app and refresh the survey by clicking the Refresh 
button on the Download Surveys screen. Open the survey to view the changes. 

 

Add a subcategory 
Adding a subcategory to the Community Science Survey app does not affect any observations 

that were previously collected. To add a second-level category to the Community Science 

Survey, complete the following steps: 

1. Open the Details page for the survey feature layer and click Data > Fields. 

2. Click the category field name. Add the new option to the list of values. 

3. Repeat the previous step for the dashboard view. 

4. Download and install Survey123 Connect. 

5. Sign in to Survey123 Connect using the account that owns the Community Science 
Survey. 

6. Use Survey123 Connect to download and open your Community Science Survey. 

7. Click the XLSForm button to open the survey spreadsheet. 

8. On the Choices tab, add the new option to the appropriate list. If you are creating a 
new list of options for a new category, create a new list. Save the XLS form. 

9. Optionally, add choices to the condition and observationtype lists for the new 
subcategory. 

10. If you are creating a new list of options for a new category, you will also need to 
add a question to the survey. Follow the pattern of the other subcategory selection 
questions to create a question that will display the appropriate subcategories when 
the new category is selected. Save the XLS form. If you are only adding a new 
option to an existing category, no new question is required. 

11. From the menu on the left side of Survey123 Connect, click Files. 

  Windows Explorer opens to the directory containing the downloaded files for the 
Community Science Survey. 

12. Open the media directory. 

  This folder contains the SVG files with the options for each of the categories. 

13. Open the SVG file that corresponds to the category where you want to add a new 
option. If you are adding options for a new category, copy, paste, rename, and edit 
an existing file. You can use a text editor, but an editor such as Inkscape allows 
you to visualize the changes as you make them. 

14. Copy and paste an existing option within the SVG file. Each option consists of three 
paths: a colored square, one or several text elements, and a line drawing of an 
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organism that belongs to the category. Make sure you copy and paste all 
components. 

15. Update the id property of the colored square to match the name (not the label) of 
the new option. 

16. Update the contents of the text to reflect your new option. 

17. If necessary, rearrange the options, update the color, and provide a new graphic. 

18. Save the changes to the SVG file. 

19. In Survey123 Connect, click the Update button to preview your changes. If you are 
satisfied, click the Publish button to push your changes to your published survey. 

20. Open the Survey123 field app and refresh the survey by clicking the Refresh 
button on the Download Surveys screen. Open the survey to view the changes. 
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Use Community Science 
The Community Science solution delivers a set of capabilities that help you engage community 

scientists, manage incoming observations, and monitor community science programs. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Submit a community science report 
You will assume the role of a member of the general public setting out on a day hike in a local 

park. You will use the Community Science Survey app to submit observations along the way. 

1. In ArcGIS Survey123, open the Community Science Survey form. 

2. At the bottom of the app, tap Collect to begin collecting data. 

3. Tap the tile that best represents the type of organism you have observed, and then 
tap to report how you observed it.  

4. At the bottom of the app, tap the arrow to continue to the next question. 

5. On the next page, fill in as many details as you can, and then tap the arrow to 
continue to the next question. 

  A photo or audio recording is used to help verify a report. Therefore, you are required to 
upload one. 

6. Take or upload a photo or audio recording (for audio observations) of the organism, 
and then tap the arrow to continue to the next question. 

7. Tap the map to provide the observation location and tap the date to provide 
information about when you made the observation, and then tap the arrow to 
continue to the next question. 

8. Provide any additional information about the observation that could be helpful in 
verifying the reported organism, and then tap the arrow to continue to the next 
question. 

9. Optionally, provide your name and email address. 

  When you provide this information, the report is counted toward the top contributor ratings 
in the Community Science Dashboard. 

10. At the bottom of the app, tap the check mark.  

  If you are working in a disconnected environment, you can save your report in your outbox 
and then submit it when you have connectivity. 

11. Choose whether to submit the survey now or save it for later. 
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Manage community science reports 
You will assume the role of a conservation staff member who verifies incoming reports based on 

the presented evidence. You will use the Community Science Manager app to verify a 

community science report. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Community Science solution. 

2. View the Community Science Manager app. 

3. In the Status column, click the filter button, and then for Status, choose 
Unverified. 

4. In the Observation Time column, click the arrows and choose Sort in ascending 
order. 

  The oldest reports are now at the top of the table. 

5. Click a report to select it. 

  The report opens in the information panel at the bottom right. 

6. Review the details and attached media. 

7. Click the Edit Record button , and then, if necessary, edit the categorization 
and identification of the organism based on the evidence provided. 

8. Update the status to Verified. 

9. Click Save to update the report. 

 

Explore community science reports 
You will assume the role of either a conservation staff member or a member of the general 

public who wants to explore the submitted community science reports. You will use the 

Community Science Dashboard to filter and explore the dataset to see what types of 

observations have been submitted. 

1. In a browser, from the Community Science solution, view the Community Science 
Dashboard. 

2. On the left, adjust the filters to refine the results by category, type of organism 
observed, status, or observation date. 

  The map, charts, count, and observation list update to show a subset of the data based on 
your filters. 

3. On the serial charts, click the bars to further filter the results. 

4. On the right, click a report in the list to review its details. 

5. Continue exploring and applying filters to reveal more details about the community 
science program.  

6. After you finish, close the Community Science Dashboard app. 
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Conservation Easement Monitoring 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Conservation Easement 

Monitoring 
Conservation Easement Monitoring can be used to routinely inspect conservation easements 

and monitor conservation easement programs. 

It streamlines the inspection of conservation easements established to protect natural resources 
such as forests, riparian areas, and wildlife. The generation of property reports strengthens 
communication with conservation easement stakeholders and promotes compliance with the 
terms of each easement. Conservation Easement Monitoring is typically implemented by 
forestry departments, natural resource departments, and other conservation organizations that 
want to take a data-driven approach to managing conservation easements. 

The Conservation Easement Monitoring solution delivers a set of capabilities that help you 
understand current property conditions, inspect conservation easements, monitor conservation 
easement programs, and engage conservation easement stakeholders. 

 

Requirements 
Conservation Easement Monitoring requires the following: 

• ArcGIS Enterprise 

• ArcGIS Field Maps 

• ArcGIS Survey123 

• Survey123 Connect 

 

Information products 
Conservation Easement Monitoring includes the following information products: 

Item Description 
Minimum 
user type 

Conservation 
Easement 
Dashboard 

An ArcGIS Dashboards app used by conservation staff 
to monitor the results and progress of conservation 
easement inspections 

Viewer 
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Conservation 
Easement Survey 

An ArcGIS Survey123 form used by mobile workers to 
inspect conservation easements 

Field Worker 

Conservation 
Easement Monitoring 

A map used by mobile workers to review existing 
conservation easements and start a routine inspection 
of a given easement 

Field Worker 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Conservation Easement Monitoring 
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Configure Conservation Easement Monitoring 
In this topic, you will learn how to configure the Conservation Easement Monitoring solution to 

meet specific needs in your organization. 

 

Load data   
Conservation Easement Monitoring can be used to routinely inspect conservation easements 

and monitor conservation easement programs. In some cases, you may have this information in 

ArcGIS or another business system already. 

Review the layers provided with the solution and determine what source data you want to load. 
Then, load your existing data into the layers provided with the ArcGIS Solution before sharing 
the maps or applications. 

Once you have determined what source data must be loaded, complete the data loading 
workflow below. 

 

Load data from a shapefile   
Load data for ConservationEasements from a shapefile by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you wish to populate. 

3. On the feature layer item details page, Click Update Data and select Append Data 
to Layer. 

4. Under Filename, click Choose File. 

5. Navigate to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you wish to load data into and the layer that contains the 
updated data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Use Conservation Easement Monitoring 
The Conservation Easement Monitoring solution delivers a set of capabilities that help you 

understand current property conditions, inspect conservation easements, monitor conservation 

easement programs, and engage conservation easement stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Conduct conservation easements inspections 
You will start by assuming the role of a mobile worker in a state forestry department capturing 

an inspection of a conservation easement. You are asked to use the Conservation Easement 

Survey to capture inspection details. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Conservation Easement Monitoring solution. 

2. View the Conservation Easement Monitoring map. 

3. On the map, click the conservation easement that you want to inspect. 

  A pop-up with information about the conservation easement property appears. 

4. In the pop-up, review the conservation easement property details, and then click 
Start Inspection to launch the Conservation Easement Survey. 

  The form opens. Property information has been automatically completed with details from 
the Conservation Easement Monitoring map. 

5. Complete the remaining survey parameters with as much additional information as 
possible. 

6. Click Submit, and then if necessary, click Send now. 

 

Monitor conservation easement programs 
Next, you will assume the role of a program manager in a state forestry department. You are 

responsible for monitoring the status of a conservation easement program. You will view the 

overall status of your conservation easement program and then look more closely at specific 

locations. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Conservation Easement Monitoring solution. 

2. View the Conservation Easement Dashboard. 

  The Conservation Easement Dashboard opens with an overview of the current program 
status. The overview displays key metrics. This information gives management a quick 
overview of the total number of conservation easements, conservation easements that 
require follow up after inspection, and completed conservation easement inspections. 
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3. In the filter panel, for Follow Up Required, choose Yes. 

4. In the right panel, at the bottom, click the List tab, and then select an inspection 
from the list. 

  The map zooms to the inspection location, and the inspection report opens in a pop-up. 

5. Review the information in the pop-up. 

 

Share inspection results 
Finally, you will assume the role of a conservation staff member in a state forestry department. 

You are responsible for generating an inspection report to send to the conservation easement 

owner or property manager. 

1. In a browser, go to the ArcGIS Survey123 website and sign in with your ArcGIS 
organization credentials. 

2. Open the Conservation Easement Survey, and then click the Data tab. 

3. From the table, select a conservation easement inspection. 

4. At the top of the page, click Report. 

5. In the Report panel, provide a report name, and then for Format, choose Portable 
Document Format (.pdf). 

6. Click Generate to create the inspection report. 

Note: 

You can generate conservation easement inspection reports for multiple inspections at the 
same time. There are two options: Select multiple inspections from the Conservation 
Easement Survey table or select the All records in the table option in the Report pane. 

Note: 

To learn more about printing reports in ArcGIS Survey123, see Print survey results 
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Conservation Outreach 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Conservation Outreach 
Conservation Outreach can be used to track wildlife conflicts and engage stakeholders in and 

around protected areas. 

It provides 24/7 access to conservation outreach information and the location-enabled wildlife 
conflict reports help conservation staff mitigate future wildlife conflicts. Conservation Outreach is 
typically implemented by conservation organizations that want to take a data-driven approach to 
managing conflicts between humans and wildlife. 

The Conservation Outreach solution delivers a set of capabilities that help you capture conflicts 
between humans and wildlife, manage the resolution of each conflict, and monitor outreach 
activities in and around protected areas. 

 

Requirements 
Conservation Outreach requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 

 

Information products 
Conservation Outreach includes the following information products: 

Item Description 
Minimum 
user type 

Wildlife Conflict 
Dashboard 

An ArcGIS Dashboards app used by conservation staff to 
monitor the status of wildlife conflict incidents within and 
around protected areas 

Viewer 

Wildlife Conflict 
Manager 

A Crowdsource Manager app used by conservation staff to 
manage and update wildlife conflict incident reports 

Editor 

Wildlife Conflict 
Reporter 

An ArcGIS Survey123 form used by conservation staff to 
collect wildlife conflict incident reports 

Field Worker 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
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(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Conservation Outreach 
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Configure Conservation Outreach 
In this topic, you will learn how to configure the Conservation Outreach solution to meet specific 

needs in your organization. 

 

Load data   
Conservation Outreach can be used to track wildlife conflicts and engage stakeholders in and 

around protected areas. In some cases, you may have this information in ArcGIS or another 

business system already. 

Review the layers provided with the solution and determine what source data you want to load. 
Then, load your existing data into the layers provided with the ArcGIS Solution before sharing 
the maps or applications. 

Once you have determined what source data must be loaded, complete the data loading 
workflow below. 

 

Load data from a shapefile   
Load data for WildlifeConflicts from a shapefile by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you wish to populate. 

3. On the feature layer item details page, Click Update Data and select Append Data 
to Layer. 

4. Under Filename, click Choose File. 

5. Navigate to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you wish to load data into and the layer that contains the 
updated data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Use Conservation Outreach 
The Conservation Outreach solution delivers a set of capabilities that help you capture and 

manage wildlife conflicts and engage local communities. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Collect wildlife conflict incidents 
You will start by assuming the role of a mobile worker in a protected area collecting wildlife 

conflict incidents. You have been asked to use the Wildlife Conflict Reporter survey to collect 

wildlife conflict incidents. 

1. On a mobile device, in ArcGIS Survey123, open the Wildlife Conflict Reporter form. 

2. Tap Collect. 

3. Complete the survey with as much information as possible. 

  Note: 

  Required information is marked with a red asterisk. 

4. Tap Submit, and then tap Send now. 

 

Manage wildlife conflicts 
Next, you will assume the role of a community outreach staff member. You will review wildlife 

conflict incidents by completing the following steps: 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Conservation Outreach solution. 

2. View the Wildlife Conflict Manager app. 

  Wildlife incident reports are listed in the table at the top. The table can be sorted and 
filtered in various ways. 

3. In the table column headers, use the filters and arrows to filter results. 

4. Select a wildlife conflict incident from the table. 

  The report details open at the bottom left. 

5. In the report details, click the Edit Record button . 

6. Make any necessary updates to the report, and then click Save. 
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Monitor wildlife conflict programs 
Now, you will assume the role of a protected area manager. You will monitor the status of 

wildlife conflict incidents within and around a protected area. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Conservation Outreach solution. 

2. View the Wildlife Conflict Dashboard app. 

3. On the left, adjust the filters to refine the results. 

4. On the right, select a wildlife conflict incident from the list. 

  The map zooms to the incident, and a pop-up with incident details appears. 

5. Review the incident details. 
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Coronavirus Business Continuity 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Coronavirus Business Continuity 
Coronavirus Business Continuity can be used to maintain business operations and share 

authoritative information with customers and stakeholders during the coronavirus disease 2019 

(COVID-19) pandemic. 

The rapid switch to home offices, frequently changing government regulations, and employee 
inability to report to work has made it difficult for organizations to understand the capacity of 
their workforce during the COVID-19 pandemic. Organizations need to know who is able to work 
and where employees are working from to make business continuity decisions. Having 
personnel perform a daily self-check-in or having supervisors check in with their teams gives 
organizations clarity into workforce capacity. Coronavirus Business Continuity is typically 
implemented by organizations that want a clear understanding of workforce capacity and facility 
status to help them adapt and ensure business continuity. 

The Coronavirus Business Continuity solution delivers a set of capabilities that help you 
understand the operational capacity of your workforce, monitor the status of your facilities, and 
communicate your reopening plans to customers and employees. 

 

Requirements 
Coronavirus Business Continuity requires the following: 

• ArcGIS Enterprise 

 

Information products 
Coronavirus Business Continuity includes the following information products: 

Item Description 
Minimum user 
type 

Individual 
Check-in 

An ArcGIS Survey123 form used by employees or 
contract personnel to report their work status 

Editor 

Team Check-in An ArcGIS Survey123 form used by a manager, 
supervisor, or team lead to report the work status of their 
personnel 

Editor 
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Personnel 
Status 
Dashboard 

An ArcGIS Dashboards app used by human resources 
executives or incident commanders to monitor workforce 
capacity 

Viewer 

Team Status 
Dashboard 

An ArcGIS Dashboards app used by a manager, 
supervisor, or team lead to monitor the capacity of their 
team. 

Viewer 

Facility Status 
Reporter 

An ArcGIS Web AppBuilder app used by facility 
managers to look up facilities they are responsible for 
and submit a report 

Editor 

Facility Status 
Report 

An ArcGIS Survey123 form used by a building or facility 
manager to report facility and operational status 

Editor 

Facilities Status 
Dashboard 

An ArcGIS Dashboards app used by executives and 
managers to monitor the operational status of their 
facilities 

Viewer 

Coronavirus 
Business 
Continuity 

An ArcGIS Hub site used by businesses, utilities, and 
government agencies to share COVID-19 health and 
safety plans with employees returning to the workplace 
and customers who visit their place of business 

Viewer (required 
for internal 
destination page) 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

2.0 • A new ArcGIS Hub site used by businesses, utilities, and government 
agencies to share COVID-19 health and safety plans with employees 
returning to the workplace and customers who visit their place of 
business 

• A new Facilities feature layer that supports the implementation of the 
Coronavirus Business Continuity and Coronavirus Business Reopening 
solutions 

• A new Individual Check-in survey that supports the implementation of the 
Coronavirus Business Continuity and Coronavirus Health Screening 
solutions 

1.0 • First release of Coronavirus Business Continuity 
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Configure Coronavirus Business Continuity 
Learn how to configure the Coronavirus Business Continuity solution to meet specific needs in 

your organization. 

 

Load personnel 
Personnel information must be loaded before using the Individual Check-in, Team Check-in, 

and related dashboards. The Check-in forms require a user to sign in with a user name. The 

signed-in user name is automatically associated with their full name, team, and office location 

whenever a check-in is submitted. Personnel information is stored in a table in the Personnel 

feature layer, and you can use the PersonnelSource.csv file to organize your personnel 

information before loading it into ArcGIS. Ensure that you populate the user name column in the 

PersonnelSource.csv file with the ArcGIS user names in your organization that use the 

Individual Check-in or Team Check-in forms. 

To load your personnel information from a spreadsheet, complete the steps below: 

1. Sign in to your ArcGIS organization and browse to the PersonnelSource.csv 

item. 

2. Open item page and click Download. 

3. Edit the .csv file and provide your personnel information. 

4. In your ArcGIS organization, browse to the Personnel feature layer. 

5. Open item page and click  Update Data > Append Data to Layer. 

6. Click Choose File and browse to your .csv file, and click Open. 

7. Click Upload and Continue. 

8. Click the Choose the layer to update drop-down arrow and choose Personnel 
Information. 

9. Uncheck Update existing features. 

10. Click Show field matching to map the fields. 

11. Click Apply Updates. 

  Tip: 

  In some cases, you may need to add or modify past check-in information. The Creator 
and CreationDate fields on feature layers are not editable when editor tracking is 
enabled. However, you can temporarily disable editor tracking on the layer and then load 
or modify your check-ins. Once you have completed loading your source data, reenable 
editor tracking on the layer. 

 

Load facilities 
Facilities must be loaded before using the Facility Status Reporter and Facility Status 

Dashboard. You can use the FacilitiesSource.csv file to inventory your facilities before 

loading it into ArcGIS. 
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To load your facilities from a spreadsheet, complete the steps below: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
FacilitiesSource item.  

2. Open item page and click Download. 

3. Edit the .csv file and provide your facility information. 

  Note: 

  At a minimum, you must provide a unique facilityid and the latitude and longitude for 
each facility. If you don’t have a unique ID, you can edit the .csv in Excel and copy this 

formula into the first row of the facilityid column: =CONCATENATE("Facility-", 
TEXT(ROW(A1),"00000")). You can then drag the right corner of the cell to fill the 
formula down for all facilities giving each a unique ID. 

4. In your ArcGIS organization, browse to the Facilities feature layer. 

5. Open item page and click  Update Data > Append Data to layer. 

6. Click Choose File, browse to your .csv file, and then click OK. 

7. Click Upload and Continue. 

8. Click the Choose the layer that you wish to append data into drop-down arrow 
and choose Facilities. 

9. Uncheck Update existing features. 

10. Click Show field matching to map the fields. 

11. Click Apply Updates. 

 

Configure the Coronavirus Business Continuity site 
The Coronavirus Business Continuity solution includes an ArcGIS Hub site that can be used by 

the general public and employees to learn how the organization is keeping customers, 

residents, and employees safe as organizations return to work during the coronavirus disease 

2019 (COVID-19) pandemic. The site provides role-based access to pages, rows, and 

information products included in the COVID-19 solutions (Business Continuity, Business Re-

opening, Site Safety, and Health Screening) and include content for the public, all employees, 

facility managers, and executives. 

The Coronavirus Business Continuity site contains information for the public and is intended to 
be shared with everyone and available to anonymous users. The Internal Destination page 
contains information for employees and is intended to be shared inside the organization and 
only available to named users in the organization. The Internal Destination page also includes 
content intended for facility managers or executives and is only visible to users in the 
organization who are members of specific groups. 

 

Update with organizational information 
After deploying the Coronavirus Business Continuity solution, the Coronavirus Business 

Continuity site layout only requires a few updates to fit your local context. Consider what 
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information you already have and what you can most easily find. This information can include 

the following: 

1. Verify that you are signed in to your ArcGIS organization and browse to 
Coronavirus Business Continuity site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. On the Coronavirus Business Continuity site scroll to the Featured News section, 

hover over the card you want to update, click the settings button , and update 
the text. 

5. Scroll to the For more information section, hover over the card, and click the 
settings button. 

6. Click the customer service link, and then click Edit. 

7. Enter an email address into the Link Destination text box and click Add Link. 

8. Scroll to the Frequently Asked Questions section, hover over the card and click 
the settings button, and update the questions and answers. 

9. Scroll to the Additional Resources section, hover over the card, and click the 
settings button. 

10. To update the links, click the Learn More button and click Edit. 

11. Enter a URL into the Link Destination text box and click Add Link. 

12. To update images, hover over the image card and click the settings button. 

13. In the side panel, provide an image for the outcome by either dragging an image or 
browsing for an image. 

14. Add additional sources of authoritative information regarding the pandemic. 

15. To modify your site’s footer, click Customize Toggle  on the side panel. 

16. Click Footer.  

  A custom footer is already provided, and in most cases, it needs to be updated with your 
organization's branding, contact information, and social media references. 

17. Click the HTML text box. 

  The HTML window appears. 

18. Make the necessary changes and click Apply. 

19. Click Save. 

20. In the top left corner of the page, click Exit edit mode. 

21. Click the Internal Destination tab. 

22. Click the edit button to open the site editor. 

23. Scroll to the Message from Executive section.  

24. To update the video, hover over the video card and click the settings button. 

25. Replace the URL in Video Link text box. 

26. Hover over the Message from Executive card, click the settings button, and 
update message you want to share with employees. 
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27. Scroll to the For more information section, hover over the card, and click the 
settings button. 

28. Click the human resources hyperlink, and then click Edit. 

29. Enter an email address into the Link Destination text box and click Add Link. 

30. Scroll to the Internal Updates section, hover over the card, click the settings button 
and update it with relevant information for employees. 

31. Click Save. 

 

Deploy related solutions 
This site references content from the Coronavirus Business Reopening, Coronavirus Health 

Screening and Coronavirus Site Safety solutions. To deploy these solutions, follow the steps in 

the Deploy an ArcGIS Solutions section. 

 

Update solution references 
This site and page have references to solutions deployed in the previous section. To update 

your site, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to 
Coronavirus Business Continuity site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Visiting Business Location section. 

5. Hover over the Health Screening card and click the settings button . 

6. Click on the Complete Screening button and click Edit. 

7. Enter the Visitor Health Screening form URL deployed in the previous step (one of 
the forms deployed in the Coronavirus Health Screening solution) into the Link 
Destination text box and click Add Link. 

  Tip: 

  Browse to the Visitor Health Screening app. Open the item page, click View 
Application, and copy the app URL. 

8. Click Save. 

9. In the upper left corner of the page, click Exit edit mode. 

10. Click the Internal Destination tab at the top of the page. 

11. Click the edit button to open the site editor. 

12. On the Internal Destination page, scroll to the Monitoring Employee Health 
section. 

13. Hover over the Health Screenings card and click settings button. 

14. Click the Complete Screening button, and then Edit. 
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15. Enter the Employee Health Screening form URL deployed in the previous step (one 
of the forms deployed in the Coronavirus Health Screening solution) into the Link 
Destination text box and click Add Link. 

  Tip: 

  Browse to the Employee Health Screening app. Open the item page, click View 
Application, and copy the app URL. 

16. Scroll to the Safe Work Environments section. 

17. Hover over the Health and Safety Plans card and click the settings button. 

18. Click the View Health Safety Plans button, and then Edit.  

19. Enter the Coronavirus Site Safety Map Viewer app URL deployed in the previous 
step (one of the forms deployed in the Coronavirus Health Screening solution) into 
the Link Destination text box and click Add Link. 

  Note: 

  Browse to the Coronavirus Site Safety Map Viewer app. Open the item page, click View 
Application, and copy the app URL. 

20. Click Save. 

 

Manage visibility of content 
The Business Continuity includes two groups Coronavirus Business Continuity—Facility 

Managers and Coronavirus Business Reopening—Executives. The Coronavirus Business 

Continuity—Facility group is associated with the Manage Facility Status section and the 

Coronavirus Business Continuity—Executives is associated with the Gain Organizational Insight 

section on the Internal Destination page. 

Any apps shared with these groups display in their corresponding section, and only members of 
the groups see this content on the page. This allows you to give a unique view to Facility 
Managers and Executives inside the organization while hiding the content for all other staff. 

1. Verify that you are signed in to your ArcGIS organization, click the Group tab and 
browse to your Coronavirus Business Continuity—Facility Managers group. 

2. Open the group page. 

3. Click Add Items to Group and search for and add the following apps: 

– Facility Status Reporter (deployed with Coronavirus Business Continuity) 

– Site Safety Form, Site Safety Manager, Site Safety Map Editor, Site Safety 
Dashboard (deployed with Coronavirus Site Safety) 

– Health Screening Dashboard (deployed with Coronavirus Health Screening) 

4. Check the check box next to the app name and click Add Items to add the apps to 
the group. 

5. Click Invite Users. 

6. Add your organization’s Facility Managers and click Add to group. 
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7. Click the Groups tab and browse to your Coronavirus Business Continuity—
Executives group in your ArcGIS organization.  

8. Click Add Items to Group. 

9. Search for and add the following apps: 

– Personnel Status Dashboard, Facilities Status Dashboard (deployed with 
Coronavirus Business Continuity) 

– Coronavirus Business Reopening (deployed with Coronavirus Business 
Reopening) 

– Site Safety Dashboard (deployed with Coronavirus Site Safety) 

– Health Screening Dashboard (deployed with Coronavirus Health Screening) 

10. Click Invite Users. 

11. Add your organization’s Executives. 

 

Integrate health screening 
Many organizations are asking all employees and visitors to attest each day that they are 

symptom-free and have not had recent contact with anyone who has tested positive for 

coronavirus and require a temperature check before they are permitted to enter the building. 

You can use the Coronavirus Health Screening solution to conduct health screenings before 

employees and visitors are permitted to enter a building, facility, or location. 

Organizations that also deploy the Coronavirus Health Screening solution can configure the 
Individual Check-in form to ask employees who plan on working from the office to first complete 
the Employee Health Screening form before coming into the office. 

To integrate health screenings with the Individual Check-in form, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Individual Check-in to download the survey. 

4. In the Download window, click Download and click OK. 

5. Click Individual Check-in again to open the survey. 

6. On the side toolbar, click the Open XLSForm Spreadsheet button. 

7. In the Microsoft Excel spreadsheet, find the health screening question located in 
the fourth row and column B (name). 

8. Scroll to the right to column J (default) and change the text from No to Yes for this 
row. 

9. Find the health screen note located in the 35th row and column B (name).  

10. Edit column C (label) and replace the number sign inside the hyperlink with the link 
to your Employee Health Screening survey. 

  Tip: 

  Look for the following text containing the hyperlink: <a href="#" 
target="_blank">health screening form</a>. 
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11. Save and close the Microsoft Excel spreadsheet and preview your changes in 
Survey123 Connect. 

12. In ArcGIS Survey123 Connect, click  Publish on the side toolbar to publish your 
changes. 

 

Extend business continuity surveys 
The Coronavirus Business Continuity solution includes a series of surveys (Individual Check-in, 

Team Check-in, and Facility Status Report) that can be used to understand the capacity of your 

workforce and status of facilities you operate. 

Review the preconfigured questions and adjust as necessary to remain in compliance with your 
organizational policies and any applicable laws. In addition, ensure you secure the survey and 
underlying layers and only share the content with appropriate members of your organization. 

 

Update feature layer views 
The Coronavirus Business Continuity solution includes a series of views created from the 

Facilities and Personnel feature layers. Organizations may want to modify the Facility Status 

Report and Individual Check-in surveys by first adding new fields to the feature layers and then 

configuring the surveys to use the newly created fields. When doing so, the new fields must be 

exposed in the appropriate views. Additionally, some views are created by joining two sources 

together, and these views must be re-created with the same name and URL after a new field is 

added. 

Organizations may want to modify the Facility Status Report, Individual Check-in, and Team 
Check-in surveys by adding new survey questions. When adding new questions, begin with the 
Update feature layer views section below. For changes such as removing questions or 
formatting the survey, proceed to the Modify business continuity surveys section. 

To add one or more fields to a layer and re-create the views, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization. 

2. Add a new field to a layer in the Facilities or Personnel hosted feature layer. 

3. Browse to the view in your contents. 

4. Open the item page and click the Visualization tab. 

5. Click More Options on the appropriate layer or table and click Set View Definition 
> Define Fields. 

6. Scroll to the newly created field and check the box next to the new field or fields. 

7. Click Apply. 

  The new field is added to the view’s definition. 

To update a join view, complete the following steps: 

1. Browse to the join view in your contents (for example, Facilities_current). 

2. Open the item page and scroll to the URL section. Click the Copy button. 

3. Paste the copied URL into Microsoft Notepad or another text editor for reference. 
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  Note: 

  The feature layer name will be used below when re-creating the join. The name can be 
found after services in the URL structure and may also contain a unique GUID, for 
example, Facilities_current_a45f71a48587425c9b90ee5527cd26d1. 

4. Click the Settings tab. 

5. Click the Delete Item button and click Delete. 

6. Browse to the source hosted feature layer (for example, Facilities). 

7. Open the item page and click Open in Map Viewer. 

8. Click the Analysis button and click Summarize Data > Join Features. 

9. Configure the join using the following table: 

  Targ
et 
layer 

  Layer 
to 
join 
to the 
target 
layer 

  Ty
pe
s 
of 
join 

  Field
s to 
matc
h 

  Join 
oper
ation 

  Define 
which 
record is 
kept 

  Result 
layer 
name 

  Faciliti
es 

  Faciliti
es 
Status 
Repor
t 

  Ch
oos
e 
the 
fiel
ds 
to 
mat
ch 

  Glob
alID 
= 
facilit
yguid 

  Join 
one 
to 
one 

  Order by 
created_date
/Newest 

  Facilities_c
urrent 

  Faciliti
es 

  Faciliti
es 
Status 
Repor
t 

  Ch
oos
e 
the 
fiel
ds 
to 
mat
ch 

  Glob
alID 
= 
facilit
yguid 

  Join 
one 
to 
one 

  Order by 
created_date
/Newest 

  Facilities_p
ublic 

  Perso
nnel 

  Perso
nnel 
Inform
ation 

  Ch
oos
e 
the 
fiel
ds 
to 
mat
ch 

  Creat
or = 
usern
ame 

  Join 
one 
to 
one 

  Order by 
CreateDate/
Newest 

  Personnel
_all 
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  Perso
nnel 
Inform
ation 

  Perso
nnel 

  Ch
oos
e 
the 
fiel
ds 
to 
mat
ch 

  User
name 
= 
Creat
or 

  Join 
one 
to 
one 

  Order by 
CreateDate/
Newest 

  Personnel
_current 

  Note: 

  Ensure each new join view uses the names defined in this table. If you use the same 
names, the layers in the map and the existing dashboard widgets do not have to 
reconfigured. If your join view contains a unique GUID, the new join view needs to be 
named with the unique GUID. 

10. Uncheck Use current map extent, if checked.  

11. Check Create results as hosted feature layer view. 

12. Update the Personnel Status Dashboard or Facilities Status Dashboard to account 
for the new fields you added to the layers. 

 

Modify business continuity surveys 
To modify a Coronavirus Business Continuity survey, complete the following steps: 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Facility Status Report to download the survey. 

  Note: 

  The Facility Status Report survey is an example. The steps below are the same for the 
Individual Check-in or Team Check-in surveys. 

3. In the Download window, click Download and click OK. 

4. Click Facility Status Report again to open the survey. 

5. On the side toolbar, click the Open XLSForm Spreadsheet button. 

6. In the Microsoft Excel spreadsheet, click the choices tab.  

  This tab comprises all the selectable options for survey questions. 

7. Revise the survey to reflect your needs. 

8. Save and close the Microsoft Excel spreadsheet. 

9. In ArcGIS Survey123 Connect, click Publish on the side toolbar. 

10. Click Publish survey to publish your changes and click OK. 
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Use Coronavirus Business Continuity 
The Coronavirus Business Continuity solution delivers a set of capabilities that help you 

understand the operational capacity of your workforce, monitor the status of your facilities, and 

communicate your reopening plans to customers and employees. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Monitor workforce capacity 
The coronavirus disease 2019 (COVID-19) pandemic has significantly affected the workforce of 

many organizations. Personnel who typically report to an office may be forced to work from 

home, facilities may be closed or access may be restricted to essential workers, and workers 

may be unable to report to work due to household issues. Organizations need to know who is 

able to work and where employees are working from to make business continuity decisions. 

Having personnel perform a daily self check-in or having supervisors check in their teams gives 

organizations clarity into workforce capacity. 

The Coronavirus Business Continuity solution includes an Individual Check-in form that collects 
information from personnel including their work status, work location, and wellness information. 
Organizations deploying the Coronavirus Business Continuity solution should review the 
preconfigured questions and adjust as necessary to remain in compliance with organizational 
policies and applicable laws. In addition, ensure that you secure the survey form and underlying 
layers and only share the content with appropriate members of your organization. 

Some organizations may find it more efficient to have managers, supervisors, or team leads 
check their team members in using the Team Check-in form. If your organization decides to use 
the Team Check-in form, you can follow the same general steps described here but with the 
Team Check-in form and the Team Status Dashboard. 

 

Complete individual check-in 
You will start by assuming the role of an employee or contractor in a government agency, 

business, or utility. You have been asked to use the Individual Check-in form to share your work 

status each morning. 

1. In a browser, from the Coronavirus Business Continuity solution, view the Individual 
Check-in form. 

2. Complete the form with as much information as possible. 

  Note: 

  Required questions are marked with a red asterisk. 
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3. Click Submit. 

 

Monitor individual check-ins 
Now, you will assume the role of a human resources or operations manager in the same 

government agency, business, or utility. You are asked to monitor the capacity of your 

workforce and are looking to see if your organization has business locations or teams that lack 

the staff required to continue operations. You will view the overall status of your workforce and 

then look more closely at specific locations and trends. 

Note: 

The steps below are the same if you choose to use the Team Status Dashboard app to 
monitor the capacity of your team. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Coronavirus Business Continuity solution. 

2. View the Personnel Status Dashboard app. 

  The Personnel Status Dashboard app opens with an overview of the current status. 

  The overview displays key metrics. This information gives management a quick overview of 
the number of team members working from their normal locations, from home, and offsite. 
Any absences and statistics related to the overall health of your workforce are also shown. 

3. On the left, in the filter panel, for Check-in Type, choose Individual. 

4. At the lower-right corner of the dashboard, click the All tab to see a complete list of 
check-ins. 

5. On the left, in the filter panel, set additional filters to further refine the dashboard 
results. 

  You can filter by location, team, date, and other key metrics captured in the Individual 
Check-in form. In the Personnel list, you can click an employee to see additional details. 

6. On any indicator, click the History tab to review results over time; move the slider 
in each chart to adjust the time period displayed. 

7. At the lower-right corner of the dashboard, click the Offsite Personnel tab to see 
the location of all personnel working offsite. 

 

Track facility status 
As the COVID-19 pandemic develops, some organizations have been required to rapidly close 

facilities or have decided to greatly reduce the number of personnel working in certain facilities. 

Having visibility into the status of all facilities is a critical component in making business 

continuity decisions. Daily or periodic status reports from facilities help organizations make 

informed decisions and necessary operational changes. 

The Coronavirus Business Continuity solution includes a Facility Status Report form for facility 
managers to report the status of the facilities they are responsible for and a Facilities Status 
Dashboard app to monitor results. Organizations deploying the Coronavirus Business Continuity 
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solution should review the preconfigured questions and adjust as necessary to remain in 
compliance with organizational policies and applicable laws. 

 

Complete a facility status report 
You will start by assuming the role of a local facility manager in a government agency, business, 

or utility. You have been asked to use the Facility Status Reporter app and Facility Status 

Report form to share the status of your facility each day or on a weekly basis. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Coronavirus Business Continuity solution. 

2. View the Facility Status Reporter app. 

3. On the right, in the Locate facility widget, search for a facility; alternatively, click a 
location on the map. 

4. Review the facility details. 

5. Click Submit Status Report. 

6. Complete the Facility Status Report form with as much information as possible. 

7. Click Submit. 

 

Monitor facility status 
Now, you will assume the role of a facility manager or operations manager in the same 

government agency, business, or utility. You have been asked to monitor the status of your 

facilities and are looking to see if your organization has business locations that may be 

impacted by the COVID-19 pandemic. You will view the status of all facilities and then look more 

closely at specific locations and trends. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Coronavirus Business Continuity solution. 

2. View the Facilities Status Dashboard app. 

  The overview displays key metrics. This information gives management a quick overview of 
the number of facility reports they have received, operational status of their facilities, and 
staffing capacity at all facilities. 

3. On the left, use filters to refine the results by facility name, country, or geographic 
region, or by various key facility characteristics. 

4. On the right, in the Number of Facilities list, select a facility to review facility 
information; alternatively, click a facility on the map. 

  Note: 

  In some instances, organizations may want to review COVID-19 case information around 
their facilities. In the United States, this information is available at the county level and 
can be added to the Facilities Status Dashboard map. After you add it to the web map, it 
is available to facility managers and operations managers when they review the status of 
their facilities. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 203 

Review return to work resources 
As an employee in a government agency, business, or utility, you are interested in learning 

more about what the organization is doing to keep you and your family safe as you begin to 

return to work. You will use the Coronavirus Business Continuity site to learn about which 

facilities are open and how their hours may be impacted, the safety plans in place at those 

facilities, and how you can check in and complete a health screening if you are coming into the 

office. 

1. In a browser, from the Coronavirus Business Continuity solution, view the 
Coronavirus Business Continuity site. 

  This site is intended to be shared with the public and is where you can share content 
intended for your customers and residents in the community. 

2. Scroll through the site and review the content. 

3. On the site header, click the Internal Destination tab. 

  The Internal Destination page is intended to be shared inside the organization and is 
where you can share content that is only intended for your employees. The page also 
includes content intended for facility managers (Manage Facility Status) or executives 
(Gain Organizational Insight) and is only visible to those users in the organization who 
are members of specific groups. 

4. Scroll through the page and review the content. 
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Coronavirus Force Readiness 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Coronavirus Force Readiness 
Coronavirus Force Readiness can be used to understand force availability and share 

authoritative information with decision makers during the Coronavirus Disease 2019 (COVID-

19) pandemic. 

The solution provides units with information regarding which personnel can report for duty and 
an understanding of their capacity to respond to a request for assistance during the COVID-19 
pandemic. Units may be requested to assist in setting up alternate care facilities, detection 
testing sites, supporting food distribution, and so on. Having personnel perform a routine check-
in or having someone from the armory or unit provide the readiness status of a group of 
personnel gives units clarity into a unit’s readiness during the pandemic. Coronavirus Force 
Readiness is typically implemented by the National Guard, Air National Guard, and other 
service branches that want to take a data-driven approach to understanding force availability 
during COVID-19. 

The Coronavirus Force Readiness solution delivers a set of capabilities that help you to 
understand the operational capacity of a force, monitor the status of units, and communicate 
capabilities and disruptions to commanders and administrative staffs during the COVID-19 
pandemic. 

 

Requirements 
Coronavirus Force Readiness requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 

 

Information products 
Coronavirus Force Readiness includes the following information products: 

Item Description 
Minimum 
user type 

Admin Dashboard An ArcGIS Dashboards app used by administrative 
NCOs to monitor personnel availability. 

Viewer 
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Personnel Readiness 
Dashboard 

An ArcGIS Dashboards app used by any unit 
member to track and monitor personnel readiness 
and availability. 

Viewer 

Commander's 
Dashboard 

An ArcGIS Dashboards used by commanders to 
quickly assess the overall unit readiness. 

Viewer 

Personnel Readiness 
Report 

An ArcGIS Survey123 form used by a military unit 
member to report availability. 

Not required 

Personnel Readiness 
Batch Report 

An ArcGIS Survey123 form used by an NCO or 
armory clerk to report the availability of their 
personnel. 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 First release of Coronavirus Force Readiness 
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Configure Coronavirus Force Readiness 
In this topic, you will learn how to configure the Coronavirus Force Readiness solution to meet 

specific needs in your organization. 

 

Extend force readiness surveys 
The Coronavirus Force Readiness solution includes a series of surveys that can be used to 

understand the capacity of your workforce. 

Review the preconfigured questions and adjust as necessary to remain in compliance with your 
organizational policies and any applicable laws. Additionally, ensure that you secure the survey 
and underlying layers and only share the content with appropriate members of your 
organization. 

 

Update feature layer views 
The Coronavirus Force Readiness solution includes a series of views created from the 

Personnel Readiness feature layer. The feature layer is used in the surveys and the subsequent 

views are used in the dashboards. Organizations may modify the Personnel Readiness Report 

survey and ultimately add new fields to the feature layers. When doing so, the new fields must 

be exposed in the appropriate views. 

To add one or more fields to a layer and re-create the views, complete the following steps: 

1. Browse to the view in your contents. 

2. Click the Visualization tab. 

3. Click the Options button  on the appropriate layer or table, then click Set View 
Definition. 

4. Click Define Fields. 

5. Scroll to the newly created field and check the box. Click Apply. 

  The new field is added to the view's definition. 

6. Repeat steps 1 through 5 for the Personnel Readiness Dashboard. 

7. Update the Personnel Readiness Dashboard to account for the new fields you 
added to the layers. 

 

Modify readiness surveys 
To modify a Coronavirus Force Readiness survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization.  

3. Click Personnel Readiness Report to download the survey.  

4. Click the Personnel Readiness Report again to open the survey. 

5. In the left pane, click Open XLSForm Spreadsheet. 
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6. In the Microsoft Excel spreadsheet, click the Choices tab. This tab comprises all of 
the selectable options for survey questions. 

7. Revise the survey to reflect your personnel readiness needs. 

8. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

9. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your 
changes. 

 

Configure echelons 
The dashboards are preconfigured to display four battalions and four companies under each 

battalion. Follow the steps below to add or remove battalions or companies from your 

dashboard. 

 

Add a battalion 
To add battalions or companies to the dashboard, complete the following steps: 

1. Sign in to your Portal for ArcGIS. 

2. Browse to the Personnel Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Select the last battalion tab while in edit mode. 

5. Go to the editing tool within this element and select Duplicate. 

6. Drag the newly created copy and position it below the last battalion tab. 

7. Reference duplicated battalion settings, text, and configuration. 

8. Add a new name, for example, 5th BN, to the new component. 

9. Save your application. 

 

Remove a battalion tab 
To remove a battalion or companies from the dashboard, complete the following steps: 

1. Sign in to your Portal for ArcGIS. 

2. Browse to the Personnel Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Select the battalion tab you want to delete while in edit mode. 

5. Click the Delete button  to delete the selected battalion. 

6. Save your application. 

 

Configure alternate reporting periods 
The dashboards are preconfigured to display individuals reporting within the last 24 hours. The 

dashboard owner can configure the dashboard to display alternate reporting periods. The 

Personnel List is the most commonly configured element in regard to its contents and time 

frame. 
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To modify the reporting period, complete the following steps: 

1. Sign in to your Portal for ArcGIS. 

2. Browse to the Personnel Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Go to the editing tool within the Personnel List  element and select Configure. 

5. Below Battalion, select the And option and add Date Reported from the drop-down 
list. You can now select from any of the available options and time frames.  

6. Click Done and save your application displaying the new reporting period. 

 

Add readiness tabs for new battalions and companies 
The dashboards are preconfigured to display four battalions and four companies and their 

applicable total force/unit size. This tab also contains the availability based on survey 

submissions and percentage of readiness. 

To add percentages of readiness to the dashboard, complete the following steps: 

1. Sign in to your Portal for ArcGIS. 

2. Browse to the Personnel Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Select the 3rd Battalion tab while in edit mode 

5. Go to the editing tool within the Personnel List  element and select Duplicate. 

6. Drag the newly created copy and position it below the 3rd Battalion tab. Reference 
the 3rd Battalion settings, text, and configuration. 

7. Add a new name, such as 5th BN, to the new component and save your 

application. 

8. Go to the Reference section within the configuration tool and add the unit size 
below Fixed Value. 

  This number will provide the available value and percentage of readiness. 

9. Follow the previous step and enter your current Total Force for each unit level. 

10. If you need to remove a battalion tab, click the Delete button . 

11. Save your application. 
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Use Coronavirus Force Readiness 
The Coronavirus Force Readiness solution delivers a set of capabilities that help you to 

understand the operational capacity of a force, monitor the status of units, and communicate 

capabilities and disruptions to commanders and administrative staffs during the COVID-19 

pandemic. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Monitor force readiness 
The Coronavirus Force Readiness solution includes a Personnel Readiness Report survey that 

collects information from personnel, including their duty type, location, MOS (military 

occupational specialty), unit they belong to, and wellness information. Units deploying 

Coronavirus Force Readiness should review the preconfigured questions and adjust as 

necessary to remain in compliance with policies and applicable laws of your state or unit. In 

addition, ensure that you secure the survey and underlying layers and only share the content 

with appropriate members of your unit. 

Some organizations may find it more efficient to have an individual, such as someone from the 
armory, check their unit member in using the Personnel Readiness Batch Report survey. If a 
unit decides to use the batch survey, follow the same general steps below with the Personnel 
Readiness Batch Report survey and the Personnel Readiness Dashboard. 

 

Complete individual readiness report 
You will start by assuming the role of a military unit member. You are asked to use the 

Personnel Readiness Report survey to share your availability status each morning. 

1. In a browser, go to your Personnel Readiness Report survey. 

2. In the Personnel Readiness Report survey, fill in the following details: 

  Parameter 
  Value 

  State   Select California. 

  Battalion   Select 1st Battalion. 

  Company   Select A Company. 

  Rank   Select E-4/CPL. 

  MOS   Type 12W. 
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  Select Duty Type   Select State Active Duty. 

  First Name   Type your first name. 

  Last Name   Type your last name. 

  Commander   Type your commander's name. 

  Provide Location   Select your location on the map or provide your 
address. 

  Can you report for duty?   Select No. 

  Is it health related?   Select Yes. 

  Is it your health or someone 
else's? 

  Select Self. 

  Is it COVID-19 related?   Select Yes. 

  Select your status   Select Quarantined. 

  Select date quarantine started   Select a date within 14 days of today. 

  Check completed by:   Select Self. 

3. Click Submit. 

 

Monitor personnel readiness 
Now, you will assume the role of the Readiness NCO in the same unit. You are asked to 

monitor the readiness of your unit and are looking to see whether your unit is available to be 

assigned to a mission. You will view the overall readiness of your workforce. 

Note: 

The steps below are the same if you are an administrative NCO and will be using the Admin 
Dashboard to monitor the readiness of your team. The Admin Dashboard will contain 
personal information about the individual unit members. 

1. In a browser, go to the Personnel Readiness Dashboard app. 

2. The Personnel Readiness Dashboard opens with an overview of the overall 
readiness of the brigade and each battalion in the brigade. 
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  The overview displays key metrics. This information gives leadership a quick overview of 
the number of unit members available. Statistics related to the availability of your unit are 
also shown. 

3. In the filter at the top of the dashboard, click Last 24 Hrs to see a complete list of 
the submissions from the last 24 hours. 

4. Filter by Time frame, MOS by Battalion, and MOS by Company. Review the list 
of personnel and their locations in the map. 

5. Click each of the Battalion tabs to see the availability for each company in that 
battalion. 

6. Adjust the slider in the Quarantined (Start Date) - Last 14 Days chart to adjust the 
time period you want to review. 

In the lower left corner of the dashboard, you can review the COVID-19 Status submitted by 

individual unit members. 
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Coronavirus Health Screening 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Coronavirus Health Screening 
Coronavirus Health Screening can be used to conduct coronavirus disease 2019 (COVID-19) 

health screenings before employees and visitors are permitted to enter a building, facility, or 

location. 

As employees return to work and locations reopen to the public, organizations are taking steps 
to protect the health and safety of all individuals in their facilities. As a result, many 
organizations are asking employees and visitors to attest each day that they are symptom free 
and have not had recent contact with anyone who has tested positive for COVID-19. Many are 
also requiring a temperature check before they are permitted to enter the building. Coronavirus 
Health Screening is typically implemented by organizations that want to conduct health 
screenings on all employees and visitors entering their facilities. 

The Coronavirus Health Screening solution delivers a set of capabilities that help you screen 
employees and visitors by requiring that they self-report symptoms or contact, record the result 
of a temperature check, and track who was permitted to enter a facility or location on a given 
date. 

 

Requirements 
Coronavirus Health Screening requires the following: 

• ArcGIS Enterprise 

 

Information products 
Coronavirus Health Screening includes the following information products: 

Item Description 
Minimum 
user type 

Employee Health 
Screening 

An ArcGIS Survey123 form used by employees or contract 
personnel to self-report coronavirus symptoms or contact 
before entering a facility or location 

Editor 

Visitor Health 
Screening 

An ArcGIS Survey123 form used by visitors to self-report 
coronavirus symptoms or contact before entering a facility or 
location 

Not required 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 213 

Temperature 
Check 

An ArcGIS Survey123 form used by health screeners to 
record temperature checks of employees and visitors before 
entering a facility or location 

Editor 

Health 
Screening 
Dashboard 

An ArcGIS Dashboards app used by health screeners and 
human resources executives to monitor health screenings and 
determine who was permitted to enter a facility or location on 
a given date 

Viewer 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Coronavirus Health Screening 
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Configure Coronavirus Health Screening 
In this topic, you will learn how to configure the Coronavirus Health Screening solution to meet 

specific needs in your organization. 

 

Load screening locations 
Screening locations must be loaded into the HealthScreenings feature layer before using the 

Health Screening Dashboard. The ScreeningLocationsSource.csv file included with the 

solution can be used to organize your screening locations before loading into ArcGIS. 

To load your screening locations from the ScreeningLocationsSource.csv file, complete the 

steps below: 

1. Sign in to your ArcGIS organization and browse to the ScreeningLocationsSource 
item. 

2. Open the item page and click Download. 

3.  Browse to and open the ScreeningLocationsSource.csv file. 

  There are two fields in the .csv file, location and capacity, that match the Locations table 

in the HealthScreenings feature layer. 

4. Edit the .csv file and provide your list of screening locations and their capacity. 

5. In your ArcGIS organization, browse to the HealthScreenings feature layer. 

6. Open the item page and click Update Data > Append Data to Layer. 

7. Click Choose File and browse to your ScreeningLocationsSource.csv file, and 

click Open. 

8. Click Upload and Continue. 

9. Click the Choose the layer that you wish to append data into drop-down arrow 
and choose Locations. 

10. Uncheck Update existing features. 

11. Click Show field matching to map the fields. 

  Note: 

  If the capacity field isn't available as a Match Field option, check the .csv file to make 

sure the values in the capacity field are all numbers. 

12. Click Apply Updates. 

 

Update location choice list 
The Employee Health Screening and Visitor Health Screening surveys provide a default list of 

options for the Campus, Building, or Place Name question. You will update this choice list to 

reflect the locations you loaded into the HealthScreenings feature layer in the previous steps. 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 
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3. Click Employee Health Screening to download the survey. 

  Note: 

  The Employee Health Screening survey is an example. The steps below are the same 
for the Visitor Health Screening survey. 

4. In the Download window, click Download and click OK. 

5. Click Employee Health Screening again to open the survey. 

6. On the side toolbar, click the Open XLSForm Spreadsheet button. 

7. In the Microsoft Excel spreadsheet, click the choices tab. The location list defines 
the choices for the Campus, Building, or Place Name question. 

8. Update the list to reflect the locations you loaded in the previous steps. 

9. Save and close the Microsoft Excel spreadsheet and preview your changes in 
ArcGIS Survey123 Connect. 

10. In Survey123 Connect, click Publish on the side toolbar. 

11. Click Publish survey to publish your changes and click OK. 

 

Extend health screening surveys 
The Coronavirus Health Screening solution includes a series of surveys (Employee Health 

Screening, Visitor Health Screening, Temperature Check) that can be used by an employee, 

contractor, or visitor to self-report coronavirus symptoms or contact before entering a facility or 

location. 

Review the preconfigured questions and adjust as necessary to remain in compliance with your 
organizational policies and any applicable laws. The screening surveys do not record any of the 
responses to the health-related questions and are only used to determine the result of the 
screening. 

 

Add additional fields 
The health screening surveys leverage a series of views created from the HealthScreenings 

feature layer. Organizations may want to modify the Employee Health Screening, Visitor Health 

Screening, and Temperature Check surveys by first adding new fields to the feature layers and 

then configuring the surveys to use the newly created fields. When doing so, the new fields 

must be exposed in the appropriate views. 

When adding new questions, consider if you need to store the answer when the survey is 
submitted. For example, the health question responses are not stored with the feature layer and 
don't require a field. 

To add one or more fields to a layer and update the views, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization. 

2. Add a new field to a layer in the HealthScreenings hosted feature layer. 

3. Browse to the view. 

4. Open the item page and click the Visualization tab. 
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5. Click More Options on the appropriate layer or table, click Set View Definition > 
Define Fields. 

6. Scroll to the newly created field and check the box next to the new field or fields. 

7. Click Apply. 

  The new field is added to the view’s definition. 

   

Modify health screening surveys 
To modify a Coronavirus Health Screening survey, complete the following steps: 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Employee Health Screening to open the survey. 

  Note: 

  The Employee Health Screening survey is an example. The steps below are the same 
for the Visitor Health Screening and Temperature Check surveys. 

3.  On the side toolbar, click the Open XLSForm Spreadsheet button. 

4. Revise the survey to reflect your health screening needs. 

5. Save and close the Microsoft Excel spreadsheet and preview your changes in 
Survey123 Connect. 

6. In Survey123 Connect, click Publish on the side toolbar. 

7. Click Publish survey to publish your changes and click OK. 

 

Self-report temperature 
Health screenings typically involve a temperature check before an individual is permitted to 

enter a facility. By default, the Coronavirus Health Screening solution assumes a health 

screener will perform the temperature check, record the result, and admit or turn away the 

individual based on the result. Some organizations may choose to have employees or visitors 

perform their own temperature checks and record the result using the original health screening 

survey. This eliminates the need for a health screener to perform a temperature check before 

entering the facility. 

To enable employees or visitors to report their temperature in the health screening survey, 
complete the following steps: 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Employee Health Screening to open the survey. 

  Note: 

  The steps below can also be used to modify the Visitor Health Screening survey. 

3.  On the side toolbar, click the Open XLSForm Spreadsheet button. 
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4. In the Microsoft Excel spreadsheet, find the ask_temperature question in the third 
row, column B (name). 

5. Scroll to the right to column J (default) and change the text from No to Yes for this 
row. 

6. Save and close the Microsoft Excel spreadsheet and preview your changes in 
Survey123 Connect. 

  Note: 

  After you answer no to the three COVID-19 symptom and contact questions, a new 
question asking for your temperature is now required. 

7. In Survey123 Connect, click Publish on the side toolbar. 

8. Click Publish survey to publish your changes and click OK. 

 

Remove the temperature check list from the dashboard 
When the health screening survey is configured to ask the employee or visitor for their 

temperature, the temperature check list in the screening dashboard no longer applies and can 

be removed. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Health 
Screening Dashboard. 

2. Open the item page and click Edit Dashboard. 

3. Hover over the upper left corner of the Temperature Check element and click 
Delete. 

4. In the Delete Element window, click Delete. 

5. Click Save to save the dashboard. 
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Use Coronavirus Health Screening 
The Coronavirus Health Screening solution delivers a set of capabilities that help you screen 

employees and visitors by requiring that they self-report symptoms or contact, record the result 

of a temperature check, and track who was permitted to enter a facility or location on a given 

date. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Self-report symptoms or contact 
You will start by assuming the role of an employee in a government agency, business, or utility. 

Each day before entering a facility, you are asked to attest that you are symptom free and have 

not had recent contact with anyone who has tested positive for COVID-19. 

1. In a browser, from the Coronavirus Health Screening solution, view the Employee 
Health Screening form. 

2. Complete the form with as much information as possible. 

  Note: 

  Required questions are marked with a red asterisk. 

  If you are signed in, the form automatically fills in your name and email address from your 
user profile. If you select Yes to any of the health-related questions, a message displays at 
the bottom of the form indicating that you are at risk for COVID-19 and are not permitted to 
enter the building, and no other questions display. 

3. Click Submit. 

 

Perform a temperature check 
Now, you will assume the role of a health screener in the same government agency, business, 

or utility. You have been asked to perform a temperature check of employees or visitors before 

they will be permitted to enter the facility. 

Note: 

If an organization chooses to ask employees and visitors to self-report their temperature, 
these steps do not apply. Follow these steps to expose a temperature check question in the 
health screening surveys. 
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1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Coronavirus Health Screening solution. 

2. View the Health Screening Dashboard app. 

  The Health Screening Dashboard app opens to a list of employees and visitors who require 
a temperature check. The list is populated with the names of employees and visitors who 
have submitted the Employee Health Screening form. 

3. Locate an individual in the list, and then click the thermometer button to the right of 
the individual's name. 

  The Temperature Check form opens in a new tab. 

4. Confirm that the value for Full Name matches the individual that you selected. 

5. Type the temperature. 

  Note: 

  A temperature below 100.4 is not considered a fever and results in a message that 
states that the individual is permitted to enter the building. A temperature of 100.4 or 
higher returns a message that states that the person is not permitted to enter. 

6. Click Submit. 

7. Close the Temperature Check form and return to the Health Screening Dashboard 
app. 

 

Monitor health screenings 
You will continue your role as a health screener in the government agency, business, or utility. 

You have been asked to admit only employees or visitors who have passed the health 

screening into the building and to instruct those that have not passed the screening to return 

home. You have also been asked to monitor building occupancy to ensure that it doesn't exceed 

the maximum capacity. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Coronavirus Health Screening solution. 

2. View the Health Screening Dashboard app. 

  The Health Screening Dashboard app has three tabs: Temperature Check, Admit, and 
Rejected. At the bottom of the dashboard, an indicator shows the building's current 
occupancy rate. 

  Note: 

  If an organization chooses to ask employees and visitors to self-report their temperature, 
the Temperature Check list does not apply. 

3. On the left side of the app, click the arrow to display the filter panel. 
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  Tip: 

  You can pin the filter panel to the dashboard by clicking the pin in the upper-right corner. 

4. For Location, select a building. 

  The Occupancy indicator updates to show the building's maximum capacity and the 
number of employees and visitors who have been admitted to that building. 

  When additional individuals pass the health screening, the occupancy percentage updates. 
When occupancy reaches 100 percent, the value displays in red. 

5. Adjust additional filters to further refine the results. 

6. On the dashboard, click the Admit tab and review the list of individuals who have 
passed the screening and are permitted to enter the building. 

7. Click the Rejected tab and review the list of individuals who did not pass the 
screening and are not permitted to enter the building. 

 

Export a list of admitted employees and visitors 
You will assume the role of a human resources executive. An employee has tested positive for 

COVID-19 and was recently in one of your buildings. You need to export a list of every 

employee and visitor who was admitted to the facility on the same day and follow up with the 

health department. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Coronavirus Health Screening solution. 

2. Open the Employee Health Screening form item page. 

3. Click Open in Survey123 and choose Manage in Survey123 website. 

4. At the top right, click the Data tab. 

5. On the left, click Filter. 

6. Set the first expression to result is admit. 

7. Click Add expression. 

8. Set the second expression to EditDate is on and specify the date. 

9. Click Apply. 

10. Click Export and choose your output format. 

  After you select the format, the file downloads. 
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Coronavirus Recovery Dashboard 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Coronavirus Recovery 

Dashboard 
Coronavirus Recovery Dashboard can be used to tabulate and monitor key recovery metrics 

and trends that support phased coronavirus disease 2019 (COVID-19) recovery efforts. 

As communities begin to reopen, balancing public health metrics with economic growth is 
essential and understanding how these metrics vary from one geography to another helps 
decision makers develop strategic reopening plans. Coronavirus Recovery Dashboard is 
typically implemented by government organizations that want to visualize key recovery metrics 
over time to help inform health restrictions, social distancing decisions and recommendations 
made to open certain sectors of the economy. 

The Coronavirus Recovery Dashboard solution delivers a set of capabilities that help you 
tabulate recovery and reopening metrics, monitor key trends and performance targets for 
defined geographies, and communicate progress to interested stakeholders. 

 

Requirements 
Coronavirus Recovery Dashboard requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.5 or later (Basic, Standard, or Advanced) 

 

Information products 
Coronavirus Recovery Dashboard includes the following information products: 

Item Description 
Minimum 
user type 

Coronavirus 
Recovery 
Dashboard 

An ArcGIS Dashboards app used by health and human 
services staff to monitor symptoms, cases, and hospital 
capacity metrics and trends to support phased recovery 
efforts 

Viewer 
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Coronavirus 
Recovery Mobile 
Dashboard 

An ArcGIS Dashboards app optimized for mobile 
devices, used by health and human services staff to 
monitor symptoms, cases, and hospital capacity metrics 
and trends to support phased recovery efforts 

Viewer 

Coronavirus 
Recovery Data 
Management 

An ArcGIS Pro project used by health and human 
services staff to tabulate key recovery metrics and 
calculate symptoms and case trends 

GIS 
Professional 
Basic 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Coronavirus Recovery Dashboard 
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Configure Coronavirus Recovery Dashboard 
In this topic, you will learn how to configure the Coronavirus Recovery Dashboard solution to 

meet specific needs in your organization. 

 

Configure recovery dashboard 
The Coronavirus Recovery Dashboard includes a series of key recovery indicators defined by 

the United States Centers for Disease Control and Prevention (CDC) and specific metrics 

identified by the United States National Governors Association (NGA). The indicators and 

metrics are tabulated for a specific reporting area. The reporting areas can be a country, state 

or province, region, county, zip code, municipality, or any other geographic area you are using 

to tabulate results. 

To configure the dashboard for new metrics and trends you want to monitor, complete the steps 
below: 

1. Sign in to your ArcGIS organization and browse to the Coronavirus Recovery 
Dashboard item. 

  Note: 

  The steps below are the same for the Coronavirus Recovery Mobile Dashboard item. 

2. Open the item page and click Edit Dashboard. 

3. Hover over the upper left corner of a element and click Duplicate. 

4. Hover over the upper left corner of the duplicated element and click Configure. 

5. Click the Data tab. 

6. For an indicator element, change the Value setting to the new metric field. For a 
serial chart element, change Series 1 to the new value field and change Series 2 
to the new value trend field. 

7. Click the General tab. 

8. Change the name of the element. 

9. Modify the Title setting by clicking Edit and updating the title for the metric. 

10. Click Done. 

11. Hover over the  Coronavirus Recovery Dashboard in the upper right corner of the 
dashboard and click Configure. 

12. Click the Actions tab. 

13. For Filter, click Add Target and select the element you added. 

14. Scroll to the bottom, and for the new element, select Name for both Source and 
Target. 

15. Click Done. 

16. Click Save to save the dashboard. 
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Set metric targets 
The Coronavirus Recovery Dashboard has target goals of 90 percent for testing and health care 

metrics. The target percentage is provided as an example of how you can set a target and 

indicate whether you are meeting the target. You will want to configure these targets to meet 

your community's goals. 

To set the target for a testing or health care metric, complete the steps below: 

1. Sign in to your ArcGIS organization and browse to the Coronavirus Recovery 
Dashboard item. 

  Note: 

  The steps below are the same for the Coronavirus Recovery Mobile Dashboard item. 

2. On the dashboard item page, click Edit Dashboard. 

3. Hover over the upper left corner of the indicator element and click Configure. 

4. Click the Data tab. 

5. Change the Reference value to the desired target. 

  In some cases, you may not have a target associated with a metric and only want to 
indicate that the value is being measured. If so, you can disable the Conditional 
Formatting option. If you want to keep the target and don't want to disable this option, skip 
to step 10. 

6. Click the General tab. 

7. Click Edit to modify the Description setting. 

8. Click Source and copy the following HTML snippet into the editor: 

   
<table style="background-color:#2695bc; color:#ffffff; font-size:16px; 
padding:2px; text-align:center; width:100%">  
    <tbody>  
        <tr>  
            <td>  
                <p>Measured</p> 
            </td>  
        </tr>  
    </tbody>  
</table> 

9. Click Source. 

10. Click Done. 

11. Click Save to save the dashboard. 
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Use Coronavirus Recovery Dashboard 
The Coronavirus Recovery Dashboard solution delivers a set of capabilities that help you 

tabulate recovery and reopening metrics, monitor key trends and performance targets for 

defined geographies, and communicate progress to interested stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Tabulate recovery metrics 
Past case and symptom information can be used to calculate 14-day trends to indicate if the 

community is seeing a downward or upward trend. New metric information can be added as 

frequently as you receive updates, and trend lines can be recalculated with the latest 

information to give an accurate picture of the current state in the community. 

You will start by assuming the role of an epidemiologist. You are asked to use the Coronavirus 
Recovery Data Management project to tabulate coronavirus disease 2019 (COVID-19) cases 
each morning. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Coronavirus Recovery Dashboard solution. 

2. Download the Coronavirus Recovery Data Management project, and then unzip the 
folder. 

3.  From the unzipped folder, open the Coronavirus Recovery Data Management 
project in ArcGIS Pro. 

4. In the Catalog pane, expand the Tasks folder, and then double-click the 
Coronavirus Recovery Data Management task. 

  Note: 

  If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Task Pane, expand the How to Use Coronavirus Recovery Data 
Management task group to see the collection of tasks. 

6. Open each task and follow the steps provided. 

 

Monitor coronavirus recovery 
Now you will assume the role of a public health officer or executive in the same government 

agency. You have been asked to monitor case and symptom trends over the last 14 days and 

verify that testing and health care facilities are meeting specific requirements. 
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Before beginning a phased reopening, you want to confirm that there is a downward trend in the 
number of new positive cases and individuals experiencing flu-like and COVID-19 symptoms. 
You also want to ensure a minimum percentage of testing sites and health care facilities are 
meeting minimum requirements defined by the community. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Coronavirus Recovery Dashboard solution. 

2. View the Coronavirus Recovery Dashboard app. 

  The Coronavirus Recovery Dashboard solution opens with trend information for cases and 
symptoms and metrics for testing and health care facilities. 

3. Observe whether the number of cases and symptoms has increased or decreased 
over the last 14 days. 

4. View the testing and health care metrics and validate that each is meeting the 
specified target. 

5. At the top right, from the drop-down list, choose another reporting area to view the 
metrics and trends for that area. 
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Coronavirus Site Safety 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Coronavirus Site Safety 

Legacy: 

Coronavirus Site Safety 

has been moved to mature support. 

Coronavirus Site Safety can be used to create coronavirus disease 2019 (COVID-19) health 
safety plans for their facilities, sites, and campuses and to monitor health safety plans as 
locations reopen. 

As employees return to work and locations reopen to the public, organizations are developing 
health safety plans to protect individuals in their facilities. The health safety plans mitigate 
workers' concerns, reduce risk and communicate actions taken to key stakeholders. Location-
enabled plans provide an efficient way to document and manage all aspects of a health safety 
plan (for example, temperature screening locations, handwashing or sanitizer stations, personal 
protective equipment (PPE) stations, and isolation areas) for a given facility. It improves an 
organization’s ability to effectively execute a plan, mitigate risk at each site, and exercise health 
safety due diligence for a location. Coronavirus Site Safety is typically implemented by 
organizations that want to take a proactive, data-driven approach to planning and managing the 
health and safety of employees, visitors and other stakeholders during the COVID-19 pandemic. 

The Coronavirus Site Safety solution delivers a set of capabilities that help you create a COVID-
19 health safety plan, estimate crowd capacities and monitor social distancing, track cleaning 
and disinfecting, monitor restocking of PPE stations, and report coronavirus-related problems 
and issues. 

 

Requirements 
Coronavirus Site Safety requires the following: 

• ArcGIS Enterprise 

• ArcGIS AppStudio Player 

• ArcGIS Field Maps 
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Information products 
Coronavirus Site Safety includes the following information products: 

Name Description 
Minimum user 
type 

Coronavirus Site 
Safety Form 

A Survey123 form used internally by a health safety 
officer to define the health safety plan for a given site 
or location 

Editor 

Coronavirus Site 
Safety Manager 

A Crowdsource Manager app used by a health safety 
officer to manage the status of health safety plans 

Editor 

Coronavirus Site 
Safety Map Editor 

A Web AppBuilder app used by a health safety officer 
to locate health resources and create social distance 
capacity estimates required for a health safety plan 

Editor 

Coronavirus Site 
Safety Map Viewer 

A Web AppBuilder app used by stakeholders to review 
a health safety map for a given location 

Viewer 

(Not required 
for public 
access) 

Coronavirus Site 
Safety Issue 
Reporter 

A Survey123 form used by field staff to report social 
distancing concerns, potential cases, and other health 
safety issues 

Field Worker 

Crowd Counter App An AppStudio app used by staff to count people 
entering and exiting an area 

Field Worker 

Coronavirus Site 
Safety Dashboard 

An ArcGIS Dashboards app used by a health safety 
officer to monitor health safety plan operations at a 
given location 

Viewer 

Coronavirus Site 
Safety Mobile 
Dashboard 

An ArcGIS Dashboards app used by a health safety 
officer on their mobile device to monitor health safety 
plan operations at a given location 

Viewer 

Cleaning and 
Restocking Status 
Map 

A map used in ArcGIS Field Maps to manage the 
cleaning, disinfecting, and restocking of health safety 
resources 

Field Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.2 • A new version of the Crowd Counter App that resolves an issue where 
the app would not load in the AppStudio Player 

1.1 • A new Coronavirus Site Safety Issue Reporter that resolves an issue 
where the form could not be opened in the ArcGIS Survey123 app. 
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• A new Coronavirus Site Safety Manager map and app that resolves an 
issue where site plan updates were missing the associated plan identifier. 

• A new Coronavirus Site Safety Map Editor app that resolves an issue 
where site plan updates were missing the associated plan identifier. 

1.0 • First release of Coronavirus Site Safety 
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Configure Coronavirus Site Safety 
You can use the ArcGIS Solutions app to deploy the Coronavirus Site Safety solution in your 

ArcGIS organization. After deploying the solution to your ArcGIS organization, configure it to 

meet specific needs in your organization and load your data if needed. 

 

Define cleaning interval 
Implementing coronavirus disease 2019 (COVID-19) health safety policies for your organization 

requires cleaning or disinfecting high-risk locations at a regular interval. The cleaning, 

disinfecting, or restocking interval varies according to your organization, the volume of people, 

or the risk level of the site. Intervals can be set in any increment from hourly to weekly or 

monthly. 

The Coronavirus Site Safety Dashboard solution helps organizations track the cleaning status of 
high-risk locations to ensure compliance with organizational policies and local regulation. Using 
the Cleaning and Disinfecting Status map in ArcGIS Collector, janitorial staff can report each 
time they clean, disinfect, or restock a given location. 

 

Update map 
Using the Coronavirus Site Safety Dashboard, an organizational health safety officer can 

identify any locations that are overdue for cleaning based on the interval determined by their 

organizational policy. This information helps the health safety officer identify locations that are 

noncompliant with the organizational policy and immediately respond with dispatch of janitorial 

staff. 

The Coronavirus Site Safety Dashboard can be configured to meet specific needs in your 
organization. Modify the default cleaning interval (1 hour) to the interval required by your 
organization. 

To configure the map, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the Coronavirus Site Safety 
Dashboard map. 

2. Open the map in Map Viewer Classic. 

3. Browse to Health Points Status_currentjoin and click the Filter button. 

4. Click the Edit tab to view the filter: StatusDate not in the last 1 hours. 

5. Modify the filter to reflect the appropriate interval for your organization. 

6. Click Apply Filter and save your map. 

 

Configure dashboard 
Once the map has been configured to filter on a new interval, the title of the cleaning and 

restocking list element in the Coronavirus Site Safety Dashboard and Coronavirus Site Safety 

Mobile Dashboard needs to be updated to reflect the interval you defined. 
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To configure the dashboard label to reflect the changes you made to the map, complete the 
steps below: 

1. Sign in to your ArcGIS organization and browse to the Coronavirus Site Safety 
Dashboard. 

2. On the dashboard item page, click Edit Dashboard. 

3. Hover over the upper left corner of the Overdue Locations (>60Min.) Cleaning 
|Disinfection | Re-stock list element and click Configure. 

4. Click the General tab. 

5. Click Edit to modify the Title value, remove the default time interval (for example, 
>60Min), and update the title to reflect the new cleaning interval. 

6. Click Done. 

7. Click Save to save the dashboard. 

8. Ensure you repeat steps 2 through 7 for the Coronavirus Site Safety Mobile 
Dashboard once you have completed the steps for the Coronavirus Site Safety 
Dashboard. 

 

Add building floor information 
For many sites, health and safety plans include interior floors and exterior spaces. ArcGIS 

Indoors is a complete indoor mapping system that can help you incorporate interior floors and 

floor awareness, and the ability to filter by indoor web layers by floor, into the Coronavirus Site 

Safety solution. The following apps support floor awareness: 

• Coronavirus Site Safety Map Editor 

• Coronavirus Site Safety Map Viewer 

• Coronavirus Site Safety Dashboard 

• Coronavirus Site Safety Mobile Dashboard 

To complete this workflow, you must have your local ArcGIS Indoors geodatabase published as 

web layers into your ArcGIS organization. 

 

Configure maps for ArcGIS Indoors 
To configure the Coronavirus Site Safety solution maps to use ArcGIS Indoors web layers, you'll 

need to review the Level Name field values defined in your ArcGIS Indoors web layers and 

ensure the Floor Number field values your health safety officer is using when creating the health 

safety plan are the same as the values in the ArcGIS Indoors layers. 

Using consistent values between Level Name field values and Floor Number field values 
ensures that the correct building floor information and related health safety plan information are 
displayed on the map and apps. 

Once you have ensured consistency between your layers, add your ArcGIS Indoors web layers 
to the Coronavirus Site Safety Map Editor map, Coronavirus Site Safety Map Viewer map, and 
Coronavirus Site Safety Dashboard map. 
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Configure web mapping apps 

1. Sign in to your ArcGIS organization and browse to the Coronavirus Site Safety Map 
Editor item page. 

2. On the item page, click Edit Application. 

3. Click Widget and click the edit button on the Filter Safety Plan and Floor widget. 

4. In the Filter Set Name: Floor Number filter group, click Add Layer. 

5. In the newly added row, in the Layer column, choose an ArcGIS Indoors web layer, 
and in the Field column, choose Level Name. 

6. Repeat step 5 for all the remaining ArcGIS Indoors web layers. 

7. In the Use Value column, choose the ArcGIS Indoors Levels web layer. 

8. Click OK and click Save. 

Repeat the process for the Coronavirus Site Safety Map Viewer app. 

 

Configure dashboards 
To configure the Coronavirus Site Safety Dashboard and CCoronavirus Site Safety Mobile 

Dashboard to use ArcGIS Indoors web layers, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the Coronavirus Site Safety 
Dashboard. 

2. On the dashboard item page, click Edit Dashboard. 

3. Hover over the upper left corner of a Floor Number selector and click Configure. 

4. In the Selector section, under Selector Options, click Change and choose your 
ArcGIS Indoors Levels web layer. 

5. In the Catogory Field parameter, choose Name. 

6. Click Action, click Add Target and choose an ArcGIS Indoors web layer, and then 
choose LEVEL_NAME for the Target Field. 

7. Repeat step 6 for all the remaining ArcGIS Indoors web layers. 

8. Click Done and click Save to save the dashboard. 

Note: 

Repeat the process for the Coronavirus Site Safety Mobile Dashboard. 

 

Extend health planning resources 
The Coronavirus Site Safety solution includes dashboards that can be used to monitor health 

safety plan operations. 

On occasion, you may need to configure the dashboard to meet specific needs in your 
organization. Each solution generally includes one or more feature layers, maps, and apps that 
can be configured to meet your needs. Review this solution with stakeholders in your 
organization before defining the specific configurations you will make. 
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Update feature layer views 
The Coronavirus Site Safety solution includes a series of feature layer join views that are used 

to display information in the Coronavirus Site Safety Dashboard and Coronavirus Site Safety 

Mobile Dashboard. Join views are created using the Join Features analysis tool by joining two 

sources together based on a matching field. The benefit of the join view is that it remains up to 

date as the source data changes. However, when new fields are added to the source layers, the 

join views must be re-created with the same name and URL for the dashboards to continue 

working properly. 

To add a field to a layer and the update the join views, complete the following steps: 

1. Add a new field to a layer (for example, the Health Points layer in the 
HealthSafetyPlanning hosted feature layer). 

2. Browse to the join view in your contents (for example, Health Points Status_join). 

3. On the item Overview page, scroll to the URL section. Click the Copy button. 

4. Paste the copied URL into Microsoft Notepad or another text editor for reference. 

  Note: 

  The feature layer name will be used below when re-creating the join. The name can be 
found after services in the URL structure and may also contain a unique GUID, for 
example, Health_Points_Status_joina45f71a48587425c9b90ee5527cd26d1. 

5. Delete the existing join view (for example, Health Points Status_join). 

6. Add the source hosted feature layer to a new web map (for example, 
HealthSafetyPlanning). 

7. Click Analysis > Summarize Data > Join Features. 

8. Configure the join using the following table: 

  Name of 
join 

  Target 
layer 

  Layer 
to 
join 
to the 
targe
t 
layer 

  Fields to 
match 

  Join 
ope
rati
on 

  Define 
which 
record is 
kept 

  Health 
Points 
Status_joi
n 

  Health 
Points 
(HealthSafet
yPlanning) 

  Statu
s 

  GlobalID = 
Health_Point
s_GlobalID 

  Join 
one 
to 
man
y 

 

  Health 
Points 
Status_c
urrentjoin 

  Health 
Points 
(HealthSafet
yPlanning) 

  Statu
s 

  GlobalID = 
Health_Point
s_GlobalID 

  Join 
one 
to 
one 

  Order by 
created_da
te/Newest 
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  Crowd 
Area 
CrowdCo
unts_join 

  Crowd 
Areas 

  Crow
dCou
nt 

  areaname = 
areaname 

  Join 
one 
to 
man
y 

 

  Note: 

  Ensure each new join view uses the names defined in the table. If you use the 
same names, the layers in the map and the existing dashboard widgets do not 
need to be reconfigured. If your join view contained a unique GUID, the new join 
view will need to be named with the unique GUID. 

9. If necessary, uncheck Use current map extent and check Create results as 
hosted feature layer view. 

10. Update the web map and app configurations for Coronavirus Site Safety 
Dashboard and Coronavirus Site Safety Mobile Dashboard to account for the new 
fields you added to the layers. 
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Use Coronavirus Site Safety 
The Coronavirus Site Safety solution delivers a set of capabilities that help you create a 

coronavirus disease 2019 (COVID-19) health safety plan, estimate crowd capacities and 

monitor social distancing, track cleaning and disinfecting, monitor restocking of personal 

protective equipment (PPE) stations, and report coronavirus-related problems and issues. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Manage a site 
Creating and implementing health and safety plans for sites, facilities, campuses, or locations is 

an important part of keeping communities and individuals safer, as schools, colleges, 

businesses, and facilities operate during the COVID-19 pandemic. 

Coronavirus Site Safetyoffers a comprehensive system to manage all sites in one central 
location. Each site or facility can progress through the site safety planning process, site 
planning, and operations independently, so you have the flexibility to implement appropriate 
health safety measures. 

In this workflow, you'll learn how to initiate and manage a site safety plan. 

 

Create a site safety plan 
You will start by assuming the role of a health safety officer who needs to initiate the site safety 

planning process. Using the Coronavirus Site Safety Form, you will document the site where a 

health safety plan will be created. 

1. Sign in, to your ArcGIS organization and browse to the Coronavirus Site Safety 
Form. 

2. Open the item page and navigate to the Coronavirus Site Safety Form. 

3. In the Coronavirus Site Safety Form, fill in the following details on the first page: 

  Parameter 
  Value 

  Enter Plan Name   Type plan name 

  Description   Type description 

  Start Date   Enter the date and time the plan will become active. 

  Contact Name   Type your name. 

  Contact Phone   Type your phone number. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 236 

  Contact Email   Type your email address. 

  Describe location   Type description 

  Additional Documents   Attach a diagram to describe the setup of a site. 

  Please locate the property   Type location information 

4. At the bottom of the page, click Submit. 

 

Manage and review site safety plans 
Now, you will continue the role of a health safety officer using the Coronavirus Site Safety 

Manager to update the status of a site safety plan for a location. 

1. In your ArcGIS organization and browse to the Coronavirus Site Safety Manager 
app. 

2. Open the item page and navigate to the Coronavirus Site Safety Manager app. 

3. Choose the Coronavirus Site Safety Manager map. 

4. In the Coronavirus Site Safety Manager table, select the plan you created in the 
Coronavirus Site Safety survey, or another plan. 

5. On the Info tab, click the edit button and edit the status. 

  As a health safety officer, you can update and monitor the status of an event throughout 
the planning process and identify when site safety maps have been created. 

6. For Status, choose Active, and click Save. 

 

Prepare site safety plans 
To protect the people who work in, shop in, study in, and use their facilities, organizations are 

preparing comprehensive site health safety plans that include prevention, mitigation, and 

response capabilities. A site health safety plan, and the health safety officer who manages it, 

represents the front line of pandemic defense for any organization, and an essential component 

of a safe back-to-work strategy. 

Health safety officers need to place preventative health resources, mitigate risk via socially 
distanced crowd management, identify high-touch surfaces in need of frequent cleaning, and 
prepare response plans for screening locations and the isolation of potential cases. 

The Coronavirus Site Safety Plan Map Editor can be used to locate health resources and create 
social distance capacity estimates required for a health safety plan. The social distance capacity 
estimates for areas or lines are based on U.S Fire Administration guidelines. 

In this workflow, you'll learn how to locate and develop a site safety plan map. 
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Develop a health and safety plan 
You will start by assuming the role of a health safety officer who needs to create a site safety 

plan map. You are asked to use the Coronavirus Site Safety Manager app to locate a site safety 

plan location and then the Coronavirus Site Safety Map Editor to create the health and safety 

plan map for your location. 

1. In your ArcGIS organization and browse to the Coronavirus Site Safety Manager 
app. 

2. Open the item page and navigate to the Coronavirus Site Safety Manager app. 

3. Choose the Coronavirus Site Safety Manager map. 

4. Select the site you created in the Coronavirus Site Safety Form survey, or another 
site. 

5. On the Info tab, click Edit Site Plan. 

  The Coronavirus Site Safety Plan Map Editor app opens and zooms to the event. It also 
filters all related information, so you will see temporary features for your site plan and floor 
number, if applicable. 

6. Click the Create Site Safety Plan widget, search for PPE Station, and enter 

details of the health asset. For Floor Number, type 1. 

7. Place a PPE station on the map and enter details for the health and safety asset. 

8. Search for a handwashing station, place it on the map, and enter details for the 
health and safety asset. 

9. Search for a high-touch location, place it on the map, and enter details for the 
health and safety asset. 

10. Repeat step 5 for each health and safety asset, route, and area you would like to 
add to your site plan map. 

11. Click Save. 

12. Select Social Distancing Crowd Areas from the drop-down list at the top of the 
Create Site Safety Plan widget. 

13. Draw an area on the map and double-click to complete the sketch. 

14. For Area name, type Waiting Area. 

  Note: 

  The Area name field must be unique 

15. Draw an area on the map and double-click to complete the sketch. 

  Note: 

  The area on the map is labeled with the number of people that can safely enter an area 
of this size based on U.S. Fire Administration guidelines. Adjust the maximum capacity 
or area size if necessary. 

16. For Description, type Crowd Area for Waiting Area. 

17. Click Save. 
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18. After completing your Site Safety map, click the Site Safety Report button, draw 
an area on the map, and click Report. 

19. Click the Print button and save a hard copy of your site plan map and summary of 
your health assets. 

20. Close the Coronavirus Site Safety Map Editor. 

 

Share site safety plans 
Employees, students, customers, and other people returning to a facility may be concerned 

about large crowds or other conditions that increase the likelihood of being exposed to the 

coronavirus. To ease those concerns, health safety officers need to communicate key aspects 

of their site health safety plans to their stakeholders, such as the locations of entry health 

screenings, hand sanitizer stations, or personal protective equipment (PPE) stations. 

The Coronavirus Site Safety Map Viewer can be used by stakeholders to review a health safety 
map for a location. In this workflow, you'll learn how to share and view a health and safety plan. 

 

Share a health and safety plan 
You will start by assuming the role of a health safety officer who needs to share a site safety 

plan. You are asked to use the Coronavirus Site Safety Manager app to locate a site safety plan 

location and then use the Coronavirus Site Safety Map Viewer to share the health and safety 

plan map for your location. 

1. In your ArcGIS organization and browse to the Coronavirus Site Safety Manager 
app. 

2. Open the item page and navigate to the Coronavirus Site Safety Manager app. 

3. Choose the Coronavirus Site Safety Manager map. 

4. Select the site you created in the Coronavirus Site Safety Form survey, or select 
another site. 

5. On the Info tab, click Share Site Plan Viewer. 

  The Coronavirus Site Safety Map Viewer app opens and zooms to the site plan. It also 
filters all related information, so you will only see features for your site plan and floor 
number, if applicable. 

6. Copy the hyperlink, and share it with site staff, cleaning staff, and other interested 
stakeholders. 

 

View a health and safety plan 
Now, you will assume the role of site staff who need to view the health and safety plan for a 

location. You are asked to use the Coronavirus Site Safety Map Viewer app to explore the 

health and safety plan. 

1. In your ArcGIS organization and browse to the Coronavirus Site Safety Map Viewer 
app. 

2. Open the item page and navigate to the Coronavirus Site Safety Map Viewer app. 
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3. In Filter Safety Plan and Floor, choose Floor Number, choose 1, and click 
Apply. 

  The first floor is displayed. 

4. Explore the health and safety map by zooming into the crowd areas and click the 
health points, lines and areas to see more information about each one. 

5. Click the Filter Resources button, enable Filter by Point Type, and choose 
Handwashing Station. 

  Only handwashing stations appear on the map. 

6. Optionally, click the Print button, choose a layout and format, and click Print to 
create a hard copy of the plan map. 

7. Close the Coronavirus Site Safety Map Viewer. 

 

Conduct health and safety operations 
The Coronavirus Site Safety solution provides a complete set of capabilities that improve the 

efficiency and effectiveness of health safety officers, cleaning staff, and site staff working at a 

location during the COVID-19 pandemic by enabling staff with tools to capture information from 

the field to share with health officers in real time. 

In this workflow, you'll learn how to use a collection of maps and apps to support health safety 
officers, cleaning staff, and site staff to visualize, monitor, and communicate real-time status 
during operational hours. 

 

Report site safety issues from the field 
When health safety issues occur at a site, staff need to be able to report the issues they 

observe in the field to the health safety officer for immediate response. 

You will assume the role of a site employee that needs to report a face mask compliance 
problem you are observing. You are asked to use the Coronavirus Site Safety Issue Reporter to 
report the health safety concern. 

1. In your ArcGIS organization and browse to the Coronavirus Site Safety Issue 
Reporter app. 

2. Open the item page and navigate to the Coronavirus Site Safety Issue Reporter 
app. 

3. In the Coronavirus Site Safety Issue Reporter, fill in the following details: 

  Type   Type issue description 

  Priority Level   Type 2 

  Narrative   Type narrative 

  Location   Choose a location on the map. 
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  Location Description   Type location description. 

  Floor   Type floor level 

4. Optionally, add an image or picture of the issue you are reporting. 

5. Click Submit. 

 

Download and configure Crowd Counter App 
The Crowd Counter App can be used by staff to count people entering and exiting an area. The 

app uses ArcGIS AppStudio Player on a mobile device to deliver a custom project that 

combines an ArcGIS QuickCapture project and an ArcGIS Dashboards (Crowd Counter 

Dashboard) into a single experience to support the crowd counting workflow. 

If you have already set up the Crowd Counter App on your mobile device, proceed to the Track 
crowd capacity section below. If this is the first time you are using the Crowd Counter App on 
your mobile device, complete the following steps: 

1. Download ArcGIS AppStudio Player onto your mobile device. 

2. Open the app on your mobile device, and sign in to your ArcGIS organization. 

3. Click the Shared button and click the Crowd Counter App button to download the 
app. 

4. Click the Crowd Counter App button.  

  An ArcGIS QuickCapture screen prompts you to sign in to your ArcGIS organization again. 

5. Click the add button and choose Browse Projects, and then click Crowd Counter 
App to download the project. 

6. When the download is complete, choose Crowd Counter Dashboard, and when 
prompted, sign in to your ArcGIS organization and choose Keep me signed in. 

Note: 

The first time you set up your mobile device with the Crowd Counter App, you are prompted 
to sign in two separate times. This is expected. After the initial setup, you are only asked to 
sign in once, after you see the ArcGIS QuickCapture screen. 

 

Track crowd capacity 
You will assume the role of site staff. You are asked to use the Crowd Counter App to count 

people entering and exiting the area to ensure the number of people admitted does not exceed 

the maximum capacity allowed for a unique area. 

1. Open and sign in to the Crowd Counter App using the ArcGIS AppStudio Player 
app on your mobile device, if it isn't already open from the previous workflow. 

2. Click the edit button to edit the area name and enter the exact area name of the 
location you are tracking crowd capacity for (use Waiting Area if you completed 

the Prepare site safety plans workflow). 
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  Note: 

  The area name you type must match exactly with the area name specified in the health 
safety plan map. If you are unsure of the exact name, click the Map tab to see a map of 
your site containing labels with the exact name of each crowd area. 

3. Click Done. 

4. Choose Enter for each person entering the area and choose Exit for each person 
exiting the area. 

5. Monitor the gauge on the Occupancy tab to understand the current capacity 
(middle number) relative to the maximum capacity (last number). 

  Tip: 

  The gauge displays different colors as capacity changes. The color green indicates 
capacity, orange indicates maximum capacity is near, and red indicates maximum 
capacity. 

6. Continue to allow people to enter and exit the area based on the current capacity. 

Note: 

If the gauge does not display the correct results, click the refresh button in the upper right 
hand corner of the app, click the edit button to edit the area name, and click Done. 

Tip: 

When the Crowd Counter App is used to count high numbers of people, consider deleting 
or archiving entry and exit records from the Crowd Count layer to ensure better 
performance of the app. 

 

Track cleaning and stocking status 
You will now assume the role of janitorial staff. You are asked to use the ArcGIS Field Maps 

mobile app to update the status of locations after you clean, disinfect, or restock them with PPE. 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Open the app on your mobile device and sign in to your ArcGIS organization. 

3. Choose Cleaning and Restocking Map. 

4. Choose a station for PPE Station, choose Cleaning and Restocking Status in the 
pop up, and click the Add button. 

  Note: 

  The space under the Add button displays all historical status records for a location, so as 
a station is restocked with PPE, a user can review this list to see when it was restocked 
and how much PPE it was restocked with. 
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5. Choose status, choose Re-stocked, and add the number of boxes stocked of each 
PPE type. 

6. Choose Submit. 

 

Monitor site safety operations 
Health safety officers need real-time information on the location issue reports, status of cleaning 

and restocking, and crowd capacity information to conduct health and safety operations of sites. 

The Coronavirus Site Safety Dashboard can be used in the command center on the day of the 

event. 

You will assume the role of a health safety officer. You are asked to use the Coronavirus Site 
Safety Dashboard to monitor and manage health safety issue reports, site capacity, and 
cleaning and restocking status. 

1. In your ArcGIS organization and browse to the Coronavirus Site Safety Dashboard 
app. 

2. Open the item page and navigate to the Coronavirus Site Safety Dashboard app. 

3. At the top of the dashboard, use Select Site Safety Location and choose a site.  

  The dashboard information updates to reflect only what is visible on the map. 

4. View the number of open issue reports in the Issue Reports section.  

5. Click the Open Reports tab at the bottom of the dashboard to see open issues in 
priority order based on site safety issues reported by staff using the Coronavirus 
Site Safety Issue Reporter. 

  Note: 

  Learn how to update the status of issue reports using the Manage issue status workflow 
in the section below. 

6. Click the Report Log tab at the bottom of the dashboard to see the last 50 issue 
reports, regardless of status, listed in order of importance.  

  This allows you to compare issue reports, reopen closed issues, and identify any emerging 
patterns. 

7. In the Capacity Monitoring section, you will see the real-time total capacity by 
percentage, as well as total capacity and maximum capacity by count across your 
site based on information from staff tracking crowd capacity using the Crowd 
Counter App. 

8. On the Area Capacities tab at the bottom of the dashboard, click Waiting Area or 
another area in the list.  

  The map zooms to the area and a pop-up appears with information about the area. The 
Capacity Monitoring section at the top of dashboard updates to reflect the capacity 
information for the area. 

9. Click the Live Count tab at the bottom of the dashboard to see the real-time list of 
entries and exits from the selected area in the Area Capacities list. 
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  Note: 

  If an individual area is not selected in the Area Capacities list, you see the total entries 
and exits from all areas in the Live Count list. 

10. Click the Status List tab on the bottom of the dashboard to see real-time cleaning 
and restocking status for PPE stations, high-touch locations, and other health 
assets. 

11. Click the Status History tab on the bottom of the dashboard to see historical 
cleaning and restocking status for PPE stations, high-touch locations, and other 
health assets. 

12. Close the app. 

 

Manage issue status 
Health safety officers need real-time information on reported health safety issues as well as the 

ability to update status, assignments, and other details of an issue. 

You will assume the role of a health safety officer. You are asked to use the Coronavirus Site 
Safety Dashboard to locate an issue report at a site and then use the Coronavirus Site Safety 
Manager to update the status of the report. 

1. In your ArcGIS organization and browse to the Coronavirus Site Safety Dashboard 
app. 

2. Open the item page and navigate to the Coronavirus Site Safety Dashboard app. 

3. At the top of the dashboard, use Select Site Safety Location and choose a site.  

  The dashboard information updates to reflect only what is visible on the map. 

4. Click the Open Reports tab at the bottom of the dashboard to see open issues in 
priority order, based on site safety issues reported by staff using the Coronavirus 
Site Safety Issue app. 

5. Click the Update Status button. 

  The Coronavirus Site Safety Manager app opens. 

6. Click the Coronavirus Issue Report Status map. 

7. In the Coronavirus Issue Reports table, select the issue you want to update. 

8. On the Info tab, click the edit button and edit the status. 

  As a health safety officer, you can update and monitor the status of an issue at any time. 

9. For Report Status, choose Closed, and click Save. 

10. Close the app. 

 

Coronavirus Testing Sites 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  
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Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Coronavirus Testing Sites 
Coronavirus Testing Sites can be used to identify at-risk populations and develop coronavirus 

disease 2019 (COVID-19) testing site plans. 

Preventing the spread of infection is one of the most effective ways to stop the pandemic and 
reopen communities. Widespread testing helps residents determine if they have been infected 
and could spread coronavirus to others. Furthermore, testing matters more in communities 
affected the most. Communities of color and socioeconomically vulnerable communities are 
disproportionately burdened by the pandemic and the impact is acute. Understanding population 
demands and where racial and socioeconomic vulnerabilities exist helps communities locate 
ideal testing sites. Coronavirus Testing Sites is typically implemented by health and human 
services or public safety agencies that want to optimize the location of coronavirus disease 
2019 (COVID-19) testing sites, maximize limited testing resources and ensure communities 
affected the most have access to coronavirus testing. 

The Coronavirus Testing Sites solution delivers a set of capabilities that help you identify at-risk 
populations, locate optimal testing sites, manage testing site status, and share testing site 
information with the public. 

 

Requirements 
Coronavirus Testing Sites requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.9 (Advanced) 

– ArcGIS Geostatistical Analyst extension 

 

Information products 
Coronavirus Testing Sites includes the following information products: 

Item Description 
Minimum user 
type 

Testing Sites 
Locator 

An ArcGIS Web AppBuilder app used by the public to 
locate the nearest coronavirus testing location 

Viewer 

Testing Sites 
Manager 

A Crowdsource Manager app used by health and human 
services staff to inventory coronavirus testing locations 

Editor 

Testing Site 
Allocation 

An ArcGIS Pro project used by health and human services 
analysts to identify at-risk populations and locate optimal 
testing sites 

GIS Professional 
Advanced 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
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(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • Resolved an issue in the Solve Location Allocation with Risk model that 
prevented it from running properly. 

1.0 • First release of Coronavirus Testing Sites. 
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Use Coronavirus Testing Sites 
The Coronavirus Testing Sites solution delivers a set of capabilities that help you identify at-risk 

populations, locate optimal testing sites, manage testing site status, and share testing site 

information with the public. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Identify at-risk populations 
At-risk populations can be quickly modeled using the Testing Site Allocation project. By default, 

the risk model helps you identify racial and socioeconomic vulnerability. 

Organizations can select specific demographic variables that align with risk factors you are 
concerned about in your community. The variables will help you create a risk map and allocate 
testing sites to these areas of need. 

You will start by assuming the role of an emergency response GIS analyst. You are asked to 
use the Testing Site Allocation project to create a community risk surface. 

1. Start ArcGIS Pro and open the Testing Site Allocation project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Testing Site 
Allocation task. 

4. In the Task pane, click the Testing Site Allocation task group to expand the 
collection of tasks. 

5. Follow the steps in each task. 

 

Locate the best testing sites 
The best testing sites can be quickly located with the Testing Site Allocation project. Use the 

previously defined risk map, population demand, and a list of candidate sites to locate the best 

testing sites in your community. 

You will start by assuming the role of an emergency response GIS analyst. You are asked to 
use the Testing Site Allocation project to select the best testing sites from a list of candidate 
sites that meet needs defined in the risk map and other population demand. 

1. Start ArcGIS Pro and open the Testing Site Allocation project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Testing Site 
Allocation task. 

4. In the Task pane, click the Testing Site Allocation task group to expand the 
collection of tasks. 

5. Open the Identify candidate sites task and follow the steps provided. 
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  Note: 

  The GISCorps COVID-19 Testing Sites feature service is a freely available source of 
nationwide existing testing sites that can be used in this task. 

6. Next, open the Identify best testing sites task and follow the steps provided. 

 

Inventory testing sites 
Laboratory tests can identify the virus that causes COVID-19 in respiratory specimens. As a 

result, health and human services officials are establishing testing sites to track the spread of 

disease and ensure proper treatment and isolation for those infected. 

Coronavirus testing sites can be added to your inventory and shared with the public. The 
Testing Sites Locator app can be used to share status information with the public. 

In this workflow, you'll learn how to add a new coronavirus testing site in your community and 
share this information with the public. 

Add a testing site 
You will start by assuming the role of an emergency response mapping technician. You are 

asked to use the Testing Sites Manager to add a new test site that was recently opened in your 

community. 

1. Sign in to your ArcGIS organization, search for Testing Sites Manager, and open 
the app. 

2. Click Edit Testing Sites and place the location of a testing site on the map. 

  Tip: 

  If you already have a list of testing sites in a spreadsheet, you can use the Load Testing 
Sites widget to load the entire list of testing sites. 

3. Enter details about the testing site: 

  Parameter 
  Value 

  Name of Facility   Type South Stadium Parking Lot 

  Full Address   Type 123 Main Street 

  Phone   Type 555-555-5555 

  Website   Type https://website.com 

  Operational 
Hours 

  Type 8am - 5pm 
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  Comments   Type Appointment required 

  Instructions   Type Multiple lines available with drive-
through access 

  Status   Select Open 

4. Click Save and click Clear. 

5. Click an existing testing site to update the operational hours, status, and any other 
characteristics, and click Save. 

Locate a testing site 
Now, you will assume the role of a resident in the same community. You have coronavirus 

symptoms and want to locate the nearest testing site. 

1. In a browser, go to the Testing Sites Locator app. 

2. Type your address in the search box or click a location directly on the map. 

3. Optionally, adjust the buffer slider to see a larger list of potential testing sites. 

4. Select the closest testing site from the list and review the instructions provided. 

5. Click the Directions tab to view driving directions to the testing site from your 
defined location. 
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Coronavirus Vaccine Distribution Dashboard 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Coronavirus Vaccine Distribution 

Dashboard 
Coronavirus Vaccine Distribution Dashboard can be used to tabulate, visualize, and monitor key 

vaccine distribution metrics and trends that support a phased coronavirus disease 2019 

(COVID-19) vaccination plan. 

As communities begin to distribute vaccines, maintaining situational awareness is essential. 
Understanding how vaccine distribution and coverage metrics vary among target populations, 
and from one geography to another, helps decision makers develop strategic vaccine 
distribution plans. Coronavirus Vaccine Distribution Dashboard is typically implemented by 
health and human services agencies that want to visualize key vaccine distribution metrics over 
time and use the metrics to inform public education campaigns, make vaccine distribution 
decisions, adapt recommendations made to reach target populations, and ensure a successful 
vaccination program. 

The Coronavirus Vaccine Distribution Dashboard solution delivers a set of capabilities that help 
you to tabulate vaccine distribution metrics, monitor key trends and performance targets for 
defined geographies, and communicate progress to interested stakeholders. 

 

Requirements 
Coronavirus Vaccine Distribution Dashboard requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 Connect 

 

Information products 
Coronavirus Vaccine Distribution Dashboard includes the following information products: 

Item Description Minimum user type 

Vaccine 
Distribution 
Dashboard 

A responsive ArcGIS Experience Builder app used by 
health and human services staff to visualize and 
monitor key vaccine distribution metrics and trends 
that support a phased vaccination plan. 

Viewer (required for 
health and human 
services personnel 
only) 
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Vaccine 
Distribution 
Reporter 

An ArcGIS Dashboards app used by health and 
human services staff to tabulate vaccine distribution 
metrics. 

Editor 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Coronavirus Vaccine Distribution Dashboard 
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Configure Coronavirus Vaccine Distribution 

Dashboard 
 

Learn how to configure the Coronavirus Vaccine Distribution Dashboard solution to meet 

specific needs in your organization. 

 

Load vaccine distribution reporting areas 
The Coronavirus Vaccine Distribution Dashboard solution helps public health agencies visualize 

and share vaccine distribution metrics for a given set of reporting areas. The reporting areas 

can be a county, ZIP Code, state, municipality, or any other geographic area you are using to 

tabulate metrics. Once you identify the specific reporting area or areas you want to use, you can 

use the Vaccine Distribution Reporter to tabulate coronavirus disease 2019 (COVID-19) 

distribution metrics for the specific reporting area. 

The Reporting Areas layer includes several important fields. The Name field stores the names 
of the reporting area and is used in the Reporting Area Category Selector in the Vaccine 
Distribution Reporter app. Use the Aggregate Area field to report distribution metrics by 
differing jurisdictions. For example, a county may want to share distribution metrics tabulated by 
the entire county as well as broken down by ZIP Code or municipality. In that case, the county 
has a value of Yes for the Aggregate Area field. The Points of Distribution (POD) field is used 
to store the number of locations where the vaccine can be accessed per reporting area. This 
metric is shown on the Vaccine Distribution Dashboard. 

Reporting Areas also contains several population fields such as Total population and Healthcare 
workers population. These fields are used in the Vaccine Distribution Reporter app to calculate 
vaccine coverage rates. Populating each population field ensures vaccine coverage rates are 
calculated accurately in the Vaccine Distribution Reporter app and visualized properly in the 
Vaccine Distribution Dashboard. 

To learn about enriching your data with information, for example, demographic data, see About 
Data Enrichment. 

 

Load data from a shapefile or file geodatabase 
To load reporting areas from a shapefile or file geodatabase, complete the following steps: 

1. Create a .zip file of a shapefile or file geodatabase of your reporting areas. 

2. Sign in to your ArcGIS organization and browse to the VaccineDistribution feature 
layer. 

3. Open the item page and click Update Data > Append Data to layer. 

4. Click Choose File, browse to your .zip file, and click OK. 

5. Click the Contents drop-down arrow and choose the appropriate file type. 

6. Click Upload and Continue. 

7. Click the Choose the layer that you wish to append data into drop-down arrow 
and choose Reporting Areas. 
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8. Uncheck Update existing features. 

9. Click Show field matching to map the fields. 

10. Click Apply Updates. 

  Tip: 

  To make additional updates to a hosted feature layer, see Append data to layers. 

 

Load vaccine distribution metrics information 
Vaccine Distribution Dashboard can be used by public health agencies and other emergency 

response agencies to visualize and monitor COVID-19 vaccine distribution metrics. The solution 

includes a Vaccine Distribution Reporter app that you can use to enter updated vaccine 

distribution metrics at a regular interval. In some cases, you may find it easier to manage this 

information in a spreadsheet and load it into the solution as you receive new information. 

To load your vaccine distribution information from a spreadsheet, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
VaccineDistributionSource item. 

2. Open the item page and click Download. 

3. Edit the .csv file and provide your vaccine distribution metrics information. 

4. In your ArcGIS organization, browse to the VaccineDistribution feature layer. 

5. Open the item page and click Update Data > Append Data to layer . 

6. Click Choose File, browse to your .csv file, and click OK. 

7. Click Upload and Continue. 

8. Click the Choose the layer that you wish to append data into drop-down arrow 
and choose Metrics. 

9. Uncheck Update existing features. 

10. Click Apply Updates. 

  Tip: 

  To make additional updates to a hosted feature layer, see Append data to layers. 

 

Extend the Vaccine Distribution Reporter app 
The Vaccine Distribution Dashboard solution includes the Vaccine Distribution Reporter app that 

you can use to tabulate vaccine distribution information. 

Review the preconfigured questions and adjust as necessary to remain in compliance with your 
organizational policies. In addition, ensure that you secure the app and underlying layers and 
only share the content with appropriate members of your organization. 
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Update feature layer views 
The Coronavirus Vaccine Distribution Dashboard solution includes a series of views created 

from the VaccineDistribution feature layer provided with the solution. Organizations may want to 

modify the Vaccine Distribution Reporter app by first adding new fields to the feature layer and 

then configuring the Vaccine Distribution Form to use the newly created fields. When doing so, 

you must expose the new fields in the appropriate views. Additionally, the 

VaccineDistribution_current view is created by joining two sources together, and you must re-

create it with the same name and URL after a new field is added. 

Organizations may want to modify the Vaccine Distribution Form by adding new survey 
questions. When adding new questions, begin with the Update feature layer views steps below. 
For changes such as removing questions or formatting the survey, proceed to the Modify 
response surveys section. 

To add one or more fields to a layer and expose the field to feature layer views, complete the 
following steps: 

1. Verify that you are signed in to your ArcGIS organization. 

2. Add a new field to the Reporting Areas or Metrics layer in the VaccineDistribution 
hosted feature layer. 

3. Browse to the VaccineDistribution_public or VaccineDistribution_reporter views in 
your contents. 

4. Open the item page and click the Visualization tab. 

5. Click More Options and click Set View Definition > Define Fields. 

6. Check the check box next to the new field or fields. 

7. Click Apply. 

  The new field is added to the view’s definition. 

To update a join view, complete the following steps: 

1. Browse to the VaccineDistribution_current join view. 

2. Open the item page and scroll to the URL section. Click the Copy button. 

3. Paste the copied URL into Microsoft Notepad or another text editor for reference.  

  Note: 

  The feature layer name will be used below when re-creating the join. You can find the 
name after services in the URL structure. It may also contain a unique GUID—for 
example, VaccineDistribution_current_a45f71a48587425c9b90ee5527cd26d1. 

4. Browse to the existing VaccineDistribution_current join view. 

5. Open the item page and click the Settings tab. 

6. Click the Delete Item button and click Delete. 

7. Browse to the VaccineDistribution feature layer. 

8. Open the item page and click Open in Map Viewer. 

9. Click the Analysis button and click Summarize Data > Join Features. 

10. When populating the Join Features tool, do the following: 
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a. Click the Choose target layer drop-down arrow and choose 
VaccineDistribution. 

b. Click the Choose layer to join to the target layer drop-down arrow and 
choose VaccineDistribution-Metrics. 

c. Click Choose the fields to match as the type of join. 

d. Click the Target field drop down arrow and choose name, and click the 
Join field drop-down arrow and choose name. 

e. Click the Choose join operation drop-down arrow and choose Join one on 
one. 

f. Under the Define which record is kept drop-down arrow, click Order by, 
click the Field drop-down arrow and choose Date reported, and click the 
Sort by drop-down arrow and choose Newest. 

  Note: 

  Ensure the new join view uses the names defined in the table above. If you use 
the same name, the layers in the map and the existing dashboard elements do 
not have to be reconfigured. If your join view contained a unique GUID, you must 
name the new join view with the unique GUID. 

g. In the Result layer name text box, enter VaccineDistribution_current. 

h. Uncheck Use current map extent, if checked. 

i. Check Create results as hosted feature layer view check box. 

11. Update the Vaccine Distribution Desktop and Mobile Dashboards account for the 
new fields you added to the layers. 

 

Modify response surveys 
To modify the Vaccine Distribution Form survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Vaccine Distribution Form to download the survey. 

4. Click Vaccine Distribution Form again to open the survey. 

5. In the Download window, click Download and click OK. 

6. On the side toolbar, click the Open XLSForm Spreadsheet button. 

7. Revise the survey to reflect your needs. 

8. Save and close the Microsoft Excel spreadsheet and preview your changes in 
ArcGIS Survey123 Connect. 

9. In ArcGIS Survey123 Connect, click Publish on the side tool to publish your 
changes. 
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Configure vaccination goals 
The Vaccine Distribution Dashboard vaccination coverage charts contain preconfigured goals to 

visualize progress toward vaccination goals. Organizations may want to modify the goals to 

better reflect their community’s vaccination goals. 

To modify the vaccination goal, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Vaccine Distribution Desktop Dashboard or Vaccine Distribution Mobile Dashboard 
item. 

  The following steps can be used to configure vaccination goals in both the desktop and 
mobile dashboards. 

2. Open the item page and click Edit Dashboard. 

3. Hover over the upper left corner of the Vaccine Coverage by Total Population 
serial chart element and click Configure. 

4. Click the Guides tab. 

  The chart contains a preconfigured goal of 67%. 

5. Using a decimal value, change the Value to your community’s vaccination goal. For 
example, a goal of 70% would be .7. 

6. Change the Label to reflect the updated goal and click Done. 

7. Repeat steps 3 through 6 to modify the goal for the Full Series Coverage Priority 
Population, Full Series Coverage Age, Full Series Coverage Race & Ethnicity, and 
Full Series Coverage Gender serial chart elements. 

8. Click the Save button to save the dashboard. 

 

Add vaccination coverage categories 
The Vaccine Distribution Dashboard solution helps public health agencies and interested 

stakeholders visualize full series vaccination coverage by priority population, age, race & 

ethnicity, and gender. Agencies may want to modify or extend the values within those 

categories. For example, data may be reported using different age ranges than those 

preconfigured. The VaccineDistribution hosted feature layer contains several custom fields that 

provide configuration flexibility. 

The Reporting Areas layer contains two Custom priority population fields, Custom gender 
population, Custom age range population, and Custom race population fields. The Metrics layer 
contains two associated Custom priority population fields, Custom gender population, Custom 
age range population, and Custom race population fields. Additionally, the Metrics layer 
contains two Custom priority vaccinated coverage fields, Custom gender vaccination coverage, 
Custom age range vaccination coverage, and Custom race vaccination coverage fields that can 
be used to store coverage rates for additional categories. 

To utilize a custom field, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
VaccineDistribution hosted feature layer. 
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2. Open the item page and click the Data tab. If necessary, choose Reporting Areas 
from the Layer drop-down arrow. 

3. Click the Fields button. 

4. Locate and click the Custom priority population field. 

  In the following steps, the priority1pop and associated fields are used as an example. The 
same process can be followed to use any of the included custom fields. 

5. Click Edit to replace Custom priority population’s alias with an alias of your 
choosing. For example, First Responder population. 

6. Click Save. 

7. Click the Layer drop-down arrow and choose Metrics. 

  Locate the associated fields, in this case, priority1 and priority1coverage. 

8. Click each field and modify the alias. For example, priority1 would be First 
Responders vaccinated and priority1coverage would be First Responders (this 
alias will be used below in the Vaccine Distribution Dashboard serial chart). 

  In this example, be sure to populate the priority1pop field in the Reporting Areas layer. 
These fields are used in the Vaccine Distribution Reporter app to calculate vaccine 
coverage rates. Populating each population field ensures vaccine coverage rates are 
calculated accurately in the Vaccine Distribution Reporter app and visualized properly in 
the Vaccine Distribution Dashboard. 

9. Repeat steps 5 and 6 for each set of custom fields you want to use in the Vaccine 
Distribution Dashboard. 

To modify the Vaccine Distribution Reporter app to use the custom fields configured above, 

complete the following steps: 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Vaccine Distribution Form to open the survey. 

3. On the side toolbar, click Open XLSForm Spreadsheet. 

4. In the name column, locate the priority1 field. In the type column, click the drop-
down arrow to change the type from hidden to integer. 

5. Update the label to use the field alias defined in the section above. 

6. Repeat step 5 for each custom field you want to use in the Vaccine Distribution 
Dashboard. 

7. Save and close the Microsoft Excel spreadsheet and preview your changes in 
ArcGIS Survey123 Connect. 

8. In ArcGIS Survey123 Connect, click Publish on the side toolbar to publish your 
changes. 

To modify the Vaccine Distribution Dashboard to use the custom fields configured above, 

complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Vaccine Distribution Desktop Dashboard or Vaccine Distribution Mobile item. 

  The following steps can be used to configure both the Desktop and Mobile dashboards. 

2. Open the item page and click Edit Dashboard. 
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3. Hover over the upper left corner of the Full Series Coverage by Priority 
Population serial chart element and click the Configure button. 

4. If necessary, click the Data tab. 

5. Click the +Series button, and click the Series 6 Field drop-down arrow and choose 
the First Responders decimal field configured above. 

6. Click the Series tab. Modify the newly created series to match the existing series 
and according to your needs. 

7. Click Done. 

8. Repeat steps 3 through 7 for additional custom fields configured above to use them 
in the Full Series Coverage by Priority Population, Full Series Coverage by Age, 
Full Series Coverage by Race & Ethnicity, and Full Series Coverage by Gender 
serial charts. 

9. Click the Save button to save the dashboard. 
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Use Coronavirus Vaccine Distribution 

Dashboard 
 

The Coronavirus Vaccine Distribution Dashboard solution delivers a set of capabilities that help 

you to tabulate vaccine distribution metrics, monitor key trends and performance targets for 

defined geographies, and communicate progress to interested stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Tabulate vaccine distribution metrics 
The Coronavirus Vaccine Distribution Dashboard solution helps health and human services 

agencies visualize key vaccine distribution metrics over time. The dashboard displays the most 

recent reported totals of doses obtained and administered to the public. It also displays the 

coverage, or percentage of the population that has been vaccinated, broken down by priority 

populations, age, race, and gender over time. 

You will start by assuming the role of an employee in a health and human services agency who 
has been tasked with reporting the latest vaccine distribution metrics each week. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Coronavirus Vaccine Distribution Dashboard solution. 

2. View the Vaccine Distribution Reporter app. 

3. Click the Reporting Area drop-down menu in the upper right and choose the 
appropriate reporting area. 

  Reporting areas can be a county, public health region, ZIP Code, state, municipality, or any 
other geographic area you are using to tabulate results. 

4. Provide the cumulative total of vaccine doses that have been obtained and 
administered to the public. 

5. Provide the total number of people who have received a partial and full series 
vaccination. 

  As some vaccines require multiple doses, a partial series vaccination would include people 
who have, for example, received the first dose of a two-dose series. 

6. If available, provide the total number of people who have received a full series 
vaccination by priority populations, gender, age range, and race and ethnicity. 

  The coverage or percent of the population that has been vaccinated will be calculated for 
you if you updated the corresponding population field in the Reporting Areas layer. See 
Configure Coronavirus Vaccine Distribution Dashboard for more information on populating 
your reporting areas. 
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7. Click Submit. 

8. Repeat this process for each additional reporting area. 

 

Monitor vaccine distribution performance 
Now, you will assume the role of a public health officer or executive in the same government 

agency. You are asked to monitor the current status of vaccine distribution in the community 

and are looking to see how the vaccine is being distributed across demographic segments of 

the population. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Coronavirus Vaccine Distribution Dashboard solution. 

2. View the Vaccine Distribution Dashboard app. 

  The dashboard displays the most recent count of doses obtained and administered and 
partial and full series vaccination coverage for the selected reporting area. It also contains 
several time series charts that display vaccination coverage over time for different 
demographic segments. 

3. In the filter on the top of the dashboard, click another reporting area to view the 
vaccine distribution metrics for a different geography. 

4. Click the Learn More tab in the Map panel to read the descriptions of the different 
metrics, how they are calculated, and to view when the metrics were last updated. 

5. Click the Priority Population, Age, Race & Ethnicity, and Gender tabs to view 
full series vaccination coverage over time for each demographic segment. 
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Crime Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Crime Analysis 
Crime Analysis can be used to enhance public safety, identify emerging trends, organize law 

enforcement operations and plan crime-prevention strategies. 

It improves productivity of crime analysts with specialized tools and a tailored desktop GIS 
interface for mapping data and performing spatial analysis, making it easier to quickly generate 
high-quality crime analysis map products. Improved crime analyst productivity helps law 
enforcement decision-makers optimize resource allocation, solve cases, and implement more 
effective crime reduction strategies. Crime Analysis is typically implemented by law enforcement 
agencies that want to use data-driven strategies to reduce crime and improve police operations. 

The Crime Analysis solution delivers a set of capabilities to help you manage incident data, 
conduct tactical and strategic analysis, perform investigative analysis and share web-based or 
hardcopy information products with decision-makers. 

 

Requirements 
Crime Analysis requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.7 - 2.9 (Basic, Standard, or Advanced) 

• ArcGIS Spatial Analyst (optional) 

 

Information products 
Crime Analysis includes the following information products: 

Item Description 
Minimum User 
Type 

CrimeAnalysis.esriAddInX An ArcGIS Pro add-in used to map, identify, 
and communicate geospatial patterns in law 
enforcement data. 

ArcGIS Desktop 
Basic or GIS 
Professional Basic 

CrimeAnalysisSolution An ArcGIS Pro project that leverages the 
capabilities included in the Crime Analysis 
add-in to generate a standard set of crime 
maps. 

ArcGIS Desktop 
Basic or GIS 
Professional Basic 
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When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

2.0 • A new Crime Analysis Add-In (2020.12.17) that includes a new ribbon 
design and analysis gallery. 

• A series of new capabilities have been added: Add Graphics Layer, 
Colocation Analysis tool, Density-based Clustering tool, Link Charts, and 
Reports. 

• Existing tools have been updated to simplify parameters, streamline 
licensing and increase performance. In some cases, tool names have 
also been changed. See Crime Analysis tool updates for more details. 

1.0 • Crime Analysis is now available in the ArcGIS Solutions app. 
• The Crime Analysis Add-In (2019.10.16). 
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Configure Crime Analysis 
The Crime Analysis solution can be deployed in your ArcGIS organization. After deploying the 

solution to your organizational portal, download, install and configure it to meet the needs in 

your organization. 

 

Download and install Crime Analysis solution 
The Crime Analysis solution includes the Crime Analysis Add-In, ArcGIS Pro project, sample 

data and maps you can use to explore common crime analysis workflows. Before you begin, 

you will need to download the CrimeAnalysis.zip file containing the ArcGIS Pro project and 

Crime Analysis add-in. After this file is downloaded to your computer and extracted, you can 

install the add-in and open the ArcGIS Pro project. 

If you are upgrading from a previous version (2018.6.26 through 2019.10.16) of the Crime 
Analysis Add-In, then skip to the Upgrade Crime Analysis Add-In (optional) section. If you 
are using it for the first time, follow the steps below to download and install the Crime Analysis 
solution. 

1. Sign in to your ArcGIS organization and click Content at the top of the website. 

  Note: 

  If you downloaded the solution directly then skip step 4. 

2. Click My Content tab, and then click on CrimeAnalysis.zip to open the item page. 

3. Click the Download button and browse to a folder on your computer. 

4. Extract CrimeAnalysis.zip. 

5. Browse to the CrimeAnalysis folder where you extracted the CrimAnalysis.zip file. 

6. Double-click CrimeAnalysis.esriAddInX to run the installer. 

7. Click the Install Add-In button. 

 

Upgrade Crime Analysis add-In (optional) 
The current version of the Crime Analysis add-in includes significant updates from versions 

2018.6.26 through 2019.10.16. If you are migrating from one of these versions, you will need to 

get familiar with the Crime Analysis ArcGIS Pro project and the Crime Analysis Add-In. See the 

Migration workflows from previous version section below to understand these changes prior 

to installing the new version. 

Note: When you upgrade, the previous version of the add-in and tools will be removed. You will 
need to update any automated scripts or documented workflows. You can install the new 
version of the Crime Analysis Add-In on another computer to limit the impact to your daily work 
while you are updating any automated scripts or workflows. Learn more about how to remove 
your add-in here. 
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Confirm your current version 
Before you upgrade to Crime Analysis version 2020.12.17 or later you will need to confirm the 

version you have currently installed. 

To verify the version currently installed use the following steps: 

1. Open any ArcGIS Pro project and click the Project tab on the ribbon. Alternatively, 
on the ArcGIS Pro start page, click Settings in the lower left corner. 

2. Click Add-In Manager then click on Crime Analysis. 

3. In the Add-Ins tab of the Add-In Manager. The Add-Ins tab will provide the version 
information. 

  If your version is 2018.6.26 through 2019.10.16 then you will also need to consider 
migrating your scripts and workflows using the Migrate workflows from previous version 
section. 

   

Install new Crime Analysis add-in 
To upgrade from a previous version of the Crime Analysis add-in that is installed on your 

computer, you will need to follow the steps below to overwrite the installed add-in with the new 

add-in. 

1. Close all ArcGIS Pro applications. 

2. Browse to the CrimeAnalysis folder 

3. Double-click CrimeAnalysis.esriAddInX to run the installer. 

4. Click the Install Add-In button. 

5. Open ArcGIS Pro. 

 

Migrate workflows from previous version 
Crime Analysis add-in (2020.12.17) has a significant number of updates. Specifically, several 

geoprocessing tools have been replaced, new tools have been added, and the solution user 

interface has changed. Review the changes below before migrating your workflows from a 

previous version. 

 

User interface updates 
The Crime Analysis ribbon now uses the analysis tool gallery interface design to organize all 

analytical geoprocessing tools in the solution. Within the gallery area, the tools retain their 

groupings (for example, tactical and strategic analysis) from previous version of the solution. 

The new ribbon design allows more space-efficient presentation of additional analytical tools on 

the Crime Analysis solution ribbon. 

 

Geoprocessing tool updates 
Many of the customized geoprocessing tools originally deployed with Crime Analysis solution 

have been updated to use system tools that are installed with ArcGIS Pro.  These tools can now 
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be found in the Crime Analysis and Safety toolbox in the geoprocessing pane, and are available 

to all users of ArcGIS Pro. As part of that process, the names and functions of tools have 

changed slightly to conform to ArcGIS Pro standards. In addition, several new system tools that 

are relevant to crime analysis workflows have been added to the solution. 

 

Crime Analysis tool updates 
The chart below outlines the names of the original tools available with the Crime Analysis add-in 

version 2018.6.26 through 2019.10.16, that have been migrated to new tools in version 

2020.12.17, and available in the updated Crime Analysis add-in. 

Old Tool New Tool  New Tool Changes 

80-20 Analysis 80-20 Analysis (Crime 
Analysis and Safety toolbox) 

Labeling is no longer applied by 
default. 

The parameter minimum cluster size 
is no longer configurable. 

The parameter attributes to preserve 
is replaced by output fields in the new 
tool. 

Extract Date Parts to 
Field 

Add Date Attributes (Crime 
Analysis and Safety toolbox) 

Updated and simplified parameters. 

Import Cell Records Cell Phone Records to 
Feature Class (Crime Analysis 
and Safety toolbox) 

Updated and simplified parameters. 

Import Cell Sites Cell Site Records to Feature 
Class (Crime Analysis and 
Safety toolbox) 

Updated and simplified parameters. 

Features To 3D By 
Time 

Feature to 3D By Time (Crime 
Analysis and Safety toolbox) 

The tool licensing requires ArcGIS 
Desktop Basic, Standard, or 
Advanced license. The 3D Analyst 
licensing has been removed. 

Space Time 
Comparison 

Find Space Time Matches 
(Crime Analysis and Safety 
toolbox) 

Labeling is no longer applied by 
default. 

Updated and simplified parameters. 

Repeat Call Patterns Generate Call Links (Crime 
Analysis and Safety toolbox) 

Labeling is no longer applied by 
default. 

Updated and simplified parameters. 

Incident Path Generate Origin Destination 
Link (Analysis toolbox) 

Updated and simplified parameters. 

Different default symbology. 
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Descriptive Statistics Charts are 
automatically created. 

Generate Sector Lines Generate Sector Links (Crime 
Analysis and Safety toolbox) 

Updated parameter names. 

Append Attributes 
From Polygon 

Join Attributes from a Polygon 
(Crime Analysis and Safety 
toolbox) 

Updated and simplified parameters. 

The overwrite matching fields in 
Target Point Features parameter is 
no longer available. 

Density Change Minus (Spatial Analyst 
Toolbox) 

The Minus tool is part of the Spatial 
Analyst toolbox requires a Spatial 
Analyst license and applies a 
different default symbology. 

Incident Sequence Points to Track 
Segments (Intelligence 
Toolbox) 

Updated and simplified parameters. 

Output features are time enabled by 
default. 

Sequence points are no longer 
created default. Output sequence 
points location is an optional 
parameter. 

The Grouping Field parameter has 
been renamed to Group Field. 

Select by Date and 
Time 

Select Layer by Date and 
Time (Crime Analysis and 
Safety toolbox) 

Updated and simplified parameters. 

Incident Count Summarize Incident Count 
(Crime Analysis and Safety 
toolbox) 

Added support for point in the Input 
Features parameter 

Labeling is no longer applied by 
default. 

The Category Field parameter has 
been renamed to Group Field and 
now requires an ArcGIS Desktop 
Basic license. 

The tool licensing requires ArcGIS 
Desktop Basic, Standard, or 
Advanced license. Parameter specific 
licensing has been removed. 

Percent Change Summarize Percent Change 
(Crime Analysis and Safety 
toolbox) 

Added support for point features in 
the Input Features parameter. 
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Labeling is no longer applied by 
default. 

The tool licensing requires ArcGIS 
Desktop Basic, Standard, or 
Advanced license. Parameter specific 
licensing has been removed. 

Configure Record 
Import (Addresses), 
Configure Record 
Import (XY), Import 
Records 

Update Features With Incident 
Records (Crime Analysis and 
Safety toolbox) 

The Update Features With Incident 
Records includes all of the 
functionality of the Configure Record 
Import (Addresses), Configure 
Record Import (XY), and Import 
Records tools. 

Note: The Export Near Repeat Calculator Table tool, Repeat and Near Repeat Classification 
tool, and Calculate Prediction Zones tool have not changed and are installed as part of the 
Crime Analysis add-in and have not been migrated into ArcGIS Pro. 

 

Automate Geoprocessing Tools (optional) 
All geoprocessing tools can be scheduled to run automatically on your computer using the 

scheduling capabilities in ArcGIS Pro or Windows Task Scheduler. Scheduling frequently run 

tools can improve productivity by reducing manual steps the analyst has to take during their 

daily work or in creating routine products. For example, by scheduling the Update Features With 

Incident Records tool to run nightly, their main datasets can get geocoded and updated into a 

web layer overnight, so the analyst has fresh data ready to use when they arrive in to work. 

Likewise, for analysts preparing monthly Compstat reports, Kernel Density or other hotspot tools 

can be automated to run on a monthly schedule to simplify the process of preparing the 

Compstat report. 

 

Disable the Crime Analysis ribbon 
The Crime Analysis ribbon is automatically added to your projects when you install the Crime 

Analysis add-in. To disable the Crime Analysis ribbon, follow these steps. 

1. From an open project, click the Project tab on the ribbon. Alternatively, on the 
ArcGIS Pro start page, click Settings in the lower left corner. 

2. Click Options then click on Crime Analysis. 

3. Disable the Show Crime Analysis tab, click OK and the back arrow. 

When the Crime Analysis ribbon is disabled it will no longer appear in ArcGIS Pro, but the tools 

will appear contextually in various locations throughout the ArcGIS Pro user interface. For 

example, on the Analysis ribbon, users will see a Crime Analysis button listing all the solution 

tools. 

Note: 
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Learn more about how to remove an add-in. 

 

Use Crime Analysis 
The Crime Analysis solution delivers a set of capabilities to help you manage incident data, 

conduct tactical and strategic analysis, perform investigative analysis and share web-based or 

hardcopy information products with decision-makers. 

In this topic, you’ll learn how to use the Crime Analysis solution by exploring the Crime Analysis 
ArcGIS Pro project and key crime analysis workflows it supports. 

The Getting started with Crime Analysis learn path includes a series of complementary web 
courses that can be used to learn how to use the  Crime Analysis solution. 

 

Review the Crime Analysis project 
Crime Analysis includes an ArcGIS Pro project with the Crime Analysis add-In. The project 

includes the Crime Analysis tab and ribbon that can be used to conduct a series of key 

analytical functions to support crime analysis. Before using the Crime Analysis tools with your 

data, familiarize yourself with the contents of the Crime Analysis project. 

1. Browse to the CrimeAnalysis folder and open the CrimeAnalysisSolution.aprx 
ArcGIS Pro project. 

2. On the ribbon, click the Crime Analysis tab. You will see the ribbon includes five 
groups of tools: Data Management, Selection, Analysis Tools and Information 
Products. 

3. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

4. In the Catalog pane, expand Maps and review the sample maps and notes 
provided. 

 

Manage incident data 
To perform analysis, crime analysts must first import data from disparate record systems and 

prepare it for use in GIS. Data import and management activities like geocoding, date field 

transformations, and appending of spatial data must be performed daily. These time consuming 

but necessary activities leave little time for actual analysis, limiting analyst productivity. Crime 

Analysis provides tools to help analysts automate data import and simplify common data 

management activities. 

To learn more about managing data using Crime Analysis, go to the CrimeAnalysisSolution 
ArcGIS Pro project and open the following maps: 

•  Enhance Attributes map 

• Import Incidents (Update Features With Incident Records) 
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Focus on specific incidents 
Crime analysts ask a wide variety of analytical questions on behalf of the organizations they 

support, requiring them to query their data from a variety of date-based, spatial, and field 

attribute perspectives that can be challenging to perform without the use of GIS. Crime Analysis 

provides selection tools that can be used individually or in tandem to interrogate incident data 

and focus on specific problem subsets. 

To learn more about performing selections using Crime Analysis, go to the 
CrimeAnalysisSolution ArcGIS Pro project and open the following maps: 

• Summarize Percent Change and Select Layer by Date and Time 

• Kernel Density and Minus 

 

Conduct tactical and strategic analysis 
Crime analysts support the data-driven crime reduction efforts of law enforcement agencies by 

using tactical analysis methods to identify short-term crime patterns, and strategic analysis 

methods to support the identification and evaluation of long-term crime problems and trends. 

Central to these methods are spatial analysis, specifically hotspot identification, but analysts can 

be challenged with understanding which techniques are available and are appropriate to the 

type of analysis they are trying to perform. Crime Analysis curates new and traditional spatial 

analysis tools appropriate for tactical and strategic crime analysis, making it easy for analysts to 

discover the right tool for the job. 

To learn more about conducting tactical and strategic analysis using Crime Analysis, go to the 
CrimeAnalysisSolution ArcGIS Pro project and open the following maps: 

• 80-20 Analysis 

• Colocation Analysis 

• Density-based Clustering 

• Kernel Density and Minus 

• Optimized Hotspot and Calendar Heat Chart 

• Summarize Incident Count 

• Summarize Percent Change and Select Layer by Date and Time 

•  RNR-Calculate Prediction Zones 

• RNR-Export Near Repeat Calculator Table 

• RNR-Repeat and Near Repeat Classification 2D 

• RNR-Repeat and Near Repeat Classification 3D 

 

Perform investigative analysis 
Crime analysts support investigations by using data to explore the relationships between 

people, events, and locations. Investigative analysis helps investigators uncover criminal 

networks and understand suspect activity patterns through analysis of cell phone records, 

financial transactions, and other investigative data sources. These forms of analysis have 

previously required specialized, expensive, single-purpose software programs. Crime Analysis 

provides a set of analytical tools to support common investigative workflows such as cell phone 
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analysis, financial analysis, temporal sequencing of GPS or incident data, and visualizing spatial 

relationships such as between locations of motor vehicle thefts with where those vehicles are 

recovered. 

To learn more about performing investigative analysis using Crime Analysis, go to the 
CrimeAnalysisSolution ArcGIS Pro project and open the following maps: 

• CPA-2D Cell Phone Points to Track Segments 

• CPA-3D Cell Phone Points to Track Segments 

• CPA-Cell Site Records to Feature Class 

• CPA-Cell Phone Records to Feature Class 

• CPA-Dissolve 

• CPA-Find Space Time Matches 

• CPA- Generate Call Links 

• CPA-Generate Sector Lines 

• Origin Destination Links (MV Theft to Recovery) 

• Origin Destination Links (Financial Crime) 

• Origin Destination Links and Link Chart (Gang Turf to Member Homes) 

• Points to Track Segments 

 

Share maps and reports 
To share their work with stakeholders and decision makers, crime analysts prepare information 

products summarizing their results. Analysts get requests to deliver these products in both 

hardcopy and interactive forms. To support the needs of their customers, analysts need flexible 

options to deliver the results of their analysis in a wide array of forms. Crime Analysis provides a 

set of information product options include hardcopy map layouts, a rich charting library, tabular 

reports, link analysis charts, and the ability to publish layers and maps into web mapping 

applications in ArcGIS Enterprise or ArcGIS Online. 

To learn more about sharing maps and reports using Crime Analysis, go to the 
CrimeAnalysisSolution ArcGIS Pro project and open the following maps: 

• Optimized Hotspot and Calendar Heat Chart 

• Origin Destination Links and Link Chart (Gang Turf to Member Homes) 

 

Crime Analysis Tool Reference 
The Crime Analysis solution delivers a set of capabilities to help you manage and query incident 

data, conduct tactical, strategic, and investigative analysis, and share web-based and hardcopy 

information products with decision-makers. 

In this topic, you’ll learn how to use the Crime Analysis solution by exploring the Crime Analysis 
navigating the Crime Analysis Add-In, and reviewing the Repeat and Near Repeat tools. 
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Crime Analysis tools 
The Crime Analysis Solution contains many tools to support key analytical functions to manage 

data, select crime incidents, conduct tactical and strategic analysis, investigate crime patterns 

and share information with other law enforcement personnel. These tools are accessed using 

the Crime Analysis tab and ribbon which is automatically added to your projects when you install 

the Crime Analysis add-in. The following sections contain a list of the tool groups in the ribbon 

with details for each tool in chronological order according to a typical crime analysis process. 

Note: You will need to ensure the Crime Analysis add-in is installed before you can review the 
Crime Analysis tools. See Configure Crime Analysis for more information. 

 

Data Management tools 
Crime Analysts can import data from disparate record systems in order to perform spatial 

analysis using ArcGIS Pro. In many cases, the data must also be geocoded and prepared for 

analysis by appending information about police operational boundaries, transforming date 

values, or other transformation functions. The Data Management group includes a series of 

tools that can be used for manual or automatic data import, geocoding, and enhancing of data 

for use in crime mapping and spatial analysis. 

The following tools and commands are included in the Data Management group of the Crime 
Analysis ribbon. 

Name  Description  

Add Data An ArcGIS Pro menu command that references data management tools that 
adds data to the map. 

Add Graphics 
Layer 

An ArcGIS Pro menu command that provides a way to include simple 
notations on a map or layout that highlight particular areas or label places. 

Import Records An ArcGIS Pro Crime Analysis and Safety toolbox that converts a nonspatial 
table to point features based on x,y-coordinates or street addresses and 
updates an existing dataset with the new or updated record information from 
the table. 

Convert Time 
Field 

An ArcGIS Pro Data Management tool that converts time values stored in a 
string or numeric field to a date field. 

Feature To 3D 
By Time 

An ArcGIS Pro Crime Analysis and Safety toolbox that creates a 3D feature 
class using date values from input features. 

Convert 
Coordinate 
Notation 

An ArcGIS Pro Data Management tool that converts coordinate notations 
contained on one or two fields from one notation format to another. 

Add Date 
Attributes 

An ArcGIS Pro Crime Analysis and Safety toolbox that adds fields containing 
date or time properties from an input date field, for example, day full name, 
day of the month, month, and year. 

Join Attributes 
From Polygon 

An ArcGIS Pro Crime Analysis and Safety toolbox that joins attributes from 
input polygon features to input point features. 
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Enrich An ArcGIS Pro Analysis tool that enriches data by adding demographic and 
landscape facts about the people and places that surround or are inside data 
locations. 

 

Selection 
Before applying spatial analysis methods, crime analysts use queries to select subsets of data 

related to their topic of analysis. The Selection group in the ribbon includes a series of tools to 

perform spatial, temporal, or location-based queries of your data. 

The following tools and commands are included in the Selection group of the Crime Analysis 
ribbon. 

Name  Description  

Explore An ArcGIS Pro command that allows you to explore maps and scenes, you 
can zoom in and out, move around, and in the case of scenes, move up, 
down, and look around. 

Select An ArcGIS Pro commands that provide interactive feature selection involves 
clicking a single feature in the view or digitizing a shape to select a set of 
features. 

Select By 
Attributes 

An ArcGIS Pro Data Management tool that adds, updates, or removes a 
selection on a layer or table view based on an attribute query. 

Select By 
Location 

An ArcGIS Pro Data Management tool that selects features in a layer based 
on a spatial relationship to features in another dataset. 

Select Layer By 
Date and Time 

An ArcGIS Pro Crime Analysis and Safety toolbox used to select records 
based on date and time ranges or date properties, for example, single date, 
time range, time period, days of the week, month, or year. 

Attributes An ArcGIS Pro command that displays the Attribute pane. 

Clear An ArcGIS Pro command that clears the current selection in the active map. 

Layer From 
Selection 

An ArcGIS Pro command that creates on new layer based on a selected set 
of features in an existing layer. 

 

Analysis Tools 
Crime Analysts perform many types of analyses to support the needs of law enforcement 

decision-makers in their organization. The Analysis Tools group includes a gallery of tools that 

can be used to perform a variety of hotspot detection techniques and other spatial methods that 

can be applied as part of tactical or strategic crime analysis projects. The gallery also includes 

tools to apply spatial methods in support of investigations, like cell phone analysis, crime series 

sequencing, or motor vehicle theft to recovery linking. 

The following tools and commands are included in the Analysis Tools group of the Crime 
Analysis ribbon. 

Name  Description  
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Summary 
Statistics 

An ArcGIS Pro Analysis tool that calculates summary statistics for field(s) 
in a table. 

Buffer An ArcGIS Pro Analysis tool that creates buffer polygons around input 
features to a specified distance. 

80-20 Analysis An ArcGIS Pro Crime Analysis and Safety toolbox used to conduct an 
80/20 analysis of features and determines cluster locations by creating a 
graduated symbol layer based on the number of incidents occurring at 
each location. 

Summarize 
Incident Count 

An ArcGIS Pro Crime Analysis and Safety toolbox used to create a feature 
class with coincident point counts. Coincident point counts for line and 
point features are determined by a specified maximum distance. Point 
counts for polygon features are determine by whether point features or 
portions of features overlap with the polygon feature. 

Summarize 
Percent Change 

An ArcGIS Pro Crime Analysis and Safety toolbox used to calculate the 
percent change for features that correspond with point features 
representing two equal comparison time periods. 

Optimized 
Hotspot 

An ArcGIS Pro Spatial Statistics tool that creates a map of statistically 
significant hot and cold spots using the Getis-Ord Gi* statistic. 

Kernel Density An ArcGIS Pro Spatial Analyst tool that calculates a magnitude-per-unit 
area from point or polyline features using a kernel function to fit a smoothly 
tapered surface to each point or polyline. This tool requires a Spatial 
Analyst license. 

Minus An ArcGIS Pro Spatial Analyst tool that subtracts the value of the second 
input raster from the value of the first input raster on a cell-by-cell basis. 

Create Space 
Time Cube 

An ArcGIS Pro Space Time Pattern Mining tool that summarizes a set of 
points into a netCDF data structure by aggregating them into space-time 
bins. 

Emerging Hot 
Spot 

An ArcGIS Pro Space Time Pattern Mining tool that identifies trends in the 
clustering of point densities. 

Colocation 
Analysis 

An ArcGIS Pro Spatial Statistics tool that measures local patterns of spatial 
association, or colocation, between two categories of point features using 
the colocation quotient statistic. 

Density-based 
Clustering 

An ArcGIS Pro Spatial Statistics tool that finds clusters of point features 
within surrounding noise based on their spatial distribution. 

Points To Tracks 
Segments 

An ArcGIS Pro Spatial Statistics tool that converts a series of output paths 
from time-enabled sequences of input point data, such as GPS points. 

Generate Origin-
Destination Links 

An ArcGIS Pro Spatial Statistics tool that generates connecting lines from 
origin features to destination features. This is often referred to as a spider 
diagram. 

Cell Site Records 
to Feature Class 

An ArcGIS Pro Crime Analysis and safety tool used to creates cell site 
points and sector polygons based on input latitude, longitude, azimuth, 
beamwidth, and radius information from a cell site table. 
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Cell Phone 
Records to 
Feature Class 

An ArcGIS Pro Crime Analysis and Safety toolbox used to imports cell 
phone records from wireless network providers and associates those 
records with a cell site and sector feature classes as generated by the Cell 
Site Records To Feature Class tool based on identifier fields. 

Generate Call 
Links 

An ArcGIS Pro Crime Analysis and Safety toolbox used to creates line 
features that represent the call links between phones, using cell site points 
or cell site antenna sectors, based on the start date and time of the call. 

Find Space Time 
Matches 

An ArcGIS Pro Crime Analysis and Safety toolbox that identifies matches 
between two feature classes based on proximity, time extent, or both. 

Generate Sector 
Lines 

An ArcGIS Pro Crime Analysis and Safety toolbox used to create line 
features that represent the extent of cell site antenna sectors. 

Dissolve An ArcGIS Pro Data Management tool aggregates features based on 
specified attributes. 

Export Near 
Repeat Calculator 
Table 

A Repeat and Near Repeat tool that creates a CSV file in the format 
required by the Near Repeat Calculator from an input feature class. The 
Near Repeat Calculator is a tool published by Temple University for 
examining the statistical significance of repeat and near repeat patterns in 
a dataset. 

Repeat and Near 
Repeat 
Classification 

A Repeat and Near Repeat tool that identify areas at risk of repeat and 
near repeat incidents by specifying the spatial and temporal range of 
influence of past incidents. 

Calculate 
Prediction Zones 

A Repeat and Near Repeat tool that identify areas at risk of repeat and 
near repeat incidents by specifying the spatial and temporal range of 
influence of past incidents. 

 

Information Products  
After the analysis is complete, Crime Analysts often prepare hard copy maps and web-based 

information products to help their organizations make data-driven decisions. The Information 

Products group includes a series of tools to create information products for analysis consumers, 

including link charts, hard-copy maps, charts, and reports, and publishing of maps and layers to 

organizational web GIS portals. 

The following tools and commands are included in the Information Products group of the Crime 
Analysis ribbon. 

Name  Description  

Create 
Chart 

An ArcGIS Pro command that creates a chart to visualize categories, distribution, 
change and relationships in your data. 

New Link 
Chart  

An ArcGIS Pro command used to generate a link chart to visualize relationships 
between entities in your data and is a complementary view to the map. 

New 
Report  

An ArcGIS Pro command used to generate a report to share a well-formatted, 
multipage representation of your data. A report can contain a tabular list of 
attributes, summary information, or both. 
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New 
Layout 

An ArcGIS Pro command that creates a new layout and add it to the project. 

Web Map An ArcGIS Pro command used to share the active map as a web map to your 
organization. 

Web 
Layer 

An ArcGIS Pro command used to share all data layers in the active map as a new 
web layer to your organization. 

 

Repeat and Near Repeat Analysis Tools 
Repeat Victimization is an empirically observed phenomenon where when a location becomes 

the victim of a specific type of crime, that location has an elevated risk of subsequent 

victimization, a risk which drops precipitously over time. A corollary phenomena is known as 

Near-Repeat Victimization, whereby locations immediately around a location that has been 

victimized are at elevated risk, a level that drops both as time passes, and as the distance from 

the originating victim increases. Repeat and Near Repeat patterns have been observed across 

a wide variety of crime types, are believed to be spatial artifacts of serial offending behaviors, 

and thus have important implications for crime prevention and investigations. 

The Crime Analysis solution includes three custom geoprocessing tools to support analyses 
relative to Repeat and Near Repeat Victimization patterns. The Export Near Repeat Calculator 
Table tool can be used with Temple University’s Near Repeat Calculator to identify statistically 
significant patterns of Repeat and Near Repeat Victimization. The Near Repeat Classification 
tool can be used to identify historical patterns of repeat and near-repeat victimization, which can 
support investigative efforts to connect and clear cases that were not otherwise known to be 
part of a pattern. The Calculate Prediction Zones tool can be used to generate daily tactical 
crime risk predictions based on Repeat Victimization and Near-Repeat Victimization risk for 
recent crime locations. These risk predictions can be used to inform police operational 
strategies for crime reduction. 

The tools in the Crime Analysis solution related to Repeat and Near Repeat Victimization 
(Export Near Repeat Calculator Table, Repeat and Near Repeat Classification, and Calculate 
Prediction Zones) were developed in cooperation with Spencer Chainey, Ph.D., Associate 
Professor in Security and Crime Science at the Jill Dando Institute of Security and Crime 
Science, University College London. 

 

Export Near Repeat Calculator Table Tool 
The Near Repeat Calculator is a tool published by Temple University for examining the 

statistical significance of repeat and near repeat patterns in a dataset. When a statistically 

significant repeat or near repeat pattern is found, the spatial and temporal bandwidths of the 

pattern can then be used as parameters for analyses involving the Repeat and Near Repeat 

Classification Tool and the Calculate Prediction Zones tool. of This tool creates a comma-

separated values (CSV) file in the format required by the Near Repeat Calculator from an input 

feature class. 
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Usage 

• Input features must have a date field. 

• The output comma-separated values (CSV) file does not contain any field headers 
as these are not supported by the Near Repeat Calculator. The output fields are, in 
order: X, Y, Date. 

 

Syntax 

ExportNearRepeatCalculatorTable_crime (Input_Feature_Class, Output_Table, Date_Field) 

Parameter  Explanation 
Data 
Type  

Output 
Table 

Specify the path and file name of output comma-separated values (CSV) 
file. 

File 

Date Field The field in the input feature class containing the date on which each 
incident occurred. If the date of the incident spans a range (for example, 
date information is recorded in two fields representing the from and to 
dates), choose the date field you consider to be most appropriate. This 
will usually be the date at the beginning of the date range. 

Field 

 

Licensing information: 

• ArcGIS Desktop Basic: Yes 

• ArcGIS Desktop Standard: Yes 

• ArcGIS Advanced: Yes 

 

Repeat and Near Repeat Classification tool 
Use a series of distance and time values to classify incidents as originators, repeats, or near-

repeats, and to identify potential spatial and temporal relationships between incidents. 

 

Usage 

• The Input Features must be a point feature class or shape file with a date field, 
representing the locations of incidents. 

• The tool will use all points with date values. Incidents without valid dates will be 
excluded and a warning message will print to the screen listing the skipped 
incidents. 

• This tool will honor a selected set of features. When the Input Features contain a 
selection, only the selected features will be considered when classifying features 
and building connections. 

• Incidents are classified as O (Originator), NR (near-repeat), or R (repeat) according 
to their proximity to each other in space and time using each combination of the 
specified spatial and temporal band values, and the specified repeat distance. 
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• Incidents are classified as originators if they are the originator of at least one other 
incident and have no preceding incidents within the current spatial and temporal 
ranges. 

• Incidents are classified as near-repeat incidents when they follow a previous 
repeat, near-repeat, or originating incident within the current spatial and temporal 
ranges, and do not meet the criteria to be classified as a repeat incident. 

• Incidents are classified as repeat incidents when they occur within the specified 
repeat distance and the current temporal range. An incident that meets the 
requirements for both a repeat and a near-repeat incident is classified as a repeat. 

• Incidents that do not meet the criteria for any of the above are left unclassified. 

• This tool creates the following three outputs: 

– A copy of the input incident features with classification fields added. These 
fields are populated with the classification values for each incident within 
each set to spatial and temporal ranges. For example, if a repeat distance of 
1 map unit (Feet), spatial bands of 100 and 200 map units (Feet), and 
temporal bands of 7 and 14 days are specified, the tool will append 6 fields 
with the following field names and aliases: 

• sb0tb1 (1 ft / 7 Days): Classification of incidents that are originators of 
repeat incidents occurring no more than 7 days later, and incidents 
that occurred within the repeat distance and 7 days of a previous 
incident. 

• sb0tb1 (1 ft / 14 Days): Classification of incidents that are originators 
of repeat incidents occurring no more than 14 days later, and 
incidents that occurred within the repeat distance and 14 days of a 
previous incident. 

• sb1tb1 (100 ft / 7 Days): Classification of incidents that are originators 
of repeat and near-repeat incidents occurring no more than 7 days 
later, and incidents that occurred within 100 map units and 7 days of 
a previous incident. 

• sb1tb2 (100 ft / 14 Days): Classification of incidents that are 
originators of repeat and near-repeat incidents occurring no more 
than 14 days later, and incidents that occurred within 100 map units 
and 14 days of a previous incident. 

• sb2tb1 (200 ft / 7 Days): Classification of incidents that are originators 
of repeat and near-repeat incidents occurring no more than 7 days 
later, and incidents that occurred within 200 map units and 7 days of 
a previous incident. 

• sb2tb2 (200 ft / 14 Days): Classification of incidents that are 
originators of repeat and near-repeat incidents occurring no more 
than 14 days later, and incidents that occurred within 200 map units 
and 14 days of a previous incident. 

• The tool also appends a field called ZVALUE with values representing 
the number of days between each incident and the smallest date 
value in the dataset. These values can be used to visualize the time 
sequence of incidents in ArcGIS Pro so that oldest incidents appear 
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near the ground and more recent incidents appear further from the 
ground. 

– A line feature class that is populated with z-enabled line features 
representing the potential relationships between repeat and near-repeat 
incidents and their originators. The z values for each vertex correspond to 
the ZVALUE field value for the incident that occurs at that vertex. 

– A comma-separated values (CSV) file summary report with the number of 
incidents processed, the counts and proportions of incidents that fall within 
each spatial and temporal band combination, and the estimated half-life and 
half-distance values which can be used as inputs for the Calculate Prediction 
Zones tool. 

• All distances are calculated using geodesic measurements. 

 

Syntax 

RepeatNearRepeatClassification_crime (Input_Feature_Class, Output_Incident_Points, 

Output_Incident_Connection_Lines, Output_Summary_Report_Location, Date_Field, 

Repeat_Incident_Distance, Spatial_Bands, Temporal_Bands) 

Parameter  Explanation 
Data 
Type  

Input Feature 
Class 

Feature class containing points representing the location of 
incidents to classify. The data contained in the features class will 
typically cover a long time period (e.g., one year). The feature 
class must have a date field (in date format) and all features 
must have date values. 

Feature 
Layer 

Output Incident 
Points 

Output feature class containing calculated classification values. Feature 
Layer or 
Feature 
Class 

Output 
Summary 
Report 
Location 

The results from the analysis of repeats and near repeats will be 
written into a Summary report (csv file format) for review. The 
report can be found in this folder after the tool has completed 
successfully. The results are also written to the Messages 
section of the Results window. 

Folder 

Date Field The field in the input feature class containing the date on which 
each incident occurred. If the date of the incident spans a range 
(e.g., date information is recorded in two fields representing the 
from and to dates), choose the date field you consider to be most 
appropriate. This will usually be the date at the beginning of the 
date range. Values in the date field are used to calculate the 
number of days between each incident. 

Field 

Repeat 
Incident 
Distance 

Maximum distance in the units of the input feature class where 
adjacent incidents are considered repeats rather than near 
repeats. A value of 0 is exact to the accuracy of the coordinate 
system. If the geocoding of the input feature class is likely to very 

Double 
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slightly vary it is recommended this value is set to 1 (i.e., 
incidents will be classified as repeats if the distance between 
them is less than or equal to 1 map unit). 

Spatial Bands Distance in the units of the input feature class to classify near 
incidents. Multiple bands can be entered. For example, bands of 
200m and 400m will classify features that are located up to and 
including 200m from a previous incident, and up to and including 
400m of a previous incident. 

Multiple 
Value 

Temporal 
Bands 

Number of days to classify near incidents. Multiple bands can be 
entered. For example, bands of 7, 14 and 21 days will classify 
features that took place up to and including 7 days, 14 days, and 
21 days of a previous incident. 

Multiple 
Value 

 

Licensing information: 

• ArcGIS Desktop Basic: No 

• ArcGIS Desktop Standard: No 

• ArcGIS Advanced: Yes 

 

Introduction to Daily Activity Dashboard 
Daily Activity Dashboard can be used to visualize calls for service and incidents sourced from 

computer-aided dispatch or records management systems and monitor daily activity. 

The solution improves operational awareness for supervisors in law enforcement agencies and 
allows them to rapidly identify emerging incident patterns and diagnose response problems. The 
increased operational awareness helps command staff allocate law enforcement resources and 
monitor the performance of officers under their command. Daily Activity Dashboard is typically 
implemented by law enforcement agencies that want to take a data-driven approach to resource 
allocation and crime reduction strategies. 

The Daily Activity Dashboard solution allows you to source incident records from computer-
aided dispatch or records management systems, visualize law enforcement incidents, and 
monitor trends or patterns. 

 

Calculate Prediction Zones tool 
Identify areas at risk of repeat and near repeat incidents by specifying the spatial and temporal 

range of influence of past incidents. 

 

Usage 

• The Input Features must be a point feature class or shape file with a date field, 
representing the locations of incidents. 
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• The tool will use all points with date values in the Temporal Range of Influence 
preceding the Initial Processing Date. Features with date values outside this range 
and features with null or invalid date values will not be processed. 

• This tool will honor a selected set of features. When the Input Features contain a 
selection, only the selected features will be considered when building the prediction 
zones. 

• Incidents that occur closer in time to the Initial Processing Date will have more 
influence over the prediction zones than older incidents. Areas nearer to incidents 
will be considered to have a greater risk of future incidents, up to the Spatial Range 
of Influence. Use the Spatial Half Distance and Temporal Half Life parameters to 
modify the rate of decay of influence. 

• The following fields are populated in the output feature class: 

– CREATEDATE: Text field populated with the date and time the features are 
created. 

– STARTDATE: The Initial Processing Date, or the calculated date if TODAY 
or YESTERDAY is the input value. 

– TIMEBAND: The Temporal Range of Influence used to generate the 
features. 

– SPACEBAND: The Spatial Range of Influence used to generate the 
features. 

– RISKRANGE: The classification of risk for the area defined by that polygon. 
Higher values have a higher level of risk ang lower values have a lower 
value of risk based on the location and dates of nearby incidents. 

• This tool creates up to two outputs: 

– A raster representation of the levels of risk over the area covered by the 
incidents. 

– Polygons generated by binning the raster values into a number of Risk 
Ranges are appended to the Output Prediction Zones Feature Class as 
described above. 

• While storing the output raster in a geodatabase is supported, it is recommended to 
store the raster in a folder rather than a geodatabase, especially if this tool will be 
run as a scheduled task. 

• All distances are calculated using geodesic measurements. 

• This tool requires the Spatial Analyst extension. 

 

Syntax 

CalculatePredictionZones_crime (Input_Features, Output_Prediction_Zones_Raster, 

Output_Prediction_Zones_Feature_Class, Date_Field, Initial_Processing_Date, 

Spatial_Range_of_Influence, Spatial_Half_Distance, Temporal_Range_of_Influence, 

Temporal_Half_Life, Risk_Calculation_Method, Number_of_Risk_Ranges) 

Parameter  Explanation 
Data 
Type  
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Input Features Feature class containing points representing the location of 
incidents and from which prediction zones will be calculated. 
The feature class must have a date field (in date format) and all 
features must have date values. 

Feature 
Layer 

Point Join 
Features 

Point features coincident with the input polygon or line features. Feature 
Layer 

Output 
Prediction 
Zones Raster 

Output prediction zone raster. Raster 
Layer 

Output 
Prediction 
Zones Feature 
Class 

Output feature class with polygons representing the prediction 
zones. 

Feature 
Class or 
Feature 
Layer 

Date Field The field in the input feature class containing the date on which 
each incident occurred. If the date of the incident spans a range 
(for example, date information is recorded in two fields 
representing the from and to dates), choose the date field you 
consider to be most appropriate. This will usually be the date at 
the beginning of the date range. Values in the date field are 
used to calculate the level of future risk based on a combination 
of when the incident occurred, the Initial Processing Date and 
the temporal decay in risk (determined from the Temporal 
Range of Influence and the Temporal Half Life). 

Field 

Initial 
Processing 
Date 

The date to use from the Input Feature Class for creating the 
prediction zones. 

Date 

Spatial Range 
of Influence 

This value determines the size of the prediction zones around 
each incident (in the units of the coordinate system of the Input 
Feature Class). The value refers to the maximum distance from 
an incident that the incident is estimated to have on influencing 
the risk of future incidents taking place. Additionally, this value 
can be based on the area around an incident that is considered 
to be practical for resource targeting and deployment (for 
example, the area to which additional patrols are targeted). 

Double 

Spatial Half 
Distance 

The distance from an incident at which the risk is estimated to 
be half that of another incident taking place (a near-repeat). This 
value is used to calculate the exponential rate of decay in the 
spatial risk of a near-repeat incident and must be lower than the 
value for the Spatial Range of Influence. Distance units are the 
units of the coordinate system of the input feature class. A 
useful initial value to apply is half the value of the Spatial Range 
of Influence. 

Double 

Temporal 
Range of 
Influence 

This value refers to the number of days before the Initial 
Processing Date that incidents are estimated to have an 
influence on the risk of future incidents taking place. More 
recent incidents have the greatest level of influence on future 

Double 
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risk. Incidents that took place between the Initial Processing 
Date and the value for the Temporal Range of Influence are 
used for creating prediction zones. For example, if this value 
was set to 3, only incidents for the Initial Processing Date and 
the two days prior would be used for creating prediction zones. 
Incidents that took place 3 days ago would have less of an 
influence on the risk of future incidents than those that took 
place on the Initial Processing Date. 

Temporal Half 
Life 

The number of days before the Initial Processing Date on which 
the risk is estimated to be half that of further incidents taking 
place immediately after the Initial Processing Date (for example, 
incidents that took place on the Initial Processing Date are 
considered to have the greatest influence on the risk of future 
incidents taking place. Incidents before the Initial Processing 
Date have less of an influence on future risk). This value is used 
to calculate the exponential rate of decay in the temporal risk of 
a repeat and near-repeat incident and must be lower than the 
value for the Temporal Range of Influence. A useful initial value 
to apply is half the value of the Temporal Range of Influence. 

Double 

Risk Calculation 
Method 

Choose the method for calculating the predictive risk. 

'CUMULATIVE' (default) creates prediction zones where the 
value of each cell is the sum of any prediction zone cells that 
overlap. 

'MAXIMUM' creates prediction zones where the value of each 
cell is the maximum value of any prediction zone cells that 
overlap 

String 

Number of Risk 
Ranges 

Integer value representing the number of ranges that will be 
used in the polygon version of the output for representing the 
variation in predicted risk (for example, if this value was set to 2, 
two Risk Ranges would determine areas of primary risk from 
areas of secondary risk). 

Long 

 

Licensing information: 

• ArcGIS Desktop Basic: Requires Spatial Analyst 

• ArcGIS Desktop Standard: Requires Spatial Analyst 

• ArcGIS Advanced: Requires Spatial Analyst 
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Daily Activity Dashboard 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Requirements 
Daily Activity Dashboard requires the following. 

• ArcGIS Enterprise 

• ArcGIS Pro 2.4 or later (Basic, Standard, or Advanced) (optional) 

 

Information products 
Daily Activity Dashboard includes the following information products: 

Item Description 
Minimum 
user type 

Daily Activity 
Dashboard 

An ArcGIS Dashboards app used by law enforcement 
command staff to monitor calls for service, crimes, and arrest 
data sourced from computer-aided dispatch or records 
management systems 

Viewer 

Record Import 
Tools 

A geoprocessing toolbox for geocoding records from a 
computer-aided dispatch or records management system and 
publishing into a local file geodatabase or hosted feature 
service (optional) 

GIS 
Professional 
Basic 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of the Daily Activity Dashboard application 
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Configure Daily Activity Dashboard 
The Daily Activity Dashboard solution can be configured to meet the specific needs in your 

organization. In this topic, you will learn how to use the Update Features with Incident 

Records tool to automatically load data from records management systems (RMS) and 

computer-aided dispatch systems (CAD) into the layers in your Daily Activity Dashboard, and 

modify or remove dashboard elements unsupported by your data schema. 

 

Load data 
The layers can be loaded with data using ArcGIS Pro. Optionally, you can automated the 

current RMS or CAD incident data to run on a schedule to ensure you are reviewing the most 

up-to-date information while using the dashboard. 

 

Load data using ArcGIS Pro 
In some cases, you may already have this information in ArcGIS or another mapping system. 

Review the layers provided with the solution and determine what source data you want to load. 

Then, load your existing data into the layers provided with the solution before sharing the maps 

or apps. 

1. In ArcGIS Pro, and ensure you are signed into your ArcGIS organization where the 
Daily Activity Dashboard solution is deployed. 

2. Click View, and then click Catalog Pane. 

3. In the Catalog Pane, click Portal, click My Content and choose the folder 
containing the solution. 

4. Add the LawEnforcementDistricts layer, Crimes layer, CallsforService layer, and 
Arrests layer to the map. 

5.  Click Analysis, then navigate to the Append tool, open the tool, use the tool to 
load the districts layer of the LawEnforcementDistricts layer. 

6. Navigate to the Update Features With Incident Records tool, open the tool and use 
it to load data into the Crimes layer. Then use the tool to load data for the 
CallsforService layer, and Arrests layer. 

 

Automate incident data updates 
You can use the ArcGIS Pro and the Update Features With Incident Records tool to update 

incident layers on a regular interval. Scheduled updates ensure users have access to current 

information to support more dynamic decision making. 

To update crimes, calls for service, arrests data on a schedule, use the Update Features With 
Incident Records tool with the Update Existing Target Features parameter enabled. Once the 
tool is configured to use your dynamic incident data, follow the schedule geoprocessing tools 
documentation to learn how to run the tool on a schedule. 
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Configure dashboard elements 
When loading data from your RMS or CAD system into the layers of the Daily Activity 

Dashboard(Crimes, Calls for Service, Arrests), you may find that your source data does not 

contain specific fields (Day of Week, Hour of Day) used in the charts or filters. Since the Daily 

Activity Dashboard is a configuration of ArcGIS Dashboards, all elements can be reconfigured 

to point to different fields, or deleted entirely, as the schema of your data necessitates. 

See Configuring ArcGIS Dashboard elements for more information. 
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Use Daily Activity Dashboard 
The Daily Activity Dashboard solution allows you to source incident records from computer-

aided dispatch or records management systems, visualize law enforcement incidents, and 

monitor trends or patterns. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Understand recent patterns of activity 
Daily Activity Dashboard allows supervisors to use data about recent trends and patterns to 

make smarter resource deployment decisions within their scope of control. 

In this workflow, you will earn how to use the Daily Activity Dashboard solution to explore recent 
crime, call for service, and arrest data to discover patterns of interest for operational responses. 

 

Visualize recent activity 
Follow these steps to visualize recent activity by precinct: 

1. In a browser, go to the Daily Activity Dashboard app. 

2. In the panel on the left side, click the Date drop-down list, and select Last 28 days. 

  The map now displays all calls, crimes, and arrests from the previous day. Calls for service 
will appear as blue circles with a phone icon, arrests will appear as gray circles with a 
handcuff icon, and crimes will appear in multiple colors—navy for violent crime, gold for 
property crime, and light gray for lesser crimes. Each crime type has its own unique symbol 
type. 

3. Select a precinct from the Precinct drop-down list. 

  The indicator elements on the right side display totals for each layer based on the filter 
selected. 

  Note: 

  You may continue to apply as many filters as you want—the filters will continue to narrow 
down the incidents displayed on the map based on the parameters you specify in your 
filter. To cancel your filter, click any filter and select All. 

4. Click one of the incident points on the map. A pop-up in the upper left corner of the 
map will appear, displaying key facts about the incident, including the date, 
location, and incident type. 

  Note: 

  Crimes, calls for service, and arrests layers all have slightly different fields. So the 
specific fields you observe in the pop-up may differ depending on the type of incident 
layer that you clicked. 
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5. Click Zoom in to zoom in to an incident on your map using the scroll wheel on your 
mouse forward. Reversing the scroll wheel zooms the map out. Alternatively, you 
may click the zoom in and zoom out buttons located in the lower left corner of the 
map to control zoom level. 

6. Select the basemap icon in the upper right corner of the map that looks like four 
maps. Then select the Imagery Hybrid basemap to see the imagery near the 
incident. 

7. When finished, reset each filter to All. 

 

Explore calls for service activity 
In this workflow, you will be preparing for a meeting with a neighborhood association. The group 

is particularly concerned about Friday night quality of life issues such as vice, drugs, alcohol 

complaints, and loud parties. 

1. Click the Calls for Service tab in the lower middle of the dashboard. 

2. Select a precinct from the Precinct filter list. 

3. In the Day of Week filter, select a day of the week. 

  You can now see the number of calls for service in your selected precinct, as well as a 
breakdown of the day of week, hour of day, and call for service type. 

4. Browse the Call for Service list to find any report of Vice/Alcohol/Narcotics or Loud 
Party Or Noise. Click the first record you find. 

  As you click, the map will zoom to the location of the call and flash a pink halo around the 
location. 

5. Click the point to open a map pop-up to get the specific location of the call, the 
officer who responded, date of call, call type, and call ID. 

6. When finished, reset all filters to the All. 

 

Explore crime activity 
You have just received grant funding to implement addition patrols in problem areas for 

burglary. To identify where and when to run these patrols, you would like to review all Burglaries 

year to date. 

1. Click the Crimes tab in the lower middle of the dashboard. 

2. Select Year to date in the Date filter. 

3. Select Burglary in the Activity Type filter. 

  The results on the dashboard will show all Burglaries year to date. In the Days of Week 
chart at the bottom of the dashboard, we can see that Burglaries peak slightly on certain 
days of the week. Additionally, you can see the Hour of Day when burglaries appear to be 
most active. 

4. Click any bar in the bar charts to filter the map for just the burglaries occurring in 
that period. 

  This filtering capability helps you to search for unique time-specific spatial patterns that 
may indicate the work of a serial offender. 
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5. When finished, reset all filters to All. 

Note: 

To deactivate a filter from a chart, click the chart bar again. 

 

Explore arrest activity 
Your first shift sergeant has recommended a commendation for an officer who has made 

several recent high-profile arrests. To consider the commendation, you need to review the 

recent arrests made by the officer. 

1. Click the Arrests tab in the lower middle of the dashboard 

2. Select the officer's id number from the Officer filter 

  You can now see all arrests made by the officer. Zoom in to the extent of the arrests. 

  Note: 

  The number in the Officer filter refers to each officer’s badge number. 

3. Click one of the arrest records in the list. 

  As you click, the map will zoom to the location of the arrest and flash a pink halo around 
the location. 

4. Click the arrest point to open a map pop-up to get the specific location of the arrest, 
the officer who responded, date of arrest, arrest type, and arrest ID. 

5. When you are done, close the Daily Activity Dashboard. 
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Dam Safety 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Dam Safety 
Dam Safety can be used to routinely inspect dams to ensure the dams they regulate are in good 

condition and provide the service for which they were intended. 

It provides dam safety programs the necessary resources to adequately inspect and monitor 
their inventories. This standardized approach minimizes failure risk and improves safety of this 
critical infrastructure used for flood protection, water supply, hydropower, irrigation, and 
recreation. Dam Safety is typically implemented by natural resource departments and other 
government agencies that want to modernize their dam inspection programs. 

The Dam Safety solution delivers a set of capabilities that help you routinely inspect dams, 
manage work assignments, and monitor inspection programs. 

 

Requirements 
Dam Safety requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 or later (Basic, Standard, or Advanced) 

• ArcGIS Survey123 

• ArcGIS Workforce 

• Survey123 Connect 

 

Information products 
Dam Safety includes the following information products: 

Item Description 
Minimum 
user type 

Dam Inspection 
Dashboard 

An ArcGIS Dashboards app used by dam safety staff to 
review fieldwork activity and monitor the progress of dam 
inspection programs 

Viewer 

Dam Inspection 
Survey 

An ArcGIS Survey123 form used by mobile workers to 
inspect upstream reservoirs, downstream hazards, and other 
relevant information at dam sites 

Field Worker 
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Dam Inspection 
Assignments 

An ArcGIS Workforce Classic project used by dam safety 
staff to manage dam inspection assignments and track the 
status of each inspection. Mobile workers access the Dam 
Inspection Assignments project using the Workforce for 
ArcGIS mobile app 

Field Worker 

Dam Safety An ArcGIS Pro project used by mapping technicians to 
inventory dam information (for example, location and 
specifications) and assign dam sites to mobile workers 

GIS 
Professional 
Basic 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Dam Safety 

Use Dam Safety 
The Dam Safety solution delivers a set of capabilities that help you routinely inspect dams, 

manage fieldwork assignments, and monitor inspection programs. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Prepare dam inspections 
You will start by assuming the role of a dam safety staff member responsible for coordinating 

dam safety field operations. You are asked to use the Dam Safety ArcGIS Pro project to setup 

your organization’s dam safety field operations. Follow the defined tasks to add inspectors, 

inventory dam information, and assign dam sites to mobile workers. 

To open the ArcGIS Pro project tasks, complete the following steps: 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Dam 
Safety solution. 

2. Download the Dam Safety desktop application template and unzip the folder. 

3. From the unzipped folder, open Dam Safety.aprx in ArcGIS Pro. 
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4. In ArcGIS Pro, in the Catalog pane, expand Tasks, and then double-click the Dam 
Safety task. 

  Note: 

  If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, expand the How to Use Dam Safety task group to see the 
collection of tasks. 

6. Follow the steps in each task. 

 

Complete a dam inspection 
Next, you will assume the role of a dam safety inspector responsible for conducting safety 

inspections of dams. You are asked to use the Dam Inspection Survey to conduct a dam safety 

inspection. 

1. Install the Survey123 field app on your mobile device, if necessary. 

2. Open the Survey123 field app, and then download and open the Dam Inspection 
Survey. 

3. Tap Inbox. 

4. Select a survey from the inbox, and then complete it. 

5. After the survey is complete, tap the check mark, and then tap Send Now to submit 
the survey. 

 

Create dam inspection reports 
In the previous section, you completed a dam safety inspection. You will now create an 

inspection report of the dam safety inspection to provide to the dam owner. 

1. In a browser, go to the Survey123 website and sign in, if necessary. 

2. Open the Dam Inspection Survey, and then click the Data tab. 

3. From the Dam Inspection Survey table, select a survey. 

4. Click the Report button. 

5. In the Report panel, type a report name, and then for Format, choose PDF. 

  Note: 

  Generating reports consumes credits. To see how many credits your report will 
consume, click Show credits. 

6. Click the Generate button to create the inspection report. 

 

Note: 
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To learn more about printing reports in ArcGIS Survey123, see Print survey results. 

 

Monitor dam inspections 
Finally, you will assume the role of a dam safety program manager responsible for managing a 

dam safety program. You are asked to review key metrics to better understand your dam safety 

program. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Dam 
Safety solution. 

2. View the Dam Inspection Dashboard app. 

3. On the left, adjust the filters to refine the inspection list results by the hazard 
classification, specific watershed, inspector name, inspection type, or inspection 
date. 

4. In the Dam Condition chart, click any bar to filter by dam condition. 

5. In the Inspections Completed panel, select any inspection to see important 
inspection details. 
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Damage Assessment 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Damage Assessment 
Damage Assessment can be used to collect initial property damage and other impacts 

immediately after a natural disaster or catastrophic incident. 

The solution provides a rapid damage assessment that helps government agencies prioritize 
activities undertaken by emergency management agencies to stabilize critical infrastructure, 
minimize health and safety threats, and restore services in a community. The initial damage 
assessment precedes the Joint Preliminary Damage Assessment (PDA) conducted with federal, 
state, and local officials after a disaster declaration is made. Damage Assessment is typically 
implemented by emergency management agencies that want to quickly understand the impact 
of a natural disaster or catastrophic incident and immediately assign resources to appropriate 
response and recovery activities. 

The Damage Assessment solution allows you to conduct an initial damage assessment and 
monitor the impact on residential buildings, commercial structures, and public facilities. 

 

Requirements 
The Damage Assessment solution requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 

 

Information products 
Damage Assessment includes the following information products: 

Item Description 
Minimum 
user type 

Damage Assessment 
Dashboard 

An ArcGIS Dashboards app used to monitor field 
assessments and determine whether damage costs 
exceed state or federal declaration thresholds 

Viewer 

Damage Assessment: 
Commercial Buildings 

An ArcGIS Survey123 form used by field inspectors to 
conduct initial damage assessments for commercial 
buildings in a connected or disconnected environment 

Field Worker 
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Damage Assessment: 
Public Facilities 

An ArcGIS Survey123 form used by field inspectors to 
conduct initial damage assessments for public facilities 
in a connected or disconnected environment 

Field Worker 

Damage Assessment: 
Residential Buildings 

An ArcGIS Survey123 form used by field inspectors to 
conduct initial damage assessments for residential 
buildings in a connected or disconnected environment 

Field Worker 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Damage Assessment 
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Use Damage Assessment 
The Damage Assessment solution delivers a set of capabilities to collect and monitor damage to 

local structures including residential, commercial buildings, and public facilities. 

Note: 

In the United States, the Federal Emergency Management Agency (FEMA) manages two 
programs to assist recovery and restoration, the Public Assistance and Individual 
Assistance programs. If the results of the initial damage assessment are significant, a Joint 
Preliminary Damage Assessment (PDA) may be conducted. For more information on the 
FEMA Preliminary Damage Assessment (PDA) process, see Damage Assessment 
Operations Manual. Esri has created surveys using ArcGIS Survey123 to support both the 
FEMA Individual Assistance and Public Assistance programs. For more information on 
these surveys, see Esri Community blog post. 

 

Conduct field surveys 
Immediately after the emergency response and rescue operations are completed, initial damage 

assessments can be conducted by emergency management field personnel to determine the 

impact of the incident. Using field apps with location-based information helps emergency 

management personnel prioritize recovery efforts. 

Initial damage assessment can be conducted for commercial, residential and public 
infrastructure using ArcGIS Survey123 on a mobile device in a connected or disconnected 
environment. 

Note: 

The Survey123 field app is available from Google Play, the App Store, and the Microsoft 
Store. You can install Survey123 directly onto your device from these stores. 

 

Submit damage assessments for commercial buildings 
In some cases, local emergency managers may assign field inspectors who are experienced in 

assessing damages for commercial properties such as hotels, office parks, or shopping centers. 

The Damage Assessment: Commercial Buildings solution is a configuration of ArcGIS 

Survey123 that can be used by field inspectors to collect initial damage assessments on a 

mobile device in a connected or disconnected environment. 

In this workflow, you’ll assume the role of a field inspector who has been assigned to collect 

local damage assessments; you will assume you are at the field location collecting the 

necessary information. 

1. Sign in to the ArcGIS Survey123 app, and choose Damage Assessment: 
Commercial Buildings. 

2. Enter an Incident Number, Incident Name, Inspection Date, and Time. 
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3. Click the Set Location button. In the map search box, enter 22 W. Chicago Ave. 
Naperville, IL. 

4. Scroll down the list and enter site information for the commercial property. 

5. Select Yes for the Is the Business Open option, enter values for the Estimated $ 
Loss Structure and Estimated $ Loss Contents parameters. 

6. For the Extent of Damage, select Minor and for the Primary Cause of Damage, 
select Flood. 

7. Continue scrolling down the list to enter a Description of Damage, Impact to 
Jurisdiction, and Additional Comments. 

8. Under Photos, attach a picture or diagram to make it easy to see the extent of 
damage. 

9. Scroll down and enter the Inspectors Information to make it easy to follow up with 
any questions. 

10. Click Yes for Is the Owner or Occupant Present to open a cascading list of 
Owner/Occupant Information. 

  Note: 

  If the owner is present, the field inspector can capture contact and insurance information, 
which will help expedite the damage assessment process. 

11. Enter all the necessary Owner/OccupantInformation, then scroll down. 

12. Enter all the necessary Insurance Information. 

13. Click Submit to complete the damage assessment survey for the commercial 
property. 

Submit damage assessments for public facilities 
In this workflow, you’ll assume the role of a field inspector who has been assigned to public 

facilities such as schools, water and sewer, or transportation infrastructure. 

1. Sign in to the ArcGIS Survey123 app, and choose Damage Assessment: Public 
Facilities survey. 

2. Enter an Incident Number, Incident Name, Inspection Date, and Time. 

3. Click the Set Location button. In the map search box, enter Naperville Central 
High School, 440 Aurora Ave, Naperville, IL. 

4. Scroll down the list and enter Site, Facility, and Address information for the 
facility. 

5. For the Damage Category option, select CAT E – Public Buildings. 

6. Enter a Description of Damage, Impact to Jurisdiction, and Impacted 
Department. 

7. Enter values for the CostEstimate and County’s CostEstimate, Percent 
Complete and any Additional Comments. 

8. Under Photos, attach a picture or diagram to make it easy to see the extent of 
damage. 

9. Scroll down and enter the Inspectors Information to make it easy to follow up with 
any questions. 
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10. Click Submit to complete the damage assessment survey for the Public Facility. 

Submit damage assessments for residential buildings 
In this workflow, you’ll assume the role of a field inspector who has been assigned to assess 

damage to residential structures. 

1. Sign in to the ArcGIS Survey123 app, and choose Damage Assessment: 
Residential Buildings survey. 

2. Enter an Incident Number, Incident Name, Inspection Date, and Time. 

3. Click the Set Location button. In the map search box, enter 23 E Hillside Rd, 
Naperville, IL. 

4. Scroll down the list and enter Site and Parcel information for the residence. 

5. Under Type of Home, select Detached Home. 

6. Enter the Address information. 

7. For the Extent of Damage, select Minor, and for the Primary Cause of Damage, 
select Flood. 

8. Enter a Description of Damage, enter values for the Estimated $ Loss Structure 
and Estimated $ Loss Contents parameters. 

9. Enter an Impact to Jurisdiction and any Additional Comments such as the 
number of floors damaged, basement, or garage. 

10. Under Photos, attach a picture or diagram to make it easy to see the extent of 
damage. 

11. Scroll down and enter the Inspectors Information to make it easy to follow up with 
any questions. 

12. Select No for the Is the Owner or Occupant Present option. 

  Note: 

  In many cases, the owner or occupant may have left to seek shelter in another location. 

13. Click Submit to complete the damage assessment survey for the residential 
building. 

Monitor damage assessment reports 
Initial damage assessment reports can be used by local officials to determine the severity and 

magnitude of a natural disaster or catastrophic incident. The information from the reports is then 

analyzed to determine whether the disaster-related costs and damages could qualify for any 

state and/or federal assistance. 

The Damage Assessment Dashboard can be used to monitor damage assessments as they are 
submitted by field inspectors and determine whether damage costs exceed state or federal 
declaration thresholds. 

1. In a browser, sign in to your ArcGIS Enterprise organization, navigate to your the 
Damage Assessment Dashboard item, then choose view dashboard. 

2. Click the Residential Buildings tab in the lower left corner of the dashboard. 

3. Review the number of residential buildings in each extent of damage category. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 297 

  Note: 

  The damage assessment categories are Destroyed, Major, Minor, Affected, and 
Inaccessible. 

4. Review the total sum of damage assessments in the upper right corner of the 
dashboard. 

5. Click one of the residential damage estimates in the list. 

  The map zooms in to the selected residential damage estimate location and a pop-up 
window appears in the upper left corner of the dashboard with information and options to 
flash the selected feature. 

6. Click the Commercial Buildings tab in the lower left corner of the dashboard. 

7. Review the number of commercial buildings in each damage category. 

8. Review the total sum of damage assessments in the upper right corner of the 
dashboard. 

9. Click one of the commercial damage estimates in the list. 

  The map zooms in to the selected residential damage estimate location and a pop-up 
window appears in the upper left corner of the dashboard with information and options to 
flash the selected feature. 

10. Click the Public Facilities tab in the lower left corner of the dashboard. 

  Note: 

  The public facilities don’t have the same damage categories as residential or commercial 
buildings but instead have symbols indicating the damage category. 

11. Review the total sum of damage assessments in the upper right corner of the 
dashboard. 

12. Click one of the damaged public facility estimates in the list. 

  The map zooms in to the selected residential damage estimate location and a pop-up 
window appears in the upper left corner of the dashboard with information and options to 
flash the selected feature. 

13. Close the Damage Assessment Dashboard. 

Introduction to Development Impact Analysis 
Development Impact Analysis can be used to evaluate proposed developments and assess 

their impact on solar radiation, shadows, and viewsheds in a community. 

It provides specialized workflows to produce information products for a comprehensive planning 
review. This optimized approach helps create powerful 3D visuals that can be used to inform 
stakeholders and improve public involvement in the development process. Development Impact 
Analysis is typically implemented by planning departments, design firms, and other local 
government agencies that want to create effective visualizations that highlight the impact of 
proposed developments. 
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The Development Impact Analysis solution delivers a set of capabilities that help you create 
solar radiation maps, evaluate how proposed developments will cast shadows on existing 
buildings, and review the impact on viewsheds. 

Deploy now 
This ArcGIS Solution can be deployed in your ArcGIS organization. 

See Deploy an ArcGIS Solution for more information. 

Requirements 
Development Impact Analysis requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 or later (Advanced) 

– ArcGIS 3D Analyst extension 

– ArcGIS Spatial Analyst extension 

Information products 
Development Impact Analysis includes the following information products: 

Item Description 
Minimum user 
type 

Solar 
Radiation 
Analysis 

An ArcGIS Pro project used by government planners to 
calculate solar radiation maps for the wider community 

GIS Professional 
Advanced 

Shadow 
Impact 
Analysis 

An ArcGIS Pro project used by government planners to 
evaluate the shadow impact of proposed or existing 
buildings on the surrounding community 

GIS Professional 
Advanced 

Visibility 
Analysis 

An ArcGIS Pro project used by planners to assess the 
visibility from or visibility of a proposed development within 
the community 

GIS Professional 
Advanced 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Development Impact Analysis 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://docdev.arcgis.com/en/arcgis-solutions/latest/get-started/get-started-with-arcgis-enterprise.htm#ESRI_SECTION1_09F5BE7EA4D0496DA4AB3A3BDD8F01D2


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 299 

Use Development Impact Analysis 
The Development Impact Analysis solution delivers a set of capabilities that help you create 

solar radiation maps, evaluate how proposed developments will cast shadows on existing 

buildings, and review the impact on viewsheds. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Shadow impact analysis 
Planners can use Shadow Impact Analysis to evaluate the shadow impact of proposed or 

existing buildings on the surrounding community. 

Two tasks are available to assess shadow impact: 

• Check Shadows 

• Analyze Shadows 

Check shadows 
You will start by assuming the role of a planner responsible for evaluating the shadow impact of 

proposed or existing buildings on the surrounding community. You are asked to use the Shadow 

Impact Analysis ArcGIS Pro project to review potential shadow impacts of proposed or existing 

buildings. Follow the Check Shadows task to do a quick visual shadow check. 

1. Download the ShadowImpactAnalysis Desktop Application Template and unzip. 

2. Open the ShadowImpactAnalysis.aprx in the unzipped folder. 

3. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

4. In the Catalog pane, expand the Tasks folder, and double-click the Check 
Shadows task. 

5. Follow the steps in each task. 

Note: 

Only use the created sun point locations for display purposes. All shadow impact 
calculations are based on the attributes of the sun points features, not the display location. 
Use Observer Horizon Distance to set the distance to the observer. 

Analyze shadows 
Next, you will continue with the role of a planner responsible for evaluating the shadow impact 

of proposed or existing buildings on the surrounding community. Follow the Analyze Shadows 

task to evaluate shadow impact of features by calculating cumulative shadow duration and area 

for the time period of interest. 

1. Download the ShadowImpactAnalysis Desktop Application Template and unzip. 

2. Open ShadowImpactAnalysis.aprx in the unzipped folder. 

3. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

4. In the Catalog pane, expand the Tasks folder, and double-click the Analyze 
Shadows task. 

5. Follow the steps in each task. 
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The Create Shadows step creates shadow panels on the observer features that will hold the 

shadow attributes: 

• shadow_h—The number of hours each observer panel is in shadow 

• shadow_hits—The number of time intervals (sun positions) each observer panel is 
in shadow 

• num_suns—The number of suns 

• start_date—The start date and time 

• end_date—The end date and time 

Note: 

Check Shadows task only shows shadows as graphics in the scene, giving you a visual 
indication of where the shadows are going to be. The Analyze Shadows task allows you to 
evaluate shadow impact of features by calculating cumulative shadow duration and area for 
the time period of interest. This analysis takes longer to run than the Check Shadow task 
but calculates cumulative shadow duration and area as features with shadow attributes as 
opposed to only a visual display of the shadows. 

Shadow hits are the number of suns that cannot been seen from the observer panel. Depending 
on the time interval, the shadow hits can be the same as the shadow hours (time interval is 1 
hour), less than the shadow hours (time interval is more than 1h), or more than the shadow 
hours (time interval is less than 1h). 

If your goal is to compare shadow impacts between different conditions, you must run this task 
multiple times, once per scenario in the comparison, such as existing versus proposed 
conditions. For example, the proposed scenario includes a model for a new development in the 
list of obstruction features along with existing buildings, whereas the existing conditions only 
include existing buildings in the obstruction features. 

To create shadow panels for a specific time during the day (for example, 10 a.m.), open the Sun 
Positions attribute table and click a record that corresponds to the time interval of interest. This 
selection is honored by the Create Shadow step. 

Solar radiation analysis 
You will now assume the role of a planner responsible for calculating solar radiation maps for 

the wider community. You are asked to use the Solar Radiation Analysis ArcGIS Pro project to 

visualize solar radiation on the ground as well as on the roofs of buildings in a 3D scene and 

evaluate total solar radiation per selected roof area. Follow the defined tasks to calculate solar 

radiation rasters, visualize solar radiation on building roofs, summarize solar radiation for 

selected roof areas, and publish the results. 

1. Download the SolarRadiationAnalysis Desktop Application Template and unzip. 

2. Open the SolarRadiationAnalysis.aprx in the unzipped folder. 

3. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

4. In the Catalog pane, expand the Tasks folder, and double-click the Solar Radiation 
Analysis task. 

5. Follow the steps in each task. 
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Note: 

The atmospheric parameters used in this analysis are calibrated to historic solar radiation 
averages provided by the NASA Surface meteorology and Solar Energy global datasets. 

These averages are provided at a one-degree resolution for the globe. While this resolution 
is adequate for most analyses, there may be some inaccuracy in areas with high variability 
in weather patterns over short distances. The accuracy of the solar radiation values is 
dependent on the quality of the input data. 

Visibility analysis 
Government agencies can use Visibility Analysis to assess visibility for the wider community. 

For example, planners, architects, and real estate appraisers can use Visibility Analysis to 

determine visibility of or from a proposed development from or of surrounding locations. Event 

planners can use the solution to calculate event visibility from specific locations or surrounding 

buildings. 

Two tasks are available to assess visibility: 

• Explore Visibility 

• Analyze Visibility 

Explore visibility 
You will now assume the role of a planner responsible for conducting visibility assessments. 

You have been asked to use the Visibility Analysis ArcGIS Pro project to determine visibility of 

or from a proposed development from or of surrounding locations. Follow the Explore Visibility 

task to quickly explore visibility in your scene. 

1. Download the VisibilityAnalysis Desktop Application Template and unzip. 

2. Open the VisibilityAnalysis.aprx in the unzipped folder. 

3. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

4. In the Catalog pane, expand the Tasks folder, and double-click the Explore 
Visibility task. 

5. Follow the steps in each task. 

Note: 

Typically, these tools are used to get an idea of visibility in your scene. The analytical 
results displayed by these tools are temporary and are not saved with the project, nor are 
they included in map packages. If you require analytical results as data including a 
measurement of how visible an object is, consider using the Analyze Visibility task. 

Analyze visibility 
Next, you will continue with the role of a planner responsible for conducting visibility 

assessments. You have been asked to use the Visibility Analysis ArcGIS Pro project to 

determine visibility of or from a proposed development from or of surrounding locations. Follow 

the Analyze Visibility task to perform a detailed visibility assessment. 
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Note: 

This task calculates the perceived and actual visible area of the target as an attribute of the 
observer. Distance and angle are considered when calculating perceived visibility because 
targets that are further away and under an angle from the observer appear smaller. 

 

Objects that are further away from the observer appear smaller and are less visible compared to 
the objects that are closer to the observer. 

Also, the angle of the targets in relation to the observer is considered because if a target is 
facing slightly away from the observer, it is less visible. 

 

Targets facing away from the observer appear smaller. 

1. Download the VisibilityAnalysis Desktop Application Template and unzip. 

2. Open the VisibilityAnalysis.aprx in the unzipped folder. 

3. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

4. In the Catalog pane, expand the Tasks folder, and double-click the Analyze 
Visibility task. 

5. Follow the steps in each task. 

Note: 

Analyze Visibility samples the observer and target features in 3D space and creates the 
following attributes on each observer panel describing the target visibility from the observer 
panel: 

• Deviation—Average angle between the observer and target panels. 
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• ActualArea—The actual area of all targets visible from the observer. 

• PerceivedArea—The perceived area of all targets from the observer, adjusted for 
distance and angle. The area of the closest target is used to proportionally 
calculate the target areas that are further away. 

• PerceivedAreaPercentage—Percentage value of PerceivedArea. This attribute is 
typically used for symbolization. 

• NumOfSightLines—Number of sight lines from the observer to all visible target 
panels. 

The average angle of the observer feature panel in relation to the target lines of sight is saved in 

the Deviation attribute. Currently, the observer deviation is not used in the visibility calculations, 

meaning all observer panels that have a deviation of less than 90 degrees are considered to 

have line of sight on the targets. Use Select By Attributes on the Deviation attribute to find the 

panels than have a smaller angle or window of visibility. 

 

Visibility is shown on the observer in the upper left without taking into account deviation (left 
image) and with deviation less than 45 degrees (right image). 

Introduction to Election Management 
Election Management can be used to manage election day activities, monitor performance, and 

gauge voter sentiment. 

The elections office is often the smallest agency in a government until Election Day, when it 
becomes the largest. Aging business systems and volunteer workforces that have varying skill 
levels present unique challenges. Election offices, in communities large and small, respond to 
Election Day issues and requests from polling places and voting centers. Issues with computer 
hardware, facilities, or supplies (for example, ballots, pens, and pencils) impact wait times and 
confidence in the election process. As a result, timely response from elections staff is 
imperative. Election Management is typically implemented by clerks, election commissions, or 
secretary of state offices that want to run efficient elections and increase confidence in the 
voting process. 

The Election Management solution delivers a set of capabilities that help you report wait times 
and request assistance at voting centers and polling places, dispatch field staff to respond to 
requests, monitor the performance of voting locations, and gauge the satisfaction of voters on 
Election Day. 
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Deploy now 
This ArcGIS Solution can be deployed in your ArcGIS organization. 

See Deploy an ArcGIS Solution for more information. 

Requirements 
Election Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.5 or later (Basic, Standard, or Advanced) 

• ArcGIS Workforce 

Information products 
Election Management includes the following information products: 

Item Description 
Minimum 
user type 

Election 
Assistant 

A Crowdsource Polling app used by poll workers to routinely 
report wait times and request assistance (for example, 
additional ballots or computer support) at their assigned 
voting center or polling place 

Editor 

Election 
Manager 

An ArcGIS Workforce Classic project used by elections staff 
to manage election day requests for assistance and track 
the resolution of each request. Field users access the 
Election Manager project using the ArcGIS Workforce 
mobile app. 

Field Worker 

Voter 
Satisfaction 
Survey 

An ArcGIS Survey123 form used by elections staff to gauge 
voter satisfaction and sentiment during an ongoing election 

Not required 

Election 
Performance 
Dashboard 

An ArcGIS Dashboards app used by elections staff to 
monitor wait times, requests for assistance, and voter 
satisfaction during an ongoing election 

Viewer 

Election Data 
Management 

An ArcGIS Pro project used by mapping technicians to 
inventory and maintain electoral districts, precincts, voting 
centers, and polling places 

GIS 
Professional 
Basic 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

Release notes 
The following are the release notes: 

Date Description 
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1.0 • First release of Election Management 

Configure Election Management 
Learn how to configure the Election Management solution to meet specific needs in your 

organization. 

Manage election data 
You will assume the role of a mapping technician responsible for maintaining an inventory of 

electoral districts, voting locations, and voting precincts. The Election Data Management ArcGIS 

Pro project includes a series of tasks to help guide you through these workflows. 

Get started 
To get started with Election Data Management, complete the following steps. 

1. Sign in to your ArcGIS organization and browse to the Election Data Management 
Desktop Application Template. 

2. Open the item page and click Download. 

3.  Unzip and open the Election Data Management ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Election Data 
Management task item. 

6. In the Tasks pane, click the Getting Started task group to expand the collection of 
tasks. 

Election Data Management is used to load, create, and edit foundational election data used in 

Election solutions such as My Elected Representative, Election Polling Places, and Election 

Manager. The solution uses three foundational datasets: 

• Voting Locations 

• Voting Precincts 

• Electoral Districts 

Voting Locations contains facilities where voters can cast ballots and is defined by a point layer. 

They can be either polling places or voting centers, depending on your community's needs. 

Voting centers can be modified to allow early voting. 

Voting Precincts contains areas that define your community's precincts and is defined by a 
polygon layer. They are related to voting locations by a unique ID and define the unique polling 
place where voters in a precinct should cast ballots. 

Electoral Districts contains geographies that define an elected office's area of representation 
and is defined by a polygon layer. For example, a mayor's Electoral District is the municipal 
boundary. Key attributes are used in My Elected Representative solution. 

Before proceeding to subsequent tasks, follow the instructions in the Add election geography 
layer task to add the ElectionGeogrophy feature layer deployed with the solution. 
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Load existing election data 
Your election agency may have existing polling place, voting center, voting precinct, or electoral 

district data, which can be loaded into the ElectionGeography feature layer. 

Voting Locations are designated as either Polling Places or Voting Centers using the Voting 
Facility Type field. Both Voting Centers and Polling Places use a standard for operational days 
and hours in the Voting Centers and Election Polling Places apps included with the Election 
Outreach solution. To load existing voting location data, designate the type, and format the 
operation days and hours, follow the instructions in the Polling places and Voting centers 
tasks. 

The polling precinct’s relationship with a polling place is defined by populating the Polling Place 
ID field with the GlobalID from the corresponding polling place. Establishing this relationship 
allows the Election Polling Places app and the Election Outreach solution to display the 
appropriate polling place when a user searches by address or defines a location on the map. 
Follow the instructions in the Polling precincts task to load existing data and establish the 
relationship. 

Follow the instructions in the Load electoral district to load existing data. 

Create new election data 
You may need to create new election data if existing data is not available. Follow the 

instructions in the Create new election data task group to create new voting locations, voting 

precincts, or electoral districts. 

Note: 

Map layers must be visible to create new data. 

Prepare for next election 
Election data changes over time as new voting locations are established, precincts are modified, 

and election cycles are completed. You must update key fields such as the next election date to 

maintain election data accuracy and ensure that public facing apps included with the Election 

Outreach solution display the correct information. Use the Next election date and Early voting 

data tasks to update key data fields as election cycles are completed. Use the Modify voting 

locations, Modify precincts, and Modify electoral districts tasks to edit your election data. 

Modify election request types 
When poll workers create requests using Election Assistant and the Election Requests form, 

requests are automatically created as assignments in the corresponding Election Manager 

Workforce project. Using Election Manager, dispatchers can assign requests to field rovers. 

Follow the steps below to add additional request types to the Election Requests ArcGIS 

Survey123 form and add the same request types to the Election Manager Workforce project. 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Election Requests to download the survey. 

4. In the Download window, click Download and click OK. 

5. Click Election Requests again to open the survey. 
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6. In the XLSForm Modified window, click Yes. 

7. On the side toolbar, click Open XLSForm Spreadsheet. 

8. In the Microsoft Excel spreadsheet, click the choices tab. 

  This tab comprises all the selectable options for survey questions. 

9. Update the name and label of the ASSIGN_TYPE with additional request 
categories such as Sanitation Supplies. Add additional Election Request types as 
needed. 

  Note: 

  Each ASSIGN_TYPE entry has a coded domain value listed in the name column. 
Increment new request types by 1, ensuring each entry is unique. 

10. Save and close the Microsoft Excel spreadsheet and preview your changes in 
Survey123 Connect. 

11. In Survey123 Connect, click Publish on the side toolbar. 

12. Click Publish survey to publish your changes and click OK. 

Update assignment types 
Occasionally, a dispatcher may need to create an assignment directly without a request from a 

poll worker. Optionally, add the newly defined request types defined above into the Election 

Manager project. 

1. Verify that you are signed in to your ArcGIS organization and browse to 
Assignments feature layer. 

2. Open the item page and click the Data tab. 

3. Click Fields. 

4. In the list of fields, click Assignment Type display name. 

5. Click Edit next to List of Values (Domain). 

6. Add the request types created above in the Election Requests form, and match 
both the label and the code you set in the survey. 

7. Click Save. 

Update voter satisfaction survey 
The Voter Satisfaction Survey allows you to solicit feedback from voters to help you gauge voter 

sentiment during an ongoing election. In some cases, you may want to add or remove questions 

from the survey. 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Voter Satisfaction Survey to download the survey. 

3. In the Download window, click Download and click OK. 

4. Click Voter Satisfaction Survey again to open the survey. 

5. In the XLSForm Modified window, click Yes. 

6. On the side toolbar, click Open XLSForm Spreadsheet. 

7. In the Microsoft Excel spreadsheet, click the choices tab. 

  This tab comprises all the selectable options for survey questions. 
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8. Click the survey tab. 

  This tab comprises all the questions in the survey. 

9. Revise the survey to reflect your needs. 

10. Save and close the Microsoft Excel spreadsheet and preview your changes in 
Survey123 Connect. 

11. In Survey123 Connect, click Publish on the side toolbar. 

12. Click Publish survey to publish your changes and click OK. 

Create Election Assistant direct URLs 
Election Assistant is accessed through a URL in a web browser. To report a wait time or request 

assistance, election workers then use either the map or list to select their assigned polling place 

or voting center. Organizations that have many voting locations may want to provide poll 

workers a direct URL to the Election Assistant app. You can use a web browser URL parameter 

to help poll workers by opening the Election Assistant app with the proper voting location 

already selected. 

By adding a facilityid parameter to the app URL, Election Assistant selects the location without 
user interaction. Ensure each voting location has a unique identifier in the facilityid field in the 
ElectionGeography feature layer. For example, by adding &facilityid=89 to the app URL, 
Election Assistant selects facility ID number 89. The full URL is similar to this: 

https://myorganization.maps.arcgis.com/apps/CrowdsourcePolling/index.html?app
id=449f9c890c584c9395a393ad5a541bc6&facilityid=89 

Use Election Management 
The Election Management solution delivers a set of capabilities that help you report wait times 

and request assistance at voting centers and polling places, dispatch field staff to respond to 

requests, monitor the performance of voting locations, and gauge the satisfaction of voters on 

Election Day. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

Report wait times 
You will first assume the role of an Election Day poll worker tasked with reporting voter wait 

times at a regular interval throughout the day. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Election 
Management solution. 

2. View the Election Assistant app. 

3. Select a voting location from the list. 

  Note: 
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  You can also select a voting location using the map. 

4. Click the Report wait time button. 

5. In the Election Wait Times form, enter and submit a wait time in minutes. 

6. Return to the Election Assistant app. 

Request assistance 
Election officials, in communities large and small, respond to Election Day issues and requests 

from polling places and voting centers. Issues with computer hardware, facilities, or supplies (for 

example, ballots, pens, and pencils) are reported by poll workers, triaged by central election 

office staff, and resolved by field workers. You will assume the role of an Election Day poll 

worker requesting assistance. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Election 
Management solution. 

2. View the Election Assistant app. 

3. Select a voting location from the list. 

  Note: 

  You can also select a voting location using the map. 

4. Click the Request assistance button. 

5. In the Election Requests form, do the following: 

– In the Request Type section, choose Election Supplies. 

– In the How critical is your request section, click the drop-down arrow and 
choose Critical. 

– Add additional details such as Additional ballots needed in the Provide 

additional details text box. 

  Note: 

  To help the election office understand the request, you can attach images. 

6. Click Submit. 

Manage election requests 
As requests for assistance are submitted by poll workers, election staff review requests and 

assign field staff to resolve the request. Now, you will assume the role of a dispatcher who 

needs to assign field open requests to field staff. 

1. In a browser, sign in to your ArcGIS organization and click the Apps button  in 
the header of the site. 

2. From the app launcher, click ArcGIS Workforce to open the app. 

3. Under Classic projects, click Election Manager to open the project. 

  Tip: 
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  When implementing the Election Management solution in your organization, add election 
staff responsible for resolving election requests in the field to the Election Manager 
ArcGIS Workforce Classic project with a Mobile Worker role. You can add users and 
assign roles in the configuration settings of the project. To access configuration settings, 
hover over Election Management project and click Configure. Click the Users tab. For 
the purposes of this exercise, ensure your named user account is assigned as a 
dispatcher and as a mobile worker. Click My Projects tab to return to your projects. 

4. In assignments list, click on assignment type header or an election request on the 
map. 

5. Review the request details, click Assign drop-down arrow and choose a field 
worker to resolve the issue. 

6. Click the Assignments back button to return to the assignments list. 

Resolve election requests in the field 
You will now assume the role of a field worker on Election Day. As a field worker, you are 

responsible for responding to and resolving requests submitted by poll workers. Using the 

Election Manager Workforce Classic project, you will review and update the status of your 

assignments. 

1. Download Workforce for ArcGIS app onto your mobile device. 

2. Open the Workforce for ArcGIS app and sign in to your ArcGIS organization. 

3. Tap the Election Manager project. 

4. Select an assignment by tapping on it in the To Do list. 

5. Tap Start. 

6. Add notes or attachments to the assignment as needed. 

7. Tap Finish to complete the assignment. 

Gauge voter satisfaction 
You will now assume the role of a voter who wants to help improve the voting experience for the 

next election by providing feedback on your voting experience. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Election 
Management solution. 

2. View the Voter Satisfaction Survey. 

3. Click Yes to indicate you did vote in the most recent election. 

4. Complete the remaining questions in the survey and click Submit. 

Monitor performance 
You will now assume the role of a clerk or election official. As an election official, you want to 

know how Election Day is functioning throughout the community by monitoring requests, wait 

times, and voter satisfaction. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Election 
Management solution. 

2. View the Election Performance Dashboard app. 

3. On the Overview tab, review the high-level metrics. 
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4. Click the Requests tab on the bottom of the dashboard. 

5. Click the graphs to explore the active and resolved requests. 

6. Click a request in the Requests list to review additional information about a 
request. 

7. Click the Wait Times tab on the bottom of the dashboard. 

8. Review the Average Wait by Hour graph noting wait time trends throughout 
Election Day. 

9. Click the Survey Results tab on the bottom of the dashboard. 

10. Explore the survey responses. 

11. Click a survey in the Completed Surveys list to see additional details. 

Introduction to Election Outreach 
Election Outreach can be used to educate the public and help voters find an appropriate voting 

center or Election Day polling place. 

State and local governments strive to improve voter participation through open communication 
and a sense of collaboration. Elections departments look for ways to increase voter turnout and 
engage constituents but are faced with changing behaviors of citizens who seem disconnected 
from the democratic process. Helping voters locate where they can vote and understand voting 
alternatives removes voter confusion. Communicating wait times to voters reduces congestion 
at polling places or voting centers and increases participation by helping voters decide when 
they want to cast their ballot on Election Day. Election Outreach is typically implemented by 
clerks, election commissions, or secretary of state offices that want to inform voters and 
increase participation in the elections. 

The Election Outreach solution delivers a set of capabilities that help you share information 
about current elected representatives with the public, get voters to an appropriate voting center 
or Election Day polling place, communicate voting wait times and recruit poll workers. 

Deploy now 
This ArcGIS Solution can be deployed in your ArcGIS organization. 

See Deploy an ArcGIS Solution for more information. 

Requirements 
Election Outreach requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.5 or later (Basic, Standard, or Advanced) 

Information products 
Election Outreach includes the following information products: 

Item Description 
Minimum user 
type 

Promoting 
Transparent 
Elections 

An ArcGIS Hub site used by the general public to 
access election information 

Not required 
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My Elected 
Representative 

An ArcGIS Web AppBuilder app used by the general 
public to determine who represents them in local, 
state, and federal elected offices 

Not required 

Election Polling 
Places 

An ArcGIS Web AppBuilder app used by voters to 
locate a polling place where ballots can be cast on 
Election Day 

Not required 

Voting Centers An ArcGIS Web AppBuilder app used by voters to 
locate a voting center where ballots can be cast in 
person or by mail 

Not required 

Poll Worker 
Application 

An ArcGIS Survey123 form used by the general public 
to volunteer to become a poll worker 

Not required 

Election Data 
Management 

An ArcGIS Pro project used by mapping technicians 
to inventory and maintain electoral districts, precincts, 
voting centers, and polling places 

GIS Professional 
Standard 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Election Outreach 

Configure Election Outreach 
In this topic, you will learn how to configure the Election Outreach solution to meet specific 

needs in your organization. 

Manage election data 
You will assume the role of a mapping technician responsible for maintaining an inventory of 

electoral districts, voting locations, and voting precincts. The Election Data Management ArcGIS 

Pro project includes a series of tasks to help guide you through these workflows. 

Get started 
To get started with Election Data Management, complete the following steps. 

1. Sign in to your ArcGIS organization and browse to the Election Data Management 
Desktop Application Template. 

2. Open the item page and click Download. 

3.  Unzip and open the Election Data Management ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 
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5. In the Catalog pane, expand the Tasks folder, and double-click the Election Data 
Management task item. 

6. In the Tasks pane, click the Getting Started task group to expand the collection of 
tasks. 

Election Data Management is used to load, create, and edit foundational election data used in 

Election solutions such as My Elected Representative, Election Polling Places, and Election 

Manager. The solution uses three foundational datasets: 

• Voting Locations 

• Voting Precincts 

• Electoral Districts 

Voting Locations contains facilities where voters can cast ballots and is defined by a point layer. 

They can be either polling places or voting centers, depending on your community's needs. 

Voting centers can be modified to allow early voting. 

Voting Precincts contains areas that define your community's precincts and is defined by a 
polygon layer. They are related to voting locations by a unique ID and define the unique polling 
place where voters in a precinct should cast ballots. 

Electoral Districts contains geographies that define an elected office's area of representation 
and is defined by a polygon layer. For example, a mayor's Electoral District is the municipal 
boundary. Key attributes are used in My Elected Representative solution. 

Before proceeding to subsequent tasks, follow the instructions in the Add election geography 
layer task to add the ElectionGeogrophy feature layer deployed with the solution. 

Load existing election data 
Your election agency may have existing polling place, voting center, voting precinct, or electoral 

district data, which can be loaded into the ElectionGeography feature layer. 

Voting Locations are designated as either Polling Places or Voting Centers using the Voting 
Facility Type field. Both Voting Centers and Polling Places use a standard for operational days 
and hours in the Voting Centers and Election Polling Places apps included with the Election 
Outreach solution. To load existing voting location data, designate the type, and format the 
operation days and hours, follow the instructions in the Polling places and Voting centers 
tasks. 

The polling precinct’s relationship with a polling place is defined by populating the Polling Place 
ID field with the GlobalID from the corresponding polling place. Establishing this relationship 
allows the Election Polling Places app and the Election Outreach solution to display the 
appropriate polling place when a user searches by address or defines a location on the map. 
Follow the instructions in the Polling precincts task to load existing data and establish the 
relationship. 

Follow the instructions in the Load electoral district to load existing data. 

Create new election data 
You may need to create new election data if existing data is not available. Follow the 

instructions in the Create new election data task group to create new voting locations, voting 

precincts, or electoral districts. 
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Note: 

Map layers must be visible to create new data. 

Prepare for next election 
Election data changes over time as new voting locations are established, precincts are modified, 

and election cycles are completed. You must update key fields such as the next election date to 

maintain election data accuracy and ensure that public facing apps included with the Election 

Outreach solution display the correct information. Use the Next election date and Early voting 

data tasks to update key data fields as election cycles are completed. Use the Modify voting 

locations, Modify precincts, and Modify electoral districts tasks to edit your election data. 

Modify elected offices 
My Elected Representative allows the general public to determine who represents them in local, 

state, and federal elected offices. My Elected Representative includes several elected office 

layers, such as Mayor, County Clerk, Governor, and United State Senate. You can modify the 

elected offices available in the app to fit your needs. For example, a city can configure My 

Elected Representative to display only locally elected offices. 

Update domain values 
Review the ElectionGeography feature layer elected offices and identify an elected office your 

organization you may want to add to My Elected Representative. 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
ElectionGeography feature layer. 

2. Open the item page and click the Data tab. 

3. Click Fields. 

4. Click the Layer drop-down menu and choose Electoral Districts. 

5. In the list of fields, click the Elected Office display name. 

6. In the List of Values (Domain) section, review the existing categories and identify 
ones that are not applicable and ones that are missing. 

7. Click Edit next to List of Values (Domain). 

8. Optionally, click the Delete button to remove a category from the list, and click 
Save. 

9. Click Add. 

10. Type the new elected office name into the Displayed Value and Stored Value text 
boxes. 

11. Repeat steps 9–10 to add the remaining elected offices. 

12. Optionally, drag the elected office to a new location in the list to reorder them. 

13. Click Save. 

Update map 
Next you will configure the My Elected Representative map to display the elected offices you 

want to display in the My Elected Representative app. 
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1. Verify that you are signed in to your ArcGIS organization and browse to the My 
Elected Representative map. 

2. Open the item page and click Open in Map Viewer. 

3. Click Details and click the Contents button. 

  The map Content pane displays a list of several preconfigured elected office map layers 
ranging from Mayor to President of the United States. Each layer is filtered using the 
Elected Office field on the Electoral Districts feature layer. 

4. To remove an unneeded elected office layer, click More Options, and click 
Remove. 

5. To copy a layer, click More Options and click Copy. 

  A new layer appears at the top of the Contents pane. 

6. To update the new layer’s name, click More Options, click Rename, type the 
elected office name in the text box, and click OK. 

7. Click Filter on the new layer. 

8. Click the Edit tab. 

  An existing filter query displays Elected Office is Value. You will modify the query to display 
the elected office. The Value drop-down menu displays the values you configured in a 
previous task. 

9. Choose the appropriate elected office domain value from the drop-down menu and 
click Apply Filter. 

10. Optionally, drag the layer to a new location in the Contents pane. 

  Tip: 

  You can also configure existing layers using the above steps. Modify the name and filter 
of an existing layer to match your configuration needs. 

11. Click Save. 

Update app 
You will now configure the My Elected Representative app to use the elected offices configured 

in the My Elected Representative map. 

1. Verify that you are signed in to your ArcGIS organization and browse to the My 
Elected Representative app. 

2. Open the item page and click Edit Application. 

3. Click the Widget tab. 

4. Click Set the widgets in this controller. 

5. Hover over the lower right corner of the Find My Elected Representative widget and 
click Configure this widget. 

6. Click the Search Settings tab. 

7. Click Set next to Select search layer(s) to configure the layers searched in the 
app. 

8. Use the Select search layer(s) window to configure the layers searched in the 
app. 
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  Check the check box next to each of the layers available. 

9. Click OK. 

10. Click Save. 

Share wait times 
When paired with the Election Management solution, Election Polling Places and Voting 

Centers can display election wait times on the map so that voters can make an informed 

decision about when to vote. 

Share polling place wait times 
The Election Polling Places map includes a Polling Place Wait Times layer that displays the 

current wait time. To share wait times in the Election Polling Places app, you’ll make use of the 

included Polling Place Wait Times map layer. 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Election Polling Places map. 

2. Open the item page and click Open in Map Viewer. 

3. Click Details and click the Content button. 

4. Uncheck the Polling Places layer (do not remove). 

5. Check the Polling Place Wait Times layer. 

  The map now displays the most recently reported wait time symbolized by the length of the 
wait reported. When an election is completed, and you want to remove the wait times 
symbol, turn on the Polling Places layer, and turn off the Polling Place Wait Times layer. 

6. Click Save. 

Share voting center wait times 
When paired with the Election Management solution, Voting Centers can display election wait 

times so that voters can make an informed decision about when to vote. The Voting Centers 

map includes a Voting Center Wait Times layer that displays the current wait time. To share wait 

times in the Voting Centers app, you’ll make use of the included Voting Center Wait Times map 

layer. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Voting 
Centers map. 

2. Open the item page and click Open in Map Viewer. 

3. Click Details and click the Content button. 

4. Uncheck the Voting Centers layer (do not remove). 

a. Click Change Style. 

b. Click Location (Single Symbol) style and click Options. 

c. Move the transparency slider to set the transparency level to 100 percent. 

d. Click OK. 

e. Click Done. 

5. Check the Voting Center Wait Times layer. 

  The map now displays the most recently reported wait time symbolized by the length of the 
wait reported. When an election is completed and you want to remove the wait times 
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symbols, turn on the Voting Centers layer and set its transparency to 0 percent, and turn 
off the Voting Center Wait Times layer. 

6. Click Save. 

Hide wait times 
When paired with the Election Management solution, Election Polling Places and Voting 

Centers will display election wait times in the information panel. In some cases, your 

organization may track election wait times for internal use without sharing those wait times in 

the public facing app. 

Hide polling place wait times 
On Election Day, the Election Polling Places app automatically displays wait times tracked using 

the Election Management solution. Follow the below steps to remove wait times from the 

Election Polling Places app. 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Election Polling Places map. 

2. Open the item page and click Open in Map Viewer. 

3. Click Details and click the Content button. 

4. On the Polling Places layer, click More Options and click Configure Pop-up. 

5. Click the Configure button. 

  Tip: 

  Click the View HTML Source button in the editor. Copy and save all the HTML syntax 
into the editor. This allows you to restore wait times or discard changes. From the editor, 
you can copy and paste the original HTML syntax into the Custom Attribute Display 
window after clicking the View HTML Source button. 

6. Delete {expression/expr0} from the pop-up. Backspace so the entire line is 
removed. 

  The result should look like this: 
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7. Click OK to close the Custom Attribute Display window. 

8. Click OK to finish configuring the pop-up. 

9. Click Save. 

  On Election Day, the pop-up does not display wait times but continues to display current 
information such as the Today is Election Day message and operational status. 

Hide voting center wait times 
A vote center can be open on Election Day as well as for a period prior to Election Day. When a 

vote center is open and active, the Voting Centers app automatically displays wait times tracked 

using the Election Management solution. Follow the below steps to remove wait times from the 

Voting Centers app. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Voting 
Centers map. 

2. Open the item page and click Open in Map Viewer. 

3. Click Details and click the Content button. 

4. On the Voting Centers layer, click More Options and click Configure Pop-up. 

5. Click the Configure button. 

  Because voting centers can be configured to be open on Election Day only or over a period 
of time, you will remove wait times from two places in the pop-up configuration. 

  Tip: 

  Click the View HTML Source button. Copy and save all the HTML syntax into the editor. 
This allows you to restore wait times or discard changes. From the editor, you can copy 
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and paste the original HTML syntax into the Custom Attribute Display window after 
clicking the View HTML Source button. 

6. Delete {expression/expr0} from the pop-up. Backspace so the entire line is 
removed. 

  The result should look like this: 

   

7. Scroll until {expression/expr8} is visible. 

8. Delete {expression/expr8} from the pop-up. Backspace so the entire line is 
removed. 

  The result should look like this: 
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9. Click OK to close the Custom Attribute Display window. 

10. Click OK to finish configuring the pop-up. 

11. Click Save. 

  When a voting center is open and active, the pop-up does not display wait times but 
continues to display current information such as the This voting center is open message 
and operational status. 

Sharing solution items 
Several layer views, maps and apps included in the Election Outreach solution must be shared 

with everyone so they can be accessed by the public on the Promoting Transparent Elections 

site. To share your election outreach items with everyone, use the guide below and complete 

the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Election Outreach folder. 

2. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   VotingLocations_currentwait 

  Feature Layer (hosted, view)   ElectionGeography_public 

  Feature Layer (hosted, view)   PollWorkerApplications_public 
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  Web Map   My Elected Representative 

  Web Map   Voting Centers 

  Web Map   Election Polling Places 

  Web Mapping Application   My Elected Representative 

  Web Mapping Application   Voting Centers 

  Web Mapping Application   Election Polling Places 

  Form   Poll Worker Application 

  Site Application   Promoting Transparent Elections 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 

Use Election Outreach 
The Election Outreach solution delivers a set of capabilities that help you share information 

about current elected representatives with the public, get voters to an appropriate voting center 

or Election Day polling place, communicate voting wait times, and recruit poll workers. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

Find elected representatives 
You will assume the role of a resident in the community who wants to find information on your 

election representatives. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Election 
Outreach solution. 

2. View the Promoting Transparent Elections site and review the sections. 

3. Scroll to the Who’s My Elected Representative section and click the Find My 
Representative button. 
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  The My Elected Representative app opens in a new tab or window. 

4. In the Find My Elected Representative widget, under Search for an address or 
locate on map, type an address in your community and press the Enter key. 

5. Review the list of elected offices. 

  Using the list of elected offices, you can discover your elected representatives and their 
contact information. For example, county commissioners are responsible for the 
management of county funds and have fiscal and regulatory powers. 

6. In the Elected Representative list, click County Commissioner. 

  The list of county commissioners updates to display representatives. The number of 
representatives displayed in the pop-up varies by elected office. 

7. Click the Back button to return to the list of elected representative. 

8. In the Elected Representative list, click United State Senate to review senators 
representing this location. 

9. When finished, close the My Elected Representative app and return to the 
Promoting Transparent Elections site. 

Find a polling place 
Many states divide communities into geographic areas and assign registered voters to 

designated polling places based on their residential address. On Election Day, ballots are cast 

at these designated polling places and then tabulated to determine the winner of a political 

contest or proposal. 

You will assume the role of a voter interested in locating the polling place where your ballot can 
be cast on Election Day. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Election 
Outreach solution. 

2. View the Promoting Transparent Elections site. 

3. Scroll to the Voting Locations section and click the Find Polling Place button to 
open the Election Polling Places app. 

4. In the Find My Polling Place widget, under Search for an address or locate on 
map, type an address in the community and press the Enter key. 

  The map updates to display the area covered by the voting precinct where the address is 
located. 

  The Information tab displays details about the polling place such as the election date, 
location, operational hours, and status. 

5. Click the Directions tab.  

  The tab displays turn-by-turn directions from the address to the polling station. 

6. On the map, zoom out and note that the area surrounding your initial address has 
multiple polling places serving voters. 

7. Click a different location on the map and observe how the app identifies a different 
precinct and how polling place details on the Information tab are updated. 

  Information in the pop-up varies by location, depending on the election details. 

8. Click the Directions tab to view turn-by-turn directions to the polling place. 
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9. When finished, close the Election Polling Places app and return to the Promoting 
Transparent Elections site. 

Locate voting centers 
Voting centers are an alternative to traditional, neighborhood-based precincts. When a 

jurisdiction opts to use voting centers, voters may cast their ballots on Election Day at any 

voting center in the jurisdiction, regardless of their residential address. Voting centers may also 

communicate early voting options such as mail-in drop boxes. 

As a voter in the community, you are also interested in locating nearby voting centers and early 
voting options. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Election 
Outreach solution. 

2. View the Promoting Transparent Elections site. 

3. Scroll to the Voting Locations sections and click the Find Voting Centers button 
to open the Voting Centers app. 

4. In the Locate Voting Center widget, click and slide the buffer distance to 5 miles. 

  The slider allows a user to define a distance within which to locate voting centers once an 
address is entered or a location is identified on the map. 

5. Under Search for an address or locate on map, type an address in the 
community and press the Enter key. 

  The map updates to display a proximity of 5 miles around the address location. 

6. Click a voting center from the search results. 

  The Information tab displays center-specific information such as location details, 
operational hours, status, and drop box location. 

7. Click the Directions tab. 

  The tab displays turn-by-turn directions from the address to the voting center. 

  The information in the pop-up varies by location, depending on the election details. 

View wait time at a polling place 
Communicating wait times to voters can reduce congestion at polling places and voting centers 

as well as help voters decide when to cast their ballot on Election Day. 

You'll assume the role of a voter on Election Day. Previously, you've located your polling place 
using the Election Polling Places app. You're now interested in using the app to view the current 
wait time to decide when to cast your ballot. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Election 
Outreach solution. 

2. View the Election Polling Places app. 

3. In the Find My Polling Place widget, under Search for an address or locate on 
map, type an address in the community and press the Enter key. 

  The Information tab updates to display details on the closest polling place to your 
address, including location, operational hours, and status. In addition, the tab reports the 
approximate wait time, which is also visualized on the map, where polling place symbols 
are color-coded according to reported wait times. 
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4. Click the Directions tab. 

  The tab displays turn-by-turn directions from the address to nearest polling place. 

5. On the map, zoom out and review additional polling places. 

  Note: 

  Depending on when you access the app, you will see an operational status of Open Now 
or Closed below the hours of operation. 

View wait times at voting centers 
After locating a voting center using the Voting Centers app, you are interested in using the app 

to view current wait times to decide when best to cast your ballot. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Election 
Outreach solution. 

2. View the Voting Centers app. 

3. In the Locate Voting Center widget, click and slide the buffer distance to 5 miles. 

4. Under Search for an address or locate on map, type an address in the 
community and press the Enter key. 

  The Locate Voting Center widget and the map update to display several voting centers 
within a 5 mile radius of your location. 

  Voting centers symbols on the map are color-coded according to reported wait times. 

5. Click a voting center from the search results. 

  Note: 

  Both the map and the pop-up display the current wait time as reported by the local 
election office. The map symbol is color-coded according to the wait time reported. 

  In addition to the current wait time, the pop-up also displays election day information such 
as location details and operational hours and status. 

  Note: 

  Depending on when you access the app, you will see an operational status of Open or 
Closed to the right of today's hours of operation. 

Volunteer as a poll worker 
As an engaged voter in the community, you want to volunteer to help conduct transparent 

elections as a poll worker. You will fill out a survey to provide your contact information and 

qualifications so the election agency can connect with you about election volunteer 

opportunities. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Election 
Outreach solution. 

2. View the Promoting Transparent Elections site. 
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3. Scroll to the Volunteer as a poll worker section and click the Volunteer button to 
open the Become a Poll Worker survey. 

4. Complete the survey and click Submit. 

Introduction to Election Results 
Election Results can be used to share results tabulated on election night and historical results 

shared after each election. 

Election results for political contests, proposals, and voter turnout for one or more jurisdictions 
are integral to election night or post-election night reporting. Election results are often shared 
through files and tables that are difficult to examine. Sharing election results in a map-based 
application helps voters and other interested stakeholders quickly visualize voting trends in a 
community. Election Results is typically implemented by clerks, election commissions, or 
secretary of state offices that want to make election results accessible and understandable by 
voters, the media, and other interested stakeholders. 

The Election Results solution delivers a set of capabilities that help you organize map-based 
election results, share results for each elected office or proposal, and communicate voter 
turnout for one or more jurisdictions. 

Deploy now 
This ArcGIS Solution can be deployed in your ArcGIS organization. 

See Deploy an ArcGIS Solution for more information. 

Requirements 
Election Results requires the following: 

• ArcGIS Enterprise 

Information products 
Election Results includes the following information products: 

Item Description 
Minimum 
user type 

Election 
Results 

An ArcGIS Dashboards app used by the general public and 
other interested parties to view map-based election results 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

Release notes 
The following are the release notes: 

Version Description 
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1.0 • First release of Election Results 

Configure Election Results 
In this topic, you’ll learn how to configure the Election Results solution to meet specific needs in 

your organization. 

Understand the Election Results feature layers 
The Election Results solution includes the ElectionResults feature layer used to store your 

tabulated election results data. The ElectionResults feature layer has two sublayers, Voting 

Jurisdictions, and the Election Results table. Voting Jurisdictions stores the geographic 

jurisdiction you’re using to visualize election results on a map (for example, County, 

Municipality, or Precinct). The Election Results table stores the results of ballot measures where 

each record represents the results of a ballot measure by contest, candidate, and jurisdiction. 

Each record in the Election Results table is also categorized as an Elected Office or Proposal 

using the Contest Category field. 

In the below example, two candidates ran for mayor in a community with three precincts. 

Contest 
Contest 
Category 

Jurisdiction 
Name Candidate Party 

Number of 
Votes 

Percent 
Vote 

Mayor Elected Office Precinct 1 John Doe Democratic 306 51 

Mayor Elected Office Precinct 2 John Doe Democratic 147 39 

Mayor Elected Office Precinct 3 John Doe Democratic 350 51 

Mayor Elected Office Precinct 1 Jane 
Smith 

Republican 245 49 

Mayor Elected Office Precinct 2 Jane 
Smith 

Republican 153 51 

Mayor Elected Office Precinct 3 Jane 
Smith 

Republican 294 49 

You can use the Election Results table to store the results of ballot measure proposals. Yes and 
No are populated in the Candidate field. In the below example, Proposal 1 was voted on in a 
community with three precincts. 

Contest 
Contest 
Category 

Jurisdiction 
Name Candidate Party 

Number of 
Votes 

Percent 
Vote 

Proposal 
1 

Proposal Precinct 1 Yes  306 51 

Proposal 
1 

Proposal Precinct 2 Yes  147 39 

Proposal 
1 

Proposal Precinct 3 Yes  350 51 
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Proposal 
1 

Proposal Precinct 1 No  245 49 

Proposal 
1 

Proposal Precinct 2 No  153 51 

Proposal 
1 

Proposal Precinct 3 No  294 49 

Load election results 
You may need to load election results data from a spreadsheet sourced from your tabulation 

system. The Election Results solution includes a .csv file that you can use to load data into the 

ElectionResults feature layer. Populate the ElectionResults.csv fields with your election 

results data, and complete the steps below to load your election results data: 

1. Sign in to your ArcGIS organization and browse to the ElectionResults.csv 

item. 

2. Open the item page and click Download. 

3. Edit the .csv file and provide your election results data. 

4. In your ArcGIS organization, browse to the ElectionResults feature layer. 

5. Open the item page and click Update Data > Append Data to layer. 

6. Click Choose Fire, browse to your .csv file, and click OK. 

7. Click Upload and Continue. 

8. Click the Choose the layer that you wish to append data into drop-down arrow 
and choose Election Results. 

9. Uncheck Update existing features. 

10. Click Show field matching to map the fields. 

11. Click Apply Updates. 

Extend election results 
The Election Results solution also includes two feature layer views created from the 

ElectionResults feature layer: ElectionResults_join and ElectionResults_dashboard. These 

feature layer views are used in the Election Results dashboard. Your organization may want to 

modify the ElectionResults feature layer fields to include additional information. When doing so, 

the new fields must be exposed in the appropriate views. Additionally, some views are created 

by joining two sources together, and you must re-create these views with the same name and 

URL after a new field is added. 

Update feature layer view 
Review the ElectionResults feature layer and identify additional fields your organization may 

want to add to the Election Results app. 

1. Verify that you are signed in to your ArcGIS organization and search for the 
ElectionResults feature layer. 

2. Add a new field to a layer in the ElectionResults feature layer. 

3. Browse to the ElectionResults_dashboard view in your contents. 

4. Open the item page and click the Visualization tab. 
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5. Click More Options on the appropriate layer or table, and click Set View 
Definition > Define Fields. 

6. Check the box next to the new field or fields. 

7. Click Apply. 

  The new field is added to the view’s definition. 

Share historical results 
You can deploy the Election Results solution multiple times to share results for multiple election 

cycles. You can configure each Election Results dashboard to share the results of an election. 

You can then share the Election Results dashboards with the Minimal Gallery app and embed 

them in your website. 

Create your Historical Election Results group 
To create the Historical Election Results group, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization. 

2. Create the following group in your ArcGIS organization: 

  Parameter 
  Value 

  Summary   Type A collection of historical election results 
apps hosted by your organization. 

  Description   Type A collection of historical election results 
apps hosted by your organization. The public 
can use this gallery of apps to access specific 
information on past elections. 

  Tags   Historical Election Results, Primary Election Results, General 
Election Results. 

  Who can view 
this group 

  Choose Everyone (public). 

  Who can join this 
group 

  Choose Only those invited by a group manager. 

  Who can 
contribute 
content to the 
group 

  Choose Group members. 

  Sort group 
content by 

  Choose Title and Ascending. 

Create your Historical Election Results Gallery app 
The Historical Election Results Gallery app is a configuration of the Minimal Gallery configurable 

application template. The app consumes the Election Results solution dashboards that you 
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have authored and shared in the Historical Election Results group. This app can be hosted in 

your ArcGIS organization or downloaded and hosted on your local web server. 

To create a historical Election Results gallery app, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Historical Election Results group. 

2. On the group page, click Create a web app and click the Minimal Gallery 
configurable application template. 

3. Click Create web app and specify a title, tags, and a summary. 

4. Click Done. 

5. Configure the app and save your edits, and click Close. 

6. Edit the item details. 

7. Click Share and share the app with Everyone (public). 

8. Embed the Historical Election Results Gallery app in your election website. 

Use Election Results 
The Election Results solution delivers a set of capabilities that help you organize map-based 

election results, share results for each elected office or proposal, and communicate voter 

turnout for one or more jurisdictions. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

Explore Election Results 
You are a member of the general public who wants to explore the results of an election in your 

community. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Election 
Results solution. 

2. View the Election Results app. 

3. Under Elected Offices, explore additional contests using the filters in the left panel. 

  Note: 

  Both the map and the results graph at the bottom update when the contests are 
selected. 

4. Under Area of interest, click the Municipality button. 

  Note: 

  Both the map and Elected Offices list update to display contests by municipality rather 
than precinct. You can use Election Results to display results by any jurisdiction type 
such as state, county, municipality, or precinct. 
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5. Select a Municipality on the map to view the candidate who received the most 
votes for the currently selected elected office. 

6. Select a municipality from the Area of interest drop-down menu. 

  Note: 

  The map, results graph, and voter turnout metrics update to display results for the 
municipality. 

7. Select the Proposal tab on the bottom of the dashboard. 

8. Explore the different proposals with the selectors on the left panel. 

9. Explore the proposal results using the Area of interest options, Proposals list, and 
map. 

10. Select the Voter Turnout tab on the bottom of the dashboard. 

11. Explore voter turnout using the Area of interest options and map. 

Introduction to Electric Data Management for 

ArcGIS Enterprise 
Electric Data Management for ArcGIS Enterprise can be used to map and manage asset 

information with the ArcGIS Utility Network. 

The solution configures ArcGIS Enterprise and the ArcGIS Utility Network to be an authoritative 
repository of information for an electric network and provides workflows that facilitate capturing 
information correctly and keeping it up to date. 

Electric Data Management for ArcGIS Enterprise delivers a data model that makes a utility 
network behave like a electric network, editing apps configured for ArcGIS Pro, and 
preconfigured maps for data sharing. It also provides a sample utility network dataset so users 
can experience a utility network in a single user environment. You can use the solution's 
deployment framework to experience an electric utility network with sample data or in a single-
user environment. 

Deploy now 
This ArcGIS Solution can be deployed in your ArcGIS organization. 

See Deploy an ArcGIS Solution for more information. 

Requirements 
Electric Data Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.8 (Standard or Advanced) 

Information products 
Electric Data Management includes the following information products: 

Item Description Minimum user type 
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Electric Data 
Management for 
ArcGIS Enterprise 

A zipped file with an ArcGIS Pro project 
package with tasks, a configured utility network 
in a file geodatabase, editor and auditor maps, 
and an asset package geodatabase 

Creator user type 
with ArcGIS Utility 
Network user type 
extension 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

Release notes 
The following are the release notes: 

Version Description 

1.0 • The first release of Electric Data Management for ArcGIS Enterprise 
• The data model in the solution has been updated to version 4. For a full 

list of updates, refer to the change log. 

Use Electric Data Management for ArcGIS 

Enterprise 
The Electric Data Management for ArcGIS Enterprise solution provides a preconfigured utility 

network, maps, styles, step-by-step instructions, common data management workflows, and 

more. The tasks in the Electric Data Management project guide you through creating your own 

utility network using the provided schema and data loading options and setting up an enterprise 

environment. The solution also includes a data dictionary with descriptions of the features in the 

data model. 

In this topic, you will learn how to use the solution to create and manage your electric utility 
network. 

Use the instructions in the Electric Data Management task to get started with the solution. 

1. Sign in to your ArcGIS organization and browse to the Electric Data Management 
For ArcGIS Enterprise V1 item. 

2. Open the item page and click Download. 

3. Unzip and open the downloaded Electric Data Management ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand Tasks and double-click the task item. 

6. In the Tasks pane, click the Explore the Data Management Solution task group 
to expand the collection of tasks. 

  Tip: 

  Click each group task heading and task to view a description at the bottom of the 
Tasks pane. 
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  Each task group includes instructional steps for using the solution. Begin by exploring the 
contents of the project, tracing and editing workflows with sample data, or configuring the 
solution for your organization. 

Explore the solution 
The data management solution is designed for organizations that want to experience a fully 

functional electric utility network. Explore common workflows with the sample data in the 

provided single user file utility network. Task-based workflows are also provided to create and 

model your own utility network to behave like a electric system in an enterprise environment. 

The solution also provides preconfigured maps for sharing data and editing data. 

This task group includes the following tasks 

• Overview 

• What's Included 

• Review the Data Model 

• Explore the Symbology and Data 

These tasks introduce the solution and walk through exploring the capabilities of the utility 

network. 

Tracing and Analysis 
Tracing is a key capability of the utility network. There are several core trace configurations that 

allow you to analyze your network. 

This solution includes workflows for critical traces for electric such as Upstream Protective 
Device. The Upstream Protective Device task walks through how use this trace to identify 
potential upstream devices that may have caused an outage. 

This task group includes the following tasks: 

• Open Ducts 

• Cable Support Trace 

• Upstream Protective Device 

• Upstream Reclosing Device 

• Downstream Customer Load 

• Downstream Transformer Load 

Editing Workflows 
Users are guided through editing workflows with the provided sample data. These workflows are 

designed to showcase common tasks while highlighting the capabilities of the utility network. 

Note: 

In the Contents pane, click the List by Snapping tab. Expand all feature classes to ensure 
snapping is checked for each asset group. 

This task group includes the following editing tasks: 

• Create Duct Bank 

• Customer Service with new Overhead Transformer 
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Install Implementation Prerequisite 
Now that the sample utility network has been explored, move on to building out a utility network 

for your own organization. Before getting started, set up the environment with the necessary 

tools. 

This task group includes the following tasks: 

• Create a Python project environment 

• Install Utility Network Package Tools 

• Install Data Loading Tools 

Configure Data Model for Implementation 
The data model has been developed and curated over several years to reflect the latest 

capabilities of the utility network. This solution delivers the latest model which has been 

developed specifically to support electric utilities to best manage their assets in a digital 

environment. 

After exploring the solution, complete the following steps to remove the sample data and 
prepare the data model to manage your electric network. 

This task group includes the following tasks: 

• Project and Remove Sample Data 

• Create Modifications Tables (Optional) 

• Loading Data (Optional) 

Prototype in a Single User Environment 
Creating a utility network that fits your organization's needs requires a solid understanding of 

your data, as well as the provided data model. We recommend starting out with a prototype to 

explore with your own data and adjust where necessary. When ready, move on to setting up 

and implementing your solution in ArcGIS Enterprise. 

To learn more about the Attribute Rules included in the Electric Data Management project, 
review the Electric Data Management Attribute Rules document. 

This task group includes the following tasks: 

• Create File Geodatabase with Schema 

• Adjust Attribute Rules 

• Update Maps Data Sources 

• Reset Trace Location Feature Classes 

• Adjust Maps 

• Export Asset Package 

Deploy Solution to an Enterprise Environment 
These tasks are a guide to set up a utility network from start to finish. This includes creating an 

enterprise database, utility network, and sharing the final maps and services with your 

organization 

This task group includes the following tasks: 
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• Setup Enterprise Database 

• Create Utility Network 

• Apply Schema 

• Adjust Attribute Rules 

• Post Process 

• Publish Services 

• Update Subnetworks 

• Update Maps Data Source to Feature Service 

• Publish Web Map 

• Reset Trace Location Feature Classes 

• Adjust Maps 

• Share with Organization 

Introduction to Emergency Management 

Operations 
Emergency Management Operations can be used to manage incident operations and maintain 

situational awareness during emergency response and recovery phases. 

The solution provides an integrated suite of role-based apps that helps emergency response 
personnel (for example, duty officers, field operations, incident commanders, and public 
information officers) share information as they perform the unique tasks required to accomplish 
incident objectives. Emergency Management Operations is typically implemented by emergency 
management agencies that want to use shared information during emergency response and 
recovery operations. 

The Emergency Management Operations solution delivers a set of capabilities that help you to 
identify an emergency incident, define the impact, allocate resources, and communicate status 
to internal and external stakeholders. 

Deploy now 
This ArcGIS Solution can be deployed in your ArcGIS organization. 

See Deploy an ArcGIS Solution for more information. 

Requirements 
The Emergency Management Operations solution requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.7 - 2.9 (Basic, Standard, or Advanced) 

Note: 

To use this solution ensure the following content and services are enabled and configured 
in ArcGIS Enterprise: directions and routing utility service, Living Atlas content and Living 
Atlas subscriber content. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://docdev.arcgis.com/en/arcgis-solutions/latest/get-started/get-started-with-arcgis-enterprise.htm#ESRI_SECTION1_09F5BE7EA4D0496DA4AB3A3BDD8F01D2
https://enterprise.arcgis.com/en/portal/10.9/administer/windows/configure-services.htm
https://enterprise.arcgis.com/en/portal/10.9/administer/windows/configure-living-atlas-content.htm


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 335 

Information products 
Emergency Management Operations includes the following information products: 

Item Description 
Minimum 
user type 

Situational 
Awareness 
Viewer 

An ArcGIS Web AppBuilder app that can be used by 
emergency management personnel to understand the 
impact of an incident on public infrastructure and human 
populations 

Editor 

Operations 
Response 

An ArcGIS Web AppBuilder app used by emergency 
management personnel to understand the status of 
emergency facilities and response teams 

Editor 

Incident Status 
Dashboard 

An ArcGIS Dashboards app used by emergency 
management personnel to monitor response activities and 
measure progress on incident objectives 

Viewer 

Incident Briefing An ArcGIS StoryMaps app used by emergency 
management personnel to brief key stakeholders during 
an incident or event 

Viewer 

Public Information A Nearby app used by the public to review authoritative 
information and understand the status of an incident or 
event 

Not required 

Emergency 
Management 
Maps 

An ArcGIS Pro project used by mapping technicians to 
create a standard set of briefing and response maps 

GIS 
Professional 
Basic 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

Release notes  
The following are the release notes: 

Version Description 

1.0 • First release of Emergency Management Operations 

 

Configure Emergency Management Operations 
The Emergency Management Operations solution includes several data layers that use facility 

information to support emergency response activities. Below is a list of facility types that are 

used in those data layers. 
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• Emergency Facilities—Police and fire 

• Industrial Facilities—Factories, utilities 

• Commercial Facilities—Shopping centers and businesses 

• Medical Facilities—Hospitals and clinics 

• Educational Facilities—Schools 

If you do not have an inventory of facility information in your ArcGIS organization, you may have 

them in a spreadsheet or another system you can export to a spreadsheet. Once you have 

created a spreadsheet for each facility type, you can load the data into the facility layers 

provided with the solution. 

Load emergency management facilities 
To load your facilities information from a spreadsheet, complete the following steps: 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type  Emergency Management Operations in the search 

box. 

4. Under  Item Type, click Layers, then click Feature Layers. 

  Note: 

  Some of the feature layers have a suffix added such as public. These are layer views of 
the of the original source feature layer. These layer views are used to share information 
with the public without showing all the details or allowing the public to edit the layers. The 
original source layers do not have a suffix. 

5. Click the title of the original source layer into which you want to load data to view 
the item details. 

6. Click Update Data, then click Append Data to Layer. 

7. Under Filename, choose your spreadsheet. 

8. Click Upload, then click Continue. 

9. Click Show field matching to match the fields from the spreadsheet to the fields in 
the selected feature layer. 

10. After you have matched the fields, click Apply Updates. 

11. Click the Data tab on the banner of the item page to confirm your data has loaded 
successfully. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

Configure the Public Information app 
The Public Information app requires access to display the National Weather Service watches, 

warnings, and advisories layer publicly. Follow the steps below to allow access to the layer and, 

optionally, configure directions to be used in the app. 
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Configure the National Weather Service watches, warnings, and 

advisories 
To configure the ArcGIS Living Atlas layers from the National Weather Service, which are 

included in the deployed map, and to share this app publicly, you will need to allow access to 

these layers through your subscription. Follow the steps below to enable the layers in the app. 

1. Sign in to your ArcGIS organization and browse to the Public Information app. 

2. View the app and identify changes you may want to make to it to support specific 
business needs in your organization. 

3. On the app item page, click Edit Application. 

4. On the Attribute tab, click Subscriber content access. 

5. Select the ArcGIS Living Atlas layers to allow public users to access them through 
your subscription. 

6. Click Save to save the app and edit the item details. 

Configure directions 
Optionally, the Public Information app can be configured to provide directions to the nearest 

facilities. 

This configuration draws routes and provides directions using the ArcGIS Online World Route 
Service. This service requires authorization to consume premium content as it consumes 
credits. Learn more about credit usage when creating simple routes. 

Follow the steps below to connect to a routing service and configure the app to enable 
directions. 

1. If necessary, sign in to your ArcGIS organization. 

2. Browse to the web app item page and click Configure App. 

3. In the left panel, click Interactivity. 

4. Click the slider to enable Show directions. 

5. Click Publish. 

6. Click Confirm. 

  The Authorize premium content dialog box appears, indicating this functionality will 
consume credits. 

7. Click Authorize. 

8. Click Launch and explore the capabilities of enabling directions. 

Use Emergency Management Operations 
The Emergency Management Operations solution delivers a set of capabilities that help you to 

identify an emergency incident, define the impact, allocate resources, and communicate status 

to internal and external stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 
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Assess impact 
The Situational Awareness Viewer can be used by emergency management personnel to 

understand the impact of an incident on public infrastructure and human populations. Situational 

Awareness Viewer includes incident information used in a suite of related emergency operations 

solutions essential to maintaining situation awareness. 

In this workflow, you will assume the role of a duty watch officer responsible for assessing the 
incident impact and sharing that information with other users in the EOC. 

Define incident area 
The incident area can be defined by selecting an existing incident, weather warning area, or 

storm report from Active Incidents and Warnings. An incident can also be created by creating a 

buffer around a point, line, or polygon. 

To define the incident area using the sample data, complete the following steps: 

1. In a browser, from the Emergency Management Operations solution, view the 
Situational Awareness Viewer. 

2. From the Active Incidents and Warnings list, click an incident perimeter. 

  Note: 

  You can also define an incident area by clicking any existing polygon. 

3. Click the more options button in the lower right corner of the pop-up window and 
choose Set Location to define the incident area. 

  The Understand Impact widget will open at the bottom of the screen with the impact of a 
one-mile buffer around the flooding incident. 

  Note: 

  The point, line, and polygon icons can be used to create another incident area by 
specifying a buffer distance around another location. This can be useful for accidents, 
chemical spills, tornado paths, wildfires, or any other type of incident. 

4. Click the Save button in the Situation Awareness panel at the bottom of the screen 
to save the incident location in the Incident layer. 

  A pop-up will appear allowing you to enter parameters for this incident. 

5. Enter an incident number, name, and type, then click Done. 

Identify potential impact 
After the incident area has been defined, the impact to population, facilities, and infrastructure 

can be determined. 

To identify the potential impact of an incident using a previously defined area, complete the 
following steps: 

1. To determine the potential impact to the population, select the Potential 
impact tab in the Situation Awareness panel at the bottom of the screen. 
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  The estimated potential impact to vulnerable populations in the incident area is displayed 
by age group. 

2. To further understand the impact to population, select the Special Needs tab. 

  This tab displays a list of residents who have registered for assistance during an 
emergency. 

3. To determine the impact to facilities, select the Schools, Shelter, and 
Hospitals tabs.  

  Each tab displays the number of facilities in the incident area. 

4. To determine the impact to road infrastructure, select the Road Closures tab.  

  This tab displays the number of Road Closures in the incident area. 

5. Click the Incident tab, then click the Download button to download all the incident 
information into a CSV file. 

  Note: 

  This CSV file can be given to the emergency management staff or volunteer 
coordinators. 

6. Click the Print button to create a report of the potential impacted facilities, 
infrastructure, and human populations. In the properties window, enter a title, 
orientation, page size, and any comments, then click OK. 

  Note: 

  This report can be printed or saved electronically to share with emergency management 
staff. 

7. The Snapshot button can be used to create a time-stamped folder in your ArcGIS 
organization containing a map and feature layers. The map and feature layers can 
be used for after-action reports or other analysis. 

  Note: 

  The Snapshot button is enabled when deployed in your organization and is enabled. 

8. Close the Situational Awareness Viewer app. 

Understand operational needs 
After the incident area has been defined and the impact has been determined, the operations 

personnel can plan and assign response activities. The Operations Response app can be used 

by emergency management personnel to understand the status of emergency facilities and 

response teams. 

In this workflow, you will assume the role of the operations section personnel responsible for 
locating and assigning emergency response resources. 
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Find resources near incident 
Operations response begins by identifying the incident area and finding nearby resources to 

support tactical operations. You can search for an address or place to find a given location to 

help plan response activities near that location. 

To locate resources near an incident, complete the following steps: 

1. In a browser, from the Emergency Management Operations solution, view the 
Operations Response app. 

2. In the search box, type an address. 

3. Click the more options button in the lower right corner of the search result pop-up 
window. 

4. Choose Set Location to define the incident area and specify a buffer distance of 1 
mile. 

5. Click the MRP Deployments tab to display a list of mission-ready packages within 
the specified buffer. 

6. Click the Response Facilities, Road Closures, and Closest Hospitals, Schools, 
Shelters tabs to find other resources. 

7. Click the Incident tab, then click the Download button on the left side and open 
the CSV file to see the list of resources. 

  Note: 

  This information can be shared with other agencies or saved for an after-action report. 

8. Explore other methods of defining incident boundaries by using the line tool to 
locate a linear incident such as a train derailment along the train tracks and use a 
buffer distance of 1 mile to see the impact area. 

9. Click the Start Over button to remove the selected incident area, if necessary. 

Locate response teams assigned to incident 
Mission teams that have been assigned to response activities can be located on the map with 

attributes and symbology for each type of response team. These locations and attributes can 

then be updated from the field as teams change or complete assignments. 

To locate a response team assigned to an incident, complete the following steps: 

1. Click the Add Resources widget in the upper right corner to view the resource that 
can be assigned to this incident. 

2. In the Search Templates box, type Emergency to see a list of resources with that 

name. 

3. Select Emergency Medical Services to add a point on the map near the point of 
the incident address. 

4. In the Add Resources list for Mission Ready Packages, add the following attributes: 

  Parameter 
  Value 
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  Name   EMS 1 

  MRP Type   medical 

  MRP Status   Acceptance of Mission 

  MRP Description   public requested assistance 

  NIMS Resource   Medical/Public Health System Assessment Team 

  NIMS Discipline   Emergency Medical Services 

  NIMS Resource Kind   Team/Equipment 

  NIMS Type   III 

  Leave the remaining attributes blank for now and close the Resources widget. 

5. Use the Directions widget to get directions from the incident location to the nearest 
hospital. 

6. Click the Print button in the Directions widget to print a map of the route with 
directions. 

  Note: 

  Operations Response can be used on a mobile device or printed directions can be sent 
to a mobile device if necessary. 

7. Click Clear to clear the directions from the map. 

Visualize incident status 
As the incident unfolds, it is important for incident commanders to monitor response activities as 

they occur in real time. Typically, the county or state Emergency Operations Center displays the 

incident status on a big screen so all command staff can monitor events and make informed 

decisions. 

In this workflow, you will assume the role of the incident command personnel responsible for 
monitoring the status of the incident and emergency response activities. 

Monitor incident status 
The Incident Status Dashboard can be used by emergency management staff to monitor 

response activities in the Emergency Operations Center and measure progress toward the 

incident objectives. 

To monitor the status of an incident, complete the following steps: 
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1. In a browser, from the Emergency Management Operations solution, view the 
Incident Status Dashboard app. 

  Note: 

  The Incident Status Dashboard is designed to be a passive dashboard, meaning no 
interaction is necessary since it typically will be viewed on a big screen in the Emergency 
Operations Center. 

2. Review the number of Active Incidents and Weather Warnings on the left side of 
the dashboard. As the active incidents increase, so does the demand on resources. 

3. Review the number of Open Shelters and Shelter Occupancy on the right side of 
the dashboard. Each green symbol on the map indicates both the location and 
status of shelters. Closed shelters will appear in red. As the shelter occupancy 
increases past 75 percent, the gauge will turn red, indicating additional shelters will 
need to be opened to meet the demand. 

4. Review the indicators at the bottom of the screen. 

– MRPs Deployed indicates the number of Mission Ready Packages that have 
been assigned or deployed. An MRP type describes a specific capability that 
has been developed, trained, and equipped to respond to a unique incident 
or situation. 

– Road Closures indicates the number of road closures within the current map 
extent. 

– PODs indicate the number of Points of Distribution where public safety 
agencies can distribute critical supplies to the public. 

5. After you are done reviewing the information, close the Incident Status Dashboard. 

Brief key stakeholders 
During an incident, emergency management personnel must provide key decision makers with 

accurate and current information that communicates the scope of the emergency incident, the 

status of operational response, and resource availability. Using digital maps to brief key 

stakeholders ensures clear communication across all command levels and enables effective 

executive-level decision-making. 

In this workflow, you will play the role of the incident command staff who is responsible for 
conducting the incident briefing. The briefing is conducted using a series of interactive apps in 
the Incident Briefing app. 

To brief key stakeholders during an incident, complete the following steps: 

1. In a browser, from the Emergency Management Operations solution, view the 
Incident Briefing app. 

2. Review information in the Introduction tab to see how the briefing app can be 
used. 

3. Click the Situational Awareness tab to see active incidents and warnings. 

  Note: 
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  The Situational Awareness app is embedded in the Incident Briefing app to provide an 
interactive map showing the status of the incident. You can select an active incident to 
show the current situation and impact to the community. 

4. Click the Operations Response tab to see current emergency response activities. 

  Note: 

  Questions often arise during an incident briefing such as how many teams are currently 
deployed or how many roads are closed. Because the Operations Response is 
embedded in the Incident Briefing app, questions such as this can be quickly answered 
with current information. 

5. Click the Incident Status tab to see the overall picture of the current situation. 

6. Close the Incident Briefing app when done reviewing. 

Inform the public 
Citizens need access to information before, during, and after an incident to assess their 

personal risk and determine when to act. The Public Information app can be used by the public 

to review authoritative information and understand the status of an incident or event. 

In this workflow, you will assume the role of a resident or member of the public that is interested 
in obtaining information about a current incident. 

Locate incident information 
Follow the steps below to get incident information using the sample data. 

1. In a browser, from the Emergency Management Operations solution, view the 
Public Information app. 

2. In the Public Information pane, drag and use the buffer distance slider to set a 
distance of 3 miles. 

  The slider allows a user to define a distance once an address is entered or a location is 
identified on the map. 

3. In the Public Information pane under Search for an address or locate on map, 
search for an address. 

4. Click the Expand All button to review all the incident information near the specified 
address. 

5. Scroll down the list of incident information to review the local incidents, open 
shelters, evacuation notices, and weather warnings. 

6. Click Open Shelter to review additional information about the selected shelter. 

7. Close the Public Information app when you are done reviewing the incident 
information. 

 

Produce emergency maps 
Often, field support personnel don’t have access to the internet or real-time maps on devices 

during an emergency incident. Therefore, it may be necessary to produce paper maps of the 
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current situation quickly. Emergency Management Maps can be used by emergency 

management mapping technicians to update the data sources with local incident data, share 

maps and data, and create standard hard copy briefing and response maps. 

In this workflow, you will assume the role of a mapping technician supporting an emergency 
incident. 

Configure project 
Emergency Management Maps is an ArcGIS Pro project used by mapping technicians to create 

a standard set of briefing and response maps. It can be used to update source data for the 

current incident which can be used in the other apps that are part of the Emergency 

Management Operations solution. 

Follow the steps below to configure the Emergency Management Maps project. 

1. In a browser, sign in to your ArcGIS Online organization, and then click My 
Contents. 

2. Locate the Emergency Management Operations folder. 

3. Download the Emergency Management Maps desktop application template. 

4. Start the ArcGIS Pro application and open the project package from the active 
portal. 

5. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

6. In the Catalog pane, expand the Using your data task group. 

7. Click the Update data sources task and follow the instructions to update the 
ArcGIS Pro project to reference hosted feature layers. 

8. Click the Append your data task and follow the instructions to add your data to the 
existing data schemas provided with the project. 

9. Click the Use existing geodatabase task and follow the instructions to source 
layers with your data or published web layers. 

10. Click the Use Esri Demographic data task and follow the instructions to use data 
included in ArcGIS Living Atlas of the World. 

Share incident maps 
Some situations require sharing data and maps with other people within the organization. After 

you resource the data in the previous workflow, you can share layers and maps with your data. 

You can also share the desktop application template with other mapping technicians. 

Follow the steps below to share an incident map. 

1. In the tasks panel, expand the Share with your organization task group. 

2. Click Share Layers and follow the task instructions to publish your data as a web 
layer. 

3. Click Remap layer to use published layers to replace layers in the project with 
the new published layers. 

4. Click Share maps to share the maps as web maps with your organization after 
referencing web layers in the project maps. 

5. Click Create Shared Map Package to create a map package that can be shared 
with other people in your organization to edit data and create map books. 
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Create a map book 
One way to deliver standard hard copy briefing and response maps to field personnel is in the 

form of a map book. The map book can be either a series of the same map with individual 

pages covering the geographic extent of the incident or a collection of different maps with the 

same extent. 

Follow the steps below to create an incident map book. 

1. In the tasks panel, expand the Create map books task group. 

2. Click Create a field reference map series and follow the task instructions to 
create a map series with pages of different extents of the same map. 

3. Click Create an incident map book and follow the task instructions to create an 
incident map book with different maps of the same extent. 

Archive incident 
After the incident or event is over and operational features in the map are ready to be archived, 

the Operations Response app can be used to update the active incident flag and archive 

incident data quickly and efficiently. When you archive an incident, the features are no longer 

visible in the app but will continue to be stored in the associated feature layers. This allows you 

to manage multiple incidents from a single app and allows you to access your archived data 

from the associated feature layers for after-action analysis or reporting. 

Follow the steps below to archive incident data and prepare for the next event. 

1. In a browser, from the Emergency Management Operations solution, view the 
Operations Response app. 

2. Click the Archive Incidents widget to view the operational layers available to be 
archived. 

3. Check the check boxes next to the layers to be archived. 

4. Click one of the Drawing tools, and then select the features on the map. 

5. From the Active Incident drop-down list, choose No, and then click Save. 

6. Close the Operations Response app. 

Introduction to Environmental Analysis 
Environmental Analysis can be used to evaluate and understand environmental impacts of 

proposed development projects and solicit feedback from stakeholders. 

It provides ready-made analysis and reporting tools that help streamline environmental review, 
solicit feedback from stakeholders, and generate reports for proposed development projects. 
This improved process decreases the time required for project review and increases 
communication between all stakeholders involved. Environmental Analysis is typically 
implemented by government agencies and conservation organizations that want to take a data-
driven approach to environmental review of proposed development projects. 

The Environmental Analysis solution delivers a set of capabilities that help you evaluate 
proposed development projects and solicit feedback from stakeholders. 

Deploy now 
This ArcGIS Solution can be deployed in your ArcGIS organization. 
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See Deploy an ArcGIS Solution for more information. 

Requirements 
Environmental Analysis requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 or later (Basic, Standard, or Advanced) 

Information products 
Environmental Analysis includes the following information products: 

Item Description 
Minimum 
user type 

Environmental 
Analysis 

An ArcGIS Pro project used by natural resource staff to 
conduct and report on an environmental impact 
analysis 

GIS 
Professional 
Basic 

Environmental 
Screening 

An ArcGIS Web AppBuilder app used by natural 
resource staff to conduct an initial environmental 
impact assessment and share the impact with 
interested parties 

Viewer 

Environmental 
Impact Public 
Comment 

A Crowdsource Polling app used by the general public 
to review projects and comment on the impact to the 
natural environment 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Environmental Analysis 

Configure Environmental Analysis 
Learn how to configure the Environmental Analysis solution to meet specific needs in your 

organization. 

Load data 
Environmental Analysis can be used to evaluate and understand environmental impacts of 

proposed development projects and solicit feedback from stakeholders. 
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Review the layers provided with the solution and determine what source data you want to load. 
Then, load your existing data into the layers provided with the solution before sharing the maps 
or applications. 

Once you have determined what source data must be loaded, complete the data loading 
workflows below. 

Load data from a shapefile 
You can load data for EnvironmentalScreening and EnvironmentalPublicComment from a 

shapefile by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data 
to Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the 
updated data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

Use Environmental Analysis 
The Environmental Analysis solution delivers a set of capabilities that help you evaluate 

proposed development projects and solicit feedback from stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

Conduct initial environmental assessment 
You will start by assuming the role of a project manager responsible for reviewing proposed 

development project scenarios. You are asked to use the Environmental Screening app to 

review several proposed development project scenarios. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Environmental Analysis solution. 
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2. View the Environmental Screening app. 

  In the app, the Environmental Screening widget is open on the right. The widget includes 
various tools that can be used to define an area of interest. 

3. Define an area of interest with one of the provided tools. 

4. Adjust the Buffer distance. 

5. Click Report to view results. 

6. In the Environmental Screening widget, expand the layer that you are interested 
in to view its details. 

7. Optionally, at the top of the widget, click the Choose units for analysis button to 
adjust the search units. 

8. Click the Download or Print button to export the report. 

Conduct detailed environmental assessment 
Now you will assume the role of a project review analyst responsible for reviewing proposed 

development projects. You are asked to use the Environmental Analysis ArcGIS Pro project to 

review a proposed development project. Follow the defined tasks to create analyses, format 

layouts, and create reports of your findings. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Environmental Analysis solution. 

2. Download the Environmental Analysis desktop application template and unzip the 
folder. 

3. From the unzipped folder, browse to the MapsandGeodatabase folder and open 
the Environmental Analysis.ppkx file in ArcGIS Pro. 

  Note: 

  The Environmental Analysis ArcGIS Pro project comes preloaded with sample data, 
geoprocessing tools, models, and layout templates for common analyses. 

4. In ArcGIS Pro, in the Catalog pane, expand Tasks, if necessary, and then double-
click the Environmental Analysis Workflows task. 

  Note: 

  If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, follow the steps of each task to begin your project review. 

Provide stakeholder feedback 
As an engaged resident in a community, you want to provide your feedback on several 

proposed development project scenarios. You will use the Environmental Impact Public 

Comment app to submit comments on each scenario. 

1. In a browser, from the Environmental Analysis solution, view the Environmental 
Impact Public Comment app. 
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2. From the list on the right, select the project that you want to comment on. 

3. Review the project details and comments. 

– Click the Vote for this project button to vote for the project. 

– Click the Add a comment button to leave a comment. 

Introduction to Equitable Property Value 
Equitable Property Value can be used to share authoritative property information, educate 

taxpayers and collect feedback from taxpayers when they are concerned about the equity of 

their property value. 

It provides 24/7 access to answer common property and tax distribution questions in order to 
increase public trust and streamline the assessment appeals process. This approach helps 
stakeholders make well-informed property and development decisions. Equitable Property 
Value is typically implemented by property appraisal departments, assessors, fiscal offices, and 
other local government organizations that want to engage taxpayers in the property valuation 
process. 

The Equitable Property Value solution delivers a set of capabilities that help you communicate 
parcel, property sales, and floodplain information as well as solicit assessment appeals from 
property owners in order to improve customer service and promote fair and equitable property 
values. 

Deploy now 
This ArcGIS Solution can be deployed in your ArcGIS organization. 

See Deploy an ArcGIS Solution for more information. 

Requirements 
Equitable Property Value requires the following: 

• ArcGIS Enterprise 

• Survey123 Connect 

Information products 
Equitable Property Value includes the following information products: 

Item Description 
Minimum 
user type 

Equitable 
Property Value 

An ArcGIS Hub site used by the general public to access tax 
parcel and related property information, find comparable 
sales, file assessment appeals, and identify properties 
impacted by FEMA floodplain boundaries 

Not Required 

Floodplain 
Inquiry 

An ArcGIS Web AppBuilder app used by the general public, 
land development companies, and real estate professionals 
to locate parcels impacted by FEMA floodplain boundaries 

Not Required 

Residential 
Comp Finder 

An ArcGIS Web AppBuilder app used by the general public, 
real estate agents, and appraisers to find comparable sales 
and related property information 

Community 
Account 
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Tax Parcel 
Viewer 

An ArcGIS Web AppBuilder app used by the general public 
to access tax parcel, tax distribution, and related property 
information on smartphones, tablets, and desktop computers 

Not Required 

Property Tax 
Assessment 
Appeal 

An ArcGIS Survey123 form used by the general public to file 
a formal request for the review of their property assessment 

Community 
Account 

Tax Liability 
Calculator 

An ArcGIS Survey123 form used by the general public to 
compute their estimated tax liability 

Not Required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Equitable Property Value 

Configure Equitable Property Value 
Learn how to configure the Equitable Property Value solution to meet specific needs in your 

organization. 

Load data 
Equitable Property Value can be used to share parcel, property sales, floodplain, and tax 

distribution information. In some cases, you may have this information in ArcGIS or another 

business system already. 

Review the layers provided with the solution and determine what source data you want to load. 
Then, load your existing data into the hosted feature layers provided with the solution before 
sharing the maps or applications. 

Once you have determined what source data must be loaded, complete one or more of the data 
loading workflows below. 

Load data from a shapefile 
You can load data for TaxParcels, SiteAddresses, SchoolDistricts, FloodZones, and 

TaxParcelSales from a shapefile by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data 
to Layer. 

4. Under Filename, click Choose File. 
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5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the 
updated data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

Tip: 

You can use the Data Assistant add-in, which is part of the Community Data Aggregation 
solution, to load your data into the TaxParcels hosted feature layer. The Data Assistant 
add-in allows you to update and load data manually or on a schedule. 

Load tax distribution information 
To configure the Tax Distribution table in the TaxParcels hosted feature layer in ArcGIS, you 

may use the sample .csv file included with the solution (TaxDistributionSources.csv). 

To load tax distribution from a spreadsheet, complete the steps below: 

1. Sign in to your ArcGIS organization and browse to the TaxDistributionSources 
item. 

2. On the item details page, click Download. 

3. Once downloaded, open the TaxDistributionSources.csv and populate Parcel ID, 
Total Tax, and Tax District distribution totals (in dollars). 

  Note: 

  After these tax values are populated, you can compute the percent of total tax dollars for 
each Tax District and populate its corresponding Tax District % attribute—for example, 
(TXDIST1/TOTTX)*100 = TXDIST1PER or ($1500/$5000)*100 = 30%. 

4. Alternatively, you can use ArcGIS Pro to populate these values based on their 
spatial relationship with tax districts. 

5. Once TaxDistributionSources.csv is populated with all the necessary data. 

6. In your ArcGIS organization, browse to the TaxParcels hosted feature layer. 

7. On the feature layer item details page, click Update Data and select Append Data 
to Layer. 

8. Under Filename, click Choose File. 

9. Browse to your .csv file and click Open. 

10. Click Upload and Continue. 
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11. From Choose the layer that you wish to append data into, select the Tax 
Distribution table to load into. 

12. Uncheck Update existing features. 

13. Click Show field matching and map the fields between the two layers. 

14. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

Configure the Equitable Property Value site 
The Equitable Property Value solution includes the Equitable Property Value Hub site that your 

organization can configure with your branding and use to share property value information with 

the public. 

Share Equitable Property Value items 
When you deploy the Equitable Property Value solution, it will create an Equitable Property 

Value site, and two Groups (Core Team and Followers) in your ArcGIS organization. Several 

maps and apps included in the Equitable Property Value solution must be shared with taxpayers 

before reviewing comparable sales and filing a property tax assessment appeal. Sharing the 

appropriate maps and apps with the Followers group created with the initiative will allow 

business owners to access them after creating a community identity. 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Equitable Property Value folder. 

2. Check the check box next to each of the items below: 

  Item 
  Name 

  Web Mapping Application   Residential Comp Finder 

  Form   Property Tax Assessment Appeal 

  Web Map   Residential Comp Finder 

  Feature Layer (hosted, view)   PropertyTaxAssessmentAppeal_fieldworker 

  Feature Layer (hosted, view)   SchoolDistricts_public 

  Feature Layer (hosted, view)   TaxParcelSales_public 

3. Click Share. 

4. In the Share window, click Edit Group Sharing. 

5. Click Equitable Property Value Followers and click OK. 
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6. Click Save. 

7. Next, you'll share items with Everyone (public). 

8. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   FloodZones_public 

  Feature Layer (hosted, view)   SiteAddresses_public 

  Feature Layer (hosted, view)   TaxLiabilityCalculator_public 

  Feature Layer (hosted, view)   TaxParcels_public 

  Web Map   Floodplain Inquiry 

  Web Map   Tax Parcel Viewer 

  Web Mapping Application   Floodplain Inquiry 

  Form   Tax Liability Calculator 

  Web Mapping Application   Tax Parcel Viewer 

  Site Application   Equitable Property Value 

9. Click Share. 

10.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

11. Click Update. 

Modify surveys 
The Equitable Property Value solution includes two surveys (Tax Liability Calculator and 

Property Tax Assessment Appeal) that can be used to estimate tax liability for a given property 

and appeal property tax. 

Review the preconfigured questions and adjust as necessary to fit your needs. 

Add additional fields 
Both surveys leverage hosted feature layer views created from the TaxLiabilityCalculator and 

PropertyTaxAssessmentAppeal hosted feature layers. Organizations may want to modify the 

Tax Liability Calculator and Property Tax Assessment Appeal surveys by first adding new fields 
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to the hosted feature layers and configuring the surveys to use the newly created fields. When 

doing so, the new fields must be exposed in the appropriate views. 

To add one or more fields to a hosted feature layer and update the views, complete the 
following steps: 

1. Add a new field to a layer in the  TaxLiabilityCalculator or 
PropertyTaxAssessmentAppeal hosted feature layer. 

2. Browse to the view in your contents. 

3. Click  Open in Map Viewer Classic. 

4. Click the More Options button on the appropriate hosted feature layer or table, and 
click  Set View Definition. Click Define Fields. 

5. Scroll to the newly created field and check the box. Click Apply. 

  The new field is added to the view’s definition. 

Modify equation for tax liability 
To modify a Equitable Property Value survey, complete the following steps: 

1. Install Survey123 Connect. 

2. Start Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Tax Liability Calculator and download the survey. 

4. Click Tax Liability Calculator again to open the survey. 

5. On the left pane, click  the Open XLSForm spreadsheet. 

6. Revise the survey logic to reflect the calculation for tax liability in your community. 

7. Save the Microsoft Excel spreadsheet and preview your changes in Survey123 
Connect. 

8. In Survey123 Connect, click Publish in the left pane to publish your changes. 

Use Equitable Property Value 
In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

Locate parcels impacted by a floodplain 
When the public and real estate professionals search for properties, floodplain boundaries come 

into consideration. Knowledge of floodplain boundaries helps ensure that informed decisions 

can be made during the land development and home buying processes. 

In this workflow, you will learn how to locate and view authoritative floodplain boundary 
information (DFIRM panels) provided by the Federal Emergency Management Agency (FEMA) 
using Floodplain Inquiry. 

You will assume the role of a resident in a local community. You want to see whether a property 
that you are interested in purchasing sits within a floodplain boundary. 
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1. In a browser, from the Equitable Property Value solution, view the Equitable 
Property Value ArcGIS Hub site.  

2. Scroll to the Property Applications section, and then click Locate Floodplain. 

  The Floodplain Inquiry app opens. 

3. On the right, in the Search Parcels widget, search for a parcel number or address, 
or click the location directly on the map. 

4. Review the property's details, such as its parcel number or address, and whether 
the property is impacted by a flood zone. 

Locate comparable sales 
To determine fair market value of a subject or prospective property, the public and real estate 

professionals can use the Residential Comp Finder to look for properties with similar 

characteristics. 

You will assume the role of a local homeowner. You want to find recently sold properties with 
similar characteristics to determine the value of your home. 

1. In a browser, from the Equitable Property Value solution, view the Equitable 
Property Value ArcGIS Hub site. 

2.  Create a community identity or sign in with an existing user account.  

3. Scroll to the Get Involved section and click Get Involved to follow the initiative. 

  Following the initiative gives you access to the Residential Comp Finder app. 

4. Scroll to the How does my property compare section, and then click Find 
Comps.  

  The Residential Comp Finder app opens. 

5. In the Locate Sale widget, search for a parcel number, address, or school district, 
or click the location directly on the map. 

6. Optionally, adjust the buffer slider to see a larger list of potential properties. 

7. Review the property's details, such as its address, parcel number, year built, floor 
area, assessed value, sale price, sales date, and sales ratio. 

8. Optionally, use filters to refine the results; for example, use the Sale Amount is 
between filter to find homes with sale prices between $250,000 and $350,000. 

Discover parcel and tax distribution information 
Providing up-to-date and accurate information on taxes can help taxpayers know where their 

dollars go and allow local governments to operate with transparency. Using the Tax Parcel 

Viewer, the public can access property tax information and see where property tax dollars are 

being distributed, along with the amount of each distribution. 

You will assume the role of a local homeowner. You want to find your property to see how your 
property taxes have been distributed. 

1. In a browser, from the Equitable Property Value solution, view the Equitable 
Property Value ArcGIS Hub site. 

2. Scroll to the Property Applications section, and then click View Parcels. 

  The Tax Parcel Viewer app opens. 
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3. On the right, in the Search Parcels widget, search for a parcel number, owner, or 
address, or click the location directly on the map. 

4. Review the property's details, such as its address, parcel number, owner name, 
subdivision, structure types, and assessed and land values. 

5. Review the tax distribution information to see how property tax from this parcel has 
been locally allocated. 

Estimate tax liability and appeal assessment 
To determine tax liability and review assessment of a property, property owners depend on the 

assessor’s office to accurately determine and assess their property’s value. 

In this workflow, you will learn how to estimate tax liability and file a formal appeal of a property 
assessment. 

Calculate estimated tax liability 
Property owners can use the Tax Liability Calculator to compute their estimated tax liability. 

1. In a browser, from the Equitable Property Value solution, view the Equitable 
Property Value ArcGIS Hub site.  

2. Scroll to the embedded Tax Liability Calculator. 

3. Complete the Sale Price field to see a property’s estimated tax liability. 

File a Property Tax Assessment Appeal 
Property owners can use the Property Tax Assessment Appeal form to file a formal request for 

the review of their property assessment. 

1. In a browser, from the Equitable Property Value solution, view the Equitable 
Property Value ArcGIS Hub site. 

2.  Create a community identity or sign in with an existing user account.  

3. Scroll to the Get Involved section and click Get Involved to follow the initiative. 

  Following the initiative gives you access to the Property Tax Assessment Appeal app. 

4. Scroll to the How does my property compare section, and then under Start the 
Appeal Process, click Apply. 

5. Complete the Property Tax Assessment Appeal form, and then click Submit. 

Introduction to Fire Hydrant Inspection 
Fire Hydrant Inspection can be used to perform fire hydrant inspections and ensure that every 

hydrant in a district performs reliably when an emergency occurs. 

The solution provides a comprehensive inventory of fire hydrants, and their status that can be 
accessed in a station or the field. The hydrant inventory can be used by fire service agencies to 
prioritize inspection activities and quickly locate operational hydrants when an emergency 
occurs. This approach reduces staff time necessary to perform routine inspections, and 
ultimately increases the effectiveness of fire suppression efforts. Fire Hydrant Inspection is 
typically implemented by fire service agencies that want to take a data-driven approach to 
preparedness and response activities. 
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The Fire Hydrant Inspection solution delivers a set of capabilities that help you inventory fire 
hydrants, collect operational status on a regular schedule, and monitor the progress of 
firefighters performing routine hydrant inspections. 

Deploy now 
This ArcGIS Solution can be deployed in your ArcGIS organization. 

See Deploy an ArcGIS Solution for more information. 

Requirements 
Fire Hydrant Inspection requires the following: 

• ArcGIS Enterprise 

• ArcGIS Collector 

Information products 
Fire Hydrant Inspection includes the following information products: 

Item Description 
Minimum 
user type 

Fire Hydrant 
Inspection 
Dashboard 

An ArcGIS Dashboards app used by fire personnel to 
monitor fire hydrant inspections occurring in a community 

Viewer 

Fire Hydrant 
Inspection 

An ArcGIS Collector web map used by fire personnel to 
inspect fire hydrants and ensure that every hydrant in a 
district performs properly and reliably when an emergency 
occurs 

Field Worker 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Fire Hydrant Inspection 

Configure Fire Hydrant Inspection 
The Fire Hydrant Inspection solution can be used by fire personnel to perform inspections and 

ensure that every hydrant in a district performs properly and reliably when an emergency 

occurs. In some cases, you may already have fire hydrant location and attribute data in ArcGIS 

or a spreadsheet. To load your fire hydrant data into the solution, follow the instructions 

appropriate for the form of your data. 
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Load fire hydrant data from a spreadsheet 
To load fire hydrant data from a spreadsheet, complete the following steps: 

1. If necessary, sign in to your ArcGIS organization 

2. At the top of the site, click Content. 

3. On the My Content tab, type fire hydrant in the search box. 

4. Click the Feature Layer item named FireHydrants. 

5. Click the Data tab. 

6. Click the Fields toggle button to display a view of all fields in the FireHydrants 
layer. 

7. Right-click the Overview tab, and open a new window. 

8. Click the Update Data button, then click Append Data to Layer. 

9. Click the Choose File button and select your spreadsheet. 

10. Click Upload and Continue. The spreadsheet may take several seconds to 
upload. 

11. Click the Show field matching link. 

12. Match the fields in your data to the appropriate corresponding field in the 
FireHydrants layer. 

  Tip: 

  Your spreadsheet must have fields containing the latitude and longitude coordinates of 
the fire hydrant location, and these fields must be matched to the Latitude and Longitude 
fields in the FireHydrants layer. 

13. Click Apply Updates. 

Load fire hydrant data 
If you have fire hydrant data you can load it into the fire hydrant layer to conduct the inspections. 

To load features from a shapefile into the fire hydrants layer, complete the steps below: 

1. If necessary, sign in to your ArcGIS organization 

2. At the top of the site, click Content. 

3. On the My Content tab, type fire hydrant in the search box. 

4. Click the Feature Layer item named FireHydrants. 

5. Click the Data tab. 

6. Click the Fields toggle button to display a view of all fields in the FireHydrants 
layer. 

7. Review the display names of all fields in the layer and consider how the fields in 
your data relate. In a later step, you will need to match the fields in your dataset to 
the associated field in the FireHydrants layer, so it is helpful to leave this page 
open for reference. 

8. Right-click the Overview tab, and open a new window. 

9. Click Choose File and browse to a .zip containing the shapefile with your ire 

hydrants and then click Open. 
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10. Click the Contents drop-down arrow and choose whether the source is a shapefile. 

11. Click Upload and Continue. The file may take several seconds to upload. 

12. Click the Show field matching link. 

13. Match the fields in your data to the appropriate corresponding field in the 
FireHydrants layer. 

14. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

Use Fire Hydrant Inspection 
The Fire Hydrant Inspection solution delivers a set of capabilities that helps you inventory fire 

hydrants, update operational status on a regular schedule, and monitor the progress of fire 

personnel performing routine hydrant inspections. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

Develop fire hydrant inventory 
A field assessment of fire hydrants is the most efficient way to develop a hydrant inventory for a 

fire department. In some cases, fire departments may be able to access hydrant data 

maintained by the local water utility and use that data to start the collection of operational status. 

In other cases, hydrant data may not exist and the field assessment used to capture the location 

of hydrants and their operational status. 

You will assume the role of a fire fighter in a fire department. In this workflow, you are asked to 
use the ArcGIS Field Maps mobile app to access your Fire Hydrant Inspection and inventory 
hydrants in your community. 

Collect new hydrant 
To collect a new fire hydrant in the field, complete the following steps: 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Open the app on your mobile device, and sign in to your ArcGIS organization. 

3. Tap Fire Hydrant Inspection to open it. 

4. Tap the search box and type a local address, and then tap the suggested 

address in the search result list to zoom to that location on the map. 

5. Tap Collect Here and tap Operable. 

6.  Swipe up on the form and tap Fire Hydrant ID and enter the identifier. 

7. Tap Station to enter the station response area. 

8. Tap Location to enter a more detailed description of the location. 
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9. Swipe up and tap Inspected On to choose today's date. 

10. Tap Pumped and choose a value. 

11. Tap Defects, then tap Hard to Open and choose a value. Add other key 
characteristics in the form. 

12. Swipe up and tap Notes to enter any other observations noted in the field. 

13. When you're done, tap Submit. 

14. Repeat steps 5 through 13 for each fire hydrant. 

Update operational status 
To update the operational status of an existing fire hydrant in the field, complete the following 

steps: 

1. Download ArcGIS Field Maps onto your mobile device if you haven't already. 

2. Open the app on your mobile device, and sign in to your ArcGIS organization. 

3. Tap Fire Hydrant Inspection to open it. 

4. Tap search, type your hydrant identifier and tap hydrant identifier in the 

search results. 

5.  Tap Edit and swipe up on the form. 

6. Swipe up and tap Inspected On to choose today's date. 

7.  Tap Operable and choose No. 

8. Tap Pumped and choose a value. 

9. When you're done, tap Submit. 

10. Repeat steps 4 through 9 for each fire hydrant. 

Monitor fire hydrant inspection program 
You will now assume the role of fire command staff and will use the Fire Hydrant Dashboard to 

monitor the progress of fire hydrant inspections. 

To monitor the progress of your fire hydrant inspection program, complete the following steps: 

1. In a browser, go to the Fire Hydrant Dashboard app. 

2. Click the Station drop-down in the left panel and choose a station.  

  You can now see all fire hydrants in your district on the map. On the bottom of the 
dashboard, you can see the total number of hydrants in the station area along with the 
number of operable and inoperable hydrants in the same area. 

3. Click the Inoperable bar in the chart to see inoperable fire hydrants. 

4. Click the Inspection Date drop-down and choose Last 30 Days in the left panel. 

  You can now see how many hydrants have been inspected in the last 30 days. 

5.  Adjust the Pressure slider to identify hydrants with low pressure. 

6. Close the app. 

Introduction to Fire Incident Dashboard 
Fire Incident Dashboard can be used to visualize fire and emergency medical service (EMS) 

incidents sourced from computer-aided dispatch or records management systems and monitor 

associated response times. 
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It improves operational visibility for supervisors in a fire service agency and allows them to 
rapidly identify emerging incident patterns and diagnose response problems. This increased 
operational awareness ensures accreditation standards are being met and community safety 
standards are satisfied. Fire Incident Dashboard is typically implemented by fire service 
agencies that want to proactively monitor response times and detect incident patterns quickly. 

The Fire Incident Dashboard solution delivers a set of capabilities that help you source incident 
records from computer-aided dispatch or records management systems, visualize fire and EMS 
incidents, and monitor trends or patterns. 

Deploy now 
This ArcGIS Solution can be deployed in your ArcGIS organization. 

See Deploy an ArcGIS Solution for more information. 

Requirements 
The Fire Incident Dashboard requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.4 - 2.9 (Basic, Standard, or Advanced) (Optional) 

Information products 
Fire Incident Dashboard includes the following information products: 

Name Description 
Minimum 
user type 

Fire Incident 
Dashboard 

An ArcGIS Dashboards application used by fire command 
staff to monitor fire and EMS incidents sourced from computer 
aided dispatch or records management data 

Viewer 

Record Import 
Tools 

A geoprocessing toolbox for geocoding records from a 
computer aided dispatch or records management system and 
publishing into a local file geodatabase or hosted feature 
service (optional) 

GIS 
Professional 
Basic 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Fire Incident Dashboard 
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Configure Fire Incident Dashboard 
The Fire Incident Dashboard solution can be configured to meet specific needs in your 

organization. In this topic, you will learn how to use the Record Import Tools toolbox to 

automatically load data from records management systems (RMS) and computer-aided dispatch 

(CAD) systems into the layers in your Fire Incident Dashboard and modify or remove dashboard 

elements unsupported by your data schema. 

Load data using Record Import Tools 
The layers in the solution can be updated using the Record Import Tools toolbox provided with 

the solution. These tools can be run from ArcGIS Pro manually or automated on a schedule 

using Windows Task Scheduler. The Record Import Tools toolbox supports the use of database 

tables from your computer-aided dispatch (CAD) or records management system (RMS) as well 

as Microsoft Excel spreadsheets (.xlsx) or comma-separated values (.csv) files. 

For each dataset you import, you will follow a two-step process. First, create a configuration file 
for each layer, and then run the import tool using the configuration file. 

The Configure Record Import tools are used to create a configuration file (.ini) that stores 

user-defined parameters about the dataset and target layer it is loading to. There are two 
versions of the Configure Record Import tool—to determine which one to use, you must first 
identify whether the data you want to load is using address information or x,y coordinates 
(longitude and latitude). 

• If your dataset already has x,y data, create a configuration file based on x,y 
coordinates using the Configure Record Import (XY) tool. 

• If your dataset only has addresses, create a configuration file based on addresses 
using the Configure Record Import (Addresses) tool. 

Once you have created a configuration file based on x,y coordinates or addresses, use the 

Record Import Tools to update the layer or feature class. 

Note: 

The Record Import tool can be run manually using the script tool in the Record Import Tools 
toolbox, or it can be run automatically using Windows Task Scheduler. 

Download the Record Import Tools toolbox 
To begin this workflow, follow the instructions to download and unzip the Record Import Tools 

toolbox. 

1. In a browser, go to the toolbox item that was deployed to your content section of 
your ArcGIS organization, and click download to download the zipped folder 
containing the toolbox. 

  Note: 

  If you deployed the solution on ArcGIS Enterprise, you need to download the toolbox 
separately. 
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2. Extract the Record Import Tools toolbox and add it to a new ArcGIS Pro project. 

Create a configuration file based on x,y coordinates 
The Configure Record Import (XY) tool creates a configuration file that is used when executing 

the Import Records tool. The configuration file stores unique information that is used by the 

Import Records tool to load from a table or spreadsheet into a feature class or a web layer. 

To create a configuration file, complete the following steps: 

1. In ArcGIS Pro, browse to the RecordImport.tbx file, open the Configure Record 
Import (XY) tool, and fill in the following parameters: 

  Parameter 
  Input 

  Configuration file 
name  

  Type the name for your configuration file. 

  Source Table   Browse to the incident file containing the data to be 
mapped. 

  Target Features    Browse to your incident feature class or web layer. 

  Portal URL   Add your ArcGIS Online organization or ArcGIS Enterprise 
portal URL. 

  Username   Type your user name. 

  Password   Type your password for the user name you provided. 

  Log File Directory   Browse to a directory to store the import records log files 
generated by the Import Records tool. 

  Summary Field   Provide a field from the source table containing values by 
which the records can be summarized. 

  Record Identifier 
Field 

  Choose a field containing a unique identifier value. 

  Record Date Field   Choose a date field containing the date the record occurred 
or was reported. 

  Delete Duplicates   Check this parameter to ensure duplicate records are 
deleted. 
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  X Coordinate Field 
(Longitude) 

  Choose the field from the source table that represents the 
x-coordinate (decimal degrees or easting). 

  Y Coordinate Field 
(Latitude) 

  Choose the field from the source table that represents the 
y-coordinate (decimal degrees or northing). 

  Source Table 
Coordinate System 

  Choose the coordinate system used in the source table 
that represents the x,y coordinates. 

  Ignore Blank 
Coordinate System 

  Check this box to ignore the coordinate pair value 0,0 from 
being imported into the target features. 

  Schema Mapping 
Type 

  Choose Source Table Schema Matches Table if your 
schema matches the target features or Use Field Mapping 
if they are not the same. 

  Field Mapping   Choose the fields from the source table that contain 
information to preserve in the target features. 

  Target Field   Choose fields from the target features that correspond to 
the field in the source table. 

  Note: 

  Source and target information for the fields specified in the Record identifier field, 
Record Date Field, X Coordinate Field, and Y Coordinate Field parameters are 
required. 

  Tip: 

  If the Source Table parameter contains dates formatted as strings, you need to update 
the Timestamp Format parameter to define the original time and date format. For more 
information, see Python strftime. 

2. Run the tool to build a configuration file containing these parameter values. 

3. Once you have created a configuration file based on x,y coordinates, use the 
Configure Record Import to update the web layer or feature class. 

 

Create a configuration file based on addresses 
The Configure Record Import (Addresses) tool creates a configuration file that is used when 

executing the Import Records tool. The configuration file stores unique information that is used 

to import records from a table or spreadsheet into a feature class or a web layer. 
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To create a configuration file, complete the following steps: 

1. In ArcGIS Pro, browse to the RecordImport.tbx file, open the Configure Record 
Import (XY) tool, and fill in the following parameters: 

  Parameter 
  Input 

  Configuration 
file name  

  Type the name for your configuration file. 

  Source Table   Browse to the incident file containing the data to be mapped. 

  Target Features    Browse to your incident feature class or web layer. 

  Portal URL   Add your ArcGIS Online organization or ArcGIS Enterprise 
portal URL. 

  Username   Type your user name. 

  Password   Type your password for the user name you provided. 

  Log File 
Directory 

  Browse to a directory to store the import records log files 
generated by the Import Records tool. 

  Summary Field   Provide a field from the source table containing values by 
which the records can be summarized. 

  Record Identifier 
Field 

  Choose a field containing a unique identifier value. 

  Record Date 
Field 

  Choose a date field containing the date the record occurred or 
was reported. 

  Delete 
Duplicates 

  Check this parameter to ensure duplicate records are deleted. 

  Street Address 
Field 

  Choose the field from the source table with the street address, 
for example, 123 Main Street, or full address, for example, 123 
Main Street, Naperville, IL. 

  City Field   Choose the field from the source table with the name of the 
city, town, or village. 

  State Field   Choose the field from the source table with the state or 
province name. 
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  ZIP Field   Choose the field from the source table with the ZIP Code or 
postal code. 

  Address Locator   Choose the ArcGIS World Geocoding Service, your locator 
service, or browse to an Address locator file. 

  Schema Mapping 
Type 

  Choose Source Table Schema Matches Table if your schema 
matches the target features or Use Field Mapping if they are 
not the same. 

  Field Mapping   Choose the fields from the source table that contain information 
to preserve in the target features. 

  Target Field   Choose fields from the target features that correspond to the 
field in the source table. 

  Note: 

  If the configuration file from this tool references the ArcGIS World Geocoding Routing 
Service in the Address Locator parameter, this configuration will consume credits when 
it is run in the Record Import Tools . The credit consumption rate is the same as the 
Geocode Addresses tool. For more information, see Geocode Addresses in the System 
tool chart. 

  Tip: 

  If the Source Table parameter contains dates formatted as strings, you need to update 
the Timestamp Format parameter to define the original time and date format. For more 
information, see Python strftime. 

2. Run the tool to build a configuration file containing these parameter values. 

3. Once you have created a configuration file based on addresses, use the Record 
Import Tools to update the web layer or feature class. 

Run the Import Records tool 
The Record Import Tools use the configuration file created from the Configure Record Import 

(XY) or Configure Record Import (Addresses) tools. Run the Import Records tool in ArcGIS Pro 

the first time you use this tool to verify it runs successfully. 

To import records, complete the following steps: 

1. In ArcGIS Pro, browse to the location of the RecordImport.tbx toolset and open the 
Record Import Tools tool. 

2. In the Configuration file parameter, browse to the location of the configuration file 
created by the Configure Record Import (XY) or Configure Record Import 
(Addresses), and click OK. 
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3. Click Run to run the tool. 

Note: 

To update your incident layer on a regular interval basis, you can use the Import Records 
tool (import_records.py) with Task Scheduler to automate import updates. 

Automate Record Import Tools 
You can use the Record Import Tools (import_records.py) with Microsoft Windows Task 

Scheduler to update incident layers on a regular interval. Scheduled updates ensure users have 

access to current information to support more dynamic decision making. 

To update incident data on a schedule, complete the following steps: 

1. Open Task Scheduler. 

  Note: 

  Use the Windows Start menu search box to find Task Scheduler. 

2. Click Action, click Create Task, and name your task. 

3. Click the Actions tab and click New. 

4. Set Action to Start a Program. 

5. Browse to the location of your Python installation (for example, <default 
directory>\Program Files\ArcGIS\Pro\bin\Python\envs\arcgispro-
py3\python.exe). 

6. In the Add arguments text box, type the name of the script, import_records.py, 

followed by the path of the configuration file in double quotation marks. 

  Note: 

  Ensure that you have double quotation marks around the configuration file path but not 
around the script name, for example, import_records.py 

"C:\recordimports\scripts\records.ini". 

7. In the Start in text box, type the path of the folder hosting your script and click OK. 

8. On the Trigger tab, click New and set a schedule for your task, and click OK. 

Log file reports 
The Record Import Tools create a series of reports designed to help you understand any errors 

that occurred while processing your data. Each time the tools are run, a new set of reports are 

created and identified by the date and time. 

Note: 

The content of each import records report will vary based on your data and the 
configuration parameters. You can find the reports in the log file directory you specified 
when running the Configure Record Import (XY) or Configure Record Import (Addresses) 
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tool. The path to these reports can also be found in the Geoprocessing Results window 
after running the Import Records script tool. 

Log file contents 
The log file header includes basic envelope information about the processes that ran, including 

the user name that ran the tool, what datasets were used, and the locator that was used (if the 

data was geolocated). 

The body of the log file includes reports and notes printed by the tool as the records were 
processed. As each stage of the tool begins, a time stamp and brief message are printed. The 
tool also reports the numbers of records that were successfully and unsuccessfully processed 
after completing many of the major processes. When records cause problems (for example, a 
record that was not successfully geocoded), they are removed from processing and are written 
out to another report. A note is printed in the log file stating the number of records that were not 
successfully processed, and in which report they can be found. 

Note: 

The tool copies the records from the source table into a temporary geodatabase table. 
Problem records are removed from this table—not the source table. 

The configuration includes an option to print a summary of the processed data. If a summary 
field is provided, this summary also appears in the configuration file. For example, summarizing 
the data by report date or an administrative boundary can indicate days or areas that may have 
missing reports. 

Unmatched report 
The Unmatched report is only created when the data was located using the ADDRESSES 

location type. This report contains all records that did not meet two criteria: 

• Geocoded with a Status value of M (matched) or T(tied) 

• Geocoded with an Addr_type value of AddrPoint, StreetAddr, BldgName, Place, POI, 
Intersection, 

  PointAddress, StreetAddress, StreetInt, or StreetAddressExt 

Records may not meet these criteria for many reasons. To help troubleshoot these issues, 

records in this report contain all fields from the attempted geocoding (Loc_name, Shape, Status, 

Score, Match_type, Match_addr, Side, User_fld, Addr_type, ARC_Street, ARC_City, and 

ARC_ZIP) as well as all fields from the original record. Use these values to determine why 

records were not successfully processed and resolve the issues. 

For more information, see Geocode a table of addresses. 

First, identify why the record was written to this report. Look at the value in the Status column. 

• Records with M failed the second criteria: they were geocoded, but not to a scale 
conducive to incident mapping, likely to the city or ZIP Code level. 

• Records with T (tied) had multiple options that were viewed by the locator as 
equally probable. There is likely some address information missing or slightly 
incorrect that is creating ambiguity for the locator. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://pro.arcgis.com/en/pro-app/2.8/help/data/geocoding/tutorial-geocode-a-table-of-addresses.htm#GUID-E11F8070-A11C-403F-82E9-F504D6549CC7


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 369 

• Records with U (unmatched) were unable to be geocoded to an acceptable 
probability level. This probability threshold is set in the locator properties and is 
often near 80 percent. 

Next, resolve the issue. You can make the necessary changes to the original report, get a 

corrected report from the data source, or make the necessary changes directly in the 

Unmatched report and reprocess the records using the same workflow and this report as the 

input spreadsheet. 

• Confirm that the address is complete. 

Whether the full address was contained in a single field (for example, FULLADDR) or spread 

across several fields (for example, FULLADDR, CITY, STATE, or ZIP), verify that the level of 

information provided matched your locator. Your local locator may be able to handle a house 

number and street name, but that isn't enough information to get a good result from the World 

Geocoding Service. Provide as much information as possible to get the best results from the 

locator. 

• Confirm that the address is correct. 

Many locators require at least an 80 percent match. Verify that the provided values are spelled 

correctly, house number values are reasonable for the range of the road, and the address falls 

within the provided city, state, and ZIP Code. 

• Confirm that the address falls within the range of your locator. 

Locators do not always cover all addresses. Private roads and new developments may not exist 

in the locator yet, or the record may fall outside the extents of your locator. In these cases, try 

another locator, or get the coordinates for the location of the record and process the record or 

records using the Configure Record Import (XY) and Configure Record Import (Addresses) 

tools. 

Once the corrections are made, reprocess the report. You can use the Delete Duplicates 
option to ensure that records are not added to the target features. 

To stop excluding results from processing, or to modify the Status or Addr_type values that are 
acceptable for your data, you can edit the Python script import_records.py that are found in the 
same directory as the ImportRecords.tbx file. 

Near the top of the script is a section titled Accepted levels of geolocation. The section contains 
two list variables: addrOK and match_value. Both lists must contain at least one value enclosed 
in quotation marks. Add, remove, or modify the values as long as the following are true: 

• Each list is enclosed in a single pair of square brackets. 

• Each item is enclosed in a single pair of quotation marks. 

• Multiple items are separated with a comma. 

For example, allow the tool to only process results with a status of "M" by changing the value as 

follows: 

• match_value = ["M","T"] to match_value = ["M"] 

Change the address locator 
The Record Import Tools are configured to use the ArcGIS World Geocoding Service available 

with all organizational accounts but can also be configured to use your own locator or geocoding 

service. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 370 

To use your own locator, complete the following steps: 

1. Browse to the location of the Record Import Tools and create a backup copy of the 
import_records.py script. 

2. Open the import_records.py script in a Python editor or a text editor. 

3. Search for the first occurrence of all_locator_fields.  

Parameter Input 

all_locator_fields These are the input address fields that the locator may use to identify the 
geography of an address. 

For a locator file (*.loc), these values can typically be found in the locator 

properties. The Input fields section contains a list of expected input address 
fields. If you are using a geocoding service, the expected input address 
fields are found on the service REST page under the Address Fields 
section. List the values in the same order they appear in the locator 
properties. 

loc_address_field The input address field that the locator expects to contain, at minimum, the 
address number and street name of the address. For single-line geocoding, 
this field may also contain the complete address. This input address field is 
typically named Street or Address. 

This value must also exist in the all_locator_fields list. 

loc_city_field The input address field that the locator expects to contain the city name. 
This input address field is typically named City. For single-line geocoding, 
use empty quotes for this value; otherwise, this value must also be included 
in the all_locator_fields list. 

loc_zip_field The input address field that the locator expects to contain the ZIP Code or 
postal code. This input address field is typically named ZIP or Postal. For 
single line-geocoding, use empty quotes for this value; otherwise, this value 
must also be included in the all_locator_fields list. 

loc_state_field The input address field that the locator expects to contain the state or 
province name or code. This input address field is typically named State, 
Province, or Region. For single-line geocoding, use empty quotes for this 
value; otherwise, this value must also be included in the all_locator_fields 
list. 

Remove or modify dashboard elements 
When loading data from your RMS or CAD system into the layers of the Fire Incident 

Dashboard, you may find that your source data does not contain specific fields used in the filters 

or charts. You can configure the Fire Incident Dashboard to point to different fields or delete it 

entirely as the schema of your data necessitates. See Configure an element in ArcGIS 

Dashboards for more information. 
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Use Fire Incident Dashboard 
The Fire Incident Dashboard solution delivers a set of capabilities that help you source incident 

records from computer-aided dispatch or records management systems, visualize fire and EMS 

incidents, and monitor trends or patterns. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

Understand recent trends 
In this topic, you’ll assume the role of a fire chief who will use the Fire Incident Dashboard to 

explore response times to citywide fire incidents in the last 30 days, examine response-time 

performance on EMS calls year-to-date, and compare fire response times by station. 

Explore response times to incidents 
Follow these steps to examine the fire department’s overall response-time performance. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Fire 
Incident Dashboard solution.  

2. View the Fire Incident Dashboard app. 

3. On the left, in the filter panel, click the Call Date drop-down list and choose Last 30 
days. 

  The map filters to display all citywide fire incidents from the past 30 days. 

4. On the right, review each gauge element for average turnout time, average travel 
time, and average total response time. 

  Note: 

  Values in the green range are within or below the acceptable range for that metric. 
Values in the red range are outside of the acceptable range for that metric. The National 
Fire Protection Association (NFPA) standard is shown below each corresponding gauge. 
For example the, NFPA standard average turnout time is 80 seconds. If the gauge 
shows that the citywide average turnout time is 1.1 minutes, or 70 seconds, citywide 
average turnout is barely acceptable because the standard average turnout time for 
incidents must be 80 seconds or fewer. 

5. On the map, click any incident. 

  In the top-left corner of the map, a pop-up appears. It displays key facts about the incident, 
including which unit and shift responded, the incident type, the unit's response times, and 
the incident location. 

6. Below the map, review the chart. 

  The chart displays the number of incident responses by each fire station and unit. You 
have already filtered for the last 30 days, so the chart shows which fire stations had the 
most responses in that time period. 

7. In the chart, click the blue bar for one of the fire stations. 
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  The map and gauges update to show only that fire station's incident responses and 
response times. 

8. In the chart, click the blue bar again to deselect the fire station. 

9. On the left, in the filter panel, click the Call Date drop-down list and choose All to 
clear the date filter. 

  Note: 

  You can apply as many filters as you want. The filters continue to narrow the number of 
incidents displayed on the map based on the parameters that you specify. To cancel a 
filter, click any filter and select All. 

Examine response-time performance by call type 
Response-time performance varies depending on the type of unit responding to the call. You 

can filter the calls by type to get a more accurate assessment of response-time performance. 

Follow these steps to examine response-time performance by call type. 

1. On the left, in the filter panel, click the Call Type drop-down list and choose EMS 
and Rescue. 

2. Click the Call Date drop-down list and choose Year to date. 

  The map updates to show only citywide EMS calls year to date. 

3. On the right, review the gauges to determine if the average response times are 
within appropriate ranges. 

4. In the Responses by Station and Unit chart, click the bar for one of the fire 
stations, and then review that station's EMS-incident response time. 

5. Click the bar again to deselect that fire station. 

6. Follow these steps to review each station's EMS-incident response time. 

7. Reset all filters to All. 

Compare fire response times by fire station 
Response-time performance may vary depending on the station or unit responding. You can 

compare response time using the station and call-type filters. 

Follow these steps to examine the response-time performance for each station. 

1. On the left, in the filter panel, select a fire station. 

  The map and gauge elements filter to reflect only the incidents that the selected fire station 
responded to. Filtering for a single fire station allows you to review the incident types that 
the fire station responded to so that you can determine if future calls can be covered by 
another station. 

2. Click the Call Type drop-down list and choose each call type one at a time, noticing 
the differences in response-type performance for each call type. 

3. After you finish, reset all filters to All. 

4. Repeat this process with the incidents in other fire stations to make help you make 
a data-driven decision on each station’s performance. 
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Introduction to Fire Safety Survey 
Fire Safety Survey can be used to conduct residential dwelling fire safety surveys that are part 

of a community’s risk reduction program. 

It provides fire service agencies with a comprehensive inventory of dwellings that have been 
surveyed and any fire safety issues discovered during an inspection. Fire service agencies can 
use the inventory to prioritize inspection activities. This approach reduces staff time necessary 
to perform safety inspections and ultimately increases the effectiveness of risk reduction 
programs. Fire Safety Survey is typically implemented by fire service agencies that want to take 
a data-driven approach to risk reduction and safety programming. 

The Fire Safety Survey solution delivers a set of capabilities that help you perform fire safety 
surveys and monitor the progress of firefighters performing routine fire safety surveys. 

Deploy now 
This ArcGIS Solution can be deployed in your ArcGIS organization. 

See Deploy an ArcGIS Solution for more information. 

Requirements 
Fire Safety Survey requires the following: 

• ArcGIS Enterprise 

• ArcGIS Field Maps 

Information products 
Fire Safety Survey includes the following information products. 

Item Description 
Minimum 
user type 

Fire Safety 
Survey 
Dashboard 

An ArcGIS Dashboards app used by fire personnel to 
monitor fire safety surveys occurring in a community 

Viewer 

Fire Safety 
Survey 

An ArcGIS Field Maps web map used by fire personnel to 
conduct dwelling fire safety surveys that are part of a 
community’s risk reduction program 

Fieldworker 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 
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1.0 • First release of Fire Safety Survey 

Configure Fire Safety Survey 
The Fire Safety Survey can be used by fire personnel to conduct and monitor dwelling fire 

safety surveys that are part of a community’s risk reduction program. Some agencies may want 

to perform additional configuration of the solution to meet their organizational needs. In this 

topic, you will learn how to modify questions in the Fire Safety Survey and how to incorporate 

additional filters to the Fire Safety Survey Dashboard. 

Modify Fire Safety Survey 
The Fire Safety Survey map for ArcGIS Field Maps is used by firefighters to perform fire safety 

surveys while inspecting a dwelling. To adjust the survey to the needs of your risk reduction 

program, add or delete fields from the FireSafetySurveys layer. Fire Safety Survey dashboard 

leverages a feature layer view that you must also update to reflect field changes. 

Add new survey question 
To add one or more fields to the FireSafetySurveys layer, complete the following steps: 

1. Sign in to your ArcGIS Online organization and click Content, if necessary. 

2. On the My Content tab, type firesafety in the search box. 

3. Click the Feature Layer item titled FireSafetySurveys. 

4. Click the Data tab. 

5. Click the Fields toggle button. 

6. Click the Add button to create a field. 

7. Define the Field Name, Display Name, Field Type, and Length, and click Add New 
Field. 

8. Follow the Update feature layer view section below to update your feature layer 
view to reflect the changes made to the layer. 

 

Delete survey question 
To delete one or more fields from the FireSafetySurveys layer, complete the following steps: 

1. Sign in to your ArcGIS Online organization and click Content, if necessary. 

2. On the My Content tab, type firesafety in the search box. 

3. Click the FireSafetySurveys feature layer item and click the Data tab. 

4. Click the check box next to the display name of the fields to delete. 

5. Click the Delete button above and to the right of the field list. 

6. Follow the Update feature layer view section below to update your feature layer 
view to reflect the changes made to the layer. 
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Update feature layer view 
To update the feature layer view to reflect field changes you have made by adding or deleting a 

field, complete the following steps: 

1. Browse to the FireSafetySurveys_dashboard feature layer view item. 

2. Click Visualization 

3. Click the More Options button on the layer, click Set View Definition, and select 
the Define Fields option. 

4. Scroll to the newly created fields and check the boxes. 

5. Click Apply. 

  The new fields are now added to the view’s definition and are visible in the Fire Safety 
Survey Dashboard. 

Use Fire Safety Survey 
The Fire Safety Survey solution delivers a set of capabilities that help you perform fire safety 

surveys and monitor the progress of firefighters performing routine fire safety surveys. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

Conduct Fire Safety Survey 
Fire Safety Survey allows firefighters in the field to conduct fire safety surveys of dwellings using 

a smartphone or tablet. 

In this workflow, you’ll learn how to use the Fire Safety Survey map in ArcGIS Field Maps to 
document a fire safety survey during a dwelling inspection. You will assume the role of a 
firefighter. You are asked to use the ArcGIS Field Maps mobile app to access your Fire Safety 
Survey map and document fire safety inspections you perform in the field. 

1. If necessary, download ArcGIS Field Maps onto your mobile device. 

2. On your mobile device, open the app, and then sign in to your ArcGIS organization. 

3. Tap Fire Safety Survey to open the map. 

4. Search for an address, and then, in the results list, tap the address to zoom to that 
location on the map. 

5. Tap the plus sign or Collect Here to open the survey form.  

  Note: 

  Your interface will vary depending on the type of mobile device that you use. 

6. Tap Yes to collect survey information. 

7. Complete the form with as much information as possible. 
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8. At the upper right, tap the check mark or Submit to submit the form. 

  If necessary, a submitted form can be edited. 

9. On the map, tap the point to open the form. 

10. At the lower left, tap Edit, and then make any necessary changes to the form. 

11. Tap the check mark or Submit to resubmit the form. 

12. At the lower right, tap More Options to see additional options. 

13. At the lower middle, tap Copy to complete another survey and add it to the map. 

Monitor Fire Safety Survey inspections 
The Fire Safety Survey Dashboard can be used by fire department personnel to monitor the 

progress of the fire safety program. It allows the viewer to see the locations where surveys were 

completed. You can also use it to find areas at risk in the community. 

You will now assume the role of fire command staff to monitor how many safety inspections 
have been completed and review the results of those surveys. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Fire 
Safety Survey solution. 

2. View the Fire Safety Survey Dashboard app. 

  On the right, in the Surveys panel, all submitted inspections are listed. At the top of the 
panel, the total number of surveys appears. 

3. On the left, use filters to refine the results by occupant type, survey status, or date. 

  When you filter results, the bar chart and number of surveys in the Surveys panel update. 

4. On the right, click an inspection address to zoom to that location on the map. 

5. Click the point on the map to open a pop-up with information collected for that 
location. 

  This information can be useful in preparing for any necessary follow-up visits. 

6. Below the map, review the chart to see the number of smoke detectors installed 
and batteries provided. 

  This information helps you to understand how many smoke detectors may be installed but 
not working correctly. 

7. On the map, close the pop-up, and then in the Surveys panel, click the inspection 
address again to reset the map. 

8. On the left, for Survey Completed, choose No. 

  No data appears in the chart area. The locations listed in the Surveys panel require follow-
up visits to complete the surveys. 

9. On the left, in the filter panel, uncheck any Occupant Type check boxes and for 
Survey Completed, click All. 

10. For Surveyed On, click the drop-down arrow and choose Between the dates. 

11. Set start and end dates to filter for all surveys completed within that time frame. 

12. Close the app. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 377 

Introduction to Fire Service Maps 
Fire Service Maps can be used to produce wall maps and run books that are placed in a fire 

station or apparatus to assist with response activities. 

Fire personnel must understand their communities and quickly respond to calls for service. 
Delayed response times could result in the loss of life and property. While maps have made 
their way on to public safety mobile data computers (MDC), two primary hardcopy maps are still 
produced for reference in the fire service. Station wall maps are generally small scale maps 
hung on the wall of each fire station to help new personnel become more familiar with the 
service area. Run Books, on the other hand, are large scale maps that include a series of map 
pages along with a street index. They are combined in to a single map book and are placed in 
each apparatus to supplement maps provided on the MDC. Having an efficient way to produce 
station wall maps or run books ensure each hardcopy map product reflects changes that may 
occur in a community. Fire Service Maps is typically implemented by fire departments that want 
to quickly produce a standard set of hardcopy maps for their community. 

The Fire Service Maps solution delivers a set of capabilities that help you produce station wall 
maps and run books for each fire response district and combine them in single map book when 
necessary. 

Deploy now 
This ArcGIS Solution can be deployed in your ArcGIS organization. 

See Deploy an ArcGIS Solution for more information. 

Requirements 
Fire Service Maps requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.7 or later 

• ReportLab 3.4.0 or later 

Information products 
Fire Service Maps includes the following information products: 

Fire 
Service 
Maps Description 

Minimum user 
type 

Fire Service 
Maps 

An ArcGIS Pro project used by fire fighters to produce wall 
maps and run books that are placed in a fire station or 
apparatus to assist with response activities. 

GIS 
Professional 
Basic 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

Release notes 
The following are the release notes: 
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Version Description 

1.0 First release of Fire Service Maps 

 

Configure Fire Service Maps 
In this workflow, you will learn how to configure the Fire Service Maps solution to meet specific 

needs in your organization. 

Configure Fire Service Maps project 
The Fire Service Maps solution includes an ArcGIS Pro project and sample data you can use to 

explore the sample data schema and a set of tools. When you are ready to configure the 

project, a series of tasks are included to help you review the data, make modifications to the 

maps and layers, load your data, and set the data sources to your data. 

1. Start ArcGIS Pro and open the Fire Service Maps project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Fire Service 
Maps task item. 

4. In the Task Pane, click the Configure Fire Service Maps task group to expand the 
collection of tasks. 

Review schema 
The Fire Service Maps project contains two geodatabases. 

• Fire Service Maps Sample.gdb contains sample data for learning how to use the 
tools. 

• Fire Service Maps.gdb contains empty layers fields that can be used to create Fire 
Run Books and Fire Station Wall Maps with your data. 

Use this task to review the geodatabase schema, layers, and fields to determine what changes 

you will need to make to use your data. See Fields, domains, and subtypes to learn more about 

how to edit the feature layer schema. 

 

Define spatial reference 
The Fire Service Maps.gdb is an empty geodatabase with the same schema and a spatial 

reference set to Web Mercator. This geodatabase can be used to define your spatial reference 

and load your data. 

Use this task to define the spatial reference for your data. See Specify a coordinate system to 
learn more about coordinate systems for your data. 

Load data 
After you have completed any necessary schema modifications, you can add your data layers to 

the map and load them into the empty Fire Service Maps geodatabase by following the steps in 

the Load data task. This task contains steps to load your data into the following layers: 
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Layer name Description 

Site Addresses Used to label building addresses in the fire service maps 

Roads Used to label road names and address ranges along a road. It is also 
used to create the street index report. 

Fire Response 
Restrictions 

Used to display the location of access restrictions such as gates, narrow 
roads, and blocked roads that would delay or preclude a fire truck in 
response to an incident 

Fire Map Index Used to create individual pages in Fire Run Books 

Response Areas Used to display administrative and response districts 

As you load your data into each layer, you will be given the option to use the field map 
capabilities to map your data fields to the predefined fields in the empty feature layers. 

Set data sources 
Use this task to replace the sample data with your data for each layer in the Fire Service Maps 

project. 

Use Fire Service Maps 
The Fire Service Maps solution delivers a set of capabilities that help you produce station wall 

maps and run books for each fire response district and combine them in single map book when 

necessary. Fire Station Wall Maps can be produced for individual fire stations or combined into 

a single station wall map. Run books can also be produced for individual fire stations or 

combined into a single run book for the entire fire department. 

In this topic, you’ll learn how to use the Fire Service Maps solution by assuming the role of the 
user and performing these workflows. 

Understand Fire Service Maps 
While maps have made their way on to public safety mobile data computers (MDC), two primary 

hardcopy maps are still produced for reference in the fire service. Station wall maps are 

generally small scale maps hung on the wall of each fire station to help new personnel become 

more familiar with the service area. Run Books, on the other hand, are large scale maps that 

include a series of map pages along with a street index. They are combined in to a single map 

book and are placed in each apparatus to supplement maps provided on the MDC. 

To learn more about the elements contained in each fire service map, follow these steps: 

1. Sign in to your ArcGIS organization and browse to the Fire Service Maps Desktop 
Application Template. 

2. Open the item page and click Download. 

3.  Unzip and open the Fire Service Maps ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Fire Service 
Maps task item. 

6. In the Task Pane, click the Getting to know Fire Service Maps task group to 
expand the collection of tasks. 
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7. Click on the Understand Fire Service Maps task and follow the steps provided. 

Install ReportLab 
ReportLab is a third-party Python library that can be used to create a street index in PDF format. 

The street index makes it easy to look up an address or street name and find the correct map 

page in a Fire Run Book. To install ReportLab, follow these steps: 

1.  Open the Fire Service Maps ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Fire Service 
Maps task item. 

4. In the Task Pane, click the Getting to know Fire Service Maps task group to 
expand the collection of tasks. 

5. Click on the Install Report Lab task and follow the steps provided. 

Create fire run book 
Fire Run Books include a cover page, several map pages, and a street index for each fire 

response district. They can be printed, placed in each apparatus, and used en-route to a call. 

You will assume the role of a fire fighter responsible for producing a fire run book for your 
response district or fire department. The Fire Service Maps ArcGIS Pro project includes a series 
of tasks to help guide you through this workflow. 

1.  Open the Fire Service Maps ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Fire Service 
Maps task item. 

4. In the Task Pane, click the Create fire run book task group to expand the 
collection of tasks. 

5. Click on the Create cover page task. Follow the steps provided in this task and all 
subsequent ones. 

Create station wall map 
Station Wall Map are large-format wall maps that can be printed for each fire response area and 

hung near an engine or apparatus. The printed wall maps are used by fire personnel for route 

navigation before leaving the station. 

You will assume the role of a fire fighter responsible for producing a station wall map for your 
response district. The Fire Service Maps ArcGIS Pro project includes a series of tasks to help 
guide you through this workflow. 

1.  Open the Fire Service Maps ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Fire Service 
Maps task item. 

4. In the Task Pane, click the Create station wall map task group to expand the 
collection of tasks. 

5. Click on the Create station wall map task. Follow the steps provided in this task 
and all subsequent ones. 
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Introduction to Flood Impact Analysis 
Flood Impact Analysis can be used to develop localized flooding scenarios and visualize the 

impact of flooding on public infrastructure, critical facilities, and vulnerable populations. 

The solution allows you to understand and visualize the impact of flooding on the community by 
using flood depth and elevation data to analyze the impact of river flooding, storm surge, tidal 
surge, and sea level rise scenarios. The results of the analysis can be used to plan road 
closures, prioritize evacuation areas, and develop mitigation strategies. Flood Impact Analysis is 
typically implemented by emergency management, public works, and planning organizations 
that want to prepare for future flooding to protect their communities. 

The Flood Impact Analysis solution allows you to prepare flood depth and elevation data, define 
flood impact areas, visualize the flood in 3D, and share the information with the public or other 
organizations. 

Deploy now 
This ArcGIS Solution can be deployed in your ArcGIS organization. 

See Deploy an ArcGIS Solution for more information. 

Requirements 
The Flood Impact Analysis solution requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.5 - 2.9 (Advanced) 

• The ArcGIS Spatial Analyst extension 

• The ArcGIS 3D Analyst extension 

Information products 
Flood Impact Analysis includes the following information products: 

Item Description 
Minimum User 
Type 

FloodImpactAnalysis.ppkx An ArcGIS Pro project package used by 
mapping technicians to create flood impact 
maps 

GIS Professional 
Advanced 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Flood Impact Analysis 
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Use Flood Impact Analysis 
The Flood Impact Analysis solution delivers a set of capabilities that help you to prepare flood 

depth and elevation data, define flood impact areas, visualize the flood in 3D, and share the 

information with the public or other organizations. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Get to know Flood Impact Analysis 
You will assume the role of a mapping technician responsible for analyzing the potential flood 

impact for your community. The Flood Impact Analysis ArcGIS Pro project includes a series of 

tasks to help guide you through these workflows. The first set of tasks will help you get to know 

Flood Impact Analysis. 

Get to know Flood Impact Analysis by completing the following steps: 

1. Start ArcGIS Pro and open the Flood Impact Analysis project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Getting to 
know Flood Impact Analysis  task and go through each subtask. 

Understand the Flood Impact Analysis solution 
Flood Impact Analysis supports a series of workflows that streamline the process of developing 

flooding scenarios to help plan for a flood event. These workflows include preparing the data for 

analysis, defining the flood impact area and the impact on infrastructure, facilities and buildings, 

sharing the flood impact information, visualizing the flood impact in 3D, and sharing the impact 

in 3D. 

This task will introduce you to the capabilities, data requirements to analyze flood impact, and 
visualization in 3D. 

Download sample data 
Sample data is provided to help you learn how to use the Flood Impact Analysis solution. A link 

is provided to download sample data for Baltimore. Using the sample data the first time will help 

you learn how to use the tasks and how to organize your data. 

Start using Flood Impact Analysis 
The Flood Impact Analysis project includes a task workflow that provides a structured sequence 

using tasks and steps. Follow the steps in this task to learn how to use the Flood Impact 

Analysis solution. 

How to use Flood Impact Analysis 
You will assume the role of a mapping technician responsible for creating the flood impact 

analysis and sharing the results with emergency management, public works, and planning 

agencies. The Flood Impact Analysis ArcGIS Pro project includes a series of tasks to help guide 

you through the workflows below. 

To conduct the flood impact analysis, complete the following steps: 

1. Start ArcGIS Pro and open the Flood Impact Analysis project. 
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2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the How to use 
Flood Impact Analysis task. 

4. In the Task Pane, click the How to use Flood Impact Analysis task group to 
expand the collection of tasks. 

5. Follow the steps in each task. 

Prepare flood depth and elevation data 
Accurate analysis and visualization of the flood impact analysis will depend on several factors 

such as: availability of flood depth data in the form of raster, ground elevation data such as 

Digital Terrain Model (DTM) or lidar, and features describing the assets to be analyzed such as 

roads, bridges, and buildings. The data preparation workflow includes a series of tasks to help 

prepare the data for analysis. A description for each task in this group is listed below. 

Prepare flood depth rasters 
Flood depth data is necessary to determine flood impact to the community at each flood stage. 

Flood depth grids or raster files contain a flood depth value within each cell in the raster. Flood 

depth at a given point can help determine the impact to buildings, roads, or bridges. 

The risk value for each raster is read from the riskTypeTable for the chosen risk type. You can 
find the riskTypeTable in the FloodImpactAnalysis.gdb. You can use the existing risk types, 
modify them, or you can add another entry. 

To remove negative values, extract flooded areas, and create the flood depth geodatabase, 
follow the steps in the Prepare flood depth rasters task. 

Prepare a water surface elevation raster 
Water surface elevation (WSE) includes a value within each raster grid cell. However, the value 

describes the elevation of the water surface within each grid cell and is a measurement from a 

fixed zero elevation such as provided in the NAVD88 vertical datum. Water surface elevation 

data can be used to calculate bridge heights above flood stages and to visualize the flood 

stages as 3D surfaces. 

To create a water surface elevation raster, extract flooded areas, and crate the water surface 
elevation input geodatabase, follow the steps in the Prepare water surface elevation raster 
task. 

Define flood impact 
Effective flood response planning begins with a better understanding of the potential flood 

impact. This task is designed to step through a standardized process to create and analyze the 

impact of each flood scenario on your community. A flood scenario can be defined in the risk 

type table as a percent chance of flooding, historical average such as 100 year, or number of 

feet above normal. A description for each task in this group is listed below. 

Create flood impact areas 
The flood impact area defines the geographic extent for each flood depth scenario. The flood 

depth data prepared in the Prepare flood depth and elevation data task group will be used to 

create the flood impact area. These flood impact areas will be the foundation for analyzing 

impact to buildings, roads, or bridges in each of the subsequent tasks. 
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To create flood impact areas and add them to the map, follow the steps in the Create flood 
impact areas task. 

Analyze roads 
This task allows you to analyze impacted roads by calculating depth of flooding for each road 

segment for any number of flood levels. The flooded roads can be an impediment to successful 

evacuations for first responders and community members when it is unknown which roads will 

be impacted. You can also symbolize the impacted roads for each flood impact area. The result 

will be a new feature class representing road segments with a depth attribute for each flood 

scenario. 

To analyze impacted roads and symbolize the impact, follow the steps in the Analyze roads 
task. 

Analyze low water crossings 
This task allows you to calculate depth of flooding for each low-level crossing for each flood 

scenario. The result can be used to identify watch points for observers to report flood depth 

during the flooding event. The parameters for this step are similar to the road flood depth except 

for the buffer distance. If this distance is specified to be greater than zero, the analysis will run 

against the buffered input features. This parameter helps you find points within the buffer 

distance that have been misplaced. You can then symbolize the low-level crossings by flood 

depth. 

To identify low water crossings and symbolize the impact, follow the steps in the Analyze low 
water crossings task. 

Analyze bridges 
Use this task to calculate the bridge height above flood water surface for each flood scenario. 

Some bridges may have one side that is lower than the other. The bridge geometry is needed to 

calculate the height above the water surface instead of a single point along the bridge. 

Therefore, the bridge needs to be a 3D polygon feature instead of a 2D feature. This task will 

extract bridge surfaces from a lidar point cloud as 3D polygons, so they can be used in the next 

task to determine the height above flood level. 

Note: 

This task requires lidar point data stored in a LAS dataset . The bridge surfaces must have 
a separate class code in the LAS dataset. 

Note: 

This task requires that you have a water surface elevation (WSE) geodatabase as 
described in the Prepare flood depth and elevation data task. 

Tip: 

The result of this task is a new point feature with the minimum height above water surface 
for each water level in the WSE geodatabase. You can label the point with the minimum 
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height attribute value to show how much clearance there will be below the bridge or how 
deep the water will be over the bridge if the height above water has a negative value. 

To analyze impacted bridges and symbolize the impact, follow the steps in the Analyze bridges 
task. 

 

Analyze buildings 
Understanding building exposure to flooding can help response personnel prioritize evacuations 

and stage equipment where it can be used effectively. It can also help mitigation planners 

understand buildings that are good candidates for purchase and removal. Use this task to 

calculate flood exposure on building polygons or 3D building multipatch feature layers. The tool 

will use your water depth geodatabase and the specified risk type to calculate the flood depth 

exposure to each building within the flood impact area. You can then symbolize the features 

according to the calculated flood exposure attribute such as the flood depth. Using a graduated 

color ramp will allow you to illustrate the severity of the building exposure. 

To analyze impacted buildings and symbolize the impact, follow the steps in the Analyze 
buildings task. 

 

Share flood impact information (optional) 
Once the analysis is completed, share the results with community stakeholders who can use the 

information to begin flood response or mitigation planning. Use this task to choose which flood 

impact layers to share, such as the flood impact area, impacted roads, bridges, and buildings for 

each flood scenario. Share the results for each flood scenario. 

Note: 

These tasks require ArcGIS Online or ArcGIS Enterprise 10.5 or later. 

To allow others to see the results of the analysis, follow the steps in the Share flood impact 
information task. 

 

Visualize flood scenarios in 3D (optional) 
The best way to communicate the impact of a flood scenario is to show how it will impact 

homes, streets, bridges, and neighborhoods. Visualizing the flood scenario in a 3D scene is a 

compelling way to communicate the potential flood impact in your community. 

Note: 

These tasks require ArcGIS Online or ArcGIS Enterprise 10.5 or later. 
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Show flood impact map in 3D 
This task allows you to convert the map containing the results of the flood impact analysis to a 

3D scene using 3D symbology and scene elevation. A digital terrain model (DTM) raster can be 

added to the 3D scene to provide a realistic scene for illustrating the impact of the flood. 

 

Create 3D flood levels from raster 
This task allows you to create 3D flood levels from raster input data. The result is a 3D version 

of the 2D raster data. For example, you may want to show a flood impact area at 5 feet against 

a building to illustrate the depth of flood on the building. 

 

Source 3D basemap data (optional) 
Visualization of 3D flood levels is more powerful when shown together with other 3D layers such 

as 3D buildings, 3D trees, and detailed elevation. Use your organization's 3D basemap to 

complement your flood impact map. If your organization does not have a 3D basemap, use 3D 

Basemaps to create your own 3D buildings, trees, and elevation surface. 

 

Create a depth elevation raster 
A depth elevation raster can improve the visualization of flood impact in 3D scenes, particularly 

in flood scenarios with very shallow flooding. Use the Create depth elevation raster task to 

create the depth elevation raster. You can repeat this task for every water surface elevation 

(WSE) raster. 

To convert the map to a 3D scene and add the depth elevation raster, follow the tasks in the 
Visualize flood scenarios in 3D task group. 

 

Publish a 3D flood impact scene (optional) 
Once the task to visualize 3D flood scenarios is completed, you can publish a 3D web scene for 

your flood impact scenarios. The 3D web scene can be shared with stakeholders who are 

responsible for flood response planning and flood mitigation planning. 

Note: 

These tasks require ArcGIS Online or ArcGIS Enterprise 10.5 or later. 

 

Publish a 3D flood impact scene 
Use this task to set the coordinate system and publish the new 3D scene to ArcGIS Online or 

your organization. 
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Share the depth elevation raster 
Use this task to share the depth elevation raster that was created previously to help improve the 

visualization of the 3D scene. 

To share the flood impact in 3D, follow the tasks in the Share 3D flood impact scene task 
group. 

After you have shared the 3D scene and depth elevation raster, you can view the results of the 
Flood Impact Analysis in a Scene Viewer in ArcGIS Online or ArcGIS Enterprise. Share the 
scene with your colleagues to help them understand the impact of local flooding on your 
community. 
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Fusion Center 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Fusion Center 
Fusion Center can be used to conduct threat mitigation on incidents affecting organizational 
assets from multiple event feeds. 

Understanding risk is achieved by using different sources of information to validate threats to 
each asset. Organizations have operators responsible for using best practices to detect, 
analyze, and alert others of any incidents that may impact the client's people, products, 
property, or brand image. These may range from extreme weather conditions, political 
instability, crime, terror, to technical failures. When a threat has been detected, the process of 
threat mitigation begins, allowing the organizational leaders to understand the steps that need to 
be taken or have been taken to remove the detected threat. Fusion Center is typically 
implemented by organizations that want to manage threats impacting business operations. 

The Fusion Center solution delivers a set of capabilities to correlate information from multiple 
event layers and assess the impact to an organization's assets such as facilities, employee 
home locations, and travelers. 

 

Requirements 
Fusion Center requires the following: 

• ArcGIS Enterprise 10.9 

• ArcGIS Pro 2.6 - 2.7 (Basic) 

Note: 

To use this solution ensure the following content and services are enabled and configured 
in ArcGIS Enterprise: GeoEnrichment Service, directions and routing utility service, Living 
Atlas content and Living Atlas subscriber content. 

 

Information products 
Fusion Center includes the following information products: 
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Item Description 
Minimum user 
type 

Dataminr Alerts 
Dashboard 

An ArcGIS Dashboards app used to visualize and 
interact with incidents from Dataminr 

Viewer 

Factal Incidents 
Dashboard 

An ArcGIS Dashboards app used to visualize and 
interact with incidents from Factal 

Viewer 

Multi Source Data 
Feeds Desktop 

An ArcGIS Pro project package used to connect 
and ingest data feeds from a variety of data 
providers 

Editor 

Facility Manager An ArcGIS Web AppBuilder app used by 
organizations to manage their facilities 

Editor 

Incident Monitor 
Dashboard 

An ArcGIS Dashboards app used to visualize 
impacted facilities 

Editor 

Incident Manager A Crowdsource Manager app used to mitigate 
threats 

Editor 

Logging Dashboard An ArcGIS Dashboards app used to display the 
status of the task running in Windows Task 
Scheduler 

Viewer 

Tactical Analysis An ArcGIS Web AppBuilder app used to create 
assessment reports based on impacted facilities 

Editor 

Fusion Center Desktop An ArcGIS Pro project package used to connect 
event layers to understand impacted facilities 

GIS Professional 
Basic 

FacilitySource An Excel document that can be used to load and 
validate an authoritative list of facilities into ArcGIS 

Not required 

 

Release notes 
The following are the release notes: 

Version Description 

1.3 • An enhancement to the Tactical Analysis app to improve performance 
and report creation. 

• An enhancement to the Incident Manager app to support email updates, 
for a single event, impacting multiple facilities at one time. 

1.2 • An update to the ArcGIS Pro project, maps and apps to simply the 
deployment of the Fusion Center solution. 

1.0 • First release of Fusion Center. 
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Configure Fusion Center 
In this topic, you will learn how to configure the Fusion Center solution to meet specific needs in 

your organization 

 

Prevent duplicate records 
To support the updating of data using the Append Data to Layer and to ensure accurate 

statistics within the information products of the solution. You'll need to add an attribute index 

which applies a unique constraint to facility_id field in the facilities layer. 

To add an unique constraint, complete the steps below: 

1. Sign in to your ArcGIS Enterprise portal. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Facilities in the search box. 

4. On the left under Folders, click the folder Fusion Center was deployed to. 

5. On the right side of the page, click Facilities to view it details. 

6. Under the Layers section, click Facilities. 

7. In the URL section , click View. 

  A new tab opens into the ArcGIS REST Service Directory for this item. 

8. In the URL bar of the browser, edit the URL with the following changes: 

a. Add the word admin between /rest/ and /services/. (For example: 
ArcGIS/rest/admin/services/facilities.) 

b. Scroll to the bottom of the page and click on Add to Definition. 

c. A window appears where you will be entering JSON to add an index to the 
layer. 

d. In the text box , copy the following: 

  { 
"indexes" : [{ 
"name" : "facility_id_Index", 
"fields" : "facility_id", 
"isAscending" : false, 
"isUnique" : true, 
"description" : "" 
}] 
} 

e. Click Add To Layer Definition to commit update. 

  The following message will appear if add was successful. {"success": true} 

9. In the browser, return to the Facilities layer tab and click on the Data tab. 

10. Click the Fields and click on Facility ID. 

  This page reveals the properties for the facility_id field. Under Settings, the Unique field is 
set to Yes. 
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Review the Fusion Center project 
The Fusion Center solution includes an ArcGIS Pro project. Before configuring the solution and 

using the workflows with your data, familiarize yourself with the contents of the Fusion Center 

Desktop project. 

To review, complete the following steps: 

1. Start ArcGIS Pro. 

  Note: 

  Ensure you are signed in to the user name where Fusion Center was deployed. 

2. In the lower left corner, click Open another project. 

3. In the left pane, under Portal, click My Content and browse to the folder where 
Fusion Center was deployed. Select Fusion Center Desktop and click OK to open. 

4. Click the View tab along the top of the ribbon. 

5. Click Tasks in the Windows group to open the Fusion Center tasks to configure, 
manage, and automate the setup and use of the Fusion Center Desktop solution. 

 

Extract the environment 
The Fusion Center solution uses the Fusion Center Desktop package to set up and configure 

the solution. In this topic, you will extract the zip file into the folder location where the ArcGIS 

Pro package was placed. 

Note: 

The workflow assumes that you have the task pane open from the Review the Fusion 
Center project workflow list above. 

Note: 

The default location for the ArcGIS Pro package is 
C:\Users\<user_name>\Documents\ArcGIS\Packages\ 

1.  Click step 1, Extract the Fusion Center Environment. 

  The group will expand in the task list. 

2. Click Extract the Fusion Center Solution Tools in the task list. 

3. Click Finish. 

  This will unzip the zip file, adding a new folder named Profiling, which will be located in the 
Fusion Center Desktop folder. You can explore in the Catalog Pane under Project > 
Folders. 
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Create an ArcGIS profile 
The Fusion Center solution will need access to your ArcGIS credentials. To create your profile 

and store that profile in Windows Credentials Manager, complete the following steps: 

Note: 

The workflow assumes that you have the task pane open from the Review the Fusion 
Center project workflow list above. 

1. Click Create An ArcGIS Profile in the task list. 

  The group will expand in the task list. 

2. Click Create ArcGIS Credential Profile in the task list. 

3. Enter the URL of your ArcGIS organization. 

4. Enter the ArcGIS user name. 

5. Enter the password. 

6. Enter the profile name that will be used to store the credentials. 

7. Click Finish. 

  When you click finish, the tool will store the credentials in Windows Credential Manager 
and update the profile script configuration file. 

   

Configure event feeds 
In this workflow, you will set the event feeds that will be used by the Fusion Center solution. 

These steps will allow the event layers to be set to enabled and updated with item IDs. 

1. Click Configure the Event Feeds in the task list. 

  The group will expand in the task list. 

2. Click Setting Event Inputs for the Configuration File in the task list. 

3. Read the overview information and click Next Step.  

4. In the drop-down menu, click Select a Section to choose an event layer and set 
that event layer to enabled if you want to have it as an input. 

  Note: 

  The configuration file has 10 event inputs with some enabled and some disabled. 
Choose each event number section and update information from each of these. 

5. Choose event section 1 or 2 to update status and item IDs for Dataminr and Factal. 

  Note: 

  If you just deployed Multi Source Data Feeds, this section should be configured with the 
proper item ids. 
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Load data 
There are a few options when loading facility data, depending on the format of your facility data. 

To load facilities data, complete the following steps: 

1. Click Load Facility Data in the task list. 

  The group will expand in the task list. 

2. There are three choices that allow the loading of facility data. 

– Validate Data and Append to a feature service 

  Note: 

  Use this option if you want to validate your facility data before importing. This 
includes ensuring unique Facility IDs. 

– Append Data 

  Note: 

  Use this option if you have facility data in a feature class and an existing hosted 
feature layer. 

– Append Data through ArcGIS Online 

  Note: 

  Use this option if you want to use the Update Data option in ArcGIS Online. 

  Once the steps have been finished, the facilities will be loaded and you can move on to 
creating geofences. 

   

Create geofences 
Once you have facilities loaded into the facility data, you can create geofences around those 

locations. 

1. Click Creating Geofenced Boundaries in the task list. 

  The group will expand in the task list. 

2. Click Create Geofence Boundaries in the task list. 

3. Read the overview in the first step on how geofences are created. Then click Run.  

4. Click the folder icon on the first input to add the facilities layer as an input. 

  Note: 

  A window will appear to allow you to add content from your ArcGIS organization. 

5. Click My Content under the portal directory. 

6. Select the folder where Fusion Center was deployed. 
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7. Select the Facilities  feature service and click Open. 

  Note: 

  This will navigate you to the layers part of the facilities layer. 

8. Select the Facilities layer and click Open.  

  Note: 

  Repeat steps 2 through 8 to add geofences to the Facility Geofence Boundary layer as 
the second input. 

9. Input a desired distance. 

10. Choose a unit of measure for the desired distance. 

 

Deploy the profiling tool 
This set of tasks will help deploy the profiling tool as a scheduled task that, at default, will run 

every three minutes. This tool will identify new incidents from event layers that intersect the 

geofence boundaries surrounding each facility. 

1. Click Deploying the Profile Tool in the task list. 

  The group will expand in the task list. 

2. Click Configuring Windows Task Scheduler in the task list. 

3. Read the overview information and click Next Step. 

4. Click Finish.  

  Note: 

  The profile tool has been deployed as a task in Windows Task Scheduler. 
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Use Fusion Center 
Fusion Center delivers a set of capabilities that allows an organization to mitigate threats to their 

organization. This is achieved by combining a variety of event layers into threat and hazard 

layers, to understand what facilities have been impacted. 

In this topic, you’ll learn how to use the Fusion Center solution by assuming the role of various 
users in the Global Security Operations Center (GSOC) and perform the following workflows. 

 

Assess the threat status 
You will assume the role of a security analyst responsible for assessing the incident impact on 

the organizational footprint. 

1. In a browser, open the Incident Monitor Dashboard. 

2. Click a facility from the Impacted Facilities list. 

  Note: 

  This will filter the list of incidents to the incidents that are affecting the selected facility. 

3. Click the Incident List tab in the lower left corner of the dashboard. 

  Note: 

  This list shows all the incidents that are affecting the facility that was selected in the 
Incident List, and the map shows only those incidents as well. 

4. Click the Incident Overview tab at the bottom of the dashboard. 

  Note: 

  The dashboard displays a complete breakdown of incidents by status Incident List, and 
the map shows only those incidents as well. 

 

Change the incident status 
When an incident has been identified as a threat to a facility, an analyst in the GSOC must 

gather information about the incident. This process is called threat mitigation. 

1. In a browser, open the Incident Monitor Dashboard. 

2. Click a facility from the Impacted Facilities list. 

  Note: 

  This will filter the list of incidents to the incidents that are affecting the selected facility. 

3. Click the Incident List tab in the lower left corner of the dashboard. 
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  Note: 

  This list shows all the incidents that are affecting the facility that was selected in the 
Incident List, and the map shows only those incidents as well. 

4. Click an incident in the Incident List to pan to the incident. 

  Note: 

  The pop-up for this incident will appear, providing more information about the incident. 

5. Click the Incident Source button in the pop-up to access the raw information from 
this event feed. 

  Note: 

  The button will open a new tab to help you understand all information about the incident. 
Close the tab when finished and return to the Incident Monitor Dashboard. 

6. Click the Triage Incident button in the incident pop-up. 

  Note: 

  The button will open the Incident Manager application in a new tab. The incident that was 
selected in the Incident Monitor Dashboard will be selected in the application. 

7. Click the edit button in the lower left quadrant to change the status of this incident 
to Under Review. 

8. Type any notes needed for others to understand the status in depth in the Notes 
section. 

9. Click the Save button. 

  Note: 

  This status change will persist in the ArcGIS system. 

 

Conduct Tactical Analysis 
Throughout the threat mitigation process, further analysis may be necessary to better 

understand the potential impact. The Tactical Analysis app can be used to glean further 

information by creating reports and visualize the extent of the incident to enhance decision 

support. 

In this workflow, you will learn how to access the Tactical Analysis app from Incident Manager 
and generate a set of reports that can be shared with key decision makers. 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 398 

Perform Tactical Analysis 

1. In a browser, open the Incident Manager application. 

2. Select either Hazards or Threats to view active incidents. 

3. Click an incident in the incident table. 

4. Click the Perform Tactical Analysis button. 

  The Tactical Analysis app opens in a separate tab that filters all active impacts based on 
the facility from the selection in Incident Manager. The Impact Summary tool on the right 
displays details on the impacted facilities. 

5. Click on one of the impacted facilities in the list. 

6. In the pop-up, click Click here to send email to Facility Administrator to open 
your default email client. 

  This email will allow reports to be shared to the facility manager. 

7. Minimize the email client and use any of the tools included in the app to share 
reports with those in your organization. 

  The section below provides additional guidance on creating reports that can be shared with 
key stakeholders. 

   

Create Infographics and Reports 
The Business Analyst tool allows you to gain social, demographic, or economic context of the 

community surrounding a facility, threat, or hazard in order to enhance decision support in 

operational response. Selecting a feature from the map enables you to generate contextual 

reports or infographics for your location of interest. 

Note: 

To use the Business Analyst widget in ArcGIS Enterprise, both the GeoEnrichment service 
and Directions and Routing service must be configured on the portal. 

Note: 

To include infographics, confirm that the required application files are installed and 
infographic starter templates are published to the portal so end users can run infographics 
from the widget. 

1. In the Impact Summary tool, select a feature from Impacted Facilities list to 
select the feature on the map. 

2. In the upper right corner, click the Business Analyst tool to open it. 

  When opened, the currently selected feature is set as the active feature for analysis. 

3. Select rings, drive time, or walk time and specify desired value to create an 
analysis area. 
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  Note: 

  If a hazard is selected, you do not need to supply a value as it will use the area extent of 
the feature. 

4. Select a type of infographic or report and click the respective Run button to 
download a report for the analysis area. 

 

Create Impact Reports 
The Understand Impact tool allows you to view information and generate reports based on the 

impacted facilities, threats, and hazards layers. 

1. In the Impact Summary tool, select a feature from Impacted Facilities list to 
select the feature on the map. 

2. In the pop-up, click the more information button in the bottom right corner to see a 
list of feature actions, and choose Set Location. 

  The Understand Impact tool opens. By default, the tool draws a 5-mile buffer around your 
selected location. 

  In an area along the bottom of the browser, displays a series of tabs displaying information 
about threats, hazards, and facilities within this area. 

3. Click the Create Report button to download the summarized information as a 
report. 

4. Click the Download button to download the information in a series of csv files. 

5. Click the Create Snapshot button to save the features within the buffer area as a 
series of standalone layers. 

 

Maintain facility information 
Facility Manager can be used by operators to maintain facility information, ad hoc areas of 

interest, and review or create geofences. 

 

Create facilities 

1. In a browser, open the Facility Manager app. 

2. In the upper right corner, click the Facility Editor tool to open it. 

3.  Click New Facility and click anywhere on the map to add a new facility feature. 

  A new window appears where you can fill in facility information. 

  Note: 

  At a minimum, a unique Facility ID and Facility Name are required. 

4. Click Save. 
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Edit an existing facility 

1. In the upper right corner, click the Facility Editor tool to open it. 

2. Select a facility from the map. 

  A new window appears where you can fill facility information. 

3. Make the desired changes and click Save. 

 

Add a new facility geofence boundary 

1. In the upper right corner, click the Facility Editor tool to open it. 

2.  Click Facility Geofence Boundary and optionally select a drawing option from the 
drop-down list. 

3. Draw a geofence around your facility of interest. 

  Note: 

  Only one geofence boundary can be drawn per facility. This boundary is used to identify 
whether a threat or hazard is within proximity. 

4. A new window appears with the attributes for the geofence feature automatically 
populated based on the facility it covers. 

  Note: 

  If the geofence covers multiple facilities, you have the option to select which attributes to 
keep. 

  The geofence is linked to the facility based on the Facility ID. Ensure that the Facility ID 
field of the geofence is populated with the facility of interest. 

5. Click Save to apply. 

 

Edit an existing facility geofence boundary 

1. In the upper right corner, click the Facility Editor tool to open it. 

2. Select a geofence from the map. 

  A new window appears where you can update the geofence attributes. Ensure Edit 
Geometry is checked if you want to update the geometry. 

  Note: 

  To create a geofence from scratch, click Delete and follow the steps for adding a new 
facility geofence boundary. 

3. Make the desired changes and click Save. 
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Gas and Pipeline Data Management for ArcGIS 

Enterprise 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Gas and Pipeline Data 

Management for ArcGIS Enterprise 
Gas and Pipeline Data Management can be used to map and manage both networked and 

linear referenced gas and pipeline asset information in a unified environment. 

The unified data management environment enables the use of both the ArcGIS Utility Network 
and ArcGIS Pipeline Referencing enabling pipeline asset management across the entirety of the 
supply chain. This solution features the Utility and Pipeline Data Model (UPDM) and includes 
common gas and pipeline data management workflows. Gas and Pipeline Data Management is 
typically implemented by vertically integrated gas utilities, and gas and hazardous liquid pipeline 
operators that want to an efficient way to manage gas and pipeline assets. 

You can use the solution's deployment framework to experience a gas and pipeline utility 
network with sample data or in a single-user environment. 

 

Requirements 
Gas and Pipeline Data Management for ArcGIS Enterprise requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.8 (Standard or Advanced) 

 

Information products 
Gas and Pipeline Data Management for ArcGIS Enterprise includes the following information 

products: 

Item Description Minimum user type 

Gas and Pipeline Data 
Management for 
ArcGIS Enterprise 

A zipped file with an ArcGIS Pro project 
package with tasks, a configured utility network 
in a file geodatabase, editor and auditor maps, 
and an asset package geodatabase 

Creator user type 
with ArcGIS Utility 
Network user type 
extension 
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When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.2 • P_Redline was z enabled to support the ArcGIS Pipeline Referencing 
capabilities 

• ManageIsDirty setting has been changed to false for all subnetworks to 

improve performance in editing and validation 

1.1 • Solution name changed from Gas and Pipeline Enterprise Data 
Management to Gas and Pipeline Data Management for ArcGIS 
Enterprise. 

• Reduced name of sequences to less than 31 characters to support 
Oracle 12.1. 

• Renamed ID Generation Attribute Rules. 
• Updated the Asset Type domain from 

Asset_Type_Structure_Vault_Boundary to 
Asset_Type_Structure_Boundary_Pipeline_Pipe_Vault. 

1.0 • The first release of Gas and Pipeline Data Management for ArcGIS 
Enterprise. 
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Use Gas and Pipeline Data Management for 

ArcGIS Enterprise 
The Gas and Pipeline Data Management for ArcGIS Enterprise solution provides a 

preconfigured utility network, maps, styles, step-by-step instructions, common data 

management workflows, and more. The tasks in the Gas and Pipeline Data Management 

project guide you through creating your own utility network using the provided schema and data 

loading options and setting up an enterprise environment. The solution also includes a data 

dictionary with descriptions of the features in the data model. 

In this topic, you will learn how to use the solution to create and manage your gas and pipeline 
utility network. 

Use the instructions in the Gas and Pipeline Data Management task to get started with the 
solution. 

1. Sign in to your ArcGIS organization and browse to the Gas and Pipeline Data 
Management for ArcGIS Enterprise V1.2 item. 

2. Open the item page and click Download. 

3. Unzip and open the downloaded Gas and Pipeline Data Management ArcGIS Pro 
project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand Tasks and double-click the task item. 

6. In the Tasks pane, click the Explore the Data Management Solution task group 
to expand the collection of tasks. 

  Tip: 

  Click each group task heading and task to view a description at the bottom of the 
Tasks pane. 

  Each task group includes instructional steps for using the solution. Begin by exploring the 
contents of the project, tracing and editing workflows with sample data, or configuring the 
solution for your organization. 

   

Explore the Data Management Solution 
The data management solution is designed for organizations that want to experience a fully 

functional gas and pipeline utility network. Explore common workflows with the sample data in 

the provided single user file utility network. Task-based workflows are also provided to create 

and model your own utility network to behave like a gas and pipeline system in an enterprise 

environment. The solution also provides preconfigured maps for sharing data and editing data. 

This task group includes the following tasks: 

• Overview 

• What's Included 

• Review the Data Model 

• Explore the Symbology and Data 
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These tasks introduce the solution and walk through exploring the capabilities of the utility 

network. 

 

Tracing and Analysis 
Tracing is a key capability of the utility network. There are several core trace configurations that 

allow you to analyze your network. 

This solution includes workflows for critical traces for gas and pipeline such as leak isolation. 
The Isolate Leak task walks through identifying a leak location and running an isolation trace to 
determine which devices need to be closed in order to isolate the leak. 

This task group includes the following tasks: 

• Isolate Leak 

 

Editing Workflows 
Users are guided through editing workflows with the provided sample data. These workflows are 

designed to showcase common tasks while highlighting the capabilities of the utility network. 

Note: 

In the Contents pane, click the List by Snapping tab. Expand all feature classes to ensure 
snapping is checked for each asset group. 

This task group includes the following tasks: 

• Add Customer Service 

• Create Cathodic Protection Zone 

• Extend Distribution Pipe 

 

Install implementation Prerequisite 
After exploring the sample utility network, move on to building out a utility network for your own 

organization. Before getting started, set up the environment with the necessary tools. 

This task group includes the following tasks: 

• Create a Python project environment 

• Install Utility Network Package Tools 

• Install Data Loading Tools 

 

Configure Data Model for Implementation 
The data model has been developed and curated over several years to reflect the latest 

capabilities of the utility network. This solution delivers the latest model which has been 
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developed specifically to support gas and pipeline utilities to best manage their assets in a 

digital environment. 

After exploring the solution, complete the following steps to remove the sample data and 
prepare the data model to manage your gas and pipeline network. 

This task group includes the following tasks: 

• Calculate Tolerances and Resolutions (Option - LRS/APR Only) 

• Project and Remove Sample Data 

• Create Modification Tables (Optional) 

• Load Data (Optional) 

 

Prototype in a Single User Environment 
Creating a utility network that fits your organization's needs requires a solid understanding of 

your data, as well as the provided data model. We recommend starting out with a prototype to 

explore with your own data and adjust where necessary. When ready, move on to setting up 

and implementing your solution in ArcGIS Enterprise. 

To learn more about the Attribute Rules included in the Electric Data Management project, 
review the Gas and Pipeline Data Management Attribute Rules document. 

This task group includes the following tasks: 

• Create File Geodatabase with Schema 

• Adjust Attribute Rules 

• Update Maps Data Sources 

• Reset Trace Location Feature Classes 

• Adjust Maps 

• Export Asset Package 

 

Deploy Solution to an Enterprise Environment 
These tasks are a guide to set up a utility network from start to finish. This includes creating an 

enterprise database, utility network, and sharing the final maps and services with your 

organization. 

This task group includes the following tasks: 

• Setup Enterprise Database 

• Create Utility Network 

• Apply Schema 

• Adjust Attribute Rules 

• Post Process 

• Publish Services 

• Update Subnetworks 

• Update Maps Data Source to Feature Service 

• Publish Web Map 
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• Reset Trace Location Feature Classes 

• Adjust Maps 

• Share with Organization 
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Homeless Point-in-Time Counts 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Homeless Point-in-Time Counts 
Homeless Point-in-Time Counts can be used to conduct point-in-time counts of sheltered and 

unsheltered homelessness individuals. 

It provides the ability to rapidly conduct homelessness counts of persons experiencing 
homelessness who are sheltered in transitional housing, an emergency shelter and safe 
havens. Using field apps and location-based information to conduct point-in-time counts helps 
meet the requirements of Department of Housing and Urban Development (HUD) in Continuum 
of Care (CoC) communities. Communities that meet these requirements can increase 
homelessness service capability and funding. Using field apps and location-based information to 
conduct point-in-time counts helps Continuum of Care communities quickly summarize the 
extent of homelessness and streamlines requests for federal funding. Homeless Point-in-Time 
Counts is typically implemented by health and human services agencies that want to 
understand the state of homelessness and collect information necessary to redirect services, 
funding, and resources to those in need. 

The Homeless Point-in-Time Counts solution delivers a set of capabilities that help you capture 
surveys during counts, visualize the extent of homelessness and filter key metrics captured in 
the survey, and export this information in a report that can be delivered to HUD. 

 

Requirements 
Homeless Point-in-Time Counts requires the following: 

• ArcGIS Enterprise 

• ArcGIS Notebook Server 

 

Information products 
Homeless Point-in-Time Counts includes the following information products: 

Item Description 
Required 
user type 

Homeless 
Counts 

An ArcGIS Survey123 form used by health and human service 
agencies and their network of volunteers to conduct sheltered 
and unsheltered homelessness surveys 

Field Worker 
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Homeless 
Count 
Dashboard 

An ArcGIS Dashboards app used by health and human service 
agencies to monitor results of a point-in-time count of sheltered 
and unsheltered persons experiencing homelessness 

Viewer 

HUD Report An ArcGIS Notebooks app used by health and human service 
staff to generate a report of homelessness point in-time counts 
to meet Housing and Urban Development (HUD) requirements 

Creator 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • A new version of the HUD Report notebook that resolves an issue where 
the point in-time observations were not calculated 

1.0 • The first release of Homeless Point-in-Time Counts 
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Configure Homeless Point-in-Time Counts 
Learn how to configure the Homeless Point-in-Time Counts solution to meet specific needs in 

your organization and load your data if needed. 

 

Extend homeless count survey 
The Homeless Point-in-Time Counts solution includes a Homeless Counts survey that can be 

used by volunteers to conduct annual point-in-time counts. The questions provided are standard 

from guidance provided by the U.S. Department of Housing and Urban Development (HUD). 

However, you can extend this survey with your own questions. Review the pre-configured 

questions and adjust as necessary to remain in compliance with your organizational policies. In 

addition, ensure you secure the survey and underlying layers and only share the content with 

appropriate members of your organization. 

 

Update feature layer views 
When adding new questions, begin with the steps listed below. For changes such as removing 

questions or formatting the survey, proceed to the Modify homeless count form survey section. 

To add one or more fields to a layer and recreate the views, complete the following steps: 

1. Sign in to your ArcGIS Online organization and search for the Homeless Counts 
hosted feature layer. 

2. Add a new field to a layer in the Homeless Counts hosted feature layer. 

 

Modify homeless count survey form 
To modify the Homeless Counts survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS Online organization. 

3. Click Homeless Counts to download the survey. 

4. Click Homeless Counts again to open the survey. 

5. On the left pane, click Open XLSForm Spreadsheet. 

6. In the Microsoft Excelspreadsheet, click the choices tab.  

  This tab comprises all the selectable options for survey questions. 

7. Revise the survey to reflect your needs. 

8. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

9. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your 
changes. 
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Add shelter names pick list 
Organizations conducting point-in-time counts may want to add a list of selectable shelter 

names. Adding the shelter names as a pick list can help maintain data consistency and save 

time in the field. 

To add your list of shelter names to a pick list, complete the following steps: 

1. Download and install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Homeless Counts to download the survey. 

4. Click Homeless Counts again to open the survey. 

5. On the left pane, click Open XLSForm Spreadsheet. 

6. In the Microsoft Excel spreadsheet, click the choices tab.  

  This tab comprises all the selectable options for survey questions. 

7. Update the name and label for shelter_name with your local areas shelters. Add 
additional shelter names and rows as needed, and if necessary delete all 
placeholder information. 

8. Click the survey tab and in cell A5, change the word text to select_one 
shelter_name. 

9. In cell I5, type in the word minimal.  

10. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

11. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your 
changes. 

Note: 

To view your changes in ArcGIS Survey123 Connect, on the Download Surveys page, click 
Download to download the updated survey. 

 

Add spatial query to Homeless Count Dashboard 
Organizations conducting point-in-time counts may want to add features such as 

neighborhoods, or city boundaries, as a spatial query to the Homeless Count Dashboard. 

To add geometries as a spatial query, complete the following steps: 

1. Sign in to your ArcGIS Online organization. 

2. Browse to the Homeless Count Dashboard map. 

3. Click Add and choose a layer, and then change the layer style. 

4. Save the map. 

5. Browse to Homeless Count Dashboard and click Edit Dashboard. 

6. Click the arrow on the left to open the left panel. Hover over the top right corner and 
click Add Category Selector in the drop-down menu. 
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7. In Selector Options, change Categories Form to Features. Choose your layer and 
click Select Layer. 

8. Change Selection to Multiple. 

9. In the Title text box, type in a selector's title. 

10. Click the Actions tab on the left pane. 

11. Click the Add Action drop-down list and choose Filter. 

12. Click the Add Target drop-down list and choose an available target, exception for 
category, number, and date selectors. Once the target has been chosen, set the 
Method to Spatial. 

13. Click Done. 

14. Save the dashboard. 
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Use Homeless Point-in-Time Counts 
Homeless Point-in-Time Counts delivers a set of capabilities that help you capture surveys 

during counts, visualize the extent of homelessness and filter key metrics captured in the 

survey, and export this information in a report that can be delivered to Department of Housing 

and Urban Development (HUD). 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Conduct point-in-time counts 
You’ll assume the role of a volunteer conducting an interview for a homeless point-in-time count. 

To conduct a point in time count, follow the steps below. 

1. In a browser, go to the Homeless Count survey. 

2. In the Homeless Counts survey, provide the following information: 

  Note: 

  Many of the questions will appear based upon the previous answer. 

  Parameter 
  Value 

  Surveyor name   Type your name. 

  Is the person in a shelter?   Select Yes 

  What is the name of the shelter/program?   Type the name of 
the shelter or 
program. 

  What is the type of shelter/program?   Select Emergency 
Shelter. 

  Are you able to survey this person?   Select Yes 

  Can I have 10 minutes of your time?   Select Yes 
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  Did another volunteer or survey worker already ask 
you questions about where you are staying tonight? 

  Select No 

  Including yourself (Person 1), how many adults are 
there in your (their) household, who are sleeping in 
the same location tonight? 

  Type 1 

  How many children <18 are there in your (their) 
household, who are sleeping in the same location 
tonight? 

  Type 2 

3. Proceed with the interview by filling in the following questions. 

– For all of the Household Questions text boxes, enter any values as if you 
were conducting the interview. 

– For Location, type an address in the search box and press Enter. 

4. Click Submit. 

Tip: 

If you don't have the Survey123 mobile app, you can download it for free as a mobile app 
from the App Store, Google Play or Amazon. Alternatively, you can download it for free as a 
desktop app from the  ArcGIS Survey123 resource page. 

 

Visualize point-in-time data 
You’ll assume the role of staff from a health and human service agency that want to see the 

results in real time of the point-in-time count. 

1. In a browser, go to the Homeless Count Dashboard. 

2. Zoom around on the map to note how the heat map changes based upon the 
extent of the map. 

  All information entered in the Homeless Counts survey automatically appears in this 
dashboard when submitted. 

3. To the left of the app, click the arrow to expand the pane to filter. 

4. Under Gender, click Male. Notice how the map and all associated charts change. 

5. Under Gender, click All. 

  Examine the other filters on the map. 

6. Close the dashboard when done exploring the various filters. 

 

Examine point-in-time data details 
You’ll assume the role of staff from a health and human service agency that wants to see more 

in-depth results from the point-in-time data. 

1. In a browser, go to the Homeless Point-in-Time Count Survey site and sign in. 

2. Click the Homeless Count survey. 
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3. Click the Analyze tab. 

4. Scroll down to examine the various questions that were asked during the survey. 

  The results will visualize the data differently depending on the type of data collected. 

5. Click the Filter button in the upper left corner of the app. 

6. Select What is the type of shelter/program? in the Surveyor name drop-down 
menu. 

7. Select Emergency Shelter in the drop-down list for the value.  

8. In the bottom of the filter panel, click Apply.  

  All of the associated data and charts are now filtered. 

9. In the upper right corner of the app in the green bar, click Data. 

10. Click any individual record in the table to see the details of that survey. 

Tip: 

You can export the data and create reports from this data. 

 

Generate HUD Report 
The Department of Housing and Urban Development (HUD) has specific guidelines that govern 

how Continuums of Care must report the results of their point-in-time counts. The Homeless 

Point in Time solution accounts for these requirements in the data schema and provides a tool 

that generates a Microsoft Excel workbook in the format required by HUD. 

Note: 

1. In a browser, go to your content in your ArcGIS organization and find the HUD 
Report ArcGIS Notebook included with the solution. 

2. Browse the instructions included with the notebook. 

  Note: 

  There are two cells that need to be executed. The first allows the notebook to create 
Excel spreadsheets and may take a few minutes to execute. The second cell creates the 
spreadsheet. 

3. Upon completion of the notebook, click the link to the report and download the 
spreadsheet. 

  This HUD Report is a summary of all the individual point-in-time surveys that were 
conducted compiled with metrics that can then be shared with HUD. Each HUD Report is 
given a date time stamp and stored in your ArcGIS Online account for future reference. 
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Homeless Risk Reduction 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Homeless Risk Reduction 
Homeless Risk Reduction can be used to identify where regular reports of homeless activity 

may originate and address regular reports of homelessness activity in a community. 

It provides the ability to leverage continual reports of homeless individuals and encampments in 
the community and identify which areas are at risk for generating homelessness. This 
collaborative approach between the public and local government agencies help determine 
where resources can be deployed to assess the situation, offer services to homeless persons, 
and determine if additional steps are required. Homeless Risk Reduction is typically 
implemented by health and human services agencies that want to proactively address 
homelessness and connect homeless individuals with available resources. 

The Homeless Risk Reduction solution delivers a set of capabilities that help you understand 
where homelessness may originate in your community and actively monitor regular reports of 
homelessness so assistance can be offered to individuals in need. 

 

Requirements 
Homeless Risk Reduction requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.7 - 2.9 

 

Information products 
Homeless Risk Reduction includes the following information products: 

Item Description 
Minimum user 
type 

Homeless 
Activity 
Reporter  

An ArcGIS Survey123 form used by organizational staff or 
the public to report the locations of homeless individuals and 
encampments in the community 

Fieldworker 

Homeless 
Activity 
Manager 

A Crowdsource Manager app used by health and human 
service agencies to manage reports of homeless individuals 
and encampments in the community 

Editor 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 416 

Homeless 
Activity 
Dashboard 

An ArcGIS Dashboards app used by health and human 
service agencies to monitor reports of homeless individuals 
and encampments in the community 

Viewer 

Homeless Risk 
Reduction 

An ArcGIS Pro project used by data analysts to learn which 
areas in their community are at risk for generating 
homelessness and how to prioritize and site intervention 
programs 

GIS 
Professional 
Basic 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • A new version of the Homeless Risk Reduction ArcGIS Pro project that 
leverages the Enrich geoprocessing tool. 

1.0 • First release of Homeless Risk Reduction 
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Use Homeless Risk Reduction 
The Homeless Risk Reduction solution delivers a set of capabilities that help you understand 

where regular reports of homeless activity may originate in your community and actively monitor 

regular reports of homelessness so assistance can be offered to individuals in need. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Report homeless activity 
In this workflow, you will assume the role of a public safety staff in your community who is 

reporting the location of homeless individuals and encampments in a community. 

Follow these steps to report homeless activity. 

1. In a browser, go to the Homeless Activity Reporter survey. 

2. In the Homeless Activity Reporter , provide the following information: 

  Parameter 
  Value 

  Activity Observed   Individual 

  Details   Type Observed new individual in 
the park with a tent and dog. 

  Observed On   Select a date 

  Photo   Add a photo 

  Would you like to be contacted 
for more information? 

  Select Yes 

  Your Name   Type your name 

  Phone Number   Type your phone number 

  Email   Type your email address 
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  Observed at   Type location information of where you 
observed the activity. 

3. Click Submit. 

Note: 

While using the app in the field, you can use ArcGIS Survey123 mobile app to use your 
current location from your mobile device GPS. 

 

Manage homeless reports 
Health and human services personnel, public safety, and nonprofit organizations can 

use  Homeless Activity Manager and  Homeless Activity Dashboard to monitor, verify, and 

assign homeless reports to agencies responsible for resolving health and safety concerns or 

providing aid to individuals and families experiencing homelessness. 

In this workflow, you’ll assume the role of a staff member from a health and human service 
agency that wants to manage reports of homeless individuals and encampments in the 
community. 

1. In a browser, go to the Homeless Activity Manager. 

  The Homeless Activity Manager shows a list of all reports that were made. 

2. In the table, highlight the first record in the table. Verify this is the record you just 
submitted via the Homeless Activity Reporter . 

3. On the dialog box, in the lower left, click the Edit record button. 

4. Change the Status to Submitted, if necessary. 

5. In the Assigned To field, select Health and Human Services. 

  Note: 

  In many cases, individual follow up may be needed to further document and add to 
ensure you are capturing an accurate representation of homelessness in your 
community. 

6. Scroll down, if necessary, and click Save. 

Note: 

If you want to automate this process more, you can automatically send emails to individuals 
that are assigned. Refer to the Survey 123 Webhooks document to learn more. 
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Visualize homelessness 
In this workflow, you’ll assume the role of staff from a health and human service agency that 

wants to view the current state of homeless activity in your community. 

1. In a browser, go to the Homeless Activity Dashboard app. 

2. On the left under Type, check Individual. Explore the various filtering capabilities. 

3. On the left under Date Observed, choose Last 7 days. 

  Note: 

  You see the report you submitted in the first workflow. 

4. Close the dashboard when you are done exploring the Homeless Reports. 

 

Identify risk of homelessness 
Data analysts can use the Homeless Risk Reduction ArcGIS Pro project to learn which areas in 

their community are at risk for generating homelessness and how to prioritize site intervention 

programs. It leverages authoritative data and uses indicators such as unemployment rate, rental 

prices, public assistance, health insurance coverage, minority population, and number of 

veterans to compute a vulnerability to homelessness layer. The resulting risk surface is then 

used to prioritize intervention program siting. The results of this tool can be used as a 

foundation for public education and awareness campaigns, operational improvements, and 

policy discussions across an entire community. 

 

Identify areas at risk 
In this workflow, you’ll assume the role of a staff member from a health and human service 

agency who wants to evaluate data to guide policy discussions. 

1. Open the Homeless Risk Reduction ArcGIS Pro project and sign in to your ArcGIS 
organization. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand Tasks and double-click the Homeless Risk 
Reduction task. 

4. Open the Identify areas at risk of generating homelessness task. 

  This task contains steps to help you define the homeless risk criteria. 

5. In the Add risk factor point data step, select the following information. 

– In the Target Features parameter, select Census Naperville. 

– In the Join Features parameter, select Assault. 

– In the Output Feature Class parameter, browse to Databases to open the 
HomelessnessRiskReduction.gdb and type JoinedAssaults for the 

feature class in the Name text box. 

6. Click Run 

7. Click Next Step. 
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8. Click the Contents tab. 

9. Right-click the output layer from the Spatial Join tool and choose Attribute Table. 

10. Right-click Join_Count and choose Fields. 

11. Change Join_Count field name and field alias to AssaultCount. 

12. Delete the TARGET_FID field the tool created. 

13. On the Fields tab, in the Changes group, click Save. 

14. Close the attribute table and fields table. 

15. Click the Tasks tab. 

16. Click Next Step to continue. 

17. In the Add key demographic data step, fill out the information below. 

– In the Input Features parameter, click the drop-down menu and choose 
JoinedAssaults. 

– In the Output Feature Class parameter, browse to Databases to open the 
HomelessRiskReduction.gdb and type EnrichedDemographicData for the 

feature class in the Name text box. 

18. Click Save. 

19. To add additional variables, click the Add button and browse to your variable of 
interest. 

20. Click OK. Repeat this step to add the remaining variables. 

21. Click the Remove variables button. 

22. Click Run. 

23. Click Next Step. 

24. In the Create homeless risk surface step, fill out the information below. 

– In the Input Features parameter, click the drop-down menu and select 
EnrichedDemographicData or your own data set. 

– In the Output Feature Class parameter, browse to Databases to open 
HomelessnessRiskReduction.gdb and type HomelessnessRiskSurface 

for the feature class in the Name text box. 

25. Click Save. 

26. In Risk Factors (High Value), click the drop-down menu and choose all your high 
to low ranking variables. 

27. In Risk Factors (Low Value), click the drop-down menu and choose all your low to 
high ranking variables. 

28. Click Run. 

  Note: 

  The AssaultCount field was created in a previous step after performing the join. 

  Based upon the factors you specified, you will see a new Risk layer appear that ranks the 
polygons from high to low. You can run the previous task multiple times ranking values 
differently. In many cases you may want to provide more inputs for data you are tracking in 
addition to assaults, such as known individuals that your organization has perhaps been 
assisting, or areas of renting issues. 
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29. Click the Prioritize prevention program locations task. 

30. In Program Design step, fill out the information below. 

– In the Input Features parameter, click the drop-down menu and choose 
HomelessnessRiskSurface. 

– In the Output Feature Class parameter, browse to Databases to open 
HomelessRiskReduction.gdb and type VulnerableSurvivorsPrograms 

for the feature class in the Name text box. 

31. Click Save. 

32. In the Contributing factors parameter, click the drop-down menu and choose 
AssaultCount and ACS HHs w/Public Assist Income:Percent. 

33. Type Assist Vulnerable Survivors in the Program Name text box. 

34. Type a value in the Number of Results text box. 

35. Click Run. 

  Repeat the above for any other programs. Use the output from your previous run as the 
Input Features. 

36. Click Next Step. 

  The result is prioritized locations where a new program can be placed, such as a woman’s 
shelter. 

  Note: 

  The next step allows you to finalize the program rankings. You may have many specific 
programs you want to act upon. Prioritizing helps you better focus your efforts. 

37. Share the map as a web layer. 

  This allows others in your organization to see the prioritized risk factors. 
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Invasive Pest Inspections 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Invasive Pest Inspections 
Invasive Pest Inspections can be used to establish and inspect invasive pest monitoring sites. 

It streamlines the inspection of invasive pest monitoring sites that help detect and track the 
spread of invasive pests. This accelerated approach increases the likelihood of detecting 
harmful plant pests and diseases before they have an opportunity to cause significant damage 
to agriculture commodities. Invasive Pest Inspections is typically implemented by agriculture 
agencies that want to take a data-driven approach to monitoring invasive pests and diseases. 

The Invasive Pest Inspections solution delivers a set of capabilities that help you establish 
invasive pest monitoring sites, conduct invasive pest inspections, and monitor invasive pest 
programs. 

 

Requirements 
Invasive Pest Inspections requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 or later (Basic, Standard, or Advanced) 

• ArcGIS Survey123 

• Survey123 Connect 

 

Information products 
Invasive Pest Inspections includes the following information products: 

Item Description 
Minimum user 
type 

Invasive Pest 
Survey: New 
Site 

An ArcGIS Survey123 form used by mobile workers to 
establish a new agricultural pest monitoring site 

Field Worker 

Invasive Pest 
Survey: Site 
Visit 

An ArcGIS Survey123 form used by mobile workers to 
conduct field inspections at an existing monitoring site 

Field Worker 
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Invasive Pest 
Survey: New 
Site Map 

A map used by agriculture staff to create multiple 
agricultural pest monitoring sites at a single location 

Editor 

Invasive Pest 
Viewer 

An ArcGIS Web AppBuilder app used by agriculture 
program managers to identify the impact of a suspected 
pest infestation on agricultural commodities and human 
populations 

Editor 

Invasive Pest 
Status 

An ArcGIS Dashboards app used by agriculture program 
managers to monitor pest inspections and ensure 
monitoring sites are meeting federal and state goals 

Viewer 

Invasive Pest 
Reports 

An ArcGIS Pro project used by mapping technicians to 
create invasive pest inspection reports 

GIS 
Professional 
Basic 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Invasive Pest Inspections 
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Configure Invasive Pest Inspections 
In this topic, you will learn how to configure the Invasive Pest Inspections solution to meet 

specific needs in your organization. 

 

Load  data  
Invasive Pest Inspections can be used to establish and inspect invasive pest monitoring sites. In 

some cases, you may have this information in ArcGIS or another business system already. 

Review the layers provided with the solution and determine what source data you want to load. 
Then, load your existing data into the layers provided with the ArcGIS Solution before sharing 
the maps or applications. 

Once you have determined what source data must be loaded, complete one of the data loading 
workflows below. 

 

Load data from a shapefile   
You can load data for InvasivePestSurveys, AgricultureLayers, PublicSafetyLocations, and 

TreatmentExemptions rom a shapefile by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you wish to populate. 

3. On the feature layer item details page, Click Update Data and select Append Data 
to Layer. 

4. Under Filename, click Choose File. 

5. Navigate to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you wish to load data into and the layer that contains the 
updated data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

 

Create a new monitoring site 
You can also create a monitoring site from scratch using the new site form in ArcGIS 

Survey123. 

To create a monitoring site without using existing information, complete the following steps: 
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1. Open ArcGIS Survey123. 

2. If the Invasive Pest Survey: New Site survey has not yet been downloaded, browse 
to Download Surveys in the main menu. 

3. Search for the Invasive Pest Survey: New Site survey you published and click to 
download it. Once it's downloaded, return to My Surveys. 

4. Select the Invasive Pest Survey: New Site survey to open it. 

5. Click the Collect button to start creating a new monitoring site. 

6. Complete the survey by answering all the questions. This includes information 
about the program this site will support, the monitoring site and site contacts, the 
species being targeted, and the type of inspections that will take place at this 
monitoring site. 

  Note: 

  The form exposes more questions depending on your answers; for example, trap 
information is required when the inspection type includes trapping. 

7. Click the check mark to submit the survey. 

 

Create a new monitoring site at an existing location 
You may want to create many monitoring sites at one site. To do this, you can use information 

in an existing monitoring site to prepopulate the ArcGIS Survey123 form. 

1. Open the Invasive Pest Survey: New Site Map. 

2. Search for an existing site using its site ID in the search bar. 

3. With the pop-up open for the existing site, click the link to launch the Invasive Pest 
Survey: New Site. 

4. When prompted, click to open ArcGIS Survey123.  

  The form opens with the site information prepopulated. 

5. Complete the rest of the information in the form. This includes information about the 
program this site will support, the species being targeted, and the type of 
inspections that will take place at this site. 

6. Once complete, click the check mark to submit the survey. 

 

Update Survey123 Connect forms 
Though Invasive Pest Survey: New Site and Invasive Pest Survey: Site Visit have been 

configured to gather comprehensive information on an invasive pest inspection, two updates 

should be made to ensure local accuracy. 

 

Update surveyor names in the Site Visit survey 
To update the surveyor names included in the survey, complete the following steps: 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 426 

1. Download and install Survey123 Connect. 

2. Start Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Invasive Pest Survey: Site Visit to download the survey. 

4. Click Invasive Pest Survey: Site Visit again to open the survey. 

5. In the left panel, click XLSForm to open the XLSForm spreadsheet. 

  A Microsoft Excel spreadsheet opens. 

6. In the Microsoft Excel spreadsheet, click the Choices tab. 

  This tab comprises all the selectable options for survey questions. 

7. In the surveyors choice list, add or remove names and labels as needed. 

8. Click Save to save the Microsoft Excel spreadsheet and preview your changes on 
the Form Preview tab of Survey123 Connect. 

9. In Survey123 Connect, click Publish in the left panel to publish your changes. 

 

Update the species target list in the Site Visit survey 
To update the species target list in the Site Visit survey, complete the following steps: 

1. Download and install Survey123 Connect. 

2. Start Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Invasive Pest Survey: Site Visit to download the survey. 

4. Click Invasive Pest Survey: Site Visit again to open the survey. 

5. In the left panel, click Open to open the XLSForm spreadsheet. 

  A Microsoft Excel spreadsheet opens. 

6. In the Microsoft Excel spreadsheet, click the Choices tab. 

  This tab comprises all the selectable options for survey questions. 

7. In the target_species choice list, add or remove names and labels as needed. 

8. Save the Microsoft Excel spreadsheet and preview your changes on the Form 
Preview tab of Survey123 Connect. 

9. In Survey123 Connect, click Publish in the left panel to publish your changes. 
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Use Invasive Pest Inspections 
The Invasive Pest Inspections solution delivers a set of capabilities that help you establish 

invasive pest monitoring sites, conduct invasive pest inspections, and monitor invasive pest 

programs. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Conduct invasive pest inspections 
The Invasive Pest Survey forms support capturing information about existing or new monitoring 

sites and keeping a record of site visits throughout a season. The survey forms were designed 

to capture information required for the Cooperative Agricultural Pest Survey (CAPS) or Farm Bill 

programs and in a format to report details from site visits to the National Agricultural Pest 

Information System (NAPIS). 

After monitoring sites have been established, an abbreviated version of the Invasive Pest 
Survey form can be used to streamline the process for field inspectors. In this workflow, you will 
assume the role of an inspector who will use the ArcGIS Survey123 inbox to load your planned 
visits into the application, and then you will complete the streamlined form for each monitoring 
site from the field. 

1. On a mobile device, in ArcGIS Survey123 open the Invasive Pest Survey: Site Visit 
form. 

  Tip: 

  If the Invasive Pest Survey: Site Visit survey has not yet been downloaded, browse to 
Download Surveys on the main menu. Search for the Invasive Pest Survey: Site Visit 
form that you published and click to download it. After it downloads, return to My 
Surveys and tap the form to open it. 

2. Tap Inbox and, if no surveys appear, click Refresh. 

3. Find your site in the list or tap Map to find sites near you.  

4. After you find your site, tap it to open the form.  

  The form opens with the site information prepopulated. 

5. Complete the rest of the information in the form. 

6. Click the check mark to submit the survey. 

7. Repeat these steps to conduct additional inspections as necessary. 
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Monitor invasive pest status 
Now, you will assume the role of an agriculture program manager who will use the Invasive Pest 

Status dashboard to monitor pest inspections. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Invasive 
Pest Inspections solution. 

2. View the Invasive Pest Status dashboard. 

  On the right, in the Monitoring Sites panel, all of the monitoring sites are listed. At the top 
of the panel, the total number of sites appears. 

3. On the left, use filters to refine the results for site status, pest status, species, and 
survey type. 

  The results on the map and in the Monitoring Sites panel update. 

4. At the bottom right, click the Inspections tab and review the inspection details. 

5. At the bottom middle, click the Monthly Comparison tab and review the metrics. 

 

View invasive pest impact 
Next, you will continue the role of an agriculture program manager who will now use the 

Invasive Pest Viewer app to identify the impact of a suspected pest infestation on agricultural 

commodities and human populations. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Invasive 
Pest Inspections solution. 

2. View the Invasive Pest Viewer app. 

3. Use the provided drawing tools to select an area of interest. 

4. View the results to understand the potential impact of invasive pests for the 
selected area.  

 

Export surveys for NAPIS reporting 
Invasive Pest Reports allows you to export information captured during field inspections for the 

CAPS or Farm Bill programs into a format that can be used to report monitoring activities to the 

NAPIS database. 

This workflow will guide you through exporting field surveys and transforming the data structure 
for use in reporting to the NAPIS database. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Invasive 
Pest Inspections solution. 

2. Download the Invasive Pest Reports desktop application template, and then unzip 
the folder. 

3. From the unzipped folder, open the InvasivePestReports.aprx file in ArcGIS 

Pro. 

4. In the Catalog pane, expand the Tasks folder, and then double-click the Invasive 
Pest Monitoring task. 
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  Note: 

  If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, expand How to Use Invasive Pest Reports, if necessary, and 
then double-click the Export Surveys for NAPIS Reporting task to begin. 

6. Follow the instructions in the task to export survey responses to a NAPIS report. 
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Know Your Zone 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Know Your Zone 
Know Your Zone can be used to share multitiered evacuation zones established to help 

residents evacuate when a hurricane or storm occurs. 

The solution provides round-the-clock access to an organization, and the location-enabled 
search helps residents quickly find evacuation zone information. This transparent approach 
improves communication with the public and promotes efficient use of transportation and public 
safety resources. Know Your Zone is typically implemented by emergency management 
agencies that want to avoid unnecessary evacuation travel, reduce congestion on traveled 
ways, and ease overcrowding at storm shelters. 

The Know Your Zone solution delivers a set of capabilities that help you to share evacuation 
zones and promote current evacuation instructions when an order is issued. 

 

Requirements 
Know Your Zone requires the following: 

• ArcGIS Enterprise 

 

Information products 
Know Your Zone includes the following information products: 

Item Description 
Minimum 
user type 

Know 
Your 
Zone 

An ArcGIS Web AppBuilder app used by the public so residents can 
determine which evacuation zone they reside in and obtain 
evacuation notices when issued 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Know Your Zone 

 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 432 

Configure Know Your Zone 
In this topic, you will learn how to configure the solution to meet specific needs in your 

organization and load your data if needed. 

 

Load evacuation zones 
You may have evacuation zones that you would like to use in the Know Your Zone solution. To 

do so, you will need to load your data into the evacuation layer schema provided with the app. 

Note: 

To append your data, it must be in a shapefile format. 

To load your facilities information from another data source, complete the following steps: 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Know Your Zone in the search box. 

4. Under Item Type, click Layers, then click Feature Layers. 

  Note: 

  Some of the feature layers have a suffix such as public. These are layer views of the 
original source feature layer. These layer views are used to share information with the 
public without showing all the details or allowing the public to edit the layers. The original 
source layers do not have a suffix. 

5. Click the title of the original source layer into which you want to load data to view 
the item details. 

6. Click Update Data, then click Append Data to Layer. 

7. Under Filename, choose your shapefile. 

8. Click Upload, then click Continue. 

9. Click Show field matching to match the fields from the spreadsheet to the fields in 
the selected feature layer. 

10. After you have matched the fields, click Apply Updates. 

11. Click the Data tab on the banner of the item page to confirm your data has loaded 
successfully. 

Tip: 

If you plan on using the Know Your Zone app to communicate active evacuation notices, 
you will need to set the Active Incident field in the Evacuation feature layer to Yes to 
ensure it is visible on the map. 
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Note: 

When you deploy the Emergency Management Operations solution and the Know Your 
Zone solution and both solutions are owned by the same user, the Evacuations layer is 
shared between both solutions. This allows the emergency evacuation status to be updated 
using the Operations Response app. The updates are visible in Know Your Zone and other 
apps that are part of the Emergency Operations solution. 

 

Enable evacuation status 
When a storm is approaching, emergency managers can configure Know Your Zone to identify 

zones that are most at risk. Evacuation status can be enabled on each high-risk zone. This 

information can be shared with the media and residents so they will know what zone they are in 

and when to evacuate. 

To enable evacuation status, complete the following steps: 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Know Your Zone in the search box. 

4. Open in Map Viewer the Know Your Zone web map. 

5. Turn on the Active Evacuation Notices layer. 

6. Turn off the Your Evacuation Zone layer. 

7. Click Save to save the map. 

8. Open the Know Your Zone web application item page and click Edit 
Application. 

9. On the banner at the top of the left panel, click the Widget button. 

10. Click Set the widgets in this controller. 

11. Click the edit button to edit the Find Your Zone widget. 

12. On the Search Settings tab, click Set, and check the box to add the Active 
Evacuations Notices layer to the search layers and uncheck the box to remove 
the Your Evacuation Zones layer. 

13. Click OK to the save the Select search layers changes. 

14. Click OK to save the changes to the Configure Find Your Zone window. 

15. Click Save to save the changes to the Know Your Zone web app. 

  Note: 

  To test your changes, you will need to load some evacuation zones into both the 
multitiered evacuation zones and evacuations layers. You will need to populate the 
Evacuation Zone, Evacuations Type, and Starts fields to see the results. 

16. After you load data into the evacuations layer, open the web app to test the 
configuration changes. 

17. Enter an address or click a location within the orange evacuation areas. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 434 

  The result of the search will indicate the evacuation zone and status of the specified 
address. In this case, the address is in Evacuation Zone B and the status is Voluntary 
Evacuation Notice. 

18. Click one of the red evacuation areas (Evacuation Zone A). 
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Use Know Your Zone 
The Know Your Zone solution delivers a set of capabilities that help you to share evacuation 

zones and promote current evacuation instructions when an order is issued. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Find your zone 
Know Your Zone can be used by the public to locate an address or place and obtain information 

about the evacuation zone and current evacuation status of that location. Search for an address 

in the search bar or click a location directly on the map to define the location to be searched. 

In this workflow, you will assume the role of a resident in Baltimore who wants to know in which 
evacuation zone you're located. 

1. In a browser, from the Know Your Zone solution, view the Know Your Zone app. 

2. On the right, in the Find Your Zone panel, type the address. 

  The map zooms to the location, and the result that displays in the panel indicates in which 
evacuation zone, if any, the address is located. 

  You can also find evacuation zone information by clicking a point on the map. 

3. On the map, click a point. 

  On the right, the results indicate in which evacuation zone, if any, the point that you clicked 
resides. 

4. Close the Know Your Zone app. 

Note: 

When a storm is approaching and evacuation orders are implemented, Know Your Zone 
can be configured to inform users of the current evacuation status of each zone. See 
Configure Know Your Zone to learn more. 
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Land Use Outreach 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Land Use Outreach 
Land Use Outreach can be used to share development regulations, construction activity, and 

solicit feedback on current land cases from the public. 

It provides 24/7 access to an organization and streamlines the development process. The 
inclusive approach increases public trust reduces the need to attend meetings in person, and 
helps government agencies harness feedback from the public to make better decisions about 
development in the community. Land Use Outreach is typically implemented by planning 
departments, public work agencies and other local government agencies that want to increase 
transparency and encourage public participation. 

The Land Use Outreach solution delivers a set of capabilities that help you share land use, 
zoning and other (for example, floodplain) regulations, generate awareness about permitted 
construction activity and engage the public when new developments are proposed. 

 

Requirements 
Land Use Outreach requires the following: 

• ArcGIS Enterprise 

 

Information products 
Land Use Outreach includes the following information products: 

Item Description 
Minimum 
user type 

Land Use Inquiry An ArcGIS Web AppBuilder app used by the general public, 
developers, and real estate professionals to identify land use 
and zoning designations that impact the use of land 

Not required 

Floodplain 
Inquiry 

An ArcGIS Web AppBuilder app used by the general public, 
land development companies, and real estate professionals 
to locate parcels impacted by FEMA floodplain boundaries 

Not required 

Construction 
Activity Tracker 

An ArcGIS Web AppBuilder app used by the general public to 
track individual building permits and general construction 
activity 

Not required 
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Public Comment A Crowdsource Polling app used by the general public and 
other interested parties to review land use cases or capital 
projects and submit feedback on a given case or project 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Land Use Outreach 

 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 438 

Configure Land Use Outreach 
Learn how to configure the Land Use Outreach solution to meet specific needs in your 

organization. 

 

Load data  
Land Use Outreach can be used to share development regulations, construction activity, and 

solicit feedback on current land cases from the public. In some cases, you may have this 

information in ArcGIS or another business system already. 

Review the layers provided with the solution and determine what source data you want to load. 
Then load your existing data into the layers provided with the solution before sharing the maps 
or applications. 

Once you have determined what source data must be loaded, complete the data loading 
workflow below. 

 

Load data from a shapefile 
Data for TaxParcels, SiteAddresses, ConstructionActivity, LandUse, Zoning, OverlayDistricts, 

and Floodzones can be loaded from a shapefile by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer to populate. 

3. On the feature layer item details page, click Update Data and select Append Data 
to Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the 
updated data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Use Land Use Outreach 
The Land Use Outreach solution delivers a set of capabilities that help you share land use, 

zoning and other (for example, floodplain) regulations, generate awareness about permitted 

construction activity and engage the public when new developments are proposed. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Locate a parcel impacted by a floodplain 
As the general public and real estate professionals search for properties, floodplain boundaries 

come into consideration so that informed decisions can be made during the land development 

and home buying processes. 

In this workflow, you will learn how to locate and view authoritative floodplain boundary 
information (DFIRM panels) provided by the Federal Emergency Management Agency (FEMA) 
using Floodplain Inquiry. You will assume the role of a resident in a local community. You want 
to see if a property you are interested in purchasing sits in a floodplain boundary. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Land Use 
Outreach solution. 

2. View the Floodplain Inquiry app. 

3. Search for a parcel number or address or click the location directly on the map. 

4. Review the property's details, such as the parcel number, address, and if the 
selected property is impacted by a flood zone. 

 

Identify land use impact 
As development occurs in a community, the general public, developers, and real estate 

professionals must identify land use and zoning designations that affect land use. 

In this workflow, you will learn how to locate and view current land use, future land use, and 
zoning designations using Land Use Inquiry. You will assume the role of a resident in a local 
community. You want to see what the current and proposed land use is for a particular property. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Land Use 
Outreach solution. 

2. View the Land Use Inquiry app. 

3. On the right, in the Locate Regulations widget, search for a parcel number or 
address or click the location directly on the map. 

4. Review current land use, future land use, and current zoning designations. 
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Review construction activity 
As development occurs in a community, the general public, developers, and real estate 

professionals must locate open, under review, approved, and closed building permits. 

In this workflow, you will learn how to track individual building permits and general construction 
activity. You will assume the role of a resident in a local community. You want to check the 
status of a recently submitted constriction permit. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Land Use 
Outreach solution. 

2. View the Construction Activity Tracker app. 

3. On the right, in the Locate Permit widget, search for an address, applicant name, 
or permit number or click the location directly on the map. 

4. Review the details and current status of the construction permit. 

 

Submit feedback in the Public Comment app 
As land use cases and capital projects are reviewed in a community, the general public and 

other interested parties can submit feedback on a given case or project. 

In this workflow, you will learn how to submit feedback and help make better development 
decisions in the community. You will assume the role of a resident in a local community. You 
want to submit feedback on a current land use case. 

1. In a browser, from the Land Use Outreach solution, view the Public Comment app. 

2. On the right, select a current case up for public comment; alternatively, click a case 
directly on the map. 

3. Review the details and current status of the case. 

4. Click the Add a comment button, complete the comment form, and click Submit. 
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Market Development 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Market Development 
Market Development can be used to understand market characteristics and performance. 

Executives and retail analysts need to understand the performance of the market landscape 
based on location. Organizations strive to increase profits by using market indicators to drive the 
decisions on where to close locations and open new locations. Understanding market 
performance based on regional and market breakdown is critical in enhancing the business 
strategy for decision makers. Market Development is typically implemented by organizations 
that want to take a data-driven approach to understand market characteristics and the 
performance of their business. 

The Market Development solution delivers a set of capabilities that helps you visualize the 
overall market landscape and communicate key business metrics with decision makers. 

 

Requirements 
Market Development requires the following: 

• ArcGIS Enterprise 

 

Information products 
Market Development includes the following information products: 

Item Description 
Minimum 
user type 

Market Explorer 
Dashboard 

An ArcGIS Dashboards app used by analysts to 
understand the overall performance of retail stores in an 
organization from various geographies 

Viewer 

Sales Performance 
Dashboard 

An ArcGIS Dashboards app used by analysts to 
understand the overall performance of each retail store 
in an organization 

Viewer 

AssetSource An Excel document that can be used to load and 
validate an authoritative list of assets into ArcGIS 

Not required 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 442 

SalesdataSource A .csv file that can be used to load an authoritative 

dataset of sales data into ArcGIS 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.2 • General schema update to the joined layer view. 

1.0 • First release of Market Development 
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Configure Market Development 
In this topic, you will learn how to configure the Market Development solution to meet specific 

needs in your organization. 

 

Prevent duplicate records 
To support the updating of data using the Append Data to Layer and to ensure accurate 

statistics within the information products of the solution. You'll need to add an attribute index 

which applies a unique constraint to facility_id field in the facilities layer. 

To add an unique constraint, complete the steps below: 

1. Sign in to your ArcGIS Enterprise portal. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Assets in the search box. 

4. On the left under Folders, click the folder Market Development was deployed to. 

5. On the right side of the page, click  Assets to view it details. 

6. Under the Layers section, click Assets. 

7. In the URL section , click View. 

  A new tab opens into the ArcGIS REST Service Directory for this item. 

8. In the URL bar of the browser, edit the URL with the following changes: 

a. Add the word admin between /rest/ and /services/. (For example: 
ArcGIS/rest/admin/services/assets.) 

b. Scroll to the bottom of the page and click on Add to Definition. 

c. A window appears where you will be entering JSON to add an index to the 
layer. 

d. In the text box , copy the following: 

  { 
"indexes" : [{ 
"name" : "asset_id_Index", 
"fields" : "asset_id", 
"isAscending" : false, 
"isUnique" : true, 
"description" : "" 
}] 
} 

e. Click Add To Layer Definition to commit update. 

  The following message will appear if add was successful. {"success": true} 

9. In the browser, return to the Assets layer tab and click on the Data tab. 

10. Click the Fields and click on Asset. 

  This page reveals the properties for the asset_id field. Under Settings, the Unique field is 
set to Yes. 
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Load data 
Information must be loaded before using the Market Explorer Dashboard and Sales 

Performance Dashboard. The AssetSource and SalesdataSource can be used to organize your 

business information before loading into ArcGIS the accompanying sales data in your 

organization. 

Note: 

Ensure you populate the Asset_ID column in the AssetSource with unique values. 

You may need to load existing assets or sales data from a spreadsheet. Review the maps or 
applications provided with the solution and determine what, if any, source data you would like to 
load. 

If you do not have an inventory of assets and sales data in ArcGIS, you may have them in a 
spreadsheet or another system you can export to a spreadsheet. If you don’t have a 
spreadsheet already, you can use the sample .csv files included with the solution 

(AssetSource, SalesdataSource) to inventory your assets and sales data. 

To load your assets or sales data from a spreadsheet, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the AssetSource item. 

2.  Open the items details page. 

3. Click Download. 

4. Edit the CSV file and populate your facility information in the document. 

  Note: 

  At a minimum, you must provide a unique Asset_ID and the latitude and longitude for 
each facility in the FacilitySource. If you don't have a unique ID, you can edit the CSV file 
in Excel and copy this formula into the first row of the facilityid column: 
=CONCATENATE("Asset-", TEXT(ROW(A1),"00000")). You can then drag the right 
corner of the cell to fill the formula down for all facilities, giving each a unique ID. 

5.  In your ArcGIS organization at the top of the site, click Content. 

6. Browse to the Assets feature layer. 

7. On the item details page, click Update Data and select Append Data to Layer. 

8. Under Filename, choose your .csv file. 

9. Click Upload and Continue. 

10. Uncheck Update existing features. 

11. Click Show field matching to map the fields. 

12. Click Apply Updates. 

13. Repeat steps 1 through 12 by downloading the SalesdataSource CSV file and 
updating the Asset Sales Data table. 

To load your data for Region Overlay, Subregion Overlay, and Competitors from a shapefile or 

file geodatabase, complete the following steps: 

1. Create a .zip file of your shapefile. 
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2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data 
to Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the 
updated data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 
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Use Market Development 
The Market Development solution delivers a set of capabilities that helps you visualize the 

overall market landscape and communicate key business metrics with decision makers. 

In this topic, you will learn how to use the Market Development solution and the set of 
capabilities and features that it provides. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Investigate market characteristics 
The Market Explorer Dashboard application includes your organization's assets overlaid with 

demographic information such as median disposable income, retail goods spending, and 

population growth. The application allows you to conduct a series of key exploratory functions 

that support the visualization of markets in and around your business by region, market, or 

store. 

Note: 

Assets may represent your retail establishments, businesses you sell into, or distributors. 

 

Visualize market characteristics 
In this workflow, you’ll assume the role of a business analyst who is assigned the task of 

exploring a particular market. You will assume that this is a market that your organization is 

considering extending operations within and examine the potential likelihood of growth, and 

communicate this with key leadership. 

1. In a browser, go to the Market Explorer Dashboard application. 

2. In the Select a Region drop-down list, select a region. 

  Filtering will zoom in to that specific region and automatically updates the set of metrics 
along the bottom of the application and the locations in the list on the right side. 

  Note: 

  The competitor indicator panel represents the number of features within the map view. 

3. In the Select a Sub-Region drop-down list, select a sub-region. 

4. In the upper right corner of the map are a set of map settings. Click the layer 
visibility button to reveal operational layers that can be switched on or off. 

5. Switch on the layer labeled USA Population growth. 

6. Zoom in to a particular market to start exploring in more detail. 
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  Notice as you zoom in or pan around, the metrics along the bottom as well as the list on 
the right side update. This map-driven capability provides context into what is within your 
view, in and around areas of interest. Also note how the USA population growth layer 
dynamically updates to more granular level of detail depending on the scale. 

  Note: 

  Holding the Shift key on your keyboard enables the area selection tool in the map. This 
will zoom in to the extent of the selected area. 

 

Explore the performance of your business 
The Sales Performance Dashboard contains your organization's assets, with panels that 

represent your business sales data broken down by category and sales for each store. The 

application is designed to digest key information about the financial performance of your 

organization’s assets. The functionality of the Sales Performance Dashboard is used to explore 

and visualize retail stores and sales information for each retail store and overall financial 

performance of your business by region, market, or store. The map-driven metrics provide an 

overview of key financial business metrics that provide insight into the market potential. 

Note: 

Assets may represent your retail establishments, businesses you sell into, or distributors. 

 

Understand store performance 
In this workflow, you’ll assume the role of a business analyst who is assigned the task of 

understanding the sales performance in a particular market. You will assume that this is a 

market that your organization is considering extending operations within and examine the 

potential likelihood of growth, and communicate this with key leadership. 

1. In a browser, go to the Sales Performance Dashboard 

2. In the Select a Region drop-down list, select a region. 

  Filtering to the Middle Atlantic will zoom in to that specific region and automatically updates 
the set of metrics and locations in the list along the left side of the application. 

3. In the Select a Sub-Region drop-down list, select a sub-region. 

4. Zoom in to a specific market to start exploring in more detail. 

  Notice as you zoom in or pan around, the metrics and the list along the left update. This 
map-driven capability provides context into what is within your view, in and around areas of 
interest. 

  Note: 

  Holding the Shift key on your keyboard enables the area selection tool in the map. This 
will zoom in to the extent of the selected area. 
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5. In the Select a Category drop-down list, select a category. 

  Notice the metrics along the left are now only showing overall sales for that specific 
category, based on the assets within the map view. 

6. Select an asset from the list. This will zoom to the selected feature and open the 
pop-up for additional sales. The metrics will also reflect the currently selected 
feature. 

7. Optionally, to filter the assets in the list to a specific area of interest, click the button 
in the upper left corner of the map to enable the layer selection mode. 

8. To change the selection method, click the drop-down arrow and click the lasso tool. 

9. Hold the left mouse button and dynamically draw around an area of features to be 
selected. 

  Notice that the metrics and the list along the left update based on the selected features. 
This selection-driven capability provides an additional level of focusing based on an area of 
interest. 

 

Add premium content 
Esri Demographics provides ArcGIS access to global demographics and business listings and is 

used for mapping and analysis. Esri Demographics data supports commercial market analytics 

and noncommercial usages, such as economic development, planning, and at-risk population 

assessment. The data is accessible as dynamic web maps, data enrichment, reports, and 

infographics. 

Market Development is configured by default with a set of information-rich demographic layers 
that can be used to visually explore key market characteristics. 

In this workflow, you will assume the role of a business analyst who is tasked with adding new 
demographic content to help enhance the ability to make decisions with new context. 

1. In a browser, sign in to your ArcGIS organization and click the Content tab. 

2. On the left side, under Folders, click Market Development. 

3. Click Market Explorer (map) to open into the item description page, then click 
Open in Map Viewer. 

4. Above the contents pane, click the Add button, then click Browse Living Atlas 
Layers. 

5. Under Search for Layers are a set of buttons to filter and sort layers by relevance. 
Click the filter button to show additional options. 

6. Under the Categories group are a set of themes that can be selected to filter from 
over 4,500 layers of ArcGIS Living Atlas content. Select a theme to explore layers 
and select a layer to view more details. 

7. Once a layer has been identified, click Add to Map. 

8. Click the Save button along the upper middle of the map and click Save. 

9. If necessary, repeat steps 1 through 8 for Sales Performance (map). 
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Mosquito Service Requests 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Mosquito Service Requests 
Mosquito Service Requests can be used to solicit reports of mosquito activity and locations of 

potential breeding sites from the general public. 

Mosquitoes are a serious threat to public health, beyond nuisance swarms and annoying bites. 
During peak times, the risk for the spread of diseases such as encephalitis, yellow fever, 
dengue, Zika, and malaria drastically increase. 24/7 access to responsible agencies ensures 
mosquito activity is reported sooner and responsible agencies address problem areas faster. 
This accelerated approach improves the quality of life in a community and reduces risks 
associated with large infestations of mosquitoes. Mosquito Service Requests is typically 
implemented by public works and mosquito control agencies that want to take a data-driven 
approach to the control of mosquito populations. 

The Mosquito Service Requests solution delivers a set of capabilities that help you solicit 
mosquito activity reports from the public, triage reports to staff and field crews for resolution and 
monitor the resolution of reports in a community. 

 

Requirements 
Mosquito Service Requests requires the following: 

• ArcGIS Enterprise 

• ArcGIS Field Maps 

 

Information products 
Mosquito Service Requests includes the following information products: 

Item Description Minimum user type 

Mosquito Control An ArcGIS Hub site used by public works and 
mosquito control agencies to share how they are 
controlling mosquito populations and the spread of 
vector-borne disease 

Not required 

Mosquito Service 
Request 

A Crowdsource Reporter app template used by the 
general public to submit mosquito activity reports in 
their community 

Editor (required for 
public works or 
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mosquito control 
personnel only) 

Mosquito Service 
Request 
Manager 

A Crowdsource Manager app used by public works 
and mosquito control personnel to triage submitted 
mosquito activity reports and update the status of 
each report as needed 

Editor 

Mosquito Service 
Request 
Dashboard 

An ArcGIS Dashboards app used by public works 
and mosquito control personnel to monitor 
mosquito activity reports submitted by the general 
public 

Viewer 

Mosquito Field 
Operations 

An ArcGIS Field Maps map used by public works 
and mosquito control personnel to address 
mosquito activity reports submitted by the general 
public 

Field Worker 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Mosquito Service Requests 
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Configure Mosquito Service Requests 
Learn how to configure the Mosquito Service Requests solution to meet specific needs in your 

organization. 

 

Configure the Mosquito Control site 
The Mosquito Service Requests solution includes an Mosquito Control ArcGIS Hub site that 

your organization can configure with your own branding and use to share important mosquito 

control information and abatement activities with the public. 

 

Update with organizational information 
After you deploy the Mosquito Service Requests solution, the Mosquito Control site layout only 

requires a few updates to fit your organization's context. Follow the steps below to update the 

site with your organization's needs: 

1. Sign in to your ArcGIS organization and browse to the Mosquito Control site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the statistics section under the website title. The Requests Completed 
card is already linked to the Mosquito Service Requests solution’s 
MosquitoObservations feature layer. These stats automatically update as service 
requests are completed. 

  The Vector-borne Disease Cases statistic is provided in a text card but styled to resemble 
the summary statistics card; this allows you the option to manually enter a statistic of your 
choice, independent of the solution data. Update the Vector-borne Disease Cases 
statistic card using a metric of your choice, or replace the text card with a summary 
statistics card and configure it to another feature layer in this solution or a related solution 
(see below). 

  To replace the text card with a summary statistics card, click Layout in the side panel. 
Drag a Summary Statistics card from the side panel onto the row and position the card to 
the right of the Surveillance Sites card. Once the card is configured, hover over the 

existing Vector-borne Disease Cases card and click the delete button . 

5. Scroll to the Report a Problem section, hover over the card, and click the settings 

button , and then update your call center and contact information, hours, and 
phone number. 

  Note: 

  The Submit a Request button is already configured to open the Mosquito Service 
Request app. 
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6. Scroll to the Frequently Asked Questions section, hover over the card and click 
the settings button, and update the questions and answers. 

7. Scroll to the Mosquito Open Data section, hover over the open data card, click the 
settings button, and update the various category links using tags, categories, or 
groups that reference your ArcGIS Open Data in the side panel. 

8. To modify your site’s footer, click Customize Toggle  on the side panel. 

9. Click Footer.  

  A custom footer is already provided, and in most cases, it needs to be updated with your 
organization's branding, contact information, and social media references. 

10. Click the HTML text box. 

  The HTML window appears. 

11. Make the necessary changes and click Apply. 

12. Click Save. 

 

Share items with the public 
Several layer views, maps and apps included in the Mosquito Service Requests solution must 

be shared with everyone so they can be accessed by the public on the Mosquito Control site. To 

share your mosquito service request items with everyone, use the guide below and complete 

the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Mosquito Service Request folder. 

2. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   MosquitoObservations_public 

  Web Map   Mosquito Service Requests 

  Web Mapping Application   Mosquito Service Requests 

  Site Application   Mosquito Control 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 
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Deploy related solutions 
This site references content from the Mosquito Surveillance, Mosquito Treatments, and Adopt-

A-Catch Basin solutions. To deploy these solutions, follow the steps in the Deploy an ArcGIS 

Solutions section. 

 

Update solution references 
This site has references to solutions deployed in the previous section. To update your site, 

complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Mosquito Control site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Surveillance Sites section under the website title, hover over the 

card, and click the settings button . 

5. In the side panel, click Find an Item and search for the 
MosquitoSurveillance_public feature layer. 

6. In the search results, click the circle in the upper left corner next to 
MosquitoSurveillance_public. 

7. In the side panel, click the Surveillance Sites (Point) layer. This feature layer was 
deployed in the previous step (part of the Mosquito Surveillance solution). 

8. Click Select.  

9. In the side panel, do the following: 

a. For Statistic Field, click Location. 

b. Leave Statistic Type as Count. 

c. Expand the Filter by Attributes section, click the drop-down arrow, and 
choose Status as the attribute. 

d. Click Add. 

e. Click the Status drop-down arrow and choose Active. 

10. Scroll to the Surveillance section, hover over the Surveillance Results card, and 
click the settings button. 

11. Click the Learn More button and click Edit. 

12. Enter the Mosquito Population Surveillance Charts app URL in the Link 
Destination text box and click Add Link. 

  Tip: 

  Browse to the Mosquito Population Surveillance Charts app. Open the item page, click 
View Application, and copy the app URL. 

13. Under Health Concerns, hover over the card and click the settings button. 

14. Click the Learn More button and click Edit. 
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15. Enter the Mosquito Health Concerns Summary app URL in the Link Destination 
text box and click Add Link. 

  Tip: 

  Browse to the Mosquito Health Concerns Summary app. Open the item page, click View 
Application, and copy the app URL. 

16. Scroll to the Treatments section, and under Treatment Areas, hover over the card 
and click the settings button. 

17. Click the Learn More button and click Edit. 

18. Enter the Mosquito Spray Areas app URL in the Link Destination text box and 
click Add Link.  

  Tip: 

  Browse to the Mosquito Spray Areas app. Open the item page, click View Application, 
and copy the app URL. 

19. Under Exclusion Requests, hover over the card and click the settings button. 

20. Click the Learn More button and click Edit. 

21. Enter the Mosquito Spray Exclusion app URL in the Link Destination text box and 
click Add Link. 

  Tip: 

  Browse to the Mosquito Spray Exclusion app. Open the item page, click View 
Application, and copy the app URL. 

22. Scroll to the How you can help section. 

  The Take the Pledge text is provided as a placeholder for your organization to add your 
own Survey123 form or organization resource. Update the Pledge Now button URL or 
remove this section if not applicable. To update the button, hover over the card and click 
the settings button. Click the Pledge Now button and click Edit. Enter the Survey123 form 
or organization resource URL in the Link Destination text box and click Add Link. Or 
remove the Pledge Now button by clicking the settings button, selecting the button text, 
and pressing the Backspace key. 

23. Under Adopt-A-Catch Basin, hover over the Adopt a Catch Basin card and click 
the settings button. 

24. Click the Learn More button and click Edit. 

25. Enter the Adopt-A-Catch Basin app URL in the Link Destination text box and click 
Add Link. 

  Tip: 

  Browse to the Adopt-A-Catch Basin app. Open the item page, click View Application, 
and copy the app URL. 
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26. Click Save. 

 

Share items with the public 
Several layer views, maps and apps included in the Mosquito Surveillance, Mosquito 

Treatments, and Adopt-A-Catch Basin solution must be shared with everyone so they can be 

accessed by the public on the Mosquito Control site. To share your items with everyone, use the 

guide below and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Mosquito Surveillance folder. 

2. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   MosquitoSurveillance_public 

  Feature Layer (hosted, view)   MosquitoHealthConcerns_public 

  Web Map   Mosquito Population Surveillance Charts 

  Web Map   Mosquito Health Concerns Summary 

  Web Mapping Application   Mosquito Population Surveillance Charts 

  Web Mapping Application   Mosquito Health Concerns Summary 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 

6. Browse to the Mosquito Treatments folder. 

7. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   MosquitoTreatments_public 

  Feature Layer (hosted, view)   SprayExclusions_survey 

  Web Map   Mosquito Spray Areas 
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  Form   Mosquito Spray Exclusions 

  Web Mapping Application   Mosquito Spray Areas 

8. Click Share. 

9.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

10. Click Update. 

11. Browse to the Adopt-A-Catch Basin folder. 

12. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   CatchBasins_public 

  Web Map   Adopt-A-Catch Basin 

  Web Mapping Application   Adopt-A-Catch Basin 

13. Click Share. 

14.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

15. Click Update. 

 

Share Mosquito Service Requests maps and app 
For the Mosquito Service Requests app to be publicly accessible through guest and social 

media access, the maps and layers must be shared with everyone. Follow the steps below to 

share your maps and layers with everyone. 

1. Click Groups at the top of the site. 

2. Open the Mosquito Service Requests group page and click View all group 
content. 

  Note: 

  Review the maps shared to the group. The maps shared to this group will be displayed in 
the Mosquito Service Requests app. 

3. Optionally, add a map or maps to the group by clicking the Add items to group 
and browse to the map or maps. Check the check box next to the map or maps you 
want to add to the group and click Add items. 
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4. Optionally, remove a map or maps from the group by checking the check box next 
to the map and click Remove from group. 

5. Click the Settings tab. 

6.  Under Who can view this group, click Everyone (public), and click Save. 

7. Click Content at the top of the site. 

8. On the My Content tab, under Folders, type Mosquito Service Requests in the 

search box. 

9. Click the Mosquito Service Requests folder. 

10. Under Item Type, click Maps. 

11. On the right side of the page, check the check box next to the maps you want to 
appear in the Mosquito Service Requests app, and click Share. 

12. In the Share window, click Everyone (public) and click Save. 

13. In the Update sharing window, click OK. 

  Note: 

  The layers associated with the maps should also be shared publicly. 

14. Next to Item Type, click Clear. 

15. Under Item Type, click Apps. 

16.  On the right side of the page, click the Mosquito Service Request app. 

17.  On the item page and click Share. 

18. In the Share window, click Everyone (public) and click Save. 

19. Click View Application. 

20. Sign in to the app using one of the sign in options and review the app. 

 

Execute Mosquito Service Requests tools 
You can extend the Mosquito Service Requests solution with a set of Python tools that can be 

used to generate report IDs, moderate reports, send email notifications, and enrich reports. 

These tools can be executed automatically via Task Scheduler, and as new problem reports are 

submitted, or updated, the corresponding action will occur. 

 

Add the ServiceFunctions toolbox 
The ServiceFunctions toolbox contains tools for generating report IDs, moderating reports, 

sending email notifications, and enriching reports. Download and add the ServiceFunctions 

toolbox to your ArcGIS Pro project before configuring the appropriate tools. 

1. Download the ServiceFunctions toolbox. 

2. Browse to the ServiceSupport.zip file and unzip the file to the location from 

which you want to the tools to execute. 

3. Open ArcGIS Pro and create a new project. 
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4. Sign in to the ArcGIS organization to which you deployed the Mosquito Service 
Requests solution, if necessary. 

5. On the View tab, in the Windows group, click the Catalog pane, if necessary. 

6. In the Catalog pane, right-click Toolboxes and choose Add Toolbox. 

  The Add Toolbox dialog box appears. 

7. Browse to the ServiceSupport folder. 

8. Click the ServiceSupport.pyt Python toolbox, and click OK. 

9. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

  If you've never used the ServiceSupport toolbox before, run the Define Connection 
Settings tool to establish a connection between the toolbox and the MosquitoObservations 
feature layer. 

10. In the Catalog pane, in the ServiceSupport.pyt Python toolbox, double-click the 
Define Connection Settings tool. 

11. In the ArcGIS Online organization or ArcGIS Enterprise portal URL parameter, 
click the drop-down arrow and choose a URL. 

12. In the Username parameter, type your user name for the organization you chose in 
step 11. 

13. In the Password parameter, type your password for the user name provided in the 
Username. 

14. Click Run. 

 

Generate report IDs 
Many workflows require you to generate a unique identifier when a feature or record is created 

so it can be referenced and tracked in other workflows. You can use the Generate IDs tool to 

configure custom unique identifiers that will be applied to features at a regularly scheduled 

interval of your choosing. The tool only generates the configuration; you must run an additional 

script (provided) to update the features with incrementing identifier values. 

Note: 

You may need to add a new field to the MosquitoObervations feature layer to store the 
unique identifier created in this workflow. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt, if necessary. 

2. Double-click the Generate IDs tool. 

3. In the Layer parameter, click Browse. 

  The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Mosquito Service Requests folder. 

6. Double-click the MosquitoObservations feature layer. 

7. Click Mosquito Observations and click OK. 

  Expand General Identifier Settings. If the tool has not been run previously, start by 
specifying at least one identifier sequence. 
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8. In the Sequence Name parameter, type a name for the sequence. 

  This value appears in the drop-down menu for selecting the sequence to assign to each 
layer. 

9. In the Pattern parameter, type a pattern to use for the sequence. 

  This can be a combination of letters, numbers, and symbols. Mark the location for the 
incrementing value with a pair of curly braces {}. Python formatting is applied to the pattern 
text, so string formatting syntax such as {0:03d} pads the incrementing number section with 
zeros to a length of 3. For example, the expression seq-{0:05d} creates the following 
pattern of values: seq-00001, seq-00002, seq-00003, and so on. 

10. In the Next Value parameter, type a value. 

  When initially creating the sequence, this must be the first value in the identifiers. After this 
point, this value shows the value to be used for the next identifier generated. 

11. In the Interval parameter, type a value. 

  The interval by which the identifier values increase between features. For example, an 
initial Next Value of 1 and an Interval of 10 creates identifiers with the incrementing values 
of 1, 11, 21, and so on. 

  Deleting or changing these sequences impacts all the layers that are configured to use the 
edited sequences. 

12. Optionally, edit the identifier configuration and run the tool to overwrite the existing 
identifier configuration for the selected layer. 

  Note: 

  If an identifier configuration already exists, a check box appears that, when checked, 
deletes the existing identifier configuration for the selected layer. 

13. Choose the moderation list to use to process the features in the selected layer. 

14. Choose the sequence to use to generate the identifiers for each feature in the 
layer. 

15. Choose a text field to store the generated identifier. 

16. Click Run to write out the identifier configuration for the layer and any changes to 
the identifier sequences. 

17. To configure identifiers for another layer, rerun the tool with the settings for the next 
layer. 

 

Moderate reports 
Public comment apps can occasionally generate feedback that should not be made publicly 

visible. Data entered into specific fields, such as personal information, can be hidden and 

protected using the pop-up configuration and layer security, but sometimes entire comments 

need to be hidden to avoid displaying sensitive or explicit content to other users. 

You can hide features by updating the value of a field so that it no longer meets the 
requirements of a filter applied to that layer in the map. You can use the Moderate Reports tool 
to configure which layers and fields to scan for explicit or sensitive words and phrases and how 
to update the feature so that it can be filtered from the map. You can choose how often to scan 
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features and records. The tool only generates the configuration; an additional script (provided) 
must be run to scan the features. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

2. Double-click the Moderate Reports tool. 

3. In the Layer parameter, click Browse. 

  The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Mosquito Service Requests folder. 

6. Double-click the MosquitoObservations feature layer. 

7. Click Mosquito Observations and click OK. 

  Expand General Moderation Settings. If the tool has not been run previously, start by 
specifying at least one moderation list. 

8. In the List Name parameter, type a name. 

  This value appears in the drop-down menu for selecting the moderation list use when 
scanning each layer. 

9. In the Filter Type parameter, click the drop-down arrow and choose to scan feature 
for words and phrases that exactly match the provided list of words and phrases. 

  For example, when the filter type is EXACT, if the list contains the word duck, the script 
updates the specified field when the feature contains the word duck, but not when it 
contains the word duckling. When the filter type is FUZZY, the script updates the feature 
when either duck or duckling are found. 

10. In the Words and Phrases parameter, type a word or phrase. Provide a comma-
separated list of words or phrases to scan for. 

  Keep in mind that deleting or changing these lists will impacts all the layers that are 
configured to use the edited sequences. 

11. If a moderation configuration already exists for the selected layer, choose to edit an 
existing configuration by selecting the name of the moderation list used in the 
configuration, or choose the option to add a new moderation configuration. 

  If you choose to edit an existing configuration, a check box appears that, when checked, 
deletes the existing moderation configuration for the selected layer. Alternatively, edit the 
moderation configuration and run the tool to overwrite the existing moderation configuration 
for the selected layer and moderation list. 

  To add a new moderation configuration, click the Add New button and continue with the 
following steps. 

12. Choose the moderation list to use to process the features in the selected layer. 

13. Choose the fields that will be scanned for content that matches the words and 
phrases in the selected moderation list. 

14. Optionally, provide an SQL query to only apply moderation to some features. 

  If no query is provided, all features are processed. 

15. Use the Field to Update parameter when a match is found between the value of a 
field and the content of a moderation list. Use the Found Value parameter to 
specify the value that should be written to this field indicating a match. 
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16. Click Run. 

 

Send email notifications 
Many workflows require that an email be sent when a feature or record is created and updated. 

You can use the Send Emails tool to configure emails that can be sent based on attribute 

values and a schedule of your choosing. The tool only generates the configuration; you must 

run an additional script (provided) to actually generate and send the emails. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

2. Double-click the Send Emails tool. 

3. In the Layer parameter, click Browse. 

  The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Mosquito Service Requests folder. 

6. Double-click the MosquitoObservations feature layer. 

7. Click Mosquito Observations and click OK. 

  All existing email settings for the layer load and can be edited by updating the parameter 
values for each configuration. To delete a single email configuration, click the Remove 

button  next to the configuration. To delete all the email configurations for the layer, 
check the Delete all existing email configurations for this layer check box. Run the tool 
to save your changes. 

8. In the Email Template parameter, click Browse to access the ServiceSupport 
folder. 

9. Click one of the HTML templates for the body of the email, and click OK. 

  To add attributes from the triggering feature to the email, use unique string keys in the 
places where the values should appear in the HTML and reference these strings in the 
Find parameter of the Email Substitutions section of the General Email Settings along 
with the name of the field that contains the value to be substituted for the string key in the 
Replace parameter. 

10. Click one of the HTML templates for the body of the email, and click OK. 

  To add attributes from the triggering feature to the email, use unique string keys in the 
places where the values should appear in the HTML and reference these strings in the 
Find parameter of the Email Substitutions section of the General Email Settings along 
with the name of the field that contains the value to be substituted for the string key in the 
Replace parameter. 

11. In the Recipient Email Address parameter, type an email address of the recipient 
or the name of a field in the layer that contains the address of the recipient. 

12. In the Email Subject parameter, type the subject for the email. 

  Similar to the email body provided in the HTML document, this text can contain string keys 
that will be swapped out for attribute values based on the Find and Replace values 
defined in the Email Substitutions list in the General Email Settings section. 
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13. In the Field to Update parameter, type Email. When the email has been sent for 

each feature, use the Sent Value parameter to specify the value that should be 
written to this field indicating that the email has been sent. 

  This field and value can be used in the previously described SQL query to prevent 
duplicate emails from being sent. 

14. Configure additional emails to be sent for the currently selected layer by clicking the 
Add New button. 

  Emails will be sent in the order they are configured. Expand General Email Settings. If the 
tool has not been run previously, start by specifying the connection information for your 
SMTP server in the tool. 

15. In the SMTP Server parameter, type the URL of the SMTP server used for sending 
emails. 

16. In the SMTP Username parameter, type the user name required to authenticate to 
the SMTP server. This is not required if authenticating through a port. 

17. In the SMTP Password parameter, type the password required to authenticate to 
the SMTP server. This is not required if authenticating through a port. 

18. In the From Address parameter, type the address from which the emails should be 
sent. 

19. In the Reply Address parameter, type the address that should be used for any 
replies to the email message. 

20. Check or uncheck the Use TLS check box to turn on or off TLS. 

21. In the Email Substitutions section, type Find and Replace values. Swap out one 
piece of text for another in the outgoing email subject or body.  

  Anywhere a value in the Find parameter is found in the email subject or body, it will be 
replaced with the corresponding value from the Replace parameter. If the value in the 
Replace parameter is a field in the layer, the Find value will be replaced with the value in 
that field in the triggering feature. For example, to add the ID of a feature from the 
REQUESTID field to the email subject, include a piece of text such as {ID} in the 
configured Email Subject, and add {ID} to the Find parameter and REQUESTID to the 
Replace parameter. All specified substitutions are applied to all emails configured for all 
layers so, while the Find values can be any piece of text, it's suggested that you use 
something that is clearly variable-like and unlikely to appear elsewhere in the messages in 
a literal form. 

  Deleting or changing these settings impacts all the emails for all the layers configured with 
this tool. 

22. Click Run. 

 

Enrich reports 
Reports made in public comment apps can be enriched with information about the report 

location. You can then use this information to efficiently direct the report to the correct person or 

agency responsible for its resolution. 

You can then use the Enrich Reports tool to configure which attribute values to calculate from a 
coincident or intersecting set of features at a regularly scheduled interval of your choosing. Note 
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that the tool only generates the configuration; you must run an additional script (provided) to 
update the features based on intersecting features. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

2. Double-click the Enrich Reports tool. 

3. In the Layer parameter, click the browse button. 

  The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Mosquito Service Requests folder. 

6. Double-click the MosquitoObservations feature layer. 

7. Click Mosquito Observations and click OK. 

8. In the Enrichment parameter, if an enrichment configuration already exists for the 
selected layer, choose to either edit an existing configuration by selecting the 
configuration from the drop-down list, or choose the option to add a new 
enrichment configuration. 

  If you choose to edit an existing configuration, a check box appears that, when checked, 
deletes the existing enrichment configuration for the selected layer. Alternatively, edit the 
configuration and run the tool to save the changes. To add a new enrichment configuration, 
click the Add New button and continue with the following steps. 

9. Choose the polygon feature layer that will provide the enriching attribute values by 
either choosing a layer from the active map or by browsing to your hosted content 
and choosing a polygon feature layer. 

10. In the Source Field parameter, click the drop-down arrow and choose a field from 
the enrichment layer. 

11. In the Target Field parameter, click the drop-down arrow and choose a field from 
the MosquitoObservations feature layer. 

  The script does not process features that already have a value in the target field. 

12. In the Priority parameter, type a value. Specify the priority that should be given to 
this enrichment configuration relative to the other configurations for the 
MosquitoObservations feature layer. 

  Enrichment configurations for a layer that have a lower priority value will override 
enrichment configurations with a higher value. For example, a layer has two enrichment 
configurations that use the same target field, but one has a priority value of 1 and the other 
has a priority of 2. If the configuration with priority 1 does not produce a valid value for the 
field, the field is populated with the value produced from the configuration with priority 2. 

13. Click Run. 

 

Set up Task Scheduler 
Use Windows Task Scheduler to schedule the script to generate report IDs when a feature or 

record is created, moderate reports when feedback contains inappropriate language, send email 

notifications when a feature or record is created or updated, or enrich reports. All the tools in 

this toolbox share a common configuration file and execution script, so only one scheduled task 

is required to automate running all the associated processes. 
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1. Open the Task Scheduler on the computer that is hosting the scripts. 

2. Click Action > Create Task and name your task. 

3. Click the Action tab and click New. 

4. Set Action to Start a Program. 

5. Browse to the location of your Python 3 installation (for example, <default 
directory>\C:\Program Files\ArcGIS\Pro\bin\Python\envs\arcgispro-
py3\python.exe). 

6. In the Add arguments text box, type the name of the script 
(servicefunctions.py). 

7. In the Start in text box, type the path to the folder where your script is and click 
OK. 

8. Click the Trigger tab, click New, and set a schedule for your task. 

9. Click OK. 

When the trigger occurs, the scripts begin scanning the configured layers and, for each one, 

processing (in order) configurations for generating identifiers, enriching reports, moderating 

reports, and sending emails. 
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Use Mosquito Service Requests 
The Mosquito Service Requests solution delivers a set of capabilities that help you solicit 

mosquito activity reports from the public, triage reports to staff and field crews for resolution and 

monitor the resolution of reports in a community. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Report mosquito activity 
You will first assume the role of a member of the community seeking information about 

mosquito control services. You will use the Mosquito Control site to learn about mosquito 

abatement services in your community and how you can report mosquito activity and potential 

breeding sites. Reports you submit using the Mosquito Service Request app will be immediately 

available to the local Mosquito Control Agency. 

1. In a browser, from the Mosquito Service Requests solution, view the Mosquito 
Control site. 

2. Scroll to the Report a Problem section, and then click Submit a Request to open 
the Mosquito Service Request app.  

  Tip: 

  You can jump directly to the Report a Problem section by clicking the Outreach button 
in the What are we doing to help section. 

3. On the Mosquito Service Request splash page, click Proceed as Guest. 

4. At the lower right, in the Mosquito Reports panel, click Submit a Report. 

5. For Type of Problem, click the drop-down arrow and choose the problem type. 

6. Complete the form with as much information as possible. 

7. At the bottom of the form, for Location, type the address to set the report location; 
alternatively, click the location on the map. 

8. Click Report It to submit the report. 

9. At the top of the Mosquito Reports form, click the Back button. 

10. At the top of the Mosquito Reports panel, click your problem report submission. 

  Your problem report appears. You will be able to monitor changes to the report here as the 
report moves through its life cycle (Submitted, Received, In Progress, and Completed). 
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Respond to mosquito reports 
Next, you will assume the role of an operations manager responsible for handling submitted 

mosquito activity reports. You will use the Mosquito Service Request Manager app to triage 

submitted reports and assign reports to the field inspectors responsible for resolution. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Mosquito 
Service Requests solution.  

2. View the Mosquito Service Request Manager app. 

  All submitted reports are listed in the table at the top. The table can be sorted and filtered 
in various ways. 

3. In the table, use the column header filters and arrows to filter results. 

4. In the table, select a report with a status of Submitted. 

  The report details open at the lower left. 

5. In the report details, click the Edit Record button . 

6. Change the status to Received, and then click Save. 

  Field inspectors are ready to address the problem. You'll change the status to In Progress 
and assign the report to the specific mosquito abatement district. 

7. Click the Edit Record button again. 

8. Change the status to In Progress. 

9. Click the Assigned To drop-down arrow and choose the appropriate district. 

10. Click Save. 

 

Update reports from the field 
Now, you will assume the role of a field inspector responsible for addressing mosquito activity 

reports submitted by the public. 

In addition to verifying and updating the status of public reports, field inspectors can also record 
the type of mosquitoes found on site, recommend treatments, and record any adulticide or 
larvicide treatments applied while on site. Status updates that are provided in the Mosquito Field 
Operations app will be immediately viewable to the public in the Mosquito Service Request app, 
and detailed information will be immediately available to operations managers in the Mosquito 
Service Request Dashboard app. 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Open ArcGIS Field Maps and sign in to your ArcGIS organization. 

3. Tap Mosquito Field Operations to open the map. 

4. On the map, locate a reported problem, and then tap it to see details and additional 
options. 

5. At the lower left, tap Edit. 

6. Swipe up on the form and tap Status, and then tap Completed. 

7. Complete the rest of the form with information from your field inspection, such as 
information related to the people contacted at the location; the date; observations 
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about the mosquitoes or larvae found on site; and what type of treatments, if any, 
were used. 

8. If applicable, tap Take Photo to take and attach a photo to document any standing 
water or water-retaining receptacles found during the inspection. 

9. When you're finished, tap Submit. 

 

Monitor activity reports 
Finally, you will assume the role of an operations manager responsible for overseeing mosquito 

abatement activity and reports submitted by the public. You will use the Mosquito Service 

Request Dashboard app to monitor incoming reports submitted by the public. Relevant metrics 

can be viewed at a glance or examined in more detail if time permits. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Mosquito 
Service Requests solution.  

2. View the Mosquito Service Request Dashboard app. 

3. Review the metrics. 

4. On the left, use the filters to refine the results by request type, status, or date. 

  When you filter results, the bar charts and number of reports in the Mosquito Reports 
panel update. 

5. On the right, in the Mosquito Reports panel, click a report to view the location. 

6. Click the point on the map to get detailed report information. 
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Mosquito Surveillance 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Mosquito Surveillance 
Mosquito Surveillance can be used to monitor mosquito populations and track the location of 

positive vector-borne disease test results. 

Routine monitoring of larval and adult mosquito populations is critical to a successful mosquito 
control program. When data is tracked and compared over time, agencies can use this 
knowledge to predict recurring problem areas, times of year, and the potential for increased risk 
of vector-borne diseases. When vector-borne disease cases do arise, health and human 
services agencies must communicate information in a timely and effective manner with the 
public and mosquito control agencies. Mosquito control agencies can then use this information 
to plan adulticide spray operations that prevent the spread of vector-borne diseases. Mosquito 
Surveillance is typically implemented by public works, health and human services, and mosquito 
control agencies that want to use data to proactively plan spray areas and reduce the risk of 
vector-borne diseases. 

The Mosquito Surveillance solution delivers a set of capabilities that help you record mosquito 
counts by species at surveillance sites; visualize trends over time; track where mosquitoes, 
chickens, birds, or humans have tested positive for vector-borne diseases; and share this 
information with internal and external stakeholders. 

 

Requirements 
Mosquito Surveillance requires the following: 

• ArcGIS Enterprise 

 

Information products 
Mosquito Surveillance includes the following information products: 

Item Description 
Minimum user 
type 

Mosquito Health 
Concerns 

An ArcGIS Web AppBuilder app used by mosquito 
control and public health staff to track locations where 
mosquitoes, chickens, birds, or humans have tested 
positive for a vector-borne disease 

Editor 
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Mosquito Health 
Concerns 
Summary 

An ArcGIS Web AppBuilder app used by mosquito 
control and public health staff to communicate 
positive vector-borne disease test results to the 
general public 

Not required 

Mosquito 
Population 
Surveillance 

A Crowdsource Polling app used by biologists and 
field inspectors to record mosquito counts by species 
at surveillance sites 

Editor 

Mosquito 
Population 
Surveillance 
Charts 

An ArcGIS Web AppBuilder app used by mosquito 
control agencies to visualize population changes over 
time through informative charts 

Viewer (required for 
internal 
stakeholders) 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Mosquito Surveillance 
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Use Mosquito Surveillance 
The Mosquito Surveillance solution delivers a set of capabilities that help you record mosquito 

counts by species at surveillance sites; visualize trends over time; track where mosquitoes, 

chickens, birds, or humans have tested positive for vector-borne diseases; and share this 

information with internal and external stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Monitor mosquito populations 
You will first assume the role of a biologist with the mosquito control agency responsible for 

processing the samples collected at the trap sites across the community. You will use the 

samples to identify the species of mosquitoes and the size of the population and record the 

counts for each surveillance site. 

You can then visualize trends and share current and historical mosquito population data with 
internal stakeholders. This information can also be used to educate the public about the types of 
mosquitoes prevalent in the area, the diseases they can carry, when they are most active, and 
how to best protect themselves from the spread of vector-borne diseases. 

1.  In a browser, sign in to your ArcGIS organization, and then browse to the Mosquito 
Surveillance solution. 

2. View the Mosquito Population Surveillance app. 

3. From the list or the map, select one of the surveillance sites. 

  You see the details on the site and a history of counts by species recorded in past 
observations. 

4. Click the Add a comment button. 

5. Fill in the counts for each species found at the surveillance site. 

6. Click Submit. 

7. Repeat these steps for each surveillance site. 

  You can now visualize the trends of the various species of mosquitoes at each surveillance 
site over time. 

8. From your ArcGIS organization, view the Mosquito Population Surveillance Charts 
app. 

9. In the Population Charts widget, search for a location; alternatively, click a point 
on the map. 

10. In the widget, click a mosquito species to see the population trend for the 
surveillance site. 
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Track vector-borne diseases 
You will continue your role as a biologist with the mosquito control agency. You typically send a 

small sampling of mosquitoes collected at each surveillance site to the lab to be tested for 

vector-borne disease. Dead birds are often reported or found in the community and sent for 

testing as well. Health departments may share with mosquito control agencies the general 

locations (so that personal health information is protected) where a vector-borne disease has 

been transmitted to a human. 

You will track where mosquitoes, chickens, birds, or humans have tested positive for vector-
borne diseases. This information can be used to plan adulticide spray operations that prevent 
the spread of a disease. It can also be used to educate the public about the types of vector-
borne diseases found in the community and how they can help prevent the spread of disease. 

1.  In a browser, sign in to your ArcGIS organization, and then browse to the Mosquito 
Surveillance solution. 

2. View the Mosquito Health Concerns app. 

3. In the Edit widget, click a template. 

4. Click the map to place the location at which the disease was found. 

5. Complete the Public Health Reports form with the details of the agent carrying the 
disease, when it was reported, and any additional comments. 

6. Click Save. 

7. At the top of the Edit widget, click the All drop-down arrow and choose Public 
Health Concerns. 

  The Public Health Concerns template can be used to generalize the location of positive 
tests in a human to avoid revealing personal health information. 

8. Click the Public Health Concerns template. 

9. On the map, draw the boundary of the generalized location of the positive human 
case. 

10. Complete the Public Health Concerns form with the details of the type of disease, 
when it was reported, and any additional comments. 

11. Click Save. 

  You can now visualize locations and counts of vector-borne cases across the community. 

12. From your ArcGIS organization, view the Mosquito Health Concerns Summary app. 

13. In the Health Concerns widget, expand Mosquito and Bird Cases and Human 
Cases to view the counts by each disease. 

14. Pan and zoom around the map to see how the counts change for different areas in 
the community and find areas of concentration. 
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Mosquito Treatments 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Mosquito Treatments 
Mosquito Treatments can be used to manage adulticiding and larviciding activities and share 

treatment plans with the general public. 

Protecting public health is at the center of all mosquito control programs, and effective treatment 
strategies are critical to controlling mosquito populations. Public works and mosquito control 
agencies use adulticides to kill adult mosquitoes and larvicides to target mosquito larvae in 
breeding habitats. When adulticides are applied to control mosquito populations, agencies must 
proactively share this information with the public and give residents an opportunity to request an 
exclusion or be notified prior to treatment. This ensures that individuals who have concerns 
about chemical treatments can avoid having their home sprayed or seek temporary shelter 
when spraying does occur. Mosquito Treatments is typically implemented by public works and 
mosquito control agencies that want to increase transparency, grow public trust, and improve 
relationships with the communities they serve. 

The Mosquito Treatments solution delivers a set of capabilities that help you plan adulticide 
spraying operations, solicit requests for spray notifications and exclusions, maintain spray 
exclusion areas, record larvicide treatments in the field, and share spray areas with internal and 
external stakeholders. 

 

Requirements 
Mosquito Treatments requires the following: 

• ArcGIS Enterprise 

• ArcGIS Field Maps 

• ArcGIS Survey123 Connect 

 

Information products 
Mosquito Treatments includes the following information products: 
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Item Description 
Minimum 
user type 

Mosquito Larvicide 
Reporting 

An ArcGIS Field Maps map used by public works and 
mosquito control personnel to test larvicide sites and 
record any treatments applied at those sites 

Field Worker 

Mosquito Adulticide 
Planning 

An ArcGIS Web AppBuilder app used by public works and 
mosquito control personnel to plan adulticide spraying 
operations and maintain spray exclusion areas 

Editor 

Mosquito Spray 
Areas 

An ArcGIS Web AppBuilder app used by the general public 
to locate recent and planned adulticide spraying areas 
near their home or business 

Not required 

Mosquito Spray 
Notifications 

An ArcGIS Survey123 form used by the general public to 
request a notification of adulticiding or larviciding near their 
home or business 

Not required 

Mosquito Spray 
Exclusions 

An ArcGIS Survey123 form used by the general public to 
request an exclusion from adulticiding or larviciding near 
their home or business 

Not required 

Mosquito Spray 
Exclusions 
Manager 

A Crowdsource Manager app used by public works and 
mosquito control personnel to manage adulticide and 
larvicide exclusion requests from the general public 

Editor 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Mosquito Treatments 
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Use Mosquito Treatments 
The Mosquito Treatments solution delivers a set of capabilities that help you plan adulticide 

spraying operations, solicit requests for spray notifications and exclusions, maintain spray 

exclusion areas, record larvicide treatments in the field, and share spray areas with internal and 

external stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Plan spray operations 
First, you will assume the role of a mosquito control agency staff member responsible for 

managing adulticide operations. You will use the Mosquito Adulticide Planning app to plan 

adulticide spray operations, update the status of spray areas to indicate whether treatments 

were completed, and maintain exclusion areas in the community. 

Updates to adulticide treatment areas will be immediately available to the public and viewable in 
the Mosquito Spray Areas app. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Mosquito 
Treatments solution. 

2. View the Mosquito Adulticide Planning app. 

  The Edit widget enables you to create new and update existing adulticide treatment or 
treatment exemption areas. 

3. To create an adulticide treatment area, click the Adulticide Treatment Areas 
template. 

4. Click the map to draw the adulticide treatment area and double-click to finish 
drawing the polygon. 

  After you finish drawing the area, the Planned Adulticide Areas form opens in the Edit 
widget. 

5. Complete the form with as much information as possible, and then click Save. 

  Existing adulticide treatment areas and treatment exemption areas can also be edited and 
deleted. 

6. On the map, select an existing planned adulticide area. 

  The area's Planned Adulticide Areas form opens in the Edit widget. Here, you can 
correct errors, update information, or modify the area's geometry. 

7. Make necessary updates to the form: 

a. Correct errors directly in the form. 

b. To edit the area's geometry, check the Edit Geometry check box, and then 
modify the area's vertices. 
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c. After the spray occurs, add the Actual Spray Date parameter. 

d. Alternatively, to delete the area, click the Delete button. 

  Updating the planned adulticide area with an actual spray date changes the symbology to 
show the area as an actual adulticide area. 

8. Click Save. 

  You can also choose which layers are visible on the map. 

9. On the right, at the top of the panel, click the Layer List button to open the widget. 

10. To view the layer of recently treated areas, check the Actual Adulticide Area 
check box. 

 

Locate mosquito spray areas 
Now, you will assume the role of a resident in the community who is interested in learning about 

mosquito spraying near your home or business. You will use the Mosquito Spray Areas app to 

locate recent and planned adulticide spraying areas near your home. 

1. In a browser, from the Mosquito Treatments solution, view the Mosquito Spray 
Areas app. 

2. In the Find Spray Areas widget, search for an address; alternatively, click the 
location on the map. 

3. In the widget, review the Recent Spray Area details. 

  The app provides details on when the spray occurred or is planned to occur, along with the 
method and any comments from the agency. 

   

Request spray notifications 
After reviewing recent and planned adulticide spraying in the community, you have determined 

that you want to be notified of future spraying. You will use the Mosquito Spray Notifications app 

to submit your contact information to the mosquito control agency so you can be notified of 

future operations. 

1. In a browser, from the Mosquito Treatments solution, view the Mosquito Spray 
Notifications app. 

2. Complete the Mosquito Spray Notifications form with as much information as 
possible.  

  Required fields are marked with a red asterisk. The Request Date field is automatically 
populated with the current date. 

3. Click Submit. 

 

Request a spray exclusion 
You will now assume the role of a resident in the community with strong allergies to pesticides. 

You want to have your home excluded from adulticide spraying. You will use the Mosquito 

Spray Exclusion app to submit your exclusion request to the mosquito control agency. The 
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agency will review your request and may follow up for more information, and if approved, it will 

include your exclusion into its adulticide operation planning for future spraying. 

1. In a browser, from the Mosquito Treatments solution, view the Mosquito Spray 
Exclusion app. 

2. Complete the Application for Pesticide Exclusion form with as much information 
as possible.  

  Required fields are marked with a red asterisk. The Request Date field is automatically 
populated with the current date. 

3. Sign the form and click Submit to complete the exclusion request. 

 

Manage exclusion requests 
As an operations manager, you will use the Mosquito Spray Exclusions Manager to manage 

adulticide and larvicide exclusion requests from the public. Approved exclusion requests will be 

immediately available to biologists and other staff planning adulticide operations. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Mosquito 
Treatments solution. 

2. View theMosquito Spray Exclusions Manager app. 

  All exclusion requests are listed at the top of the table. The table can be sorted and filtered 
in various ways. 

  A Submitted status indicates requests that have not yet been reviewed by staff. 

3. In the table, in the Status column, click the filter, and then for Status is, choose 
Submitted. 

4. Click an exclusion request. 

  The request details open at the lower left. After a request has been received, staff 
members review it for completeness, including forms, signatures, and justification. 

5. On the Application Info tab, click the Edit button , and then for Status, 
choose Staff Review. 

6. Click an exclusion request to open its details. 

7. Click Edit, and then for Status, choose Approved. 

8. Click Save. 

  Approving the exclusion request removes the request from the Mosquito Spray Exclusions 
Manager app and promotes it to the Mosquito Adulticide Planning app, where you can use 
it to plan mosquito spray areas and known exemption areas. 

   

Control juvenile mosquitoes 
As a field biologist for a mosquito control agency, you are responsible for inventorying larvicide 

sites, recording inspection results at each site, and documenting larvicides applied. Using the 

Mosquito Larvicide Reporting map, you will also be able to add new inspection sites as well as 

update the status of each site. 
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Add a new inspection site 
On occasion, new inspection sites will be added. You will use the Mosquito Larvicide Reporting 

map to make these changes. 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Open ArcGIS Field Maps and sign in to your ArcGIS organization. 

3. Tap the Mosquito Larvicide Reporting map to open it. 

4. Tap Add to add a new inspection site. 

  By default, ArcGIS Field Maps uses your current location. 

5.  Pan or zoom to the site location, and then tap Add Point. 

6. Swipe up on the form, if necessary, and then for Location, type a location name or 
description. 

7. Tap Status and choose Active. 

8. When you're finished, tap Submit. 

 

Complete a site inspection 
After an inspection at each site is complete, a history of larviciding in a community can be 

reported. 

1. On the Mosquito Larvicide Reporting map, tap an existing larvicide site. 

2. In the form, under Related, tap Larvicide Inspections. 

3. Tap Add to begin documenting your larvicide inspection results. 

4. Swipe up, if necessary, and then complete the inspection form. 

5. When you're finished, tap Submit. 

 

Retire an inspection site 
On occasion, inspection sites will need to be retired. You will use the Mosquito Larvicide 

Reporting map to make these changes. 

1. On the Mosquito Larvicide Reporting map, tap the existing larvicide site that you 
want to retire. 

2. Tap Edit. 

3. Tap Status and choose Retired. 

4. When you're finished, tap Submit. 
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Multi Source Data Feeds 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Multi Source Data Feeds 
Multi Source Data Feeds solution can be used to visualize global incidents in ArcGIS. 

Businesses need access to critical information with confidence, to enable organizational 
response to incidents at different levels and across different business units. This is needed to 
allow organizations to see beyond the horizon and react to real-time incidents across the globe. 
Round-the-clock access to incident data is at the cornerstone of this need. Multi Source Data 
Feeds is typically implemented by organizations that rely on event feeds to understand incidents 
across the globe. 

The Multi Source Data Feeds solution delivers a set of capabilities that provides awareness in 
near real time to incidents around the globe. This access is enabled by Esri business partners 
that curate event information into one location and allow consumption through the business 
partner APIs. 

 

Requirements 
Multi Source Data Feeds requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 - 2.7 (Basic) 

 

Information products 
Multi Source Data Feeds includes the following information products: 

Item Description 
Minimum user 
type 

Dataminr Alerts 
Dashboard 

An ArcGIS Dashboards app used to visualize and 
interact with incidents from Dataminr 

Viewer 

Factal Incidents 
Dashboard 

An ArcGIS Dashboards app used to visualize and 
interact with incidents from Factal 

Viewer 

Multi Source Data 
Feeds Desktop 

An ArcGIS Pro project package used to connect and 
ingest data feeds from a variety of data providers 

GIS Professional 
Basic 
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Release notes 
The following are the release notes: 

Version Description 

1.1 • Shortened the field length for all fields to cut down on storage. 
• Added support to store credentials in Credential Manager. 

1.0 • First release of Multi Source Data Feeds 
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Configure Multi Source Data Feeds 
In this topic, you will learn how to configure the Multi Source Data Feeds solution to meet 

specific needs in your organization. 

 

Review the Multi Source Data Feeds project 
The Multi Source Data Feeds solution includes an ArcGIS Pro project. Before configuring the 

solution and using the workflows with your data, familiarize yourself with the contents of the 

Multi Source Data Feeds Desktop project. 

To review, complete the following steps: 

1. Start ArcGIS Pro. 

  Note: 

  Ensure that you are signed in to the user name with which Multi Source Data Feeds was 
deployed. 

2. In the lower right corner, click Open another project. 

3. In the left pane under Portal, click My Content and browse to the folder where 
Multi Source Data Feeds was deployed. Select Multi Source Data Feeds Desktop 
and click OK to open. 

4. Click the View tab along the top of the ribbon. 

5. Click Tasks in the Windows group to open the Multi Source Data Feeds Tasks to 
configure, manage, and automate the data feeds. 
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Use Multi Source Data Feeds 
The Multi Source Data Feeds solution delivers a set of capabilities that provides awareness in 

near real time to incidents around the globe. This access is enabled by Esri business partners 

that curate event information into one location and allow consumption through the business 

partner APIs. 

Note: 

To view content from premium providers, API keys must be acquired from the data 
provider. 

In this topic, you will learn how to use the Multi Source Data Feeds solution and the set of 
capabilities and features that it provides. 

 

Explore the Dataminr dashboard 
1. In a browser, sign in to your ArcGIS organization and click the Content tab. 

2. On the left side, under Folders, click Multi Source Data Feeds. 

3. Click the Dataminr Alerts Dashboard to open into the item description page, then 
click View Dashboard. 

4. Zoom in to an area of interest in the United States. 

  Note: 

  Holding the Shift key on your keyboard enables the area selection tool in the map. This 
will zoom in to the extent of the selected area. 

  Notice as you zoom in or pan around, the set of metrics along the bottom of the application 
and the alerts in the list on the left side dynamically update. This map-driven capability 
provides context into what is within your view. 

5. Along the bottom of the map are a set of tabs; click Data Overview. 

  This tab contains a set of metrics to provide context into the magnitude of alerts over time 
and by category. The metrics are based on alerts within your view. 

6. Switch to the Map Overview tab and in the Publisher Category drop-down list, 
select a value. 

  Notice that with this filter enabled, the set of metrics along the bottom of the application, the 
alerts in the list on the left side, and the map automatically update. 

7. Click an incident in the list. This will zoom to the selected feature and open the pop-
up with additional alert details. 

8. Scroll to the bottom of the pop-up and click the link to view more details on this alert 
in Dataminr by signing in to your Dataminr account. 
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Explore the Factal dashboard 
1. In a browser, sign in to your ArcGIS organization and click the Content tab. 

2. On the left side, under Folders, click Multi Source Data Feeds. 

3. Click the Factal Incidents Dashboard to open into the item description page, then 
click View Dashboard. 

4. In Filter Incidents by, click This Week. 

  Notice that with this filter enabled, the inset map and the set of metrics along the right side 
of the application, the locations in the list on the left side, and the map automatically 
update. 

5. Zoom in to an area of interest in the United States. 

  Note: 

  Holding the Shift key on your keyboard enables the area selection tool in the map. This 
will zoom in to the extent of the selected area. 

  Notice as you zoom in or pan around, the set of metrics along the right side of the 
application and the locations in the list on the left side dynamically update. This map-driven 
capability provides context into what is within your view. 

6. Along the bottom of the map are a set of tabs; click Data Overview. 

  This tab contains a set of metrics to provide context into the magnitude of incidents over 
time. The metrics are based on incidents within your view. 

7. Switch to the Map Overview tab and click on an incident in the list. This will zoom 
to the selected feature and open the pop-up with additional incident details. 

  Notice the inset map on the right side of the application zooms in and centers on the 
incident. This map provides regional context and awareness of where other incidents have 
appeared. 

8. Scroll to the bottom of the pop-up and click the link to view more details on this 
incident in Factal by signing in to your Factal account. 
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My Neighborhood Services 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to My Neighborhood Services 
My Neighborhood Services can be used to share information about available facilities and 

services in a community. 

It provides 24/7 access to amenities and services to residents, businesses and visitors to help 
them determine if they would like to live, work, or locate a business in the community. This 
approach allows government agencies to communicate available facilities and services timely 
and flexible manner and improves overall quality of life. My Neighborhood Services is typically 
implemented by economic development departments, planning departments, chambers of 
commerce, and other local government agencies that want to promote government services to 
the public. 

The My Neighborhood Services solution delivers a set of capabilities that help you promote 
government facilities and services to the public. 

 

Requirements 
My Neighborhood Services requires the following: 

• ArcGIS Enterprise 

 

Information products 
My Neighborhood Services includes the following information products: 

Item Description 
Minimum 
user type 

My Neighborhood 
Services 

An ArcGIS Web AppBuilder app used by the general public 
to locate government facilities and available services that 
increase the quality of life in a community 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of My Neighborhood Services 
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Configure My Neighborhood Services 
In this topic, you will learn how to configure the My Neighborhood Services solution to meet 

specific needs in your organization. 

 

Load data 
My Neighborhood Services can be used to share information about available facilities and 

services in a community. In some cases, you may have this information in ArcGIS or another 

business system already. 

Review the layers provided with the solution and determine what source data you would like to 
load. Then, load your existing data into the layers provided with the ArcGIS Solution before 
sharing the maps or applications. 

Once you have determined what source data must be loaded, complete the data-loading 
workflows below. 

 

Load data from a shapefile 
Data for EmergencyResponseFacilities, GovernmentFacilities, LandmarkFacilities, 

MailShippingFacilities, MedicalFacilities, ParkRecreationFacitilies, and TransportationFacilities 

can be loaded from a shapefile by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data 
to Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer into which you want to load data and the layer that contains the 
updated data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Configure directions 
Follow the steps below to connect to a routing service and configure the widget to enable 

directions in the app. 

 

Configure widget 
To configure an app to use routes and provide directions, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the ArcGIS Web AppBuilder 
app. 

2. Open the item page and click Edit Application. 

3. Click the Widget tab and click Set the widget in this controler to open the page 
for an in-panel widget.  

4. Hover over the Near Me widget and click the Configure this widget button to open 
the widget configuration window. 

5. Check the Enable Directions check box if it is not checked. 

6. Click the Direction Settings tab, click Set, and choose a routing service. 

7. Click Next and choose one or more route layers, click OK, and click OK again. 

8. Save the app and share it with everyone. 

9. Open the app. 

 

Esri premium content 
The app draws routes and provides directions using the ArcGIS Online World Route Service. 

This service requires subscriber access because it consumes credits. See Configure Living 

Atlas content to enable access to premium content. 

Learn more about credit usage when creating simple routes 
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Use My Neighborhood Services 
The My Neighborhood Services solution delivers a set of capabilities that help you promote 

government facilities and services to the public. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Find services 
My Neighborhood Services is an application for the public to find services near them. Members 

of the public can search for an address or click the corresponding map to find information about 

services near them. 

In this workflow, you are a member of the public and want to learn what services are in your 
area. 

1. In a browser, from the My Neighborhood Services solution, view the My 
Neighborhood Services app. 

2. In the Locate Services widget, search for an address; alternatively, click a location 
directly on the map. 

  In the widget, an expandable list of available services near your defined location appears. 

3. Optionally, adjust the slider to increase or decrease the search area. 

4. In the widget, click a service. 

  The map zooms to and highlights the service's location, and details about the service 
appear in the widget. 

5. Review the information provided. 

6. In the widget, click the Directions tab to view driving directions from your defined 
location. 
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My Trash Services 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to My Trash Services 
My Trash Services can be used to share waste pickup schedules and recycling information with 

the general public. 

It provides 24/7 access to an organization, and the location-enabled search helps residents 
quickly find waste pickup schedules and recycling centers and learn what materials are 
accepted. This transparent approach improves communication with the public and addresses 
one of the most frequently asked questions in a community. My Trash Services is typically 
implemented by public works agencies and other local government organizations that want to 
educate the public and promote waste and recycling services available in their community. 

The My Trash Services solution delivers a set of capabilities that help you share typical waste 
pickup schedules with the public, highlight schedule changes, and promote nearby recycling 
centers and the materials accepted. 

 

Requirements 
My Trash Services requires the following: 

• ArcGIS Enterprise 

 

Information products 
My Trash Services includes the following information products: 

Item Description 
Minimum 
user type 

My Trash 
Services 

An ArcGIS Web AppBuilder app used by the general public to 
locate recycling centers and obtain information about curbside 
trash services 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 489 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of My Trash Services 
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Configure My Trash Services 
In this topic, you'll learn how to configure the My Trash Services solution to meet specific needs 

in your organization. 

 

Load data 
In some cases, you may already have this information in ArcGIS or another mapping system. 

Review the layers provided with the solution and determine what source data you want to load. 

Then, load your existing data into the layers provided with the solution before sharing the maps 

or apps. 

Once you have determined what source data must be loaded, complete one or more of the data 
loading workflows below. 

 

Load data from a shapefile 
Load data into the PublicWorksDistrict and TrashRecyclingFacilities layers from a shapefile by 

completing the following steps: 

1. Create a .zip file of your shapefile. 

2. Sign in to your ArcGIS organization and browse to the feature layer you want to 
populate. 

3. Open the item page and click Update Data > Append Data to Layer. 

4.  Click Choose File and browse to your .zip file, and click Open. 

5. Click Upload and Continue. 

6. Click Choose the layer that you wish to append data into drop-down arrow and 
choose the layer that contains the updated data. 

7. Uncheck Update existing features. 

8. Click Show field matching and map the fields between the two layers. 

9. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

 

Configure directions 
Follow the steps below to connect to a routing service and configure the widget to enable 

directions in the app. 

 

Configure widget 
To configure an app to use routes and provide directions, complete the following steps: 
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1. Sign in to your ArcGIS organization and browse to the ArcGIS Web AppBuilder 
app. 

2. Open the item page and click Edit Application. 

3. Click the Widget tab and click Set the widget in this controler to open the page 
for an in-panel widget.  

4. Hover over the Near Me widget and click the Configure this widget button to open 
the widget configuration window. 

5. Check the Enable Directions check box if it is not checked. 

6. Click the Direction Settings tab, click Set, and choose a routing service. 

7. Click Next and choose one or more route layers, click OK, and click OK again. 

8. Save the app and share it with everyone. 

9. Open the app. 

 

Esri premium content 
The app draws routes and provides directions using the ArcGIS Online World Route Service. 

This service requires subscriber access because it consumes credits. See Configure Living 

Atlas content to enable access to premium content. 

Learn more about credit usage when creating simple routes 
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Use My Trash Services 
The My Trash Services solution delivers a set of capabilities that help you share typical waste 

pickup schedules with the public, highlight schedule changes, and promote nearby recycling 

centers and the materials accepted. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Find recycling centers and curbside service 

information 
You will assume the role of a resident in the community, and you want to know when your next 

trash pickup day is and find nearby recycling centers. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the My Trash 
Services solution. 

2. View the My Trash Services app. 

3. In the Locate Services widget, under Search for an address or locate on map, 
type an address in the community and press Enter. 

4. Optionally, click and slide the search buffer by distance. 

  Note: 

  The list updates to display recycling centers and trash, recycling, and yard waste pickup 
details. 

5. Click Recycling Facilities and click one of the facilities. 

  The Information tab displays details about the recycling facility, including materials 
accepted, location, hours of operation, and contact details. 

6. Click the Directions tab. The tab displays turn-by-turn directions from the searched 
address to the closest recycling facility. 

7. Click the Recycling Facilities button once to return to the list of recycling facilities, 
and click it again to return to the full list of trash and recycling services. 

8. Click Trash Pickup and review information and directions about trash pickup. 

9. Click the Back button to return to the full list of trash and recycling services. Repeat 
step 6 to view recycling and yard pickup details. 
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Neighborhood Early Warning 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Neighborhood Early Warning 
Neighborhood Early Warning can be used to identify neighborhoods trending in a positive or 

negative direction and ultimately measure the fragility of neighborhoods over time. 

It leverages authoritative data and key indicators (for example, blight violations, demolitions, 
crime, utility shutoffs, sales, rental units) to identify tipping neighborhoods. The resulting maps 
are a foundation for public education and awareness campaigns, operational improvements, 
and community-based policy discussions. Neighborhood Early Warning is typically implemented 
by planning departments, building officials, health and human services agencies, blight task 
forces, and other local government agencies that monitor neighborhood change over time, 
investing in stabilization programs and need to evaluate whether their investments are effective. 

The Neighborhood Early Warning solution delivers a set of capabilities that help you create a 
neighborhood change index, measure the fragility of neighborhoods over time and share the 
results with key stakeholders. 

 

Requirements 
Neighborhood Early Warning requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 or later (Basic, Standard, or Advanced) 

 

Information products 
Neighborhood Early Warning includes the following information products: 

Item Description 
Minimum 
user type 

Neighborhood 
Early Warning 

An ArcGIS Pro project used by data analysts to identify 
neighborhoods trending in a positive or negative direction 
and ultimately measure the fragility of neighborhoods over 
time 

GIS 
Professional 
Basic 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
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with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Neighborhood Early Warning 
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Use Neighborhood Early Warning 
The Neighborhood Early Warning solution delivers a set of capabilities that help you create a 

neighborhood change index, measure the fragility of neighborhoods over time and share the 

results with key stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Identify neighborhood change 
The Neighborhood Early Warning project can be used to understand neighborhoods trending in 

a positive or negative direction and ultimately measure the fragility of neighborhoods over time. 

You will start by assuming the role of a data analyst in a neighborhood revitalization task force 
responsible for organizing key neighborhood indicators. You are asked to use the Neighborhood 
Stabilization project to identify neighborhoods trending in a positive or negative direction. 

1. From the Neighborhood Stabilization solution, click the Neighborhood Stabilization 
item under Solution Contents to open the item details of the desktop application 
template. 

2. Click Download and place the contents on your computer. 

3. Using Explorer, browse to the NeighborhoodEarlyWarning.zip folder and extract it. 

4. Open the Neighborhood Stabilization ArcGIS Pro project. 

5. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

6. In the Catalog pane, expand Maps and review the maps provided. 

  Note: 

  The map provided in this project is used by data analysts to identify neighborhoods 
trending in a positive or negative direction and ultimately measure their fragility over 
time. 

7. In the Catalog pane, expand the Tasks folder, and double-click the Neighborhood 
Early Warning task. 

8. In the Tasks pane, click the How to Use Neighborhood Early Warning task 
group to expand the collection of tasks. 

9. Follow the steps in each task. 
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Neighborhood Stabilization 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Neighborhood Stabilization 
Neighborhood Stabilization can be used to understand current property conditions, return 

blighted properties to productive use, and engage the public in neighborhood stabilization 

conversations. 

It provides neighborhood stabilization program managers the ability to develop strategies that 
assist in the rehabilitation of properties that might otherwise become sources of abandonment 
and blight. The result can be used to rehabilitate, resell, or redevelop properties in order to 
stabilize neighborhoods and help to curtail the decline of property values in neighborhoods. 
Neighborhood Stabilization is typically implemented by planning departments, building officials, 
health and human services agencies, and other local government agencies that want to develop 
a location-driven approach to neighborhood stabilization. 

The Neighborhood Stabilization solution delivers a set of capabilities that help you conduct 
property surveys, measure the fragility of neighborhoods, track blight, demolition activity, and 
publish a focused set of information products for citizens in your community. 

 

Requirements 
Neighborhood Stabilization requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 or later (Standard or Advanced) 

 

Information products 
Neighborhood Stabilization includes the following information products: 

Item Description 
Minimum user 
type 

Neighborhood 
Stabilization 

An ArcGIS Hub site used by the general public to access 
blight complaints, track demolition activity, locate 
mortgage or housing counselors, and conduct property 
surveys 

Not required 
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Blight Status 
Dashboard 

An ArcGIS Dashboards app used by local government 
leaders to proactively monitor the status of blight 
complaints and efforts made to reduce blighted properties 

Viewer 

Demolition 
Tracker 

An ArcGIS Web AppBuilder app used by the general 
public to track building demolitions and the financial cost 
to a community 

Not required 

Mortgage 
Counseling 
Locator 

An ArcGIS Web AppBuilder app used by the general 
public to locate mortgage or housing counselors in a 
community 

Not required 

Tax Liability 
Calculator 

An ArcGIS Survey123 form used by citizens to compute 
their estimated tax liability 

Not required 

Property 
Condition Survey 

A Photo Survey app used by local governments to publish 
street-level photo collections, conduct property surveys, 
and automate the classification of property condition 
using ML/AI 

GIS 
Professional 
Standard 

Neighborhood 
Early Warning 

An ArcGIS Pro project used by data analysts to identify 
neighborhoods trending in a positive, or negative, 
direction and ultimately measure the fragility of 
neighborhoods over time 

GIS 
Professional 
Standard 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Neighborhood Stabilization 
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Configure Neighborhood Stabilization 
Learn how to configure the Neighborhood Stabilization solution to meet specific needs in your 

organization. 

 

Load data 
Neighborhood Stabilization can be used to understand current property conditions, return 

blighted properties to productive use, and engage the public in neighborhood stabilization 

conversations. 

Review the layers provided with the solution and determine what source data you want to load. 
Then, load your existing data into the layers provided with the solution before sharing the maps 
or applications. 

Once you have determined what source data must be loaded, complete the data loading 
workflow below. 

Note: 

Prior to loading data, ensure you populate the Status field in DemolitionSites with values 
represented in the layer: Planned Demolition, Contracted Demolition, or Completed 
Demolition. 

 

Load data from a shapefile 
Data for DemolitionSites or MortgageCounselingFacilities can be loaded from a shapefile by 

following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you wish to populate. 

3. On the feature layer item details page, Click Update Data and select Append Data 
to Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the 
updated data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Configure property surveys 
Blighted and vacant structures can have a significant impact on property value and may have 

substantial remediation costs associated with them. Property Condition Survey can be used by 

local governments to publish street-level photo collections, conduct property surveys, and 

automate the classification of property condition using ML/AI. 

 

Publish a property survey app 
The Property Condition Survey app consumes the map you authored during the publish map 

step in the ArcGIS Pro project. 

To configure the Photo Survey app, complete the following steps: 

1. Using Windows Explorer, browse to the 
\Documents\ArcGIS\Packages\PropertyConditionSurvey\commondata\userd
ata\PhotoSurvey folder and unzip it. 

2. Open the configuration.json file in Microsoft Notepad or another text editor. 

3. Enter the web map ID for your photo survey map, for example, "webmap": 
daa3eeae86954f4cba87c044466c4c2f. 

  Note: 

  The web map ID can be found at the end of the map URL in ArcGIS Online. For 
example, in 
http://myorganization.maps.arcgis.com/home/item.html?id=2ef11dad8ff0417
8b2b236e867e9c952, the web map ID is 2ef11dad8ff04178b2b236e867e9c952. 

4. Save and close the file. 

5. Copy the PhotoSurvey folder to your web server so it can be accessed as a 
website or virtual directory. In IIS, the default web server directory is <your 
directory>\Inetpub\wwwroot\. 

6. Browse to Start > Control Panel > Administrative Tools > Internet Information 
Services (IIS) Manage. 

7. Click <your server> > Sites > Default Web Sites. 

8. Right-click the web server directory folder for the app and choose Convert to 
Application. 

9. Choose the DefaultAppPool application pool. 

10. Click OK. 

11. Begin using Property Condition Survey by browsing to http://<your 
server>/PhotoSurvey/default.htm. 
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Configure the property survey app 
Use the configuration.json file to configure the Photo Survey app to your organization's needs. 

Photo randomization, guest access, thumbnail image display, and Twitter credentials can all be 

configured by modifying the following parameters: 

Parameter Description 

randomizeSelection Controls how the Photo Survey app will display photos. 

• True for random photo display (default) 
• False for ordered photo display 

allowGuestSubmissions Specifies if the Photo Survey app will allow guest or anonymous 
survey submissions. 

• True to allow guests (anonymous) to submit survey 
submissions 

• False to disallow guests (anonymous) to submit survey 
submissions 

showGuest Specifies if the Photo Survey app will allow guest or anonymous 
access. 

• True to allow guest (anonymous) access 
• False to disallow guest (anonymous) access 

thumbnailLimit Sets the maximum number of thumbnails displayed in the Photo 
Survey carousel. If the number of photos for a given property 
exceeds this number, the photo carousel will not be displayed in the 
app. 

includeOverviewMap Specifies if the Photo Survey app will include an overview map. 

• True to show overview map 
• False to remove overview map 

showSkip Specifies if the Photo Survey app will include a skip button. This 
requires all surveys to be submitted. 

• True to show skip button 
• False to remove skip button 
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Configure survey questions 
There are several options available regarding the types of survey responses that can be 

displayed in the survey panel. Choose from the options below based on the structure of your 

data as well as the desired user experience. 

Once you have determined which response type to use, choose the appropriate options in the 
Survey Questions table. 

Field Description Required information 

Field name in 
Photo Points 

Field name in the Photo Points layer that the 
survey response will be stored in. 

Field name 

Question Type Survey question type. Choose from the drop-down 
list. 

Parent, Child 

Parent 
OBJECTID 

If the question should be dependent on the 
response to a parent question, add the parent 
ObjectID of this question. 

ObjectID 

Display 
Condition(s) 

Value required to display this question. Value 

Question Text Text displayed for each survey question. Text 

Question UI Type Available question types. Choose from the drop-
down list. 

Button, List, Drop-
down list, Text, 
Number 

Image URL To display images on the survey panel, add the 
image URL. 

URL 

Image Position Position of image in the survey panel. Choose from 
the drop-down list. 

Before, After 

Required? If the question is required for the survey, choose 
from the drop-down list. 

Yes, No 

Question Order Order of the questions as they appear in the 
survey form. 

Numeric value 
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Use Neighborhood Stabilization 
The Neighborhood Stabilization solution delivers a set of capabilities that help you conduct 

property surveys, measure the fragility of neighborhoods, track blight, demolition activity, and 

publish a focused set of information products for citizens in your community. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Identify neighborhood change 
The Neighborhood Early Warning project can be used to understand neighborhoods trending in 

a positive or negative direction and ultimately measure the fragility of neighborhoods over time. 

You will start by assuming the role of a data analyst on a neighborhood revitalization task force 
responsible for organizing key neighborhood indicators. You are asked to use the Neighborhood 
Stabilization project to identify neighborhoods trending in a positive or negative direction. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Neighborhood Stabilization solution. 

2. Download the Neighborhood Early Warning desktop application template, and then 
unzip the folder. 

3. From the unzipped folder, open the Neighborhood Early Warning.aprx file in 
ArcGIS Pro. 

4. In the Catalog pane, expand Maps and review the maps provided. 

  Note: 

  If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

  The map provided in this project is used by data analysts to identify neighborhoods 
trending in a positive or negative direction and ultimately measure their fragility over 
time. 

5. In the Catalog pane, expand the Tasks folder, and then double-click the 
Neighborhood Early Warning task. 

6. In the Tasks pane, expand the How to Use Neighborhood Early Warning task 
group to see the collection of tasks. 

7. Follow the steps in each task. 
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Perform property condition surveys 
Property Condition Survey uses location-enabled photos produced by many commercially 

available cameras and simplifies data processing so street-level photo collections can be 

gathered on a regular basis. Photo collections can then be used in the Property Condition 

Survey app or be classified using the Microsoft Custom Vision service to identify property where 

overgrowth, graffiti, and boarded windows may exist. 

 

Perform street-level photo acquisition 
To start, you’ll assume the role of a data analyst who needs to decide what type of camera will 

be used to acquire street-level photos. The Photo Survey toolbox has been designed to work 

with standard EXIF data captured by commercially available cameras, and there are several on 

the market that can be used to collect photos. 

When selecting cameras and planning photo collection for your community, consider the 
following questions: 

• Is the camera well suited for diverse weather conditions, and can it be mounted on 
the side of a vehicle or on a window of a vehicle? 

• Does the camera take photos at predefined intervals (for example, every two 
seconds) and acquire GPS coordinate values for each photo taken? 

• Does the camera write photo data in a standard EXIF format? 

• How many photos can be stored on a given camera, and how will you get photos 
off the device? 

• How many vehicles will you use to acquire photos for your entire community? You 
will need two cameras for each vehicle used to acquire photos. 

• What is the speed you will travel to acquire the photos? The slower you can drive, 
the more photos you will acquire for each property. 

• What are the routes used to acquire photos? Will those routes cover every property 
in your community? 

• Can you use vehicles (for example, trash trucks and street cleaners) or employees 
(for example, code enforcement officers and assessors) who already canvass the 
community to acquire photos? 

• Would volunteer organizations working in your community partner with you to 
acquire photos? 

 

Review the Property Condition Survey project 
Now you will assume role of a data analyst on a neighborhood revitalization task force 

responsible for configuring the property condition survey. You are asked to configure the 

Property Condition Survey app using the map authored during the publish map step in the 

ArcGIS Pro project. 

1. Start ArcGIS Pro and open the Property Condition Survey project package from the 
active portal. 
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2. In the Catalog pane, expand Databases and review the sample survey questions 
provided with the Property Condition Survey project. 

  Note: 

  If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, if necessary, and then double-click 
the Property Condition Survey task. 

4. In the Tasks pane, follow the steps in the Property Condition Survey task to set up 
the Property Condition Survey app. 

 

Calculate blight probability 
Now you will assume role of a data scientist on a neighborhood revitalization task force 

responsible for configuring the Property Condition Survey. You are asked to calculate the blight 

probability in the images taken at street level to augment manual surveys. 

1. In a browser, go to Microsoft Custom Vision, and then sign in or create an account. 

  Note: 

  If you created an account, after your account has been created, be sure to accept the 
terms and conditions. 

2. If necessary, in the Azure Portal, create a resource group for Custom Vision. 

3. On the Custom Vision landing page, in the upper right, click the settings button. 

4. Copy the training key, prediction key, prediction resource ID, and prediction 
endpoint for your account. 

5. In the Property Condition Survey project, for the Detect Blight task, use the copied 
values. 

6. After you have run the Detect Blight task, review your results in the Photo Points 
layer published in the Publish Map task in the Property Condition Survey project. 

Survey the property condition 
Now you will assume the role of a community volunteer. You are concerned with neighborhoods 

in your community and want to contribute by completing the Property Condition Survey. 

1. In a browser, from the Neighborhood Stabilization solution, view the Neighborhood 
Stabilization ArcGIS Hub site. 

2. Scroll to the Understanding Neighborhood Conditions section, and then under 
Survey Property Conditions, click Learn More. 

  The Property Condition Survey sign-in page appears. 

3. Sign in with your Twitter credentials, if applicable, or click Guest to complete the 
survey anonymously. 
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  Tip: 

  If you choose to sign in with your Twitter credentials, you can keep track of the total 
number of surveys that you’ve completed and your overall ranking. 

4. Answer the survey questions based on the photo that is displayed in the main 
panel. 

  Tip: 

  You can use the thumbnail images in the lower area of the screen to cycle through all the 
photos available for the property, if available. To select the photo that best shows the 
property, click the favorite button in the upper-left corner of the photo. 

5. Click Submit survey to complete the report. 

 

Track demolition activity 
Demolition activity can have a significant impact on property value and the financial cost to a 

community. Demolition Tracker can be used by the public to locate planned, contracted, and 

completed building demolition. 

Now, you will assume the role of a resident in a local community. You are concerned with where 
demolitions have occurred, where they are contracted and planned, and what the total cost is to 
the community. 

1. In a browser, from the Neighborhood Stabilization solution, view the Neighborhood 
Stabilization ArcGIS Hub site. 

2. Scroll to the Understanding Neighborhood Conditions section, and then under 
Track Demolition Activity, click Learn More. 

  The Demolition Tracker opens. On the right, the Demolition Tracker widget lists the 
number of planned, contracted, and completed demolitions visible in the map extent. 

3. On the map, in the search field, type your address or zoom to a location directly on 
the map. 

  The demolition information in the Demolition Tracker widget updates to the new map 
extent. 

4. In the Demolition Tracker widget, click Planned Demolitions to view specific 
addresses of buildings planned for demolition. 

5. Click a specific planned demolition address. 

  On the map, a pop-up shows the demolition's neighborhood, use description, comments, 
planned date, and estimated cost. 

6. In the Demolition Tracker widget, click Contracted Demolitions to view specific 
addresses of buildings contracted for demolition. 

7. Click a specific contracted demolition address. 

  On the map, a pop-up shows the demolition's neighborhood, use description, comments, 
contractor, scheduled date, and quoted cost. 
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8. In the Demolition Tracker widget, click Completed Demolitions to view specific 
addresses of buildings that have been demolished. 

9. Click a specific completed demolition address. 

  On the map, a pop-up shows the demolition's neighborhood, use description, comments, 
contractor, completed date, and actual cost. 

   

Monitor blight status 
Blight complaints can have a significant impact on property value and may have substantial 

remediation costs associated with them. Blight Status Dashboard can be used by local 

government leaders to proactively monitor the status of blight complaints and efforts made to 

reduce blighted properties. 

Now you will assume the role of a local government leader. You are concerned with where 
blight reports have been submitted and the resolution status. 

1. In a browser, from the Neighborhood Stabilization solution, view the Blight Status 
Dashboard app. 

  The Blight Status Dashboard opens with an overview of the current blight-related reports. 

  Note: 

  The overview displays key metrics. This information gives management a quick overview 
of the number of blight reports in their community. 

2. At the lower left, click the Blight Dashboard tab and explore the blight reports. 

3. On the left side of the app, click the arrow to display the filter panel. 

  Tip: 

  You can pin the filter panel to the dashboard by clicking the pin in the upper-right corner. 

4. Use filters to refine the results by status or submission date. 

5. Below the map, in the Report Type panel, review the charts to see a breakdown of 
the report types. 
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Network Path Planner 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Network Path Planner 
Network Path Planner can be used to plan fronthaul routes to wireless equipment such as 5G 

sites, backhaul routes from wireless towers, and plan routes to residential neighborhoods or 

business locations. 

Access to the Internet, with sufficient bandwidth, is essential in an information society. Major 
investments in broadband infrastructure that support access to the internet continues to grow in 
urban, suburban and rural communities. As a result, telecommunication agencies must design 
effective networks that balance capital costs with customer service. Simple design tools that 
provide an efficient route to a proposed site reduce cost and increase revenue opportunities. 
Network Path Planner is typically implemented by telecommunications organizations that want 
to quickly develop cost effective, high-level network designs from their existing network to 
proposed sites. 

The Network Path Planner solution delivers a set of capabilities that help you create an 
optimized fiber route and estimate the cost of the route. 

 

Requirements 
Network Path Planner requires the following: 

• ArcGIS Pro 2.7 or later (Basic, Standard, or Advanced) 

• ArcGIS Network Analyst extension 

 

Information products 
Network Path Planner includes the following information products: 

Item Description 
Minimum user 
type 

Network Path 
Planner 

An ArcGIS Pro project used by network planners to 
create a network route. 

GIS Professional 
Basic 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Network Path Planner 
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Use Network Path Planner 
The Network Path Planner project can be used to plan fronthaul routes to wireless equipment 

such as 5G sites, backhaul routes from wireless towers, and plan routes to residential 

neighborhoods or business locations. 

 

Identify Optimal Network Paths 
You will start by assuming the role of a network planner or wireless provider responsible for 

generating a proposed route for a series of 5G sites. You are asked to use the Network Path 

Planner project to identify the optimal network path for your organization. 

1. From the Network Path Planner solution, click the Network Path Planner item under 
Solution Contents to open the item details of the desktop application template. 

2. Click Download and place the contents on your computer. 

3. Using File Explorer, browse to the NetworkPathPlanner.zip folder and extract it. 

4. Open the Network Path Planner ArcGIS Pro project. 

5. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

6. In the Catalog pane, expand Maps and review the maps provided. 

  Note: 

  The map provided in this project is provided with sample dataset to exercise the tools. 

7. In the Catalog pane, expand the Tasks folder, and double-click the Network Path 
Planner task. 

8. In the Tasks pane, click the How to Use Network Path Planner task group to 
expand the collection of tasks. 

9. Follow the steps in each task. 
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Operations Management 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Operations Management 
Operations Management can be used to respond to an event and manage resulting missions. 

The solution allows military organizations to capture real-time data related to the event and 
mission development. Command leadership can collect and review reports submitted by 
operations personnel from any connected device. The solution enables immediate interaction 
between the technology and military personnel, allowing for rapid information dissemination and 
intelligent decision-making. Operations Management is typically implemented by organizations, 
such as the Army National Guard, that want to take a data-driven approach to plan, manage, 
and understand current missions associated with events. 

The Operations Management solution delivers a set of capabilities that help you to capture and 
update event and mission details, allocate resources, and gain situational awareness of 
resources and tasks against designated missions. 

 

Requirements 
Operations Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 

 

Information products 
Operations Management includes the following information products: 

Item Description 
Minimum 
user type 

Operations 
Dashboard 

An ArcGIS Dashboards app with embedded ArcGIS 
Survey123 forms that provides a dynamic method for 
input of events, missions, status reports, and field 
reports. 

Viewer 

Operations 
Management 
Dashboard 

An ArcGIS Dashboards app used by command 
personnel to monitor events, missions, status reports, 
and field reports. 

Viewer 
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Operations 
Manager 

An ArcGIS Dashboards app used by operations 
personnel to manage events and missions. 

Editor 

Event Entry An ArcGIS Survey123 form that can be used by a liaison 
or LNO to enter events. 

Not required 

Mission Entry An ArcGIS Survey123 form used by a liaison or LNO to 
enter missions. 

Not required 

Field Report An ArcGIS Survey123 form used by an LNO or military 
unit member to report on events in the field. 

Not required 

Status Report An ArcGIS Survey123 form used by a liaison or LNO to 
provide updates regarding the status of a mission. 

Not required 

Operations Events An ArcGIS Survey123 form that can be referenced as a 
master schema for all included surveys in Operations 
Dashboard. 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 First release of Operations Management 
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Configure Operations Management 
In this topic, you will learn how to configure the Operations Management solution to meet 

specific needs in your organization. The apps included with the Operations Management 

solution come with Survey123 reports. Follow the steps below to configure the solution. 

 

Configure solution 
Once Operations Management has been deployed, you can make optional configurations to the 

solution. Follow the steps below to configure the Operations Dashboard and the Operations 

Manager applications. 

 

Configure the Search widget 
To use the Search widget within Operations Manager, complete the following steps: 

1. Open the Operations Manager web app in editing mode. 

2. Click to open the Widget tab and select the Search widget.  

3. In the Layer Source section, select Set and browse to the current Events and 
Missions layer in the Portal for ArcGIS option. 

– Alternatively, copy the updated Events and Missions map service URL and 
paste it in the Service URL option. 

4. Browse to Add Search Source. 

5. Click Feature Layer and select Events and Missions. 

6. Configure the rest of the widget and save your application. 

 

Add data sources 
The Operations Management solution allows operations management personnel to enter details 

about events and missions supporting events. It can be helpful to add additional data to provide 

context for feature entry and management. 

The layers listed below can be added to the map to provide further context when entering new 
events, missions, status reports, and field reports. 

Learn more about how to add layers to a map. 

• State and county layers 

– States map service 

– Counties map service 

– COVID-19 cases data feed 

• ArcGIS Living Atlas layers 

– National Weather Service Severe Events 

– National Weather Service Extreme Events 

• NOAA Web Services 

– NOAA Base Reflectivity Radar 
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Extend the Operations Management Dashboard 
The Operations Management Dashboard is preconfigured to display all units under the 

Assigned To section within the Survey123 form. It also displays default mission statuses. You 

may need to configure the dashboard to align with your organization. 

 

Add a battalion 
To add additional battalions or companies to the dashboard, complete the following steps: 

1. Browse to the Operations Management Dashboard and click Edit Dashboard. 

2. In the Mission Assignment/Status element, click the Configure button . 

3. Go to the Data tab, select the Filter window, and under the Assigned To window, 
select Include. At this point, you will add only the units of interest and nothing else 
will be included. 

4. Save your application. 

 

Modify mission status 
The dashboards are preconfigured to display various statuses. The statuses can be modified or 

removed. If your organization uses a status that is not included, ensure a new category is added 

to the Survey123 form before adding it to the Operations Management Dashboard. To modify 

the mission statuses, complete the following steps: 

1. Select any Mission Status element and go to Editing Features. 

2. Click the Duplicate button  to copy the setting of the existing indicator elements 
to add a new category. Make sure that the new category has been added to the 
Survey123 form first. 

3. Remove the status element by clicking the delete button . 

4. Save your application. 

 

Modify lists 
The dashboards included in this solution come with preselected and basic fields within their 

appropriate lists. Additional fields can be turned on when configuring your solution to better 

address your organization's needs. To modify lists, complete the following steps: 

1. Click the Configure button  for any of the list components within the dashboard. 

2. Select the List tab and click Insert  to see the field options available. 

3. Select one or multiple fields to be added to the display. 

4. Add a label in front of your field item. 

5. Click Done. 

6. Save your application. 
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Extend Operations Manager 
The Operations Manager web application includes a Summary widget that provides a clustering 

feature that can be enabled. This feature will perform groupings of the features on the map 

indicating potential hot spots. The Operations personnel can use this clustering information to 

begin deploying assets and resources to areas that show high concentrations. 

 

Enable clustering 
To enable clustering in the Summary widget, complete the following steps: 

1. Access the Operations Manager web app while in editing mode.  

2. Go to the Widget tab and select the Configure this Widget option for the 
Summary widget. 

3. Check Display as Summary Clusters. 

4. Click OK and save the application. 
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Use Operations Management 
The Operations Management solution delivers a set of capabilities that help you to capture and 

update event and mission details, allocate resources, and gain situational awareness of 

resources and tasks against designated missions. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Manage missions 
The Operations Dashboard provides the LNO or mission manager a single interface to submit 

events, missions, status updates for missions, and field reports. Operations Manager allows the 

operations personnel the freedom to filter data, modify or move events, and find specific 

information within a few seconds. Finally, command leadership can remain aware of current and 

historical missions in the Operations Management Dashboard. New events and missions can be 

added as frequently as needed. 

 

Enter a new event 
You will start by assuming the role of the event or mission manager. You have just received a 

request for assistance from Miami-Dade County in response to a hurricane. You will use the 

Event Entry survey to capture a new event. 

To capture a new event using the Event Entry survey, complete the following steps: 

1. In a browser, go to your Operations Dashboard.  

2. Select the Events tab in the lower right and fill in the following details:  

  Parameter 
  Value 

  Event ID   Type EVENT001. 

  Begin Date   Select the date 09/08/2020. 

  End Date   Select the date 09/15/2020. 

  Location   Draw a polygon along the Miami-Dade County area. 

  Event Type   Select Weather. 

  Event Sub 
Category ID 

  Select Hurricane. 

  Event 
Description 

  Type Hurricane Olga is moving at 15 mph with high 
winds of 175 mph. Hurricane Olga is approaching 
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the Miami-Dade County geographical area and is 
located approximately 300 miles from the Florida 
coastline. 

3. Click Submit. 

 

Enter a new mission 
You have now been asked to start capturing the missions related to Hurricane Olga. You will 

use the Mission Entry survey to capture mission information. 

To capture information about a new mission, complete the following steps: 

1. In a browser, go to your Operations Dashboard or refresh your current browser if 
you have just entered the event. 

2. Select the Hurricane Olga event from the events list widget. 

3. Select the Missions tab in the lower right. Notice that the EVENT001 event ID is 

automatically showing as part of the new Mission Entry.  

4. In the Mission Entry survey, fill in the following details: 

  Parameter 
  Value 

  Mission ID   Type MISSION001. 

  Location   Type LAT: 25.79496 LON: -80.12594. 

  Start Date   Select the date 09/08/2020. 

  End Date   Select the date 09/12/2020. 

  Mission Type   Select Personnel Support. 

  Mission Description   Type 150 personnel are needed to fill 
sandbags and place them in designated 
areas. 

  COVID related   Select No. 

  Mission Status   Select Pending Approval. 

  Mission Priority   Select Medium. 
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  Assigned to ID   Select 1st Battalion. 

  Personnel 
Information ID 

  Select Yes. 

  Personnel Details   Select Other. 

  Enter # of Other 
Personnel 

  Type 150. Total Personnel will automatically fill. 

  Vehicle Information   Select Yes. 

  Vehicle and Aircraft 
Details 

  Select Yes. 

  Land Vehicle Type   Select Utility Truck and type 5 for the Quantity. 

  Estimate Cost   Select Yes. 

  Estimate Mission 
Cost/Day 

  Type 5000. 

  Submitter POC 
Details 

  Enter your name and contact information. 

  Ground Commander 
POC Details 

  Enter commander point of contact details. 

5. Click Submit. 

 

Monitor missions 
Now, you will assume the role of the Operations Manager. You are asked to monitor the 

missions of your unit. You will review the missions of your workforce. 

To monitor a specific mission, complete the following steps: 

1. In a browser, go to the Operations Manager application. You will see an overview 
of the events and missions that have been entered. 

2. Click the Item details button . After reviewing the content, close the window. 

3. Type % in the Search widget. 

4. Select MISSION001 from the results. 
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Parcel Drafter 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Parcel Drafter 
Parcel Drafter can be used to enter metes-and-bounds descriptions and check for closure errors 

in order to verify survey information prior to submission. 

It provides deed examiners up-to-date parcel information and a digital workflow for entering new 
metes-and-bounds land descriptions. This optimized approach helps organizations reduce the 
time required to process land description documents and share results between staff. Parcel 
Drafter is typically implemented by property appraisal departments, assessors, fiscal offices, 
and other local government agencies that want to improve their overall transaction time when a 
parcel related document is recorded. 

The Parcel Drafter solution delivers a set of capabilities that help you capture parcel boundaries 
as documents are filed and can be integrated into a larger land records workflow that produces 
a complete inventory of tax parcels, subdivisions, lots, and related encumbrances. 

 

Requirements 
Parcel Drafter requires the following: 

• ArcGIS Enterprise 

 

Information products 
Parcel Drafter includes the following information products: 

Item Description 
Minimum 
user type 

Parcel 
Drafter 

An ArcGIS Web AppBuilder app used by mapping technicians to 
enter metes-and-bounds descriptions and check for closure errors 

Editor 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Parcel Drafter 

Configure Parcel Drafter 
Learn how to configure the Parcel Drafter solution to meet specific needs in your organization. 

Load data  
Parcel Drafter can be used to enter metes-and-bounds descriptions and check for closure errors 

to verify survey information prior to submission. In some cases, you may already have this 

information in ArcGIS or another business system. 

Review the layers provided with the solution and determine what source data you want to load. 
Then, load your existing data into the layers provided with the solution before sharing the maps 
or applications. 

Once you have determined what source data must be loaded, complete the data loading 
workflow below. 

Load data from a shapefile 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data 
to Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the 
updated data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://enterprise.arcgis.com/en/portal/10.9/use/manage-hosted-feature-layers.htm#APPEND


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 520 

Use Parcel Drafter 
The Parcel Drafter solution delivers a set of capabilities that help you capture parcel boundaries 

as documents are filed and can be integrated into a larger land records workflow that produces 

a complete inventory of tax parcels, subdivisions, lots, and related encumbrances. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Provide parcel descriptions 
Parcel Drafter can be used to provide metes-and-bounds descriptions and check for closure 

errors to verify survey information prior to submission. 

 

Add a parcel 
You will start by assuming the role of a mapping technician in a tax assessment office who is 

responsible for checking a new parcel description. You are asked to use Parcel Drafter to 

provide a metes-and-bounds description and check for closure errors to verify survey 

information prior to submission. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Parcel 
Drafter solution. 

2. View the Parcel Drafter app. 

3. Use the Search widget to find a parent parcel or address. 

4. Click the Enter a property description button to open the widget. 

5. In the widget, click the Start New Traverse button, and then either click the map or 
specify X,Y coordinates to start drafting a parcel. 

  Before starting a new description, you will choose appropriate units. 

6. In the widget, at the top right, click the Settings button, and then use the drop-
down lists to choose the units that best represent the units of the incoming 
document. 

7. At the top of the pane, click the Back arrow to return to the New Traverse 
template. 

8. Under New Traverse, to the left of Bearing, click the red connection line to open a 
drop-down list. 

9. Choose either Boundary or Connection as the line type of your parcel traverse 
leg. 

10. For Bearing, Length, and Radius, type the dimensions of the parcel traverse, and 
then click the Add button on the right to add a new leg. 
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  As you type the dimensions, the traverse lines are drawn on the map from the starting 
point. Optionally, you can use the Digitize tool below the New Traverse grid to manually 
draw the parcel boundaries. 

  Tip: 

  To provide a bearing in degrees/minutes/seconds using quadrant bearing, type the 
values in one of the following formats: 20-25-25-3 (3 is the shortcut for the southwest 

quadrant) or S20-25-25W. 

  When providing a bearing in decimal degrees, type the value in the following format: 
20.2525. 

11. Optionally, update the angle and scale during the traverse to rotate and scale new 
lines. 

  Tip: 

  After providing the first line of the traverse (and if rotation or scale values have not been 
specified), you can rotate the line to fit the underlying geometry (for example, section 
line, parcels, or other survey lines). All subsequent lines will be applied this rotation, but 
the records, bearings, and distances will be captured as provided. 

12. Click Save. 

 

Edit parcels 
Next, you will assume the role of a mapping technician in a tax assessment office who is 

responsible for editing parcel descriptions. You are asked to use Parcel Drafter to edit a metes-

and-bounds description and check for closure errors. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Parcel 
Drafter solution. 

2. View the Parcel Drafter app. 

3. In the Enter a property description widget, click Edit Traverse. 

4. Click an existing parcel, and then edit the traverse or attribute information. 

5. Click Save. 
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Parcel Value Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Parcel Value Analysis 
Parcel Value Analysis can be used to find comparable sales and visualize the impact of sales, 

foreclosures, and assessment appeals on property value in a neighborhood or tax district. 

It improves the quality of property valuations and provides property appraisers access to current 
property characteristics and neighborhood trends, ensuring that property is valued in a fair and 
equitable way. The result can be shared with property appraisers inside your organization and 
can be used to defend property valuations. Parcel Value Analysis is typically implemented by 
property appraisal departments, assessors, fiscal offices, and other local government agencies 
that want to take a visual, location-driven approach to property valuation. 

The Parcel Value Analysis solution delivers a set of capabilities that help you improve the 
overall quality of property valuations by accessing key operational layers from assessment and 
tax business systems; narrows a search of property sales by defining a price range, year built, 
and living area; and provides a high-level view into changes in property assessments and tax 
revenue within a local government. 

 

Requirements 
Parcel Value Analysis requires the following: 

• ArcGIS Enterprise 

 

Information products 
Parcel Value Analysis includes the following information products: 

Item Description 
Minimum 
user type 

Value Analysis 
Dashboard 

An ArcGIS Dashboards app used by assessors to visualize the 
impact of sales, foreclosures, and assessment appeals on 
property value in a neighborhood or tax district 

Viewer 

Residential 
Comp Finder 

An ArcGIS Web AppBuilder app used by the general public, 
real estate agents, and appraisers to find comparable sales 
and related property information 

Viewer 
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When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Parcel Value Analysis 
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Configure Parcel Value Analysis 
Learn how to configure the Parcel Value Analysis solution to meet specific needs in your 

organization. 

 

Load data  
Parcel Value Analysis can be used to share parcel, property sales, floodplain, and tax 

distribution information. In some cases, you may already have this information in ArcGIS or 

another business system. 

Review the layers provided with the solution and determine what source data you want to load. 
Then, load your existing data into the layers provided with the solution before sharing the maps 
or applications. 

Once you have determined what source data must be loaded, complete one or more of the data 
loading workflows below. 

 

Load data from a shapefile   
Load data for TaxParcels, SiteAddresses, SchoolDistricts, and TaxParcelSales from a shapefile 

by completing the following steps: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data 
to Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the 
updated data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

 

Load tax distribution information 
To configure the Tax Distribution table in the TaxParcels layer in ArcGIS, you can use the 

sample .csv file included with the solution (TaxDistribution.csv). 
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To load tax distribution from a spreadsheet, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the TaxDistribution item. 

2. On the item details page, click Download. 

3. Once downloaded, open the TaxDistribution.csv file and populate the Parcel ID, 
Total Tax, and Tax District distribution totals (in dollars). 

  Note: 

  After these tax values are populated, you can compute the percent of total tax dollars for 
each tax district and populate its corresponding Tax District % attribute, for example, 
(TXDIST1/TOTTX)*100 = TXDIST1PER or ($1500/$5000)*100 = 30%. 

4. Alternatively, you can use ArcGIS Pro to populate these values based on their 
spatial relationship with tax districts. 

5. In your ArcGIS organization, browse to the TaxParcels feature layer. 

6. On the feature layer item details page, click Update Data and select Append Data 
to Layer. 

7. Under Filename, click Choose File. 

8. Browse to your .csv file and click Open. 

9. Click Upload and Continue. 

10. From Choose the layer that you wish to append data into, select the Tax 
Distribution table to load data into. 

11. Uncheck Update existing features. 

12. Click Show field matching to map the fields. 

13. Map the Latitude field to the y-column and the Longitude field to the x-column. 

14. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Use Parcel Value Analysis 
The Parcel Value Analysis solution delivers a set of capabilities that help you improve the 

overall quality of property valuations by accessing key operational layers from assessment and 

tax business systems; narrows a search of property sales by defining a price range, year built, 

and living area; and provides a high-level view into changes in property assessments and tax 

revenue within a local government. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Analyze property value 
Value Analysis Dashboard can be used to visualize the impact of sales, foreclosures, and 

assessment appeals on property value in a neighborhood or tax district. 

 

Explore assessment neighborhoods 
You will start by assuming the role of a residential property appraiser in an assessment 

organization that is responsible for valuing property. You are asked to use the Value Analysis 

Dashboard to investigate specific assessment neighborhoods and identify assessed value 

outliers, analyze recent property sales, and review appeals and foreclosures. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Parcel 
Value Analysis solution. 

2. View the Value Analysis Dashboard. 

  The Value Analysis Dashboard opens, showing information about sales, appeals, and 
foreclosures, as well as overall metrics regarding property value and total property tax 
outstanding. 

3. On the left, click the All Neighborhoods drop-down arrow and choose an 
assessment neighborhood to refine the results. 

4. Click the All Sales drop-down arrow and choose a date range to further refine the 
results. 

5. Explore the neighborhood and notice the range of assessed values.  

  The parcels shaded in blue have higher values than parcels shaded in yellow. 

6. On the map, click a sale to see a pop-up with the sale's details and a description of 
the likelihood that this sale could impact property tax levied against the property. 

7. Review the high-level metrics about the neighborhood, including the current 
assessed value, current taxable value, and the overall taxes owed. 
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Locate comparable sales 
Now, you will assume the role of a residential property appraiser in an assessment organization 

that is responsible for valuing property. You are asked to use the Residential Comp Finder to 

investigate property sales by defining a price range, year built, and living area. The resulting list 

of properties sold can then be used to help determine the fair market value of a subject or 

prospective property. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Parcel 
Value Analysis solution. 

2. View the Residential Comp Finder app. 

3. On the right, in the Locate Sale widget, search for a parcel number, address, or 
school district, or click a location directly on the map. 

4. Optionally, adjust the buffer slider to see a larger list of potential businesses. 

5. Review the property's details, such as its address, parcel number, year built, floor 
area, assessed value, sale price, sales date, and sales ratio. 

6. Optionally, use filters to refine the results; for example, use the Sale Amount is 
between filter to find homes with sale prices between $250,000 and $350,000. 
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Participatory Budgeting 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Participatory Budgeting 
Participatory Budgeting can be used to solicit community feedback to identify, discuss, and 

prioritize public spending projects. 

It provides 24/7 access to an organization, and the location-enabled project ideas drive 
community engagement and help efficiently triage ideas to the person or department 
responsible for project scoping. Input gathered in the public application often makes up for gaps 
in official knowledge and brings the people and their government closer together as a 
community. It also allows historically disenfranchised groups to participate, leading to new ideas 
in government. Participatory Budgeting is typically implemented by planning departments, public 
works agencies, and other local government agencies that want to increase transparency and 
solicit feedback from the public and ultimately build a community in which everyone’s voice can 
be heard. 

The Participatory Budgeting solution delivers a set of capabilities that help you solicit project 
ideas from the public, triage and monitor these ideas, and incorporate popular ideas in future 
capital improvement plans. 

 

Requirements 
Participatory Budgeting requires the following: 

• ArcGIS Enterprise 

 

Information products 
Participatory Budgeting includes the following information products: 

Item Description 
Minimum 
user type 

Participatory 
Budgeting 

An ArcGIS Hub site used by the general public to learn 
how they can become involved in the participatory 
budgeting process 

Not required 

Participatory 
Budgeting 

A Crowdsource Reporter app used by the general public 
to identify, discuss, and prioritize project ideas 

Not required 
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Participatory 
Budgeting Manager 

A Crowdsource Manager app used by local government 
personnel to triage project ideas submitted by the 
general public 

Editor 

Participatory 
Budgeting 
Dashboard 

An ArcGIS Dashboards app used by local government 
personnel to monitor project ideas reported by the 
general public 

Viewer 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Participatory Budgeting 
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Configure Participatory Budgeting 
Learn how to configure the Participatory Budgeting solution to meet specific needs in your 

organization. 

 

Configure the Participatory Budgeting site 
The Participatory Budgeting solution includes the Participatory Budgeting ArcGIS Hub site, 

which your organization can configure with your own branding and use to share important 

budgeting and planning information with the public. 

After deploying the Participatory Budgeting solution, the Participatory Budgeting site layout only 
requires a few updates to fit your local context. Follow the steps below to update the site with 
your organization's needs: 

1. Sign in to your ArcGIS organization and browse to the Participatory Budgeting site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Statistics section under the title of the website. The Community 
Ideas statistics card is already linked to the Participatory Budgeting solution’s 
PublicProjectIdeas_public feature layer. This statistic automatically updates as you 
load data into your solution. 

  The Available Budget and Ideas Funded statistics are provided in a text card but styled 
to resemble the Community Ideas statistics card; this allows you the option to manually 
enter a statistic of your choice, independent of data. Update the Available Budget and 
Ideas Funded statistics cards using a metric of your choice, or replace the text card with a 
Summary Statistics card and use the PublicProjectIdeas_public feature layer view as its 
data source, similar to the other statistics cards. 

5.  Update the Available Budget and Ideas Funded cards by hovering over one of 

the cards and clicking the settings button , and then update the text. To add a 
Summary Statistics card to the existing row, see the Display key metrics section 
in the Insert charts, tables, and metrics topic. Once the card has been added to the 

row, hover over the replaced card and click the delete button . 

6. Scroll to the Meet the Participatory Budgeting Committee section, hover over 
the card, and click the settings button on the horizontal toolbar. 

7. To update the image, click </> Edit in HTML and replace the existing URL with the 
URL of your image, and edit the photo names in the card. 

8. Click Apply. 

9. Scroll to the Frequently Asked Questions section, hover over the card and click 
the settings button, and update the questions and answers. 

10.  On the side panel, click Footer. 

  A custom footer is already provided, and in most cases, it needs to be updated with your 
organization's branding, contact information, and social media references. 
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11. Click the HTML text box. 

  The HTML window appears. 

12. Make the necessary changes and click Apply. 

13. Click Save. 

 

Share items with the public 
Several layer views, maps and apps included in the Participatory Budgeting solution must be 

shared with everyone so they can be accessed by the public on the Participatory Budgeting site. 

To share your participatory budgeting items with everyone, use the guide below and complete 

the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Participatory Budgeting folder. 

2. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   PublicProjectIdeas_public 

  Web Map   Participatory Budgeting 

  Web Mapping Application   Participatory Budgeting 

  Site Application   Participatory Budgeting 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 
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Use Participatory Budgeting 
The Participatory Budgeting solution delivers a set of capabilities that help you solicit project 

ideas from the public, triage and monitor these ideas, and incorporate popular ideas in future 

capital improvement plans. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Submit a project idea 
You will first assume the role of an engaged resident in the community. You want to learn more 

about the project ideas submitted by the community that are being considered for funding. You 

also have your own project idea that you want to submit for consideration by the community. 

1. In a browser, from the Participatory Budgeting solution, view the Participatory 
Budgeting site. 

2. Scroll to the Do You Have a Project Idea section and click the Submit an Idea 
button to open the Participatory Budgeting app. 

3. Click Proceed as Guest or sign in with your ArcGIS Online or ArcGIS Hub 
community account. 

4. In the Ideas list, browse ideas created by others in the community. 

5. Click an idea. 

6. To like an idea, click the I agree button to vote for it, or click the Leave a reply 
button to comment. 

7. At the upper left, click the arrow to return to the list of submissions. 

8. Click Submit Idea to add your own idea. 

9. In the form, provide details about your idea, your contact information, and the 
location for the idea. 

10. Click the Report It button to submit your idea. 

 

Manage project ideas 
You will now assume the role of a member of the participatory budgeting committee. One of 

your responsibilities is to review ideas submitted by the public and determine if they are viable 

and what the estimated cost would be. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Participatory Budgeting solution. 

2. View the Participatory Budgeting Manager app. 

3. In the table or on the map, click an idea. 

  The idea details open at the lower left. 
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4. In the idea details, click the Edit Record button . 

5. Confirm that the idea category is appropriate. 

6. For Vetted, choose Yes. 

7. For Viable, choose Yes, if appropriate. 

8. For Estimated Cost, type an estimated cost for the project. 

9. Click Save. 

 

Monitor project ideas 
As a member of the participatory budgeting committee, another of your responsibilities is to 

monitor ideas submitted by the public to ensure the program is running smoothly. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Participatory Budgeting solution. 

2. View the Participatory Budgeting Dashboard app. 

3. On the left, use filters to refine the results by project category, status, viability, or 
date. 

  When you filter the results, the bar chart and number of project ideas update. 

4. Click an idea on the map to view its details. 
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Performance Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Performance Management 
Performance Management can be used to monitor key performance metrics and communicate 

progress made on strategic outcomes to the general public and other interested stakeholders. 

Historically, government agencies have focused on process and compliance, but this 
management style has not yielded the expected results. As a result, many agencies are 
focusing on performance or results that benefit the public and attempting to increase public 
confidence in the results. Performance Management is typically implemented by government 
agencies that want to use evidence and results to foster a culture of continuous improvement, 
spend scarce budget resources wisely, and ensure that the community's needs are being 
prioritized. 

The Performance Management solution delivers a set of capabilities that help you tabulate 
performance metrics, monitor performance using a series of dashboards and key performance 
indicators (KPIs), visualize performance for defined geographies, and share performance with 
the public through a community website. 

 

Requirements 
Performance Management requires the following: 

• ArcGIS Enterprise 

 

Information products 
Performance Management includes the following information products: 

Item Description 
Minimum user 
type 

Community 
Performance 

An ArcGIS Hub site used by government agencies to 
share key performance indicators (KPIs) and 
communicate progress made on strategic outcomes 
with the general public and other interested 
stakeholders 

Not required 

Performance 
Management 

An ArcGIS Dashboards app used by government 
agencies to monitor key performance indicators (KPIs) 

Viewer (required if 
dashboard is used 
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and communicate progress made on strategic 
outcomes with the general public and other interested 
stakeholders 

for internal 
purposes only) 

Performance 
Management 
Mobile 

An ArcGIS Dashboards app, optimized for mobile 
devices, used by government agencies to monitor key 
performance indicators (KPIs) and communicate 
progress made on strategic outcomes with the general 
public and other interested stakeholders 

Viewer (required if 
dashboard is used 
for internal 
purposes only) 

Performance 
Management 
Survey 

An ArcGIS Survey123 form used by the general public 
to provide feedback on the community's strategic 
outcomes and key performance indicators (KPIs) 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Performance Management 
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Configure Performance Management 
Learn how to configure the Performance Management solution to meet specific needs in your 

organization. 

 

Load data 
The PerformanceManagement feature layer deployed with the solution is designed to be flexible 

to the different metrics that communities may want to measure as part of their Performance 

Management initiative. The PerformanceManagement feature layer contains two sublayers: 

• A Boundaries layer, which stores the different levels of geography used to measure 
community performance—for example, the municipality or city, council districts, 
neighborhoods, and so on. 

• A Metrics table, which stores the name of the metric, the strategic outcome it is associated 
with, the date it was reported, the geography it is measuring, the target or goal associated 
with the metric, and the actual value recorded. The image below shows an example of two 
metrics, Graduation Rate and Median Household Income, measured for different 
geographies and dates. 

•  

• The image below shows a filtered view of the table for a single metric, Graduation Rate, for 
the City of Naperville recorded annually since 2014. In this example, you have also set a 
new target or goal for 2019 with no actual value recorded yet. This allows you to display 
future goals in the performance dashboard. 
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•  

 

Load performance boundaries 
The Boundaries layer is used to define, which geographies the community want to measure 

performance and controls the options listed in the filter of the performance dashboard. This can 

be a single location (for example, the city), or multiple locations (for example, the city, its 

neighborhoods, and council districts). 

To load features from a shapefile into the Boundaries layer, complete the steps below: 

1. Sign in to your ArcGIS organization and browse to the PerformanceManagement 
feature layer item. 

  Note: 

  When you deploy the solution, two feature layers are created in your ArcGIS 
organization My Content tab, PerformanceManagement and 
PerformanceManagement_dashboard. PerformanceManagement_dashboard is a 
noneditable view of the PerformanceManagement feature layer that is used by the 
dashboards. PerformanceManagement is editable and is intended for users inside the 
organization to add, modify, and delete records. 

2. Open the item page and click Update Data > Append Data to Layer. 

3. Click Choose File and browse to a .zip containing the shapefile with your 

boundary features, and then click Open. 

4. Click Upload and Continue. 

5. Click the Choose the layer that you wish to append data into drop-down arrow 
and choose Boundaries. 

6. Uncheck Update existing features. 

7. Click Show field matching to map the fields. 

  Note: 

  The key required field for the Boundaries layer is the name field, which represents the 
name of the geography. This field is used in the relationship between the Boundaries 
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layer and Metrics table and is what drives the location filter in the dashboard. If you have 
a type field on the source layer, it can be mapped as well. If not, it can be edited after 
you append the data. 

8. Click Apply Updates. 

 

Load performance metrics 
The Metrics table is configured to allow a community to manage all their key performance 

indicator (KPI) data across different geographies and over time in a single table. Each row in the 

table corresponds to a single KPI for a specified geography and date and time. 

Often the performance data is coming from multiple business systems in the organization and 
exist in many different formats. Much of the effort in standing up the performance management 
dashboards is in bringing all these different datasets into a consistent format that can be 
consumed in ArcGIS. One approach for external tabular data is to use software such as 
Microsoft Excel to format the data to the model expected by the Metrics table. Once formatted in 
Microsoft Excel, the spreadsheet can be loaded into Metrics table. 

Tip: 

Download a sample Microsoft Excel spreadsheet with a schema matching the schema of 
the Metrics table to help with loading into the Performance Management solution. 

To prototype the dashboard, it may help to focus on one metric for a specific geography in the 
community. To load records from the spreadsheet into the Metrics table, complete the steps 
below: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
PerformanceManagement feature layer item. 

2. Open the item page and click Update Data > Append Data to Layer. 

3. Click Choose File, browse to your spreadsheet, and click Open. 

4. Click Upload and Continue. 

5. Click the Choose the layer that you wish to append data into drop-down arrow 
and choose Metrics. 

6. Uncheck Update existing features. 

7. Click Show field matching to map the fields. 

8. Click Apply Updates. 

 

Configure performance dashboard for an outcome 
The Performance Management solution comes with two template dashboards (large display and 

mobile) that can be reused for different outcomes and configured for KPIs measured in your 

community. 

To configure a dashboard for your strategic outcome and KPIs, complete the steps below: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Performance Management or Performance Management Mobile dashboard. 
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2. Open the item page and click Edit Dashboard. 

3. Click the arrow next to Save, click Save As, and specify a title, tags, and a 
summary. 

4. Hover over the upper left corner of the header and click Configure . 

5. Update the Title for your strategic outcome, and then click Done. 

6. Click the Save to save the dashboard. 

The large display dashboard has two rows of four panels each and the mobile dashboard has a 

single column with eight panels. Each panel is composed of three stacked elements: 

• The Current tab is an indicator element that displays the most recent reported value 
for a given metric. When applicable, this element also displays if the metric is 
meeting or not meeting the designated target for that geography. 

• The History tab is a serial chart element that displays the performance of that 
metric over time. The actual value is displayed as a bar chart, and when applicable, 
the target is displayed as a line. 

• The Detail tab is a rich text element where you can provide additional context for 
the metric, for example, how it is measured, where the data is coming from, and 
why it is important. 

Each panel is configured for a different key performance indicator associated with the strategic 

outcome. The steps below describe how you can configure each element in a panel for your 

metric. Repeat the steps below for each panel in the dashboard. 

Note: 

The mobile dashboard is intended to be embedded in a website, for example, the 
Community Performance site included in the solution. When editing or viewing the 
dashboard in the browser, the panels fill the space available and do not leave enough 
space for each panel vertically. The Community Performance site provides the mobile 
dashboard with enough space vertically so that each panel displays well, and the user can 
scroll the page to view each metric. 

 

Current tab 
To configure the Current tab, complete the steps below: 

1. Click the Current tab. 

2. Hover over the upper left corner of the element and click Configure . 

3. Click the Data tab. 

4. Change the Filter settings, by clicking the drop-down arrow and changing the 
Value to correspond to your metric. 

5. Click the Indicator tab. 

6. If your metric has a target, enable Conditional Formatting; otherwise, turn off this 
option. 
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  Note: 

  When enabled, you can visualize the value differently when the actual value is equal to 
or above the target value and when the actual value is less than the target. Also, 
complete the following steps for both representations. 

7. Optionally, modify the Middle Text for each indicator, to add or remove additional 
characters to display next to the actual value, for example, a percent sign, dollar 
sign, and so on. 

8. In the Icon area, click Change and choose an appropriate icon, or click the 
Custom tab to add your own custom Scalable Vector Graphics (SVG) icon. 

9. Optionally, in the Formatting area, change the value pattern to format the number. 

10. Click the General tab. 

11. Change the name of the element. 

12. Modify the Title setting by clicking Edit and updating the title for the metric. 

13. Modify the Description setting by clicking Edit. 

14. Click Source and copy and paste the appropriate HTML snippet below into the 
editor: 

  Value is meeting the target: 

  <table style="background-color:#35ac46; color:#ffffff; font-size:16px; 
padding:0px; width:100%"> 
    <tbody> 
        <tr>  
            <td width="40"> 
                <svg fill="#ffffff" height="32" id="ember25808" 
style="vertical-align: middle; margin-left:auto; margin-right:auto; 
display:block;" viewbox="0 0 16 16" width="32" 
xmlns="http://www.w3.org/2000/svg" 
xmlns:xlink="http://www.w3.org/1999/xlink"> 
                    <path d="M7.5 0C3.366 0 0 3.364 0 7.5S3.365 15 7.5 
15c4.136 0 7.5-3.364 7.5-7.5S11.636 0 7.5 0zm.001 14C3.916 14 1 11.084 1 
7.5S3.916 1 7.501 1C11.085 1 14 3.916 14 7.5S11.085 14 7.501 14z"></path> 
                    <path d="M11.634 4.633L6.5 9.767 4.312 7.579l-
.707.707L6.5 11.18l5.841-5.84z"></path> 
                </svg> 
            </td> 
            <td>  
                <p><span>Target: </span>{element/reference}</p>  
                <p>{reportdt}</p>  
            </td>  
        </tr> 
    </tbody> 
</table> 

  Value is not meeting the target: 

  <table style="background-color:#de2900; color:#ffffff; font-size:16px; 
padding:0px; width:100%">  
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    <tbody>  
        <tr>  
            <td width="40">  
                <svg fill="#ffffff" height="32" id="ember25808" 
style="vertical-align: middle; margin-left:auto; margin-right:auto; 
display:block;" viewbox="0 0 16 16" width="32" 
xmlns="http://www.w3.org/2000/svg" 
xmlns:xlink="http://www.w3.org/1999/xlink">  
                    <path d="M7 3h1v7H7zm0 8h1v1H7z" vector-effect="non-
scaling-stroke"></path>  
                    <path d="M7.5 0C3.366 0 0 3.364 0 7.5S3.365 15 7.5 
15c4.136 0 7.5-3.364 7.5-7.5S11.636 0 7.5 0zm.001 14C3.916 14 1 11.084 1 
7.5S3.916 1 7.501 1C11.085 1 14 3.916 14 7.5S11.085 14 7.501 14z" vector-
effect="non-scaling-stroke"></path>  
                </svg>  
            </td>  
            <td>  
                <p><span>Target: </span>{element/reference}</p> 
                <p>{reportdt}</p> 
            </td> 
        </tr> 
    </tbody> 
</table> 

  Metric has no target: 

  <table style="background-color:#0084a8; color:#ffffff; font-size:16px; 
padding:0px; width:100%">  
    <tbody>  
        <tr>  
            <td width="40">  
                <svg fill="#ffffff" height="32" id="ember25808" 
style="vertical-align: middle; margin-left:auto; margin-right:auto; 
display:block;" viewbox="0 0 16 16" width="32" 
xmlns="http://www.w3.org/2000/svg" 
xmlns:xlink="http://www.w3.org/1999/xlink">  
                    <path d="M7.5 0C3.366 0 0 3.364 0 7.5S3.365 15 7.5 
15c4.136 0 7.5-3.364 7.5-7.5S11.636 0 7.5 0zm.001 14C3.916 14 1 11.084 1 
7.5S3.916 1 7.501 1C11.085 1 14 3.916 14 7.5S11.085 14 7.501 14z"></path>  
                    <path d="M8.164 3.414l-.707.708L10.336 7H3v1h7.336l-
.224.224-2.655 2.655.707.707L12.25 7.5z"></path>  
                </svg>  
            </td>  
            <td>  
                <p>Measured</p>  
                <p>{reportdt}</p>  
            </td>  
        </tr>  
    </tbody>  
</table> 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 542 

15. Click Source, and click Done. 

16. Click Save to save the dashboard. 

 

History tab 
To configure the History tab, complete the steps below: 

1. Click the History tab. 

2. Hover over the upper left corner of the element and click Configure . 

3. Click the Data tab. 

4. Change the Filter settings, by clicking the drop-down arrow and changing the value 
to correspond to your metric. 

5. Update the Minimum Period setting frequency at which the metric is updated. 

6. If the metric has a target value, configure the chart with two series. Set the Series 1 
Field setting to Actual and set the Series 2 Field setting to Target. Click the + 
Series button to add a second series if it isn't already added. If the metric has no 
target, remove the second series. 

7. If you did not add a second series, go to step 12. 

8. Click the Chart tab. 

9. Change the Legend Placement setting to Bottom. 

10. Click the Series tab. 

11. In the Target area, change the Type setting to Line and the Color setting to 
#00734c. 

12. Click the General tab. 

13. Change the name of the element. 

14. Modify the Title setting by clicking Edit and updating the title for the metric. 

15. Click Done, and click the Save button to save the dashboard. 

 

Detail tab 
To configure the Detail tab, complete the steps below: 

1. Click the Detail tab. 

2. Hover over the upper left corner of the element and click Configure . 

3. In the rich text editor, update the title for the metric. 

4. Add any addition text, hyperlinks, or images to the description that will help explain 
how the metric is measured, where the data comes from, and why it is important. 

5. Click Done, and click the Save button to save the dashboard. 

 

Add a strategic outcome page to Community 

Performance site 
The Performance Management solution comes with a site that you can use to share key 

performance metrics and communicate progress made on strategic outcomes to the general 
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public and other interested stakeholders. The site includes a template page that can be reused 

for each outcome defined for the community. 

To add a new outcome page, complete the steps below: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Community Performance site. 

2. Open the item page and click View Application. 

3. At the top of the Community Performance site, click the Outcome tab. 

4. Click the edit button  to open the site editor. 

5. In the top right corner of the page, click More Actions  and choose Clone 
Layout. 

  Note: 

  This creates a copy of the Outcome page and creates a new item in the home folder of 
your content. 

6. In the side panel, click Page Info and update Page Info, Page Summary, and the 
slug of the page for your outcome. 

7. Scroll down the page and you will see the two performance management 
dashboards included with the solution embedded in the page. 

  Note: 

  While editing the page, both dashboards display. When viewing the page, the first 
dashboard is in a row that only displays when the browser width is greater than 992 
pixels. The second dashboard is optimized for mobile display and is in a row that only 
displays when the browser width is less than 992 pixels. 

8. Hover over the first dashboard and click the settings button . 

9. In the side panel, hover over the Modify button and click Edit. 

10. In the Select Application window, search for the Performance Dashboard 
associated with the outcome and click Select. 

11. Repeat steps 8 through 10 for the mobile dashboard. 

12. Scroll to the Outcome section of the page, hover over the image card and click the 
settings button. 

13. In the side panel, provide an image for the outcome by either dragging an image or 
browsing for an image. 

14. Hover over the Outcome card and click the settings button. 

15. Edit the text for your outcome to describe what it is and why it is important to the 
community. 

16. Click Save. 
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17. At the top of page, click the Community Performance drop-down arrow and 
choose Initiative Site. 

18. In the side panel, click Header. 

19. Expand the Menu options, click the Add Link drop-down arrow, and choose to 
existing content. 

20. In the Add Content window, search for the Outcome page you created in the 
previous steps and click Select. 

21. Drag the menu link in the side panel to reorder link positions at the top of the site. 

22. Click Save. 

Note: 

In the Discover What Makes Our Community Stand Out section of the site is a gallery 
card. This gallery shows any pages shared with the site that have the Outcome tag. The 
new outcome page you added in the previous steps now display here and provide a link to 
the page. To update the image and text associated with the gallery card, browse to the 
page item in your content and update the thumbnail, summary, and description. 

 

Share items with the public 
Several layer views, maps and apps included in the Performance Management solution must be 

shared with everyone so they can be accessed by the public on the Community Performance 

site. To share your performance management items with everyone, use the guide below and 

complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Performance Management folder. 

2. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   PerformanceManagement_dashboard 

  Feature Layer (hosted, view)   PerformanceManagementSurvey_public 

  Dashboard   Performance Management 

  Dashboard   Performance Management Mobile 

  Form   Performance Management Survey 

  Site Application   Community Performance 

3. Click Share. 
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4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 

 

Modify performance survey 
To modify the Performance Management Survey, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to 
Performance Management Survey. 

2. Open the item page and click Open in Survey123 > Manage in Survey123 
website. 

3. Click the Design tab. 

4. Edit the survey and save the changes. 

5. Click Publish. 
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Use Performance Management 
The Performance Management solution delivers a set of capabilities that help you tabulate 

performance metrics, monitor performance using a series of dashboards and key performance 

indicators (KPIs), visualize performance for defined geographies, and share performance with 

the public through a community website. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Monitor community performance 
You will assume the role of a resident in the community. You are interested in learning how the 

community measures success and learn how well the community and your neighborhood is 

performing in these areas. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Performance Management solution. 

2. View the Community Performance site. 

3. Scroll down to the Discover What Makes Our Community Stand Out section of 
the page and click one of the strategic outcomes. 

  At the top of the page is the associated performance dashboard. Each KPI displays the 
most recent reported value, when it was last measured, and when applicable, if the metric 
is meeting or not meeting the designated target. 

4. For a KPI, click the History tab. 

  This tab displays the performance of that KPI over time. The actual value is displayed as a 
bar chart and when applicable the target is displayed as a line. 

5. For a KPI, click the Details tab. 

  This tab provides additional context for the KPI—for example, how it is measured, where 
the data is coming from, and why it is important. 

6. Click a new geography from the drop-down menu in the upper right corner of the 
dashboard to visualize for performance at locations in the community—for example, 
a neighborhood or council district. 

7. Click another outcome using the links at the top of the site to view the 
corresponding performance dashboard and related KPIs. 

 

Provide feedback on performance initiative 
After reviewing the community goals and the KPIs used to measure performance, you want to 

provide feedback on the aspects you liked and thought the community is performing well in and 

the aspects you feel the community can improve. 
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1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Performance Management solution. 

2. View the Community Performance site. 

3. Scroll down to the Tell Us How We’re Doing section and click the Share 
Feedback button to open the Performance Management Survey app. 

4. Fill out the Performance Management Survey survey to provide your feedback. 

5. Click Submit. 
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Plans and Drawings 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Plans and Drawings 
Plans and Drawings can be used to index the geographic extent of record plans and drawings 

and provide access to a catalog of source documents in the office or the field. 

Design drawings, construction plans, as-builts, and other source documents contain vital 
information that is used daily by engineers and field staff to make infrastructure improvements. 
Many times, these drawings have been automated and are cataloged in a document 
management system, but some drawings may only exist in hardcopy format and be stored in an 
office file cabinet. And while each of these record drawings may represent a given geography, 
understanding the extent of the record drawing and whether it contains the information you are 
looking for can be quite time consuming. Plans and Drawings is typically implemented by public 
works agencies and utilities that want to simplify access to record drawings and ensure that 
engineers and field staff understand what drawings exist at a given location. 

The Plans and Drawings solution delivers a set of capabilities that help you index record 
drawings, associate a geographic extent with each drawing, and provide access to a catalog of 
plans and drawings in the office or the field. 

 

Requirements 
Plans and Drawings requires the following: 

• ArcGIS Enterprise 

 

Information products 
Plans and Drawings includes the following information products: 

Item Description 
Minimum 
user type 

Plan 
Catalog 

An ArcGIS Web AppBuilder app used by public works staff to 
access a catalog of record drawings, as-builts, and other source 
documents 

Viewer 

Plan 
Index 

An ArcGIS Web AppBuilder app used by public works staff to index 
the geographic extent of record plans and drawings 

Editor 
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When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Plans and Drawings 
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Use Plans and Drawings 
The Plans and Drawings solution delivers a set of capabilities that help you index record 

drawings, associate a geographic extent with each drawing, and provide access to a catalog of 

plans and drawings in the office or the field. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Index plans and drawings 
First, you will assume the role of a public works engineer. You need to index a record drawing 

submitted for a recent project. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Plans and 
Drawings solution. 

2. View the Plan Index app. 

  The Index Plan widget allows you to create a geographic extent for your project. 

3. To create a new plan, click the Plans and Drawings template. 

4. Click the map to draw the geographic extent around the project location, and then 
double-click to finish drawing the polygon. 

  Note: 

  You can use the Search widget to quickly update the map extent to desired addresses, 
place-names, or locations of existing projects. 

5. After you draw the geographic extent, you are prompted with a Plans Index form. 

6. Complete the form with as much information as possible. 

  Tip: 

  In the Document Path text box, type a URL or other resolvable file path to your 
organization's existing document repository solution. 

  In the Document Location Description text box, describe the physical location if 
documents are not stored in a digital format with a resolvable document path, link, or 
URL. For example, type Public Works Building, 2nd Floor in the 2022 
Projects cabinet. 

7. Scroll to the Attachments option. 

  Note: 
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  The Attachments option is useful for uploading before-and-after photos related to the 
project and other relevant project media. 

8. Optionally, add attachments. 

9. Click Save to complete the indexing workflow. 

 

View plans and drawings 
After they are indexed, record drawings can be accessed from the office or the field. Now, you 

will assume the role of an engineer at a local utility who needs to access pertinent plans and 

drawings while in the field on a site visit to a new infrastructure project. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Plans and 
Drawings solution. 

2. View the Plan Catalog app. 

  The app opens with the Filter Plans widget open on the right. Filters are active by default; 
filtering by project type or date automatically updates the results in the map. 

3. In the Filter Plans widget, adjust the filters to refine the results. 

4. On the map, click a project extent. 

  A pop-up with more information about the project appears. In addition to providing project 
information, the pop-up includes a Document ID link, if available. 

5. If available, click the Document ID link to open the referenced plan or drawing 
associated with this project.  

  The link opens in a new browser tab. 

   

Share a record drawing link 
A colleague has requested information about the record drawing for a bridge project that you 

recently indexed. You will use the Plan Catalog to create a direct link to the project details and 

share with your colleague. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Plans and 
Drawings solution. 

2. View the Plan Catalog app. 

3. At the upper right, click the Share button to open the widget. 

  In the Share widget, under Share a link to this app, there is a pregenerated link. By 
default, this short link uses your app's current map extent. In the following steps, you will 
construct a query within the share link so that it opens a specific project detail when 
opened. 

4. Click Link Options. 

5. Click Query a feature and zoom to it.  

  The drop-down lists that appear must be completed to generate a project-specific app link. 

6. Click the first drop-down arrow and choose Plans and Drawings. 

7. Click the second drop-down arrow and choose projname. 
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8. Click the third drop-down arrow and search for or choose the project that you want 
to share.  

9. At the top of the widget, click the Back arrow. 

  The sharing short link is now updated using your project query information. 

10. Below the short link, click the Email button to launch a pregenerated email with 
your custom app link.  

  A draft email opens in your device’s default email handler. Alternatively, you can copy the 
short link from the Share a link to this app text box. If you have accessed the Plan 
Catalog app from a mobile device, you can use this link to share a record by text message 
or other messaging app. 
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Police Transparency 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Police Transparency 
Police Transparency can be used to share authoritative information and communicate 

engagement efforts that build trust with the public and community stakeholders. 

In some communities, inequitable policing practices have eroded the public’s trust and 
challenged the legitimacy of local law enforcement agencies. As a result, many agencies are 
seeking new ways to improve their relationship with the communities they serve. The larger 
reform efforts are helping law enforcement agencies improve transparency and demonstrate 
accountable police policies. At the same time, agencies are also engaging the community more 
deeply and using their feedback to drive policing priorities and enforcement policies. Police 
Transparency is typically implemented by law enforcement agencies that want to increase 
transparency, grow public trust, and improve relationships with the communities they serve. 

The Police Transparency solution delivers a set of capabilities that help you share information 
openly with the public, promote your agency’s work, demonstrate accountability when force is 
used, illustrate how workforce recruiting reflects the diversity of the community, and engage the 
public to improve policing services and solve problems. 

 

Requirements 
Police Transparency requires the following: 

• ArcGIS Enterprise 

 

Information products 
Police Transparency includes the following information products: 

Item Description 
Minimum user 
type 

Police Transparency An Enterprise Sites site used by the public to 
understand community crime conditions, explore 
patterns of police use of force, learn about the 
diversity of their police force, access open data, and 
discover opportunities for police-community 
engagement. 

Not required 
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Crime Summary 
Dashboard 

An ArcGIS Dashboards app used by the public to 
understand historical statistical trends across major 
crime categories and individual crime types. 

Not required 

Crime Trends 
Dashboard 

An ArcGIS Dashboards app used by the public to 
explore statistical trends and hot spots across 
individual crime types. 

Not required 

Public Crime Map An ArcGIS Web AppBuilder app used by the public 
to explore recent crime conditions in their community 
and create reports for an area of interest. 

Not required 

Use of Force by 
Race and Ethnicity 

An ArcGIS Dashboards app used by the public to 
explore patterns in the race and ethnicity of officers 
and subjects involved in use of force incidents in 
relation to the composition of the community. 

Not required 

Use of Force by 
Race and Ethnicity 
Mobile Dashboard 

An ArcGIS Dashboards app used by the public on 
mobile devices to explore patterns in the race and 
ethnicity of officers and subjects involved in use of 
force incidents in relation to the composition of the 
community. 

Not required 

Use of Force by 
Neighborhood 

An ArcGIS Dashboards app used by the public to 
explore characteristics of use of force incidents by 
community policing area. 

Not required 

Use of Force by 
Subject 

An ArcGIS Dashboards app used by the public to 
explore characteristics of the subjects of use of force 
incidents. 

Not required 

Use of Force by 
Officer 

An ArcGIS Dashboards app used by the public to 
explore characteristics of the officers involved in use 
of force incidents. 

Not required 

Police Interaction 
Survey 

An ArcGIS Survey123 form used by the public to 
provide feedback about their interactions with police 
personnel. 

Not required 

My Community 
Officer 

A Zone Lookup app used by the public to learn about 
the community policing officer responsible for an 
area of interest and how to contact them. 

Not required 

Community Safety 
and Policing 
Satisfaction Survey 

An ArcGIS Survey123 form used by the public to 
report their perceptions of community safety and 
holistic performance of their police agency. 

Not required 

Community Crime 
Problem Reporter 

A Crowdsource Reporter app used by the public to 
submit information about crime problems in their 
community. 

Not required 
(Optional 
Community 
Identity) 

Community Crime 
Problem Manager 

An ArcGIS Dashboards app used by community 
policing officers to capture data on a community 
crime problem-solving project as it proceeds through 
the SARA problem-solving model. 

Editor 
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Community Crime 
Problem Dashboard 

An ArcGIS Dashboards app used by the public to 
monitor the status and outcomes of community crime 
problem-solving projects. 

Not required 

Law Enforcement 
Diversity Dashboard 

An ArcGIS Dashboards app used by the public to 
understand the racial, ethnic, and gender diversity of 
their police force in relation to the composition of the 
community. 

Not required 

Law Enforcement 
Diversity Mobile 
Dashboard 

An ArcGIS Dashboards app used by the public on 
mobile devices to understand the racial, ethnic, and 
gender diversity of their police force in relation to the 
composition of the community. 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Police Transparency 
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Configure Police Transparency 
In this topic, you will learn how to configure the Police Transparency solution to meet specific 

needs in your organization. 

 

Load your data 
Police Transparency can be used by law enforcement agencies to share crime, use of force, 

police personnel, and community policing boundary information. In some cases, you may 

already have this information in ArcGIS Enterprise or another business system. 

Review the layers provided with the solution and determine what source data you want to load. 
Then, load your existing data into the layers provided with the ArcGIS Solution before sharing 
the maps or apps. 

Once you have determined what source data must be loaded, complete one, or more, of the 
data-loading workflows below. 

 

Load police personnel roster 
Police Transparency can be used by law enforcement agencies to share data about the 

diversity of their agency personnel. The Police Transparency solution includes the Law 

Enforcement Diversity Dashboard that can be used to display this information by race, ethnicity, 

and gender in relation to community proportions. 

To load your agency personnel roster into the Law Enforcement Diversity Dashboard from a 
spreadsheet, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the Police Personnel Microsoft 
Excel item. 

2. On the item details page, click Download. 

3. Once downloaded, open the Police_Personnel.csv file and enter your personnel 
roster information. 

  Tip: 

  Many fields have existing domain values that are used for filters and charts in the Law 
Enforcement Diversity Dashboard. If the values in your data are not identical to the 
values in each domain, you can either change the values in your data to match the 
values already in each field’s domain list to update the domain list of each field in the 
Police_Personnel table to reflect the values in your data. Then follow the steps in the 
Modify apps section to update the Law Enforcement Diversity Dashboard to reflect your 
values. 

4. Ensure the name of the spreadsheet is Police_Personnel and do not change any 
field names. 

5. Click Save to save your changes. 

6. In your ArcGIS organization, browse to the Police_Personnel hosted feature table. 
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7. On the item details page, click Update Data, then click Append Data to Layer. 

8. Under Filename, choose your .csv file. 

9. Click Upload and Continue. 

10. Uncheck Update existing features. 

11. Click Show field matching. 

12. Confirm that all fields listed in the Fields column have a corresponding field listed 
in the Match Field column. 

13. If no field is listed in the Match Field column, click the drop-down box for that field, 
and select the field name from the spreadsheet that reflects the value shown in the 
Fields column. 

14. Click Apply Updates. 

 

Load community policing areas 
To load your data into the CommunityPolicingAreas layer, complete the following steps: 

1. In your ArcGIS organization, browse to the feature layer you want to populate. 

2. Create a .zip file of a shapefile of your Community Policing Areas. 

3. On the item details page, click Update Data , then click Append Data to Layer. 

4. Under Filename, choose your  .zip file. 

5. Click  Upload and Continue. 

6. From Choose the layer that you wish to append data into, select  the 
CommunityPolicingAreas layer. 

7. Uncheck Update existing features. 

8. Click  Show field matching  to map the fields. 

9. Click Apply Updates. 

 

Load use of force data 
Police Transparency can be used by law enforcement agencies to share use of force 

information. The solution includes several charts and dashboards that can be used to display 

characteristics of use of force incidents by race and ethnicity, neighborhood, subject of the 

force, and the officer involved. 

To load your agency use of force data from a spreadsheet into the UseOfForce feature layer, 
complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the UseOfForce Microsoft Excel 
item. 

2. On the item details page, click Download. 

3. Once downloaded, open the UseOfForce Excel workbook. 

  Note: 

  The workbook contains three spreadsheet tabs—one for Incidents, one for Subjects, 
and one for Officers. Enter your personnel roster information. 
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4. Ensure the name of the spreadsheet is UseOfForce and do not change any field 
names. 

  Note: 

  Review the fields in the UseOfForce feature layer. This layer is comprised of an Incidents 
layer, an Officers related table, and a Subjects related table—you will need to be familiar 
with the fields and domain values of all three. 

  Tip: 

  Many fields have existing domain values that are used in filters and charts on the ArcGIS 
Enterprise Sites page and in the use of force dashboard. If the values in your data are 
not identical to the values in each domain, you can either change the values in your data 
to match the values already in each field’s domain list, or follow the steps in the Modify 
data section to update the domain list of each field in the UseOfForce feature layer to 
reflect the values in your data. Then follow the steps in the Modify apps section to 
update the ArcGIS Enterprise Sites charts, Use of Force by Race and Ethnicity, Use of 
Force by Neighborhood, Use of Force by Officer, and Use of Force by Subject 
dashboards to reflect your values. 

5. Click Save to save your changes. 

6. In your ArcGIS organization, browse to the UseOfForce feature layer. 

7. On the item details page, click Update Data, then click Append Data to Layer. 

  Note: 

  Ensure that the data in your Excel workbook already has valid latitude and longitude 
coordinates. If your data has only addresses and no coordinates, you can geocode it 
using a local address locator and ArcGIS Pro, or the Publish an Excel file workflow in 
your ArcGIS organizational portal. Export the resulting layer as a CSV file or Excel 
spreadsheet and add the Latitude and Longitude values to the UseOfForce worksheet 
in the Incidents layer. 

8. Under Filename, choose your Excel workbook file.  

9. Click Upload and Continue. 

10. Select Incidents from the drop-down list and choose the layer into which you want 
to append data. 

11. Select Incidents from the drop-down list and choose the layer from 
UseOfForce.xlsx that contains the updated data. 

12. Uncheck Update existing features. 

13. Click Show field matching. 

14. Confirm that all fields listed in the Fields column have a corresponding field listed 
in the Match Field column. 

  If no field is listed in the Match Field column, click the drop-down box for that field, and 
select the field name from the spreadsheet that reflects the value shown in the Fields 
column. 
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15. Click Apply Updates. 

16. Repeat steps 7 through 15 twice, appending the data from the Officers and 
Subjects tabs of your spreadsheet into the Officers and Subjects feature tables. 

Note: 

If you want to automate the process of appending new Use of Force data from a local Excel 
workbook into the UseOfForce feature layer, see the Automate data updates section. 

 

Load crime data 
Police Transparency can be used by law enforcement agencies to share crime data. The 

solution includes web mapping apps and dashboards that can be used to display current and 

historical crime conditions in a community. 

To load your agency crime data from a spreadsheet into the Crime feature layer, complete the 
steps below. 

Tip: 

Ensure that the data in your Excel workbook already has valid latitude and longitude 
coordinates. If your data has only addresses and no coordinates, you can geocode it using 
a local address locator and ArcGIS Pro, or the Publish an Excel file workflow in your ArcGIS 
organizational portal. Export the resulting layer as a CSV file or Excel spreadsheet and add 
the Latitude and Longitude values to the Crimes worksheet along with the rest of your 
features. 

1. Sign in to your ArcGIS organization and browse to the Crimes feature layer. 

2. On the item details page, click Update Data, then click Append Data to Layer. 

3. Under Filename, choose your Excel workbook file. 

4. Click Upload and click Continue. 

  Tip: 

  You will need to be familiar with the fields and domain values. Many fields have existing 
domain values that are used for filters and charts in the Crime Summary Dashboard, 
Crime Trends Dashboard, and Public Crime Map. If the values in your data are not 
identical to the values in each domain, you can either change the values in your data to 
match the values already in each field’s domain list, or follow the steps in the Modify data 
section to update the domain list of each field in the Crime feature layer to reflect the 
values in your data. When complete, you will update the Crime Summary Dashboard, 
Crime Trends Dashboard, and Public Crime Map to reflect your data values. 

5. Uncheck Update existing features. 

6. Click Show field matching. 

  The Field column contains all of the fields in the Crimes feature layer. The Match Field 
column displays the names of all fields in your source Excel workbook. 
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  If no field is listed in the Match Field column, click the drop-down box for that field, and 
select the field name from your spreadsheet that reflects the value shown in the Fields 
column. 

7. Click Apply Updates. 

Note: 

If you want to automate the process of appending new Use of Force data from a local Excel 
workbook into the Crimes feature layer, see the Automate record import section. 

 

Load data for use of force context chart 

1. Sign in to your ArcGIS organization and browse to the ContextOfUseOfForce CSV 
item. 

2. On the item details page, click Download. 

3. Click Edit on the CSV file and enter a single year’s worth of summary totals for the 
following datasets: Calls For Service, Arrests, Total Use of Force, Serious Injury 
Force, and Deadly Force. Click Save to save the CSV file when complete. 

4. In your ArcGIS organization, browse to the ContextOfUseOfForce feature table. 

5. On the item details page, Click Update Data, then click Append Data to layer. 

6. Under Filename, choose your CSV file. 

7. Click Upload and Continue. 

8. Uncheck Update existing features. 

9. Click Show field matching. Confirm that all fields listed in the Fields column have 
a corresponding field listed in the Match Field column. If no field is listed in the 
Match Field column, click the drop-down box for that field, and select the field 
name from the CSV file that reflects the value shown in the Fields column. 

10. Click Apply Updates. 

Tip: 

To modify the data in this table after the initial load, browse to the data section of the 
ContextOfUseOfForce item, and double-click a value in the table to change it. 

 

Remove outdated personnel records (optional) 
At some point, you may want to delete all data in a feature layer to load new information. For 

example, your organization may update the personnel roster information used in the Law 

Enforcement Diversity Dashboard semi-annually. To avoid duplicate or incorrect records, the 

existing records must first be deleted before a current roster can be appended into the solution’s 

Police Personnel table. 

Delete features 
To delete features from a hosted feature layer or table, complete the following steps: 
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1. Sign in to your ArcGIS organization. 

2. Go to the Overview tab of the Police_Personnel hosted feature table. 

3. In the lower right corner, in the URL category, click View. 

  The ArcGIS REST Services Directory for this page appears. 

4. Click the link of the layer or table from which you want to delete records. 

5. In the URL bar of the browser, edit the URL with the following changes. 

a. Add the word admin between rest/ and services. (For example: 

ArcGIS/rest/admin/services/Police_Personnel) 

b. Add the word truncate between 0/ and ?token. (For example: 

FeatureServer/0/truncate?token=) 

6. In the next window, click Truncate. 

 

Update a layer with a join view 
The Police Transparency solution includes a series of feature layer join views that are used to 

display information in the Use Of Force page and in a series of use of force dashboards. Join 

views are created using the Join Features analysis tool by joining two sources together based 

on a matching field. The benefit of the join view is that it remains up to date as the source data 

changes. However, when new fields are added to the source layers or when field domain values 

are changed, the join views must be recreated with the same name and URL for the charts and 

dashboards to continue working properly. 

To add a field to a layer and update the join views, complete the following steps: 

1. Browse to the join view in your contents. 

2. On the item's Overview page, scroll to the URL section. Click the Copy button. 

3. Paste the copied URL into Microsoft Notepad or another text editor for reference. 

  Note: 

  The feature layer’s service name will be used below when re-creating the join. The name 
can be found after services in the URL structure and may also contain a unique GUID, 
for example, 
UseOfForce_Incidents_Subjects_joina45f71a48587425c9b90ee5527cd26d1. 

4. Delete the existing join view. 

5. Add the source hosted feature layer to a new web map (for example, UseOfForce). 

6. Click Analysis, Summarize Data, Join Features. 

7. Configure the join using the table below. 

  Name of join 

  Targe
t 
layer 

  Layer 
to join 
to the 
target 
layer   Fields to match 

  Joi
n 
ope
rati
on 
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  UseOfForce_Inciden
ts_Subjects_join 

  Incide
nts 
(UseO
fForce
) 

  Subje
cts 
(UseO
fForce
) 

  agency_case_number=ag
ency_case_number 

  Join 
one 
to 
man
y 

  UseOfForce_Inciden
ts_Officers_join 

  Incide
nts 
(UseO
fForce
) 

  Office
rs 
(UseO
fForce
) 

  agency_case_number=ag
ency_case_number 

  Join 
one 
to 
man
y 

  Tip: 

  Ensure each new join view uses the names defined in the table above. If you use the 
same names, the layers in the map and the existing dashboard widgets will not have to 
be reconfigured. If your join view contained a unique GUID, the new join view must be 
named with the unique GUID. 

8. If necessary, uncheck Use current map extent. Check Create results as hosted 
feature layer view. 

9. Update the web map and app configurations of Use of Force by Race and Ethnicity, 
Use of Force by Neighborhood, Use of Force by Subject, and Use of Force by 
Officer Dashboard to account for the new fields or domain values you added. 

 

Automate record import 
Some organizations may want to automate the importing of data from their record systems into 

the layers in the Police Transparency solution. In particular, users may want to perform daily or 

weekly updates of their Crimes or Use of Force data to ensure that residents have timely access 

to information. 

The layers in the Police Transparency solution can be updated using the Record Import 
Tools toolbox. These tools can be executed from ArcGIS Pro manually or automated on a 
schedule using Windows Task Scheduler. The Toolbox supports the use of database tables 
from your Computer Aided Dispatch (CAD) or Records Management System (RMS) as well 
as Microsoft Excel spreadsheets (.xls) or comma-separated values (.csv) files. 

 

Modify ArcGIS Enterprise Sites pages 
The Police Transparency solution includes an ArcGIS Enterprise Sites site and pages that your 

organization can configure with your own branding and share your organization’s story with the 

public. 
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Update with organizational information  
After deploying the Police Transparency solution, the site and pages require a few updates to fit 

your local context. Consider what information you already have and what you can most easily 

find. 

To update the Police Transparency site, complete the following steps: 

1. From the Customize window of the Site Home, select Header and Branding. 

2. Update the header to include your organizational icon. 

3. Change the name and short name of the site ( Police Transparency) to a name that 
better reflects your specific organization. 

4. Browse to the Social Icons group and enter in the URLs for your agency's 
Facebook, Twitter, and Instagram accounts, or disable if you don’t want them 
displayed. 

5. Click Apply, then click Save to save the page, and click Publish Draft. 

6. From the Customize window of the Site Home, select Footer. 

7. Click the expand button in the right corner of the HTML section. 

8. Replace the default icon URL, department name, email address, and street 
address with the correct values for your organization. 

9. Enter the URLs for your agency's Facebook, Twitter, LinkedIn, Instagram, and 
YouTube accounts. 

10. Delete any icons from the HTML that are not required, then click Apply. 

11. Click Save to save the page. 

12. Click Publish Draft. 

13. Update the main header image on each page to an image from your organization. 

  For best results, this image should be 96 dpi and 1920 x 400. 

14. Update the other stock images in the site with images from your organization. 

  For best results, these images should be 600 x 400 and 96 dpi. 

15. On the main page, click Configure on the Facebook and Twitter Social Media 
Cards to update the Timeline Link URL to your organization’s Facebook and Twitter 
pages. 

16. Review all text on each page for consistency with your organizational messaging. 

  Tip: 

  Consider working with your Public Information Officer to refine this content to reflect your 
organizational needs. 

17. Browse to the Frequently Asked Questions section of the main page and click 
Configure to update the questions and answers. 

18. Browse to the Recruitment, Employment, and Diversity Resources section of 
the Personnel Diversity page and click Configure to update the images, text, and 
buttons to reflect your organizational initiatives. 
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Remove ArcGIS Hub Premium content 
The Police Transparency solution comes with features that require ArcGIS Hub Premium; if you 

are using ArcGIS Enterprise Sites, you will want to remove the features that require ArcGIS Hub 

Premium. Organizations using this solution with ArcGIS Enterprise Sites should perform the 

following steps to remove the ArcGIS Hub Premium content from their site. 

To remove ArcGIS Hub premium content, complete the following steps: 

1. Browse to your app launcher and click Hub and click Police Transparency to begin 
editing the site. 

2. Scroll to the section titled Get Involved on the main site page. 

3. Click the delete button for the row card containing the section title, not just the 
section title. 

4. Click Save, then click Publish Draft. 

5. Repeat steps 1 through 3 for the Community Engagement, Workforce Diversity, 
Crime Stats, and Use of Forces pages in the site. 

6. Go to the Community Engagement page and scroll to the Scheduled Events 
section. 

7. Click the delete button for the row card containing the event calendar, not just the 
event calendar itself. 

8. Click Save, then click Publish Draft. 

 

Modify custom use of force charts 
Several charts on the Use of Force page of the Police Transparency solution make use of 

custom queries from solution layers that use preexisting values from domain lists. For your data 

to display properly in these charts, the values in your data must exactly match the values in the 

field domain list of the field in the feature layer. If your data contains different values, you must 

modify the custom JSON of the Hub charts to reflect your field values. 

To modify the JSON of the custom use of force charts, complete the following steps: 

1. Sign in to your ArcGIS organization. 

2. Click your app launcher and select Sites. 

3. Click the Police Transparency site. 

4. On the Customize accordion, click the number of associated pages button. 

5. Click the Use of Force page. 

6. Find the chart labeled Serious Injury Use of Force Incidents and click the 
configure button (shaped like a gear). 

7. In the JSON Chart Definition section, find the section of the JSON that looks like 
the following: 

  "where": "forcelevel='Level 3- Serious Injury'" 

8. Replace the value Level 3- Serious Injury with the value in your data that 
represents incidents involving serious injury. 

9. Click Apply. 

10. Click Save and click the drop-down list and select Publish Draft. 
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11. Repeat steps 6 through 10 with the Fatal Use Of Force Incidents chart, replacing 
the value Deadly Force-Fatality with the value in your data that represents fatal use 
of force incidents. 

 

Modify apps 
The Police Transparency solution includes many apps that are used by law enforcement 

agencies to help residents and stakeholders explore crime conditions, use of force patterns, and 

departmental diversity. Apps in the Police Transparency solution can be modified to meet the 

needs of individual organizations. This section covers several app modification workflows 

organizations commonly require. 

 

Modify dashboards 
The Use of Force by Race and Ethnicity and Law Enforcement Diversity Dashboard require an 

organization to manually enter your jurisdiction’s population percentage values for each 

race/ethnicity group represented on the dashboards. This information helps to contextualize 

proportions of force and personnel data relative to the composition of the community. 

To update the dashboards with population percentages by race and ethnicity for your 
jurisdiction, complete the following steps: 

1. Obtain information about population percentages by race and ethnicity for your 
jurisdiction. 

  Tip: 

  This data is most typically obtained from the U.S. Census Bureau’s Quick Facts web 
page, where you can type the name of your jurisdiction to get population percentages by 
race and ethnicity. Consult your planning department for more information. 

2. Sign in to your ArcGIS organization. 

3. Browse to and click to open the item page of the dashboard you want to edit. 

4. Click Edit Dashboard. 

5. Find the first indicator element where the language Community Makeup: XX% 
appears and click the configure (gear) button. 

6. Click the General options category, then click Edit in the Description section. 

7. Switch the default value with the appropriate value for your jurisdiction. 

8. Repeat for all indicator elements with the Community Makeup: XX% text. 

9. Click Save. 

 

Update dashboard charts to reflect new field values 
Dashboards in the Police Transparency solution have been preconfigured to use layer fields 

that are powered by default domain values. If your data does not match the preexisting values, 

your data may not display or may display as a gray other value in dashboard charts. 
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To update dashboards to reflect new field values, complete the following workflow: 

1. Sign in to your ArcGIS organization. 

2. Browse to and click to open the item page of the dashboard you want to edit. 

3. Click Edit Dashboard. 

4. Review your dashboard and identify all chart elements that require updating. 

5. For each chart element that needs an update, click the configure button. 

6. If the chart is a pie chart, click the Slices options category, delete the existing 
values, then click Load Categories. Style the categories with colors appropriate for 
the dashboard. 

7. If the chart is a serial chart, click the Series options category, delete the existing 
values, then click Load Categories. Style the categories with colors appropriate for 
the dashboard.  

8. Click Save. 

 

Update dashboard filters to reflect new field values 
The Use of Force by Race and Ethnicity and Law Enforcement Diversity Dashboard both use 

field values (that are preset by a domain) to filter by specific demographic groups. If the values 

in your data differ from the domains present in the default fields of the Police_Personnel, 

UseOfForce-Subjects, and UseOfForce-Officers tables, these dashboards may not properly 

display. For example, if your data contains coded values for race/ethnicity (A, B, W, I, H, and so 

on) instead of complete values such as the domain for these fields, you will need to modify the 

element filters of these dashboards to reflect your values. 

To update dashboard elements in Law Enforcement Diversity Dashboard or Use of Force by 
Race and Ethnicity to use your field values, complete the following steps: 

1. Sign in to your ArcGIS organization. 

2. Browse to and click to open the item page of the dashboard you want to edit. 

3. Click Edit Dashboard. 

4. Review your dashboard and identify all chart elements that require updating. 

5. For each indicator element that needs an update, click the configure button. 

6. In the Value drop-down list of the Filter section, replace the default value with the 
appropriate value from your data that represents the information conveyed by the 
element. 

7. Click Done. 

8. Repeat for all other indicator elements in the dashboard that require updating. 

9. Click the Save button. 

 

Change the crime summary dashboard from NIBRS to UCR 
Some organizations may want to provide public crime data according to the Federal Bureau of 

Investigation’s old Uniform Crime Reporting Summary Reporting System (SRS) standards 

rather than the new National Incident-Based Reporting System (NIBRS). The Crime Summary 

Dashboard is configured using the NIBRS standard, but can be updated to reflect the older UCR 

SRS standard if required by an organization. 
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To update the Crime Summary Dashboard from NIBRS reporting standards to UCR SRS 
standards, complete the following workflow. 

Note: 

Before you begin this workflow, ensure that you have valid values populated in the UCR 
Offense Description and UCR Offense Category fields of the Crimes layer. 

1. Sign in to your ArcGIS organization. 

2. Browse to your content and click the Crime Summary Dashboard. 

3. Click Edit Dashboard. 

4. Click the configure button in the upper left corner of the Rich Text element 
containing the text Crimes Against Persons. 

5. In the text box, change the text to Violent Crime, then click Done. 

6. In the indicator element immediately below, click the configure button. 

7. In the Value section and Filter subsection, change the drop-down selection from 
NIBRS Crime Against Category to UCR Category, then change the value from 
Crimes Against Persons to Violent Crime (or the equivalent value in your data). 

8. Scroll down to the Reference section and Filter subsection, change the drop-down 
selection from NIBRS Crime Against Category to UCR Category, then change 
the value from Crimes Against Persons to Violent Crime (or the equivalent value 
in your data). 

9. Click Done. 

10. Click the configure button on the Crimes Against Persons By Year chart element 
to the right of the last two elements you modified. 

11. In the Filter section, change the drop-down selection from NIBRS Crime Against 
Category to UCR Category, then change the value from Crimes Against 
Persons to Violent Crime (or the equivalent value in your data). 

12. Click Done. 

13. Click the configure button on the Crimes Against Persons By Month chart 
element to the right of the last element you modified. 

14. In the Filter section, change the drop-down selection from NIBRS Crime Against 
Category to UCR Category, then change the value from Crimes Against 
Persons to Violent Crime (or the equivalent value in your data). 

15. Click Done. 

16. Repeat steps 4 through 15 for the remaining two rows of elements, replacing 
Crimes Against Property with Property Crime (or the equivalent value in your 
data), then replacing Crimes Against Society with Part II crimes (or the 
equivalent value in your data). 

17. Click the Save button. 

 

Change the crime trends dashboard from NIBRS to UCR 
Some organizations may want to provide public crime data according to the Federal Bureau of 

Investigation’s old Uniform Crime Reporting Summary Reporting System (SRS) standards 
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rather than the new National Incident-Based Reporting System (NIBRS). The Crime Trends 

Dashboard is configured using the NIBRS standard, but can be updated to reflect the older UCR 

SRS standard if required by an organization. 

To update the Crime Trends Dashboard from NIBRS reporting standards to UCR SRS 
standards, complete the following workflow. 

Note: 

Before you begin this workflow, ensure that you have valid values populated in the UCR 
Offense Description and UCR Offense Category fields of the Crimes layer. 

1. Sign in to your ArcGIS organization. 

2. Browse to your content and click the Crime Summary Dashboard. 

3. Click Edit Dashboard. 

4. Click the configure button along the right side of the Crime Type filter. 

5. In the Category Field, change the drop-down selection from NIBRS Description 
to UCR Description. 

6. Click the Actions options tab. 

7. In the Target Field drop-down list for the Crime Hotspots layer, select UCR 
Description. 

8. Click Done. 

9. Click the Save button. 

 

Change the public crime map from NIBRS to UCR SRS 
Some organizations may want to provide public crime data according to the Federal Bureau of 

Investigation’s old Uniform Crime Reporting Summary Reporting System (SRS) standards 

rather than the new National Incident-Based Reporting System (NIBRS). The Public Crime Map 

app is configured using the NIBRS standard, but can be updated to reflect the older UCR SRS 

standard if required by an organization. 

To update the Public Crime Map app from NIBRS reporting standards to UCR SRS standards, 
complete the following workflow. 

Note: 

Before you begin this workflow, ensure that you have valid values populated in the UCR 
Offense Description and UCR Offense Category fields of the Crimes layer. 

1. Sign in to your ArcGIS organization. 

2. Browse to your content and click the Public Crime Map Web Mapping app. 

3. Click Edit Application. 

4. Click the Widget button at the top of the configuration section of Web AppBuilder. 

5. Click the Header Control- Set the widgets in this controller button. 

6. Click the Configure this widget edit button on the Summary widget. 

7. Click the edit button under Display Options for the Crimes layer. 
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8. Click the Panel tab. 

9. In the Layer Options section, change the drop-down selection from NIBRS 
Description to UCR Description. 

10. In the Group Options section, change the drop-down selection from NIBRS 
Offense Category to UCR Category. 

11. Click OK twice to save the reconfigured Summary widget. 

12. Click the Configure this widget edit button on the Filter widget. 

13. Click the NIBRS Offense Category filter. 

14. On the Info tab, change the label of the filter from NIBRS Offense Category to 
UCR Category. 

15. On the Expressions tab, change the drop-down selection from NIBRS Offense 
Category to UCR Category. 

16. Change operator to is any of. 

17. Check the Ask for values check box. 

18. Click the NIBRS Offense Description filter. 

19. On the Info tab, change the label of the filter from NIBRS Offense Description to 
UCR Description. 

20. On the Expressions tab, change the drop-down selection from NIBRS Offense 
Description to UCR Description. 

21. Change operator to is any of. 

22. Check the Ask for values check box. 

23. Click OK to save the reconfigured Filter widget. 

24. Click the Configure this widget edit button on the Report widget. 

25. Click the edit button under Actions for the Crimes layer. 

26. Change the drop-down selection from NIBRS Description to UCR Description. 

27. Click OK twice to save the reconfigured Report widget. 

28. Click Save at the bottom of the configuration window of Web AppBuilder. 

 

Modify Police Transparency surveys 
To modify any survey in the Police Transparency solution, including the Police Interaction 

Survey or the Community Safety and Policing Satisfaction Survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click to download the survey you want to edit. 

4. Click again to open the survey. 

5. In the left pane, click Open XLSForm Spreadsheet. 

6. In the Microsoft Excel spreadsheet, click the choices tab. This tab comprises all 
the selectable options for survey questions. 

7. Revise the survey to reflect your organizational needs. 

8. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 
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9. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your 
changes. 
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Use Police Transparency 
The Police Transparency solution delivers a set of capabilities that help you share information 

openly with the public, promote your agency’s work, demonstrate accountability when force is 

used, illustrate how workforce recruiting reflects the diversity of the community, and engage the 

public to improve policing services and solve problems. 

In this topic, you will learn how to use the Police Transparency solution by assuming various 
roles and using the solution to answer questions about policing topics of general interest, 
including understanding crime conditions in your community, learning about law enforcement 
use of force, discovering police-community engagement opportunities, and exploring the 
workforce diversity of the law enforcement agency. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Understand crime statistics 
You will assume the role of a resident in the community. You are interested in learning more 

about overall trends of crime in your community, and specifically about trends in burglary. You 

are concerned that burglaries are increasing around your home, so you’d like to be able to learn 

about recent burglaries in your area and print a report to take to the upcoming neighborhood 

meeting to ask your community policing officer what is going on and how to address the 

problem. 

 

Examine statistical crime trends 
Complete the following steps to learn more about overall crime trends, specifically burglary, in 

your community: 

1. In a browser, open the Police Transparency site, and click the Crime Stats page. 

2. Scroll down the page to view the Crime Summary Dashboard. The dashboard 
displays the three main categories of crimes according to the National Incident-
Based Reporting System (NIBRS). These categories are shown as 365-day 
percent change statistics, counts by year, and counts by month. 

  Note: 

  In January 2021, the Federal Bureau of Investigation (FBI) changed to NIBRS from the 
previous Uniform Crime Reporting (UCR) Summary Reporting System. Links to 
additional details about NIBRS can be found in the resources section of the Crime Stats 
page. 

3. To understand burglary trends specifically, scroll to the Crime Mapping Apps 
section and click the Crime Trends Dashboard. 
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4. Click the Crime Type filter and select Burglary/Breaking & Entering, then click 
the Filter Results tab. 

  You can now view 28-day, year-to-date, and last 365-day percent change statistics, 
burglary counts by year, by month, and a map of burglary hot spots. 

5. To filter for only the current year of burglaries, select This Year from the Report 
Date filter. 

  The Crime By Year and Crime By Month charts will be updated. Additionally, the burglary 
hot spots will change to reflect the current year only. 

6. Zoom in on the map. As you zoom in, individual burglaries appear. Click the 
burglary to learn more about the incident. 

 

Explore recent crime activity 
The Public Crime Map app can be used to explore recent burglary activity and create a printed 

report to take to your neighborhood meeting. 

Complete the following steps to learn about recent burglaries in your area and print a report to 
take to the upcoming neighborhood meeting: 

1. On the Crime Stats page, scroll to the Crime Mapping Apps section, and click 
Public Crime Map. 

  This mapping app displays the last 28 days of crime by default and shows a list of all 
crimes in the community, grouped by type of crime. 

2. To view all burglaries this year, click the Filter widget. In the NIBRS Offense 
Description filter, select Burglary/Breaking & Entering, then click the option to 
activate the filter. 

3. In the Date of Crime filter, in the first drop-down box, select January 1 of this year. 

4. In the second drop-down box, select today, then click the option to activate the 
filter. 

  You can now view year-to-date burglaries citywide. 

5. To view the burglaries near your home, go to the address search bar and enter 
your address. Click each burglary to learn more about the incident. 

  You would like to discuss these burglaries with your neighbors and community policing 
officer at an upcoming community meeting. 

6. Click the Report widget, then select the Point draw mode. 

7. Click your home address. In the buffer distance (optional) parameter, enter a buffer 
distance of .25 miles, then click Report. 

8. Click the add button to see a list of all burglaries within the 0.25-mile radius around 
your house. 

9. To download these records as a CSV file, click the Download button or click the 
Print button to create a printable report. 

  A report will be generated containing a map of your app’s current map extent and a list of 
the records within the search area. You can change the report title or any header text to 
meet your needs. You can also choose to enter additional comments in the comments box. 
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10. To filter for only the current year of burglaries, select This Year from the Date of 
Crime Report filter. 

  The Crime By Year and Crime By Month charts will be updated. Additionally, the burglary 
hot spots will change to reflect the current year only. 

11. Zoom in on the map to see individual burglaries. 

12. Click a burglary to learn more about the incident. 

 

Share your perceptions of community safety and police performance 
Complete the following steps to provide feedback on your interactions with law enforcement in 

your community: 

1. In a browser, open the Police Transparency site and click the Crime Stats menu 
tab. 

2. Scroll down to the Tell Us How We’re Doing section and click the Take the 
Survey button. 

3. Fill in the Community Safety and Policing Satisfaction Survey to provide your 
feedback. 

4. Click Submit. 

 

Learn about use of force 
Now you will assume the role of a community leader. You have recently been appointed to a 

police oversight board responsible for reviewing use of force incidents in the community. To 

perform this role, you need to first gain a basic understanding of how and why force is used by 

law enforcement, racial equity implications of its use, and then dig deeper to understand 

patterns in the use of force by the subjects of force, officers involved, and by neighborhood. 

 

Gain a basic understanding of use of force 
Complete the following steps to learn more about use of force in your community: 

1. In a browser, open the Police Transparency site, and click the Use Of Force page. 

2. Scroll down to view the Key Use of Force Metrics. 

  These three charts show total use of force incidents, use of force incidents involving a 
serious injury requiring medical care or hospitalization, and fatal use of force incidents. 

3. Scroll to the How Often Do We Use Force? section. 

  This section displays charts illustrating the infrequency of use of force relative to the total 
scope of police interactions with citizens, and how few are determined to be inconsistent 
with policy. 

4. Scroll down to the Why Do Officers Use Force? section. 

  This section helps you understand what types of incidents are most likely to result in force, 
the type of resistance officers are encountering that require use of force, and the type of 
force applied. 

5. Scroll down to the Racial Equity section. 
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  This section displays a dashboard that examines the distribution of subject of force and 
officers involved by race and ethnicity, compared to the racial and ethnic composition of the 
community overall. 

6. Click the Force Level or Date drop-down filters to further refine these metrics. 

7. Click the Officers Involved tab to visualize the distribution of officers involved in 
use of force incidents by race and ethnicity relative to community composition. 

 

Explore characteristics of subjects of force 
The Use of Force by Subject dashboard helps the public explore the characteristics of use of 

force in your neighborhood and compare through the perspectives of demographics, context of 

the incident, condition of the subjects, and location. Use the filters to set criteria, then click any 

bar in the charts to refine the results. For example, you may want to know more about the 

characteristics of subjects of electric force through conducted electrical devices such as Tasers 

or stun guns. 

Complete the following steps to dig deeper into the topic of use of force by exploring the 
characteristics of the persons subjected to force: 

1. In a browser, open the Police Transparency site, and click the Use Of Force page. 

2. Scroll down to view the Gain a Deeper Understanding section. 

3. Click Use of Force by Subject. 

4. In the Force Type drop-down filter, select a type of force. 

5. Click the Incident Context tab to see the proportion of incidents that were found to 
be inconsistent with policy. 

6. Click the Out of Policy slice of the Result of Internal Review pie chart. 

7. Click the Map tab to view the selected incidents symbolized by color according to 
the race and ethnicity of the subject of force. 

  The colors correspond to another layer in the map, the Predominant Race and Ethnicity by 
Census Tract, an ArcGIS Living Atlas of the World layer based on data from the U.S. 
Census Bureau’s American Community Survey. 

8. Click the Legend tool in the map to understand how color corresponds to race and 
ethnic group. 

  The presence of both layers on the map allows us to understand the relationship between 
the race and ethnicity of the residents of an area and who is subjected to force there, and 
to recognize patterns in which force is being applied to a particular group disproportionately 
to its community composition. 

9. Click a polygon in the Predominant Race by Tract layer. 

The pop-up displays which race or ethnic group is predominant in that tract as well as the 

resident counts of all other race and ethnic groups within the tract. 

 

Explore characteristics of officers applying force 
The Use of Force by Officer dashboard helps the public explore the characteristics of officers 

applying force through the perspectives of demographics, context of the incident, and location. 

Use the filters to set criteria, then click any bar in the charts to refine the results. For example, 
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you may want to know more about the characteristics of officers who apply force resulting in 

serious injury or death. 

Complete the following steps to dig deeper into the topic of use of force by exploring the 
characteristics of the persons subjected to force: 

1. In a browser, open the Police Transparency site, and click the Use Of Force page. 

2. Scroll down to view the Gain a Deeper Understanding section. 

3. Click Use of Force by Officer. 

4. In the Force Level drop-down filter, select a force level. 

5. Click the Incident Context tab to view the incident contexts most frequently 
associated with the level of force you selected. 

6. Click a category on the Call Type bar chart. This further filters the dashboard, 
allowing you to explore the characteristics of officers involved specifically in the 
force level and call type you have selected. 

7. Click back on the Demographics tab. 

8. Follow steps 6 through 8 of the Explore characteristics of subjects of force 
section in this topic to learn about the spatial distribution of race and ethnicity and 
community composition. 

 

Explore use of force incidents by neighborhood 
The Use of Force by Neighborhood dashboard helps the public explore the characteristics of 

use of force in their neighborhood and to compare it to other neighborhoods and the community 

overall. Use the filters to set criteria, then click any bar in the charts to refine the results. For 

example, you may want to know more about the characteristics of use of force incidents in your 

neighborhood and how they compare to nearby neighborhoods. 

Complete the following steps to explore the characteristics of use of force incidents in your 
neighborhood and compare them to other neighborhoods and the community overall. 

1. In a browser, open the Police Transparency site, and click the Use Of Force page. 

2. Scroll down to view the Gain a Deeper Understanding section. Click Use of 
Force by Neighborhood. 

3. In the Neighborhood drop-down filter, select a neighborhood. 

  The map zooms to your neighborhood boundaries and filters the content. The charts 
automatically adjust to your filter selection. You can see from the filtered charts use of force 
incidents the trend in use of force incidents overall, and the frequency of serious injury or 
fatal incidents. 

4. In the Neighborhood drop-down filter, select a different neighborhood. 

  You can now compare the overall, serious injury, and fatal trends in use of force incidents 
between the two neighborhoods. 

5. Click the Details tab to review and contrast demographic characteristics of subjects 
of use of force, the type of force applied, and the type of calls in which force most 
frequently occurs. 
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6. Follow steps 6 through 8 of the Explore characteristics of subjects of force section 
in this topic to learn about the spatial distribution of race and ethnicity and 
community composition. 

 

Discover community engagement opportunities 
Now you will assume the role of a concerned business owner. Your business has recently been 

victimized. You believe the crime to be part of a larger problem, and you want to become more 

active in working with your department to solve this problem and prevent future crimes. To 

perform this role, you’ll need to learn how to get connected to police by finding your community 

officer, report your crime problem, provide feedback on your experience as a victim, and get 

information on upcoming police community events in which you can participate. 

 

Find your community officer 
Complete the following steps to learn more about the men and women that work with your 

neighborhood to solve safety concerns: 

1. In a browser, open the Police Transparency site, and click the Community 
Engagement page. 

2. Scroll down to the Find Your Community Officer section. 

3. In the My Community Officer app, you have the following options: enter your 
address or click a map location. 

The app will show a name and picture of your community officer, contact information, duty 

hours, the community policing area the location belongs to, and information about when 

meetings are held for this area. 

 

Report community crime problems 
Complete the following steps to view existing crime problems reported by the public and to 

submit a new non-emergency problem you have observed in the community. 

1. In a browser, open the Police Transparency site, and click the Community 
Engagement page. 

2. Scroll down to the Engaging the Community section and under Report a Crime 
Problem, click Submit a Problem. 

3. Click Proceed as Guest. 

4. Click Submit a Problem. 

5. Complete the form, providing a name for the problem, describing the nature of the 
problem and where it is occurring, and, optionally, your contact information. 

6. Click the map to start drawing a polygon that defines the extent of the problem 
area. Keep clicking to define the edges of the polygon, then double-click to 
complete. 

7. Click Report It. 
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8. Now you can view your crime problem and others recently submitted by residents. 
Click another crime problem. 

9. Click the like button to like the report. 

10. To add your comments, click the comment button. When complete, click Submit 
Comment. 

 

Manage community crime problems 
Once a crime problem report has been submitted, Community Policing Officers (CPOs) work 

with community members to validate, prioritize, and solve these concerns. The Community 

Crime Problem Manager enables CPOs to manage the crime problems through a collaborative, 

community-oriented problem-solving process based on the Problem-Oriented Policing SARA 

model (Scan, Analyze, Respond, Assess). In this section, you will take the role of a CPO. 

Complete the following steps to learn how to manage citizen-reported crime problems through a 

problem-solving process: 

1. From your content, open the Community Crime Problem Manager. 

  The overview tab displays a list of all crime problems with charts displaying their project 
approval status and problem-solving phase. 

2. Click a bar in the chart to filter the crime problem list. You may also use the 
neighborhood filter to select crime problems occurring in a specific neighborhood. 

3. Click a problem from the list to zoom to the location of the problem. 

4. Click the problem on the map to activate a pop-up to learn more about the problem. 

  Each tab in the Community Crime Problem Manager displays a step in the problem-solving 
process, with instructions on the actions to be taken and data to be edited for that step. 

5. Click Create Report. 

  This opens the Data tab of ArcGIS Survey123, where you can click the Print button to 
create a printable PDF file of the crime problem record. 

6. Review the list of crime problems and click the one you want to edit. The map will 
zoom to the problem, and the left-side ArcGIS Survey123 form will display the 
record you have selected. 

7. Follow the instructions to update the form with the data required for the step. Click 
the Submit button at the bottom of the ArcGIS Survey123 form to submit your 
edits. 

8. As your crime problem proceeds through the problem-solving steps in the real 
world, follow the instructions on each tab to advance the problem through the 
process in the app. 

 

Explore community crime problems 
As CPOs and community members work together to solve crime problems, the public can 

exercise oversight on the status of active and completed projects using the Community Crime 

Problem Dashboard. In this section, you will resume your role of a concerned business owner. 

Complete the following steps to explore previous crime problem-solving successes and other 

active problem-solving projects that are underway: 
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1. In a browser, open the Police Transparency site, and click the Community 
Engagement page. 

2. Scroll down to the Engaging the Community section and under Monitor 
Problem-Solving Projects, click Monitor Projects to open the Community Crime 
Problem Dashboard. 

3. Use the filters to set criteria, then click any chart or list to refine the results. 

4. Click a project in the list to review a specific project. 

  The map will zoom to the location of the problem. 

5. Click the Details tab to view complete details for that project. 

 

Submit feedback on a police interaction 
Complete the following steps to provide feedback to the department on your recent experience 

as a crime victim: 

1. In a browser, open the Police Transparency site and click the Community 
Engagement menu tab. 

2. Scroll down to the Engaging the Community section and under How Did We 
Do?, click Complete Survey. 

3. Fill in the Police Interaction Survey to provide your feedback. 

4. Click Submit. 

 

Explore law enforcement workforce diversity 
You will assume the role of a local media reporter. You are writing a story about representation 

of women and communities of color in policing. You want to learn more about the composition of 

the workforce of the local law enforcement agency and how that compares to the community 

overall. 

1. In a browser, open the Police Transparency site and click the Workforce Diversity 
menu tab. 

2. Scroll down to the Law Enforcement Diversity Dashboard. 

  The summary tab of the dashboard displays the percentage of employees in each 
demographic group listed. 

  Note: 

  Under each demographic group, a text box indicates the percentage that group 
represents in the community overall. This information allows you to quickly identify which 
demographic groups are overrepresented in the police workforce relative to the 
composition of the community. 

3. To view civilian employees only, go to the Rank drop-down filter and select 
Civilian. 

  The demographic percentages will adjust to your selection. This will allow you to compare 
representation of sworn employees versus civilian employees. 
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4. To view all sworn employees, deselect Civilian in the drop-down filter and select all 
other ranks. 

5. Click the Details tab. 

  The Details tab allows you to visualize and interact with various diversity metrics of the 
workforce. 

6. Click the Black Female section of the Race and Gender bar chart to learn more 
about representation of Black females in the department. 

  The charts and metrics automatically adjust based on your selection. 

7. Click the Black Female section of the Race and Gender bar chart to turn off the 
selection. 
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Protection Operations 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Protection Operations 
Protection Operations can be used to track poaching or illegal activity and monitor the status of 

protection operations in and around protected areas. 

It provides 24/7 access to protection operations information and helps organizations respond to 
threats in real-time. This accelerated approach improves wildlife safety and reduces risks 
associated with illegal activities in a protected area. Protection Operations is typically 
implemented by conservation organizations that want to take a data-driven approach to 
monitoring illegal activity. 

The Protection Operations solution delivers a set of capabilities that help you track poaching 
and illegal activity, monitor protection operations, and visualize patterns of illegal activity. 

 

Requirements 
Protection Operations requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 

• Survey123 Connect 

 

Information products 
Protection Operations includes the following information products: 

Item Description 
Minimum 
user type 

Protected Area 
Dashboard 

An ArcGIS Dashboards app used by conservation staff to 
monitor the status of protected area operations 

Viewer 

Protection 
Incident 
Dashboard 

An ArcGIS Dashboards app used by conservation staff to 
monitor the status of protection operations within and 
around protected areas 

Viewer 

Protected Area 
Reports 

An ArcGIS Web AppBuilder app used by conservation staff 
to perform analysis and generate reports 

Creator 
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Protection 
Incident Manager 

A Crowdsource Manager app used by conservation staff to 
manage and update protection incident reports 

Editor 

Protection 
Incident Reporter 

An ArcGIS Survey123 form used by conservation staff to 
collect protection incident reports 

Field Worker 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Protection Operations 
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Configure Protection Operations 
Learn how to configure the Protection Operations solution to meet specific needs in your 

organization. 

 

Load data  
Protection Operations can be used to track poaching or illegal activity and monitor the status of 

protection operations in and around protected areas. In some cases, you may already have this 

information in ArcGIS or another business system. 

Review the layers provided with the solution and determine what source data you want to load. 
Then, load your existing data into the layers provided with the solution before sharing the maps 
or applications. 

Once you have determined what source data must be loaded, complete the data loading 
workflow below. 

 

Load data from a shapefile    
Load data for ProtectionIncidents from a shapefile by completing the following steps: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data 
to Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the 
updated data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Use Protection Operations 
The Protection Operations solution delivers a set of capabilities that help you track poaching 

and illegal activity, monitor protection operations, and visualize patterns of illegal activity. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Collect protection incidents 
You will start by assuming the role of a mobile worker in a protected area collecting protection 

incidents. You are asked to use the Protection Incident Reporter survey to collect protection 

incidents. 

1. On a mobile device, in ArcGIS Survey123, open the Protection Incident Reporter 
form. 

2. Tap the Collect button. 

3. Complete the survey with as much information as possible. 

4. Tap the check mark to submit the form, and then tap Send now. 

 

Manage protection incidents 
Next, you will assume the role of a conservation staff member. You will review protection 

incidents. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Protection Operations solution. 

2. View the Protection Incident Manager app. 

3. In the table, use the Illegal Incident Type column header filter to filter for a specific 
incident type. 

4. Select a protection incident from the table. 

  The report details open at the lower left. 

5. In the report details, click the Edit record button . 

6. Make any necessary updates to the report, and then click Save. 

 

Monitor protection incidents 
Now, you will assume the role of a protected area manager. You will monitor the status of 

protection incidents in and around a protected area. 
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1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Protection Operations solution. 

2. View the Protection Incident Dashboard app. 

3. On the left, adjust the filters to refine the results. 

4. On the right, select a protection incident from the incidents list. 

  The map zooms to the incident, and a pop-up with incident information appears. 

5. In the pop-up, click View Incident Details to open a new browser tab and review 
the protection incident details. 

 

Monitor protected area operations 
For this workflow, you will continue to assume the role of a protected area manager. You will 

monitor the status of poaching and illegal activity, wildlife observations, and wildlife conflicts in 

and around protected areas. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Protection Operations solution. 

2. View the Protected Area Dashboard app. 

3. In the left, adjust the filters to refine the results. 

  Tip: 

  If you do not see the filter panel, click the arrow on the left to expand the panel. 

4. At the bottom of the page, click the Protection Incidents, Wildlife Observations, 
and Wildlife Conflicts tabs to view information about each area. 

5. On the Protection Incidents tab, on the right, select a protection incident from the 
incidents list. 

  The map zooms to the incident, and a pop-up with incident information appears. 

6. In the pop-up, click View Incident Details to open a new browser tab and review 
the protection incident details. 

 

Generate protected area reports 
Finally, you will assume the role of a conservation staff member. You will perform analysis and 

generate reports on protected area data. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the 
Protection Operations solution. 

2. View the Protected Area Reports app. 

3. Click the Filter Protected Area Data button to open the widget. 

4.  In the widget, turn on the Poaching Incident Status filter, expand the section, and 
select a status type. 

5. Click the Update Layer Visibility button to open the widget. 

6. In the widget, select the layers that you want to include in your report. 
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7. Click the Perform Analysis button to open the widget.  

8. Select an analysis tool, set the analysis parameters, and click Run Analysis.  

  After the tool completes, the analysis output displays on the map. 

9. To create a hard copy of the map showing analysis outputs, click the Print a Map 
button. 

10. To generate a report, click the Create Reports  button to open the widget. 

11. To create a report, complete the following steps: 

a. Choose the report type. 

b. Define the area of interest. 

c. Optionally, set a buffer distance. 

d. Click Report. 

  An overview of the report information is displayed. 

12. Click the Download button to download the report data. 

13. Click the Print button to print a copy of the report. 
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Public Notification 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Public Notification 
Public Notification can be used to identify a collection of properties and create structured mailing 

lists of owners and occupants. 

It streamlines the public notification process and reduces staff resources required to generate 
public notices required to meet procedural or statutory requirements. Public Notification is 
typically implemented by planning departments, assessor offices, and other local government 
agencies that want to increase the reliability of their public notification process. 

The Public Notification solution delivers a set of capabilities that help you identify properties, 
generate a list of owners or occupants, and document which properties were included in the 
public notice. 

 

Requirements 
Public Notification requires the following: 

• ArcGIS Enterprise 

 

Information products 
Public Notification includes the following information products: 

Item Description 
Minimum 
user type 

Public 
Notification 

An ArcGIS Web AppBuilder app used by local government staff 
to identify a collection of properties and create mailing labels, or 
a structured text file, of owners and occupants 

Viewer 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Public Notification 

Configure Public Notification 
Learn how to configure the Public Notification solution to meet specific needs in your 

organization. 

 

Load data  
Public Notification can be used to identify a collection of properties and create structured mailing 

lists of owners and occupants. In some cases, you may already have this information in ArcGIS 

or another business system. 

Review the layers provided with the solution and determine what source data you want to load. 
Then, load your existing data into the layers provided with the solution before sharing the maps 
or applications. 

Once you have determined what source data must be loaded, complete the following data 
loading workflow: 

 

Load data from a shapefile   
Load data for TaxParcels or SiteAddresses from a shapefile by completing the following steps: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data 
to Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the 
updated data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 
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To make additional updates to a hosted feature layer, see Append data to layers. 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://enterprise.arcgis.com/en/portal/10.9/use/manage-hosted-feature-layers.htm#APPEND


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 589 

Use Public Notification 
The Public Notification solution delivers a set of capabilities that help you identify properties, 

generate a list of owners or occupants, and document which properties were included in the 

public notice. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Create mailing list 
An update to the land-use plan requires a zoning change for a residential area. As a result, city 

planners must notify property owners and occupants in and around the proposed change of an 

upcoming public meeting. In this workflow, you'll learn how to create a structured mailing list 

using a selected parcel and adding the appropriate buffer to notify property owners and 

occupants. 

You will start by assuming the role of a city and regional planner. You are asked to use Public 
Notification to notify property owners and occupants of a proposed zoning change. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Public 
Notification solution. 

2. View the Public Notification app. 

3. On the right, use the search field to search for a parcel or address, or use the 
Select tool to select a feature directly on the map. 

  Note: 

  The search options that you see vary depending on how you configured the app. 

  Tip: 

  You can also use the Select tool to add features to an existing selection by pressing 
Shift and drawing the addition on the map. You can use the Select tool to remove 
features by pressing Ctrl and drawing around the area that you want to remove. 

4. Optionally, apply a search distance to add a buffer. 

  Note: 

  The buffer distance set during the configuration will be used as the default for each layer. 

5. For Addressee Layer, choose the layer to use for the notification. 
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6. If applicable, click Review to further refine and finalize your selection; use the 
Select tool to add or remove parcels. 

7. For Format, choose the PDF label format or CSV output for the notification. 

8. Click Download. 
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Public Parking 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Public Parking 
Public Parking can be used to inventory parking assets and promote public parking (lots, 

garages, on-street spaces, and pay stations) alternatives in a downtown or neighborhood. 

As downtowns and neighborhoods expand and become more vibrant, accessible and reliable 
parking information allows drivers to choose a convenient parking option. Any challenge locating 
a parking option or the perception of a parking shortage will frustrate drivers and impact 
businesses and restaurants in the area. Managing and communicating parking information 
helps drivers locate desirable spaces and reduces congestion in a downtown or neighborhood. 
Public Parking is typically implemented by public works and planning departments that want to 
educate the public and promote parking assets in their community. 

The Public Parking solution delivers a set of capabilities that help you inventory parking assets 
and share nearby surface lots, garages, and on-street spaces with drivers. 

 

Requirements 
Public Parking requires the following: 

• ArcGIS Enterprise 

• ArcGIS Field Maps 

 

Information products 
Public Parking includes the following information products: 

Name Description 
Minimum 
user type 

Parking Field 
Map 

An ArcGIS Field Maps map used by public works or 
planning department personnel to inventory public parking 
and pay stations in the field 

Field Worker 

Parking Inventory An ArcGIS Web AppBuilder app used by public works or 
planning department personnel to inventory public parking 
and pay stations 

Editor 
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Parking Locator A Nearby app used by the general public to locate public 
parking alternatives 

Not required 

Public Parking An ArcGIS Hub site used by public works and planning 
departments to communicate public parking alternatives. 

Not required 

Parking 
Satisfaction 
Survey 

An ArcGIS Survey123 form used by the general public to 
share their experience with parking resources in a 
community. 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Public Parking 
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Configure Public Parking 
Public Parking can be used to inventory parking assets and promote public parking (lots, 

garages, on-street spaces, and pay stations) alternatives in a downtown or neighborhood. 

In this topic, you'll learn how to configure the Public Parking solution to meet specific needs in 
your organization. 

 

Load data 
In some cases, you may already have this information in ArcGIS or another mapping system. 

Review the layers provided with the solution and determine what source data you want to load. 

Then, load your existing data into the layers provided with the solution before sharing the maps 

or apps. 

Once you have determined what source data must be loaded, complete one or more of the data 
loading workflows below. 

 

Load data from a shapefile 
Load data into the Parking layer from a shapefile by completing the following steps: 

1. Create a .zip file of your shapefile. 

2. Sign in to your ArcGIS organization and browse to the feature layer you want to 
populate. 

3. Open the item page and click Update Data > Append Data to Layer. 

4.  Click Choose File and browse to your .zip file, and click Open. 

5. Click Upload and Continue. 

6. Click Choose the layer that you wish to append data into drop-down arrow and 
choose the layer that contains the updated data. 

7. Uncheck Update existing features. 

8. Click Show field matching and map the fields between the two layers. 

9. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

 

Populate operational hours 
This solution leverages the Opening Hours Specification to display operating hours for a place 

or service. When you populate the data fully, Arcade expressions interpret the data and display 

the operating hours in a human-readable format in the map pop-up. Understanding the data 

specification and options in the Arcade expressions will help you populate your data and display 

it in the maps and apps provided with the ArcGIS Solution. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://enterprise.arcgis.com/en/portal/10.9/use/manage-hosted-feature-layers.htm#APPEND
https://links.esri.com/openingHours


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 594 

 

Operating Hours Specification 
The Operating Hours Specification allows you to store a combination of operating hours in a 

single field but relies on a series of data standards to render the information correctly. To ensure 

operating hours are displayed correctly, follow the standards below: 

• Enter all times using a 24-hour clock without a leading 0—for example, Tu (7:00-
19:00). 

• Use a two-letter abbreviation for each day, with the first letter capitalized—for 
example, Mo, Tu, We, Th, Fr, Sa, Su. 

• When a location is open 24 hours a day, use 24 Hours—for example, Mo (24 
Hours). 

• When a location is closed on a specific day, use Closed—for example, Sa-Sun 
(Closed). 

• Enclose all times and closed statuses in parentheses—for example, Tu (7:00-
19:00); We-Mo (Closed). 

• Separate days and ranges with a semicolon to denote the two (or more) groups—
for example, Th-Fr (7:00-19:00); Sa (24 Hours). 

Using the standards above, a diverse set of operating hours can be populated for your places 

and services. Some common examples include the following: 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. seven days a week, 
populate the operating hours field with the following: Mo-Su (9:00-17:00). 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. during the week and 
closed on weekends, populate the operating hours field with the following: Mo-Fr 
(9:00-17:00); Sa-Su (Closed). 

• To specify the place is open one day (Tuesday) a week, populate the operating 
hours field with the following: Tu (7:00-19:00); We-Mo (Closed). 

• To specify the place has operating hours that vary by day, populate the operating 
hours field with the following: Mo-Tu (9:00-17:00); We (Closed); Th-Fr (7:00-19:00); 
Sa (24 Hours); Su (Closed). 

Operating hours data can be populated all at once for many places and services using Calculate 

field values or uniquely entered for each place or service using an application provided with the 

solution. 

 

Arcade expressions 
The Arcade expressions include several settings that allow you configure the look and feel of 

the operating hours when they are displayed in the web map pop-up. The expressions work with 

the operating hours data and web map pop-up configurations to display current operating hours 

in your map and app. 

This solution uses three Arcade expressions: Hours, Days, and Open/Closed. To modify one of 
these expressions, complete the following steps: 
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1.  Verify that you are signed in to your ArcGIS organization and browse to the 
Parking Locator map. 

2. Open the item page and click Open in Map Viewer. 

3. Click More Options and click Configure Pop-up on the On Street Parking layer. 

4. Under Attribute Expressions, double-click the Arcade expression you want to 
modify. 

  Each Arcade expression has a set of variables that can be configured according to your 
organization’s needs. Review the expression notes and modify the variables as needed. 
Do not change anything else in the expressions. 

5. Click OK. 

6. Repeat the above steps for the Lots and Garages layer. 
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Configure parking locator 
The Parking Locator app can be used by the general public to locate public parking alternatives. 

Directions to the nearest parking space can be enabled so users can quickly find the space they 

are looking for. 

 

Configure directions 
Follow the steps below to enable directions. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Parking 
Locator app. 

2. Open the item page and click Configure App. 

  Close the Welcome to the App Setup Page splash page. 

3. In the left side panel, click Interactivity. 

4. If you are in Full Setup mode, click Results and click the Show directions toggle 
button. 

5. If you are in Express Setup mode, click the Show directions toggle button. 

6. Click Publish. 

7. Click Confirm. 

  The Authorize premium content window will appear indicating the number of credits 
consumed. 

8. Click Launch. 

 

Modify satisfaction survey 
The Public Parking solution includes a Parking Satisfaction Survey that can be used to gather 

public sentiment and feedback on parking facilities. Review the preconfigured questions and 

align the survey with your organizational policies and desired outcomes. 

To modify the Parking Satisfaction Survey, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Parking 
Satisfaction Survey. 

2. Open the item page and click Open in Survey 123 > Manage in Survey123 
website. 

3. Click the Design tab. 

4. Make your edits to the survey and save the changes. 

5. Click Publish twice. 

 

Configure parking site 
The Public Parking solution includes the Public Parking ArcGIS Hub site that your organization 

can configure with your branding and use to share parking information with the public. 
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Update with organizational information 
After deploying the Public Parking solution, the Public Parking site layout only requires a few 

updates to fit your local context. Consider what information you already have and what you can 

most easily find. To update your site, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Public 
Parking site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Statistics section listed under the title of the website.  

  The Total Number of Spaces, EV Charging Stations, and Average Hourly Rate ($) 
statistics cards are linked to the Public Parking solution’s Parking_public feature layer. 
These stats automatically update parking assets are added using the Parking Inventory 
app. 

5. Scroll to the Pay Your Parking Ticket section, hover over the card and click 

settings button . 

6. Click the Pay Now button and click Edit. 

7. Enter the URL to your online payment system, if available, in the Link Destination 
text box and click Add Link. 

8. Scroll to the Apply Now section, hover over the card and click settings button. 

9. Click the Apply for Permit button and click Edit. 

10. Enter the URL to your residential permit program, if available, in the Link 
Destination text box and click Add Link. 

11. Scroll to the Frequently Asked Questions section, hover over the card and click 
the settings button, and update the questions and answers. 

12.  On the side panel, click Footer. 

  A custom footer is already provided, and in most cases, it needs to be updated with your 
organization's branding, contact information, and social media references. 

13. Click the HTML text box. 

  The HTML window appears. 

14. Make the necessary changes and click Apply. 

15. Click Save. 

 

Share items with public 
Several layer views, maps and apps included in the Public Parking solution must be shared with 

everyone so they can be accessed by the public on the Public Parking site. To share your public 

parking items with everyone, use the guide below and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Public 
Parking folder. 

2. Check the check box next to each of the items below: 
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  Item 
  Name 

  Feature Layer (hosted, view)   Parking_public 

  Web Map   Parking Locator 

  Web Mapping Application   Parking Locator 

  Form   Parking Satisfaction Survey 

  Feature Layer (hosted)   ParkingSatisfactionSurvey_public 

  Site Application   Public Parking 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  Warning: Sharing editable layers publicly appears notifying that you are sharing 
editable layers publicly. 

5. Click Update. 
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Use Public Parking 
The Public Parking solution delivers a set of capabilities that help you inventory parking assets 

and share nearby surface lots, garages, and on-street spaces with drivers. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Collect parking assets in the field 
In many cases, a field assessment of existing parking assets may be the most efficient way to 

develop a parking inventory. The information collected in the field can then be augmented with 

other descriptive information that helps drivers or the public find parking alternatives. 

You will assume the role of a mobile worker in a public works or planning department. In this 
workflow, you are asked to use the ArcGIS Field Maps mobile app to access your Parking Field 
Map and inventory parking assets in your community. 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Tap Parking Field Map to open the map. 

3. Search for an address, and then in the results list, tap the address to zoom to that 
location on the map. 

4. Tap the plus sign or Collect Here to open the survey form. 

  Note: 

  Your interface may vary depending on the type of mobile device you use. 

5.  Tap the type of parking asset that you want to add. 

6. Swipe up to view the form, and then complete the survey with as much information 
as possible, tapping to expand sections as necessary. 

7. Swipe down and tap Add Point. 

8. At the upper right, tap the check mark or Submit to submit the survey. 

9. Repeat these steps for each parking asset. 

 

Develop parking inventory 
The Parking Inventory app can be used by public works or planning department personnel to 

inventory public parking and pay stations. Existing parking assets collected in the field can be 

reviewed and information added to help drivers or the public find parking alternatives. New 

parking assets can also be added to a parking inventory using imagery and record documents. 
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You will assume the role of a parking supervisor in a public works or planning department. In 
this workflow, you are asked to review parking assets collected by field staff and add new 
parking assets available in record drawings. The steps below provide guidance; however, you 
can enter information as you see fit and examine the different dependencies in the form. 

 

Review assets collected in the field 
To review assets that were collected in the field, complete the following steps: 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Public 
Parking solution. 

2. View the Parking Inventory app. 

3. At the upper right, click the Filter button to open the widget. 

4. In the widget, in the Public Parking section, click the Visible to Public drop-down 
arrow and choose No, and then turn the Public Parking filter on. 

5. On the map, click a parking asset to open its pop-up. 

  Tip: 

  If you do not see any assets, return to and complete the Collect parking assets in the 
field workflow. 

6. In the pop-up, at the lower right, click the more options button  and 
choose Smart Editor. 

  The Add Parking Assets widget opens on the right, showing the form that was collected in 
the field for this parking asset. 

7. Update or complete the information in the form. 

  Tip: 

  This solution uses the Operating Hours Specification and relies on a series of data 
standards (for example, Mo-Fr (7:00-19:00)) to render the operating hours correctly. For 
more information, see Populate operational hours. 

8. For Visible to the public, choose Yes. 

9. Scroll to the bottom of the form and click Save. 

10. Click Close. 

11. Repeat these steps for each parking asset. 

 

Add a new parking asset 

1. In the Parking Inventory app, click the Add Parking Assets button to open the 
widget, if necessary, and then select the type of parking asset that you want to add. 

2. On the map, click the location of the asset. 

3. Complete the form with as much information as possible. 

4. Scroll to the bottom of the form and click Save. 
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5. Click Close. 

6. Repeat these steps for each parking asset. 

 

Locate parking alternatives 
Communicating parking information helps drivers locate desirable spaces and reduces 

congestion in a downtown or neighborhood. The Public Parking site and Parking Locator app 

can be used to communicate public parking alternatives and find a parking space. 

 

Find a parking space 
You will assume the role of a resident or member of the public. In this workflow, you are 

interested in locating a parking space near a given location in a downtown or neighborhood. 

1. In a browser, from the Public Parking solution, view the Public Parking site. 

2. Scroll to the Find Parking Space section, and then click the Locate Parking 
button. 

  The Parking Locator opens, showing parking alternatives in the area. 

3. On the left, in the Parking Locator panel, search for an address.  

  You see suggestions as you type. 

4. Press Enter or choose an address from the list. 

  In the Parking Locator panel, nearby parking alternatives are listed. 

  Tip: 

  If your search returned no results, adjust the slider to increase the search distance. 

5. In the Parking Locator panel or on the map, click a parking alternative and review 
the additional details. 

 

Share parking experience 
Understanding public perception with parking alternatives helps shape parking studies and 

plans to deliver affordable and well-located parking. The Parking Satisfaction Survey form is 

used by the public to share their experience with parking resources in a community. 

1. In a browser, from the Public Parking solution, view the Public Parking site. 

2. Scroll to the Parking Satisfaction section. 

3. Click Share Your Experience. 

4.  Complete the survey, and then click Submit. 
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Readiness Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Readiness Management 
Readiness Management can be used to understand and communicate comprehensive unit and 

force readiness. 

It provides leaders and decision makers an understanding of available personnel resources and 
allows them to share authoritative data of assigned and attached forces. Units may be 
requested to assist in setting up traffic control points, helping with debris removal, preparing 
alternate care facilities, supporting food distribution, and so on. Having personnel perform a 
routine check-in or having someone from the armory or unit provide the readiness status of a 
group of personnel gives units clarity about force readiness. Readiness Management is typically 
implemented by the National Guard, Air National Guard, and other service branches that want 
to take a data-driven approach to understanding force availability. 

The Readiness Management solution delivers a set of capabilities that help you understand the 
operational capacity of a force, monitor the status of units, and communicate capabilities and 
disruptions to commanders and administrative staff. 

 

Requirements 
Readiness Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 

 

Information products 
Readiness Management includes the following information products: 

Item Description 
Minimum 
user type 

Admin Dashboard An ArcGIS Dashboards app used by administrative 
NCOs to monitor personnel availability 

Viewer 

Readiness 
Dashboard 

An ArcGIS Dashboards app used by any unit member 
to track and monitor personnel readiness and 
availability. 

Viewer 
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Personnel 
Readiness Report 

An ArcGIS Survey123 form used by a military unit 
member to report availability. 

Not required 

Personnel 
Readiness Batch 
Report 

An ArcGIS Survey123 form used by an NCO or 
armory clerk to report the availability of their 
personnel. 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 First release of Readiness Management 
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Configure Readiness Management 
In this topic, you will learn how to configure the Readiness Management solution to meet 

specific needs in your organization. 

 

Extend readiness surveys 
Included with Readiness Management are a series of surveys that can be used to understand 

the capacity of your workforce. 

Review the preconfigured questions and adjust as necessary to remain in compliance with your 
organizational policies and any applicable laws. Additionally, ensure that you secure the survey 
and underlying layers and only share the content with appropriate members of your 
organization. 

 

Update feature layer views 
The Readiness Management solution includes a series of views created from the Personnel 

Readiness feature layer. The feature layer is used in the surveys, and the subsequent views are 

used in the dashboards. Organizations can modify the Personnel Readiness Report surveys 

and ultimately add new fields to the feature layers. When doing so, the new fields must be 

exposed in the appropriate views. 

To add one or more fields to a layer and re-create the views, complete the following steps: 

1. Browse to the view in your contents. 

2. Click the Visualization tab. 

3. Click the Options button  on the appropriate layer or table and click Set View 
Definition. 

4. Click Define Fields. 

5. Scroll to the newly created field and check the box. Click Apply. 

  The new field is added to the view's definition. 

6. Repeat steps 1 through 5 for the Readiness Dashboard. 

7. Update the Readiness Dashboard to account for the new fields you added to the 
layers. 

 

Modify readiness surveys 
To modify a Readiness Management survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization.  

3. Click Personnel Readiness Report to download the survey.  

4. Click the Personnel Readiness Report again to open the survey. 

5. In the left pane, click Open XLSForm Spreadsheet. 
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6. In the Microsoft Excel spreadsheet, click the Choices tab. This tab contains the 
selectable options for survey questions. 

7. Revise the survey to reflect your personnel readiness needs. 

8. Save the Microsoft Excel spreadsheet and preview your changes using the ArcGIS 
Survey123 Connect form preview. 

9. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your 
changes. 

To modify the Battalion or Company names in the Personnel Readiness Report or Personnel 

Readiness Batch Report, you will need to also account for the modification of the calculation in 

the choice_filter column of the Survey123 Connect XLSForm. The choice_filter column 

controls the cascading select functionality associated with each of the battalions and companies 

that fall within it. 

For example, in the Personnel Readiness Report, if you select 1st Battalion, the next 

question asking for Company will be limited to only those companies in the 1st Battalion (A–D). 
Likewise, if you select 2nd Battalion, you see companies in the 2nd Battalion (E–H). 

Learn more about how to work with cascading selects. 

 

Configure echelons 
The dashboards are preconfigured to display four battalions and four companies under each 

battalion. Follow the steps below to add or remove battalions or companies from your 

dashboard. 

 

Add a battalion 
To add additional battalions or companies to the dashboard, complete the following steps: 

1. Sign in to your Portal for ArcGIS. 

2. Browse to the Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Select the last battalion tab while in edit mode. 

5. Go to the editing tool in this element and select Duplicate. 

6. Drag the newly created copy below the last battalion tab. 

7. Reference duplicated battalion settings, text, and configuration. 

8. Add a new name, for example, 5th BN, to the new component. 

9. Save your application. 

 

Remove a battalion tab 
To remove battalions or companies from the dashboard, complete the following steps: 

1. Sign in to your Portal for ArcGIS. 

2. Browse to the Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://docdev.arcgis.com/en/survey123/desktop/create-surveys/xlsformcascadingselects.htm


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 606 

4. Select the battalion tab you want to delete while in edit mode. 

5. Click the Delete button  to delete the selected battalion. 

6. Save your application. 

 

Configure alternate reporting periods 
The dashboards are preconfigured to display individuals reporting within the last 24 hours. The 

dashboard owner can configure the dashboard to display alternate reporting periods. The 

Personnel List parameter is the most commonly configured element related to its contents and 

time frame. 

To modify the reporting period, complete the following steps: 

1. Sign in to your Portal for ArcGIS. 

2. Browse to the Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Go to the editing tool in the Personnel List element and select Configure. 

5. Below Battalion, select the And option and add Date Reported from the drop-
down list.  

  You can now select from any of the available options and time frames. 

6. Select Done and save your application to display the new reporting period. 

 

Add readiness tabs for new battalions and companies 
The dashboards are preconfigured to display four battalions and four companies and their 

applicable total force or unit size. This tab also contains their availability of personnel based on 

survey submissions and percentage of readiness. 

To add additional percentages of readiness to the dashboard, complete the following steps: 

1. Sign in to your Portal for ArcGIS. 

2. Browse to the Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Select the 3rd Battalion tab while in edit mode. 

5. Go to the editing tool in the Personnel List element and select Duplicate. 

6. Drag the newly created copy below the 3rd Battalion tab. Reference the 3rd 
Battalion settings, text, and configuration. 

7. Add a new name, such as 5th BN, to the new component and save your 

application. 

8. Go to the Reference section in the configuration tool and add the unit size below 
Fixed Value. 

  This number provides the available value and percentage of readiness. 

9. Follow the previous step and enter the current Total Force value for each unit 
level. 

10. If you need to remove a battalion tab, click the Delete button .  

11. Save your application. 
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Use Readiness Management 
The Readiness Management solution delivers a set of capabilities that help you understand the 

operational capacity of a force, monitor the status of units, and communicate capabilities and 

disruptions to commanders and administrative staff. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Monitor force readiness 
Some organizations may find it more efficient to have an individual, such as someone from the 

armory, check in their unit member using the Personnel Readiness Batch Report survey. If a 

unit decides to use the batch survey, follow the same general steps below with the Personnel 

Readiness Batch Report survey and the Readiness Dashboard. 

 

Complete an individual readiness report 
You will start by assuming the role of a military unit member. You are asked to use the 

Personnel Readiness Report survey to share your availability status each morning. 

1. In a browser, go to your Personnel Readiness Report survey. 

2. In the Personnel Readiness Report survey, fill in the following details: 

  Parameter 
  Value 

  Battalion   Select 1st Battalion. 

  Company   Select A Company. 

  Select which Guard you are a 
member of  

  Select ARNG. 

  ARNG Rank   Select E-4/CPL. 

  MOS   Type 12W. 

  Select Duty Type   State Active Duty 

  First Name   Type your first name. 

  Last Name   Type your last name. 
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  Commander   Type your commander's name. 

  Provide Location   Select your location on the map or provide 
your address. 

  Can you report for duty   Select Yes. 

  Check Completed By   Select Self. 

3. Click Submit.  

 

Complete a readiness batch report 
Alternatively, you will start by assuming the role of a readiness NCO. You are asked to use the 

Personnel Readiness Batch Report survey to submit availability of troops. 

1. In a browser, go to your Personnel Readiness Batch Report survey. 

2. In the Personnel Readiness Batch Report survey, fill in the following details: 

  Parameter 
  Value 

  Enter Location   Select your location on the map or provide your 
address. 

  Battalion   Select 1st Battalion. 

  Company   Select A Company. 

  Select which Guard you 
are a member of 

  Select ARNG. 

  ARNG Rank   Select E-7/SFC. 

  MOS   Type 25W. 

  Select Duty Type   Select State Active Duty. 

  First Name   Type your first name. 

  Last Name   Type your last name. 

  Commander   Type your commander's name. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 609 

  Select which Guard(s) you 
would like to submit 
entries for 

  Select ARNG (Army National Guard). 

  ARNG Available Troops   Enter the number of troops available to report for 
duty. 

  ARNG Unavailable Troops   Enter the number of troops not available to report for 
duty. 

  Would you like to input 
details for each ARNG 
duty type? 

   Yes 

  ARNG Duty Type Details   Enter the number of troops under each duty type, 
the number of troops entered must equal the 
number of troops available to report for duty. 

  Total Available Troops   Updated automatically. 

  Total Unavailable Troops   Updated automatically. 

3. Click Submit.  

 

Monitor personnel readiness 
Now you will assume the role of the Readiness NCO in the same unit. You are asked to monitor 

the readiness of your unit and are looking to see if your unit is available to be assigned to a 

mission. You will view the overall readiness of your workforce. 

Note: 

The steps below are the same if you are an administrative NCO and will be using the Admin 
Dashboard to monitor the readiness of your team. The Admin Dashboard will contain 
personal information about the individual unit members. 

1. In a browser, go to the Readiness Dashboard application. 

  The Readiness Dashboard opens with an overview of the overall readiness of the brigade 
and each battalion within the brigade. 

2. In the filter at the top of the dashboard, the Last 24 Hrs tab is automatically 
selected to view a list of submissions within the last 24 hours. The Last 48 Hrs and 
Last 72 Hrs options can also be selected. 

3. Activate the Date Range filter by first selecting All in the Time frame filter and then 
providing a Start and End date. Review the list of personnel and their locations in 
the map. 
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4. Click each of the battalion tabs to see the availability for each company in that 
battalion. 
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Recreation Outreach 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Recreation Outreach 
Recreation Outreach can be used to increase participation in outdoor activities and understand 

recreation license trends. 

For decades there has been a decline in the number of people that are interested in outdoor 
recreation, prompting the need to understand recreation license trends more deeply and 
maximize the use of recreation resources. Understanding who has purchased recreation 
licenses or permits helps organizations target marketing activities and increase retention rates. 
Providing 24/7 access to recreation opportunities allows you to reach new outdoor license and 
permit buyers and increase the use of outdoor resources in your community. Recreation 
Outreach is typically implemented by fish and wildlife agencies, parks departments, and other 
recreation agencies that want to take a data-driven approach to increasing public participation in 
outdoor recreation. 

The Recreation Outreach solution delivers a set of capabilities that help you understand 
recreation license trends, engage the public about their recreation experiences, and promote 
recreation opportunities to the public. 

 

Requirements 
Recreation Outreach requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 or later (Basic, Standard, Advanced) 

• ArcGIS Survey123 

 

Information products 
Recreation Outreach includes the following information products: 

Item Description 
Minimum user 
type 

Outdoor 
Recreation 

An ArcGIS Hub site used by the general public to 
discover outdoor recreation opportunities 

Not required 

Angler Catch 
Survey 

An ArcGIS Survey123 form used by anglers to provide 
feedback related to their fishing experience 

Not required 
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Boating 
Experience 
Survey 

An ArcGIS Survey123 form used by boaters to provide 
feedback related to their boating experience 

Not required 

Hunting Harvest 
Survey 

An ArcGIS Survey123 form used by hunters to provide 
feedback related to their hunting experience 

Not required 

Trail Experience 
Survey 

An ArcGIS Survey123 form used by trail users to provide 
feedback related to their trail experience 

Not required 

Recreation 
License 
Dashboard 

An ArcGIS Dashboards app used by Fish and Wildlife 
Coordinators to determine which communities to target for 
Reactivation, Retention, and Recruitment (R3) campaigns 

Viewer 

Recreation 
License 
Management 

An ArcGIS Pro project package used to manage and 
analyze license data 

GIS 
Professional 
Basic 

Park Locator An ArcGIS Web AppBuilder app used by the general 
public to locate a park or recreation facility and obtain 
information about recreation activities in the area 

Not required 

Recreation 
License Locator 

An ArcGIS Web AppBuilder app used by anglers, boaters, 
and hunters to locate license or permit retailers and 
obtain information about rules and regulations 

Not required 

Water Resource 
Locator 

An ArcGIS Web AppBuilder app used by anglers and 
boaters to locate water access sites and obtain 
information about amenities at the access site 

Not required 

Wildlife Resource 
Locator 

An ArcGIS Web AppBuilder app used by the general 
public to locate wildlife conservation or recreation areas 
and obtain information about area amenities 

Not required 

Trail Locator An ArcGIS Web AppBuilder app used by the general 
public to locate a trail and obtain information about trail 
activities in the region 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.2 • A new version of the Recreation License Management ArcGIS Pro 
project that resolves an issue with the Standardize Licenses tool to work 
with domains. 
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1.1 • Updated the Recreation License Management ArcGIS Pro project to 
reference correct layers. 

1.0 • First release of Recreation Outreach 

Configure Recreation Outreach 
Learn how to configure the Recreation Outreach solution to meet specific needs in your 

organization. 

 

Load data 
Recreation Outreach can be used to increase participation in outdoor activities and understand 

recreation license trends. In some cases, you may already have this information in ArcGIS or 

another business system. 

The Recreation Outreach solution includes five locator apps to share outdoor resources with the 
public: the Water Resource Locator, the Wildlife Resource Locator, the Trail Locator, the Park 
Locator, and the Recreation License Locator. Each of these locator apps has a corresponding 
feature layer that needs to be populated with data for the apps to function. 

Review the layers provided with the solution and determine what source data you want to load. 
Then, load your existing data into the layers provided with the solution before sharing the maps 
or apps. 

Once you have determined what source data must be loaded, complete one or more of the data 
loading workflows below. 

 

Load data from a shapefile 
Load data for LicenseLocations, ParkRecreationFacilities, Trails, WildlifeResources, and 

WaterResources from a shapefile by completing the following steps: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data 
to Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the 
updated data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 
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11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

Modify satisfaction surveys 
The Recreation Outreach solution includes focused surveys to gauge public opinion and gather 

feedback on outdoor recreation use. These surveys require slight modification to localize them 

for your use. 

To update the list of locations in each survey, complete the following steps: 

1. Download and install Survey123 Connect. 

2. Start Survey123 Connect and sign in to your ArcGIS organization. 

3. Click any of the surveys to download the individual survey forms. 

4. Click the survey again to open it. 

5. In the left panel, click the XLSForm button. 

  A Microsoft Excel spreadsheet opens. 

6. In the Microsoft Excel spreadsheet, click the choices tab. This tab comprises all 
the selectable options for survey questions. 

7. In the choice list, find the placeholder choices (Choice 1, Choice 2, and so on) and 
replace them with your own values. 

8. Click Save to save the Microsoft Excel spreadsheet and preview your changes on 
the Form Preview tab of Survey123 Connect. 

9. In Survey123 Connect, click Publish in the left panel to publish your changes. 

 

Configure Outdoor Recreation site 
The Recreation Outreach solution requires small modifications to localize it for your use. The 

following sections describe how to configure Recreation Outreach for your organization. 

 

Update organizational information 
The Recreation Outreach solution includes an Outdoor Recreation site to share information 

about outdoor recreation with the public. This app requires slight modification to be localized for 

your use. 

1. Sign in to your ArcGIS Online organization and browse to the Outdoor Recreation 
site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. On the main Outdoor Recreation page, update the following: 
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a. Under the Buy License Online section, hover over the card and click the edit 

pencil  to update the Learn more link to your online licensing portal. 

b. Under the Buy License Online section, hover over the card and click the edit 
pencil to update the Learn more link to your online licensing portal. 

c. Under the Make a Reservation section, hover over the card and click the edit 
pencil to update the Learn more link to your online reservation portal. 

d. To modify the footer on the Outdoor Recreation site, on the side panel, click 

Customize Toggle . 

5. Click Footer. A custom footer is already provided, and in most cases needs to be 
updated with just your organization's branding, contact information, and social 
media references. Click the HTML text box, make the necessary changes, and click 
Apply. 

6. Click Settings and expand Interactions. Make sure the Embedded Apps setting 
is toggled off. 

7. Click Save. 

8. On the Fishing page, update the following: 

a. Under the Fishing Rules and Regulations section, hover over the card and 

click the edit pencil  to update the Learn more link to your regulation 
website. 

b. Under the Buy License Online section, hover over the card and click the edit 
pencil to update the Learn more link to your online licensing portal. 

c. Under the Frequently Asked Questions section, hover over the card and 
click the edit pencil, and update the questions and answers. 

9. Click Save. 

10. On the Hunting page, update the following: 

a. Under the Learn to Hunt and Hunting Rules and Regulations sections, hover 
over the card and click the edit pencil to update the Learn more link to your 
learning and regulations websites. 

b. Under the Buy License Online section, hover over the card and click the edit 
pencil to update the Learn more link to your online licensing portal. 

c. Under the Frequently Asked Questions section, hover over the card and 
click the edit pencil, and update the questions and answers. 

11. Click Save. 

12. On the Boating page, update the following: 

a. Under the Boating Education and Boating Rules and Regulations sections, 
hover over the card and click the edit pencil to update the Learn more link to 
your learning and regulations websites. 

b. Under the Frequently Asked Questions section, hover over the card and 
click the edit pencil, and update the questions and answers. 

13. Click Save. 
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Share items with public 
Several layer views, maps and apps included in the Recreation Outreach solution must be 

shared with everyone so they can be accessed by the public on the Outdoor Recreation site. To 

share your Outdoor Recreation items with everyone, use the guide below and complete the 

following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Recreation Outreach folder. 

2. Check the check box next to each of the items below: 

  Item 
  Name 

  Feature Layer (hosted, view)   AnglerCatchSurvey_public 

  Feature Layer (hosted, view)   BoatingExperienceSurvey_public 

  Feature Layer (hosted, view)   HuntingHarvestSurvey_public 

  Feature Layer (hosted, view)   LicenseLocations_public 

  Feature Layer (hosted, view)   ParkRecreationFacilities_public 

  Feature Layer (hosted, view)   Trails_public 

  Feature Layer (hosted, view)   WaterResources_public 

  Feature Layer (hosted, view)   WildlifeResourceAreas_public 

  Feature Layer (hosted, view)   WildlifeResourceLocations_public 

  Web Map   Park Locator 

  Web Map   Recreation License Locator 

  Web Map   Trail Locator 

  Web Map   Water Resource Locator 

  Web Map   Wildlife Resource Locator 
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  Web Mapping Application   Park Locator 

  Web Mapping Application   Recreation License Locator 

  Web Mapping Application   Trail Locator 

  Web Mapping Application   Water Resource Locator 

  Web Mapping Application   Wildlife Resource Locator 

  Form   Angler Catch Survey 

  Form   Boating Experience Survey 

  Form   Hunting Harvest Survey 

  Site Application   Outdoor Recreation 

  Hub Page   Boating 

  Hub Page   Fishing 

  Hub Page   Hunting 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 

6. Click OK and click Save. 
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Use Recreation Outreach 
The Recreation Outreach solution delivers a set of capabilities that help you understand 

recreation license trends, engage the public about their recreation experiences, and promote 

recreation opportunities to the public. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Explore outdoor destinations 
Recreation Outreach contains multiple locator apps for the general public to find recreation 

opportunities and license information. Members of the public can search for an address or click 

the corresponding map to find information about parks, trails, water resources, wildlife 

resources, or recreation license locations. 

You are a member of the public and want to learn what recreation opportunities are in your 
area. You will use the locator apps in the Recreation Outreach solution to find outdoor 
destinations. 

 

Find park opportunities 

1.  Sign in to your ArcGIS organization and browse to the Outdoor Recreation site. 

2. Find the Park Locator card and click the Explore button to launch the Park Locator. 

3. Enter your address in the search box or pan and zoom to an area of the map you 
are interested in. 

4. Click the Filter button and select characteristics to limit results based on your 
selected criteria. 

5. Select the location of interest from the list and review information provided. 

6. Click on the Directions tab to view driving directions to the recreation opportunity 
from your defined location. 

 

Find trail opportunities 

1.  Sign in to your ArcGIS organization and browse to the Outdoor Recreation site. 

2. Find the Trail Locator card and click the Explore button to launch the Trail Locator. 

3. Enter your address in the search box or pan and zoom to an area of the map you 
are interested in. 

4. Click the Filter button and select characteristics to limit results based on your 
selected criteria. 

5. Select the location of interest from the list and review information provided. 

6. Click on the Directions tab to view driving directions to the recreation opportunity 
from your defined location. 
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Find fishing and boating opportunities 

1.  Sign in to your ArcGIS organization and browse to the Outdoor Recreation site. 

2. Find the Water Resource Locator card and click the Explore button to launch the 
Water Resource Locator . 

3. Enter your address in the search box or pan and zoom to an area of the map you 
are interested in. 

4. Click the Filter button and select characteristics to limit results based on your 
selected criteria. 

5. Select the location of interest from the list and review information provided. 

6. Click on the Directions tab to view driving directions to the recreation opportunity 
from your defined location. 

 

Find hunting opportunities 

1.  Sign in to your ArcGIS organization and browse to the Outdoor Recreation site. 

2. Find the Wildlife Resource Locator card and click the Explore button to launch the 
Wildlife Resource Locator . 

3. Enter your address in the search box or pan and zoom to an area of the map you 
are interested in. 

4. Click the Filter button and select characteristics to limit results based on your 
selected criteria. 

5. Select the location of interest from the list and review information provided. 

6. Click on the Directions tab to view driving directions to the recreation opportunity 
from your defined location. 

 

Review and prepare recreation license data 
Staff can use the Recreation License Management ArcGIS Pro project and Recreation License 

Management Dashboard to organize, load, and review recreation license data. This allows staff 

to review this information spatially, which can provide an enhanced view and understanding of 

license trends. 

You are a data analyst at a conservation agency responsible for analyzing trends in recreation 
license data. You are asked to use the Recreation License Management ArcGIS Pro project to 
prepare your data to share in the Recreation License Dashboard. 

1. Start ArcGIS Pro and open the Recreation License Management project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand Tasks, and double-click the Recreation License 
Management task. 

4. In the Tasks pane, click the Getting Started task group to expand the collection of 
tasks. 

5. Click the Understanding Recreation License Management task to review the 
project. 
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6. Follow the tasks provided in the Prepare License Data task group to format 
recreation license data. 

7. Follow the tasks provided in the Calculate License Information task group to 
summarize and load recreation license data. 
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Resource Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Resource Management 
Resource Management can be used to monitor resource inventories at each unit or command. 

Military organizations need to be able to aggregate equipment inventories from smaller military 
installations. Having a broad view of all assets and installations held by a unit and its 
subordinate units allows the commander to make informed resource allocation decisions. 
Resource Management is typically implemented by the National Guard or other military 
organizations that want to maximize their efficiency and take a data-driven approach to asset 
management. 

The Resource Management solution delivers a set of capabilities that help you to capture and 
update equipment location, available quantities, and operational status, and gain situational 
awareness of resources under a particular command or region. 

 

Requirements 
Resource Management requires the following: 

• ArcGIS Enterprise 

 

Information products 
Resource Management includes the following information products: 

Item Description 
Minimum user 
type 

Resource Management 
Dashboard 

An ArcGIS Dashboards app used by logistics 
personnel to monitor resource inventories. 

Viewer 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Resource Management 

Configure Resource Management 
Configure the Resource Management solution to meet specific needs in your organization. The 

app included with this solution contains a set of layers to be loaded with data. These layers 

automatically go through a joining process and create a joined layer that will be used by the 

included dashboard. 

 

Load resource data 
After Resource Management is deployed in your environment, the two accompanying files need 

to be populated with your own installation and inventory data. 

Note: 

To ensure the solution works correctly, follow the data structure in the file headers included 
in the attached empty layer. 

 

Load installations 
To consolidate all resources from attached military units and installations, complete the 

following steps: 

1. In a browser, go to your Resource Management solution and click Military 
Installations - Layer. 

2. Click Update Data and click Append Data to Layer. 

3. Click Choose File and browse to your shapefile or .csv file. 

4. Match the ObjectID field to a field in your file. 

5. Click the Show Field Matching link. 

6. Complete additional field mapping. 

7. Click Apply Updates. 

 

Load resource inventory 
To consolidate all resource inventories, complete the following steps: 

1. In a browser, go to your Resource Management solution and click Resource 
Inventory - Spreadsheet. 

2. Click Update Data and click Append Data to Layer. 
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3. Click Choose File and browse to your .csv file. 

4. Match the ObjectID field to a field in your file. 

5. Click the Show Field Matching link. 

6. Complete additional field mapping. 

7. Click Apply Updates. 

 

Add installations or resources to your configuration 
It may occasionally be necessary to add data to a currently deployed solution. This capability is 

a necessity when subordinate units begin to submit their resource inventory to the headquarters 

and a more comprehensive report is needed. 

To add data in an instance of Resource Management already deployed in your organization, 
complete the following steps: 

1. Prepare your file to be uploaded by ensuring the data structure is correct and the 
ObjectID value follows in ascending order from the highest ObjectID value already 
in your deployed dashboard. 

  Note: 

  If you are unfamiliar with the existing data, you can use your Resource Management 
Dashboard to check the highest ObjectID value. The lowest value in your new data to be 
uploaded should be one greater than your existing data. If your existing data ends with 
ObjectID 27, the new data should start with ObjectID 28. 

2. Follow the steps in the previous sections to either upload your installations or 
upload your resource inventory. 

 

Modify datasets for your organization 
The layers delivered with the solution include a comprehensive list of command structure 

options and resource categories. If you want to make your data even more robust, you can 

modify the included fields and domains. Additional domains are included in the hosted layers 

that come with the solution. 

 

Select installation domains from embedded lists 
Domains are available in the Echelon 1-3 columns to represent command structure. Users can 

change these domains after a data upload has taken place. To select other domain options, 

complete the following steps: 

1. Click Military Installations - Layer. 

2. Click the Data tab. 

  A table view of the data appears. 

3. Double-click the first row under Echelon_1 to display and select additional brigade 
options. You can do the same with the other echelon columns. 
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Select resource inventory domains from embedded lists 
Domains are available in the Resource_Category and Resource_Type columns. Users can 

change these domains after a data upload has taken place. To select other domain options, 

complete the following steps: 

1. Click Resource Inventory - Spreadsheet. 

2. Click the Data tab. 

  A table view of the data appears. 

3. Double-click the first row under Resource_Category to display and select 
additional category options. You can do the same with Resource_Type. 

4. Follow the steps in the Select installation domains from embedded lists section 
above to select domains from the existing table. 

 

Modify fields and domains 
To add fields or domains to the data included in the solution, complete the steps in the following 

help topics: 

• Learn about adding or deleting fields from your data. 

• Learn about modifying domains in your data. 
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Use Resource Management 
The Resource Management solution delivers a set of capabilities that help you to capture and 

update equipment location, available quantities, and operational status, and gain situational 

awareness of resources under a particular command or region. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Monitor inventory and operational status 
Resource Management is typically implemented by organizations that want to maximize their 

efficiency and take a data-driven approach to asset management. Resource Management 

Dashboard is used to gain a clear understanding of equipment’s location and to consistently 

track asset operational status. Resource Management Dashboard contains information about 

military installations and resource inventory essential to resource monitoring tasks. 

You will now assume a National Guard logistics personnel role that has been ordered to 
mobilize your troops and equipment and respond to an approaching natural disaster. To monitor 
a specific unit, complete the following steps: 

1. In a browser, open the Resource Management Dashboard.  

2. Select your Unit Name or UIC.  

  The dashboard will begin to filter data based on your selection. 

3. Clear your selections by selecting All under the Unit Name or UIC drop-down 
menu. 

4. Filter your data based on a specific date, time frame, command, or 
resource/category type. 

  Inventory is displayed by total count and total entries. Four resource statuses are tracked: 
Total On-Hand, Available, Non-Mission Capable, and Event Tasked. The embedded 
map will show the exact unit location and associated equipment that was submitted. 
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Road Closures 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Road Closures 
Road Closures can be used to maintain an inventory of road closures and communicate 

closures and detours to travelers. 

Public works and public safety departments close roads for construction activities, special 
events, and public safety incidents, often creating detours for drivers. Proactively managing and 
communicating closure and detour information helps residents and drivers navigate an altered 
road landscape and avoid unnecessary congestion. Road Closures is typically implemented by 
public works and public safety agencies that want to have a single catalog of roads impacted by 
construction activities, events, and incidents and share this information with the public. 

The Road Closures solution delivers a set of capabilities that help you inventory road closures 
and related detours, communicate closures and detours with the public, and share authoritative 
closure information with consumer applications, such as Waze. 

 

Requirements 
Road Closures requires the following: 

• ArcGIS Enterprise 

 

Information products 
Road Closures includes the following information products: 

Item Description 
Minimum 
user type 

Road 
Closures 

An ArcGIS Web AppBuilder app used by public works and public 
safety staff to maintain an inventory of road closures and 
communicate closures, blocks, and detours to travelers 

Editor 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Road Closures 

Configure Road Closures 
Learn how to configure the Road Closures solution to meet specific needs in your organization. 

 

Create a public road closure map 
Focused road closure maps and information can be embedded in your website so they can be 

accessed by the general public. Maps can be focused on public safety incidents or specific 

events occurring in a community, or they can be more general road closure maps used during 

road construction season. 

To create a public road closure map, complete the following steps: 

1. Sign in to your ArcGIS organization. 

2. Create a map that can be used by the general public to view road closures by doing 
the following: 

a. Choose a basemap. 

b. Add the RoadClosures_public layer to the map and remove 
RoadClosures_public from the layer names. 

c. Save the map as Public Road Closures. 

3. Share the map with your organization and everyone. 

4. Embed the Public Road Closures map in your public works website. 

 

Share with Waze 
Sharing your road closure information allows consumer navigation and traffic companies, such 

as Waze, to leverage the information in apps used daily by the general public. Sharing up-to-

date information with these apps helps minimize the impact of road closures, ease congestion, 

and enhance driver safety in your community. The road closures layer complies with the 

Common Internet File Structure (CIFS) for road closures but must be configured, as shown 

below, to capture required information. 

 

Share road closure information 
To share your road closure information with Waze, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization. 
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2. When assigning a Creative Commons License to your RoadClosures layer, choose 
the following options: 

– For Allow adaptations of your work to be shared, choose Yes. 

– For Allow commercial uses of your work, choose Yes. 

3. In the Have a web page area, copy the HTML that is generated by the Creative 
Commons site. 

4. In your ArcGIS organization, browse to your RoadClosures_public layer. 

5. Open the item details page. 

6. Click Edit to edit the item details. 

7. Scroll to the Terms of Use section and click Edit. 

8. Click View HTML Source. 

9. Paste the HTML copied from the Creative Commons site into the Terms of Use 
text box. 

10. Click Save. 

  Note: 

  You must use a license that allows international commercial use and allows shared 
adaptations or a license placing your data in the public domain. 

11. Enroll in the Waze for Cities program. 

  When you share your road closure information with Waze for Cities, new road closures 
added by your community in ArcGIS will be added to Waze every minute. 

   

Add your organization reference 
To share your road closures with Waze, you must store your organization reference with every 

road closure. This field is used by Waze to identify which organization the road closure data is 

coming from. The reference name must be a maximum of either 10 capital letters or 12 

lowercase letters. The reference is your Waze for Cities program ID. 

To add your organization reference, complete the steps below: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Road 
Closures map. 

2. Open the item page and click Open in Map Viewer. 

3. Click Edit. 

4. Click Manage. 

5. Click the Layer drop-down arrow and choose the Road Closures layer. 

6. Click the drop-down arrow next to the Both Directions feature template and 
choose Properties. 

7. In the Properties window, scroll to Organization and enter your organization 
reference. 

8. Click Done. 

9. Repeat steps 6 through 7 for the One Direction feature template layer properties. 

10. Click Save Changes. 
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Set required fields 
To share your road closures with Waze, some information is required. You must change the 

fields indicated below as required so all road closures that are created capture the information 

needed by Waze. 

To set fields transmitted to consumer apps as required, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Road 
Closures app. 

2. Open the item page and click Edit Application. 

3. Click the Widget tab and click Set the widget in this controller to open the page 
for an in-panel widget. 

4. Hover over the Create New Closure widget and click the Configure this widget 

button  to open the widget configuration window. 

5. Click the Smart Actions tab. 

6. Click Add New. 

7. In the Group Name text box, type Required Fields. 

8. Click the Layer for Expression drop-down arrow and choose Road Closures. 

9. Click the Edit Expression button. 

10. Click Add expression and set the expression to OBJECTID is not blank. 

11. Click OK. 

12. Expand the Road Closure layer and check the check box for following fields as 
required: 

– Street Name 

– Reason 

– Description 

– Direction 

– Start Time 

– End Time 

13. Click OK twice. 

14. Save the app. 

 

Configure the Road Closures layer to share with Waze 
One of the partners that your community can share data with is Waze through the Waze for 

Cities program. To share your data with Waze, follow the steps found in the Waze partners 

Overview page. To share your feed, you must create a JSON request from the Public Road 

Closures feature layer. 

To create the request URL required by Waze, follow the steps below: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
RoadClosures_public item. 

2. Open the item page and click the Road Closures layer under Layers. 
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3. From the layer URL, click Copy. 

4. Paste the URL into a text editor. 

5. Copy the code below and paste it into the text editor at the end of the URL you 
pasted in the previous step. 

  /query?where=1%3D1&outFields=OBJECTID,street,subtype,description,directio
n,starttime,endtime,type,reference&outSR=4326&returnZ=false&f=geojson 

  Tip: 

  For more information on querying a feature layer, see Query a feature layer. 

6.  Provide the URL to Waze. 
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Use Road Closures 
The Road Closures solution delivers a set of capabilities that help you inventory road closures 

and related detours, communicate closures and detours with the public, and share authoritative 

closure information with consumer applications, such as Waze. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Create road closures 
You will assume the role of an employee in the public works department. You have received 

plans for streets that will need to be closed. You will draw the closures on the map, place the 

road blocks, and identify the detour routes. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Road 
Closures solution. 

2. View the Road Closures app. 

  The Road Closures app opens with the Create New Closure widget open on the right. 

3. In the Create New Closure widget, check the Use Preset Values (new features 
only) check box. 

4. Type the contact information for the closure in the appropriate text boxes. 

5. In the Identifier text box, type a unique ID. 

  Note: 

  This information will be added to each closure, road block, and detour you create to 
associate it with the same event. 

6. On the map, use the search field or pan and zoom to the closure location. 

7. In the widget, click the Both Directions template. 

8. Click the map and begin to draw a line at an intersection; click to add a vertex and 
double-click to finish the closure line. 

  After you finish drawing the closure on the map, a Road Closures form appears on the 
right. 

9. Complete the form with as much information as possible. 

10. Click Save. 

11. Click the Road Blocks template. 

12. On the map, click the intersection on one side of the closure. 

  Note: 
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  The road block is automatically populated with the information from the closure it 
intersects, so you don’t have to reenter it. 

13. Click Save. 

14. Click the Road Detours template. 

15. On the map, sketch the alternate route around the closure and double-click to finish 
drawing the line. 

  Note: 

  If the detour intersects the closure at the start and end, it automatically pulls the details 
from the closure. 

16. Click Save. 

 

Update closure details 
You will continue as an employee in the public works department. Dates for a road closure have 

been extended. You will update the end date of the closure and its associated road blocks and 

detour. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Road 
Closures solution. 

2. View the Road Closures app. 

3. In the upper right of the app, click the Update Existing Closures button to open 
the widget. 

4. In the Update Existing Closures widget, click the Extent tool. 

5. On the map, drag a box around the road closure, including the associated road 
blocks and detour. 

6. In the Update Existing Closures pop-up, click the End Time drop-down arrow and 
choose a new date. 

7. Click Save. 

  Closures that are no longer active, with an end date that is before today, will continue to 
show on the map but will have a transparency applied. This feature is helpful when you 
have reoccurring events; for example, past closures can be selected and updated with new 
dates. 
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Road Network Data Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Road Network Data Management 
Road Network Data Management can be used to maintain an authoritative inventory of roads, 

intersections, and physical road characteristics and track legal agreements executed with a 

public works agency. 

It provides a series of workflows and standard road layers that streamline the maintenance of a 
public road repository, their physical characteristics, and legal agreements defining 
maintenance services provided by the organization. Road Network Data Management is 
typically implemented by public works and transportation departments that want to develop and 
maintain a public road repository that supports a variety of maintenance functions. 

The Road Network Data Management solution delivers a set of capabilities that help you 
maintain a standard set of public road layers, streamline road data management workflows, 
track maintenance agreements, and continuously improve the quality of public road information. 

 

Requirements 
Road Network Data Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.5 or later (Standard or Advanced) 

 

Information products 
Road Network Data Management includes the following information products: 

Item Description 
Minimum user 
type 

Road Network 
Data Management 

An ArcGIS Pro project used by mapping technicians to 
maintain an authoritative inventory of public roads, road 
intersections, and physical road characteristics 

GIS 
Professional 
Standard 

Road Maintenance 
Agreements 

An ArcGIS Web AppBuilder app used by engineers and 
operations staff to track legal agreements executed with 
a public works agency 

Editor 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
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(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Road Network Data Management 
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Use Road Network Data Management 
The Road Network Data Management solution delivers a set of capabilities that help you 

maintain a standard set of public road layers, streamline road data management workflows, 

track maintenance agreements, and continuously improve the quality of public road information. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Manage road network data 
You will start by assuming the role of a mapping technician responsible for maintaining an 

inventory of public roads, road intersections, and physical road characteristics. The Road 

Network Data Management ArcGIS Pro project includes a series of tasks to help guide you 

through these workflows. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Road 
Network Data Management solution. 

2. Download the Road Network Data Management desktop application template, and 
then unzip the folder. 

3.  From the unzipped folder, open the Road Network Data Management ArcGIS Pro 
project in ArcGIS Pro. 

4. In the Catalog pane, expand the Tasks folder, and then double-click the Road 
Network Data Management task item. 

  Note: 

  If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, expand the How to use Road Network Data Management 
task group to see the collection of tasks. 

 

Add roads 
Roads are line segments representing centerlines of all public roadways or carriageways that 

support asset management and mapping. Typically, this information is compiled from 

authoritative road centerlines maintained for addressing purposes. 

1. To add new public roads, follow the steps in the Add roads task. 
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Add intersections 
When creating new roads, existing roads are split at intersections along the new road. An 

inventory of road intersections with the names of relevant crossroads is often required by 911 

systems and to manage right-of-way assets. 

1. To add new road intersections, follow the steps in the Add intersections task. 

 

Add road characteristics 
A series of map layers is used to track the characteristics (for example, ownership, functional 

classification, speed limit, physical characteristics, and special routes) of each public road. The 

feature classification and type schema for the roads is based on a functional classification of 

roads provided by the Federal Highway Administration (FHWA). Specific attributes and default 

values vary for each feature type. 

1. To add new road characteristics, follow the steps in the Add road characteristics 
task. 

 

Track maintenance agreements 
You will now assume the role of an engineer or operations staff at a public works agency. You 

are responsible for managing the legal agreements defining maintenance services provided by 

the agency for assets within the public right-of-way. 

1. In a browser, from the Road Network Data Management solution, view the Road 
Maintenance Agreements app. 

  The app opens with the Create Maintenance Agreement open on the right. 

2. In the Create Maintenance Agreement widget, choose a template. 

3. Click the map to start a sketch. 

4. Click the map to add additional vertices and double-click to finish the sketch. 

  After you finish the sketch, the Road Maintenance Agreements legal agreement form 
opens in the Create Maintenance Agreement widget. 

5. Complete the details of the legal agreement. 

6. Click Save. 

7. At the top right, click the Filter Maintenance Agreement button to open the 
widget.  

8. Filter for the asset type that you just added. 

9. On the map, select an agreement to view its details. 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 637 

ROW Permitting 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to ROW Permitting 
ROW Permitting can be used to manage permit applications required to construct, operate, use, 

or maintain a facility within the public right-of-way. 

It provides a single destination for right-of-way permit applications and supports comprehensive 
right-of-way permit review workflows in a community. Capturing the location of proposed work 
along with other permit information streamlines the permit review process and helps 
communicate where work is occurring in the public right-of-way. ROW Permitting is typically 
implemented by public works agencies and other local government organizations that want to 
reduce the time to apply for and receive approval for a right-of-way permit. 

The ROW Permitting solution delivers a set of capabilities that help you collect and organize 
permit applications, coordinate the permit review process, gather feedback during permit review, 
and share approved permits with internal and external stakeholders. 

 

Requirements 
ROW Permitting requires the following: 

• ArcGIS Enterprise 

 

Information products 
ROW Permitting includes the following information products: 

Item Description Minimum user type 

ROW Permit An ArcGIS Survey123 form used by contractors and 
property owners to apply for a permit to construct, 
operate, use, or maintain a facility within the right-of-
way 

Editor (required if form 
is used for internal 
purposes only) 

ROW Permit 
Manager 

A Crowdsource Manager app used by public works 
agencies to facilitate the right-of-way permit process 
and manage the status of a permit application 

Editor 

ROW Permit 
Review 

A Crowdsource Polling app used by government 
agencies to review right-of-way permit applications 
and offer comments during the review process 

Editor 
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ROW Permit 
Public 
Comment 

A Crowdsource Polling app used by the general 
public and interested parties to review permit 
applications and comment on proposed construction 
activity 

Not required 

ROW Permit 
Locator 

An ArcGIS Web AppBuilder app used by the general 
public and other interested parties to locate pending 
and approved right-of-way permits in their community 

Not required 

ROW Permit 
Dashboard 

An ArcGIS Dashboards app used by public works 
executives to monitor the status of right-of-way 
permits in their community 

Viewer 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of ROW Permitting 
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Use ROW Permitting 
The ROW Permitting solution delivers a set of capabilities that help you collect and organize 

permit applications, coordinate the permit review process, gather feedback during permit review, 

and share approved permits with internal and external stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Submit a permit application 
First, you will assume the role of a resident in the community. You want to host a block party in 

your neighborhood and close the street for the weekend. 

1. In a browser, from the ROW Permitting solution, view the ROW Permit form. 

2. In the Applicant Information section, provide your contact information. 

3. Leave the Contractor Information section blank, as this work does not require a 
contractor. 

4. In the Job Information section, search for the street that you want to close, and 
then place the point along that street. 

5. For Type, choose Temporary Use. 

6. For Subtypes, check the Neighborhood Festival check box. 

7. For Description, provide a brief description. 

8. For Site Plan \ Construction Drawings, if applicable, upload a drawing of where 
the road blocks should begin and end. 

9. For Proposed Start Date and Proposed Completion Date, choose dates for the 
closure. 

10. For Lane Closure Required, choose No. 

11. Sign the form, and then click Submit. 

 

Manage permit status 
You will now assume the role of a supervisor in the public works department. It is your job to 

review and triage permit requests and ensure the permit application is reviewed by the correct 

people. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the ROW 
Permitting solution. 

2. View the ROW Permit Manager app. 

  All permit applications are listed in the table at the top. The table can be sorted and filtered 
in various ways. 
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3. Click a permit with a status of Submitted. 

  The permit application details open at the lower left. 

4. On the Details tab, review the permit application information, and then click the 

Edit Record button . 

5. For Status, choose StaffReview. 

6. Click Save. 

  The permit is now displayed in the ROW Permit Review app and can be shared with other 
departments or agencies to provide their feedback and approval. After all departments 
have approved the permit, you'll change the status in the ROW Permit Manager app to 
BoardReview. 

7. Click the Edit Record button again. 

8. For Status, choose BoardReview. 

9. Click Save. 

  The permit is now displayed in the ROW Permit Public Comment app and can be shared 
with the general public for feedback. If public feedback is positive and you are ready to 
approve the permit, you'll change the status to Approved. 

10. Click the Edit Record button again. 

11. For Status, choose Approved. 

12. Click Approved/Denied Date and choose the current date. 

13. For Approved State Date and Approved Completion Date, specify values that 
signify the dates that the permit is valid. 

14. Click Save. 

 

Conduct internal review 
You will now assume the role of a supervisor in the public safety department. A permit 

application requesting a street closure has been submitted. You will review the permit details to 

confirm that all the necessary information is provided and that you don’t have any concerns. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the ROW 
Permitting solution. 

2. View the ROW Permit Review app. 

3. On the right, click a permit application in the list. 

  Tip: 

  If no permit applications are listed, return to the previous workflows and ensure that at 
least one permit application has a status of StaffReview. 

4. Review the details, and then click the Add a comment button. 

5. For Organization, choose Public Works. 

6. Provide your name and comments. 

7. For Action Taken, choose Approved. 
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8. Click Submit. 

 

Find approved and pending permits 
As an engaged resident, you are interested in learning more about the active and planned work 

in the community. 

1. In a browser, from the ROW Permitting solution, view the ROW Permit Locator app. 

  The app opens with the Locate ROW Permit widget open on the right. 

2. In the Locate ROW Permit widget, search for an address; alternatively, click the 
location on the map. 

  Any permits that are pending or approved appear at the bottom of the widget. 

3. If necessary, use the slider to increase the search distance and view additional 
permit applications. 

4. Click Pending or Approved, and then explore the permits that are within the 
specified search distance of the address. 

5. At the top of the list, click the Back button to return to the permit list and continue 
exploring nearby permits. 

Note: 

Pending permits have a Comment hyperlink that opens the ROW Permit Public Comment 
app. This app can be used by the general public to provide their feedback or concerns on 
the proposed work. 

 

Provide public comments 
Many communities have statutory public notice requirements that community members must be 

given the opportunity to express concerns about proposed developments and work within the 

public right-of-way. As a concerned resident, you will review the pending permits in the 

community and provide feedback instead of attending a council or commission meeting. 

1. In a browser, from the ROW Permitting solution, view the ROW Permit Public 
Comment app. 

2. Click a permit application in the list. 

  Tip: 

  If no permit applications are listed, return to the previous workflows and ensure that at 
least one permit application has a status of BoardReview. 

3. Review the details, and then click the Add a comment button. 

4. Provide your name, address, and comments. 

5. Click Submit. 
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Monitor permit applications 
Finally, you will assume the role of a supervisor in the public works department. It is your job to 

ensure that permits are moving through the application process and being approved or denied 

in a timely manner. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the ROW 
Permitting solution. 

2. View the ROW Permit Dashboard app. 

3. On the left, adjust the filters to refine the results. 

4. On the right, in the Permits panel, click a permit application to view a pop-up with 
application details; alternatively, click a permit on the map. 
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School Locator 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to School Locator 
School Locator can be used to share district and attendance zone boundaries with the general 

public. 

It provides 24/7 access to an organization, and the location-enabled search helps residents 
quickly find which school district their household is assigned to and understand which schools 
their children will attend. This transparent approach improves communication with the public 
and saves many parents time because they do not need to call the district for school 
assignments. The solution also helps residents and home buyers make important decisions 
when considering where, and when, to make a real estate move. School Locator is typically 
implemented by government agencies and school districts that want to educate the public and 
promote public education resources available in their community. 

The School Locator solution delivers a set of capabilities that help you share school district and 
attendance zone boundaries; highlight school performance; and promote available elementary, 
middle, and high school educational resources. 

 

Requirements 
School Locator requires the following: 

• ArcGIS Enterprise 

 

Information products 
School Locator includes the following information products: 

Item Description 
Minimum 
user type 

School 
Locator 

An ArcGIS Web AppBuilder app used by the general public to 
locate elementary and secondary schools and view school districts 
and attendance zone boundaries 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of School Locator 
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Configure School Locator 
In this topic, you'll learn how to configure the School Locator solution to meet specific needs in 

your organization. 

 

Load data 
In some cases, you may already have this information in ArcGIS or another mapping system. 

Review the layers provided with the solution and determine what source data you want to load. 

Then, load your existing data into the layers provided with the solution before sharing the maps 

or apps. 

Once you have determined what source data must be loaded, complete one or more of the 
following data-loading workflows. 

 

Load data from a shapefile 
Load data into the SchoolDistricts layer from a shapefile by completing the following steps: 

1. Create a .zip file of your shapefile. 

2. Sign in to your ArcGIS organization and browse to the feature layer you want to 
populate. 

3. Open the item page and click Update Data > Append Data to Layer. 

4.  Click Choose File and browse to your .zip file, and click Open. 

5. Click Upload and Continue. 

6. Click Choose the layer that you wish to append data into drop-down arrow and 
choose the layer that contains the updated data. 

7. Uncheck Update existing features. 

8. Click Show field matching and map the fields between the two layers. 

9. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

 

Configure directions 
Follow the steps below to connect to a routing service and configure the widget to enable 

directions in the app. 

 

Configure widget 
To configure an app to use routes and provide directions, complete the following steps: 
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1. Sign in to your ArcGIS organization and browse to the ArcGIS Web AppBuilder 
app. 

2. Open the item page and click Edit Application. 

3. Click the Widget tab and click Set the widget in this controler to open the page 
for an in-panel widget.  

4. Hover over the Near Me widget and click the Configure this widget button to open 
the widget configuration window. 

5. Check the Enable Directions check box if it is not checked. 

6. Click the Direction Settings tab, click Set, and choose a routing service. 

7. Click Next and choose one or more route layers, click OK, and click OK again. 

8. Save the app and share it with everyone. 

9. Open the app. 

 

Esri premium content 
The app draws routes and provides directions using the ArcGIS Online World Route Service. 

This service requires subscriber access because it consumes credits. See Configure Living 

Atlas content to enable access to premium content. 

Learn more about credit usage when creating simple routes 
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Use School Locator 
The School Locator solution delivers a set of capabilities that help you share school district and 

attendance zone boundaries; highlight school performance; and promote available elementary, 

middle, and high school educational resources. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Find schools and attendance zones 
You will assume the role of a resident in the community and want to learn more about schools 

and attendance zone boundaries in your area. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the School 
Locator solution. 

2. View the School Locator app. 

3. In the Locate School widget, under Search for an address or locate on map, 
type an address in the community and press Enter. You can also click the map to 
set a location. 

  The list updates to display school attendance zones that serve the location entered. 

4. Review the list of school attendance zones. 

  Using the list, you can see information related to which school your child will attend, 
enrollment numbers, the school district, and directions. 

5. In the school attendance zones results list, click Elementary School Attendance 
Zone. 

  The map zooms to corresponding school attendance zone boundaries and highlights the 
associated school your child will attend based on your searched address. 

  The Information tab displays details regarding which school your child will attend, current 
enrollment numbers, and the name and size of the school district. 

6. Click the Directions tab. 

  The tab displays turn-by-turn directions from the searched address to the school location. 

7. Click the Back button to return to the school attendance zones results list. 

8. Repeat step 4 for both Middle School Attendance Zone and High School 
Attendance Zone. 
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Sewer Data Management for ArcGIS Enterprise 

Introduction to Sewer Data Management for 

ArcGIS Enterprise 
Sewer Data Management for ArcGIS Enterprise can be used to map and manage asset 

information with the ArcGIS Utility Network. 

The solution configures ArcGIS Enterprise and the ArcGIS Utility Network to be an authoritative 
repository of information for a sewer network and provides workflows that facilitate capturing 
information correctly and keeping it up to date. 

Sewer Data Management for ArcGIS Enterprise delivers a data model that makes a utility 
network behave like a sewer network, editing apps configured for ArcGIS Pro, and 
preconfigured maps for data sharing. It also provides a sample utility network dataset so users 
can experience a utility network in a single-user environment. You can use the solution's 
deployment framework to experience a sewer utility network with sample data or in a single-user 
environment. 

 

Requirements 
Sewer Data Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.8 (Standard or Advanced) 

 

Information products 
Sewer Data Management includes the following information products: 

Item Description Minimum user type 

Sewer Data 
Management for 
ArcGIS Enterprise 

A zipped file with an ArcGIS Pro project 
package with tasks, a configured utility network 
in a file geodatabase, editor and auditor maps, 
and an asset package geodatabase 

Creator user type with 
the ArcGIS Utility 
Network user type 
extension 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 649 

1.0 • The first release of Sewer Data Management for ArcGIS Enterprise 
• The data model in the solution has been updated to version 4. For a full 

list of updates, refer to the change log. 
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Use Sewer Data Management for ArcGIS 

Enterprise 
The Sewer Data Management for ArcGIS Enterprise solution provides a preconfigured utility 

network, maps, styles, step-by-step instructions, common data management workflows, and 

more. The tasks in the Sewer Data Management project guide you through creating your own 

utility network using the provided schema and setting up an enterprise environment. The 

solution also includes a data dictionary with descriptions of the features in the data model. 

In this topic, you will learn how to use the solution to create and manage your sewer utility 
network. 

Use the instructions in the Sewer Data Management task to get started with the solution. 

1. Sign in to your ArcGIS organization and browse to the Sewer Data Management 
for ArcGIS Enterprise V1 item. 

2. Open the item page and click Download. 

3. Unzip and open the downloaded Sewer Data Management ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand Tasks and double-click the task item. 

6. In the Tasks pane, click the Explore the Data Management Solution task group 
to expand the collection of tasks. 

  Tip: 

Click each group task heading and task to view a description at the bottom of the Tasks pane. 

Each task group includes instructional steps for using the solution. Begin by exploring the 
contents of the project, tracing and editing workflows with sample data, or configuring the 
solution for your organization. 

 

Explore the Data Management Solution 
The data management solution is designed for organizations that want to experience a fully 

functional sewer utility network. Explore common workflows with the sample data in the 

provided single user file utility network. Task-based workflows are also provided to create, and 

model your own utility network to behave like a sewer system in an enterprise environment. The 

solution also provides preconfigured maps for sharing data and editing data. 

This task group includes the following tasks: 

• Overview 

• What's Included 

• Review the Data Model 

• Explore the Symbology and Data 

These tasks introduce the solution and walk through exploring the capabilities of the utility 

network. 
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Tracing and Analysis 
Tracing is a key capability of the utility network. There are several core trace configurations that 

allow you to analyze your network. 

This solution includes an upstream trace to identify all features that are upstream of the starting 
point sewer network. 

This task group includes the following task: 

• Upstream Trace 

 

Editing Workflows 
Users are guided through editing workflows with the provided sample data. These workflows are 

designed to showcase common tasks while highlighting the capabilities of the utility network. 

Note: 

In the Contents pane, click the List by Snapping tab. Expand all feature classes to ensure 
snapping is checked for each asset group. 

This task group includes the following tasks: 

• Add Sewer Manholes and Pipes 

• Add Customer Service Lateral 

 

Installing Implementation Prerequisites 
After exploring the sample utility network, move on to building out a utility network for your own 

organization. Before getting started set up the environment with the necessary tools. 

This task group includes the following tasks: 

• Create a Python project environment 

• Install Utility Network Package Tools 

• Install Data Loading Tools 

 

Configure Data Model for Implementation 
The data model has been developed and curated over several years to reflect the latest 

capabilities of the utility network. This solution delivers the latest model which has been 

developed specifically to support sewer utilities to best manage their assets in a digital 

environment. 

After exploring the solution, complete the following steps to remove the sample data and 
prepare the data model to manage your sewer network. 

This task group includes the following tasks: 

• Project and Remove Sample Data 
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• Create Modification Tables (Optional) 

• Loading Data (Optional) 

 

Prototype in a Single User Environment 
Creating a utility network that fits your organization's needs requires a solid understanding of 

your data, as well as the provided date model. We recommend starting out with a prototype to 

explore with your own data and adjust where necessary. When ready, move on to setting up 

and implementing your solution in ArcGIS Enterprise. 

To learn more about the Attribute Rules included in the Sewer Data Management project, 
review the Sewer Data Management Attribute Rules document. 

A few notable attribute rules have been highlighted in the table below. These attribute rules 
have been designed to improve adding and editing manholes. These are disabled by default but 
can be enabled to take advantage of the described functionality. 

Name Description 

Line - Snap to Manhole 
batch 

When a main is snapped to a manhole channel, the main will be 
pulled back 2 ft. A Connection point is added to the end of the 
main, contained in the Manhole, and associated by connectivity to 
the Manhole Channel. 

StructureJunction - Create 
Manhole Channel batch 

When a Sewer Storm Vault - Manhole is created, generate and 
contain a Manhole Channel. 

This task group includes the following tasks: 

• Create File Geodatabase with Schema 

• Adjust Attribute Rules 

• Update Maps' Data Sources 

• Reset Trace Location Feature Classes 

• Adjust Maps 

• Export Asset Package 

 

Deploy Solution to an Enterprise Environment 
These tasks are a guide to set up a utility network from start to finish. This includes creating an 

enterprise database, utility network, and sharing the final maps and services with your 

organization. 

This task group includes the following tasks: 

• Setup Enterprise Database 

• Create Utility Network 

• Apply Schema 

• Adjust Attribute Rules 

• Post Process 

• Publish Services 
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• Update Subnetworks 

• Update Maps Data Source to Feature Service 

• Publish Web Map 

• Reset Trace Location Feature Classes 

• Adjust Maps 

• Share with Organization 
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Special Event Operations 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Special Event Operations 
Special Event Operations can be used to develop safety plans and monitor public safety 

operations during a special event. 

It provides a way to collaborate in a geographic context to simplify the safety planning and 
operations workflows. Event information from the incident action plan can be mapped and 
monitored along with live event information such as weather, traffic, field reports, and health and 
safety incidents. Special Event Operations is typically implemented by public safety operations 
that want to improve event health and safety planning to protect participants and the public. 

Special Event Operations delivers a set of capabilities that help you organize special events, 
create event site maps, develop health and safety plans, manage event incidents and 
assignments, monitor public health and safety operations, and create after-action reports. 

Note: 

If you represent a local government that requires permitting capabilities, you may be 
interested in the Special Event Permitting and Operations solution. It includes permitting 
capabilities and special events operations capabilities. 

 

Requirements 
Special Event Operations requires the following: 

• ArcGIS Enterprise 

• ArcGIS Data Store - Spatiotemporal big data store 

• ArcGIS Notebook Server 

• ArcGIS Survey123 

• ArcGIS Survey123 Connect 

• ArcGIS AppStudio Player 

• ArcGIS Collector 

• ArcGIS Tracker 

• ArcGIS Workforce 

Note: 
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To use this solution ensure the following content and services are enabled and configured 
in ArcGIS Enterprise: Living Atlas content and Living Atlas subscriber content. 

 

Information products 
Special Event Operations includes the following information products: 

Item Description 
Minimum 
user type 

Special Event 
Form 

An ArcGIS Survey123 form used by public safety event 
planners to catalog community or special events 

Editor 

Special Event 
Manager 

A Crowdsource Manager app used by public safety event 
planners to manage the status of special events during the 
review process 

Editor 

Special Event Site 
Map 

An ArcGIS Web AppBuilder app used by event coordinators 
to create site maps (temporary structures, routes, and so 
on) that accompany permit apps 

Editor 

Special Event 
Operations Map 

An ArcGIS Web AppBuilder app used by public safety event 
planners to create operations maps of public safety 
resources and conduct a high-level threat analysis 

Editor 

Special Event 
Operations 
Notebook 

An ArcGIS Notebooks app used by public safety event 
planners to create unique public safety operations maps 
and apps for each event 

Editor 

Copy Previous 
Site and 
Operations Maps 

An ArcGIS Notebooks app used by event coordinators and 
public safety event planners to create a copy of site and 
operations maps 

Editor 

Special Event 
Field Reporter 

An ArcGIS Survey123 form used by public safety staff to 
report lost children, suspicious activity, field observations, 
and health- and safety-related issues 

Field Worker 

Special Event 
Field Manager 

An ArcGIS Workforce Classic project used by public safety 
event dispatchers to manage field reports and event 
assignments. Field users access the project using the 
ArcGIS Workforce app 

Editor 

Special Event 
Operations 
Dashboard 

An ArcGIS Dashboards app used by public safety command 
staff to monitor operations, weather, traffic, and health and 
safety issues during a special event 

Viewer 

Crowd Counter 
App 

An ArcGIS AppStudio app used by staff to count people 
entering and exiting an area 

Field Worker 

Special Event 
After Action 

An ArcGIS Web AppBuilder app used by public safety 
command staff to visualize historical event operations and 
support event after-action reports 

Viewer 

Special Event 
Operations Apps 

An app used to organize the Special Event Operations apps 
after running ArcGIS Notebooks 

Editor 
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When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • A new version of the Crowd Counter App that resolves an issue where 
the app would not load in the AppStudio Player 

1.0 • First release of Special Event Operations 
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Configure Special Event Operations 
The ArcGIS Solutions app can be used to deploy the Special Event Operations solution in your 

ArcGIS organization. After deploying the solution to your ArcGIS organization, configure the 

solution to meet specific needs in your organization and load your data if needed. 

 

Preset event identifier 
All of the special events and associated assets are stored in common hosted feature layers. 

Many of the applications in the solution use an event identifier to filter the maps for a specific 

event. To ensure that the features are being tagged with the appropriate event identifier, update 

the editing applications to use preset values in the Event ID field. 

1. Sign in to your ArcGIS organization and search for the Special Event Site Map app. 

2. Click Edit Application. 

3. Click Widget in the upper left corner of the app. 

4. Click Set the widgets in this controller. 

5. Hover over the Create Site Map widget and click Configure this Widget.  

6. On the Configure Create Site Map dialog box, click Attribute Actions. 

7. Scroll down to Preset, hover over Event ID, and click the Edit button under Actions. 

8. Uncheck Hide in preset value display. 

9. Click OK. 

10. Click OK to close the Configure Create Operations Map dialog box. 

11. Click Save. 

12. Repeat the steps above for the Special Event Operations Map app. 

 

Extend event survey 
The Special Event Operations solution includes a Special Event Form, which is a survey that 

can be used by public safety event planners to catalog community or special events. Review the 

preconfigured questions and adjust as necessary to remain in compliance with your 

organizational policies. In addition, ensure that you secure the survey and underlying layers and 

only share the content with appropriate members of your organization. 

 

Update feature layer views 
The Special Event Operations solution includes a series of views created from feature layers 

provided with the solution. Organizations may want to modify the Special Event Form by first 

adding new fields to the feature layers and then configuring the surveys to use the newly 

created fields. When doing so, the new fields must be exposed in the appropriate views. 

Additionally, some views are created by joining two sources, and these views must be re-

created with the same name and URL after a new field is added. 

When adding new questions, begin with the steps below. For changes such as removing 
questions or formatting the survey, proceed to the Modify the event form survey section. 

To add one or more fields to a layer and re-create the views, complete the following steps: 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 658 

1. Sign in to your ArcGIS organization and search for the Special Events hosted feature 
layer. 

2. Add a new field to a layer in the Special Events hosted feature layer. 

3. Navigate to the Special Event Permit stakeholder layer view in your contents. 

  Note: 

 In some cases, you may have existing permits you want to load into the special event 
layer. The stakeholder view is designed to provide a read-only view of the event form when 
accessed from Special Event Manager. 

4. Click the Open in Map View arrow and click Add to new map. 

5. Click the More Options button on the appropriate layer or table and click Set View 
Definition. Click Define Fields. 

6. Scroll to the newly created field, check the box, and click Apply. 

Modify the event form survey 
To modify the Special Event Form survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Special Event Form to download the survey. 

4. Click Special Event Form again to open the survey. 

5. In the left pane, click Open XLSForm Spreadsheet. 

6. In the Microsoft Excel spreadsheet, click the choices tab. This tab comprises all the 
selectable options for survey questions. 

7. Revise the survey to reflect your Special Event Form needs. 

8. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect. 

9. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 

Note: 

To view your changes in ArcGIS Survey123, on the Download Surveys page, click 
Download to get the updated survey. 

 

Add event assets 
The Special Event Operations solution includes several layers that can be used to locate event 

assets and develop health and public safety plans. These layers include several domains to 

help you get started with the event planning process. Each of these domains can be configured 

to include any additional features you would like to capture. 

To add a new event asset and update the symbology, complete the following steps: 

1. Sign in to your ArcGIS organization. 

2. Click Content and browse to the folder you deployed the Special Event Operations 
solution in. 
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3. Search for SpecialEventAssets and open the item details page. 

4. Click Fields and click Event Asset Type. 

5. Next to List of Values, click Edit. 

6. Add your additional asset types and click Save. 

7. Click the Visualization tab. 

8. Click Change Style and update the style for each new asset you added to the list. 

9. Repeat steps 7 and 8 and update the style for SpecialEventAssets_operations. 

Note: 

The same steps can be used to modify the SafetyPlanning and HealthSafetyPlanning 
layers and associated views. 

Configure Crowd Counter App 
The Special Event Operations solution includes the ability to track the number of people 

entering and exiting a defined area to ensure the number of people admitted does not exceed 

the maximum capacity allowed for the size of the area. 

Download and set up Crowd Counter App 
You will need to set up Crowd Counter App on your mobile device to manage and track crowd 

capacity. To download and install Crowd Counter App on your mobile device, follow these 

steps: 

1. Download ArcGIS AppStudio Player onto your mobile device. 

2. Open the app on your mobile device and sign in to your ArcGIS organization. 

3. Click the Shared button and click the Crowd Counter App button to download the app. 

4. Click the Crowd Counter App button and sign in to your ArcGIS organization again. 

5. Click the add button and choose Browse Projects, and then click Crowd Counter to 
download the project. 

6. When the download is complete, click Crowd Counter, sign in to your ArcGIS 
organization, and check Keep me signed in. 

Note: 

The first time you set up your mobile device with Crowd Counter App, you are prompted to 
sign in two separate times. This is expected. After the initial setup, you are no longer 
prompted to sign in. 

 

Create After Action app 
Incident commanders are responsible for the health and safety of participants during an event. 

The Special Event After Action app provides useful visualization tools to see both how incidents 

occurred and how field personnel responded. This information can be used to further examine 

specific incidents and help plan for future events. 

Follow the workflow below to create a unique Special Event After Action app for your event. 
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Follow the steps below create a unique track view of your event. 

1. Open a new map project in ArcGIS Pro. 

2. Sign in to your ArcGIS organization account within ArcGIS Pro . 

3. Search for the <Event Name Date>_trackview and add the track view to the map. 

  If you have many field personnel over an extended period of time then, you may have a 
large number of tracks and want to change the maximum number of records returned. 

4. Select the track view you added to the map and export the data from the track view into a 
new layer. 

5. Publish the new layer as a service in your ArcGIS organization and name it <Event Name 
Date> - Tracks. 

Follow the steps below create a Special Event After Action web map to use in the After Action 

app. 

1. Sign in to ArcGIS organization and navigate to the Special Event After Action web map 
item. 

2. Open in Map Viewer the Special Event After Action web map. 

3. Add the layer you published in the previous workflow to the map. 

4. Change the style of the layer and symbolize by the Full Name field. 

5. Add the layer assignments layer named the <Event Name Date> - Assignments to the 
map. 

6. Change the style of the layer and symbolize by the report type field using the public 

safety category. 

7. Remove the Report Type layer from the map. 

8. Save the Special Event After Action map with a new same for example, Special Event 
After Action - Event Name.  

Follow the steps below create a Special Event After Action app for your event. 

1. In your ArcGIS organization, navigate to the Special Event After Action app item and Edit 
Application. 

2. Choose the triangle button, next to Save, and choose Save As. 

3. Choose a name for the app for example, Special Event After Action - <Event Name>.  

4. Choose Map, Choose web map, then choose the map you created in the previous 
workflow. 

5. Choose Widget, Set the widgets in this controller, Group Filter widget, and then choose 
OK. 

6. Add each layer of the map to the widget and choose the Event Identifier field as the filter. 

7. Choose After Action Report widget and update the layer to the<Event Name Date> - 
Assignments. 

8. Choose Find Personnel widget and update the layer to the<Event Name Date> - Tracks. 

9. Save and then Launch the application. 

The application is a historical archive of the special event and can be used to animate 

assignments and track locations. Repeat this workflow for each event. 
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Use Special Event Operations 
Special Event Operations can be used to organize special events, create event site maps, 

develop health and safety plans, manage event incidents and assignments, monitor public 

health and safety operations, and create after-action reports. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Manage special events 
Special Event Operations offers a comprehensive system to manage all events in one central 

location. It allows you to manage the entire process through the event approval process, event 

site planning, operations and after-action review. All information can be kept in preparation for 

each event to be used next year. 

In this workflow, you'll learn how to create and manage events. 

 

Create a special event 
You will start by assuming the role of a public safety event planner who needs create a special 

event and manage it through the planning approval process. You are asked to use the Special 

Event Form survey to create an event. 

1. In a browser, from the Special Event Operations solution, view the Special Event Form 
survey. 

2. In the Special Event Form survey, fill in the following details on the first page: 

  Parameter 
  Value 

  Enter the name of the 
special event 

  Type 5K for the Local Animal Shelter. 

  Select an event type   Type Competition or Race. 

  Description of Event   Type A great event to be had by everyone 
benefiting animals in need. 

  Open to the public   Select Yes. 

  Estimated Attendance   Type 1000. 
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  Will alcohol be served at 
the event 

  Select No. 

3. At the bottom of the first page, click Next. 

4. Complete the remaining event form pages, selecting an event start date one week from 
today in the morning and ending in the evening of the same day. 

5. On page 4 of the event survey, provide the following information: 

– For Event location, type the name of a local park. 

– For Locate the event on a map, type the park's address and zoom to the location. 

6. At the bottom of the page, click Submit. 

 

Manage and review special events 
In this workflow, you will assume the role of a public safety event planner who is asked to 

manage the review process and notify other government departments or agencies when a 

Special Event Form has been submitted. You will review the event information and update the 

status. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Special Event 
Operations solution.  

2. View the Special Event Manager app. 

3. In the Special Events table, click the Status column filter and select Under Review. 

4. From the table, select the event that you created previously. 

  The event details open in the Info panel. 

5. In the Info panel, scroll down and click Review Event Info.  

6. Review the form, and then close the Special Event Form survey. 

 

Prepare site plans 
Since many of the assets are temporarily set up before the event, planners need an interactive 

way to quickly assign the location of each asset. The Special Event Site Map allows 

coordinators or safety planners to quickly add these assets to the map for an event. 

In this workflow, you'll learn how to create and copy site maps as well as notify others when 
maps are ready to be reviewed. 

 

Create a special event site map 
You will start by assuming the role of a public safety event organizer who needs to create an 

event site map for the special event. You are asked to use the Special Event Manager app to 

locate a special event and the Special Event Site Map to create a site map. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Special Event 
Operations solution.  

2. View the Special Event Manager app. 

3. In the Special Events table, click the Status column filter and select Under Review. 

4. In the table, select the event that you created previously. 
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5. In the Info panel, click Edit Site Map. 

  The Special Event Site Map app opens and zooms to the event. It also filters all related information, 
so you only see temporary features for your event. 

6. In the Create Site Map pane, click Food Concessions and type King Smoothie. 

7. Click a location on the map within the park. 

  Note: 

  The Event Identifier field is passed automatically from your filter selection in the Select 
Event widget and cannot be edited. 

8. Click Save. 

9. Repeat these steps for each event asset, route, and area you would like to add to your site 
map. 

10. After completing your site map, click Save, and then close the Special Event Site Map. 

 

Copy event maps from the previous year (optional) 
In many cases, events are reoccurring and have similar site maps year after year. The Copy 

Previous Site and Operations Maps allows you to copy a previous site map to a new event. 

Modifications can then be made and added to the site map for the new event. 

In this workflow, you will learn how to copy event maps from a previous year and update the 
maps when necessary. 

Note: 

To execute the Copy Previous Site and Operations Maps script, the event organizer must 
have access to the ArcGIS Notebooks item. In addition, you need at least two events (see 
the Create a special event section). The first event's status must be set to Archived and 
should have an associated site map. The new event should have the status set to Under 
Review. Do not use the event that you have already approved previously because it will be 
used in the subsequent steps. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Special Event 
Operations solution.  

2. In a browser, view the Special Event Manager app. 

3. Click the Status column filter and select Under Review. 

4. Select the event you created in the Special Event Form survey. 

5. In the Info panel, scroll down and click Copy Previous Site and Operations Maps. 

  An ArcGIS Notebooks app appears on a separate tab and will prompt you to sign in. 

6. Click Cell and choose Run All. 

7. In the Archived drop-down menu, choose a previous event that already has a site map. 

8. In the New Event drop-down menu, choose the new event that does not have an 
associated site map. 

9. Click Copy Previous Site and Operations Maps. 

10. When the script completes, return to the Special Event Manager app and select the event 
in the list of events. 
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11. Click Edit Site Map and verify the new site map is complete. 

  Note: 

  You may also want to verify the operations map is complete. 

12. Make any required modifications to the site map and click Save. 

 

Prepare operations plans 
The Special Event Operations Map allows safety planners to add all relevant health and safety 

resources and perform high-level risk assessments. It can be used to locate isolation areas or 

set up plexiglass barriers at ticket counters or food vending booths. In addition, it can be used to 

calculate the number of people allowed in each space using Centers for Disease Control and 

Prevention (CDC) guidelines. Event staff can use the real-time counter at entrances and exits 

for each venue to maintain a safe environment for everyone. 

Public safety staff can add resource assignments, road closures, traffic restrictions, and 
estimates of crowd sizes to guide field personnel assignments. Optionally, planners can create 
a reference grid for field staff supporting the event, conduct a visibility assessment for high-risk 
locations, or identify areas that may be impacted by a potential bomb explosion or chemical 
spill. 

In this workflow, you'll learn how to create operations maps and copy events from previous 
years. 

 

Coordinate with public safety event planners 
You will start by assuming the role of a public safety event planner who needs to coordinate with 

public safety event planners. You are asked to use the Special Event Manager app to locate a 

permit app and notify public safety that a health and safety plan is needed for this event. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Special Event 
Operations solution.  

2. View the Special Event Manager app. 

3. Click the Status column filter and select Under Review. 

4. Select the event you created in the Special Event Form survey or select another event. 

5. On the Info tab, click Edit Operations Map. 

  Note: 

  When you open the Special Event Operations Map from the Special Event Manager, the 
Event Identifier and Plan Identifier fields are passed automatically to the Select Event 
widget and should not be edited. 

  You can use the Develop a health and safety plan workflow in the next section to help you 
edit the operations map. 

6. After the Special Event Operations Map is complete, return to the Special Event Manager 
app, and then in the event's Info panel, click the Edit button. 
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7. Locate the Operations Map Complete field and click Yes. 

8. Locate the Status field, click Approved. 

9. Click Save. 

 

Develop a health and safety plan 
Next, you will assume the role of a public safety event planner who needs to develop a health 

and safety plan for an event. You are asked to use the Special Event Operations Map to create 

an operations map of public safety resources and conduct a high-level threat analysis. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Special Event 
Operations solution.  

2. View the Special Event Operations Map app. 

3. Click the Basemap widget and select Imagery. 

4. Click the Create Operations Map widget and search for PPE Station. 

5. Place a PPE station on the map and add details for the health and safety asset. 

6. Click Save. 

7. Search for Handwashing Station, place it on the map, and add details for the event 

asset. 

8. Click Save. 

9. Repeat these steps for each health and safety asset, route, and area that you would like to 
add to your operations map. 

10. Search for Road Blocks, place two on the map, and add details for each of the road 

blocks. 

11. Click Save. 

12. At the top of the Create Operations Map widget, select Social Distancing Crowd Areas 
from the drop-down list. 

13. Click the template, draw an area on the map, and double-click to complete the sketch. 

14. For Area name, type Vendor Area. 

  Note: 

  The Area name field must be unique. 

15. For Max Capacity, type 100, and then click Save. 

  Note: 

  The area on the map is labeled with the number of people that can safely enter an area 
of this size based on CDC social distancing guidelines. Adjust the maximum capacity or 
area size if necessary. 

16. At the top of the Create Operations Map widget, select Crowd Estimates from the drop-
down list. 

  Note: 
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  Crowd estimation is determined by Jacobs' method; the high, medium, and low values of 
crowd estimation appear on the map. 

17. Click the template, draw an area on the map, and double-click to complete the sketch. 

18. For Description, type Crowd Area for Event. 

19. Click Save. 

20. Search for Medical Tent, place it on the map, and add details for the event asset. 

21. Click Save. 

22. Finally, search for On Foot, place three public safety resources on the map, and type the 

following details for each resource: 

– For Point of Contact, type an officer name. 

– For Point of Contact Phone, type a unique phone number for each officer. 

– For Comments, type Public Safety support for Humane Shelter Event. 

23. After completing your health and safety operations map, click Save. 

 

Conduct high-level threat analysis (optional) 
The Special Event Operations Map includes a series of tools that can be used to define the 

impact of an incident (chemical or other threat) on event assets and resources. As you complete 

the health and safety plan, you may be asked to conduct a high-level threat analysis and identify 

the impact on your event operations plan. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Special Event 
Operations solution.  

2. View the Special Event Operations Map app. 

3. Click the Gridded Reference Graphic widget to create a reference grid that can be used 
in large outdoor events.  

4. Define the location of the grid from a point or area, and then click Create GRG. 

5. To identify the impact of a chemical incident and create a potential evacuation area, click 
the Emergency Response Guide widget. 

6. Select the location, material, and size of the accident along with the wind direction and 
time, and then click Create Zones. 

7. Click the Threat Analysis widget to identify the impact of other threats. 

8. Select the location, type of threat, and size of the accident, and then click Create Zones. 

9. Finally, to identify the impact of an incident on event assets and resources, click the 
Situational Awareness widget. 

10. Select the location and the distance impacted, and then click the map. 

  After using the Gridded Reference Graphic, Emergency Response Guide, or Threat 
Analysis widgets and publishing the derived layers, you can associate the layers with the 
event so they can be used in other event operations apps. 

11. Select a health and safety resource you added earlier and copy the event identifier. 

12. Click the Assign Event Identifier widget and select the features generated by the 
previously identified widgets.  

13. Type the event identifier, and then click Save. 
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Copy event maps from the previous year 
Many times, reoccurring events will use similar site and operations maps from one year to the 

next. For instance, an annual 5k run will have similar route, food concessions, and public safety 

support locations. Re-creating the site map every year can be very time consuming. In this 

workflow, you will learn how to copy event maps from a previous year and update the maps 

when necessary. 

You will continue assuming the role of an event organizer. You are asked to use the Special 
Event Manager app and the Copy Previous Site and Operations Maps script to create a copy of 
the previous year site map and operations maps. 

Note: 

To execute the Copy Previous Site and Operations Maps script, the event organizer must 
have access to the ArcGIS Notebooks item. In addition, you need two events including the 
previous year and the current year. The status of the previous year's event must be set to 
Archived. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Special Event 
Operations solution.  

2. View the Special Event Manager app. 

3. Click the Status column filter and select Under Review. 

4. Select the event that you created previously. 

5. In the Info panel, scroll down and click Copy Previous Site and Operations Maps. 

  An ArcGIS Notebooks app appears on a separate tab and will prompt you to sign in. 

6. Click Cell and choose Run All. 

7. In the Archived drop-down list, choose a previous event that already has a site map. 

8. In the New Event drop-down list, choose the new event that does not have an associated 
site map. 

9. Click Copy Previous Site/Operations Maps. 

10. After the script completes, return to the Special Event Manager app and select the event in 
the table. 

11. Click Edit Site Map and verify the new site map is complete. 

  Note: 

  You may also want to verify the Special Event Operations Map is complete. 

12. Make any required modifications to the site map, and then click Save. 

 

Conduct health and safety operations 
The Special Event Operations solution provides a complete set of capabilities that improve the 

efficiency and effectiveness of public safety personnel working on special events by enabling 

public safety personnel with tools to capture information from the field to share with 

commanders in a synthesized operational picture in real time. 
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In this workflow, you'll learn how to use a collection of maps and apps to support incident 
commanders and site staff to visualize, monitor, and communicate real-time status during an 
event, as well as visualize incident response after an event has occurred. 

Deploy event operations apps 
Public safety event planners and incident commanders need a unique set of maps and apps for 

each event. The unique maps and apps allow them to manage personnel assignments, 

activities, and incidents during an event and conduct after-action reviews that help them 

improve planning for future events. Each event requires the following: 

• Unique apps for incident commanders, firefighters and emergency medical technicians, law 
enforcement officers, event dispatchers, health and safety officers, cleaning staff, and site 
staff 

• The ability to monitor the location field personnel assigned to an event 

• An incident tracking and assignment system that can be used onsite at the event 

• Maps that show relevant event assets and public safety resources assigned to an event 

You will assume the role of a public safety event planner. You are asked to use the Special 

Event Operations Notebook to create a copy of the event operations apps for a unique event. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Special Event 
Operations solution.  

2. View the Special Event Manager app. 

3. Click the Status column filter and select Approved. 

4. Select the event you created in the Special Event Form survey, or another event. 

5. On the Info tab, click Create Operations apps. 

  The Special Event Operations Notebook opens. 

6. Review the instructions provided with ArcGIS Notebooks. 

7. Click the Special Event Field Personnel link to view a list of all field personnel working 
the event, as well as dispatchers that will communicate with them. 

8. Click Download and open the spreadsheet in Microsoft Excel. 

9. Ensure that the spreadsheet includes the field personnel that have already been added to 
your ArcGIS organization and have been assigned ArcGIS Tracker licenses. 

10. Save the file as FieldPersonnel.xlsx and close the spreadsheet. 

  Note: 

  To test the operations apps, you may want to add your user name to the spreadsheet 
and ensure that you have an ArcGIS Tracker license for testing. 

  Note: 

  Typically, the operations apps are created in advance of the event. However, if additional 
field personnel are assigned to the event after you run the notebook, you will need to add 
them manually as follows: 

  Add field personnel as workers to the ArcGIS Workforce project. 

  Add field personnel as users to the ArcGIS Tracker View. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://learn.arcgis.com/en/projects/manage-and-complete-hydrant-inspections/#create-and-configure-a-workforce-project
https://docdev.arcgis.com/en/tracker/help/track.htm


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 669 

  Add field personnel to the group created for the event. 

11. Return to the Special Event Field Personnel item page, click Update, and browse to your 
FieldPersonnel.xlsx file. 

12. Close the Special Event Field Personnel tab in your browser. 

13. Click the Cell menu and click Run All. 

14. Under Select a Special Event to deploy Operations apps, click the drop-down arrow 
next to Select an Event, and choose your event. 

15. Click Deploy Special Event Operations apps. 

  Note: 

  The creation of the event operations apps takes a few minutes. 

16. When the progress bar is completed, click View Deployed Event Operations 
applications. 

 

Track locations of field personnel 
The ability to quickly identify the location of field personnel is critical during events. Dispatchers 

and incident commanders need to see a map with the location of their staff to determine who 

should respond to specific incidents. 

You will assume the role of a firefighter, emergency medical technician, or law enforcement 
officer who will capture their location while working the event. You will use the Tracker field app 
to track your location so the incident command staff can determine your location. 

1. On your mobile device, open the ArcGIS Tracker app. 

2. Click Sign in with ArcGIS Enterprise and enter your credentials. 

3. Turn on Track My Location. 

 

Report activity from the field 
During an event, public safety staff and site staff collect field observations that are used to 

protect the health and safety of event attendees. 

You will assume the role of a firefighter, emergency medical technician, or law enforcement 
officer who needs to report suspicious activity, or a safety concern observed at the event. You 
are asked to use the Special Event Field Reporter survey to report the suspicious activity or 
safety concern. 

1. In a browser, go to the Special Event Operations gallery and click the Special Event Field 
Reporter survey for your event name and date. 

2. In the Special Event Field Reporter survey, fill in the following details: 

  Parameter 

  Value 

  Type   Select Suspicious Activity. 
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  Suspicious Activity 
Type 

  Select Object. 

  Description   Type Backpack left at location with no owner to be 
seen for 20 minutes. 

3. Optionally, add an image or picture. 

4. Locate the field report on the map. 

5. Click Submit. 

 

Manage field assignments 
It’s common for minor incidents such as traffic accidents, medical calls, or disorderly spectators 

to occur during a special event. Often these incidents are reported by radio or 911 calls to a 

dispatcher in the event command center. 

Now, you will assume the role of an event dispatcher who needs to assign field reports or other 
incidents to field staff. You are asked to use the Special Event Field Manager to assign the 
suspicious activity or safety concern to a firefighter, emergency medical technician, or law 
enforcement officer. 

1. In a browser, go to the Special Event Operations Gallery and click the Special Event 
Field Manager Special Event Field Manager for your event name and date. 

2. When the new tab opens, click Open in ArcGIS Workforce. 

3. Click the Suspicious Activity assignment in the list. 

4. Click Assign and choose a field worker from the drop-down menu. 

5. Click the Search bar and type King Smoothie. 

6. Click the Special Event Assets: 1 Result feature and click Create assignment. 

7. In the new assignment, fill in the following details: 

  Parameter 

  Value 

  Assignment Type   Select Medical Response. 

  Assign   Choose a field worker from the drop-down list. 

  Description   Type Citizen reporting heat exhaustion and has 
collapsed. 

  Priority   Choose High from the drop-down list. 

  Due Date and 
Time 

  Select a time on the same day of the event. 

8. Click Create Assignment. 

  Field personnel can open the ArcGIS Workforce app on their mobile device and see their 
assignments. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 671 

 

Track crowd capacity 
You will assume the role of site staff. You are asked to use the Crowd Counter App to count 

people entering and exiting the area to ensure that the number of people admitted does not 

exceed the maximum capacity allowed for a unique area. 

Tip: 

See Configure Crowd Counter App to learn how to install and set up Crowd Counter App on 
your mobile device. 

1. Open and sign in to Crowd Counter App using the ArcGIS AppStudio Player app on your 
mobile device, if it isn't already open from the previous workflow. 

2. Tap the Edit button to edit the Area Name value and enter the exact area name of the 
location you are tracking crowd capacity for. Type Vendor Area if you completed the 

prepare operation plans workflow. 

3. Tap Done. 

4. Tap Enter for each person entering the area and tap Exit for each person exiting the area. 

5. Review the gauge on the Occupancy tab to learn the current capacity (middle number) 
relative to the maximum capacity (last number). 

  Note: 

  The gauge displays different colors as capacity changes. The color green indicates 
under maximum capacity, orange indicates near maximum capacity, and red indicates 
maximum capacity. 

6. Continue to allow people to enter and exit the area based on the current capacity. 

Note: 

If the gauge does not display the correct results, use the refresh button in the upper right 
corner of the app to edit the Area Name value. 

Tip: 

When the Crowd Counter App is used to count high numbers of people, consider deleting 
or archiving entry and exit records from the Crowd Count layer to ensure high performance 
of the app. 

 

Track cleaning and stocking status 
You will assume the role of cleaning staff. You are asked to use the ArcGIS Collector mobile 

app to access your cleaning and restocking map to provide the status of cleaning and 

restocking of personal protective equipment (PPE) every 60 minutes. 

1. Download ArcGIS Collector onto your mobile device. 
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2. Open the app on your mobile device, and sign in to your ArcGIS organization. 

3. Choose the Cleaning and Restocking Map for your event and date. 

4. Choose a PPE Station, choose Cleaning and Restocking Status in the pop-up, and click 
the Add button. 

5. Choose status, choose Restocked, and add the number of boxes stocked of each PPE 
type. 

6. Click Submit. 

 

Monitor event operations 
Incident commanders need real-time information on the location of incidents, location of staff, 

and incoming weather and traffic information to make informed decisions during an event. The 

Special Event Operations Dashboard can be used in the command center on the day of the 

event. 

1. In a browser, from the Special Event Operationssolution, view the Special Event 
Operations Dashboard app. 

2. Click Open incidents within the last hour and choose an incident. 

3. Click the Post Locations tab on the bottom of the dashboard to see post location versus 
the actual location of staff. 

4. Click the Weather tab on the bottom of the dashboard to see real-time weather radar 
information. 

5. Click the Traffic tab on the bottom of the dashboard to see real-time traffic and road 
closure information. 

6. Click the Crowds tab on the bottom of the dashboard, to see real-time crowd counts for an 
area based on information from staff tracking crowd capacity using the Crowd Counter 
App. 

7. Click the Sanitation tab on the bottom of the dashboard to see real-time cleaning and 
restocking status for PPE stations, high-touch locations, and other health assets. 

8. Close the app. 

 

Conduct after-action briefings 
Incident commanders are responsible for the health and safety of participants during an event. 

The Special Event After Action app provides useful visualization tools to see both how incidents 

occurred and how field personnel responded. This information can be used to further examine 

specific incidents and help plan for future events. 

You will assume the role of an incident commander. You are asked to use the use the Special 
Event After Action app, including the site map, operation plans, assignments, incidents, and 
historical staff locations from the event, that you created after the event is complete. 

Tip: 

See Create After Action app to learn how to set up Special Event After Action app for a 
specific special event. 

1. In a browser, go to the Special Event After Action app for your event, use your mouse to 
hover over the time slider at the bottom the map and click the pause button. 
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2. Adjust the time slider to see when and where incidents occurred and when and where staff 
responded. 

  Note: 

  If the map does not animate based on time, the incidents may be outside of the time 
extent of the event. 

3. Click the After Action Report button, click the rectangle, draw the reporting area, and click 
the Report button. 

4. Click the Print button, choose the print layout, and click the Print button again to create a 
report containing the visible map and incidents during the event. 

5. Click the Download button, choose CSV, and click the Download button again to create a 
CSV file containing the incidents during the event. 
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Special Event Permitting and Operations 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Special Event Permitting and 

Operations 
Special Event Permitting and Operations can be used to manage special event permits, protect 

event attendees, and promote special events occurring in the community. 

It provides a way to collaborate in a geographic context to simplify the permitting and operations 
workflows. These integrated apps ensure that permits are routed to the correct person for 
approval, operation and field staff are coordinated, and necessary event information remains 
current. Special Event Permitting and Operations is typically implemented by planning, public 
works, public safety, and other organizations that want to improve event permitting workflows 
and health and safety planning and to protect participants and the public. 

Special Event Permitting and Operations delivers a set of capabilities that help you collect and 
organize permit apps, develop event site maps and health and safety plans, coordinate the 
permit review process, share event information with the public, monitor public health and safety 
operations, and create after-action reports. 

 

Requirements 
Special Event Permitting and Operations requires the following: 

• ArcGIS Enterprise 

• ArcGIS Data Store - Spatiotemporal big data store 

• ArcGIS Notebook Server 

• ArcGIS Survey123 

• ArcGIS Survey123 Connect 

• AppStudio Player 

• ArcGIS Collector 

• ArcGIS Tracker 

• ArcGIS Workforce 

• ArcGIS Hub 

Note: 
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To use this solution ensure the following content and services are enabled and configured 
in ArcGIS Enterprise: Living Atlas content and Living Atlas subscriber content. 

 

Information products 
Special Event Permitting and Operations includes the fiollowing information products: 

Item Description 
Required 
user type 

Special Event 
Permit 

An ArcGIS Survey123 form used by event organizers and 
sponsors to apply for a community or special event permit 

Not 
required 

Special Event 
Permit Manager 

A Crowdsource Manager app used by event coordinators to 
facilitate the special event permit process and manage the 
status of a permit app 

Editor 

Special Event Site 
Map 

An ArcGIS Web AppBuilder app used by event 
coordinators to create site maps (temporary structures, 
routes, and so on) that accompany permit apps 

Editor 

Special Event Site 
Map Viewer 

An ArcGIS Web AppBuilder app used by the general public 
and other interested parties to view event site maps 

Not 
required 

Special Event 
Permit Review 

An ArcGIS Web AppBuilder app used by departments or 
agencies to review permit apps and offer comments during 
the permit review process 

Editor 

Special Event 
Permit Dashboard 

An ArcGIS Dashboards app used by government 
executives to monitor the status of special event permits 

Viewer 

Special Event 
Calendar 

An ArcGIS Dashboards app used by the public to discover 
festivals, shows, concerts, and other events occurring in a 
community 

Not 
required 

Promoting Special 
Events 

An ArcGIS Hub site used by the general public to access 
special event information and destinations in their 
community 

Not 
required 

Special Event 
Operations 
Notebook 

An ArcGIS Notebooks app used by public safety event 
planners to create unique public safety operations maps 
and apps for each event 

Editor 

Copy Previous Site 
and Operations 
Maps 

An ArcGIS Notebooks app used by event coordinators and 
public safety event planners to create a copy of site and 
operations maps 

Editor 

Special Event 
Operations Map 

An ArcGIS Web AppBuilder app used by public safety 
event planners to create operations maps of public safety 
resources and conduct a high-level threat analysis 

Editor 

Special Event Field 
Reporter 

An ArcGIS Survey123 form used by public safety staff to 
report lost children, suspicious activity, field observations, 
and health- and safety-related issues 

Field 
Worker 
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Special Event Field 
Manager 

An ArcGIS Workforce project used by public safety event 
dispatchers to manage field reports and event assignments 

Editor 

Special Event 
Operations 
Dashboard 

An ArcGIS Dashboards app used by public safety 
command staff to monitor operations, weather, traffic, and 
health and safety issues during a special event 

Viewer 

Crowd Counter App An AppStudio app used by staff to count people entering 
and exiting an area 

Field 
Worker 

Special Event After 
Action 

An ArcGIS Web AppBuilder app used by public safety 
command staff to visualize historical event operations and 
support event after-action reports 

Viewer 

Special Event 
Operations Apps 

A gallery app used to organize the operations apps after 
running the Special Event Operations Notebook 

Editor 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • A new version of the Crowd Counter App that resolves an issue where the app 
would not load in the AppStudio Player 

1.0 • First release of Special Event Permitting and Operations 
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Configure Special Event Permitting and 

Operations 
The ArcGIS Solutions app can be used to deploy the Special Event Operations solution in your 

ArcGIS organization. After deploying the solution, configure it to meet specific needs in your 

organization, and load your data if needed. 

 

Preset an event identifier 
All of the special events and associated assets are stored in common hosted feature layers. 

Many of the applications in the solution use an event identifier to filter the maps for a specific 

event. To ensure that the features are tagged with the appropriate event identifier, update the 

editing applications to use preset values in the Event ID field. 

1. Sign in to your ArcGIS organization and search for the Special Event Site Map app. 

2. Click Edit Application. 

3. Click Widget in the upper left corner of the app. 

4. Click Set the widgets in this controller. 

5. Hover over the Create Site Map widget and click the edit button next to Configure this 
Widget.  

6. On the Configure Create Site Map dialog box, click Attribute Actions. 

7. Scroll down under Preset, hover over Event ID, and click the Edit button under Actions. 

8. Uncheck Hide in preset value display. 

9. Click OK. 

10. Click OK to close the Configure Create Operations Map dialog box. 

11. Click Save. 

12. Repeat steps 1 through 11 for the Special Event Operations Map app. 

 

Extend an event permit survey 
The Special Event Permitting and Operations solution includes a survey that can be used by 

event organizers to apply for a special event permit. Review the preconfigured questions and 

adjust as necessary to remain in compliance with your organizational policies. In addition, 

ensure that you secure the survey and underlying layers and only share the content with 

appropriate members of your organization. 

 

Update feature layer views 
The Special Event Permitting and Operations solution includes a series of views created from 

feature layers provided with the solution. You can modify the Special Event Permit survey by 

first adding new fields to the feature layers and then configuring the surveys to use the newly 

created fields. The new fields must be exposed in the appropriate views. Additionally, some 

views are created by joining two sources together, and these views must be re-created with the 

same name and URL address after a new field is added. 
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Note: 

Complete the workflow below to add new questions to the survey by adding new fields. 
Refer to the Modify event permit survey section to learn how to remove questions or format 
a new survey. 

To add one or more fields to a layer and re-create the views, complete the following steps: 

1. Sign in to your ArcGIS organization and search for the SpecialEvents hosted feature layer. 

2. Add a new field to a layer in the SpecialEvents hosted feature layer. 

3. Go to the SpecialEvents_approved view in your contents. 

4. Click the Open in Map View drop-down arrow and click Add to new map. 

5. Click the more options button on the appropriate layer or table and click Set View 
Definition. Click Define Fields. 

6. Scroll to the newly created field and check the box. Click Apply. The new field is added to 
the view’s definition. 

To update a join view, complete the following steps: 

1. Go to the join view in your contents (for example, SpecialEventAreas_approved). 

2. On the item details page, scroll to the URL section. Click the Copy button. 

3. Paste the copied URL into Microsoft Notepad or another text editor for reference. 

  Note: 

  The feature layer name is used below when re-creating the join. The name can be found 
after services in the URL structure and may also contain a unique GUID, for example, 
SpecialEventAreas_approved_a45f71a48587425c9b90ee5527cd26d1. 

4. Delete the existing join view (for example, SpecialEventAreas_approved). 

5. Add the SpecialEvents hosted feature layer to a new web map. 

6. Click Analysis > Summarize Data > Join Features. 

7. Configure the join using the information in the following table: 

  Name of join 
  Target 

layer 

  Layer 
to join 
to the 
target 
layer 

  Fields 
to 
match 

  Join 
oper
atio
n 

  Define 
which 
record is 
kept 

  SpecialEventAsse
ts_approved 

  SpecialEve
ntAssets 

  Special
Events 

  eventid
entifier 
= 
eventid 

  Join 
one 
to 
one 

  Order by 
Date 
Reported
/Newest 

  SpecialEventRout
es_approved 

  SpecialEve
ntRoutes 

  Special
Events 

  eventid
entifier 

  Join 
one 

  Order by 
Date 
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= 
eventid 

to 
one 

Reported
/Newest 

  SpecialEventArea
s_approved 

  SpecialEve
ntAreas 

  Special
Events 

  eventid
entifier 
= 
eventid 

  Join 
one 
to 
one 

  Order by 
Date 
Reported
/Newest 

  Note: 

  Ensure that each new join view uses the names defined in this table. If you use the same 
names, the layers in the map and the existing dashboard widgets do not have to be 
reconfigured. If your join view contained a unique GUID, the new join view must be 
named with the unique GUID. 

8. If necessary, uncheck Use current map extent. Check Create results as hosted feature 
layer view. 

9. Update the Special Event Site Map Viewer and other special event maps and apps to 
account for the new fields you added to the layers. 

 

Modify event permit survey 
To modify the Special Event Permit survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Special Event Permit to download the survey. 

4. Click Special Event Permit again to open the survey. 

5. In the left pane, click Open XLSForm Spreadsheet. 

6. In the Microsoft Excel spreadsheet, click the choices tab. This tab comprises all the 
selectable options for survey questions. 

7. Revise the survey to reflect your special event permit needs. 

8. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect. 

9. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 

Note: 

On the Download Surveys page, click Download to view your changes in ArcGIS 
Survey123 Connect. 

 

Notify reviewers 
The Special Event Permit Review app allows departmental reviewers to provide input on each 

event. The Special Event Permit Manager has a button that opens an email to send to these 

reviewers. Often these reviewers are the same for every event, so rather than typing the same 
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emails for each departmental reviewer every time an event is ready for review, you can populate 

the email so it always includes their email addresses. 

1. Sign in to your ArcGIS organization. 

2. Click Content and browse to the folder where you deployed the Special Event Permitting 
and Operations solution. 

3. Search for the Special Event Permit Manager web map and open it. 

4. In the layer list, highlight Special Event Permits, click the more options button, and click 
Configure Pop-up. 

5. Under Attribute Expressions, scroll down to Notify Reviewers Email Link. 

6. Find the following line of code: var emailRecipient = "" 

7. Enter the email addresses of the reviewers separated by semicolons between the empty 
quotation marks. 

8. Click OK to close the Arcade window. 

9. Click OK to close the Configure Pop-up window. 

10. Click Save to save the Special Event Permit Manager. 

11. Click Content and browse to the folder where you deployed the Special Event Permitting 
and Operations solution. 

12. Search for the Special Event Permit Manager app and open it. 

13. Find an event that has the Status parameter set to Approved and Site Map Complete set 
to Yes. 

14. Click the Notify Reviewers button. Verify that the emails are now populated as part of the 
email. 

 

Add event assets 
The Special Event Permitting and Operations solution includes several layers that can be used 

to locate event assets and develop health and public safety plans. These layers include several 

domains to help you get started with the event permitting and planning process. Each of these 

domains can be configured to include any additional features you want to capture. 

To add a new event asset and update the symbology, complete the following steps: 

1. Sign in to your ArcGIS organization. 

2. Click Content and browse to the folder where you deployed the Special Event Permitting 
and Operations solution. 

3. Search for SpecialEventAssets and open the item details page. 

4. Click Fields and click Event Asset Type. 

5. Next to List of Values, click Edit. 

6. Add your additional asset types and click Save. 

7. Click the Visualization tab. 

8. Click Change Style and update the style for each new asset you added to the list. 

9. Repeat steps 7 and 8 and update the style for SpecialEventAssets_approved and 
SpecialEventAssets_operations. 

Tip: 
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You can use the same steps to modify the SafetyPlanning and HealthSafetyPlanning layers 
and associated views. 

 

Share event destination 
Promoting Special Events is an ArcGIS Hub site that can be used to promote special events in a 

community. It can also serve as a destination for event organizers that must apply for a special 

event permit. The ArcGIS Hub site integrates several maps and apps included in the Special 

Event Permitting and Operations solution. Each of these maps and apps must be shared with 

the public so they can be accessed at the Promoting Special Events destination. 

To share the event maps and apps, complete the following steps: 

1. Sign in to your ArcGIS organization. 

2. Search for Promoting Special Events and open the item details page. 

3. Share the ArcGIS Hub site with everyone (public). 

4. Repeat this process for each of the following items: 

Item Name Sharing 

Web mapping app Special Event Site Map Viewer Everyone (public) 

Dashboard Special Event Calendar Everyone (public) 

Form Special Event Permit Everyone (public) 

Web map Special Event Site Map Viewer Everyone (public) 

Web map Special Event Calendar Everyone (public) 

Feature layer (hosted) SpecialEvents Everyone (public) 

Feature layer (hosted, view) SpecialEvents_approved Everyone (public) 

Feature layer (hosted, view) SpecialEventsAssets_approved Everyone (public) 

Feature layer (hosted, view) SpecialEventsRoutes_approved Everyone (public) 

Feature layer (hosted, view) SpecialEventsAreas_approved Everyone (public) 

Feature layer (hosted, view) RoadClosures_public Everyone (public) 

 

Configure Crowd Counter App 
The Special Event Operations solution includes the ability to track the number of people 

entering and exiting a defined area to ensure the number of people admitted does not exceed 

the maximum capacity allowed for the size of the area. 

 

Download and set up Crowd Counter App 
You will need to set up the Crowd Counter App on your mobile device to manage and track 

crowd capacity. To download and install the Crowd Counter App on your mobile device, follow 

these steps: 
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1. Download ArcGIS AppStudio Player onto your mobile device. 

2. Open the app on your mobile device and sign in to your ArcGIS organization. 

3. Tap the Shared button and choose the Crowd Counter App button to download the app. 

4. Choose the Crowd Counter App button, and sign in to your ArcGIS organization again. 

5. Choose the add button and choose Browse Projects, and then choose Crowd Counter to 
download the project. 

6. When the download is complete, choose Crowd Counter, sign in to your ArcGIS 
organization, and choose the Keep me signed in. 

Note: 

The first time you set up your mobile device with the Crowd Counter App, you are prompted 
to sign in two times. This is expected. After the initial setup, you are no longer be prompted 
to sign in. 

 

Create After Action app 
Incident commanders are responsible for the health and safety of participants during an event. 

The Special Event After Action app provides useful visualization tools to see both how incidents 

occurred and how field personnel responded. This information can be used to further examine 

specific incidents and help plan for future events. 

Follow the workflow below to create a unique Special Event After Action app for your event. 

Follow the steps below create a unique track view of your event. 

1. Open a new map project in ArcGIS Pro. 

2. Sign in to your ArcGIS organization account within ArcGIS Pro . 

3. Search for the <Event Name Date>_trackview and add the track view to the map. 

  If you have many field personnel over an extended period of time then, you may have a 
large number of tracks and want to change the maximum number of records returned. 

4. Select the track view you added to the map and export the data from the track view into a 
new layer. 

5. Publish the new layer as a service in your ArcGIS organization and name it <Event Name 
Date> - Tracks. 

Follow the steps below create a Special Event After Action web map to use in the After Action 

app. 

1. Sign in to ArcGIS organization and navigate to the Special Event After Action web map 
item. 

2. Open in Map Viewer the Special Event After Action web map. 

3. Add the layer you published in the previous workflow to the map. 

4. Change the style of the layer and symbolize by the Full Name field. 

5. Add the layer assignments layer named the <Event Name Date> - Assignments to the 
map. 

6. Change the style of the layer and symbolize by the report type field using the public 

safety category. 

7. Remove the Report Type layer from the map. 
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8. Save the Special Event After Action map with a new same for example, Special Event 
After Action - Event Name.  

Follow the steps below create a Special Event After Action app for your event. 

1. In your ArcGIS organization, navigate to the Special Event After Action app item and Edit 
Application. 

2. Choose the triangle button, next to Save, and choose Save As. 

3. Choose a name for the app for example, Special Event After Action - <Event Name>.  

4. Choose Map, Choose web map, then choose the map you created in the previous 
workflow. 

5. Choose Widget, Set the widgets in this controller, Group Filter widget, and then choose 
OK. 

6. Add each layer of the map to the widget and choose the Event Identifier field as the filter. 

7. Choose After Action Report widget and update the layer to the<Event Name Date> - 
Assignments. 

8. Choose Find Personnel widget and update the layer to the<Event Name Date> - Tracks. 

9. Save and then Launch the application. 

The application is a historical archive of the special event and can be used to animate 

assignments and track locations. Repeat this workflow for each event. 
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Use Special Event Permitting and Operations 
Special Event Permitting and Operations can be used by local governments to collect and 

organize permit apps, develop event site maps and health and safety plans, coordinate the 

permit review process, share event information with the public, monitor public health and safety 

operations, and create after-action reports. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Manage event permits 
Special events start with private or nonprofit organizations that request an event permit from the 

local authorities. Typically, this permit request is submitted in hard copy or a fillable form that is 

received by a special event coordinator. The coordinator is then often responsible for delegating 

the review process to stakeholders from many departments. Often this process is further 

encumbered by paper or email delays. 

In this workflow, you'll learn how to create and manage special event permits. 

 

Apply for a special event permit 
You will start by assuming the role of an event organizer who needs to submit a permit app to a 

local government for approval. You are asked to use the Special Event Permit survey to apply 

for an event permit and submit a site map along with your app. 

1. In a browser, from the Special Event Permitting and Operations solution, view the Special 
Event Permit survey. 

2. In the Special Event Permit survey, fill in the following details on the first page: 

  Parameter 

  Value 

  Enter the name of the 
special event 

  Type 5K for the Local Animal Shelter. 

  Select an event type   Type Competition or Race. 

  Description of Event   Type A great event to be had by everyone 
benefiting animals in need. 

  Open to the public   Select Yes. 
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  Estimated Attendance   Type 1000. 

3. At the bottom of the first page, click Next. 

4. Complete the remaining event permit pages, selecting an event start date one week from 
today in the morning and ending in the evening of the same day.  

5. On page 8 of the event survey, provide the following information: 

– For Event location, type the name of a local park. 

– For Locate the event on a map, type the park's address and zoom to the location. 

– For Event Site Map, browse to a local file and attach a diagram an event organizer 
would use to describe the setup of an event. 

6. At the bottom of the page, click Next. 

7. On page 9, sign the permit app. 

8. Click Submit. 

 

Submit an internal event 
In some cases, an event may be hosted by your own organization, so there is no need to fill out 

the full permit. In that case, you can use a shortened version of the permit that represents the 

internal submission. 

1. In a browser, from the Special Event Permitting and Operations solution, view the Special 
Event Permit survey. 

2. In the browser's address bar, at the end of the URL, add &field:submittype=Internal. 

  Your final URL parameter should be similar to the following address: 

  https://survey123.arcgis.com/share{YourItemID}?portalUrl={YourPortalURL}&field:submitty
pe=Internal 

  The internal event permit will not contain as much detail as a sponsored event. 

3. Fill out the survey with a new event and submit it. 

 

Coordinate a permit review 
Now, you will assume the role of an event organizer in the same local government. You are 

asked to coordinate the review process and notify other government departments when a 

special event permit has been submitted. You will review the permit app and update the status 

of the permit. 

1. In a browser, from the Special Event Permitting and Operations solution, view the Special 
Event Permit Manager app. 

2. In the Special Event Permits table, click the Permit Status column filter and select 
Submitted. 

3. In the table, select the event that you created previously. 

4. In the Info panel, scroll down and click Review Permit Application. 

  The permit app that was submitted by the organizer opens, which allows further review of 
the app, permit updates, and email communication with the organizer. 

5. Close the Special Event Permit survey and return to the Special Event Permit Manager 
app. 
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6. On the Info tab, click the edit button and click Edit to edit the event status. 

  Note: 

  As a special event coordinator, you can track the permit status throughout the review life 
cycle and identify when site and operations maps have been created. 

7. For Permit Status, choose Under Review, and then click Save. 

 

Prepare site plans 
The event site map is the foundation of the event. It provides a common reference for planning, 

operating, and promoting each event. It can also include the event location, event assets, 

designated areas, and routes required to conduct the event. The Special Event Site Map allows 

coordinators or safety planners to quickly add these assets to the map for an event. 

In many cases, events are reoccurring and have similar setups year after year. The Copy 
Previous Site and Operations Maps notebook allows you to create a new event using a previous 
site map as a starting point. Modifications can then be made and added to the site map for the 
new event. 

In this workflow, you'll learn how to create and copy site maps as well as notify others when 
maps are ready to be reviewed. 

 

Create a site map 
You will start by assuming the role of an event organizer who needs to create an event site map 

for a permit app. You are asked to use the Special Event Permit Manager to locate a permit app 

and the Special Event Site Map to create a site map. 

1. In a browser, from the Special Event Permitting and Operations solution, view the Special 
Event Permit Manager app. 

2. In the Special Event Permits table, click the Permit Status column filter and select Under 
Review. 

3. In the table, select the event that you created previously. 

4. In the Info panel, scroll down and click Edit Site Map. 

  The Special Event Site Map app opens and zooms to the event permit app. It also filters all 
related information, so you see temporary features for your event. 

5. On the Create Site Map dialog box, click Food Concessions, and then type King 
Smoothie. 

6. Click a location on the map within the park. 

  Note: 

  The Event Identifier field is passed automatically from your filter selection in the Select 
Event widget and cannot be edited. 

7. Click Save. 

8. Repeat these steps for each event asset, route, and area that you want to add to your site 
map. 
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9. After completing your site map, click Save, and close the Special Event Site Map. 

 

Copy event maps from the previous year (optional) 
Many times, reoccurring events will use similar site and operations maps from one year to the 

next. For instance, an annual 5k run will have a similar route, food concessions, and public 

safety support locations. Re-creating the site map every year can be time-consuming. In this 

workflow, you will learn how to copy event maps from a previous year and update the maps 

when necessary. 

You will continue assuming the role of an event organizer. You are asked to use the Special 
Event Permit Manager and the Copy Previous Site and Operations Maps script to create a copy 
of the previous year's site map and operations maps. 

Note: 

To execute the Copy Previous Site and Operations Maps script, the event organizer must 
have access to the ArcGIS Notebooks item. In addition, you need at least two events (see 
the Create a special event section). The first event's status must be set to Archived and 
should have an associated site map. The new event should have the status set to Under 
Review. Do not use the event you have already approved above as it will be used in the 
subsequent steps.. 

1. In a browser, from the Special Event Permitting and Operations solution, view the Special 
Event Permit Manager app. 

2. In the Special Event Permits table, click the Permit Status column filter and select Under 
Review. 

3. In the table, select the event that you created previously. 

4. In the Info panel, scroll down and click Copy Previous Site/Operations Maps. 

  An ArcGIS Notebooks app appears in a new tab and may prompt you to sign in. 

5. Click Cell and choose Run All. 

6. In the Archived drop-down list, choose a previous event that already has a site map. 

7. In the New Event drop-down list, choose the new event that does not have an associated 
site map. 

8. Click Copy Previous Site/Operations Maps. 

9. When the script completes, return to the Special Event Permit Manager and select the 
event in the Special Event Permits table. 

10. Click Edit Site Map and verify the new site map is complete. 

  Note: 

  You may also want to verify the Special Event Operations Map is complete. 

11. Make any required modifications to the site map and click Save. 
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Notify permit reviewers 
You will continue assuming the role of an event organizer. You are asked to use the Special 

Event Permit Manager to update the permit app and notify internal stakeholders that the 

proposed event is ready for review. 

1. In a browser, from the Special Event Permitting and Operations solution, view the Special 
Event Permit Manager app. 

2. In the Special Event Permits table, click the Permit Status column filter and select Under 
Review. 

3. In the table, select the event that you created previously. 

4. In the Info panel, scroll down and click Edit. 

5. Locate the Site Map Complete field, choose Yes, and click Save. 

6. On the Info tab, click Notify Reviewers. 

7. Copy the hyperlink from the email and paste it in a new tab in your browser. 

  Note: 

  You will send this email to the permit review staff members who participate in your permit 
review process. 

8. Close your email client. 

Note: 

If your email client does not open when you click the Notify Reviewer button, ensure that 
your default email client is configured. 

 

Inform stakeholders 
As the number and size of local special events increase, so does the impact on public 

infrastructure and resources. Executives from a local government need to see a comprehensive 

impact to the community. Key indicators, such as events serving alcohol or fireworks or 

requiring road closures, can show the impact on public safety or public works resources. The 

Special Event Permitting and Operations solution provides a Special Event Permit Dashboard to 

allow executives to see a historical context of all events and where they are in the approval 

process, and filter by event type. 

Public attendance to an event can be dependent on how well it is promoted. The Promoting 
Special Events ArcGIS Hub site allows your community to have a branded destination to 
promote events as well as other places to visit, such as museums or popular restaurants. A 
member of the general public can view the Special Event Calendar to find a specific event of 
interest to them, with an associated detailed site map of the event. 

In this workflow, you'll learn how to update and monitor special event permits as well as view the 
special events in your community. 
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Gather feedback from internal stakeholders 
Event permits are typically reviewed by several different government departments or agencies. 

Incorporating feedback from the internal stakeholders before the permit is approved is critical. In 

this workflow, you will learn how to review a permit app and offer comments. You will also learn 

how to review a summary of all comments provided during the review process. 

You will start by assuming the role of a permit review staff member (for example, public works 
director, planning director, or incident commander). You are asked to use the Special Event 
Permit Review app to review an event permit app and the site map and offer any comments. 

1. In a browser, from the Special Event Permitting and Operations solution, view the Special 
Event Permit Review app. 

2. In the list of special events, select the event that you created previously or select another 
special event. 

3. Click View Permit Application to review details found in the permit app, and then close 
the Special Event Permit survey. 

4. Click the Add a comment button and fill in the following details: 

  Parameter 

  Value 

  Organization   Select Public Works. 

  Comments   Type Concerned that additional cross street need to be 
blocked. 

  Any 
Instructions 

  Type Approved contingent on additional road blocks. 

  Action   Select Approved. 

5. Click Submit, and then close the Special Event Permit Review app. 

Now you will assume the role of an event coordinator. You are asked to use the Special Event 

Permit Manager app to review comments provided by the permit review staff to approve or deny 

the permit app. 

1. In a browser, return to the Special Event Permit Manager app. 

2. In the table, click the Permit Status column filter and select Under Review. 

3. Select the event that you created previously or select another event. 

4. In the Info panel, click the Comments tab. 

  Comments may be provided by the permit review staff. In some cases, the comments may 
require you to update the site and operations maps or contact the event organizer to alter 
their plans for the event. 

5. Click the Info tab, and then click the Edit button. . 

6. For Permit Status, select Approved, and then click Save. 

7. On the Info tab, click Notify Organizer. 

  The email is directed to the person who originally applied for the permit and the event 
organizer. The email includes a link to the original permit app and the site map that can be 
viewed for reference. 
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8. Close your email client. 

 

Monitor event permit applications 
Many organizations are seeing a growing number of events in their community. As a result, 

event executives need to monitor the status of the event permit process and understand which 

events are occurring throughout the community. 

In this workflow, you will assume the role of an event executive. You are asked to use the 
Special Event Permit Dashboard to monitor the special event permit program, review key 
indicators, and get an understanding of the type of events scheduled in the community. 

1. In a browser, from the Special Event Permitting and Operations solution, view the 
Special Event Permit Dashboard app. 

2. In the left panel, click the Status filter and select Under Review. 

3. Review the list of permits and indicators. 

4. Select an event from the list and review additional event information. 

5. Click the graph to filter events by month.  

 

Share events with the public 
Special events have become an important factor in local economies by attracting participants 

and spectators from outside the community to events such as 5k fun runs, marathons, outdoor 

concerts, and arts and crafts festivals. In some cases, local governments hosting similar special 

events are competing with each other for event participants that help support the local economy. 

Therefore, promoting and marketing local events is important. 

Finally, you will assume the role of a resident or member of the public. You are interested in 
events happening in your community and will use an ArcGIS Hub destination on your 
community's website along with the Special Event Calendar app to discover upcoming events. 

1. In a browser, from the Special Event Permitting and Operations solution, view the 
Promoting Special Events ArcGIS Hub site.  

2. Scroll to the Things to Do section, and then click Learn more to open the Special Event 
Calendar app. 

3. On the left, search for an event by name, date, or type. 

4. Review the list of events occurring in the community. 

5. Select an event from the list and review additional event information. 

6. Click the View Event Map link and review assets (for example, entrances, road blocks, 
and vendors) placed for the event. 

  Note: 

  For larger events, it may be useful to search for an event asset. 

7. After reviewing the Special Event Site Map Viewer, close it and return to the Special Event 
Calendar. 

8. Select another event from the list and review additional event information. 
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Prepare operations plans 
The Special Event Operations Map allows safety planners to add all relevant health and safety 

resources and perform high-level risk assessments. It can be used to locate isolation areas or 

set up plexiglass barriers at ticket counters or food vending booths. In addition, it can be used to 

calculate the number of people allowed in each space using Centers for Disease Control and 

Prevention (CDC) guidelines. Event staff can use a real-time counter at entrances and exits for 

each venue to maintain a safe environment for everyone. 

In addition, public safety staff can add resource assignments, road closures, traffic restrictions, 
and estimates of crowd sizes to guide field personnel assignments. Optionally, planners can 
create a reference grid for field staff supporting the event, conduct a visibility assessment for 
high-risk locations, or identify areas impacted by a potential bomb explosion or chemical spill. 

In this workflow, you'll learn how to create operations maps and copy events from previous 
years. 

 

Coordinate with public safety event planners 
You will start by assuming the role of an event organizer who needs to coordinate with public 

safety event planners. You are asked to use the Special Event Permit Manager to locate a 

permit application and notify the public safety event planners that a health and safety plan is 

needed for this event. 

1. In a browser, from the Special Event Permitting and Operations solution, view the Special 
Event Permit Manager app.  

2. In the table, click the Permit Status column filter and select Under Review. 

3. Select the event. 

4. On the Info tab, click Edit Operations Map. 

  A new email message opens with the link to the event operations map. 

  Note: 

  For larger events, it may be useful to search for an event asset. You will send this email 
to public safety event planners who participate in your permit review process. 

5. Copy the link from the email, and then close your email client.  

6. In a new browser tab, paste the link and press Enter. 

7. Close your email client. 

8. Review the Special Event Operations Map, and then return to the Special Event Permit 
Manager app. 

9. In the Info panel, click the Edit button. 

10. Locate the Special Event Operations Map Complete field and choose Yes. 

 

Develop a health and safety plan 
Next, you will assume the role of a public safety event planner who needs to develop a health 

and safety plan for an event. You are asked to use the Special Event Operations Map to create 

an operations map of public safety resources and conduct a high-level threat analysis. 
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1. In a browser, from the Special Event Permitting and Operations solution, view the Special 
Event Operations Map app. 

  Note: 

  When the public safety event planner opens the email sent by the event organizer, the 
event identifier and the plan identifier fields are passed automatically to the Select Event 
widget and should not be edited. 

2. Click the Basemap widget and select Imagery. 

3. Click the Create Operations Map widget and search for PPE Station. 

4. Place a personal protective equipment (PPE) station on the map and enter details for the 
health and safety asset. 

5. Click Save. 

6. Search for Hand washing Station, place it on the map, and enter details for the event 

asset. 

7. Click Save. 

8. Repeat these steps for each health and safety asset, route, and area that you want to add 
to your operations map. 

9. Search for Road Blocks, place two on the map, and enter details for each of the road 

blocks. 

10. Click Save. 

11. At the top of the Create Operations Map widget, select Social Distancing Crowd Areas 
from the drop-down list. 

12. Click the template, draw an area on the map, and double-click to complete the sketch. 

13. For Area name, type Vendor Area. 

14. For Max Capacity, type 100, and then click Save. 

  Note: 

  The area on the map will be labeled with the number of people who can safety enter an 
area of this size based on CDC social distancing guidelines. Adjust the maximum 
capacity or area size, if necessary. 

15. At the top of the Create Operations Map widget, select Crowd Estimates from the drop-
down list. 

  Note: 

  Crowd estimation is determined by Jacobs' method; the high, medium, and low values of 
crowd estimation appear on the map. 

16. Click the template, draw an area on the map, and double-click to complete the sketch. 

17. For Description, type Crowd Area for Event. 

18. Click Save. 

19. Search for Medical Tent, place it on the map, and enter details for the event asset. 

20. Click Save. 
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21. Finally, search for On Foot, place three public safety resources on the map, and type the 

following details for each resource: 

– For Point of Contact, type an officer name. 

– For Point of Contact Phone, type a unique phone number for each officer. 

– For Comments, type Public Safety support for event. 

22. After completing your health and safety operations map, click Save. 

 

Conduct high-level threat analysis (optional) 
The Special Event Operations Map includes a series of tools that can be used to define the 

impact of an incident (chemical or other threat) on event assets and resources. As you complete 

the health and safety plan, you may be asked to conduct a high-level threat analysis and identify 

the impact on your event operations plan. 

1. In a browser, from the Special Event Permitting and Operations solution, view the Special 
Event Operations Map app.  

2. Click the Gridded Reference Graphic widget to create a reference grid that can be used 
in large outdoor events.  

3. Define the location of the grid from a point or area, and then click Create GRG. 

4. To identify the impact of a chemical incident and create a potential evacuation area, click 
the Emergency Response Guide widget. 

5. Select the location, material, and size of the accident along with the wind direction and 
time, and then click Create Zones. 

6. Click the Threat Analysis widget to identify the impact of other threats. 

7. Select the location, type of threat, and size of the accident, and then click Create Zones. 

8. Finally, to identify the impact of an incident on event assets and resources, click the 
Situational Awareness widget. 

9. Select the location and the distance impacted, and then click the map. 

  After using the Gridded Reference Graphic, Emergency Response Guide, or Threat 
Analysis widgets and publishing the derived layers, you can associate the layers with the 
event so they can be used in other event operations apps. 

10. Select a health and safety resource you added earlier and copy the event identifier. 

11. Click the Assign Event Identifier widget and select the features generated by the 
previously identified widgets.  

12. Type the event identifier, and then click Save. 

 

Copy event maps from the previous year (optional) 
Many times, reoccurring events will use similar site and operations maps from one year to the 

next. For instance, an annual 5k run will have a similar route, food concessions, and public 

safety support locations. Recreating the site map every year can be very time consuming. In this 

workflow, you will learn how to copy event maps from a previous year and update the maps 

when necessary. 

You will continue assuming the role of an event organizer. You are asked to use the Special 
Event Permit Manager and the Copy Previous Site and Operations Maps script to create a copy 
of the previous year's site map and operations maps. 
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Note: 

To execute the Copy Previous Site and Operations Maps script, the event organizer must 
have access to the ArcGIS Notebooks item. In addition, you need two events, and the 
status of the previous year's event must be set to Archived. 

1. In a browser, from the Special Event Permitting and Operations solution, view the Special 
Event Permit Manager app.  

2. Click the Permit Status column filter and select Under Review. 

3. Select the event that you created previously. 

4. In the Info panel, scroll down and click Copy Previous Site/Operations Maps. 

  An ArcGIS Notebooks app appears in a separate tab and may prompt you to sign in. 

5. Click Cell and choose Run All. 

6. In the Archived drop-down menu, choose a previous event that already has a site map. 

7. In the New Event drop-down menu, choose the new event that does not have an 
associated site map. 

8. Click Copy Previous Site/Operations Maps. 

9. When the script completes, return to the Special Event Permit Manager and select the 
event in the table. 

10. Click Edit Site Map and verify the new site map is complete. 

  Note: 

  You may also want to verify the Special Event Operations Map is complete. 

11. Make any required modifications to the site map and click Save. 

 

Conduct health and safety operations 
The Special Event Permitting and Operations solution provides a complete set of capabilities 

that improve the efficiency and effectiveness of public safety personnel working at special 

events by enabling public safety personnel with tools to capture information from the field to 

share with commanders in a synthesized operational picture in real time. 

In this workflow, you'll learn how to use a collection of maps and apps to support incident 
commanders and site staff to visualize, monitor, and communicate real-time status during an 
event as well as visualize incident response after an event has occurred. 

 

Deploy event operations apps 
Public safety event planners and incident commanders need a unique set of maps and apps for 

each event. The unique maps and apps allow them to manage personnel assignments, 

activities, and incidents during an event and conduct after-action reviews that help them 

improve planning for future events. Each event requires the following: 

• Unique apps for incident commanders, firefighters and emergency medical technicians, law 
enforcement officers, event dispatchers, health and safety officers, cleaning staff, and site 
staff 
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• The ability to monitor the location field personnel assigned to an event 

• An incident tracking and assignment system that can be used onsite at the event 

• Maps that show relevant event assets and public safety resources assigned to an event 

You will assume the role of a public safety event planner. You are asked to use the Special 

Event Operations Notebook to create a copy of the event operations apps for a unique event. 

Note: 

This workflow requires you to sign in to your ArcGIS organization, and the Special Event 
Permitting and Operations solution must be deployed. 

1. In a browser, go to the Special Event Operations Notebook and review the instructions 
provided with ArcGIS Notebooks. 

2. Click the Special Event Field Personnel link to view a list of all field personnel working 
the event, as well as dispatchers that will communicate with them. 

3. Click Download and open the spreadsheet in Microsoft Excel. 

4. Ensure that the spreadsheet includes the field personnel that have already been added to 
your ArcGIS organization and have been assigned Tracker licenses. 

  Note: 

  Typically, the operations apps are created in advance of the event. However, if additional 
field personnel are assigned to the event after you run the notebook, you will need to add 
them manually as follows: 

  Add field personnel as workers to the ArcGIS Workforceproject. 

  Add field personnel as users to the ArcGIS Tracker view. 

  Add field personnel to the group created for the event. 

5. Save the file as FieldPersonnel.xlsx and close the spreadsheet. 

6. Return to the Special Event Operations Notebook, click Update, and browse to your 
FieldPersonnel.xlsx file. 

7. Close the Special Event Field Personnel tab in your browser. 

8. Click the Cell menu and click Run All. 

9. Under Select a Special Event to deploy Operations applications, click the Select an 
Event drop-down arrow, and choose your event. 

10. Click Deploy Special Event Operations. 

11. When the progress bar is complete, click View Deployed Event Operations. 

  A collection of new event operations apps opens. 

   

Track locations of field personnel 
The ability to quickly identify the location of field personnel is critical during the event. 

Dispatchers and incident commanders need to see a map with the location of their staff to 

determine who should respond to specific incidents. 
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You will assume the role of a firefighter, emergency medical technician, or law enforcement 
officer who will capture their location while working at the event. You will use the Tracker field 
app to track your location for incident command to see. 

1. On your mobile device, open the ArcGIS Tracker app. 

2. Click Sign in with ArcGIS Enterprise and enter your credentials. 

3. Turn on Track My Location. 

You can now minimize Tracker to conduct the rest of your work. Your tracks will continue to be 

captured for operations staff while you have Track My Location on. 

 

Report activity from the field 
During an event, public safety staff and site staff collect field observations that are used to 

protect the health and safety of event attendees. 

You will assume the role of a firefighter, emergency medical technician, or law enforcement 
officer who needs to report suspicious activity or a safety concern observed at the event. You 
are asked to use the Special Event Field Reporter survey to report the suspicious activity or 
safety concern. 

1. In a browser, go to the Special Event Operations gallery and click the Special Event Field 
Reporter survey for your event name and date. 

2. In the Special Event Field Reporter survey, fill in the following details: 

  Parameter 

  Value 

  Type   Select Suspicious Activity. 

  Suspicious Activity 
Type 

  Select Object. 

  Details   Type Backpack left at location with no owner to be 
seen for 20 minutes. 

3. Optionally, add an image or picture. 

4. Locate the field report on the map. 

5. Click Submit. 

 

Manage field assignments 
It’s common for minor incidents such as traffic accidents, medical calls, or disorderly spectators 

to occur during a special event. Often these incidents are reported by radio or 911 calls to a 

dispatcher in the event command center. 

Now, you will assume the role of an event dispatcher who needs to assign field reports or other 
incidents to field staff. You are asked to use the Special Event Field Manager to assign the 
suspicious activity or safety concern to a firefighter, emergency medical technician, or law 
enforcement officer. 
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Note: 

This workflow requires you to be signed in to your ArcGIS organization and have the 
Special Event Permitting and Operations solution deployed. 

1. In a browser, go to the Special Event Operations Gallery and click the Special Event 
Field Manager for your event name and date. 

2. When the new tab opens, click Open in ArcGIS Workforce. 

3. Click the Suspicious Activity assignment in the list. 

4. Select Assign and choose a fieldworker from the drop-down menu. 

5. Click the Search bar and type King Smoothie. 

6. Click Special Event Assets: 1 Result feature and click Create assignment. 

7. In the new assignment, fill in the following details: 

  Parameter 

  Value 

  Assignment Type   Select Medical Response. 

  Assign   Choose a fieldworker from the drop-down list. 

  Description   Type Citizen reporting heat exhaustion and has 
collapsed. 

  Priority   Choose High from the drop-down list. 

  Due Date and 
Time 

  Select a time on the same day of the event. 

8. Click Create Assignment. 

  Field personnel can open the ArcGIS Workforce app on their mobile device and see their 
assignments. 

   

Track crowd capacity 
You will assume the role of site staff. You are asked to use the Crowd Counter App to count 

people entering and exiting the area to ensure that the number of people admitted does not 

exceed the maximum capacity allowed for a unique area. 

Tip: 

See Crowd Counter App to learn how to install and set up the Crowd Counter App on your 
mobile device. 

1. Open and sign in to the Crowd Counter App using the ArcGIS AppStudio Player app on 
your mobile device, if it isn't already open from the previous workflow. 
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2. Tap the edit button to edit the Area Name value, and enter the exact area name of the 
location you are tracking crowd capacity for. Use Vendor Area, if you completed the 
Prepare operation plans workflow. 

3. Choose Done. 

4. Choose Enter for each person entering the area, and choose Exit for each person exiting 
the area. 

5. Monitor the gauge on the Occupancy tab to understand the current capacity (middle 
number) relative to the maximum capacity (last number). 

  Note: 

  The gauge displays different colors as capacity changes. Green indicates under 
capacity, orange indicates near maximum capacity, and red indicates maximum 
capacity. 

6. Continue to allow people to enter and exit the area based on the current capacity. 

Note: 

If the gauge does not display the correct results, tap the refresh button in the upper right 
corner of the app. 

Tip: 

When the Crowd Counter App is used to count high numbers of people, consider deleting 
or archiving entry and exit records from the Crowd Count layer to ensure best performance. 

 

Track cleaning and stocking status 
You will assume the role of cleaning staff. You are asked to use the ArcGIS Collector mobile 

app to access your cleaning and restocking map to provide the status of cleaning and 

restocking of PPE every 60 minutes. 

1. Download ArcGIS Collector onto your mobile device. 

2. Open the app on your mobile device and sign in to your ArcGIS organization. 

3. Tap the Cleaning and Restocking Map for your event name and date. 

4. Choose a PPE station, choose Cleaning and Restocking Status in the pop-up, and 
choose the Add button. 

5. Choose Status, choose Re-stocked, and add the number of boxes stocked of each PPE 
type. 

6. Choose Submit. 

 

Monitor event operations 
Incident commanders need real-time information on the location of incidents and staff as well as 

incoming weather and traffic information to make informed decisions during an event. The 
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Special Event Operations Dashboard can be used in the command center on the day of the 

event. 

1. In a browser, go to the Special Event Operations gallery app. 

2. Click the name and date of your event Special Event Operations Dashboard. 

3. On the Incident tab, Tracked Units, Units on assignment, and Last Known Locations 
provide up-to-date location information of staff and assignments. 

4. Click Open incidents within the last hour and choose an incident. 

5. Click the Post Locations tab on the bottom of the dashboard to see post location versus 
the actual location of staff. 

6. Click the Weather tab on the bottom of the dashboard to see real-time weather radar 
information. 

7. Click the Traffic tab on the bottom of the dashboard to see real-time traffic and road 
closure information. 

8. Click the Crowds tab on the bottom of the dashboard to see real-time crowd counts for an 
area based on information from staff tracking crowd capacity using the Crowd Counter 
App. 

9. Click the Sanitation tab on the bottom of the dashboard to see real-time cleaning and 
restocking status for PPE stations, high-touch locations, and other health assets. 

10. Close the app. 

 

Conduct after-action briefings 
Incident commanders are responsible for the health and safety of participants during an event. 

The Special Event After Action app provides useful visualization tools to see both how incidents 

occurred and how field personnel responded. This information can be used to further examine 

specific incidents and help plan for future events. 

You will assume the role of an incident commander. You are asked to use the use the Special 
Event After Action app, including the site map, operation plans, assignments, incidents, and 
historical staff locations from the event, that you created after the event is complete. 

Tip: 

See Create After Action app to learn how to set up Special Event After Action app for a 
specific special event. 

1. In a browser, go to the Special Event After Action app for your event, use your mouse to 
hover over the time slider at the bottom the map and click the pause button. 

2. Adjust the time slider to see when and where incidents occurred and when and where staff 
responded. 

  Note: 

  If the map does not animate based on time, the incidents may be outside of the time 
extent of the event. 

3. Click the After Action Report button, click the rectangle, draw the reporting area, and click 
the Report button. 
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4. Click the Print button, choose the print layout, and click the Print button again to create a 
report containing the visible map and incidents during the event. 

5. Click the Download button, choose CSV, and click the Download button again to create a 
CSV file containing the incidents during the event. 
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Stormwater Data Management for ArcGIS 

Enterprise 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Stormwater Data Management for 

ArcGIS Enterprise 
Stormwater Data Management for ArcGIS Enterprise can be used to map and manage asset 

information with the ArcGIS Utility Network. 

The solution configures ArcGIS Enterprise and the ArcGIS Utility Network to be an authoritative 
repository of information for a stormwater network and provides workflows that facilitate 
capturing information correctly and keeping it up to date. 

Stormwater Data Management for ArcGIS Enterprise provides a data model that makes a utility 
network behave like a stormwater network, editing apps configured for ArcGIS Pro, and 
preconfigured maps for data sharing. It also provides a sample utility network dataset so users 
can experience a utility network in a single-user environment. You can use the solution's 
deployment framework to experience a stormwater utility network with sample data or in a 
single-user environment. 

 

Requirements 
Stormwater Data Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.8 (Standard or Advanced) 

 

Information products 
Stormwater Data Management includes the following information products: 

Item Description Minimum user type 

Stormwater Data 
Management for 
ArcGIS Enterprise 

A zipped file with an ArcGIS Pro project 
package with tasks, a configured utility network 
in a file geodatabase, editor and auditor maps, 
and an asset package geodatabase 

Creator user type 
with ArcGIS Utility 
Network user type 
extension 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
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(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • The first release of Stormwater Data Management for ArcGIS Enterprise. 
• The data model in the solution has been updated to version 4. For a full 

list of updates, refer to the change log. 
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Use Stormwater Data Management for ArcGIS 

Enterprise 
The Stormwater Data Management for ArcGIS Enterprise solution provides a preconfigured 

utility network, maps, styles, step-by-step instructions, common data management workflows, 

and more. The tasks in the Stormwater Data Management project guide you through creating 

your own utility network using the provided schema and setting up an enterprise environment. 

The solution also includes a data dictionary with descriptions of the features in the data model. 

In this topic, you will learn how to use the solution to create and manage your stormwater utility 
network. 

Use the instructions in the Stormwater Data Management task to get started with the solution. 

1. Sign in to your ArcGIS organization and browse to the Stormwater Data Management for 
ArcGIS Enterprise V1 item. 

2. Open the item page and click Download. 

3. Unzip and open the downloaded Stormwater Data Management ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand Tasks and double-click the task item. 

6. In the Tasks pane, click the Explore the Data Management Solution task group to 
expand the collection of tasks. 

  Tip: 

  Click each group task heading and task to view a description at the bottom of the Tasks 
pane. 

  Each task group includes instructional steps for using the solution. Begin by exploring 
the contents of the project, tracing and editing workflows with sample data, or configuring 
the solution for your organization. 

 

Explore the Data Management Solution 
The data management solution is designed for organizations that want to experience a fully 

functional stormwater utility network. Explore common workflows with the sample data in the 

provided single user file utility network. Task-based workflows are also provided to create, and 

model your own utility network to behave like a stormwater system in an enterprise 

environment. The solution also provides preconfigured maps for sharing data and editing data. 

This task group includes the following tasks: 

• Overview 

• What's Included 

• Review the Data Model 

• Explore the Symbology and Data 

These tasks introduce the solution and walk through exploring the capabilities of the utility 

network. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://links.esri.com/StormwaterDataManagement/DataDictionary/v4


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 704 

 

Tracing and Analysis 
Tracing is a key capability of the utility network. There are several core trace configurations that 

allow you to analyze your network. 

This solution includes an downstream trace to identify all features that are downstream of the 
starting point stormwater network. 

This task group includes the following task: 

• Downstream Trace 

 

Editing Workflows 
Users are guided through editing workflows with the provided sample data. These workflows are 

designed to showcase common tasks while highlighting the capabilities of the utility network. 

Note: 

In the Contents pane, click the List by Snapping tab. Expand all feature classes to ensure 
snapping is checked for each asset group. 

This task group includes the following tasks: 

• Add Stormwater Manholes, Pipes, and Catch Basins 

• Add Best Management Practice (BMP) Area 

 

Installing Implementation Prerequisites 
After exploring the sample utility network, move on to building out a utility network for your own 

organization. Before getting started set up the environment with the necessary tools. 

This task group includes the following tasks: 

• Create a Python project environment 

• Install Utility Network Package Tools 

• Install Data Loading Tools 

 

Configure Data Model for Implementation 
The data model has been developed and curated over several years to reflect the latest 

capabilities of the utility network. This solution delivers the latest model which has been 

developed specifically to support stormwater utilities to best manage their assets in a digital 

environment. 

After exploring the solution, complete the following steps to remove the sample data and 
prepare the data model to manage your stormwater network. 

This task group includes the following tasks: 
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• Project and Remove Sample Data 

• Create Modification Tables (Optional) 

• Loading Data (Optional) 

 

Prototype in a Single User Environment 
Creating a utility network that fits your organization's needs requires a solid understanding of 

your data, as well as the provided date model. We recommend starting out with a prototype to 

explore with your own data and adjust where necessary. When ready, move on to setting up 

and implementing your solution in ArcGIS Enterprise. 

To learn more about the Attribute Rules included in the Stormwater Data Management project, 
review the Stormwater Data Management Attribute Rules document. 

A few notable attribute rules have been highlighted in the table below. These attribute rules 
have been designed to improve adding and editing manholes. These are disabled by default but 
can be enabled to take advantage of the described functionality. 

Name Description 

Line - Snap to Manhole 
batch 

When a pipe is snapped to a Manhole Channel, the pipe will be 
pulled back 2 ft. A Connection Point is added to the end of the 
pipe, contained in the Manhole, and associated by connectivity to 
the Manhole Channel. 

StructureJunction - Create 
Manhole Channel batch 

When a Sewer Storm Vault - Manhole is created, generate and 
contain a Manhole Channel. 

This task group includes the following tasks: 

• Create File Geodatabase with Schema 

• Adjust Attribute Rules 

• Update Maps' Data Sources 

• Reset Trace Location Feature Classes 

• Adjust Maps 

• Export Asset Package 

 

Deploy Solution to an Enterprise Environment 
These tasks are a guide to set up a utility network from start to finish. This includes creating an 

enterprise database, utility network, and sharing the final maps and services with your 

organization. 

This task group includes the following tasks: 

• Setup Enterprise Database 

• Create Utility Network 

• Apply Schema 

• Adjust Attribute Rules 

• Post Process 

• Publish Services 
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• Update Subnetworks 

• Update Maps Data Source to Feature Service 

• Publish Web Map 

• Reset Trace Location Feature Classes 

• Adjust Maps 

• Share with Organization 
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Target Hazard Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Target Hazard Analysis 
Target Hazard Analysis can be used to identify properties and buildings that could result in a 

loss of life, or have a negative impact on the community, if a fire were to occur. 

Many fire departments are taking proactive steps to assess risk and mitigate the impact of a fire 
in their community. The first step in this risk assessment is the identification of buildings or 
properties that may harm the community if a fire were to occur. Occupancy, size, life safety and 
economic impact are some of the criteria used to assess the risk of a building or property. 
Understanding risk can be a time consuming process and reducing the time it takes to conduct 
an assessment saves fire departments money. It also allows them to evaluate their community 
on a regular basis and measure the effectiveness of mitigation strategies. Target Hazard 
Analysis is typically implemented by fire departments that want to understand risk in their 
community and use the assessment to prioritize preplanning activities, fire inspections and other 
community risk activities. 

The Target Hazard Analysis solution delivers a set of capabilities that help you calculate a 
hazard score for each building or property and understand where a fire may negatively impact a 
community. 

 

Requirements 
Target Hazard Analysis requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.5 or later (Basic, Standard or Advanced) 

 

Information products 
Target Hazard Analysis includes the following information products. 

Item Description 
Minimum user 
type 

Target 
Hazard 
Analysis 

An ArcGIS Pro project package used by fire service personnel 
to identify properties and buildings that could result in a loss of 
life, or have a negative impact on the community, if a fire were 
to occur. 

GIS 
Professional 
Basic 
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When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 First release of Target Hazard Analysis 
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Use Target Hazard Analysis 
The Target Hazard Analysis solution delivers a set of capabilities to calculate a hazard score 

with user-defined criteria such as occupancy type, life safety, building size, economic impact, 

and fire flow requirements. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Understand hazard criteria 
Before using Target Hazard Analysis it is important to understand the criteria used, tools and 

tasks provided, and the data requirements. Gaining this understanding before you begin will 

help you use it effectively and produce target hazard results. To conduct a target hazard 

analysis, it is necessary to determine the evaluation criteria. The criteria are used to assess the 

potential impact of a fire on each building. The greater the potential impact, the greater the 

target hazard score. Certain attributes are required to perform a target hazard analysis of 

buildings or parcels. Information is provided to describe the minimum attributes you will need for 

each property. 

To learn more about the criteria contained in Target Hazard Analysis, follow these steps: 

1. Sign in to your ArcGIS organization and browse to the Target Hazard Analysis Desktop 
Application Template. 

2. Open the item page and click Download. 

3.  Unzip and open the Target Hazard Analysis ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Target Hazard 
Analysis task item. 

6. In the Task Pane, click the Getting started task group to expand the collection of tasks. 

 

Perform building analysis 
This workflow uses occupancy, life safety, floor area, height, fire flow, and economic impact to 

calculate a hazard score on all buildings. Choose this workflow when the minimum attribute 

information is available in your buildings layer. If some of the required attributes are in your 

parcels layer, you can transfer the required attributes from a parcel layer to a buildings layer as 

part of this workflow. 

You will assume the role of a fire fighter responsible for conducting a target hazard analysis on 
all buildings in your community. The Target Hazard Analysis ArcGIS Pro project includes a 
series of tasks to help guide you through this workflow. 

1. Open the Target Hazard Analysis ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Target Hazard 
Analysis task item. 

4. In the Task Pane, click the Perform target hazard analysis with buildings task group to 
expand the collection of tasks. 
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5. Click on each task and follow the steps provided. 

 

 

Perform parcel analysis 
This workflow uses occupancy, life safety, floor area, height, fire flow, and economic impact to 

calculate a hazard score on all parcels. Choose this workflow if you do not have building 

information and all of the necessary information is available in your parcel layer. 

You will assume the role of a fire fighter responsible for conducting a target hazard analysis on 
all parcels in your community. The Target Hazard Analysis ArcGIS Pro project includes a series 
of tasks to help guide you through this workflow. 

1. Open the Target Hazard Analysis ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Target Hazard 
Analysis task item. 

4. In the Task Pane, click the Perform target hazard analysis with parcels task group to 
expand the collection of tasks. 

5. Click on each task and follow the steps provided. 
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Tax Reverted Property 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Tax Reverted Property 
Tax Reverted Property can be used to collect delinquent tax property information and market 

properties available for sale to land development companies, real estate professionals, and the 

general public. 

It provides treasurer staff with a digital process that streamlines property posting and replaces 
newspaper-based tax sale processes that help in the recovery of back taxes, interest, and 
penalties. This approach helps government agencies more efficiently document delinquent 
property and return them to tax-producing ones. Tax Reverted Property is typically implemented 
by treasurer and tax collection agencies that want to improve the overall process for recovering 
property tax revenue. 

The Tax Reverted Property solution delivers a set of capabilities that help you improve the 
collection of delinquent property information, document tax-delinquent properties, and market 
properties during a property tax sale. 

 

Requirements 
Tax Reverted Property requires the following: 

• ArcGIS Enterprise 

 

Information products 
Tax Reverted Property includes the following information products: 

Item Description 
Minimum 
user type 

Tax Reverted 
Property 

A map used by treasurer's office staff to collect delinquent tax 
property information 

Editor 

Tax Reverted 
Property 
Dashboard 

An ArcGIS Dashboards app used by treasurer's office staff to 
monitor tax-reverted property field work 

Viewer 

Tax Sale An ArcGIS Web AppBuilder app used by the general public, 
land development companies, and real estate professionals 
to locate tax reverted properties sold at auction 

Not 
Required 
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When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Tax Reverted Property 
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Use Tax Reverted Property 
The Tax Reverted Property solution delivers a set of capabilities that help you improve the 

collection of delinquent property information, document tax-delinquent properties, and market 

properties during a property tax sale. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Collect and monitor tax-reverted properties 
Code Enforcement Operations can be used to collect delinquent property information, document 

tax-delinquent properties, and market properties during a property tax sale. 

 

Collect tax-reverted property information 
You will start by assuming the role of a treasurer staff member responsible for verifying a tax-

reverted property. You are asked to use Tax Reverted Property to visit a tax-delinquent property 

in the field and verify the details. 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Tap Tax Reverted Property to open the map. 

3. Search for an address, and then in the results list, tap the address to zoom to that location 
on the map. 

4. Tap the plus sign or tap Collect Here to open the survey form. 

  Note: 

  Your interface may vary depending on the type of mobile device that you use. 

5. Tap Not Posted or Posted as needed. 

6. Complete the survey with as much information as possible. 

7. Optionally, attach a property photograph. 

8. At the upper right, tap the check mark or tap Submit to submit the survey. 

 

Monitor a tax-reverted property posting 
Next, you will assume the role of a tax collection administrator responsible for reviewing the 

status of the tax-reverted property fieldwork. You are asked to use the Tax Reverted Property 

Dashboard app to monitor the collection and posting progress. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Tax Reverted 
Property solution. 

2. View the Tax Reverted Property Dashboard app. 
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  On the right, in the Delinquent Properties panel, all tax-delinquent properties are listed. 

3. Review the number of properties that have been posted. 

4. On the left, use filters to refine the results by status or date. 

5. Click a specific tax-delinquent property to review the parcel information, property 
information, and tax information. 

 

Find a property for sale 
Finally, you will assume the role of a real estate agent who wants to attend a property tax 

auction for the purposes of buying land. You use the Tax Sale app to find a property that fits the 

needs of your client. 

1. In a browser, from the Tax Reverted Property solution, view the Tax Sale app. 

2. Search for a parcel number or address. 

3. Click a specific property to review the property, structure, and tax information. 
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Traffic Crash Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Traffic Crash Analysis 
Traffic Crash Analysis can be used to analyze crash data and identify streets and intersections 

where concentrations of serious and fatal crashes occur. 

Safety is one of the most important factors to consider when evaluating a road network. 
Analyzing crashes that occur at intersections and along roadways to determine where a high 
percentage of serious injury and fatalities occur is a key aspect of the safety evaluation. The 
result of this analysis is generally referred to as a High Injury Network (HIN). It helps inform 
engineering, education, and enforcement decisions and also serves as the foundation for 
Complete Streets or Vision Zero initiatives adopted to reduce fatalities or serious injury on 
roadways in the community. Traffic Crash Analysis is typically implemented by transportation, 
public works, and public safety agencies that want to use data-driven strategies to improve 
safety along the transportation network. 

The Traffic Crash Analysis solution delivers a set of capabilities that help you to analyze crash 
data using methodologies defined by the United States Road Assessment Program (usRAP) 
and the Federal Highway Administration (FHWA), identify locations where concentrations of 
serious injury and fatal crashes occur, and share the results with decision makers and the 
public. 

 

Requirements 
Traffic Crash Analysis requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.5 or later (Advanced) 

 

Information products 
Traffic Crash Analysis includes the following information products: 

Item Description Minimum user type 

Crash Analysis An ArcGIS Pro project used by transportation, public 
works, and public safety staff to analyze crash data 
and identify streets and intersections where 
concentrations of serious and fatal crashes occur. 

GIS Professional Basic 
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Fatal and 
Serious Injury 
Dashboard 

An ArcGIS Experience Builder app used by the 
public and other interested stakeholders to locate 
traffic crashes that resulted in serious injury or 
fatality to motorists, cyclists, or pedestrians. 

Viewer (required if 
dashboard is used for 
internal purposes only) 

High Injury 
Network 
Locator 

A Nearby app used by the public and other 
interested stakeholders to locate streets and 
intersections where concentrations of serious and 
fatal traffic crashes occur. 

Viewer (required if app 
is used for internal 
purposes only) 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Traffic Crash Analysis 
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Configure Traffic Crash Analysis 
In this topic, you will learn how to configure the Traffic Crash Analysis solution to meet specific 

needs in your organization. 

Load traffic crashes 
The Fatal and Serious Injury Dashboard can be used to share locations of traffic crashes that 

resulted in serious injury or fatality to motorists, cyclists, or pedestrians. The dashboard also 

provides insights into the times of day, days of week, and months of year when these crashes 

occur more frequently. 

To load your traffic crashes from a spreadsheet, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the TrafficCrashesSource.csv item. 

2. Open the item page and click Download. 

3. Edit the .csv file and provide your traffic crash information. 

  Note: 

  The crash_date field should be formatted with times expressed using a 24-hour clock: 
12/31/2020 22:30:00. 

4. In your ArcGIS organization, browse to the TrafficCrashes feature layer. 

5. Open the item page and click Update Data > Append Data to layer. 

6. Click Choose File and browse to your .csv file, and click OK. 

7. Click Upload and Continue. 

8. Uncheck Update existing features. 

9. Click Show field matching to map the fields. 

10. Click Apply Updates. 

 

Update crash date, month, day, and hour attributes 
When dates are loaded into hosted feature layers, it is assumed the dates are in Coordinated 

Universal Time (UTC). Those times are then displayed in the local time of the browser, which 

can cause them to be offset from the original time of the crash. This can be resolved in the 

attributes by calculating the offset. In addition, the Day, Month, and Hour fields used in the Fatal 

and Serious Injury Dashboard charts can be calculated from the crash date. 

To update the Crash Date, Day, Month, and Hour fields, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the TrafficCrashes 
feature layer. 

2. Open the item page and click the Data tab. 

3. If you need to offset the crash time to account for UTC, complete the steps below; 
otherwise, skip to step 9. 

4. Click the Date of Crash column. 

5. Click Calculate. 

6. On the Calculate Field dialog box, choose Arcade. 

7. Enter the following expression: ToUTC($feature.crash_date). 
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8. Click OK. 

9. Click the Day column. 

10. Click Calculate. 

11. On the Calculate Field dialog box, choose Arcade. 

12. Enter the following expression: Weekday($feature.crash_date). 

13. Click OK. 

14. Click the Month column. 

15. Click Calculate. 

16. On the Calculate Field dialog box, choose Arcade. 

17. Enter the following expression: Month($feature.crash_date) + 1. 

  Note: 

  In Arcade, January is returned as 0 and December is 11. You are adding it to express 
the months as 1-12. 

18. Click OK. 

19. Click the Hour column. 

20. Click Calculate. 

21. On the Calculate Field dialog box, choose Arcade. 

22. Enter the following expression: Hour($feature.crash_date). 

23. Click OK. 

 

Load high injury network 
A high percentage of serious injury and fatal crashes involving motorists, cyclists, and 

pedestrians often occur on a small percentage of streets and intersections. These streets and 

intersections are often referred to as the High Injury Network (HIN). The Crash Analysis ArcGIS 

Pro project can be used to analyze crash data along the transportation network to the streets 

and intersections that have the highest frequency of crashes. The results of this analysis can be 

loaded into the High Injury Network Locator and be shared with the public and other 

stakeholders. 

To load your High Injury Network, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Crash Analysis 
Desktop Application Template. 

2. Open the item page and click Download. 

3. Unzip and open the Crash Analysis ArcGIS Pro project. 

4. On the View tab, in the Windows group, click CatalogPane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Crash Analysis task. 

6. In the Tasks pane, click the How to Use Crash Analysis task group to expand the 
collection of tasks. 

7. Double-click the Analyze crashes with FHWA network screening task and follow the 
steps provided. 
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usRAP data prerequisites 
The United States Road Assessment Program (usRAP) protocol defines how roads should be 

segmented to analyze risk. Road networks are divided into segments with breakpoints at 

locations where the following things occur: 

• A route begins or ends. 

• The county name changes. 

• There is discontinuity in the route, such as a gap in mileposts. 

• The roadway type changes. 

• The annual average daily traffic (AADT) changes by 20 percent or more. 

• The speed limit category changes. 

The usRAP tools use a series of input feature classes and fields on those feature classes to 

create basic road segments. Verify your data meets the tools parameter requirements below 

before using the usRAP tools. 

Feature class Description Required fields 

CrashLocations Locations of crashes. crashyear: The 4-digit year the 
crash occurred, for example, 
2020. 

routename: The name of the 
route on which the crash 
occurred. 

Routes Baseline routes. routename: Name of the route. 

routetype: Type of the route. 

CountyBoundary County features. countyname: Name of the 
county. 

AccessControl Road segments with access control 
information. 

accesscontrol: Type of access 
control to segment. This field 
should have a domain applied 
with the following options: 

Full Access Control 

Partial Access Control 

No Access Control 

Medians Road segments with median information. mediantype: Type of median of 
the segment. This field should 
have a domain applied with the 
following options: 

Undivided Roadway 

Divided Roadway 
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TravelLanes Road segments with number of travel lanes. totallanes: Number of lanes for 
the segment. 

AreaType Road segments with the type of area. areatype: Type of area for the 
segment. This field should 
have a domain applied with the 
following options: 

Urban 

Rural 

SpeedLimit Road segments with the speed limit. speedlimit: The speed limit of 
the segment. 

AADT Road segments with the annual average 
daily traffic (AADT) values. Each year 
should be stored as a separate feature 
class (for example, AADT_2020) and you 
can include up to five years in the analysis. 

aadt: The annual average daily 
traffic of the segment. 
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Use Traffic Crash Analysis 
The Traffic Crash Analysis solution delivers a set of capabilities that help you to analyze crash 

data using methodologies defined by the United States Road Assessment Program (usRAP) 

and the Federal Highway Administration (FHWA), identify locations where concentrations of 

serious injury and fatal crashes occur, and share the results with decision makers and the 

public. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Analyze traffic crashes 
The Crash Analysis ArcGIS Pro project helps public works, public safety, and transportation 

staff analyze crash data along roadways and at intersections. The project provides tasks and 

tools that allow you to perform this analysis using two methodologies. You will assume the role 

of transportation analyst responsible for analyzing crash data to identify roadways that have a 

higher risk of traffic crashes. 

 

United States Road Assessment Program (usRAP) protocol 
usRAP uses a risk-mapping protocol to create maps that show variations in the level of crash 

risk across a road network. These maps can guide the prioritization of highway infrastructure 

improvements and targeted enforcement strategies. The tasks and tools will guide you through 

performing the analysis according to the usRAP protocol. 

• Create roadway segments. 

• Assign crashes. 

• Create risk maps. 

The advantage of this methodology is that it uses roadway and traffic control feature data to 

assess risk and can better account for rural areas with lower traffic volumes or limited or 

unreliable crash data. The usRAP tools use a series of input feature classes and fields on those 

feature classes to create basic road segments. Confirm that your data meets the tools 

parameter requirements below before using the usRAP tools. 

To analyze crash data using the usRAP protocol, complete the following steps: 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Traffic Crash 
Analysis solution. 

2. Download the Crash Analysis desktop application template and unzip the folder. 

3. From the unzipped folder, open Crash Analysis.aprx in ArcGIS Pro. 

4. In ArcGIS Pro, in the Catalog pane, expand Tasks, and then double-click the Crash 
Analysis task. 
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  Note: 

  If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, expand the How to Use Crash Analysis task group to see the 
collection of tasks. 

6. Double-click the Analyze crashes with usRAP protocol task and follow the steps 
provided. 

 

Federal Highway Administration (FHWA) network screening 
Network screening is the process of studying safety conditions on an entire road network or a 

subset of the network. While there are a variety of methods available to conduct network 

screening, three are included in the Crash Analysis project: 

• Crash Frequency 

• Crash Rate 

• Equivalent Property Damage Only 

The advantage of this tool is that it only requires the location of crashes and streets or 

intersections to calculate a crash frequency. Optionally, traffic volume expressed as an average 

daily traffic volume or the severity of the crash can be used to calculate the crash rate and 

equivalent property damage only, respectively. 

To analyze crash data using the FHWA network screening, complete the following steps: 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Traffic Crash 
Analysis solution. 

2. Download the Crash Analysis desktop application template and unzip the folder. 

3. From the unzipped folder, open Crash Analysis.aprx in ArcGIS Pro. 

4. In ArcGIS Pro, in the Catalog pane, expand Tasks, and then double-click the Crash 
Analysis task. 

  Note: 

  If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, expand the How to Use Crash Analysis task group to see the 
collection of tasks. 

6. Double-click the Analyze crashes with FHWA network screening task and follow the 
steps provided. 

 

Visualize fatal and serious injury crashes 
Now you will assume the role of a resident who commutes daily to work by bike. You want to 

see where fatal and severe injury crashes involving cyclists have occurred in the community and 

the times of day they most often occur. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 724 

1. In a browser, from the Traffic Crash Analysis solution, view the Fatal and Serious Injury 
Dashboard app. 

  The dashboard displays traffic crashes by mode, severity, and date. An accident may 
involve multiple parties and modes of transportation; in those cases, the most vulnerable 
mode of transportation is used for the mode. For example, if a motorist and bicyclist are 
involved in an accident, click the Mode drop-down arrow and choose Bicyclist. Similarly, 
the highest severity is associated with the accident. For example, if a car accident results in 
one fatality and three non-incapacitating injuries, click the Severity drop-down arrow and 
choose Fatality. 

2. In the left panel, use the filters to refine results by Mode, Severity, and Date Range. 

  The charts below and to the right of the map are linked, so as you click a bar in one chart, 
related details are filtered and updated in other charts and in the map. This feature can be 
helpful in looking for trends in crashes, both spatially and by time of day, week, and year. 

3. Use the graphs to filter traffic crashes by Hour of Day, Day of Week, and Month of Year. 

 

Locate high-risk streets and intersections 
You will continue your role of a resident in the community and want to learn what streets and 

intersections along your daily commute have a higher risk of traffic crashes. 

1. In a browser, from the Traffic Crash Analysis solution, view the High Injury Network Locator 
app. 

  The app displays the streets and intersections where concentrations of serious and fatal 
traffic crashes have occurred. 

2. To set a location to be buffered, type an address in the search bar and press Enter or click 
a location on the map. 

3.  Optionally, move the slider to increase or decrease the buffer distance. 

4. Expand Intersections or Streets to see details about the number of crashes per mile and 
per million vehicle miles. 
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Transit Outreach 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Transit Outreach 
Transit Outreach can be used to share information about planned service changes and solicit 

feedback from riders and the general public on their experience with public transit. 

It provides 24/7 access to an organization, and the location-enabled reports help efficiently 
triage reports to the correct person or department responsible for their resolution. Through 
effective public engagement, transit agencies identify and understand the needs of the 
community as a whole and incorporate those needs into transportation plans and programs. 
Transit Outreach is typically implemented by transit agencies that want to become more 
transparent and responsive and ultimately provide better transit service. 

The Transit Outreach solution delivers a set of capabilities that help you solicit feedback from 
riders, manage the transit agency's response, share information about upcoming service 
changes, and allow the public to provide feedback on proposed changes. 

 

Requirements 
Transit Outreach requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.5 or later (Basic, Standard, or Advanced) 

 

Information products 
Transit Outreach includes the following information products: 

Item Description 
Minimum user 
type 

Transit Service 
Change 

A Crowdsource Polling app used by the general public to 
obtain information about planned service changes and, 
optionally, comment on proposed changes 

Not required 

Transit Rider 
Reporter 

An ArcGIS Survey123 form used by the general public to 
submit compliments, problems, questions, and 
suggestions related to their experience on public transit 

Not required 

Transit Rider 
Reporter Manager 

A Crowdsource Manager app used by transit staff to 
triage rider feedback and update the status of each report 

Editor 
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Transit Rider 
Reporter 
Dashboard 

An ArcGIS Dashboards app used by transit staff to 
monitor feedback submitted by the general public 

Viewer 

Transit Data 
Management 

An ArcGIS Pro project used by transit staff to convert a 
GTFS public transit dataset to route and stop features 
and manage service change communication 

GIS 
Professional 
Basic 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Transit Outreach 

 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 727 

Configure Transit Outreach 
In this topic, you will learn how to configure the Transit Outreach solution to meet specific needs 

in your organization. 

Load transit system 
The Transit Outreach solution includes an ArcGIS Pro project used to convert your GTFS public 

transit dataset to route and stop features that are used as base layers in the maps and apps 

included in the solution. 

To load your transit routes and stops in the solution, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the Transit Data Management Project 
Package. 

2. Open the item page and click Download. 

3. Start the ArcGIS Pro application and open the Transit Data Management project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Transit Data 
Management task. 

6. In the Tasks pane, click the How to Use Transit Data Management task group to expand 
the collection of tasks. 

7. Double-click the Load transit routes and stops task and follow the steps provided. 

 

Manage service change commenting 
Some transit agencies offer riders the ability to provide their feedback on proposed service 

changes before they are implemented. This information is used by the transit agency to help 

decide if they should move forward with the change. 

The Transit Service Change app allows riders to view upcoming service changes and by default 
allows riders to add a comment on the change. Transit agencies can also control when the 
commenting period is open or closed or disable commenting completely. 

 

Close commenting period 
To close the commenting period, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Transit Service 
Change app. 

2. Open the item page and click Configure App. 

3. Click the Options tab. 

4. Under Feedback period, click Feedback period closed and provide an appropriate 
window title and message in the Feedback period closed window title text box. 

5. Click Save to save the app configuration. 

6. Click Close. 
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Disable comments 
To disable comments, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Transit Service 
Change app. 

2. Open the item page and click Open in Map Viewer. 

3. Click Details and click the Contents button. 

4. On the Comments layer, click More Options and click Remove. 

5. Click Yes, remove table. 

6. Click Save. 

 

Add route name pick list 
The Transit Rider Reporter survey can be used by the public to submit compliments, problems, 

questions, and suggestions related to their experience on public transit. Adding accurate names 

to the routes pick list ensures data consistency and ensures that Transit Rider Reporter 

functions properly with other apps included in the Transit Outreach solution. 

To add your list of route names to the pick list, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Transit Rider Reporter to download the survey. 

4. In the Download window, click Download and click OK. 

5. Click Transit Rider Reporter again to open the survey. 

6. In the XLSForm Modified window, click Yes. 

7.  On the side toolbar, click the Open XLSForm Spreadsheet button. 

8. In the Microsoft Excel spreadsheet, click the choices tab. This tab comprises all the 
selectable options for survey questions. 

9. Update the name and label for routes with your route names. Add additional route names 
and rows as needed, and if necessary, delete all placeholder information. 

  The choices tab includes Rail, Streetcar, and Bus route types. This allows the Transit 
Rider Reporter to present the appropriate pick list based on the rider's category selection. 

10. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

11. In ArcGIS Survey123 Connect, click Publish on the side toolbar. 

12. Click Publish survey to publish your changes and click OK. 
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Use Transit Outreach 
The Transit Outreach solution delivers a set of capabilities that help you solicit feedback from 

riders, manage the transit agency's response, share information about upcoming service 

changes, and allow the public to provide feedback on proposed changes. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

View service changes 
First, you’ll assume the role of a transit rider. You use the same transit routes on your daily 

commute. You will use the Transit Service Change app to learn about upcoming changes to 

service and how it may impact your commute. 

1. In a browser, from the Transit Outreach solution, view the Transit Service Change app. 

  All routes are listed in the panel on the right. They are also marked on the map. 

2. Click a route in the list or on the map. 

3. Review the details about when the service change is effective, how it will impact riders, and 
why the change is being made. 

  The Transit Service Change app can also be used by riders to comment on proposed 
changes. 

4. On the right, at the bottom of the route details, click the Add a comment button. 

5. Provide your name, address, and comments. 

6. Click Submit. 

 

Manage service changes 
Next, you’ll assume the role of a transit mapping technician who manages service change 

communication. You will use the Transit Data Management project to manage the routes and 

service change details visible to the public in the Transit Service Change app. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Transit Outreach 
solution. 

2. Download the Transit Data Management project package. 

3. Open the Transit Data Management project in ArcGIS Pro. 

4. In the Catalog pane, expand the Tasks folder, and double-click the Transit Data 
Management task. 

  Note: 
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  If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, expand the How to Use Transit Data Management task group to see 
the collection of tasks. 

6. Double-click Manage transit service changes task and follow the steps provided. 

 

Submit rider feedback 
Now, you’ll assume the role of a transit rider. While riding a bus, you noticed a problem and 

want to report it to the transit agency. You will use Transit Rider Reporter to submit feedback. 

1. In a browser, from the Transit Outreach solution, view the Transit Rider Reporter app. 

2. For I would like to, choose the reason that you are submitting the survey. 

3. For Related to, choose the response that best describes what your report is about. 

  Depending on the category selected, additional questions appear. For example, clicking 
Bus adds questions about the route and vehicle number. 

4. Answer any additional questions, if necessary. 

5. For Details, type additional information about the issue. 

6. For When did it occur, choose the date and time that you made your observation. 

7. For Where did it occur, search for the address and press Enter. 

8. In the Contact Information section, choose the type of response that you want. 

  Tip: 

  To submit feedback anonymously, choose No, for your information only. 

9. Click Submit. 

 

Manage rider reports 
You will now assume the role of a transit agency employee who monitors customer feedback. 

You will use Transit Rider Reporter Manager to view and manage rider feedback. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Transit Outreach 
solution. 

2. View the Transit Rider Reporter Manager app. 

  All reports are listed in the table at the top. The table can be sorted and filtered in various 
ways. 

3. In the table, use the column header filters and arrows to filter results. 

4. From the table, select a report with a status of Submitted. 

  The report details open at the lower left, and the map zooms to the report's location. 

5. After reviewing the details, you decide to assign the report for follow-up. 

6. In the report details, click the Edit Record button . 

7. Click the Assigned To drop-down arrow and choose a group. 
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8. Change the status to In Progress. 

9. Optionally, to add comments to the rider report, click the Comments tab, and then click 
Add Record. 

10. Click Save. 

  In the table, the record's status updates to In Progress. On the map, the symbol also 
changes. 

  You have received a message from the group that you assigned the report to. The 
message states that the rider report has been communicated to the appropriate team and 
the report can be closed. 

11. If necessary, in the table, click the report. 

12. In the report details, click the Edit Record button. 

13. Change the status to Completed. 

14. Click Resolved On and choose a date. 

15. Optionally, for Resolution, type details about how the report was resolved. 

16. Click Save. 

  In the table, the record's status updates to Completed. On the map, the symbol also 
changes. 

   

Monitor rider reports 
As rider reports are submitted, resolved, and closed, you are interested in noting trends and the 

overall feedback received. You will continue your role as a transit agency employee, this time 

looking to gain insight into the feedback received through the Transit Rider Reporter app. You 

will use Transit Rider Reporter Dashboard to view feedback and key metrics. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Transit Outreach 
solution. 

2. View the Transit Rider Reporter Dashboard app. 

  The Transit Rider Reporter Dashboard app opens with the Overview tab active. 

  The Overview tab displays infographics of categories of reports. This information gives 
management a quick overview of the number of reports submitted by the public. 

3. Click the Rider Reports tab. 

  The Rider Reports tab allows a transit manager to monitor their department's progress 
with responding to reports. The tab displays the top problem types and categories and 
summarizes reports by month with details. 

  Charts are linked, so when you click a category in one chart, related charts and lists are 
filtered and updated to allow a manager to identify issues and areas that need attention. 

4. On the left side of the app, click the arrow to display the side panel.  

  Tip: 

  To pin the side panel to the dashboard, click the pin in the upper right. 

  The side panel allows you to apply several survey and feedback filters. You can filter by 
Report Type, Submission Date, Occurrence Date, and Route. 
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Transit Safety 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Transit Safety 
Transit Safety can be used to document safety issues and manage corrective actions or 

mitigation activities. 

Each transit ride must be carefully executed to ensure the safety, security, and timeliness of 
service. Safety is the highest priority for transit agencies. Even with the best foresight, 
unexpected events can occur. The Federal Transit Administration (FTA) recently adopted the 
practice of safety management systems (SMS) to improve transit safety. Implementing an SMS 
helps transit agencies continuously improve system safety. Rapid data collection and high-
quality reporting can lead to process improvements across organizations. Visualizing this data 
over time allows transit agencies to identify trends and implement changes that address safety 
issues. Transit Safety is typically implemented by transit agencies that want to adopt an SMS to 
improve transit services and save lives. 

The Transit Safety solution delivers a set of capabilities that help you document events 
(accidents, incidents, and occurrences), report hazards, create work assignments, dispatch field 
staff for mitigation activities, and monitor the status of safety events and hazards across the 
transit system. 

 

Requirements 
Transit Safety requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.5 or later (Basic, Standard, or Advanced) 

• ArcGIS Field Maps 

• ArcGIS Workforce 

 

Information products 
Transit Safety includes the following information products: 

Item Description 
Minimum user 
type 
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Transit Event 
Reporter 

AnArcGIS Survey123 form used by transit safety staff to 
document the initial event report of an accident, incident, 
or occurrence. 

Editor 

Transit Hazard 
Reporter 

An ArcGIS Survey123 form used by the general public or 
transit staff to report a safety hazard issue. 

Editor (required 
for transit staff 
only) 

Transit Safety 
Manager 

A Crowdsource Manager app used by transit safety staff to 
manage safety event investigations and hazard risk 
assessments and mitigation. 

Editor 

Transit Safety 
Dashboard 

An ArcGIS Dashboards app used by transit safety staff to 
monitor events and hazards across the transit system. 

Viewer 

Transit 
Mitigation 
Assignments 

An ArcGIS Workforce Classic project used by transit staff 
to manage mitigation activities in the field and track the 
resolution of each. Field users access the Transit 
Mitigation Assignments project using the ArcGIS 
Workforce mobile app. 

Field Worker 

Transit Field 
Mitigations 

An ArcGIS Field Maps map used by transit staff to update 
the status of a mitigation activity while in the field. 

Field Worker 

Transit Data 
Management 

An ArcGIS Pro project used by transit staff to convert a 
GTFS public transit dataset to route and stop features and 
manage service change communication. 

GIS Professional 
Basic 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Transit Safety 
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Configure Transit Safety 
In this topic, you will learn how to configure the Transit Safety solution to meet specific needs in 

your organization. 

Load transit routes and stops 
The Transit Safety solution includes an ArcGIS Pro project that is used to convert your GTFS 

public transit dataset to route and stop features that are used as base layers in the maps and 

apps included in the solution. 

To load your transit routes and stops in the solution, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the Transit Data Management Project 
Package. 

2. Open the item page and click Download. 

3. Start the ArcGIS Pro application and open the Transit Data Management project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Transit Data 
Management task. 

6. In the Tasks pane, click the How to Use Transit Data Management task group to expand 
the collection of tasks. 

7. Double-click Load transit routes and stops task and follow the steps provided. 
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Use Transit Safety 
The Transit Safety solution delivers a set of capabilities that help you document events 

(accidents, incidents, and occurrences), report hazards, create work assignments, dispatch field 

staff for mitigation activities, and monitor the status of safety events and hazards across the 

transit system. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Report safety events 
You’ll assume the role of safety manager. You just received information about an incident that 

occurred on one of your rail lines. You will use Transit Event Reporter to add the safety event 

and send a report to the state oversight committee. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Transit Safety 
solution. 

2. View the Transit Safety Manager app. 

3. Click the Help button  in the upper right corner of the app. 

4. Click the Input New Event button. 

5. In the Transit Event Reporter survey, fill in the following details: 

– For Location, click the map. 

– For Date of event, choose a date and time. 

– For Date of report, choose a date and time. 

– Click the Event Type drop-down arrow and choose Incident. 

– Type INCI-587 in the Event ID text box. 

– Click the Mode drop-down arrow and choose Tram, Light Rail, Streetcar. 

– Type OID-43 in the Operator text box. 

– Type 3001 in the Vehicle ID text box. 

– Type 1 in the Number injured text box. 

– Type the following in the Initial summary text box: An 83-year-old female fell 
shortly after departure of the transit vehicle. The fall was 
initiated by the sudden movement of the vehicle after it left the 
station. 

6. Click Submit. 

 

Manage safety events 
You’ll assume the role of safety manager. You have just received a new event report and need 

to send the report to the state and follow the event throughout the investigation period. 
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1. In a browser, sign in to your ArcGIS organization, and then browse to the Transit Safety 
solution. 

2. View the Transit Safety Manager app. 

3. In the left panel, click the Events map. 

4. Click the event you reported in the previous section. 

  The event details appear under the table. You have determined that this event requires 
sending information to the transit oversight committee. 

5. On the Details tab, click the Email Event Report button. 

  An email opens with the specific event details. Fill in an email address and any other 
important details. You can send the email to the necessary recipients. 

6. Return to the Transit Safety Manager app. 

  You will now update the status of the report. After a week, new details about the event 
become available. You will add these details to the report. 

7. On the Details tab, click the Edit button . 

8. Fill in the following details: 

– Click the Status drop-down arrow and choose Continued Investigation. 

– Type One light rail car in the Involved Vehicles text box. 

– Click the Weather drop-down arrow and choose Sunny. 

– Type 58 in the Temperature text box. 

– Type 0 in the Damage Estimate text box. 

– Click the D&A Testing drop-down arrow and choose No. 

9. Click Save. 

  After some time, you are now ready to complete the investigation and decide on a probable 
cause. 

10. Click the Edit button. 

11. Fill in the following details: 

– Click the Status drop-down arrow and choose Final Report. 

– Click the Probable Cause drop-down arrow and choose Slips and Falls. 

– Type fall during initial acceleration of light rail in the Detailed 

Probable Cause text box. 

– Click the Preventable drop-down arrow and choose No. 

12. Click Save. 

13. On the Details tab, click the Print Final Report button to view the sample result. 

14. Click the Edit button. 

15. Fill in the following details: 

– Click the Status drop-down arrow and choose Event Closed. 

– For Date Closed, choose the current date. 

16. Click Save. 

 

Report safety hazards 
You’ll assume the role of a transit agency employee. You need to report a hazard that you found 

at a bus stop. You will use Transit Hazard Reporter to add the safety hazard. 
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1. In a browser, sign in to your ArcGIS organization, and then browse to the Transit Safety 
solution. 

2. View the Transit Hazard Reporter survey. 

3. Fill in the following details: 

– For Location, click the map. 

– For Date of hazard, select a date and time. 

– Click the Hazard type drop-down arrow and choose Unsafe Conditions. 

– Type There is ice at the bus stop in the Descriptions text box. 

– Click Select image file to upload a photo. 

– For Would you like to report anonymously, click No. 

– For Identity, click Contractor. 

– Type your name in the Name text box. 

– Type your email in the Email text box. 

– Type your phone number in the Phone text box. 

4. Click Submit. 

 

Manage safety hazards 
You will now assume the role of a transit safety manager. You need to mitigate all hazards that 

relate to your transit system. You will access the risk of the hazard, assign mitigation activities, 

and submit a final risk assessment for the hazard. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Transit Safety 
solution. 

2. View the Transit Safety Manager app. 

3. In the left panel, click the Hazards map. 

4. Click the hazard you reported in the previous section. 

  The hazard details appear under the table. 

5. On the Details tab, click the Edit button . 

6. Fill in the following details: 

– Type HAZ-123 in the Hazard ID text box. 

– Click the Risk Score Pre-Mitigation drop-down arrow and choose 3E. 

– Click the Risk Value (pre) drop-down arrow and choose Medium. 

– Type your name in the Risk Assessor (pre) text box. 

  Note: 

  The risk values and score are modeled on the Mil Standard 882E. Assign both a 
score and a value to complete the risk assessment. 

7. Click Save. 

  The risk score premitigation is now populated with a visual representation of your risk 
score. You have determined that mitigation is necessary for this risk. You will now add 
related mitigation activities to the hazard. 

8. Click the Related Information tab. 
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9. Click Add Record. 

10. Fill in the following details: 

– Click the Mitigation Type drop-down arrow and choose Maintenance. 

– Type Facilities - Bus Stops in the Manager Responsible text box. 

– Type Apply salt to bus stop to remove ice in the Details text box. 

11. Click Save. 

  Now that you have created mitigation assignments, you will update the status of your 
hazard. 

12. Click the Details tab. 

13. Click the Edit button. 

14. Click the Status drop-down arrow and choose Mitigation in progress. 

15. Click Save. 

16. Assign field staff to complete mitigation activities. 

  Note: 

  Use the Create Work Assignment button to launch a workforce app where you can 
assign field activities. Field staff can then use the Transit Mitigation Assignments 
ArcGIS Workforce Classic project to manage their work assignments and the Transit 
Field Mitigations ArcGIS Collector map to update the action taken and close the 
mitigation activity. 

  Update the hazard status to reflect that the fieldwork for this mitigation is complete. 

17. Click the Related Information tab. 

18. Click the Edit button. 

19. Fill in the following details: 

– Click the Status drop-down arrow and choose Closed. 

– Type Salt applied and ice removed in the Action Taken text box. 

– For Date Complete, choose the current date. 

20. Click Save. 

  You will now close the hazard. 

21. Click the Details tab. 

22. Click the Edit button. 

23. Fill in the following details: 

– Click the Status drop-down menu and choose Closed. 

– Click the Risk Score Post-Mitigation drop-down arrow and choose 4C. 

– Click the Risk Value (post) drop-down arrow and choose Low. 

– Type your name in the Risk Assessor (Post) text box. 

– For Date Closed, choose the current date. 

24. Click Save. 
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Monitor safety performance 
You are the Transit Safety manager interested in understanding the performance of your Safety 

Management Program and searching for areas of improvement. You will view the status of the 

program and then look in detail at both hazards and events. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Transit Safety 
solution. 

2. View the Transit Safety Dashboard app. 

  The Transit Safety Dashboard opens with the Overview tab active. 

  The Overview tab displays infographics of events and hazards. This information gives 
management a quick overview of the number of events and hazards in the last 90 days and 
their performance relative to the previous 90 days. 

3. Click the Events tab. 

  The Events tab allows a safety manager to monitor how their department is doing when it 
comes to investigating events. 

  In the report, charts are linked. As you click and select a category in one chart, related 
details are filtered and updated in other charts on the report to allow a manager to identify 
issues and areas that need attention. 

4. Click the Hazards tab. 

  The Hazards tab allows a safety manager to monitor how their department is doing when it 
comes to assessing and mitigating hazards. 

  In the report, charts are linked. As you click and select a category in one chart, related 
details are filtered and updated in other charts on the report to allow a manager to identify 
issues and areas that need attention. 

5. Click the arrow on the left side of the app to display the side panel. You can pin the side 
panel to the dashboard by clicking the pin in the upper right corner. 

  The side panel allows you to apply several event and hazard filters. You can filter by 
Occurrence Date, Event Type, Event Mode, and Hazard Type by clicking the drop-down 
and choosing a filter. 
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Transportation 511 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Transportation 511 
Transportation 511 can be used to share road conditions and closures that may impact travel 

throughout a community or state. 

Established in July 2000 by the Federal Communications Commission, 511 is the nationally 
designated, three-digit telephone number for traveler information. 511 provides a simple number 
travelers can use to access road and traffic information from within the jurisdiction they are 
traveling. Many 511 systems now include a map-based application that includes real-time 
incident and weather information. The application provides 24/7 access to critical information, 
and the location-enabled search allows travelers to quickly find traffic incidents, travel 
restrictions, road conditions, closures, live traffic camera feeds, and other transportation 
information. Transportation 511 is typically implemented by public works or transportation 
agencies that want to provide the public with current road conditions and traffic information. 

The Transportation 511 solution delivers a set of capabilities that help you import critical 
information from your incident management system and share roadway information with the 
public so they can make informed decisions before they travel. 

 

Requirements 
Transportation 511 requires the following: 

• ArcGIS Enterprise 

 

Information products 
Transportation 511 includes the following information products: 

Item Description 
Minimum 
user type 

Transportation 
511 

An ArcGIS Web AppBuilder for the general public to understand 
roadway conditions and closures that may impact travel 
throughout a state. 

Not required 

Overwrite 
Features 

A Python script and sample file geodatabase that you can 
schedule to update the Transportation 511 app with real-time 
traffic and roadway condition information. 

Creator 
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When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Transportation 511 
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Configure Transportation 511 
In this topic, you will learn how to configure the Transportation 511 solution to meet specific 

needs in your organization. 

Add a real-time traffic layer 
Add additional context to your Transportation 511 app by including World Traffic Service from 

ArcGIS Living Atlas. Part of a larger collection of Esri curated content, World Traffic Service 

presents historical and near real-time traffic information for different regions of the world. This 

dynamic traffic map service is updated every 5 minutes, includes traffic incidents and provides 

visualizations for different traffic speeds relative to the free flow of traffic. 

Note: 

World Traffic Service is licensed under the Esri Master License Agreement and is exclusive 
content for Esri subscribers. Use of this service requires an ArcGIS Online organization 
subscription or an ArcGIS developer account. ArcGIS Living Atlas subscriber content does 
not consume ArcGIS Online credits. See Configure Living Atlas content to enable access 
subscriber content. 

 

Configure map 
To leverage Esri’s World Traffic Service in your Transportation 511 app, you first must add the 

service to your map. 

1. Sign in to your ArcGIS organization and browse to the Transportation 511 map. 

2. Open the item page and click Open in Map Viewer. 

3. Click Add > Browse Living Atlas Layers. 

4. Type traffic in the search text box. 

5. Click the Add button  World Traffic Service to add it to the map. 

  Tip: 

  You may determine you do not want to display the Traffic Incidents layers from World 
Traffic Service as this is already a layer you will provide. Before proceeding to the next 
step, click the Back button and in the Contents pane, expand the World Traffic Service 
group layer. Uncheck the North America Traffic Incidents (or your region if outside North 
America) layer group to ensure these layers are not visible in the Transportation 511 
app. 

6. Click Save. 

 

Configure the app 
Once the World Traffic Service layer is added to your map, additional steps are needed to 

configure the service to properly display in your Transportation 511 app. 
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Configure World Traffic Service Incidents with the Road Conditions widget 

Optionally, you can display traffic incidents from World Traffic Service in the Transportation 511 

app the same way as Road Condition layers are displayed from your feature collection. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Transportation 
511 app. 

2. Open the item page and click Edit Application. 

3. Click the Widget tab. 

4. Click Set the widgets in this controller. 

5. Hover over the Road Conditions widget and then click the Configure this widget button 

. 

6. Click Add Layer three times. 

  Each time you click Add Layer, the following layers are added to the Road Conditions 
widget: Traffic Incidents Overview, Traffic Incidents Intermediate, and Traffic Incidents 
Detailed. 

  Note: 

  The World Traffic Service Traffic Incident layers are scale dependent. If you want your 
app to display Traffic Incident information and counts at all scales, you must add all three 
layers to the Road Conditions widget configuration. 

7. Provide a label for each of the layers added, for example: World Traffic Service Incidents. 

8. Click OK. 

9. Click Save. 

 

Troubleshoot Overwrite Hosted Features script errors 
The table below describes common errors that can occur when running the Overwrite Hosted 

Features script and how to resolve each. 

Script error Resolution 

Unable to find feature 
service with ID: {ID} 

Verify the Item ID for your feature service and the baseURL entered 
for your ArcGIS organization. 

Unable to find feature 
collection with ID: {ID} 

Verify the Item ID for your feature collection and the baseURL 
entered for your ArcGIS organization. 

File GDB: {path to 
zipped file geodatabase} 
could not be found 

Verify the path and file name for your zipped file geodatabase. 

Cannot add the item Verify that the user name used in the configuration does not already 
own a file geodatabase item with the same name as input to the 
fgdb parameter. 

IOError: [Errno 2] No 
such file or directory: 
{Log File Path} 

Verify that the script can write to the file path location configured for 
the log. 
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Error Processing table 
data – check file format, 
supported data types 
and data license 

Verify that each layer in the feature service has an associated 
feature class in the geodatabase and that the published feature 
service and zipped file geodatabase contain the same number of 
layers. 

URLOpen Error 
[Errno11001] getaddrinfo 
failed URLOpen Error 
[Errno11004] getaddrinfo 
failed 

Verify that baseURL parameter contains a forward slash at the end 
of the address, for example, 
http://myorganization.maps.arcgis.com/. 
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Use Transportation 511 
The Transportation 511 solution delivers a set of capabilities that help you import critical 

information from your incident management system and share roadway information with the 

public so they can make informed decisions before they travel. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

View road conditions 
You will assume the role of a motorist planning travel to your next destination in search of 

information about road conditions prior to driving across state. You will use the Transportation 

511 app to discover current roadway conditions, restrictions and closures, and other alerts to 

help plan a safer trip. 

1. In a browser, from the Transportation 511 solution, view the Transportation 511 app. 

  The Road Conditions widget is open by default. Road Conditions categories are 
presented in a list with corresponding total counts. 

  Note: 

  Information shown in the Road Conditions list automatically updates as you pan and 
zoom the map to different extents or when searching for a location by address. 

2. Click a category to expand it. 

  After expanding a category, you may notice that it includes expandable lists that are 
specific to a particular road or highway. 

3. If necessary, in the category, expand a list. 

4. Click one of the listed reports. 

  On the map, a pop-up displays at the location of the incident. The pop-up includes details 
about the incident, and, for some types of incidents, it provides a link to additional 
information. 

5. In the Road Conditions widget, to the left of a category, click the button to turn the layer 
on and off. 

 

Configure data updates 
The Overwrite Hosted Features script is meant to be scheduled as a task to run regularly to 

keep road condition information current in the app. The script takes a zipped file geodatabase 

and overwrites the published feature collection with the current road condition information. The 

script can run on a machine without ArcGIS installed. You will now assume the role of a 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 746 

employee in the transportation agency responsible for keeping the Transportation 511 app up to 

date with the latest information on road conditions across the state. 

 

Configure script parameters 
To configure the Overwrite Hosted Features script, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the Transportation 511 solution item. 

2. Open the item page and click Overwrite Features. 

3. On the item page, click Download. 

4. Unzip the OverwriteFeatures folder. 

5. Download and install Python version 2.7 or version 3.4 if you do not have it installed on 
your machine. 

6. Browse to and open the overwrite_hosted_features.cfg file in a text editor, and 

update the following inputs: 

  Parameter 

  Description 

  featureServi
ceItemID 

  The item ID for your Transportation 511 feature service. 

  featureColle
ctionItemID 

  The item ID for your Transportation 511 feature collection. 

  Note: 

  Item IDs are found at the end of the URLs when viewing item 
details, for example, 
http://myorganization.maps.arcgis.com/home/item.html
?id=d7c57317a0564cafae28cdc464d63ff9. 

  fgdb   The path to the provided zipped file geodatabase, for example, 
C:\Transportation511\RoadConditions.zip. 

  Tip: 

  A sample schema geodatabase is provided in the Overwrite 
Features .zip file. 

  baseURL   Your organization's URL, for example, 
https://myorganization.maps.arcgis.com. 

  username   Your ArcGIS username. 

  pw   Your ArcGIS password. 

  maxAllowable
Offset 

  To optimize performance of the data in the application, it is 
recommended that you generalize complex line and polygon 
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features. Enter the maximum amount of simplification you want for 
the features in the feature collection. 

  Note: 

  This is defined in the units of the spatial reference of the service, 
by default, in meters. 

  nameMapping   To ensure that features in your feature collection are updated with 
data from the correct feature class in the file geodatabase, enter a 
layer mapping to match layers in the published feature layer with 
the file geodatabase feature class in this parameter following this 
pattern: 

  Feature Service Layer 1, Database Feature Class 1; Feature 
Service Layer 2, Database Feature Class 2 

  Note: 

  The defaults provided in the configuration file work against the 
provided sample geodatabase and the deployed feature service. 

  path (Optional)   The path and file name where you want the log to be written. 

  isVerbose 

(Optional) 

  True or false. To disable logging, leave this parameter blank. 

7. Save your edits to the configuration file. 

8. Run the Overwrite Hosted Features script, overwrite_hosted_features.py, to test your 

configuration. If necessary, refer to the troubleshooting guide below. 

 

Schedule data updates 
You can use the Overwrite Hosted Features script (overwrite_hosted_features.py) with 

Windows Task Scheduler to overwrite feature collections at a regular interval. Scheduled 

updates ensure that users have access to current information to support more timely decision-

making when traveling. 

To update the Transportation 511 feature collection on a schedule, complete the following 
steps: 

1. Open Task Scheduler on the computer hosting the scripts. 

2. Click Action > Create Task and name your task. 

3. Click the Action tab and click New. 

4. Set Action to Start a Program. 

5. Click Browse and go to the location of your Python installation (for example, <default 
directory>\Python27\python.exe), and click Open. 

6. In the Add Arguments text box, type the path and name of the script 
(overwrite_hosted_features.py) and path and name of the configuration file 

(overwrite_hosted_features.cfg), and click OK. 
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7. Click the Trigger tab, click New, and set a schedule for your task. 

8. Click the Settings tab, click the If the task is already running, then the following rule 
applies drop-down arrow, and choose Do not start a new instance. 

9. Click OK. 
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Vaccine Coverage Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Vaccine Coverage Analysis 
Vaccine Coverage Analysis can be used to identify underserved populations and optimize plans 

for disease vaccination sites. 

Comprehensive vaccination coverage is one of the most effective ways to stop a pandemic and 
reopen communities. Communities of color and socioeconomically vulnerable areas are 
disproportionately burdened when vaccinations are available but underutilized. Identifying areas 
of low vaccination rates and vulnerable populations can help ensure equitable vaccine 
distribution. Vaccine Coverage Analysis is typically implemented by health and human services 
or public safety agencies that want to optimize the location of vaccination sites, maximize limited 
resources, and ensure communities affected the most have access to vaccines. 

The Vaccine Coverage Analysis solution delivers a set of capabilities that help you identify 
priority and underserved populations, locate optimal vaccination sites, and share vaccine site 
information with internal and external stakeholders. 

 

Requirements 
Vaccine Coverage Analysis requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.7 - ArcGIS Pro 2.9 (Advanced) 

– ArcGIS Geostatistical Analyst extension 

Information products 
Vaccine Coverage Analysis includes the following information products: 

Item Description 
Minimum user 
type 

Vaccine 
Coverage 
Analysis 

An ArcGIS Pro project used by health and human services 
analysts to identify priority and underserved populations, 
locate optimal vaccination sites, and share vaccine site 
information with internal and external stakeholders 

GIS 
Professional 
Advanced 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
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with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • Added support for single dose vaccines and revised vaccination rate 
calculation. 

• Resolved an issue in the Configure Existing Sites model that prevented 
the Append tool from functioning properly in ArcGIS Pro 2.8. 

1.0 • First release of Vaccine Coverage Analysis 
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Use Vaccine Coverage Analysis 
The Vaccine Coverage Analysis solution delivers a set of capabilities that help you identify 

priority and underserved populations, locate optimal vaccination sites, and share vaccine site 

information with internal and external stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Identify coverage gaps 
Priority populations and vaccine rates can be used to identify underserved populations quickly 

using the Vaccine Coverage Analysis project. Current vaccination statistics collected from 

vaccination sites and priority populations will help you identify areas that have low vaccination 

rates and high-priority populations. 

You will start by assuming the role of a health and human services analyst. You are asked to 
use the Vaccine Coverage Analysis project to identify underserved populations. 

1. Sign in to your ArcGIS organization and browse to the Vaccine Coverage Analysis Desktop 
Application Template. 

2. Open the item page and click Download. 

3.  Unzip and open the Vaccine Coverage Analysis ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Vaccine Coverage 
Analysis task. 

6. In the Tasks pane, click the Identify underserved populations task group to expand the 
collection of tasks. 

7. In the Tasks pane, double-click the Prepare vaccination and priority population task 
and follow the steps provided. 

8. Double-click the Create coverage map task and follow the steps provided. 

9. Double-click the Evaluate current vaccine distribution by drive time task and follow the 
steps provided. 

 

Locate vaccination sites 
The best vaccination sites can be quickly located with the Vaccine Coverage Analysis project. 

Use the previously identified coverage gaps and a list of candidate sites to locate new sites in 

your community. 

You will continue to assume the role of a health and human services analyst. You are asked to 
use the Vaccine Coverage Analysis project to select the best vaccination sites from a list of 
candidate sites that meet needs defined in the vaccine gap analysis. 

1. Open the Vaccine Coverage Analysis ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Vaccine Coverage 
Analysis task. 
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4. In the Tasks pane, click the Locate vaccination sites task group to expand the collection 
of tasks. 

5. In the Tasks pane, double-click the Identify potential distribution sites task and follow 
the steps provided. 

6. Double-click the Select new points of distribution task and follow the steps provided. 
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Vision Zero 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Vision Zero 
Vision Zero can be used to solicit transportation hazards and dangerous traffic behaviors on 

roadways from bikers, drivers, pedestrians, and others using public streets. 

Traffic collisions result in thousands of deaths each year and many communities are beginning 
to tackle this public health problem by adopting Vision Zero programs. Vision Zero programs 
engage many internal and external stakeholders (for example, the general public, planners, 
engineers, public health officials, and policymakers) and use data-driven strategies to create 
safer roadways for travelers. A key aspect of any Vision Zero program is a web destination that 
helps agencies share key initiatives with the public and solicit feedback from stakeholders. 
Feedback is then used to understand perceived problems, visualize trends, and inform policies. 
Vision Zero is typically implemented by public works, transportation, and public safety agencies 
that want to engage stakeholders and use data to reduce traffic hazards in their community. 

The Vision Zero solution delivers a set of capabilities that help you share your Vision Zero 
strategy with the public, solicit transportation hazards and dangerous traffic behaviors from key 
stakeholders, manage each reported hazard, and monitor the status of its resolution. 

 

Requirements 
Vision Zero requires the following: 

• ArcGIS Enterprise 

 

Information products 
Vision Zero includes the following information products: 

Item Description Minimum user type 

Vision Zero An ArcGIS Hub site used by public works, 
transportation, and public safety agencies to 
communicate strategies to eliminate traffic deaths of 
and life-altering injuries to travelers in the 
community. 

Not required 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 754 

Vision Zero 
Pledge 

An ArcGIS Survey123 form used by the general 
public to pledge to practice safe driving behaviors 
and obey all traffic laws. 

Not required 

Transportation 
Hazard Reporter 

A Crowdsource Reporter app used by the general 
public to report transportation hazards and 
dangerous traffic behaviors that could lead to 
fatalities or serious injuries. 

Not required 

Transportation 
Hazard Manager 

A Crowdsource Manager app used by public works, 
transportation, and public safety agencies to triage 
transportation hazards submitted by the general 
public. 

Editor 

Transportation 
Hazard 
Dashboard 

An ArcGIS Experience Builder app used by public 
works, transportation, and public safety agencies to 
monitor transportation hazards and dangerous traffic 
submitted by the general public. 

Viewer (required if 
the app is used for 
internal purposes 
only) 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Vision Zero 
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Configure Vision Zero 
In this topic, you will learn how to configure the Vision Zero solution to meet specific needs in 

your organization. 

Modify hazard types and responsible agencies 
Vision Zero includes problem types and responsible agencies for hazard reports. In some 

cases, you may want to add a problem type. In addition, you may want to modify the 

responsible agencies provided to more accurately reflect the name of the agency, department, 

or team that is responsible for responding to hazard reports. 

1. Sign in to your ArcGIS organization and browse to the TransportationHazardReports 
feature layer. 

2. Open the item page and click the Data tab. 

3. Click Fields. 

4. Click the Problem observed display name. 

  Review the List of Values (Domain). Identify domains that are missing or need to be 
removed from the list. 

5. Click Edit next to List of Values (Domain). 

6. Optionally, click Add. 

7. Type the problem type in the Displayed Value and Stored Value text boxes. 

8. Repeat steps 6 and 7 to add the remaining problem types. 

9. Optionally, click Delete to remove a problem type. 

10. Optionally, click in the Label text box with an existing problem type and change the name. 
Repeat this step to change the Code value as well. 

11. Optionally, drag the problem type to a new location in the list to reorder them. 

12. Click Save. 

Now, let’s review the list of responsible agencies and modify it to meet the needs of your 

organization. 

1. Click the Assigned To display name in the left panel. 

  Review existing agencies and identify missing ones in the List of Values (Domain) 
section. 

2. Click Edit next to List of Values (Domain). 

3. Optionally, click Add. 

4. Type the new agency name in the Displayed Value and Stored Value text boxes. 

5. Repeat steps 3 and 4 to add the remaining missing agencies. 

6. Optionally, click Delete to remove an agency. 

7. Optionally, click in the Label text box with an existing agency labeled and change the 
agency name. Repeat this step to change the Code value as well. 

8. Optionally, drag the category to a new location in the list to reorder them. 

9. Click Save. 
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Update the pledge survey 
The Vision Zero Pledge survey allows you to enlist the general public in practicing safe driving 

behaviors. Review the preconfigured questions and align the survey with your organizational 

policies and desired outcomes. 

To modify the Vision Zero Pledge survey, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Vision Zero 
Pledge form. 

2. Open the item page and click Open in Survey123 > Manage in Survey123 website. 

3. Click the Design tab. 

4. Edit the survey and save the changes. 

5. Click Publish twice. 

 

Configure the Vision Zero site 
The Vision Zero solution includes the Vision Zero ArcGIS Hub site that your organization can 

configure with your branding and use to share strategies to eliminate traffic deaths of and life-

altering injuries to travelers in the community. 

 

Update with organizational information 
After deploying the Vision Zero solution, the Vision Zero site layout requires a few updates to fit 

your local context. Consider what information you already have and what you can most easily 

find. To update your site, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Vision Zero 
site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the By the Numbers section listed under the title of the website. 

  The Taken the Vision Zero Pledge statistic card is linked to the Vision Zero solution’s 
VisionZeroPledge_opendata feature layer. The stat is automatically updated as pledges 
are submitted. 

  The Fatalities and Seriously Injured cards are text cards but styled to resemble the 
summary statistics cards; this allows you the option to manually enter a statistic of your 
choice, independent of the solution data. 

5. Hover over the Fatalities card and click the settings button . 

6. Update the number of traffic fatalities. 

7. Hover over the Seriously Injured card and click the settings button. 

8. Update the number of traffic-related injuries. 

9. Scroll to the Transportation Hazards section, hover over the Other Reporting Methods 
card and click the settings button. 

10.  Click the Code View option and update the phone number, and click Code View. 
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11. Scroll to the Frequently Asked Questions section, hover over the card and click the 
settings button, and update the questions and answers. 

12. Scroll to the Additional Resources section, hover over an image card, and click the 
settings button. 

13. On the side panel, provide a URL to an image in the text box or click Upload to upload an 
image associated with the resource. 

14. Hover over the text card, click the settings button, and update the text. 

15. Click the Learn More button and click Edit. 

16. Enter a URL in the Link Destination text box and click Add Link. 

17. Scroll to the Partner section, hover over an image card, and click the settings button. 

18. On the side panel, provide a URL to an image in the text box or click Upload to upload an 
image associated with a partner you want to promote on the site. 

19. To modify your site’s footer, click Customize Toggle  on the side panel. 

20. Click Footer.  

  A custom footer is already provided, and in most cases, it needs to be updated with your 
organization's branding, contact information, and social media references. 

21. Click the HTML text box. 

  The HTML window appears. 

22. Make the necessary changes and click Apply. 

23. Click Save. 

 

Share Traffic Crash Analysis apps 
You can enhance the Vision Zero site with additional public-facing applications included with the 

Traffic Crash Analysis solution. The High Injury Network Locator helps the general public locate 

streets and intersections where concentrations of serious and fatal traffic crashes occur. You 

can share the Fatal and Serious Injury Dashboard so the general public can locate crashes that 

resulted in serious injury or fatality. To share the apps on the Vision Zero site, complete the 

following steps: 

1. Verify you are signed in to your ArcGIS organization and browse to the Fatal and Serious 
Injury Dashboard web experience. 

2. Open the item page and click the Share button. 

3. In the Share window, click Edit group sharing. 

4. Enter Vision Zero Maps in the search text box. 

5. Click the check box next to the Vision Zero Maps group. 

6. Click OK. 

7. Click Save. 

8. Repeat steps 2-6 for the High Injury Network Locator app. 

9. Click Update in the Update sharing window. 
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Share items with the public 
Several layer views, maps, and apps included in the Vision Zero solution must be shared with 

everyone so they can be accessed by the public on the Vision Zero site. To share your items 

with everyone, use the guide below and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization. 

2. Click Groups at the top of the site. 

3. Open the Transportation Hazard Reporter group page and click the Settings tab. 

4. Under Who can view this group, click Everyone (public), and click Save. 

5. Click Content at the top of the site. 

6. On the My Content tab, under Folders, type Vision Zero in the search box. 

7. Click the Vision Zero folder. 

8. Check the check box next to each of the items below: 

  Item 

  Name 

  Feature Layer (hosted, view)   TransportationHazardReports_public 

  Web Map   Transportation Hazard Reporter 

  Web Mapping Application   Transportation Hazard Reporter 

  Feature Layer (hosted, view)   TransportationHazardReports_dashboard 

  Web Map   Transportation Hazard Dashboard 

  Dashboard   Transportation Hazard Desktop Dashboard 

  Dashboard   Transportation Hazard Mobile Dashboard 

  Web Experience   Transportation Hazard Dashboard 

  Form   Vision Zero Pledge 

  Feature Layer (hosted)   VisionZeroPledge_public 

  Feature Layer (hosted)   VisionZeroPledge_opendata 

  Site Application   Vision Zero 

9. Click Share. 

10.  In the Share window, click Everyone (public) and click Save. 
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  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

11. Click Update. 

 

Extend Vision Zero 
You can extend the Vision Zero solution with a set of Python tools that can be used to generate 

report IDs, moderate reports, send email notifications, and enrich reports. These tools can be 

executed automatically via Task Scheduler and as new problem reports are submitted, or 

updated, the corresponding action will occur. 

Add the ServiceFunctions toolbox 
The ServiceFunctions toolbox contains tools for generating report IDs, moderating reports, 

sending email notifications, and enriching reports. Download and add the ServiceFunctions 

toolbox to your ArcGIS Pro project before configuring the appropriate tools. 

1. Download the ServiceFunctions toolbox. 

2. Browse to the ServiceSupport.zip file and unzip the file to the location from which you 

want to the tools to execute. 

3. Open ArcGIS Pro and create a new project. 

4. Sign in to the ArcGIS organization to which you deployed the Vision Zero solution, if 
necessary. 

5. On the View tab, in the Windows group, click the Catalog pane, if necessary. 

6. In the Catalog pane, right-click Toolboxes and choose Add Toolbox. 

  The Add Toolbox dialog box appears. 

7. Browse to the ServiceSupport folder. 

8. Click the ServiceSupport.pyt Python toolbox, and click OK. 

9. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

  If you've never used the ServiceSupport toolbox before, run the Define Connection 
Settings tool to establish a connection between the toolbox and the 
TransportationHazardReports feature layer. 

10. In the Catalog pane, in the ServiceSupport.pyt Python toolbox, double-click the Define 
Connection Settings tool. 

11. In the ArcGIS Online organization or ArcGIS Enterprise portal URL parameter, click the 
drop-down arrow and choose a URL. 

12. In the Username parameter, type your user name for the organization you chose in step 
11. 

13. In the Password parameter, type your password for the user name provided in the 
Username. 

14. Click Run. 

 

Generate report IDs 
Many workflows require you to generate a unique identifier when a feature or record is created 

so it can be referenced and tracked in other workflows. You can use the Generate IDs tool to 

configure custom unique identifiers that will be applied to features at a regularly scheduled 
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interval of your choosing. The tool only generates the configuration; you must run an additional 

script (provided) to update the features with incrementing identifier values. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt, if necessary. 

2. Double-click the Generate IDs tool. 

3. In the Layer parameter, click Browse. 

  The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Vision Zero folder. 

6. Double-click the TransportationHazardReports feature layer. 

7. Click Transportation Hazard Reports, and then click OK. 

  Expand General Identifier Settings. If the tool has not been run previously, start by 
specifying at least one identifier sequence. 

8. In the Sequence Name parameter, type a name for the sequence. 

  This value appears in the drop-down menu for selecting the sequence to assign to each 
layer. 

9. In the Pattern parameter, type a pattern to use for the sequence. 

  This can be a combination of letters, numbers, and symbols. Mark the location for the 
incrementing value with a pair of curly braces {}. Python formatting is applied to the pattern 
text, so string formatting syntax such as {0:03d} pads the incrementing number section with 
zeros to a length of 3. For example, the expression seq-{0:05d} creates the following 
pattern of values: seq-00001, seq-00002, seq-00003, and so on. 

10. In the Next Value parameter, type a value. 

  When initially creating the sequence, this must be the first value in the identifiers. After this 
point, this value shows the value to be used for the next identifier generated. 

11. In the Interval parameter, type a value. 

  The interval by which the identifier values increase between features. For example, an 
initial Next Value of 1 and an Interval of 10 creates identifiers with the incrementing values 
of 1, 11, 21, and so on. 

  Deleting or changing these sequences impacts all the layers that are configured to use the 
edited sequences. 

12. Optionally, edit the identifier configuration and run the tool to overwrite the existing 
identifier configuration for the selected layer. 

  Note: 

  If an identifier configuration already exists, a check box appears that, when checked, 
deletes the existing identifier configuration for the selected layer. 

13. Choose the moderation list to use to process the features in the selected layer. 

14. Choose the sequence to use to generate the identifiers for each feature in the layer. 

15. Choose a text field to store the generated identifier. 

16. Click Run to write out the identifier configuration for the layer and any changes to the 
identifier sequences. 

17. To configure identifiers for another layer, rerun the tool with the settings for the next layer. 
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General Identifier Settings are not specific to any one layer—they apply to all layers configured 

using this tool. 

 

Moderate reports 
Public comment apps can occasionally generate feedback that should not be made publicly 

visible. Data entered into specific fields, such as personal information, can be hidden and 

protected using the pop-up configuration and layer security, but sometimes entire comments 

need to be hidden to avoid displaying sensitive or explicit content to other users. 

You can hide features by updating the value of a field so that it no longer meets the 
requirements of a filter applied to that layer in the map. You can use the Moderate Reports tool 
to configure which layers and fields to scan for explicit or sensitive words and phrases and how 
to update the feature so that it can be filtered from the map. You can choose how often to scan 
features and records. The tool only generates the configuration; an additional script (provided) 
must be run to scan the features. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

2. Double-click the Moderate Reports tool. 

3. In the Layer parameter, click Browse. 

  The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Vision Zero folder. 

6. Double-click the TransportationHazardReports feature layer. 

7. Click Transportation Hazard Reports, and then click OK. 

  Expand General Moderation Settings. If the tool has not been run previously, start by 
specifying at least one moderation list. 

8. In the List Name parameter, type a name. 

  This value appears in the drop-down menu for selecting the moderation list use when 
scanning each layer. 

9. In the Filter Type parameter, click the drop-down arrow and choose to scan feature for 
words and phrases that exactly match the provided list of words and phrases. 

  For example, when the filter type is EXACT, if the list contains the word duck, the script 
updates the specified field when the feature contains the word duck, but not when it 
contains the word duckling. When the filter type is FUZZY, the script updates the feature 
when either duck or duckling are found. 

10. In the Words and Phrases parameter, type a word or phrase. Provide a comma-separated 
list of words or phrases to scan for. 

  Keep in mind that deleting or changing these lists will impacts all the layers that are 
configured to use the edited sequences. 

11. If a moderation configuration already exists for the selected layer, choose to edit an 
existing configuration by selecting the name of the moderation list used in the 
configuration, or choose the option to add a new moderation configuration. 

  If you choose to edit an existing configuration, a check box appears that, when checked, 
deletes the existing moderation configuration for the selected layer. Alternatively, edit the 
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moderation configuration and run the tool to overwrite the existing moderation configuration 
for the selected layer and moderation list. 

  To add a new moderation configuration, click the Add New button and continue with the 
following steps. 

12. Choose the moderation list to use to process the features in the selected layer. 

13. Choose the fields that will be scanned for content that matches the words and phrases in 
the selected moderation list. 

14. Optionally, provide an SQL query to only apply moderation to some features. 

  If no query is provided, all features are processed. 

15. Use the Field to Update parameter when a match is found between the value of a field 
and the content of a moderation list. Use the Found Value parameter to specify the value 
that should be written to this field indicating a match. 

16. Click Run. 

 

Send email notifications 
Many workflows require that an email be sent when a feature or record is created and updated. 

You can use the Send Emails tool to configure emails that can be sent based on attribute 

values and a schedule of your choosing. The tool only generates the configuration; you must 

run an additional script (provided) to actually generate and send the emails. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

2. Double-click the Send Emails tool. 

3. In the Layer parameter, click Browse. 

  The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Vision Zero folder. 

6. Double-click the TransportationHazardReports feature layer. 

7. Click Transportation Hazard Reports, and then click OK. 

  All existing email settings for the layer load and can be edited by updating the parameter 
values for each configuration. To delete a single email configuration, click the Remove 

button  next to the configuration. To delete all the email configurations for the layer, 
check the Delete all existing email configurations for this layer check box. Run the tool 
to save your changes. 

8. In the Email Template parameter, click Browse to access the ServiceSupport folder. 

9. Click one of the HTML templates for the body of the email, and click OK. 

  To add attributes from the triggering feature to the email, use unique string keys in the 
places where the values should appear in the HTML and reference these strings in the 
Find parameter of the Email Substitutions section of the General Email Settings along 
with the name of the field that contains the value to be substituted for the string key in the 
Replace parameter. 

10. Optionally, in the SQL Query parameter, provide an SQL query to only trigger an email 
from specific features. 
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  If no query is provided, all features trigger emails every time the script is run, so you most 
likely want to use this query along with the Field to Update and Sent Value parameters to 
ensure that the same email isn't sent repeatedly for the same feature. 

11. In the Recipient Email Address parameter, type an email address of the recipient or the 
name of a field in the layer that contains the address of the recipient. 

12. In the Email Subject parameter, type the subject for the email. 

  Similar to the email body provided in the HTML document, this text can contain string keys 
that will be swapped out for attribute values based on the Find and Replace values 
defined in the Email Substitutions list in the General Email Settings section. 

13. In the Field to Update parameter, type Email. When the email has been sent for each 

feature, use the Sent Value parameter to specify the value that should be written to this 
field indicating that the email has been sent. 

  This field and value can be used in the previously described SQL query to prevent 
duplicate emails from being sent. 

14. Configure additional emails to be sent for the currently selected layer by clicking the Add 
New button. 

  Emails will be sent in the order they are configured. Expand General Email Settings. If the 
tool has not been run previously, start by specifying the connection information for your 
SMTP server in the tool. 

15. In the SMTP Server parameter, type the URL of the SMTP server used for sending emails. 

16. In the SMTP Username parameter, type the user name required to authenticate to the 
SMTP server. This is not required if authenticating through a port. 

17. In the SMTP Password parameter, type the password required to authenticate to the 
SMTP server. This is not required if authenticating through a port. 

18. In the From Address parameter, type the address from which the emails should be sent. 

19. In the Reply Address parameter, type the address that should be used for any replies to 
the email message. 

20. Check or uncheck the Use TLS check box to turn on or off TLS. 

21. In the Email Substitutions section, type Find and Replace values. Swap out one piece of 
text for another in the outgoing email subject or body.  

  Anywhere a value in the Find parameter is found in the email subject or body, it will be 
replaced with the corresponding value from the Replace parameter. If the value in the 
Replace parameter is a field in the layer, the Find value will be replaced with the value in 
that field in the triggering feature. For example, to add the ID of a feature from the 
REQUESTID field to the email subject, include a piece of text such as {ID} in the 
configured Email Subject, and add {ID} to the Find parameter and REQUESTID to the 
Replace parameter. All specified substitutions are applied to all emails configured for all 
layers so, while the Find values can be any piece of text, it's suggested that you use 
something that is clearly variable-like and unlikely to appear elsewhere in the messages in 
a literal form. 

  Deleting or changing these settings impacts all the emails for all the layers configured with 
this tool. 

22. Click Run. 
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Enrich reports 
Reports made in public comment apps can be enriched with information about the report 

location. You can then use this information to efficiently direct the report to the correct person or 

agency responsible for its resolution. 

You can then use the Enrich Reports tool to configure which attribute values to calculate from a 
coincident or intersecting set of features at a regularly scheduled interval of your choosing. Note 
that the tool only generates the configuration; you must run an additional script (provided) to 
update the features based on intersecting features. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

2. Double-click the Enrich Reports tool. 

3. In the Layer parameter, click the browse button. 

  The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Vision Zero folder. 

6. Double-click the TransportationHazardReports feature layer. 

7. Click Transportation Hazard Reports, and then click OK. 

8. In the Enrichment parameter, if an enrichment configuration already exists for the selected 
layer, choose to either edit an existing configuration by selecting the configuration from the 
drop-down list, or choose the option to add a new enrichment configuration. 

  If you choose to edit an existing configuration, a check box appears that, when checked, 
deletes the existing enrichment configuration for the selected layer. Alternatively, edit the 
configuration and run the tool to save the changes. To add a new enrichment configuration, 
click the Add New button and continue with the following steps. 

9. Choose the polygon feature layer that will provide the enriching attribute values by either 
choosing a layer from the active map or by browsing to your hosted content and choosing a 
polygon feature layer. 

10. In the Source Field parameter, click the drop-down arrow and choose a field from the 
enrichment layer. 

11. In the Target Field parameter, click the drop-down arrow and choose a field from the 
TransportationHazardReports feature layer. 

  The script does not process features that already have a value in the target field. 

12. In the Priority parameter, type a value. Specify the priority that should be given to this 
enrichment configuration relative to the other configurations for the 
TransportationHazardReports feature layer.  

  Enrichment configurations for a layer that have a lower priority value will override 
enrichment configurations with a higher value. For example, a layer has two enrichment 
configurations that use the same target field, but one has a priority value of 1 and the other 
has a priority of 2. If the configuration with priority 1 does not produce a valid value for the 
field, the field is populated with the value produced from the configuration with priority 2. 

13. Click Run. 

 

Set up Task Scheduler 
Use Windows Task Scheduler to schedule the script to generate report IDs when a feature or 

record is created, moderate reports when feedback contains inappropriate language, send email 
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notifications when a feature or record is created or updated, or enrich reports. All the tools in 

this toolbox share a common configuration file and execution script, so only one scheduled task 

is required to automate running all the associated processes. 

1. Open the Task Scheduler on the computer that is hosting the scripts. 

2. Click Action > Create Task and name your task. 

3. Click the Action tab and click New. 

4. Set Action to Start a Program. 

5. Browse to the location of your Python 3 installation (for example, <default 
directory>\C:\Program Files\ArcGIS\Pro\bin\Python\envs\arcgispro-
py3\python.exe). 

6. In the Add arguments text box, type the name of the script (servicefunctions.py). 

7. In the Start in text box, type the path to the folder where your script is and click OK. 

8. Click the Trigger tab, click New, and set a schedule for your task. 

9. Click OK. 

When the trigger occurs, the scripts begin scanning the configured layers and, for each one, 

processing (in order) configurations for generating identifiers, enriching reports, moderating 

reports, and sending emails. 
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Use Vision Zero 
The Vision Zero solution delivers a set of capabilities that help you share your Vision Zero 

strategy with the public, solicit transportation hazards and dangerous traffic behaviors from key 

stakeholders, manage each reported hazard, and monitor the status of its resolution. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Submit a traffic hazard 
You will first assume the role of a concerned resident in the community who wants to notify the 

city of a problem that you observed. 

1. In a browser, from the Vision Zero solution, view the Vision Zero site. 

2. Scroll to the Transportation Hazards section and click Report Hazard. 

3. In the Transportation Hazard Reporter app, at the lower right, click  Submit a Hazard. 

4. Complete the form with as much information as possible. 

5. Click Report It. 

6. At the top of the Transportation Hazards form, click the arrow to return to the list. 

7. At the top of the list, click the problem that you just submitted. 

  Information about the problem that you reported appears. As the report moves through its 
life cycle (Submitted, Received, In Progress, and Completed), the status bar updates. 

8.  Below the status bar, click Leave a reply. 

  You or others can add comments to update or highlight information related to the initial 
problem reported to authorities. 

9. Optionally, add and submit a comment; otherwise, click Cancel. 

 

Respond to hazard reports 
You are now a city employee who is responsible for responding to submitted transportation 

hazard problem reports, assigning them to the appropriate department for resolution, and 

providing the resolution information when completed. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Vision Zero 
solution. 

2. View the  Transportation Hazard Manager  app. 

  All problem reports are listed in the table at the top. The table can be sorted and filtered in 
various ways. 

3. In the table, use the column header filters and arrows to filter results. 

4. Select a problem with a status of Submitted. 

  The problem details open at the lower left. 
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5. In the details, on the Details tab, click the Edit Record button . 

6. For Visible to the Public, choose Yes. 

7. For Status, choose Received. 

8. Click Save. 

  The next step is to investigate the location for Vision Zero improvements. You'll change the 
status to In Progress and assign the problem to the most appropriate department. 

9. Click the Edit Record button again. 

10. For Status, choose In Progress. 

11. For Assigned To, choose the appropriate department. 

12. Click Save. 

  After the department assigned to the problem informs you that the problem has been 
investigated and improvements to the intersection have been submitted for review, you'll 
change the status to Completed. 

13. Click the Edit Record button again. 

14. For Status, choose Completed. 

15. In the Resolution text box, type Improvements submitted to Vision Zero taskforce 
for review. 

16. Click Save. 

  Because the issue has been completed, the status indicator has changed, and the details 
now provide information about when and how the issue was resolved. 

   

Monitor reports and measure performance 
As a program manager for the city, you want to know how well the Vision Zero program is 

functioning and monitor the reports coming in. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Vision Zero 
solution. 

2. View the Transportation Hazard Dashboard app. 

3. On the left, use filters to refine results by status, transportation mode, problem, or date. 

4. Use the graphs to filter and explore active and resolved problem reports. 

5. In the Hazard Reports list, click a report to zoom to it on the map and open a pop-up with 
more information. 

 

Take the Vision Zero pledge 
As an engaged resident of the community, you want to take the Vision Zero pledge to commit to 

streets that are safe, accessible, and shared by everyone in the community. 

1. In a browser, from the Vision Zero solution, view the Vision Zero site. 

2. Scroll to the Vision Zero Pledge section and click Take the Pledge. 

3. Complete the Vision Zero Pledge survey, and then click Submit. 
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Water Distribution Data Management for ArcGIS 

Enterprise 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Water Distribution Data 

Management for ArcGIS Enterprise 
Water Distribution Data Management for ArcGIS Enterprise can be used to map and manage 

asset information with the ArcGIS Utility Network. 

It configures ArcGIS Enterprise and the ArcGIS Utility Network to be an authoritative repository 
of information for a water distribution network and provides workflows that facilitate capturing 
information correctly and keeping it up to date. 

Water Distribution Data Management for ArcGIS Enterprise delivers a data model that makes a 
utility network behave like a water distribution network, editing apps configured for ArcGIS Pro, 
and preconfigured maps for data sharing. It also provides a sample utility network dataset so 
users can experience a utility network in a single user environment. You can use the solution's 
deployment framework to experience a water distribution utility network with sample data or in a 
single user environment. 

 

Requirements 
Water Distribution Data Management for ArcGIS Enterprise requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.8 or later (Standard or Advanced) 

 

Information products 
Water Distribution Data Management includes the following information products: 

Item Description Minimum user type 

Water Distribution 
Data Management for 
ArcGIS Enterprise 

A zipped file with an ArcGIS Pro project 
package with tasks, a configured utility network 
in a file geodatabase, editor and auditor maps, 
and an asset package geodatabase 

Creator user type 
with ArcGIS Utility 
Network user type 
extension 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 769 

(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • ManageIsDirty setting has been changed to false for all subnetworks to 

improve performance in editing and validation 

1.0 • The first release of Water Distribution Data Management for ArcGIS Enterprise. 
• The data model in the solution has been updated to version 4. For a full list of 

updates, refer to the change log. 
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Use Water Distribution Data Management for 

ArcGIS Enterprise 
The Water Distribution Data Management for ArcGIS Enterprise solution provides a 

preconfigured utility network, maps, styles, step-by-step instructions, common data 

management workflows, and more. The tasks in the Water Distribution Data Management 

project guide you through creating your own utility network using the provided schema and data 

loading options and setting up an enterprise environment. The solution also includes a data 

dictionary with descriptions of the features in the data model. 

In this topic, you will learn how to use the solution to create and manage your water distribution 
utility network. 

Use the instructions in the Water Distribution Data Management task to get started with the 
solution. 

1. Sign in to your ArcGIS organization and browse to the Water Distribution Data 
Management for ArcGIS Enterprise V1.1 item. 

2. Open the item page and click Download. 

3. Unzip and open the downloaded Water Distribution Data Management ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand Tasks and double-click the task item. 

6. In the Tasks pane, click the Explore the Data Management Solution task group to 
expand the collection of tasks. 

  Tip: 

  Click each group task heading and task to view a description at the bottom of the Tasks 
pane. 

  Each task group includes instructional steps for using the solution. Begin by exploring 
the contents of the project, tracing and editing workflows with sample data, or configuring 
the solution for your organization. 

 

Explore the Data Management Solution 
The data management solution is designed for organizations that want to experience a fully 

functional water distribution utility network. Explore common workflows with the sample data in 

the provided single user file utility network. Task-based workflows are also provided to create 

and model your own utility network to behave like a water distribution system in an enterprise 

environment. The solution also provides preconfigured maps for sharing data and editing data. 

This task group includes the following tasks: 

• Overview 

• What's Included 

• Review the Data Model 

• Explore the Symbology and Data 
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These tasks introduce the solution and walk through exploring the capabilities of the utility 

network. 

 

Tracing and Analysis 
Tracing is a key capability of the utility network. There are several core trace configurations that 

allow you to analyze your network. 

This solution includes workflows for critical traces for water distribution utilities such as isolating 
a leak. The Isolate Leak task walks through identifying a leak location and running an isolation 
trace to determine which devices need to be closed in order to isolate the leak. 

This task group includes the following task: 

• Isolate Leak 

 

Editing Workflows 
Users are guided through editing workflows with the provided sample data. These workflows are 

designed to showcase common tasks while highlighting the capabilities of the utility network. 

Note: 

In the Contents pane, click the List by Snapping tab. Expand all feature classes to ensure 
snapping is checked for each asset group. 

This task group includes the following tasks: 

• Add Customer Service 

• Add Fire Hydrant Service 

• Create Cathodic Protection Zone 

• Extend Distribution Pipe 

 

Installing Implementation Prerequisites 
After exploring the sample utility network, move on to building out a utility network for your own 

organization. Before getting started set up the environment with the necessary tools. 

This task group includes the following tasks: 

• Create a Python project environment 

• Install Utility Network Package Tools 

• Install Data Loading Tools 

 

Configure Data Model for Implementation 
The data model has been developed and curated over several years to reflect the latest 

capabilities of the utility network. This solution delivers the latest model which has been 
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developed specifically to support water distribution utilities to best manage their assets in a 

digital environment. 

After exploring the solution, complete the following steps to remove the sample data and 
prepare the data model to manage your water distribution network. 

This task group includes the following tasks: 

• Project and Remove Sample Data 

• Create Modification Tables (Optional) 

• Loading Data (Optional) 

 

Prototype in a Single User Environment 
Creating a utility network that fits your organization's needs requires a solid understanding of 

your data, as well as the provided date model. We recommend starting out with a prototype to 

explore with your own data and adjust where necessary. When ready, move on to setting up 

and implementing your solution in ArcGIS Enterprise. 

To learn more about the Attribute Rules included in the Water Distribution Data Management 
project, review the Water Distribution Data Management Attribute Rules document. 

This task group includes the following tasks: 

• Create File Geodatabase with Schema 

• Adjust Attribute Rules 

• Update Maps' Data Sources 

• Reset Trace Location Feature Classes 

• Adjust Maps 

• Export Asset Package 

 

Deploy Solution to an Enterprise Environment 
These tasks are a guide to set up a utility network from start to finish. This includes creating an 

enterprise database, utility network, and sharing the final maps and services with your 

organization. 

This task group includes the following tasks: 

• Setup Enterprise Database 

• Create Utility Network 

• Apply Schema 

• Adjust Attribute Rules 

• Post Process 

• Publish Services 

• Update Subnetworks 

• Update Maps Data Source to Feature Service 

• Publish Web Map 

• Reset Trace Location Feature Classes 

• Adjust Maps 
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• Share with Organization 
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Wildlife Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated.  

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov 2025 

 

Introduction to Wildlife Management 
Wildlife Management can be used to capture wildlife observations and monitor the status of 

wildlife populations in and around protected areas. 

It streamlines wildlife field observations and the location-enabled wildlife observations help 
protected area managers evaluate the effectiveness of current wildlife management strategies. 
Monitoring wildlife observation information and trends derived from this information informs 
monitoring and protection plans developed for a protected area. Wildlife Management is 
typically implemented by conservation agencies that want to take a data-driven approach to 
managing wildlife populations. 

The Wildlife Management solution delivers a set of capabilities that help you capture wildlife 
observations, monitor wildlife populations, and analyze trends in protected areas. 

 

Requirements 
Wildlife Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 

• ArcGIS QuickCapture 

• Survey123 Connect 

 

Information products 
Wildlife Management includes the following information products: 

Item Description 
Minimum 
user type 

Wildlife 
Observation 
Dashboard 

An ArcGIS Dashboards app used by conservation staff to 
monitor the status of wildlife observations within and around 
protected areas 

Viewer 

Wildlife 
Observation 
Reporter 

An ArcGIS Survey123 form used by conservation staff to 
collect wildlife observations 

Field Worker 
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Rapid Wildlife 
Reporter 

An ArcGIS QuickCapture project used by conservation staff 
to collect wildlife observations 

Field Worker 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release Notes 
The following are the release notes: 

Version Description 

1.0 • First release of Wildlife Management 
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Configure Wildlife Management 
In this topic, you will learn how to configure the Wildlife Management solution to meet specific 

needs in your organization. 

Load data   
Wildlife Management can be used to capture wildlife observations and monitor the status of 

wildlife populations in and around protected areas. In some cases, you may have this 

information in ArcGIS or another business system already. 

Review the layers provided with the solution and determine what source data you would like to 
load. Then, load your existing data into the layers provided with the ArcGIS Solution before 
sharing the maps or applications. 

Once you have determined what source data must be loaded, complete the data loading 
workflow below. 

Load data from a shapefile    
Data for WildlifeObservations be loaded from a shapefile by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you wish to populate. 

3. On the feature layer item details page, Click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Navigate to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you wish to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

 

Updating the animal list 
Species diversity varies between protected areas, so it is critical for protected area staff to be 

able to configure the animal list within the Wildlife Management solution. In the following 

sections, we will highlight how protected area staff can configure the Wildlife Management 

solution to match local animal species. 
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Update the animal choice list in the Wildlife Observation Reporter 
To update the animal choice list, complete the following steps: 

1. Download and install Survey123 Connect. 

2. Start Survey123 Connect and sign in to your ArcGIS organization. 

3. Click on Wildlife Observation Reporter to download the survey. 

4. Click on Wildlife Observation Reporter again to open the survey. 

5. On the left panel, click Open XLSForm Spreadsheet. A Microsoft Excel spreadsheet will 
open. 

6. In the Microsoft Excel spreadsheet, click on the Choices tab. This tab comprises all the 
selectable options for survey questions. 

7. In the animal choice list, add or remove animal names and labels as needed. 

8. Save the Microsoft Excel spreadsheet and preview your changes in the Form Preview tab 
of Survey123 Connect. 

9. In Survey123 Connect, click Publish in the left panel to publish your changes. 

Note: 

The default animal list configuration comes with SVG graphics for each animal. If additional 
animals are added, you will need to add a new graphic for each additional animal to the 
media folder of the Wildlife Observation Reporter survey and list the file name of the new 
image in the image column of the XLSForm. 

 

Update the animal attribute list in the WildlifeObservations feature 

layer 
To update the animal attribute list in the WildlifeObservations feature layer, complete the 

following steps: 

1. On the WildlifeObservations feature layer item page, click the Data tab and then click the 
Fields button. 

2. Click the Animal field to open the field settings and click Edit under List of Values 
(Domain). 

3. Remove all animals from the list using the Delete button and enter the Label and Code for 
each new animal. 

4. When updates are complete, click Save. 

Note: 

The animal list in the WildlifeObservations feature layer must be identical (syntax and order) 
to the animal choice list you updated in the Wildlife Observation Reporter. 

 

Update the Rapid Wildlife Reporter ArcGIS QuickCapture project 
To update the Rapid Wildlife Reporter ArcGIS QuickCapture project, complete the following 

steps: 
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1. Click the Apps button  and Open ArcGIS QuickCapture. 

2. Click the Edit button on the Rapid Wildlife Reporter project. 

3. To add new animal buttons: 

a. Select an existing animal button, then click the Copy button in the button pane. 

b. In the Appearance tab, update the Label of the new animal button with the animal 
name. Then remove the existing animal image and add your new animal image. 
Select an existing animal button, then click the Copy button in the button pane. 

c. In the Data tab, select the new animal name from the Animal choice list 
dropdown. This will reflect the changes made to the WildlifeObservations feature 
layer. 

4. To delete animal buttons, select the Animal button then click the Delete button in the 
button page. To delete multiple animal buttons at once, hold down the shift key and select 
the animal buttons. 

5. To reorder animal buttons, simply drag and drop the animal buttons in the desired order. 

6. When you are finished making updates, click Save. 

Note: 

After the updates are saved, field users will see an option to update the Rapid Wildlife 
Reporter project in the ArcGIS QuickCapture application. Selecting update will download 
the new project updates to their device. 
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Use Wildlife Management 
The Wildlife Management solution delivers a set of capabilities that help you capture wildlife 

observations, monitor wildlife populations, and analyze trends in protected areas. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Collect wildlife observations 
The Rapid Wildlife Reporter app can be used to quickly capture wildlife observations in the field 

using a simple big button interface. The Wildlife Observation Reporter app can be used to 

capture detailed wildlife counts, information about the health of observed animals, and photos of 

the observation. Both can be used on a mobile device in a connected or disconnected 

environment. 

Collect rapid wildlife observations 
You will start by assuming the role of a mobile worker in a protected area collecting 

observations of wildlife. You are asked to use the Rapid Wildlife Reporter app to collect rapid 

observations. 

1. Download ArcGIS QuickCapture onto your mobile device. 

2. In ArcGIS QuickCapture, open the Rapid Wildlife Reporter app. 

3. Tap the image of the animal that you have observed. 

4. For Total Animals, type the number of animals, and then click Done. 

5. Repeat these steps to add additional animal observations. 

6. After recording your observations, close the project. 

Note: 

By default, wildlife observations automatically send when your device is in connected mode. 
Before sending, you can click the Map button and view the wildlife observation locations on 
a map, and then, if necessary, you can adjust the location. 

 

Collect detailed wildlife observations 
You will start by assuming the role of a mobile worker in a protected area collecting 

observations of wildlife. You are asked to use the Wildlife Observation Reporter to collect 

detailed observations. 

1. On a mobile device, in ArcGIS Survey123, open the Wildlife Observation Reporter form. 

2. Tap Collect. 

3. Complete the survey with as much information as possible. 
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  Note: 

  Required information is marked with a red asterisk. 

4. Tap the check mark to submit the form, and then tap Send now. 

 

Monitor wildlife observations 
Now you will assume the role of a protected area manager. You will view wildlife observations 

throughout the protected area. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Wildlife 
Management solution. 

2. View the Wildlife Observation Dashboard app. 

  The Wildlife Observation Dashboard app opens with an overview of the current program 
status. 

3. On the left, adjust the filters to refine the results. 

4. On the right, select an observation from the list. 

  The map zooms to the location of the observation, and a pop-up with more information 
appears. 

5. Review the observation details. 
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